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USER INTERFACE IN A NUTSHELL 
When you start Tradesignal, the main user interface will be shown:When you start Tradesignal, the main user interface will be shown:  
  

l At the very top area of the window, there is the title bar. It contains information about the current window and the At the very top area of the window, there is the title bar. It contains information about the current window and the Quick Quick 
Access ToolbarAccess Toolbar..  

l Below the title bar, there is the Below the title bar, there is the ToolbarToolbar (or Ribbon bar). It offers access to all basic functionality (Edit, Insert, Search...). The  (or Ribbon bar). It offers access to all basic functionality (Edit, Insert, Search...). The 
Toolbar is tabbed with different toolbars for different groups of functionality. New tab pages may appear depending on the Toolbar is tabbed with different toolbars for different groups of functionality. New tab pages may appear depending on the 
document currently selected in a workspace.document currently selected in a workspace.  

l To the right of the toolbar tabs, you can see the status of the connection to the data provider. A green icon shows that the To the right of the toolbar tabs, you can see the status of the connection to the data provider. A green icon shows that the 
connection is available, and a red icon signals a failed connection. To reconnect a failed connection, doubleconnection is available, and a red icon signals a failed connection. To reconnect a failed connection, double--click the icon to click the icon to 
open the open the Primary Data Feed (Online Data) Settings in the Tradesignal OptionsPrimary Data Feed (Online Data) Settings in the Tradesignal Options. .   
To the right of the status icon, the time (depending on the time zone) is displayed. When scheduled print jobs are active, an To the right of the status icon, the time (depending on the time zone) is displayed. When scheduled print jobs are active, an 

The Tradesignal User InterfaceThe Tradesignal User Interface
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icon is displayed to the left of the status icon. icon is displayed to the left of the status icon.   
When you move the mouse pointer onto the status icon, a status popWhen you move the mouse pointer onto the status icon, a status pop--up opens. Here you can find information aboutup opens. Here you can find information about

¡ the used data providerthe used data provider  
¡ the current connection statusthe current connection status  
¡ the connected server (depending on the used data provider)the connected server (depending on the used data provider)  
¡ possibly active possibly active print jobsprint jobs  
¡ the set timezonethe set timezone  

l On the right, you can find the On the right, you can find the ToolboxToolbox. It offers access to symbols, properties, indicators, strategies, functions, templates, . It offers access to symbols, properties, indicators, strategies, functions, templates, 
(saved) workspaces and help. Above the button area, the details are displayed, like symbol lists or the property manager for (saved) workspaces and help. Above the button area, the details are displayed, like symbol lists or the property manager for 
the selected elements.the selected elements.  

l In the middle, you find the open In the middle, you find the open WorkspacesWorkspaces. This is where document types like . This is where document types like chartscharts, , portfoliosportfolios, , watchlistswatchlists, , scannersscanners, , 
indicatorsindicators, , strategiesstrategies, and other information are displayed. The tabs below the currently visible workspace allow selection of , and other information are displayed. The tabs below the currently visible workspace allow selection of 
which workspace to show.which workspace to show.  

l Below the workspaces, there is the Below the workspaces, there is the output windowoutput window which contains tabs for the  which contains tabs for the alertsalerts generated by strategies, tools and  generated by strategies, tools and 
indicators.indicators.  

USING MOUSE AND KEYBOARDUSING MOUSE AND KEYBOARD  

MOUSE HANDLINGMOUSE HANDLING  

The user interface is operated with the mouse.The user interface is operated with the mouse.

l Elements and buttons are activated or selected by clicking on them with the left mouse button (default). Typical activities Elements and buttons are activated or selected by clicking on them with the left mouse button (default). Typical activities 
are clicking on buttons to start activities, clicking on menu entries, or clicking on a drawing object to select it. When chart are clicking on buttons to start activities, clicking on menu entries, or clicking on a drawing object to select it. When chart 
objects are selected, their properties become available in the property inspector in the toolbox.objects are selected, their properties become available in the property inspector in the toolbox.  

l To open the context menu of an element, click on it with the right mouse button (also called To open the context menu of an element, click on it with the right mouse button (also called rightright--clickclick). The context menu ). The context menu 
opens, and you can select entries in the menu by clicking the default (left) mouse button. Context menus are available opens, and you can select entries in the menu by clicking the default (left) mouse button. Context menus are available 
almost everywhere, e.g. for documents, indicators etc.almost everywhere, e.g. for documents, indicators etc.  

l Some elements or menus open with a double click. This means clicking two times in fast succession with the left mouse Some elements or menus open with a double click. This means clicking two times in fast succession with the left mouse 
button. (If you click too slowly, you may simply open and close an element. In this case, try doublebutton. (If you click too slowly, you may simply open and close an element. In this case, try double--clicking again.) Typical clicking again.) Typical 
doubledouble--click activities are opening symbol lists (instead of clicking on the plus symbol), or opening a symbol in a chart click activities are opening symbol lists (instead of clicking on the plus symbol), or opening a symbol in a chart 
(instead of selecting (instead of selecting Open in ChartOpen in ChartOpen in ChartOpen in Chart from the context menu). from the context menu).  

l You can move elements around with the mouse. To do so, you need to You can move elements around with the mouse. To do so, you need to drag&dropdrag&drop the elements. Click on the element with  the elements. Click on the element with 
the left mouse button and keep the button pressed while moving the pointer to a new position (drag). Once there, release the left mouse button and keep the button pressed while moving the pointer to a new position (drag). Once there, release 
the mouse button (drop). Typical drag&drop activities in Tradesignal are applying indicators to symbol charts by dragging the mouse button (drop). Typical drag&drop activities in Tradesignal are applying indicators to symbol charts by dragging 
them into the chart, or drawing lines, squares etc. with the chart tools.them into the chart, or drawing lines, squares etc. with the chart tools.  

KEYBOARD HANDLINGKEYBOARD HANDLING  

Many elements can be opened/closed, or actions can be started, by pressing a certain keyboard shortcut. These shortcuts are Many elements can be opened/closed, or actions can be started, by pressing a certain keyboard shortcut. These shortcuts are 
notated in a special way, for example:notated in a special way, for example:

l Ctrl + SCtrl + SCtrl + SCtrl + S means "press the  means "press the CrtlCrtlCrtlCrtl key and the  key and the SSSS key at the same time". key at the same time".  
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l Ctrl + Shift + F4Ctrl + Shift + F4Ctrl + Shift + F4Ctrl + Shift + F4 means "press the  means "press the CrtlCrtlCrtlCrtl key, the  key, the ShiftShiftShiftShift key and the  key and the F4F4F4F4 function key all at the same time". function key all at the same time".  (Function keys are (Function keys are 
usually in the top area of a keyboard.)usually in the top area of a keyboard.)  

You can find a comprehensive list of all shortcuts in the chapter You can find a comprehensive list of all shortcuts in the chapter Keyboard ShortcutsKeyboard Shortcuts..

HIDING USER INTERFACE ELEMENTSHIDING USER INTERFACE ELEMENTS  

You can hide the toolbar, the toolbox and the alert area.You can hide the toolbar, the toolbox and the alert area.

l To hide the To hide the ToolbarToolbar, click on the icon with the vertical arrow at the top right in the header bar. To display the hidden , click on the icon with the vertical arrow at the top right in the header bar. To display the hidden ToolbarToolbar  
temporarily, lefttemporarily, left--click onto one of the toolbar tabs that remain visible.click onto one of the toolbar tabs that remain visible.  

l To hide the To hide the ToolboxToolbox, click on the icon with the small right, click on the icon with the small right--pointing arrow in the toolbox title. The toolbox is hidden to the pointing arrow in the toolbox title. The toolbox is hidden to the 
very right, under a long button labeled with the currently selected toolbox panel. Click on this button to temporarily open the very right, under a long button labeled with the currently selected toolbox panel. Click on this button to temporarily open the 
toolbox, or click the lefttoolbox, or click the left--pointing arrow button at the top of the bar to show the full toolbox once more.pointing arrow button at the top of the bar to show the full toolbox once more.  

l To hide the alert area (which is situated in the lower area of the workspace), click on the button to the bottomTo hide the alert area (which is situated in the lower area of the workspace), click on the button to the bottom--right of the right of the 
pane, below the tabs. When hidden the alert area will be replaced with a small info icon next to the workspace tabs, click pane, below the tabs. When hidden the alert area will be replaced with a small info icon next to the workspace tabs, click 
this to restore the alert pane. The alert pane can also be maximized using the button above the collapse button. You can find this to restore the alert pane. The alert pane can also be maximized using the button above the collapse button. You can find 
more information on alerts in the chapter more information on alerts in the chapter AlertsAlerts..  
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IMPORTANT FEATURES TOUR 
In this article you can find an overview of the most important Tradesignal functions. For detailed information, please follow the In this article you can find an overview of the most important Tradesignal functions. For detailed information, please follow the 
references to the respective articles.references to the respective articles.

CLASSIC CHART ANALYSISCLASSIC CHART ANALYSIS  

Tradesignal makes it easy for you to create charts for one or more symbols, Tradesignal makes it easy for you to create charts for one or more symbols, 
indicators and strategies. The design possibilities are vast. In the indicators and strategies. The design possibilities are vast. In the 
following, some important features will be given. following, some important features will be given.   
  
You can find an introduction to the user interface in the chapter You can find an introduction to the user interface in the chapter User User 
Interface in a NutshellInterface in a Nutshell..

CREATING A CHARTCREATING A CHART  

To open a new empty chart, click on the To open a new empty chart, click on the ChartChartChartChart button in the  button in the ToolbarToolbar. You . You 
can then add symbols to this chart, e.g. by dragging symbols from the can then add symbols to this chart, e.g. by dragging symbols from the 
ToolboxToolbox into it.  into it.   
  
You can also quickly open a chart for a symbol directly from the toolbar:You can also quickly open a chart for a symbol directly from the toolbar:

1.1. Click on the Click on the Symbol ListsSymbol ListsSymbol ListsSymbol Lists button in the  button in the ToolboxToolbox..  
2.2. Open a symbol list, e.g. the Nasdaq indizes, and look for the Open a symbol list, e.g. the Nasdaq indizes, and look for the 

".NDX".".NDX".  
3.3. DoubleDouble--click on the entry. Alternatively, rightclick on the entry. Alternatively, right--click on it and select click on it and select 

Open in ChartOpen in ChartOpen in ChartOpen in Chart in the context menu. in the context menu.  

You can also enter the symbol shortcut in the You can also enter the symbol shortcut in the Command LineCommand Line..

1.1. Enter the shortcut ".NDX" in the command line.Enter the shortcut ".NDX" in the command line.  
2.2. Select Select New ChartNew ChartNew ChartNew Chart from the drop from the drop--down menu.down menu.  

The data is displayed as a candlestick chart. You can change this default chart setting in the The data is displayed as a candlestick chart. You can change this default chart setting in the Tradesignal OptionsTradesignal Options, see the chapter , see the chapter 
Set New Default Chart StyleSet New Default Chart Style. The line and bar chart types are also available as default.. The line and bar chart types are also available as default.  
  
In general, many more chart types are available to you, like Forest, Equivolume, Kagi or Point&Figure. You can find a complete list In general, many more chart types are available to you, like Forest, Equivolume, Kagi or Point&Figure. You can find a complete list 
of all available chart types in of all available chart types in ChartChart..  
  
On the top left in the (subOn the top left in the (sub--)chart, you can find the chart legend. Here, information about the symbols, indicators, strategies, periods )chart, you can find the chart legend. Here, information about the symbols, indicators, strategies, periods 
etc. is available. The chart legend offers a context menu in which you can find various functions, depending on the entry type. etc. is available. The chart legend offers a context menu in which you can find various functions, depending on the entry type. 

CHANGING THE PERIOD AND TIME SPANCHANGING THE PERIOD AND TIME SPAN  

ChartChart

Chart LegendChart Legend
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There are various ways to change the displayed data. In the toolbar, the There are various ways to change the displayed data. In the toolbar, the 
buttons buttons PeriodPeriodPeriodPeriod and  and Time SpanTime SpanTime SpanTime Span are available. Click on the small arrows to  are available. Click on the small arrows to 
open the respective button menus.open the respective button menus.

l Keep the Keep the PeriodPeriodPeriodPeriod at  at DailyDailyDailyDaily. With this setting, one bar (candlestick) is . With this setting, one bar (candlestick) is 
drawn per day.drawn per day.  

l For the For the Time SpanTime SpanTime SpanTime Span, select , select Current YearCurrent YearCurrent YearCurrent Year, for example., for example.  

You can also change the displayed time span and prices by directly You can also change the displayed time span and prices by directly 
manipulating the axes with the mouse. To do so, click on the time axis manipulating the axes with the mouse. To do so, click on the time axis 
with the right mouse button and keep it pressed while moving the mouse with the right mouse button and keep it pressed while moving the mouse 
left and right. You can see that the axis is stretched and shrunk. The price left and right. You can see that the axis is stretched and shrunk. The price 
axis can be changed accordingly. You can find more information in the axis can be changed accordingly. You can find more information in the 
chapter chapter Stretch/shrink AxesStretch/shrink Axes..

ADDING DRAWING ELEMENTSADDING DRAWING ELEMENTS  

In the chart tools you can find simple drawing elements like lines, circles In the chart tools you can find simple drawing elements like lines, circles 
and rectangles, but also tools with a calculation function, like the Fibonacci and rectangles, but also tools with a calculation function, like the Fibonacci 
Retracements or Andrew's Pitchfork. You can find more information in the Retracements or Andrew's Pitchfork. You can find more information in the 
chapter chapter Chart ToolsChart Tools. . 

1.1. Click on the symbol for the trend line in the toolbar.Click on the symbol for the trend line in the toolbar.  
2.2. With the mouse button pressed, draw a trend line between two With the mouse button pressed, draw a trend line between two 

points in your current chart. A line is drawn.points in your current chart. A line is drawn.  
3.3. Now click on the symbol for the linear regression channel in the Now click on the symbol for the linear regression channel in the 

toolbar.toolbar.  
4.4. With the mouse button pressed, draw a linear regression channel With the mouse button pressed, draw a linear regression channel 

from a low to a high in the chart. You can see that the midline and a regression channel are calculated and drawn; they from a low to a high in the chart. You can see that the midline and a regression channel are calculated and drawn; they 
change angle and width depending on the bars (candlesticks) that are included from the start to the end point.change angle and width depending on the bars (candlesticks) that are included from the start to the end point.  

Some drawing elements can be combined with the alert function. You can find more information in the chapter Some drawing elements can be combined with the alert function. You can find more information in the chapter AlertsAlerts..

CHANGING THE CHART DESIGNCHANGING THE CHART DESIGN  

You can edit the details of the chart design, for example by changing the You can edit the details of the chart design, for example by changing the 
chart properties in the toolbox.chart properties in the toolbox.  
  
However, you can also use one of the available chart styles to change the However, you can also use one of the available chart styles to change the 
design extensively. design extensively. 

1.1. Click on the small arrow on the Click on the small arrow on the StylesStylesStylesStyles  button in the toolbar to open button in the toolbar to open 
the button menu.the button menu.  

2.2. Select a style from the list, for example Select a style from the list, for example BlueBlueBlueBlue. If you have drawing . If you have drawing 
elements in the chart, you can see that changing the style also elements in the chart, you can see that changing the style also 

Editing the PeriodEditing the Period

Trend Line and Regression Channel in the ChartTrend Line and Regression Channel in the Chart

Edited Chart StyleEdited Chart Style
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results in color changes for the drawn elements.results in color changes for the drawn elements.  

You can find more information in the chapter You can find more information in the chapter Chart PropertiesChart Properties..

DISPLAYING SEVERAL SYMBOLS IN THE SAME WORKSPACEDISPLAYING SEVERAL SYMBOLS IN THE SAME WORKSPACE  

You can display more than one symbol in the same workspace, e.g. as You can display more than one symbol in the same workspace, e.g. as 
subchart. For that, it is important to have a look at the settings for subcharts subchart. For that, it is important to have a look at the settings for subcharts 
in the in the Tradesignal OptionsTradesignal Options. . 

1.1. Open the file menu (above the toolbar in the Tradesignal window) Open the file menu (above the toolbar in the Tradesignal window) 
and select the entry and select the entry OptionsOptionsOptionsOptions..  

2.2. On the left, click on the entry On the left, click on the entry AdvancedAdvancedAdvancedAdvanced and then check whether the  and then check whether the 
setting setting Instruments > Open symbols in a new subchartInstruments > Open symbols in a new subchartInstruments > Open symbols in a new subchartInstruments > Open symbols in a new subchart is  is 
selected.selected.  

This entry has the following effect: This entry has the following effect: 

l If no subcharts should be opened: If a chart with a symbol is If no subcharts should be opened: If a chart with a symbol is 
displayed and you add a symbol by selecting displayed and you add a symbol by selecting Add SymbolAdd SymbolAdd SymbolAdd Symbol in the  in the 
context menu of that symbol, then the symbol is displayed in the context menu of that symbol, then the symbol is displayed in the 
same chart as the first symbol. This can make it hard to distinguish same chart as the first symbol. This can make it hard to distinguish 
between the two quotations.between the two quotations.  

l If subcharts should be opened: The added symbol is displayed as a subchart below the first symbol.If subcharts should be opened: The added symbol is displayed as a subchart below the first symbol.  

Subcharts share the same time and price axes. This has the advantage (or disadvantage) that all changes of e.g. period and time Subcharts share the same time and price axes. This has the advantage (or disadvantage) that all changes of e.g. period and time 
span apply to all subcharts.span apply to all subcharts.    
  
Tip: You can edit the period for a single symbol in the chart legend context menu. Tip: You can edit the period for a single symbol in the chart legend context menu.   
  
You can also display several charts in one workspace. For this, simply add the symbol by selecting You can also display several charts in one workspace. For this, simply add the symbol by selecting Open in ChartOpen in ChartOpen in ChartOpen in Chart in the symbol  in the symbol 
context menu. This way, the chart opens with its own axes. context menu. This way, the chart opens with its own axes.   
  
You can find more information in the chapter You can find more information in the chapter ChartsCharts..

KEEPING THE SYMBOL OVERVIEWKEEPING THE SYMBOL OVERVIEW  

SYMBOLS AND SYMBOL LISTSSYMBOLS AND SYMBOL LISTS  

Three Charts as SubchartsThree Charts as Subcharts

Three Charts as ChartsThree Charts as Charts
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You can see symbols and symbol lists by clicking on the button You can see symbols and symbol lists by clicking on the button Symbol Symbol Symbol Symbol 
ListsListsListsLists in the toolbox. in the toolbox.  
  
Symbol lists are sorted in groups. These are labeled with a folder symbol. Symbol lists are sorted in groups. These are labeled with a folder symbol. 
Click on the plus symbol in front of it to display the symbol lists. Click on the plus symbol in front of it to display the symbol lists.   
  
Symbol lists are labeled with a document symbol with a star. Symbols are Symbol lists are labeled with a document symbol with a star. Symbols are 
labeled with a star.labeled with a star.  
  
The context menu offers a lot of functions for both. For example, you can The context menu offers a lot of functions for both. For example, you can 
open symbols in charts or in a market depth document. Symbol lists can be open symbols in charts or in a market depth document. Symbol lists can be 
opened in a opened in a ScannerScanner, , WatchlistWatchlist or a  or a PortfolioPortfolio. .   
  
You can find more information in the chapter You can find more information in the chapter Symbol ListsSymbol Lists and the chapter  and the chapter 
Symbol SearchSymbol Search..

ADDING SYMBOLS TO LISTSADDING SYMBOLS TO LISTS  

Single symbols are always managed in symbol lists. Single symbols are always managed in symbol lists. 

1.1. To add a new symbol, open the context menu of a symbol list and select To add a new symbol, open the context menu of a symbol list and select New SymbolNew SymbolNew SymbolNew Symbol. The New Symbol wizard opens.. The New Symbol wizard opens.  
2.2. You can choose between three options. Select You can choose between three options. Select A standard symbol (from the data provider)A standard symbol (from the data provider)A standard symbol (from the data provider)A standard symbol (from the data provider)..  
3.3. The The Symbol SearchSymbol Search opens. Search the symbol you want to add. opens. Search the symbol you want to add.  

You can also add symbols to symbol lists by dragging symbols into them from other lists.You can also add symbols to symbol lists by dragging symbols into them from other lists.  
  
You can find more information in the chapter You can find more information in the chapter Add a Symbol to a Symbol ListAdd a Symbol to a Symbol List..

CREATING A NEW SYMBOL LISTCREATING A NEW SYMBOL LIST  

You can create your own symbols lists, for example to have your favorites in one list.You can create your own symbols lists, for example to have your favorites in one list.  

1.1. In the toolbox, click the In the toolbox, click the Symbol ListsSymbol ListsSymbol ListsSymbol Lists button and then on  button and then on New Symbol ListNew Symbol ListNew Symbol ListNew Symbol List in the  in the Related TaskRelated Task area. The Symbol List  area. The Symbol List 
wizard opens. Select the option wizard opens. Select the option UserUserUserUser----defined Symbol Listdefined Symbol Listdefined Symbol Listdefined Symbol List..  

2.2. The second window of the Wizard opens. Enter a name for the symbol list.The second window of the Wizard opens. Enter a name for the symbol list.  
3.3. Click on Click on AddAddAddAdd to start the  to start the Symbol SearchSymbol Search. Find the symbols, select them and . Find the symbols, select them and AddAddAddAdd them to the list. them to the list.  
4.4. Click on Click on DoneDoneDoneDone. The new symbol lists appears in the toolbox.. The new symbol lists appears in the toolbox.  

You can find more information in the chapter You can find more information in the chapter Symbol ListsSymbol Lists..

USING A WATCHLISTUSING A WATCHLIST  

Symbols and Symbol ListsSymbols and Symbol Lists
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The Watchlist is optimized for monitoring symbol data in realtime. In The Watchlist is optimized for monitoring symbol data in realtime. In 
combination with indicators (see below), alerts can be issued when certain combination with indicators (see below), alerts can be issued when certain 
data is "interesting" as defined by your indicators. data is "interesting" as defined by your indicators.   
  
The easiest way is to open an existing symbol list in a Watchlist. The easiest way is to open an existing symbol list in a Watchlist. 

1.1. RightRight--click on a symbol list in the toolbox and select click on a symbol list in the toolbox and select Open in Open in Open in Open in 
WatchlistWatchlistWatchlistWatchlist from the context menu. The Wizard opens. from the context menu. The Wizard opens.  

2.2. You can add one or more indicators, for example the "Relative You can add one or more indicators, for example the "Relative 
Strength Index".Strength Index".  

3.3. In the next step, you can also add one or more strategies.In the next step, you can also add one or more strategies.  
4.4. When finished selecting, click on When finished selecting, click on DoneDoneDoneDone..  

Similarly you can open single symbols in the Watchlist.Similarly you can open single symbols in the Watchlist.    
  
To open an empty Watchlist, click on the To open an empty Watchlist, click on the WatchlistWatchlistWatchlistWatchlist button in the toolbar. button in the toolbar.  
  
You can sort the Watchlist columns by clicking on the respective column header. A small triangle appears (pointing up or down, You can sort the Watchlist columns by clicking on the respective column header. A small triangle appears (pointing up or down, 
depending on the sorting direction). To change the direction, click on the column header again. depending on the sorting direction). To change the direction, click on the column header again.   
  
Symbols can be copied from other tables into the Watchlist by using Drag & Drop, e.g. from the Symbols can be copied from other tables into the Watchlist by using Drag & Drop, e.g. from the ScannerScanner to the Watchlist. In a  to the Watchlist. In a 
similar way, you can drag symbols from the Watchlist into a similar way, you can drag symbols from the Watchlist into a ScannerScanner or  or PortfolioPortfolio..

1.1. Click into a table cell of the symbol you want to copy. A small plus sign and a rectangle appear under the mouse cursor.Click into a table cell of the symbol you want to copy. A small plus sign and a rectangle appear under the mouse cursor.  
2.2. Drag the cursor into the other table. The symbol is copied into the table.Drag the cursor into the other table. The symbol is copied into the table.  

You can find more information in the chapter You can find more information in the chapter WatchlistWatchlist..

SCANNING SYMBOLSSCANNING SYMBOLS  

The Scanner helps you search the large number of symbols traded at The Scanner helps you search the large number of symbols traded at 
international markets for profitable trading candidates.international markets for profitable trading candidates.  
  
In contrast to the In contrast to the WatchlistWatchlist, the , the ScannerScanner offers no realtime information. offers no realtime information. It  It 
is therefore more useful for scanning large symbol lists for indicator or price is therefore more useful for scanning large symbol lists for indicator or price 
patterns, for example overnight. patterns, for example overnight.   
  
Similar to the Watchlist, you can quickly fill the Scanner by calling up the Similar to the Watchlist, you can quickly fill the Scanner by calling up the 
context menu of a symbol or symbol list and selecting context menu of a symbol or symbol list and selecting Open in Market Open in Market Open in Market Open in Market 
ScannerScannerScannerScanner. .   
  
As for a As for a WatchlistWatchlist, you can, you can

l open an empty Scanner via the toolbaropen an empty Scanner via the toolbar  
l directly add indicators and strategies when creating a Scannerdirectly add indicators and strategies when creating a Scanner  
l copy symbols from the Scanner into other tables by using Drag&Drop, or filling symbols from other tables into the Scannercopy symbols from the Scanner into other tables by using Drag&Drop, or filling symbols from other tables into the Scanner  
l sort the columns in the Scanner by clicking on the respective column headers.sort the columns in the Scanner by clicking on the respective column headers.  

WatchlistWatchlist

Symbols in the ScannerSymbols in the Scanner
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You can find more information in the chapter You can find more information in the chapter ScannerScanner..

INDICATORS AND STRATEGIESINDICATORS AND STRATEGIES  

Indicators and strategies are the main themes in analyzing symbol quotations. Indicators and strategies are the main themes in analyzing symbol quotations.   
  
Alongside classic drawing tools like trend lines or channels, indicators help to classify trends or offer clear trading signals. In Alongside classic drawing tools like trend lines or channels, indicators help to classify trends or offer clear trading signals. In 
Tradesignal, you can use indicators with Tradesignal, you can use indicators with ChartsCharts, , ScannersScanners, , WatchlistsWatchlists and more. Indicators can be combined, derived from each  and more. Indicators can be combined, derived from each 
other, or calculated for more than one symbol. other, or calculated for more than one symbol.   
  
Strategies combine indicators with entry and exit signals. This allows you to trade mechanical systems. Strategies combine indicators with entry and exit signals. This allows you to trade mechanical systems.   
  
You can find more information in the chapter You can find more information in the chapter Introduction to Functions, Indicators and StrategiesIntroduction to Functions, Indicators and Strategies..

APPLYING AN INDICATOR TO A CHARTAPPLYING AN INDICATOR TO A CHART  

1.1. Open a symbol in a chart.Open a symbol in a chart.  
2.2. Click on the Click on the IndicatorsIndicatorsIndicatorsIndicators button in the toolbox. button in the toolbox.  
3.3. Drag the indicator "Moving Average Exponential" onto the chart legend of the symbol. Alternatively, you can also select Drag the indicator "Moving Average Exponential" onto the chart legend of the symbol. Alternatively, you can also select 

ApplyApplyApplyApply in the context menu of the indicator. in the context menu of the indicator.  

In a similar way you can apply indicators to a In a similar way you can apply indicators to a WatchlistWatchlist, , ScannerScanner and  and PortfolioPortfolio..  
  
You can find more information in the chapter You can find more information in the chapter Using IndicatorsUsing Indicators..

EDITING THE INDICATOR PROPERTIESEDITING THE INDICATOR PROPERTIES  

You can edit the properties of indicators. You can edit the properties of indicators. 

l RightRight--click the indicator entry in the chart legend and select click the indicator entry in the chart legend and select 
PropertiesPropertiesPropertiesProperties from the context menu. The indicator properties are  from the context menu. The indicator properties are 
displayed in the toolbox.displayed in the toolbox.  

l Alternatively, click on the Alternatively, click on the PropertiesPropertiesPropertiesProperties button in the toolbox and  button in the toolbox and 
select the indicator in the list of elements available in the chart, on select the indicator in the list of elements available in the chart, on 
top of the properties display. (For example, for a chart that may be top of the properties display. (For example, for a chart that may be 
"Chart", "Money Management", the symbol shortcut, indicators and "Chart", "Money Management", the symbol shortcut, indicators and 
strategies.)strategies.)  

For the "MACD" indicator in our example, you can set the For the "MACD" indicator in our example, you can set the PeriodSlowPeriodSlowPeriodSlowPeriodSlow to  to 
"38" by clicking into the field and entering a number. You can also click on "38" by clicking into the field and entering a number. You can also click on 
the spin buttons to increase or decrease the number. the spin buttons to increase or decrease the number. 

APPLYING AN INDICATOR TO AN INDICATORAPPLYING AN INDICATOR TO AN INDICATOR  
Indicator Properties in the ToolbarIndicator Properties in the Toolbar
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You can apply a second indicator to the indicator used above, "Moving You can apply a second indicator to the indicator used above, "Moving 
Average Exponential", for example via the command line.Average Exponential", for example via the command line.

1.1. Click on the "Moving Average Double Crossover" entry in the chart Click on the "Moving Average Double Crossover" entry in the chart 
legend to select the indicator.legend to select the indicator.  

2.2. Enter the symbol shortcut Enter the symbol shortcut MACDMACDMACDMACD in the command line. in the command line.  
3.3. Select Select Add IndicatorAdd IndicatorAdd IndicatorAdd Indicator in the drop in the drop--down menu.down menu.  

The "MACD" indicator is now applied to the "Moving Average Exponential".The "MACD" indicator is now applied to the "Moving Average Exponential".

APPLYING STRATEGIES TO A CHARTAPPLYING STRATEGIES TO A CHART  

Strategies are an important part of trading systems, since they combine Strategies are an important part of trading systems, since they combine 
indicators with entry and exit signals. This allows you to trade mechanical indicators with entry and exit signals. This allows you to trade mechanical 
systems. systems.   
  
Strategies are applied similarly to indicators. You can apply strategies to Strategies are applied similarly to indicators. You can apply strategies to 
ChartsCharts, , WatchlistsWatchlists, , ScannersScanners and  and PortfoliosPortfolios..  
  
Here is an example that you can also use for the optimization below. Here is an example that you can also use for the optimization below. 

1.1. Open a symbol in a chart, for example a symbol of the Dow Jones Open a symbol in a chart, for example a symbol of the Dow Jones 
group.group.  

2.2. Click on the Click on the StrategiesStrategiesStrategiesStrategies button in the toolbar. button in the toolbar.  
3.3. Select the "Moving Average Double Crossover" strategy and drag it into the chart.Select the "Moving Average Double Crossover" strategy and drag it into the chart.  
4.4. Click on the Click on the PropertiesPropertiesPropertiesProperties button and select the strategy in the list of elements on top. button and select the strategy in the list of elements on top.  
5.5. Set Set PeriodFastPeriodFastPeriodFastPeriodFast to "5" days and  to "5" days and PeriodSlowPeriodSlowPeriodSlowPeriodSlow to "10" days. to "10" days.  

Now the strategy is set up. Now the strategy is set up.   
  
Alternatively, you can add trading systems by clicking on the Alternatively, you can add trading systems by clicking on the Add StrategyAdd StrategyAdd StrategyAdd Strategy button in the  button in the Trading SystemsTrading Systems group in the toolbar. A  group in the toolbar. A 
window opens in which you can find strategies sorted by subject, e.g. strategies for stops or position sizing.window opens in which you can find strategies sorted by subject, e.g. strategies for stops or position sizing.    
  
You can find more information in the chapter You can find more information in the chapter Using StrategiesUsing Strategies..

OPTIMIZING TRADING SYSTEMSOPTIMIZING TRADING SYSTEMS  

Applying an Indicator to an IndicatorApplying an Indicator to an Indicator

Applying StrategiesApplying Strategies
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Trading systems are often based on mathematical or statistical calculations Trading systems are often based on mathematical or statistical calculations 
and include many variables. The and include many variables. The OptimizerOptimizer helps you to find good and  helps you to find good and 
stable parameter sets for your trading system. stable parameter sets for your trading system.   
  
For the following example, please use the system you created in the For the following example, please use the system you created in the 
previous section.previous section.

1.1. Click on the Click on the OptimizeOptimizeOptimizeOptimize button in the toolbar. button in the toolbar.  
2.2. Select the method Select the method Brute ForceBrute ForceBrute ForceBrute Force..  
3.3. In the right field, select the parameter In the right field, select the parameter PeriodFastPeriodFastPeriodFastPeriodFast..  
4.4. Remove it by clicking on the Remove it by clicking on the <<<<<<<< button in the middle of the window. button in the middle of the window.  
5.5. Select Select PeriodSlowPeriodSlowPeriodSlowPeriodSlow in the field on the right and enter the start value  in the field on the right and enter the start value 

"10" and the end value "50"."10" and the end value "50".  
6.6. Click on Click on NextNextNextNext. Click on . Click on Next againNext againNext againNext again (so that all available data is used for optimization) and finally click on  (so that all available data is used for optimization) and finally click on OptimizeOptimizeOptimizeOptimize in the  in the 

last window.last window.  

The optimization starts. This may take some time, therefore a button The optimization starts. This may take some time, therefore a button PausePausePausePause is available in the  is available in the OptimizerOptimizer group group in the toolbar. Click  in the toolbar. Click 
on it to halt the optimization and to display the intermediate results.on it to halt the optimization and to display the intermediate results.  
  
When the optimization is finished, the results are displayed, in this case for optimizing the When the optimization is finished, the results are displayed, in this case for optimizing the Moving Average Double CrossoverMoving Average Double CrossoverMoving Average Double CrossoverMoving Average Double Crossover  
strategy. During the optimization, Tradesignal has calculated and checked many possible parameter combinations, and the result strategy. During the optimization, Tradesignal has calculated and checked many possible parameter combinations, and the result 
shows that certain settings for shows that certain settings for PeriodSlowPeriodSlowPeriodSlowPeriodSlow would have been more profitable than others. would have been more profitable than others.  
  
To apply the result of the optimization, for example the number for To apply the result of the optimization, for example the number for PeriodSlowPeriodSlowPeriodSlowPeriodSlow with the highest profit, simply double with the highest profit, simply double--click on the click on the 
row with the highest profit and confirm the warning with row with the highest profit and confirm the warning with YesYesYesYes. .   
  
Please remember that the optimization is always a backtest, e.g. working with the data of past trading periods. Therefore it is Please remember that the optimization is always a backtest, e.g. working with the data of past trading periods. Therefore it is 
recommended to check the optimization results against current developments from time to time. recommended to check the optimization results against current developments from time to time.   
  
You can find more information in the chapter You can find more information in the chapter OptimizerOptimizer..

PORTFOLIO TRADINGPORTFOLIO TRADING  

Trading with a trading system of one or more symbols, or even several Trading with a trading system of one or more symbols, or even several 
trading systems, is done most effectively by using the trading systems, is done most effectively by using the PortfolioPortfolio function.  function. 
With it, you can trade via a central account that includes settings for money With it, you can trade via a central account that includes settings for money 
and risk management. The and risk management. The PortfolioPortfolio also allows you creating a global  also allows you creating a global 
Performance ReportPerformance Report. .   
  
In a similar way to the In a similar way to the ScannerScanner and  and WatchlistWatchlist, you can open an empty , you can open an empty 
Portfolio from the toolbar, or you can open symbols and symbol lists in a Portfolio from the toolbar, or you can open symbols and symbol lists in a 
PortfolioPortfolio by selecting  by selecting Open in PortfolioOpen in PortfolioOpen in PortfolioOpen in Portfolio from the context menus.  from the context menus.   
  
As for a As for a WatchlistWatchlist, you can, you can

l directly add indicators and strategies when creating a Portfoliodirectly add indicators and strategies when creating a Portfolio  

Results of the OptimizerResults of the Optimizer

Portfolio TradingPortfolio Trading
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l copy symbols from the Portfolio into other tables by using Drag & Drop, or filling symbols from other tables into the Portfoliocopy symbols from the Portfolio into other tables by using Drag & Drop, or filling symbols from other tables into the Portfolio  
l sort the columns in the Portfolio by clicking on the respective column headers.sort the columns in the Portfolio by clicking on the respective column headers.  

You can find more information in the chapter You can find more information in the chapter PortfolioPortfolio..

POSITION MANAGERPOSITION MANAGER  

When trading a mechanical system, the When trading a mechanical system, the Position ManagerPosition Manager offers a  offers a 
complete overview over your current trading system activities. It displays complete overview over your current trading system activities. It displays 
open, filled, and canceled orders and your currently held positions. open, filled, and canceled orders and your currently held positions.   
  
You can open the Position Manager via the button You can open the Position Manager via the button Position ManagerPosition ManagerPosition ManagerPosition Manager in  in 
the toolbar. However, there are only entries in the Position Manager if a the toolbar. However, there are only entries in the Position Manager if a 
number of conditions have been met. number of conditions have been met.   
  
You can find more information in the chapter You can find more information in the chapter Position ManagerPosition Manager..  
  
The Position Manager is closely correlated with automatic order routing, The Position Manager is closely correlated with automatic order routing, 
see next paragraph. see next paragraph. 

AUTOMATIC ORDER ROUTINGAUTOMATIC ORDER ROUTING  

The automatic order routing function in Tradesignal allows you trading with a more or less mechanical trading system connected to The automatic order routing function in Tradesignal allows you trading with a more or less mechanical trading system connected to 
your broker. You can decide if the orders are to be routed automatically or only with a manual confirmation. your broker. You can decide if the orders are to be routed automatically or only with a manual confirmation.   
  
If you are using broker software without interfaces to Tradesignal, you can set up the order routing so that the trading activity is If you are using broker software without interfaces to Tradesignal, you can set up the order routing so that the trading activity is 
only displayed in the only displayed in the Position ManagerPosition Manager. You can then enter the orders into the broker's software manually. . You can then enter the orders into the broker's software manually.   
  
You can find more information in the chapter You can find more information in the chapter Automatic Order RoutingAutomatic Order Routing..    

Position ManagerPosition Manager
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USING THE HELP BUTTON 
With the help button With the help button FileFileFileFile menu you can: menu you can:

l call up the help topics of Tradesignalcall up the help topics of Tradesignal  
l write an ewrite an e--mail to support with necessary system informationmail to support with necessary system information  
l open open Tradesignal onlineTradesignal online discussion forums in the internal browser discussion forums in the internal browser  
l show the application log fileshow the application log file  
l search for application updatessearch for application updates  
l get information about your current Tradesignal versionget information about your current Tradesignal version  

HELP TOPICSHELP TOPICS  

Show the online version of the Show the online version of the help topicshelp topics as found in the help toolbox. The help topics give you an overview of Tradesignal help.  as found in the help toolbox. The help topics give you an overview of Tradesignal help. 
You can either manually search the tree structure for an article or you can use the input field to search for a specific keyword. In You can either manually search the tree structure for an article or you can use the input field to search for a specific keyword. In 
this case, a flat list of articles with those keywords is displayed. If you want to go back to the overview, click on the link this case, a flat list of articles with those keywords is displayed. If you want to go back to the overview, click on the link Table of Table of 
ContentsContents..

SEND SUPPORT INFORMATIONSEND SUPPORT INFORMATION  

This function collects some data about your Tradesignal system, puts it into a ZIP file, so that it can be attached to your email to This function collects some data about your Tradesignal system, puts it into a ZIP file, so that it can be attached to your email to 
send to support. This data collection will help the support team solve your problem. send to support. This data collection will help the support team solve your problem. 

CHECK FOR UPDATESCHECK FOR UPDATES  

Here you can check for the latest update of Tradesignal. This options is not available in all versions of Tradesignal.Here you can check for the latest update of Tradesignal. This options is not available in all versions of Tradesignal.

ABOUT TRADESIGNALABOUT TRADESIGNAL  

Shows you information about your Tradesignal installation.Shows you information about your Tradesignal installation.    
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WORKSPACES 
The workspace is the area of a software desktop in which documents are The workspace is the area of a software desktop in which documents are 
open and editable. Tradesignal workspaces provide many special functions open and editable. Tradesignal workspaces provide many special functions 
to make using the software easier for you.to make using the software easier for you.    
  
You can use workspaces for the following: You can use workspaces for the following: 

l Editing and saving several charts at the same timeEditing and saving several charts at the same time  
l Arranging charts in groupsArranging charts in groups  
l Saving different documents like charts, scanners, portfolios and Saving different documents like charts, scanners, portfolios and 

editors as one workspaceeditors as one workspace  
l Working with several desktops and monitors at the same timeWorking with several desktops and monitors at the same time  

WORK WITH WORKSPACESWORK WITH WORKSPACES  

NEW WORKSPACENEW WORKSPACE  

Tradesignal always opens a new workspace if you start a new document on an empty desktop.Tradesignal always opens a new workspace if you start a new document on an empty desktop.    
  
You can also use the following methods to set up new workspaces manually:You can also use the following methods to set up new workspaces manually:

l Click the Click the NewNewNewNew button in the  button in the FileFileFileFile menu. menu.  
l Press the key combination Press the key combination Ctrl + NCtrl + NCtrl + NCtrl + N..  
l Click on Click on NewNewNewNew in the context menu of the workspace tab. in the context menu of the workspace tab.  
l Click on the plus (+) button next to the workspace tabs at the bottom of the screen.Click on the plus (+) button next to the workspace tabs at the bottom of the screen.  

A new workspace is opened. A new workspace tab appears on the lower left. A new workspace is opened. A new workspace tab appears on the lower left. 

OPEN WORKSPACEOPEN WORKSPACE  

You can only open saved workspaces. Otherwise, you can always set up a new workspace. You can only open saved workspaces. Otherwise, you can always set up a new workspace.   
  
Open a saved workspace: Open a saved workspace: 

l By opening the By opening the WorkspacesWorkspacesWorkspacesWorkspaces manager in the toolbox and double manager in the toolbox and double--clicking a list entry orclicking a list entry or  
l By clicking on By clicking on RecentRecentRecentRecent in the  in the FileFileFileFile menu and choosing a workspace from the list of last edited workspaces. If you click on the  menu and choosing a workspace from the list of last edited workspaces. If you click on the 

entry entry More...More...More...More..., a file dialog opens in which you can open, copy or move workspaces. , a file dialog opens in which you can open, copy or move workspaces.   
When you press the key combination When you press the key combination Ctrl + OCtrl + OCtrl + OCtrl + O, a general file dialog opens in which you have access not only to workspaces , a general file dialog opens in which you have access not only to workspaces 
but also to indicators, strategies, functions etc. In both dialogs you have the possibility to select and open more than one but also to indicators, strategies, functions etc. In both dialogs you have the possibility to select and open more than one 
workspace at once.workspace at once.  

As an additional feature, you can open workspaces via the context menu of packages. For that, the packages have to be displayed. As an additional feature, you can open workspaces via the context menu of packages. For that, the packages have to be displayed. 
RightRight--click on the package name and select either click on the package name and select either 

l Open All WorkspacesOpen All WorkspacesOpen All WorkspacesOpen All Workspaces to open all workspaces in this package or to open all workspaces in this package or  
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l Open All Yellow WorkspacesOpen All Yellow WorkspacesOpen All Yellow WorkspacesOpen All Yellow Workspaces (red, blue) to open the color (red, blue) to open the color--tagged ones only.tagged ones only.  

For colorFor color--tagging workspaces in the toolbox, see the chapter tagging workspaces in the toolbox, see the chapter ToolboxToolbox..

RENAME WORKSPACERENAME WORKSPACE  

To rename a workspace, open the context menu of the workspace tab and click on To rename a workspace, open the context menu of the workspace tab and click on RenameRenameRenameRename. A dialog opens in which you can enter . A dialog opens in which you can enter 
a new name for the workspace. a new name for the workspace. 

CLOSE WORKSPACECLOSE WORKSPACE  

To close a single workspace, choose one of the following options:To close a single workspace, choose one of the following options:

l Press the key combination Press the key combination Ctrl + Shift + F4Ctrl + Shift + F4Ctrl + Shift + F4Ctrl + Shift + F4..  
l Click on Click on Close WorkspaceClose WorkspaceClose WorkspaceClose Workspace in the context menu of the workspace tab or in the file menu. in the context menu of the workspace tab or in the file menu.  
l Click on the Click on the xxxx button on the tab of the workspace. button on the tab of the workspace.  

To close all workspaces, click on To close all workspaces, click on Close all WorkspacesClose all WorkspacesClose all WorkspacesClose all Workspaces in the file menu. in the file menu.  
  
The last closed workspace can be quickly restored using the The last closed workspace can be quickly restored using the Restore Removed ItemsRestore Removed Items feature. feature.

SAVE WORKSPACESAVE WORKSPACE  

To save workspaces, choose one of the following entries in the file menu:To save workspaces, choose one of the following entries in the file menu:

l SaveSaveSaveSave ( (Ctrl + SCtrl + SCtrl + SCtrl + S) to save the current workspace (also available in the tab context menu).) to save the current workspace (also available in the tab context menu).  
l Save asSave asSave asSave as to save the current workspace under another name. to save the current workspace under another name.  
l Save allSave allSave allSave all to save all open workspaces. to save all open workspaces.  

You can find all saved workspaces in the You can find all saved workspaces in the WorkspacesWorkspacesWorkspacesWorkspaces manager of the toolbox.  manager of the toolbox. 

DELETE WORKSPACEDELETE WORKSPACE  

You can only delete workspaces that have been saved. Otherwise you can simply close a workspace that is no longer useful.You can only delete workspaces that have been saved. Otherwise you can simply close a workspace that is no longer useful.  
  
To delete a saved workspace, open the To delete a saved workspace, open the WorkspacesWorkspacesWorkspacesWorkspaces manager in the toolbox for a list of saved workspaces. Choose  manager in the toolbox for a list of saved workspaces. Choose DeleteDeleteDeleteDelete from  from 
the context menu of an entry.the context menu of an entry.

NAVIGATE IN WORKSPACESNAVIGATE IN WORKSPACES  

You can browse through open workspaces by pressing You can browse through open workspaces by pressing Ctrl + WCtrl + WCtrl + WCtrl + W for forward and  for forward and Ctrl + QCtrl + QCtrl + QCtrl + Q for backward scrolling.  for backward scrolling.   
  
You can change the workspace sequence by clicking on a tab and dragging and dropping it to the left or right.You can change the workspace sequence by clicking on a tab and dragging and dropping it to the left or right.  
  
NoteNoteNoteNote: If you want to see all open workspaces at a glance in multiple line, select : If you want to see all open workspaces at a glance in multiple line, select MultilineMultiline in the context menu of the workspace. in the context menu of the workspace.
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DEFINE KEYBOARD SHORTCUTSDEFINE KEYBOARD SHORTCUTS  

You can assign the keyboard shortcuts You can assign the keyboard shortcuts Ctrl + 0Ctrl + 0Ctrl + 0Ctrl + 0 up to  up to 9999 for often used workspaces. For this, either: for often used workspaces. For this, either:

l RightRight--click on the workspace tab orclick on the workspace tab or  
l RightRight--click in the list of workspaces in the click in the list of workspaces in the WorkspaceWorkspaceWorkspaceWorkspace manager in the toolbar manager in the toolbar  

and choose and choose Set ShortcutSet ShortcutSet ShortcutSet Shortcut  to select a key command from the subto select a key command from the sub--menu.menu.

ARRANGE WORKSPACES ON MONITORSARRANGE WORKSPACES ON MONITORS  

You can move a workspace to another monitor by clicking the workspace tab and dragging and dropping it to the target monitor. You can move a workspace to another monitor by clicking the workspace tab and dragging and dropping it to the target monitor.   
  
You can also arrange the workspaces on more than one monitor by clicking on the You can also arrange the workspaces on more than one monitor by clicking on the LayoutLayoutLayoutLayout button in the toolbar and choosing up to  button in the toolbar and choosing up to 
ten monitors to distribute the workspaces. ten monitors to distribute the workspaces. 

ARRANGE WORKSPACES ON DESKTOPSARRANGE WORKSPACES ON DESKTOPS  

You can display workspaces on new desktops. Desktops are new windows that will appear in the Windows task bar. They only You can display workspaces on new desktops. Desktops are new windows that will appear in the Windows task bar. They only 
offer the context menus of workspace bar and chart. offer the context menus of workspace bar and chart.   
  
To display a workspace on a different desktop, rightTo display a workspace on a different desktop, right--click the workspace tab, then choose click the workspace tab, then choose Change DesktopChange DesktopChange DesktopChange Desktop from the sub from the sub--menu to menu to 
select a desktop. Alternative you can dragselect a desktop. Alternative you can drag--andand--drop the workspace tab to the according desktop.drop the workspace tab to the according desktop.  
  
You can move the new desktop to other monitors by dragging and dropping. You can move the new desktop to other monitors by dragging and dropping. 

LOCK LAYOUT AGAINST CHANGESLOCK LAYOUT AGAINST CHANGES  

To prevent unwanted changes in the layout design of your workspaces, eitherTo prevent unwanted changes in the layout design of your workspaces, either

l click the click the LayoutLayoutLayoutLayout toolbar tab and click on  toolbar tab and click on LockLockLockLock, or, or  
l rightright--click the workspace tab and choose click the workspace tab and choose LockLockLockLock from the context menu. from the context menu.  

Documents in a locked workspace cannot be changed in size, form or position.Documents in a locked workspace cannot be changed in size, form or position.    
  
To unlock the workspace, simply click on the toolbar button a second time.To unlock the workspace, simply click on the toolbar button a second time.

PASSWORD PROTECTIONPASSWORD PROTECTION  
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You can restrict access to a workspace by specifying passwords for opening You can restrict access to a workspace by specifying passwords for opening 
and editing it by selecting the and editing it by selecting the LayoutLayoutLayoutLayout toolbar tab and clicking on  toolbar tab and clicking on 
Password Protect...Password Protect...Password Protect...Password Protect...  
  

Password Protection dialogPassword Protection dialog

Important:Important:Important:Important:  The password cannot be recovered, so if you lose it, you will The password cannot be recovered, so if you lose it, you will 
not be able to edit/access your protected workspace anymore.not be able to edit/access your protected workspace anymore.

ORGANIZE DOCUMENTS IN WORKSPACESORGANIZE DOCUMENTS IN WORKSPACES  

DEFAULT LAYOUTSDEFAULT LAYOUTS  

Tradesignal offers several default layouts for documents on a workspace. Tradesignal offers several default layouts for documents on a workspace. 
You can find them by selecting the You can find them by selecting the LayoutLayoutLayoutLayout tab on the toolbar.  tab on the toolbar.   
  
RebalanceRebalanceRebalanceRebalance arranges the documents as homogeneous as possible on the  arranges the documents as homogeneous as possible on the 
workspace. workspace.   
  
TabbedTabbedTabbedTabbed arranges all documents in a single stack. Each document is  arranges all documents in a single stack. Each document is 
accessible via a tab. accessible via a tab.   
  
ColumnsColumnsColumnsColumns arranges all documents in a row. arranges all documents in a row.    
  
RowsRowsRowsRows arranges all documents in a vertical column.  arranges all documents in a vertical column.   
  
TiledTiledTiledTiled generates a checker generates a checker--board pattern of the open documents. The board pattern of the open documents. The 
documents are arranged as homogeneously as possible in size and documents are arranged as homogeneously as possible in size and 
position. position.   
  
MaximizeMaximizeMaximizeMaximize (key  (key F4F4F4F4) shows the active document in full size in the ) shows the active document in full size in the 
workspace. A doubleworkspace. A double--click on the document tab will also maximize the click on the document tab will also maximize the 
document. Repeat to return to the former arrangement.document. Repeat to return to the former arrangement.  
  
You can change the size of a single document by moving the frame of the You can change the size of a single document by moving the frame of the 
document to the left, right, up or down.document to the left, right, up or down.

MOVE DOCUMENTSMOVE DOCUMENTS  

You can move documents across the workspace by dragging and dropping the document tab to a new position. During dragging, the You can move documents across the workspace by dragging and dropping the document tab to a new position. During dragging, the 
position is marked by a black, rectangular frame. position is marked by a black, rectangular frame.   
  
In principle, documents can be placed to the left, right, above or below another document. In principle, documents can be placed to the left, right, above or below another document.   

Layout "Tiled" documentsLayout "Tiled" documents

Layout "Tabs" (stacked documentsLayout "Tabs" (stacked documents
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In addition, you can place a document over another one, which results in a document stack. In this case, two tabs will be offered in In addition, you can place a document over another one, which results in a document stack. In this case, two tabs will be offered in 
the document space. The following rules apply to stacked documents:the document space. The following rules apply to stacked documents:

l Click on the document tab to bring the document to the front of the stack, i.e. display.Click on the document tab to bring the document to the front of the stack, i.e. display.  
l Drag the document tab to the left or right to change the position of the document in the stack.Drag the document tab to the left or right to change the position of the document in the stack.  

QUICK NAVIGATION BETWEEN DOCUMENTSQUICK NAVIGATION BETWEEN DOCUMENTS  

A document is activated when you click on its tab or frame. A document is activated when you click on its tab or frame.   
  
You can also use keyboard commands for quickly switching between documents (especially when stacked): You can also use keyboard commands for quickly switching between documents (especially when stacked): 

l Ctrl + TabCtrl + TabCtrl + TabCtrl + Tab switches to the next document in the workspace. If documents are stacked, the next document in the stack is  switches to the next document in the workspace. If documents are stacked, the next document in the stack is 
displayed.displayed.  

l Ctrl + Shift + TabCtrl + Shift + TabCtrl + Shift + TabCtrl + Shift + Tab switches to the previous document in the workspace. If documents are stacked, the previous document in  switches to the previous document in the workspace. If documents are stacked, the previous document in 
the stack is displayed.the stack is displayed.  

COPY AND PASTE DOCUMENTSCOPY AND PASTE DOCUMENTS  

In a workspace, you can copy documents and then paste them into another or the same workspace, duplicating it.In a workspace, you can copy documents and then paste them into another or the same workspace, duplicating it.  

1.1. Activate a document by clicking on its tab or frame.Activate a document by clicking on its tab or frame.  
2.2. In the In the EditEdit group in the  group in the HomeHomeHomeHome tab of the  tab of the ToolbarToolbar, click on the button , click on the button CopyCopyCopyCopy (keyboard shortcut  (keyboard shortcut Ctrl + CCtrl + CCtrl + CCtrl + C).).  
3.3. If necessary, switch to another workspace and click on the button If necessary, switch to another workspace and click on the button PastePastePastePaste (keyboard shortcut  (keyboard shortcut Ctrl + VCtrl + VCtrl + VCtrl + V).).  

SYMBOL LINKINGSYMBOL LINKING  

You can link several documents so that in all documents the same symbol You can link several documents so that in all documents the same symbol 
or period is displayed. The links are connected to colors, which are or period is displayed. The links are connected to colors, which are 
displayed as small filled rectangles on the top left of the document tab. displayed as small filled rectangles on the top left of the document tab.   
  
You can find the linking possibilities in the context menu of the document You can find the linking possibilities in the context menu of the document 
tab: tab: 

l Symbol LinkingSymbol LinkingSymbol LinkingSymbol Linking: When you change the symbol of a linked : When you change the symbol of a linked 
document, the symbol is changed in all linked documents.document, the symbol is changed in all linked documents.  

l Period LinkingPeriod LinkingPeriod LinkingPeriod Linking: When you change the period of a linked document, : When you change the period of a linked document, 
the period is changed in all linked documents.the period is changed in all linked documents.  

You have the choice betweenYou have the choice between

l Six normal links: these links only apply within the same workspace.Six normal links: these links only apply within the same workspace.  
l Three global links: these links apply across all workspaces.Three global links: these links apply across all workspaces.  

Note that you can assign only one document and one period link per document.Note that you can assign only one document and one period link per document.

l Global component linkingGlobal component linkingGlobal component linkingGlobal component linking: In addition to linking components within a single workspace, a component can be marked with : In addition to linking components within a single workspace, a component can be marked with 

Link DocumentsLink Documents
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a a ‘‘global linkglobal link’’. . The effect of this is that whenever a globally linked item is changed (either the symbol or period replaced), The effect of this is that whenever a globally linked item is changed (either the symbol or period replaced), 
all other components in all open workspaces with the same global link color will also be updated.all other components in all open workspaces with the same global link color will also be updated.  

RESTORING REMOVED ITEMSRESTORING REMOVED ITEMS  

When a workspace or item in a workspace is closed, or an item from a chart or watchlist is deleted, a yellow popup window will When a workspace or item in a workspace is closed, or an item from a chart or watchlist is deleted, a yellow popup window will 
be displayed at the bottom of the application window with a button labelled be displayed at the bottom of the application window with a button labelled UnremoveUnremoveUnremoveUnremove. This button may be clicked to undo the . This button may be clicked to undo the 
last remove/delete operation. Clicking the last remove/delete operation. Clicking the xxxx button on the popup window will hide it without performing the undo operation (a  button on the popup window will hide it without performing the undo operation (a 
new link labelled new link labelled UnremoveUnremoveUnremoveUnremove will instead be displayed to the left of the clock at the top right of the application window). will instead be displayed to the left of the clock at the top right of the application window).  
  
To only show the unobtrusive link at the top right of the application window, uncheck the corresponding box in the options found To only show the unobtrusive link at the top right of the application window, uncheck the corresponding box in the options found 
under under File > Options > Advanced > WorkspacesFile > Options > Advanced > Workspaces..    
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COMMAND LINE 
The command line is a central control element of Tradesignal. From here, The command line is a central control element of Tradesignal. From here, 
you can you can 

l create new documents like charts or scannerscreate new documents like charts or scanners  
l open Internet pagesopen Internet pages  
l enter Equilla formulasenter Equilla formulas  
l change the trading period of chartschange the trading period of charts  
l enter Tradesignalenter Tradesignal--specific !Bang commandsspecific !Bang commands  

GLOBAL COMMAND LINE FUNCTIONSGLOBAL COMMAND LINE FUNCTIONS  

l The command line is contextThe command line is context--sensitive, i.e. in the drop down menu sensitive, i.e. in the drop down menu 
of the command line, only functions available for the entered of the command line, only functions available for the entered 
command or text are displayed. The most probable function is command or text are displayed. The most probable function is 
offered first.offered first.  

l DoubleDouble--click in the command line field to open the dropclick in the command line field to open the drop--down down 
menu. This can be useful e.g. if there is a symbol shortcut in the menu. This can be useful e.g. if there is a symbol shortcut in the 
command line and you want to call up a function for it.command line and you want to call up a function for it.  

l The command line "remembers" previous entries. Click the small The command line "remembers" previous entries. Click the small 
arrow to the right of the command line field to open the list of arrow to the right of the command line field to open the list of 
previous entries. You can delete the command line history in the previous entries. You can delete the command line history in the 
Tradesignal OptionsTradesignal Options..  

l On the basis of these remembered entries, the command line offers autoOn the basis of these remembered entries, the command line offers auto--completion upon entering letters. For example, if completion upon entering letters. For example, if 
you have already entered "nsd.x" once, the next time you type "nsd" it will lead to the correct autoyou have already entered "nsd.x" once, the next time you type "nsd" it will lead to the correct auto--completion.completion.  

SYMBOL SHORTCUTSSYMBOL SHORTCUTS  

With a symbol shortcut you can open a With a symbol shortcut you can open a ChartChart, a , a ScannerScanner, a , a WatchlistWatchlist or a  or a PortfolioPortfolio. If such document types are already open, you . If such document types are already open, you 
can display the symbol in them. In case of an open chart, you can either substitute the displayed symbol or add a second time line can display the symbol in them. In case of an open chart, you can either substitute the displayed symbol or add a second time line 
to the existing chart. to the existing chart.   
  
Further commands can be entered along with the symbol shortcut:Further commands can be entered along with the symbol shortcut:  

l Periods Periods -- Enter a trading period right after the symbol shortcut. For example, ".DJI 60m" will Enter a trading period right after the symbol shortcut. For example, ".DJI 60m" will open an hourly chart of the Dow  open an hourly chart of the Dow 
Jones index.Jones index.  

l Data fields Data fields -- Enter a data field name, for example "CAT NYS bid" oder "CAT NYS ask". (Calls up data from the data  Enter a data field name, for example "CAT NYS bid" oder "CAT NYS ask". (Calls up data from the data 
provider.)provider.)  

l Units Units -- Enter a unit; this is especially useful in case of commodities and goods. (Calls up data from the data provider.) Enter a unit; this is especially useful in case of commodities and goods. (Calls up data from the data provider.)  

Command LineCommand Line

Command line with open menuCommand line with open menu
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l Currency Currency -- Enter the currency in which the symbol should be displayed. For example, enter "IBM NYS eur" to display IBM in  Enter the currency in which the symbol should be displayed. For example, enter "IBM NYS eur" to display IBM in 
euros. You can find the currency shortcuts in the symbol properties in the toolbox.euros. You can find the currency shortcuts in the symbol properties in the toolbox.  

SHORT CODES FOR INDICATORSSHORT CODES FOR INDICATORS  

Each Tradesignal indicator, as well as many indicators from other sources offer a short code. With it you can call up the program Each Tradesignal indicator, as well as many indicators from other sources offer a short code. With it you can call up the program 
from the command line. For example, to apply the Momentum indicator, enter "MOM" in the command line and select the offered from the command line. For example, to apply the Momentum indicator, enter "MOM" in the command line and select the offered 
option "Add Indicator Momentum". option "Add Indicator Momentum".   
  
Short codes can be applied to all document types that can work with indicators. To find out possible short codes, open the indicator Short codes can be applied to all document types that can work with indicators. To find out possible short codes, open the indicator 
window in the toolbox and hover over the list entries with the mouse. You can find the short code in the tool tip.window in the toolbox and hover over the list entries with the mouse. You can find the short code in the tool tip.

EQUILLA CODEEQUILLA CODE  

You can also enter You can also enter Equilla CodeEquilla Code directly in the command line (not available for trading commands like Buy or Short). This way you  directly in the command line (not available for trading commands like Buy or Short). This way you 
can easily set up new indicators or display an oftencan easily set up new indicators or display an often--used spread between two symbols.used spread between two symbols.  

ENTER A FORMULA IN A CHARTENTER A FORMULA IN A CHART  

You can create and apply indicator combinations by directly entering the formula in the command line. In that formula, you can You can create and apply indicator combinations by directly entering the formula in the command line. In that formula, you can 
combine Equilla functions and perform arithmetic operations. An editor is not necessary. combine Equilla functions and perform arithmetic operations. An editor is not necessary.   
  
To apply the following examples, an instrument has to be open in a chart.To apply the following examples, an instrument has to be open in a chart.  
  
Example 1: Calculate a five day average of the trading volume and then the ten day momentum:Example 1: Calculate a five day average of the trading volume and then the ten day momentum:

Momentum( Average( Volume, 5 ), 10 ) 

Example 2: Calculate the absolute difference between the open and close, then the 14 day RSI and then the exponential average Example 2: Calculate the absolute difference between the open and close, then the 14 day RSI and then the exponential average 
for it over 5 days:for it over 5 days:

Drawline( XAverage( RSI( ABS( Open ­ Close ), 14 ), 5 ) ) 

Example 3: Display the difference between the close and the 200 day average line:Example 3: Display the difference between the close and the 200 day average line:

Close ­ Average( Close, 200 ) 

DISPLAY SYNTHETIC TIME LINES, E.G. SPREADSDISPLAY SYNTHETIC TIME LINES, E.G. SPREADS  

If you want to display the difference or ratio between two timelines, enter the two symbol shortcuts with the arithmetic operator If you want to display the difference or ratio between two timelines, enter the two symbol shortcuts with the arithmetic operator 
between them. Instead of entering the symbol short cuts you can also drag the symbol from a symbol list, scanner, watchlist or an between them. Instead of entering the symbol short cuts you can also drag the symbol from a symbol list, scanner, watchlist or an 
open chart to the command line.open chart to the command line.  
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For example, enter For example, enter 

fdax 2006m / fdax 2006z 

and choose the option and choose the option New Formula ChartNew Formula ChartNew Formula ChartNew Formula Chart to display the spread. to display the spread.

OPEN WEB ADDRESSOPEN WEB ADDRESS  

To open a web site, enter a website address in the command line and choose the option To open a web site, enter a website address in the command line and choose the option New BrowserNew BrowserNew BrowserNew Browser. . 

CHANGE THE TRADING PERIODCHANGE THE TRADING PERIOD  

This feature is available for every document with an editable time period. Enter one of the following period shortcuts in the This feature is available for every document with an editable time period. Enter one of the following period shortcuts in the 
command line and choose the option command line and choose the option Set IntraSet IntraSet IntraSet Intra----Bar PeriodBar PeriodBar PeriodBar Period::

l mmmm or  or monthlymonthlymonthlymonthly  -- Display a monthly period. Display a monthly period.  

l wwww or  or weeklyweeklyweeklyweekly  -- Display a weekly period. Display a weekly period.  

l dddd or  or dailydailydailydaily  -- Display a one day period. You can add a number, e.g. "2d" for a two day period. Display a one day period. You can add a number, e.g. "2d" for a two day period.  

l hhhh  -- Display a period based on hours. A leading number has to be added, e.g. "3h" for a three hour period. Display a period based on hours. A leading number has to be added, e.g. "3h" for a three hour period.  

l mmmm  -- Display a period based on minutes. A leading number has to be added, e.g. "5m" for a five minute period. Display a period based on minutes. A leading number has to be added, e.g. "5m" for a five minute period.  

l ssss  -- Display a period based on seconds. A leading number has to be added, e.g. "6s" for a six second period. Display a period based on seconds. A leading number has to be added, e.g. "6s" for a six second period.  

l tttt or  or ticktickticktick  -- Display a one tick period. Display a one tick period.  

!!BANG COMMANDS!!BANG COMMANDS  

The soThe so--called !!Bang commands in Tradesignal work in a similar manner to the traditional commands for command line called !!Bang commands in Tradesignal work in a similar manner to the traditional commands for command line 
interpreters. They always have a leading "!!" (2 exclamation marks) and offer you a quick way to access certain software functions. interpreters. They always have a leading "!!" (2 exclamation marks) and offer you a quick way to access certain software functions. 

l !!!!!!!!  -- Enter only the 2 exclamation marks in the command line to open a list of all available Bang!! commands. Enter only the 2 exclamation marks in the command line to open a list of all available Bang!! commands.  

l !!add!!add!!add!!add  -- Adds a symbol to an open document in the workspace. Example: "!!add .dax" adds the dax in a Chart, Scanner,  Adds a symbol to an open document in the workspace. Example: "!!add .dax" adds the dax in a Chart, Scanner, 
Watchlist or Portfolio.Watchlist or Portfolio.  

l !!close!!close!!close!!close + option  + option -- "!!close d" Closes the active document, "!!close w" closes the active workspace and "!!close all" closes  "!!close d" Closes the active document, "!!close w" closes the active workspace and "!!close all" closes 
all workspaces and documents.all workspaces and documents.  

l !!eval!!eval!!eval!!eval + formula name  + formula name -- Adds an Equilla formula in the chart. Example: "!!eval open of .dax" adds the timeline for the dax  Adds an Equilla formula in the chart. Example: "!!eval open of .dax" adds the timeline for the dax 
open to a chart.open to a chart.  

l !!evalseries!!evalseries!!evalseries!!evalseries + formula series name  + formula series name -- Adds an Equilla formula series to a chart. Adds an Equilla formula series to a chart.  
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l !!log!!log!!log!!log  -- Opens the Tradesignal log file which contains important information about the program status and error messages. Opens the Tradesignal log file which contains important information about the program status and error messages.  

l !!new!!new!!new!!new + type shortcut (+ content)  + type shortcut (+ content) -- Opens a new document. For most documents, the content, e.g. a symbol or web address,  Opens a new document. For most documents, the content, e.g. a symbol or web address, 
has to be given. The following shortcuts are available: b has to be given. The following shortcuts are available: b -- browser, c  browser, c -- chart, f  chart, f -- Equilla function, i  Equilla function, i -- indicator, m  indicator, m -- Scanner, o  Scanner, o 
-- Portfolio, p  Portfolio, p -- market profile, s  market profile, s -- strategy, t  strategy, t -- Position Manager, v  Position Manager, v -- Watchlist, w  Watchlist, w -- workspace. workspace.  

l !!replace!!replace!!replace!!replace + symbol shortcut  + symbol shortcut -- Exchanges the symbol in the active chart with the symbol given in the command. Example: "!! Exchanges the symbol in the active chart with the symbol given in the command. Example: "!!
replace .dax".replace .dax".  

l !!replaceall!!replaceall!!replaceall!!replaceall + old symbol shortcut + new symbol shortcut  + old symbol shortcut + new symbol shortcut -- Exchanges the old symbol in all charts with the new symbol.  Exchanges the old symbol in all charts with the new symbol. 
Example: "!!replaceall ADS GER".Example: "!!replaceall ADS GER".  

l !!set!!set!!set!!set + + document property  document property -- Changes the property settings of a document. Example: "!!set historylength 100" for a chart. Changes the property settings of a document. Example: "!!set historylength 100" for a chart.  

l !!setall!!setall!!setall!!setall + + document property  document property -- Changes the property settings of all documents in which this property is applicable. Example:  Changes the property settings of all documents in which this property is applicable. Example: 
"!!setall historylength 100" for all charts."!!setall historylength 100" for all charts.  
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TOOLBAR 
In Tradesignal, the classic menu is substituted with a RibbonIn Tradesignal, the classic menu is substituted with a Ribbon--style Toolbar.style Toolbar.

l There are multiple tabThere are multiple tab--pages of toolbar buttons and menus organized pages of toolbar buttons and menus organized 
according to general functionality.according to general functionality.  

l The first tab is the The first tab is the FileFileFileFile menu, that will show the backstage view of  menu, that will show the backstage view of 
the application when selected. The backstage view is an interactive the application when selected. The backstage view is an interactive 
menu that contains all functions that operate on a workspace as a menu that contains all functions that operate on a workspace as a 
whole (for example printing).whole (for example printing).  

l The The HomeHomeHomeHome tab contains the majority of functions that pertain to the contents of a workspace. tab contains the majority of functions that pertain to the contents of a workspace.  

l The remaining tabs contain the functions implied by their title. The remaining tabs contain the functions implied by their title. InsertInsertInsertInsert for commands concerning inserting content into a  for commands concerning inserting content into a 
workspace. workspace. LayoutLayoutLayoutLayout for workspace layout commands.  for workspace layout commands. Order routingOrder routingOrder routingOrder routing for functions concerned with order routing. for functions concerned with order routing.  

l The final tab The final tab EditorEditorEditorEditor will only appear if a text editor is selected in a workspace. This tab has all functions concerned with  will only appear if a text editor is selected in a workspace. This tab has all functions concerned with 
editing Equilla or HTML source code and editing Equilla or HTML source code and debuggingdebugging Equilla content in charts. Equilla content in charts.  

l Some buttons open menus that offer further functions. You can recognize these by the small black arrow below the buttons.Some buttons open menus that offer further functions. You can recognize these by the small black arrow below the buttons.  

l The arrangement of the buttons in the toolbar changes depending on the monitor or program window size. Therefore, either The arrangement of the buttons in the toolbar changes depending on the monitor or program window size. Therefore, either 
more buttons or fewer buttons (but with menu functionality) are visible.more buttons or fewer buttons (but with menu functionality) are visible.  

l For many functions, you can open a help topic. The help is available via the key For many functions, you can open a help topic. The help is available via the key F1F1F1F1 if the tool tip says that there is a help  if the tool tip says that there is a help 
file for this feature. The help topic is then displayed in the internal browser.file for this feature. The help topic is then displayed in the internal browser.  

l You can toggle the Toolbar with the keyboard shortcut You can toggle the Toolbar with the keyboard shortcut Ctrl + F1Ctrl + F1Ctrl + F1Ctrl + F1, by double, by double--clicking on a Toolbar tab or by clicking the small clicking on a Toolbar tab or by clicking the small 
arrow on the far right of the toolbar tabs. When collapsed the toolbar can be temporarily shown by clicking on one of the arrow on the far right of the toolbar tabs. When collapsed the toolbar can be temporarily shown by clicking on one of the 
toolbar tabs.toolbar tabs.  

TOOLBAR TABS AND GROUPSTOOLBAR TABS AND GROUPS  

The functions displayed on a Toolbar tab are further organized into named groups to improve identification. The following groups The functions displayed on a Toolbar tab are further organized into named groups to improve identification. The following groups 
are available by toolbar tab:are available by toolbar tab:

FILE TABFILE TAB  

This tab shows the backstage view, which combines typical file operations like save and open with interactive inline content This tab shows the backstage view, which combines typical file operations like save and open with interactive inline content 
organized as sub menus:organized as sub menus:

l RecentRecentRecentRecent  -- List of recently opened workspaces. List of recently opened workspaces.  
l PrintPrintPrintPrint  -- Print preview and printing. Print preview and printing.  
l Save & SendSave & SendSave & SendSave & Send  -- Functions to export the current workspace in various ways and formats. Functions to export the current workspace in various ways and formats.  
l HelpHelpHelpHelp  -- The application  The application HelpHelp menu. menu.  
l OptionsOptionsOptionsOptions  -- All application configuration options. All application configuration options.  

ToolbarToolbar
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HOME TABHOME TAB  

l EditEditEditEdit  -- The typical clipboard functions like copy and paste. The typical clipboard functions like copy and paste.  
l StrategiesStrategiesStrategiesStrategies  -- Functions to add and augment trading system components. Functions to add and augment trading system components.  
l TableTableTableTable  -- Functions concerning table Functions concerning table--based elements.based elements.  
l DataDataDataData  -- Functions associated with searching for  Functions associated with searching for -- and manipulating  and manipulating -- financial data. financial data.  
l ChartChartChartChart  -- Functions concerned with chart document. Functions concerned with chart document.  
l Chart ToolsChart ToolsChart ToolsChart Tools  -- Drawing tools for use in charts. Drawing tools for use in charts.  
l FavoritesFavoritesFavoritesFavorites  -- Any indicators with short codes that have been color Any indicators with short codes that have been color--tagged will be listed here.tagged will be listed here.  
l StyleStyleStyleStyle  -- Operations for creating and applying styles and templates to workspace elements. Operations for creating and applying styles and templates to workspace elements.  
l FindFindFindFind  -- Search for items withing open workspace elements. Search for items withing open workspace elements.  

INSERT TABINSERT TAB  

l ChartsChartsChartsCharts  -- Chart Chart--like items that can be inserted into a workspace.like items that can be inserted into a workspace.  
l TablesTablesTablesTables  -- Table Table--based items that can be inserted into a workspace.based items that can be inserted into a workspace.  
l TradingTradingTradingTrading  -- Trading Trading--system related elements.system related elements.  
l ResearchResearchResearchResearch  -- Research tools. Research tools.  
l DeveloperDeveloperDeveloperDeveloper  -- Developer specific tools. Developer specific tools.  

LAYOUT TABLAYOUT TAB  

l LayoutLayoutLayoutLayout  -- Functions to change the layout of the current workspace Functions to change the layout of the current workspace  
l MonitorsMonitorsMonitorsMonitors  -- Options to utilize multiple monitors. Options to utilize multiple monitors.  

ORDER ROUTING TABORDER ROUTING TAB  

l Order RoutingOrder RoutingOrder RoutingOrder Routing  -- Functions to control and configure automatic order routing. Functions to control and configure automatic order routing.  

EDITOR TABEDITOR TAB  

l EditEditEditEdit  -- The typical clipboard functions like copy and paste. The typical clipboard functions like copy and paste.  
l Text EditorText EditorText EditorText Editor  -- Functions found in a typical developer text editor Functions found in a typical developer text editor  
l ExportExportExportExport  -- Options to export an Equilla script in various ways. Options to export an Equilla script in various ways.  
l FindFindFindFind  -- Typical search (and replace) operations. Typical search (and replace) operations.  
l DebugDebugDebugDebug  -- Commands to control the  Commands to control the Equilla DebuggerEquilla Debugger..  
l BreakpointsBreakpointsBreakpointsBreakpoints  -- Set and manage breakpoints for use when debugging. Set and manage breakpoints for use when debugging.  
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QUICK ACCESS TOOLBAR 
The Quick Access Toolbar allows you to create a personalized toolbar comprised of buttons and menus found on the various Toolbar The Quick Access Toolbar allows you to create a personalized toolbar comprised of buttons and menus found on the various Toolbar 
tabs. The Quick Access Toolbar can be displayed above or below the main Toolbar by using the option available in the context tabs. The Quick Access Toolbar can be displayed above or below the main Toolbar by using the option available in the context 
menu by rightmenu by right--clicking on the Quick Access Toolbar.clicking on the Quick Access Toolbar.

ADDING ITEMSADDING ITEMS  

Items may be added to the toolbar either by Items may be added to the toolbar either by 

l rightright--clicking on the desired item in the main Toolbar and selecting the option clicking on the desired item in the main Toolbar and selecting the option Add to Quick Access ToolbarAdd to Quick Access ToolbarAdd to Quick Access ToolbarAdd to Quick Access Toolbar, or, or  
l using the using the ++++ button in the tree of commands found in the options under  button in the tree of commands found in the options under File > Options > Personalize > Ribbon ToolbarFile > Options > Personalize > Ribbon Toolbar  

Some items may not be added to the Quick Access Toolbar. These items will have the Some items may not be added to the Quick Access Toolbar. These items will have the Add to Quick Access ToolbarAdd to Quick Access ToolbarAdd to Quick Access ToolbarAdd to Quick Access Toolbar option  option 
disabled in their context menu.disabled in their context menu.

REMOVING ITEMSREMOVING ITEMS  

Items may be removed from the Quick Access Toolbar by eitherItems may be removed from the Quick Access Toolbar by either

l rightright--clicking on the desired item on the Quick Access Toolbar and selecting the option clicking on the desired item on the Quick Access Toolbar and selecting the option Remove from Quick Access Remove from Quick Access Remove from Quick Access Remove from Quick Access 
ToolbarToolbarToolbarToolbar, or, or  

l using the using the xxxx button on the desired item in the  button on the desired item in the Toolbar ItemsToolbar ItemsToolbar ItemsToolbar Items list found in the options under  list found in the options under File > Options > Personalize > File > Options > Personalize > 
Ribbon ToolbarRibbon Toolbar  

REORDERING AND GROUPINGREORDERING AND GROUPING  

Items in the Quick Access Toolbar may be reordered and/or grouped using the Items in the Quick Access Toolbar may be reordered and/or grouped using the Toolbar ItemsToolbar ItemsToolbar ItemsToolbar Items list in the options under  list in the options under File > File > 
Options > Personalize > Ribbon ToolbarOptions > Personalize > Ribbon Toolbar. The up and down arrows against an item may be used to reposition that item. The . The up and down arrows against an item may be used to reposition that item. The Begin Begin Begin Begin 
GroupGroupGroupGroup box may be checked to inset a group separator before the selected Toolbar item. box may be checked to inset a group separator before the selected Toolbar item.    
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TOOLBOX 
The toolbox on the lower right grants you access to many key features of Tradesignal, namely symbol lists, properties, indicators, The toolbox on the lower right grants you access to many key features of Tradesignal, namely symbol lists, properties, indicators, 
strategies, (Equilla) functions, templates, and workspaces.strategies, (Equilla) functions, templates, and workspaces.

GENERAL FEATURESGENERAL FEATURES  

CONTEXT MENUSCONTEXT MENUS  

In all windows (except for properties) you can rightIn all windows (except for properties) you can right--click on a list entry to click on a list entry to 
open its context menu. There, you can find functions like applying, editing, open its context menu. There, you can find functions like applying, editing, 
renaming, deleting, etc. You can also tag list entries with colors to find renaming, deleting, etc. You can also tag list entries with colors to find 
them more easily later.them more easily later.

RELATED TASKS AREARELATED TASKS AREA  

Here you can find links to related tasks. These depend on the active tool.Here you can find links to related tasks. These depend on the active tool.

l For symbols, the available links are For symbols, the available links are New Symbol ListNew Symbol ListNew Symbol ListNew Symbol List, , New New New New 
SymbolSymbolSymbolSymbol and  and New GroupNew GroupNew GroupNew Group (see the chapter  (see the chapter Symbol ListsSymbol Lists).).  

l For indicators, strategies, functions and workspaces, you can find the For indicators, strategies, functions and workspaces, you can find the 
link link New...New...New...New... (indicator, strategy etc.) and links for  (indicator, strategy etc.) and links for Package Package 
ManagementManagement ( (New PackageNew PackageNew PackageNew Package and  and Show/Hide PackagesShow/Hide PackagesShow/Hide PackagesShow/Hide Packages). ). 
Packages correspond to folders on your computer and should make Packages correspond to folders on your computer and should make 
tool handling easier for you.tool handling easier for you.  

l Templates are saved from charts (see the chapter Templates are saved from charts (see the chapter Save a TemplateSave a Template), ), 
so only links for so only links for Package ManagementPackage Management are available here. are available here.  

l For properties, no links to related tasks are available.For properties, no links to related tasks are available.  

EDIT THE TOOLBOX APPEARANCEEDIT THE TOOLBOX APPEARANCE  

You can also decrease and increase the number of tool buttons, as well as completely removing tools from the toolbox. Click on the You can also decrease and increase the number of tool buttons, as well as completely removing tools from the toolbox. Click on the 
small arrow head on the lower right to open the context menu of the toolbox. You have the following options:small arrow head on the lower right to open the context menu of the toolbox. You have the following options:

l Show More ButtonsShow More ButtonsShow More ButtonsShow More Buttons ? Display one of the small buttons below the toolbox as a regular tool button. You can repeat this  ? Display one of the small buttons below the toolbox as a regular tool button. You can repeat this 
until all tools are shown as tool buttons.until all tools are shown as tool buttons.  

l Show Less ButtonsShow Less ButtonsShow Less ButtonsShow Less Buttons ? Display one of the tool buttons as small symbol button below the toolbox. You can repeat this until  ? Display one of the tool buttons as small symbol button below the toolbox. You can repeat this until 
all tool buttons are shown as small buttons.all tool buttons are shown as small buttons.  

l Add or Remove ButtonsAdd or Remove ButtonsAdd or Remove ButtonsAdd or Remove Buttons ? Here you can completely suppress the display of tools in the menu. For this, click on the  ? Here you can completely suppress the display of tools in the menu. For this, click on the 
respective entries in the subordinate menu to switch the tools on or off.respective entries in the subordinate menu to switch the tools on or off.  

Alternatively you can reduce/expand the display of the tool buttons by dragging the separator between the button menu and the Alternatively you can reduce/expand the display of the tool buttons by dragging the separator between the button menu and the 
display window upwards or downwards. For this, position the mouse cursor on the dotted grip bar above the tool buttons so that it display window upwards or downwards. For this, position the mouse cursor on the dotted grip bar above the tool buttons so that it 
changes into a double arrow. Then drag the grip bar up or down and release the mouse button when done.changes into a double arrow. Then drag the grip bar up or down and release the mouse button when done.

ToolboxToolbox
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REPOSITIONING TOOLBOX ELEMENTSREPOSITIONING TOOLBOX ELEMENTS  

Toolbox buttons can be reorganized by dragging and dropping them eitherToolbox buttons can be reorganized by dragging and dropping them either

l vertically within the same list of buttons, orvertically within the same list of buttons, or  
l to the opposite edge of the application window, to split the toolbox on both left and right sidesto the opposite edge of the application window, to split the toolbox on both left and right sides  

To drag all toolbox elements to the opposite side, hold the To drag all toolbox elements to the opposite side, hold the CtrlCtrlCtrlCtrl key while dragging a single button. key while dragging a single button.

COLLAPSING AND TEMPORARILY SHOWING THE TOOLBOXCOLLAPSING AND TEMPORARILY SHOWING THE TOOLBOX  

You can hide and show the toolbox by pressing the small arrow button to the right of the toolboxes title.You can hide and show the toolbox by pressing the small arrow button to the right of the toolboxes title.  
  
To hide and show the properties window directly, press To hide and show the properties window directly, press Ctrl + F2Ctrl + F2Ctrl + F2Ctrl + F2. .   
  
When the Toolbox is collapsed, it can be temporarily shown by clicking on the collapsed toolbox in any location other than the When the Toolbox is collapsed, it can be temporarily shown by clicking on the collapsed toolbox in any location other than the 
arrow button used to restore the toolbox.arrow button used to restore the toolbox.  
  
To temporarily show a specific toolbox pane, click the corresponding icon.To temporarily show a specific toolbox pane, click the corresponding icon.

DELETING AND RESTORING ITEMSDELETING AND RESTORING ITEMS  

If a toolbox allows the deletion of its contents, normally using the rightIf a toolbox allows the deletion of its contents, normally using the right--click context menu and selecting click context menu and selecting DeleteDeleteDeleteDelete. The . The most recently most recently 
deleted itemdeleted item may be restored clicking on the  may be restored clicking on the UnremoveUnremoveUnremoveUnremove button that is either displayed in a yellow pop button that is either displayed in a yellow pop--up at the bottom of the up at the bottom of the 
application window, or the application window, or the UnremoveUnremoveUnremoveUnremove link shown to the left of the clock at the top right of the application window. Please note,  link shown to the left of the clock at the top right of the application window. Please note, 
only the most recently deleted item may be restored in this way.only the most recently deleted item may be restored in this way.  
  
If an item that is deleted has a corresponding file (for example workspace, indicators, strategies, functions and templates), the If an item that is deleted has a corresponding file (for example workspace, indicators, strategies, functions and templates), the 
deleted file will be moved to the system Recycle Bin if it was stored on a file system that supports the Recycle Bin function.deleted file will be moved to the system Recycle Bin if it was stored on a file system that supports the Recycle Bin function.

NAVIGATING TO AN ITEM IN WINDOWS EXPLORERNAVIGATING TO AN ITEM IN WINDOWS EXPLORER  

If an item or folder in the Toolbox has a corresponding file (e.g. workspaces and indicators), the rightIf an item or folder in the Toolbox has a corresponding file (e.g. workspaces and indicators), the right--click context menu for the click context menu for the 
item or folder will have an option called item or folder will have an option called Open In Windows ExplorerOpen In Windows ExplorerOpen In Windows ExplorerOpen In Windows Explorer. Clicking on this option will open the file or folders location . Clicking on this option will open the file or folders location 
in Windows Explorer.in Windows Explorer.

SELECTING MULTIPLE ITEMS AT ONCESELECTING MULTIPLE ITEMS AT ONCE  

To perform an operation on multiple items at once, first select the items by either:To perform an operation on multiple items at once, first select the items by either:

l holding down the holding down the CtrlCtrlCtrlCtrl key and clicking on each item, or key and clicking on each item, or  
l click on the first item to select, then hold down the click on the first item to select, then hold down the ShiftShiftShiftShift key and click on the last item to select all items between these  key and click on the last item to select all items between these 

two items.two items.  

Once multiple items have been selected, the rightOnce multiple items have been selected, the right--click context menu will show only those operations that are applicable to click context menu will show only those operations that are applicable to 
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multiple selected items. Typically allowed operations include: deleting the selected items, moving the selected items between multiple selected items. Typically allowed operations include: deleting the selected items, moving the selected items between 
folders, color tagging all the items, or opening the items in various ways within a workspace.folders, color tagging all the items, or opening the items in various ways within a workspace.

AVAILABLE TOOLS IN THE TOOLBOXAVAILABLE TOOLS IN THE TOOLBOX  

SYMBOL LISTSSYMBOL LISTS  

Here you can find the list of symbols for the available securities. Read the chapter Here you can find the list of symbols for the available securities. Read the chapter Symbol ListsSymbol Lists for more information. for more information.

PROPERTIESPROPERTIES  

In the properties window, you can access all objects and their properties within the document. The objects are listed at the top of In the properties window, you can access all objects and their properties within the document. The objects are listed at the top of 
the window. The properties of the selected object are listed below, sorted by category. The properties are discussed in the topic of the window. The properties of the selected object are listed below, sorted by category. The properties are discussed in the topic of 
each object.each object.  

INDICATORSINDICATORS  

Here you can find all indicators that were delivered in the Tradesignal data folder, as well as all indicators you may have saved in Here you can find all indicators that were delivered in the Tradesignal data folder, as well as all indicators you may have saved in 
other packages. Read the chapter other packages. Read the chapter IndicatorsIndicators for more information. A search box at the top of the pane allows searching by title  for more information. A search box at the top of the pane allows searching by title 
keywords or indicator short code.keywords or indicator short code.

STRATEGIESSTRATEGIES  

Here you can find all strategies that were delivered in the Tradesignal data folder, as well as all strategies you may have saved in Here you can find all strategies that were delivered in the Tradesignal data folder, as well as all strategies you may have saved in 
other packages. Read the chapter other packages. Read the chapter StrategiesStrategies for more information. A search box at the top of the pane allows searching by title  for more information. A search box at the top of the pane allows searching by title 
keywords or strategy short code.keywords or strategy short code.

FUNCTIONSFUNCTIONS  

Here you can find all functions that were delivered in the Tradesignal data folder, as well as all functions you may have saved in Here you can find all functions that were delivered in the Tradesignal data folder, as well as all functions you may have saved in 
other packages. Read the chapter other packages. Read the chapter FunctionsFunctions for more information. A search box at the top of the pane allows searching by title  for more information. A search box at the top of the pane allows searching by title 
keywords.keywords.

TEMPLATESTEMPLATES  

Here you can find templates, in which graphical properties and information about indicators and trading systems are saved. Via the Here you can find templates, in which graphical properties and information about indicators and trading systems are saved. Via the 
context menu, you can directly call up a template. It will contain the security data with which it was originally saved. Read the context menu, you can directly call up a template. It will contain the security data with which it was originally saved. Read the 
chapter chapter Using TemplatesUsing Templates for more information. A search box at the top of the pane allows searching by title keywords. for more information. A search box at the top of the pane allows searching by title keywords.

WORKSPACESWORKSPACES  

Here you can find saved workspaces. Via the context menu you can assign up to ten Here you can find saved workspaces. Via the context menu you can assign up to ten keyboard shortcutskeyboard shortcuts. Read the chapter . Read the chapter 
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WorkspacesWorkspaces for more information. A search box at the top of the pane allows searching by title keywords for more information. A search box at the top of the pane allows searching by title keywords

HELPHELP  

The help is divided into categories that are displayed as main entries. Under most main entries, subThe help is divided into categories that are displayed as main entries. Under most main entries, sub--topics are available. At the top topics are available. At the top 
of the help window you can find an input box. Here you can enter a search term for a fullof the help window you can find an input box. Here you can enter a search term for a full--text search in the help. Alternatively, text search in the help. Alternatively, 
doubledouble--click on a list entry to open the topic in the browser window.click on a list entry to open the topic in the browser window. Via the context menu, you can open the help topic in a new  Via the context menu, you can open the help topic in a new 
browser window. For this, click on browser window. For this, click on Open Link in new BrowserOpen Link in new BrowserOpen Link in new BrowserOpen Link in new Browser. The new browser window is then stacked upon the first one (see . The new browser window is then stacked upon the first one (see 
also the section also the section Move Documents in the WorkspaceMove Documents in the Workspace).).

COLORCOLOR--TAGGING ENTRIESTAGGING ENTRIES  

Except for symbols and properties, you can colorExcept for symbols and properties, you can color--tag entries in the tag entries in the ToolboxToolbox. Color. Color--tagged entries will appear on top of the list, tagged entries will appear on top of the list, 
sorted by the three colors yellow, red, and blue.sorted by the three colors yellow, red, and blue.  
  
To assign a color tag, rightTo assign a color tag, right--click on an entry and select click on an entry and select Yellow TagYellow TagYellow TagYellow Tag (red, blue) from the context menu.  (red, blue) from the context menu.   
  
To remove the tag again, click on To remove the tag again, click on No TagNo TagNo TagNo Tag..  
  
If a colorIf a color--tagged indicator or strategy also has a Short Code set, this item will be displayed in the Toolbar in the tagged indicator or strategy also has a Short Code set, this item will be displayed in the Toolbar in the Home > FavoritesHome > Favorites  
group. Options to configure this feature can be found in the options under group. Options to configure this feature can be found in the options under File > Options > Advanced > Indicators & StrategiesFile > Options > Advanced > Indicators & Strategies..    
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KEYBOARD SHORTCUTS 
Many functions in Tradesignal can be called up by using keyboard shortcuts. You can find a complete list of all shortcuts in the Many functions in Tradesignal can be called up by using keyboard shortcuts. You can find a complete list of all shortcuts in the 
following tables.following tables.

GENERAL APPLICATIONGENERAL APPLICATION  

NAVIGATION IN THE CHARTNAVIGATION IN THE CHART  

DescriptionDescriptionDescriptionDescription Keyboard ShortcutKeyboard ShortcutKeyboard ShortcutKeyboard Shortcut
HelpHelp F1F1
Jump to Command LineJump to Command Line F2F2
Start Symbol SearchStart Symbol Search F3F3
Start Print PreviewStart Print Preview Ctrl + PCtrl + P
Open / Close the toolbarOpen / Close the toolbar Ctrl + F1Ctrl + F1
Open / Close the property inspector in the toolboxOpen / Close the property inspector in the toolbox Ctrl + F2Ctrl + F2
Delete text, documents, or elements in documentsDelete text, documents, or elements in documents DelDel

DescriptionDescriptionDescriptionDescription Keyboard ShortcutKeyboard ShortcutKeyboard ShortcutKeyboard Shortcut
Move up price axisMove up price axis Arrow upArrow up
Move down price axisMove down price axis Arrow downArrow down
Move time axis to the rightMove time axis to the right Arrow to the rightArrow to the right
Move time axis to the leftMove time axis to the left Arrow to the leftArrow to the left
Zoom in price axisZoom in price axis Shift + Arrow upShift + Arrow up
Zoom out price axisZoom out price axis Shift + Arrow downShift + Arrow down
Zoom out time axisZoom out time axis Shift + Arrow to the rightShift + Arrow to the right
Zoom in time axisZoom in time axis Shift + Arrow to the leftShift + Arrow to the left
Page up price axisPage up price axis Ctrl + Arrow upCtrl + Arrow up
Page down price axisPage down price axis Ctrl + Arrow downCtrl + Arrow down
Page time axis to the rightPage time axis to the right Ctrl + Arrow to the rightCtrl + Arrow to the right
Page time axis to the leftPage time axis to the left Ctrl + Arrow to the leftCtrl + Arrow to the left
Toggle between subchartsToggle between subcharts Page upPage up
Toggle between subchartsToggle between subcharts Page downPage down
Jump to the beginning of the chartJump to the beginning of the chart Pos1Pos1
Jump to the end of the chartJump to the end of the chart EndEnd
Magnetic mode for drawing toolsMagnetic mode for drawing tools F6F6
Show standard time spanShow standard time span F8F8
Show complete time spanShow complete time span Ctrl + F8Ctrl + F8
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WORKSPACESWORKSPACES  

CLIPBOARDCLIPBOARD  

PROGRAMMING AND DEBUGGINGPROGRAMMING AND DEBUGGING  

DescriptionDescriptionDescriptionDescription Keyboard ShortcutKeyboard ShortcutKeyboard ShortcutKeyboard Shortcut
Arrange workspacesArrange workspaces F9F9
Go to previous workspaceGo to previous workspace Ctrl + QCtrl + Q
Go to next workspaceGo to next workspace Ctrl + WCtrl + W
Toggle between full view (maximized) and normal viewToggle between full view (maximized) and normal view F4F4
Reload data (like chart, scanner, browser)Reload data (like chart, scanner, browser) F5F5
Reload data in all workspace elementsReload data in all workspace elements Ctrl + F5Ctrl + F5
Go to next workspace elementGo to next workspace element Ctrl + TabCtrl + Tab
Go to previous workspace elementGo to previous workspace element Ctrl + Shift + TabCtrl + Shift + Tab
Open new workspaceOpen new workspace Ctrl + NCtrl + N
Create new Equilla strategyCreate new Equilla strategy Ctrl + Shift + N, SCtrl + Shift + N, S
Create new Equilla indicatorCreate new Equilla indicator Ctrl + Shift + N, ICtrl + Shift + N, I
Create new Equilla functionCreate new Equilla function Ctrl + Shift + N, FCtrl + Shift + N, F
Open dialog for opening workspaces or packagesOpen dialog for opening workspaces or packages Ctrl + OCtrl + O
Save workspaceSave workspace Ctrl + SCtrl + S
Close active workspace elementClose active workspace element Ctrl + F4Ctrl + F4
Close active workspaceClose active workspace Ctrl + Shift + F4Ctrl + Shift + F4

DescriptionDescriptionDescriptionDescription Keyboard ShortcutKeyboard ShortcutKeyboard ShortcutKeyboard Shortcut
Select all (for text, Equilla code, tables)Select all (for text, Equilla code, tables) Ctrl + ACtrl + A
Copy selected document, text, Equilla code or table elementCopy selected document, text, Equilla code or table element Ctrl + CCtrl + C
Cut selected document, text, Equilla code or table elementCut selected document, text, Equilla code or table element Ctrl + XCtrl + X
Insert clipboard contents into active documentInsert clipboard contents into active document Ctrl + VCtrl + V
Repeat last clipboard actionRepeat last clipboard action Ctrl + YCtrl + Y
Undo last clipboard actionUndo last clipboard action Ctrl + ZCtrl + Z

DescriptionDescriptionDescriptionDescription Keyboard ShortcutKeyboard ShortcutKeyboard ShortcutKeyboard Shortcut
Compile Equilla codeCompile Equilla code F7F7
Toggle comments for the selected codeToggle comments for the selected code Ctrl + K, CCtrl + K, C
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Search for textSearch for text Ctrl + FCtrl + F
Search and replace textSearch and replace text Ctrl + HCtrl + H
Jump to a specific line numberJump to a specific line number Ctrl + GCtrl + G
Pause the debuggerPause the debugger PausePause
Continue executionContinue execution F5F5
Restart executionRestart execution Ctrl + Shift + F5Ctrl + Shift + F5
Step overStep over F10F10
Step inStep in F11F11
Step outStep out Shift + F11Shift + F11
Quick watchQuick watch Shift + F9Shift + F9
Toggle breakpointToggle breakpoint F9F9
Enable/disable breakpointEnable/disable breakpoint Ctrl + F9Ctrl + F9
Open related functionOpen related function F12F12
Save indicators, trading systems or Equilla functionsSave indicators, trading systems or Equilla functions Ctrl + Shift + SCtrl + Shift + S
Show all available functionsShow all available functions Ctrl + SpaceCtrl + Space
Show all available variables for a functionShow all available variables for a function Ctrl + Shift + SpaceCtrl + Shift + Space
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SYMBOL SEARCH 
The symbol search is a useful tool to keep an overview of all the securities available on markets around the world. You can use the The symbol search is a useful tool to keep an overview of all the securities available on markets around the world. You can use the 
sophisticated Tradesignal symbol search for the following:sophisticated Tradesignal symbol search for the following:

l Searching for unknown symbolsSearching for unknown symbols  
l Assembling symbol lists with securities of similar categoriesAssembling symbol lists with securities of similar categories  

START THE SYMBOL SEARCHSTART THE SYMBOL SEARCH  

There are several ways to start the symbol search:There are several ways to start the symbol search:

l Click the Click the SearchSearchSearchSearch button in the toolbar. button in the toolbar.  
l Press the key Press the key F3F3F3F3..  
l Open the context menu of a symbol list and select the entry Open the context menu of a symbol list and select the entry New New New New 

SymbolSymbolSymbolSymbol, then the option , then the option Standard SymbolStandard SymbolStandard SymbolStandard Symbol..  
l In the toolbox, start a In the toolbox, start a New Symbol ListNew Symbol ListNew Symbol ListNew Symbol List, select the option , select the option UserUserUserUser----

defined Symbol Listdefined Symbol Listdefined Symbol Listdefined Symbol List and click the  and click the AddAddAddAdd button in the next window. button in the next window.  

A search window opens in which you can further define your search terms. A search window opens in which you can further define your search terms. 
Please note that the available search options depend on the used data Please note that the available search options depend on the used data 
provider.provider.

MARKET AND EXCHANGEMARKET AND EXCHANGE  

By selecting a specific market sector, you can limit the search and result list, for example to avoid finding Wheat Future when you By selecting a specific market sector, you can limit the search and result list, for example to avoid finding Wheat Future when you 
are actually searching for a bond starting with "WHE". are actually searching for a bond starting with "WHE".   
  
All market sectors like bonds, call options, futures, certificates etc. are available. The standard setting is All market sectors like bonds, call options, futures, certificates etc. are available. The standard setting is All Market SectorsAll Market SectorsAll Market SectorsAll Market Sectors..  
  
In the In the ExchangeExchangeExchangeExchange list you can find all exchanges offered by your data provider. list you can find all exchanges offered by your data provider.

SEARCH A NAME OR SYMBOLSEARCH A NAME OR SYMBOL  

Here you can limit the search scope further. Enter the (first) letters of the name or symbol. You can search for the following options Here you can limit the search scope further. Enter the (first) letters of the name or symbol. You can search for the following options 
(to the right of the entry field):(to the right of the entry field):  
  
All FieldsAll FieldsAll FieldsAll Fields  -- Search all fields (default setting). Search all fields (default setting).  
  
Only NameOnly NameOnly NameOnly Name  -- Search by security name. Example: For "WHE", "Anywhere MD" might be found, although its symbol is "ANWM  Search by security name. Example: For "WHE", "Anywhere MD" might be found, although its symbol is "ANWM 
PNK".PNK".  
  
Only SymbolOnly SymbolOnly SymbolOnly Symbol  -- Search by symbol. Example: For "WHE", "WHE GER" might be found, although the security name is "Pacific Textil  Search by symbol. Example: For "WHE", "WHE GER" might be found, although the security name is "Pacific Textil 
Holdings".Holdings".  
  

Symbol SearchSymbol Search



:: www.tradesignal.comwww.tradesignal.com

Tradesignal GmbHTradesignal GmbH Page 45Page 45 Version 7.0Version 7.0

  
Only ISINOnly ISINOnly ISINOnly ISIN  -- Search by ISIN (International Securities Identification Number). Search by ISIN (International Securities Identification Number).

USE THE SEARCH RESULTSUSE THE SEARCH RESULTS  

USE THE SEARCH RESULT DIRECTLYUSE THE SEARCH RESULT DIRECTLY  

When you start the search with the When you start the search with the SearchSearchSearchSearch button in the toolbar or by  button in the toolbar or by 
pressing pressing F3F3F3F3, you can only select a single symbol. You have the choice of , you can only select a single symbol. You have the choice of 
actions to perform with the security.actions to perform with the security.  
  
You can open the following new documents: You can open the following new documents: ChartChart, , Market DepthMarket Depth, , ScannerScanner, , 
WatchlistWatchlist, , PortfolioPortfolio, , Market ProfileMarket Profile..  
  
Alternatively, you can insert the symbol into the selected element of the Alternatively, you can insert the symbol into the selected element of the 
workspace, e.g. a chart. This can be done in the following four ways:workspace, e.g. a chart. This can be done in the following four ways:  
  
Insert the symbol into the selected workspace itemInsert the symbol into the selected workspace itemInsert the symbol into the selected workspace itemInsert the symbol into the selected workspace item  -- Select this to  Select this to 
add the found item as a second symbol in a chart, for example.add the found item as a second symbol in a chart, for example.    
  
Insert the symbol into the selected workspace item with a new date Insert the symbol into the selected workspace item with a new date Insert the symbol into the selected workspace item with a new date Insert the symbol into the selected workspace item with a new date 
scalescalescalescale  -- Select this to add the new symbol, for example as a subchart with its own date scale. Select this to add the new symbol, for example as a subchart with its own date scale.  
  
Replace the symbol in the selected workspace itemReplace the symbol in the selected workspace itemReplace the symbol in the selected workspace itemReplace the symbol in the selected workspace item  -- Select this to substitute the new symbol for the original symbol.  Select this to substitute the new symbol for the original symbol.   
  
Replace all symbols in the selected workspace itemReplace all symbols in the selected workspace itemReplace all symbols in the selected workspace itemReplace all symbols in the selected workspace item  -- Select this to substitute the new symbol for the original symbols, for  Select this to substitute the new symbol for the original symbols, for 
example in several charts.example in several charts.

ADD SEARCH RESULTS TO A SYMBOL LISTADD SEARCH RESULTS TO A SYMBOL LIST  

If you search via the If you search via the Add New Symbol ListAdd New Symbol ListAdd New Symbol ListAdd New Symbol List link and the option  link and the option UserUserUserUser----
Defined Symbol ListDefined Symbol ListDefined Symbol ListDefined Symbol List, you can add more than one symbol. , you can add more than one symbol.   
  
If you fill a new symbol list, you have to enter a name for it.If you fill a new symbol list, you have to enter a name for it.

l Click the Click the AddAddAddAdd button to add the current result to the symbol list  button to add the current result to the symbol list 
without closing the search window.without closing the search window.  

l Click the Click the CloseCloseCloseClose button to end the search. The new symbols are  button to end the search. The new symbols are 
displayed in the symbol list.displayed in the symbol list.  

If you set up a new list, confirm the selection with If you set up a new list, confirm the selection with DoneDoneDoneDone..

EXAMPLE: SET UP A NEW LIST WITH OIL BONDSEXAMPLE: SET UP A NEW LIST WITH OIL BONDS  

Symbol ActionsSymbol Actions

Adding several symbols to a listAdding several symbols to a list
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1.1. Start a new symbol list by clicking on Start a new symbol list by clicking on New Symbol ListNew Symbol ListNew Symbol ListNew Symbol List in the  in the Related TaskRelated Task area. area.  
2.2. Choose the option Choose the option UserUserUserUser----defined Symbol Listdefined Symbol Listdefined Symbol Listdefined Symbol List. A new dialog opens.. A new dialog opens.  
3.3. Enter the name Enter the name Oil SecuritiesOil Securities..  
4.4. Click the Click the AddAddAddAdd button to start the symbol search. button to start the symbol search.  
5.5. Search securities with the name part "Oil".Search securities with the name part "Oil".  
6.6. Select the top symbols from the list by keeping the Shift key pressed while clicking, and confirm with Select the top symbols from the list by keeping the Shift key pressed while clicking, and confirm with CloseCloseCloseClose..  

The program returns to the list in the Symbol List wizard. Click The program returns to the list in the Symbol List wizard. Click DoneDoneDoneDone  to finish. In the symbol list manager, you can now find the to finish. In the symbol list manager, you can now find the 
new list "Oil Securities".new list "Oil Securities".    
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SYMBOL LISTS 
Symbol lists include the symbols and names of tradedSymbol lists include the symbols and names of traded securities. A symbol  securities. A symbol 
list corresponds to a category, a branch or index or is assembled by the list corresponds to a category, a branch or index or is assembled by the 
trader. You can use the symbol lists for the following: trader. You can use the symbol lists for the following: 

l As an "extended memory" for a high number of symbolsAs an "extended memory" for a high number of symbols  
l Sorting symbols according to branches, countries or other criteriaSorting symbols according to branches, countries or other criteria  
l As a basis for Charts, Scanners and other documentsAs a basis for Charts, Scanners and other documents  
l For filing symbols from the For filing symbols from the ScannerScanner or  or Symbol SearchSymbol Search  
l For filing formulas or other calculations with which to generate For filing formulas or other calculations with which to generate 

chartscharts  

Tradesignal offers a symbol list manager in which you can administrate Tradesignal offers a symbol list manager in which you can administrate 
and sort a large number of lists. You can find it in the toolbox under the and sort a large number of lists. You can find it in the toolbox under the 
button button Symbol ListSymbol ListSymbol ListSymbol List..  
  
Since single symbols are always managed as part of a symbol list, the Since single symbols are always managed as part of a symbol list, the 
special functions for those are also described in this chapter. special functions for those are also described in this chapter. 

START A NEW SYMBOL LISTSTART A NEW SYMBOL LIST  

When starting Tradesignal for the very first time, you are asked if you want to receive lists from your data provider. If you confirm When starting Tradesignal for the very first time, you are asked if you want to receive lists from your data provider. If you confirm 
this, you will use the Symbol List wizard for the first time. However, you can start the wizard any time to create a new list. this, you will use the Symbol List wizard for the first time. However, you can start the wizard any time to create a new list. 

1.1. In the toolbox, click the In the toolbox, click the Symbol ListsSymbol ListsSymbol ListsSymbol Lists button. button.  
2.2. In the In the Related TaskRelated Task area, click on  area, click on New Symbol ListNew Symbol ListNew Symbol ListNew Symbol List..  

The Symbol List wizard opens. Three options are available:The Symbol List wizard opens. Three options are available:

l Predefined Symbol List from Your Data ProviderPredefined Symbol List from Your Data ProviderPredefined Symbol List from Your Data ProviderPredefined Symbol List from Your Data Provider  -- Receive  Receive 
standard lists, for example NASDAQ indexes.standard lists, for example NASDAQ indexes.  

l UserUserUserUser----defined Symbol Listdefined Symbol Listdefined Symbol Listdefined Symbol List  -- Start a new, empty symbol list to  Start a new, empty symbol list to 
which you can add symbols or symbol lists, see below.which you can add symbols or symbol lists, see below.  

l Import Symbol List from FileImport Symbol List from FileImport Symbol List from FileImport Symbol List from File  -- Import a symbol list from a file in  Import a symbol list from a file in 
CSV format (comma separated value) or XML format. The expected CSV format (comma separated value) or XML format. The expected 
separators for CSV in Tradesignal are a comma or semicolon. One separators for CSV in Tradesignal are a comma or semicolon. One 
way to create files in such a format is to save your data in Excel as way to create files in such a format is to save your data in Excel as 
CSV text file or use CSV text file or use exportexportexportexport on a symbol list. on a symbol list.  

MANAGE SYMBOLS AND SYMBOL LISTSMANAGE SYMBOLS AND SYMBOL LISTS  

EDIT VIA THE CONTEXT MENUEDIT VIA THE CONTEXT MENU  

Symbol ListsSymbol Lists

Symbol List WizardSymbol List Wizard
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You can manage Symbols and Symbol Lists with the functions offered in the context menus.You can manage Symbols and Symbol Lists with the functions offered in the context menus.

l OpenOpenOpenOpen single symbols in a  single symbols in a ChartChart, , ScannerScanner, , PortfolioPortfolio, , WatchlistWatchlist, , Market DepthMarket Depth, , Market ProfileMarket Profile or  or NewsNews..  

l OpenOpenOpenOpen a symbol list in a  a symbol list in a ScannerScanner, , WatchlistWatchlist or  or PortfolioPortfolio..  

l You can You can openopenopenopen a symbol from a list in an  a symbol from a list in an editoreditor as long as it is a composite symbol. as long as it is a composite symbol.  

l You can You can addaddaddadd a new symbol to your existing list. a new symbol to your existing list.  

l A symbol list can be A symbol list can be refreshedrefreshedrefreshedrefreshed. This option is only available for predefined symbol lists from the data provider. Tradesignal . This option is only available for predefined symbol lists from the data provider. Tradesignal 
will update changes of the predefined lists after restart of the application, unless you do a manual refresh.will update changes of the predefined lists after restart of the application, unless you do a manual refresh.  

l You can You can renamerenamerenamerename a symbol or symbol list. a symbol or symbol list.  

l You can You can deletedeletedeletedelete a symbol or symbol list from the list. a symbol or symbol list from the list.  

l You can You can duplicateduplicateduplicateduplicate a list. A one a list. A one--toto--one copy will be created, which can be modified and renamed.one copy will be created, which can be modified and renamed.  

l You can You can printprintprintprint a symbol or symbol list. With this function, all information for each symbol is printed. This can take a while if  a symbol or symbol list. With this function, all information for each symbol is printed. This can take a while if 
you print a long list of symbols. For more information, see the chapter you print a long list of symbols. For more information, see the chapter PublishingPublishing..  

l Select Select OptimizeOptimizeOptimizeOptimize to start the optimizer for the symbol or symbol list. This starts the  to start the optimizer for the symbol or symbol list. This starts the OptimizerOptimizer. In the case of a symbol list, . In the case of a symbol list, 
all symbols included in the list will be optimized. The results will be displayed in a table, sorted by total net profit.all symbols included in the list will be optimized. The results will be displayed in a table, sorted by total net profit.  

l You can also You can also sortsortsortsort a symbol list, see the section  a symbol list, see the section Sort Symbol ListsSort Symbol Lists..  

l You can You can exportexportexportexport a symbol list in either CSV or XML format. The XML format supports all symbol types, whereas CSV only  a symbol list in either CSV or XML format. The XML format supports all symbol types, whereas CSV only 
supports standard symbols.supports standard symbols.  

l You can You can Allow Forward CurvesAllow Forward CurvesAllow Forward CurvesAllow Forward Curves for a user for a user--defined symbol list to be able to create a defined symbol list to be able to create a Forward CurveForward Curve from it. from it.  

ADD A SYMBOL TO A SYMBOL LISTADD A SYMBOL TO A SYMBOL LIST  

Single symbols are always managed in symbol lists. To add a new symbol, open the context menu of a symbol list and select Single symbols are always managed in symbol lists. To add a new symbol, open the context menu of a symbol list and select New New New New 
SymbolSymbolSymbolSymbol. The New Symbol wizard opens.. The New Symbol wizard opens.You can choose between the following options:You can choose between the following options:

l A standard symbol (from the data provider)A standard symbol (from the data provider)A standard symbol (from the data provider)A standard symbol (from the data provider)  -- This corresponds  This corresponds 
to the to the Symbol SearchSymbol Search and is the standard way to add a symbol. and is the standard way to add a symbol.  

l A composite symbol calculated from a formulaA composite symbol calculated from a formulaA composite symbol calculated from a formulaA composite symbol calculated from a formula  -- This way you  This way you 
can add a formula, which refers to other securities,can add a formula, which refers to other securities, as a symbol  as a symbol 
itself. You can find more information below in the section itself. You can find more information below in the section Create Create 
Composite SymbolsComposite Symbols..  

l A userA userA userA user----defined continuationdefined continuationdefined continuationdefined continuation  -- Here you can set up continuations  Here you can set up continuations 
for futures. You can also add symbols to symbol lists by dragging for futures. You can also add symbols to symbol lists by dragging 
symbols into them from other lists. For more information see the symbols into them from other lists. For more information see the 
chapter chapter Continuous ContractsContinuous Contracts..  

l A combined symbol created from multiple standard symbolsA combined symbol created from multiple standard symbolsA combined symbol created from multiple standard symbolsA combined symbol created from multiple standard symbols  

New Symbol WizardNew Symbol Wizard
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This option allows you to create a combination of standard symbols, e.g. the same security traded on multiple exchanges. This option allows you to create a combination of standard symbols, e.g. the same security traded on multiple exchanges. 
For more information see sectionFor more information see section  Create Combined SymbolsCreate Combined Symbols..  

DRAG AND DROP SYMBOLSDRAG AND DROP SYMBOLS  

l You can move single symbols into another symbol list by Drag&Drop.You can move single symbols into another symbol list by Drag&Drop.  

l You can drag a symbol into a document in the workspace, for example to add the symbol to a Scanner table.You can drag a symbol into a document in the workspace, for example to add the symbol to a Scanner table.  

l Drag a symbol into an existing chart to create a subchart or drag a symbol while holding CTRL to replace the chart.Drag a symbol into an existing chart to create a subchart or drag a symbol while holding CTRL to replace the chart.  

l You can also go the other way round and drag a symbol from an open document (like a Chart, Scanner, Watchlist or You can also go the other way round and drag a symbol from an open document (like a Chart, Scanner, Watchlist or 
Portfolio) into a symbol list.Portfolio) into a symbol list. To do this, click into the chart legend or  To do this, click into the chart legend or -- in case of tables  in case of tables -- click into a table cell until a plus  click into a table cell until a plus 
symbol and a rectangle appear under the mouse cursor. Then drag the symbol into the symbol list.symbol and a rectangle appear under the mouse cursor. Then drag the symbol into the symbol list.  

l If you drag a symbol to an open editor, its symbol shortcut will be inserted enclosed in single quotes. This can be used for If you drag a symbol to an open editor, its symbol shortcut will be inserted enclosed in single quotes. This can be used for 
Equilla inline instrumentsEquilla inline instruments..  

DRAG AND DROP SYMBOL LISTSDRAG AND DROP SYMBOL LISTS  

l Symbol lists can be moved between folders. To do this, simply drag the list into the target folder.Symbol lists can be moved between folders. To do this, simply drag the list into the target folder.  

l Symbol lists can also be dragged into an open Scanner, Watchlist or Portfolio. They can also be dragged to an open Chart, Symbol lists can also be dragged into an open Scanner, Watchlist or Portfolio. They can also be dragged to an open Chart, 
this will open all contained symbols.this will open all contained symbols.  

l If you drag a symbol list to an open editor, its symbol list shortcut will be inserted in double quotes. This can be used for If you drag a symbol list to an open editor, its symbol list shortcut will be inserted in double quotes. This can be used for 
lists of lists of Equilla inline instrumentsEquilla inline instruments. For further details see the Equilla help in Tradesignal.. For further details see the Equilla help in Tradesignal.  

SET UP A SYMBOL LIST WITH SEVERAL SYMBOLSSET UP A SYMBOL LIST WITH SEVERAL SYMBOLS  

When creating a new symbol list, you can add symbols in the process.When creating a new symbol list, you can add symbols in the process.  

1.1. In the symbol list manager, click on the folder in which the new list should be created.In the symbol list manager, click on the folder in which the new list should be created.  
2.2. Select Select New Symbol ListNew Symbol ListNew Symbol ListNew Symbol List in the context menu of the folder. The Symbol List wizard opens. Enter a name for the list and click  in the context menu of the folder. The Symbol List wizard opens. Enter a name for the list and click 

the the AddAddAddAdd button to start the symbol search for finding and adding symbols. button to start the symbol search for finding and adding symbols.  

SORT SYMBOL LISTSSORT SYMBOL LISTS  
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You can sort a symbol list in two ways. Select the entry You can sort a symbol list in two ways. Select the entry Sort Symbol ListSort Symbol ListSort Symbol ListSort Symbol List  
in the context menu of a symbol list to start the Symbol List Sorting wizard.in the context menu of a symbol list to start the Symbol List Sorting wizard.  
  
Automatically sort the listAutomatically sort the listAutomatically sort the listAutomatically sort the list  -- Sort the list automatically using criteria  Sort the list automatically using criteria 
defined by you. The possible sorting criteria are defined by you. The possible sorting criteria are Ticker SymbolTicker SymbolTicker SymbolTicker Symbol (default)  (default) 
and and Instrument Display NameInstrument Display NameInstrument Display NameInstrument Display Name (full name of the symbol, displayed in  (full name of the symbol, displayed in 
brackets [ ] after the symbol). Set a sorting direction of brackets [ ] after the symbol). Set a sorting direction of ascendingascendingascendingascending (default)  (default) 
or or descendingdescendingdescendingdescending. .   
  
You can also choose the options You can also choose the options Sort numericallySort numericallySort numericallySort numerically if your securities  if your securities 
include numbers, and include numbers, and Ignore the case of itemsIgnore the case of itemsIgnore the case of itemsIgnore the case of items. Both options take longer . Both options take longer 
for sorting.for sorting.  
  
Manually sort the listManually sort the listManually sort the listManually sort the list  -- Select this to sort the list manually. A dialog opens in which you can select symbols and change their  Select this to sort the list manually. A dialog opens in which you can select symbols and change their 
position in the list by clicking the position in the list by clicking the Move up/Move DownMove up/Move DownMove up/Move DownMove up/Move Down buttons. When finished sorting, click  buttons. When finished sorting, click DoneDoneDoneDone..  
  
A changed order only affects the current symbol list, not all.A changed order only affects the current symbol list, not all.

CREATE NEW GROUPSCREATE NEW GROUPS  

When you are handling many different symbol lists, it may be useful to structure them further. To do so, create new groups. Click When you are handling many different symbol lists, it may be useful to structure them further. To do so, create new groups. Click 
on on New GroupNew GroupNew GroupNew Group in the  in the Related TaskRelated Task area. area.

CREATE COMPOSITE SYMBOLSCREATE COMPOSITE SYMBOLS  

Composite instruments are artificial instruments, calculated from Equilla Composite instruments are artificial instruments, calculated from Equilla 
formulas which refer to other symbols. You can save composite instruments formulas which refer to other symbols. You can save composite instruments 
as symbols if the relevant references to symbols and their prices are as symbols if the relevant references to symbols and their prices are 
included in the formulas.included in the formulas.  

l For a simple composite instrument, a formula can be entered directly For a simple composite instrument, a formula can be entered directly 
into the command line to create a new chart.into the command line to create a new chart.  

l To create a more complex composite instrument, choose To create a more complex composite instrument, choose New New New New 
SymbolSymbolSymbolSymbol in the context menu of a symbol list and select  in the context menu of a symbol list and select A A A A 
composite symbol calculated from a formulacomposite symbol calculated from a formulacomposite symbol calculated from a formulacomposite symbol calculated from a formula. Enter the Equilla . Enter the Equilla 
code and a name. The new composite symbol is added to the code and a name. The new composite symbol is added to the 
current symbol list.current symbol list.  

In Tradesignal you can use the symbol picker to quickly add a symbol to the formula as an In Tradesignal you can use the symbol picker to quickly add a symbol to the formula as an inline instrumentinline instrument..

EXAMPLE FOR A SIMPLE COMPOSITE INSTRUMENTEXAMPLE FOR A SIMPLE COMPOSITE INSTRUMENT  

We want to calculate the difference between the open and close of each trading period. The Equilla code for this isWe want to calculate the difference between the open and close of each trading period. The Equilla code for this is  

Symbol List Sorting WizardSymbol List Sorting Wizard

Create a "Composite Instrument" in a symbol listCreate a "Composite Instrument" in a symbol list
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Open ­ Close 

Since we want to save the formula as a composite symbol in a symbol list, references to a security have to be included in the Since we want to save the formula as a composite symbol in a symbol list, references to a security have to be included in the 
formula, for example .DJI (Dow Jones Industrial). The resulting code isformula, for example .DJI (Dow Jones Industrial). The resulting code is  

Open .dji ­ Close .dji 

Enter this formula in the Enter this formula in the Command LineCommand Line and select the option  and select the option New Formula ChartNew Formula ChartNew Formula ChartNew Formula Chart in the drop in the drop--down menu. The formula is down menu. The formula is 
instantly calculated and ready for use. Save the formula as a symbol by dragging its name from the chart legend into a symbol list.instantly calculated and ready for use. Save the formula as a symbol by dragging its name from the chart legend into a symbol list.

EXAMPLE FOR A MORE COMPLEX COMPOSITE INSTRUMENTEXAMPLE FOR A MORE COMPLEX COMPOSITE INSTRUMENT  

The following code would result in a composite instrument that includes the spread between the Intel symbol and the Dow Jones The following code would result in a composite instrument that includes the spread between the Intel symbol and the Dow Jones 
Industry index.Industry index.  
  

Variables: openRatio, closeRatio; 

 

openRatio = Open of 'intc nas' / Open of '.dji'; 

closeRatio = Close of 'intc nas' / Close of '.dji'; 

 

DrawForest( openRatio, closeRatio ); 

Copy this code into the editor window of a composite instrument, enter a name, and generate the symbol. Afterwards you can Copy this code into the editor window of a composite instrument, enter a name, and generate the symbol. Afterwards you can 
display the spread by calling up the composite symbol.display the spread by calling up the composite symbol.

CREATE COMBINED SYMBOLSCREATE COMBINED SYMBOLS  
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Combined symbols are synthetic instruments created by combining the Combined symbols are synthetic instruments created by combining the 
input values of an ordered list of standard symbols and cumulated to a input values of an ordered list of standard symbols and cumulated to a 
target period from a specified base period. target period from a specified base period.   
  
A combined symbol is very useful when you have a similar product traded A combined symbol is very useful when you have a similar product traded 
at multiple different sources (e.g. Forex and Commodity Brokers) and you at multiple different sources (e.g. Forex and Commodity Brokers) and you 
would like a combined view of the whole market for that product.would like a combined view of the whole market for that product.  
  
When a combined symbol is created, a base period must be specified, the When a combined symbol is created, a base period must be specified, the 
data from this base period for each of the component symbols will be data from this base period for each of the component symbols will be 
combined to make the new instrument. Obviously, for periods other than combined to make the new instrument. Obviously, for periods other than 
tick there is likely to be some overlapping of data; in this case the values tick there is likely to be some overlapping of data; in this case the values 
from the component symbol that is specified earlier in the list will be used.from the component symbol that is specified earlier in the list will be used.  
  
It is recommended to only use tick as a base period when absolutely It is recommended to only use tick as a base period when absolutely 
necessary. The calculation time of the composite will be excessively long necessary. The calculation time of the composite will be excessively long 
and it is unlikely there will be a suitable quantity of tick data to create a and it is unlikely there will be a suitable quantity of tick data to create a 
daily chart of reasonable length.daily chart of reasonable length.    

Create a combined symbol dialogCreate a combined symbol dialog



:: www.tradesignal.comwww.tradesignal.com

Tradesignal GmbHTradesignal GmbH Page 53Page 53 Version 7.0Version 7.0

SCANNER 
A Scanner (also sometimes called screener) is used for searching large A Scanner (also sometimes called screener) is used for searching large 
symbol lists according to defined criteria. You can use the Tradesignal symbol lists according to defined criteria. You can use the Tradesignal 
Scanner for: Scanner for: 

l Searching certain indicator constellations in symbol listsSearching certain indicator constellations in symbol lists  
l Searching for chart patterns in symbol listsSearching for chart patterns in symbol lists  
l Searching for technical analysis patterns in price listsSearching for technical analysis patterns in price lists  
l Backtest of trading systems for several symbolsBacktest of trading systems for several symbols  
l Obtaining statistical data like annual high in price listsObtaining statistical data like annual high in price lists  
l Optimizing trading systems based on a group of symbolsOptimizing trading systems based on a group of symbols  

The easiest application, for example, is using the Scanner to search a The easiest application, for example, is using the Scanner to search a 
certain constellation of indicators. Use a relative strength indicator (RSI) > certain constellation of indicators. Use a relative strength indicator (RSI) > 
70 to find the strongest symbols in a list. 70 to find the strongest symbols in a list.   
  
The document type scanner has the following design parameters:The document type scanner has the following design parameters:

l The maximum history length is 5000.The maximum history length is 5000.  
l The maximum number of instruments is 5001.The maximum number of instruments is 5001.  
l The maximum number of indicators/strategies is 32.The maximum number of indicators/strategies is 32.  
l Indicators and strategies are processed sequentially, i.e. they are applied in the given sequence to each instrument, before Indicators and strategies are processed sequentially, i.e. they are applied in the given sequence to each instrument, before 

the next instrument is processed.the next instrument is processed.  

USING THE SCANNERUSING THE SCANNER  

You can fill the Scanner with symbols in various ways.You can fill the Scanner with symbols in various ways.

WITH THE WIZARDWITH THE WIZARD  

When choosing one of the following methods, the wizard will open: When choosing one of the following methods, the wizard will open: 

l Click on the Click on the ScannerScannerScannerScanner button in the  button in the InsertInsert tab of the toolbar. tab of the toolbar.  
l In the file menu, select In the file menu, select NewNewNewNew (key shortcut  (key shortcut Ctrl+Shift+NCtrl+Shift+NCtrl+Shift+NCtrl+Shift+N) to open the Create Item Wizard. Select ) to open the Create Item Wizard. Select Market ScannerMarket ScannerMarket ScannerMarket Scanner..  
l Open the context menu of a symbol list in the toolbox and choose the entry Open the context menu of a symbol list in the toolbox and choose the entry Open in Market ScannerOpen in Market ScannerOpen in Market ScannerOpen in Market Scanner. (If selecting this for . (If selecting this for 

a single symbol, it opens without a wizard.)a single symbol, it opens without a wizard.)  

The Create Item wizard opens, in which you can select indicators and strategies in two more steps. Click on The Create Item wizard opens, in which you can select indicators and strategies in two more steps. Click on DoneDoneDoneDone to close the  to close the 
wizard and save the settings. wizard and save the settings. 

ADDING ONE OR MORE SYMBOLS MANUALLYADDING ONE OR MORE SYMBOLS MANUALLY  

You can also add single symbols or open a new market scanner without using the wizard. You can also add single symbols or open a new market scanner without using the wizard. 

l Open the context menu of a symbol or symbol list in the toolbox and choose the entry Open the context menu of a symbol or symbol list in the toolbox and choose the entry Insert SymbolInsert SymbolInsert SymbolInsert Symbol to add it to the active  to add it to the active 

ScannerScanner
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market scanner.market scanner.  
l In the command line, enter a symbol shortcut, e.g. "DD NYS" and select In the command line, enter a symbol shortcut, e.g. "DD NYS" and select Add SymbolAdd SymbolAdd SymbolAdd Symbol to add it to a scanner, or  to add it to a scanner, or New New New New 

Market ScannerMarket ScannerMarket ScannerMarket Scanner for a new one. for a new one.  
l Via the symbol search. For this, click on the Via the symbol search. For this, click on the searchsearch button and select  button and select Insert the symbol into the selected workspace Insert the symbol into the selected workspace Insert the symbol into the selected workspace Insert the symbol into the selected workspace 

itemitemitemitem to add it to the scanner, or  to add it to the scanner, or Create a new Market ScannerCreate a new Market ScannerCreate a new Market ScannerCreate a new Market Scanner for a new one. for a new one.  
l You can also add symbols to a scanner via drag&drop from the toolbox or other documents.You can also add symbols to a scanner via drag&drop from the toolbox or other documents.  

The The History LengthHistory LengthHistory LengthHistory Length (candles/bars) that is regularly taken into account is 2. When you add an indicator, the length may be  (candles/bars) that is regularly taken into account is 2. When you add an indicator, the length may be 
increased if necessary for the indicator calculation. E.g., the Chande Momentum Oscillator sets the length to 16. If you go below increased if necessary for the indicator calculation. E.g., the Chande Momentum Oscillator sets the length to 16. If you go below 
this necessary length, indicators may not give results anymore. In this case, increase the length again. this necessary length, indicators may not give results anymore. In this case, increase the length again.   
  
When you select a symbol list (e.g. the Nasdaq), please ensure that the index itself is not included in the Scanner. It makes no When you select a symbol list (e.g. the Nasdaq), please ensure that the index itself is not included in the Scanner. It makes no 
sense to include an index in a list of symbols when scanning for optimal trading parameters. (It is different if you trade in sense to include an index in a list of symbols when scanning for optimal trading parameters. (It is different if you trade in 
certificates and the scanner is filled with index values.)certificates and the scanner is filled with index values.)

SCANNER PROPERTIESSCANNER PROPERTIES  

In the properties manager, you can edit the scanner properties. Important parameters are:In the properties manager, you can edit the scanner properties. Important parameters are:  
  
History LengthHistory LengthHistory LengthHistory Length  -- Enter the length of the history here (max. 5000). Enter the length of the history here (max. 5000).  
  
Min. Referenced BarsMin. Referenced BarsMin. Referenced BarsMin. Referenced Bars  -- Enter the minimum number of bars that should be used for calculating the values of indicators and  Enter the minimum number of bars that should be used for calculating the values of indicators and 
strategies.strategies.

SAVING, RESTORING AND RESETTING DEFAULT SETTINGSSAVING, RESTORING AND RESETTING DEFAULT SETTINGS  

In the appearance area, you can find two important buttons. In the appearance area, you can find two important buttons. 

l Disk button (Save as Default) Disk button (Save as Default) -- Click here to save your current settings as the new default settings. Click here to save your current settings as the new default settings.  
l Restore button (Restore Default Settings, circled arrow) Restore button (Restore Default Settings, circled arrow) -- Click here to reset all settings to the default settings. Click here to reset all settings to the default settings.  

Not all settings can be saved like this. E.g., the standard period and other user interface settings are entered in the Not all settings can be saved like this. E.g., the standard period and other user interface settings are entered in the Tradesignal Tradesignal 
OptionsOptions..  
  
To restore the original default settings of your Tradesignal installation, click on the To restore the original default settings of your Tradesignal installation, click on the Restore Default SettingsRestore Default SettingsRestore Default SettingsRestore Default Settings button in the  button in the 
Tradesignal OptionsTradesignal Options..

DELETING SYMBOLS FROM A SCANNERDELETING SYMBOLS FROM A SCANNER  

You can delete symbols from a scanner.You can delete symbols from a scanner.  

1.1. Select the symbols. You have the following options:Select the symbols. You have the following options:

¡ Press Press Ctrl+ACtrl+ACtrl+ACtrl+A to select all. to select all.  
¡ Press Press CtrlCtrlCtrlCtrl and click on single instruments to select them. and click on single instruments to select them.  
¡ Press Press ShiftShiftShiftShift and click on two instruments to select the instruments between them.. and click on two instruments to select the instruments between them..  
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2.2. Press the Press the DelDelDelDel key to delete the selected instruments. key to delete the selected instruments.  

SCANNER BUTTONS IN THE TOOLBARSCANNER BUTTONS IN THE TOOLBAR  

Start ScanStart ScanStart ScanStart Scan  -- Start the Scanner. Start the Scanner.  
  
Stop ScanStop ScanStop ScanStop Scan  -- Stop the scanning process. All table fields filled at this point  Stop the scanning process. All table fields filled at this point 
are saved. are saved.   
  
PeriodPeriodPeriodPeriod  -- Here you can set the period that is to be used in the Scanner (this  Here you can set the period that is to be used in the Scanner (this 
corresponds to the period settings for a chart). The symbols in the Scanner corresponds to the period settings for a chart). The symbols in the Scanner 
are always called up with the default period at first. are always called up with the default period at first.   
  
ColumnsColumnsColumnsColumns  -- Open the menu for the column settings of the Scanner.  Open the menu for the column settings of the Scanner.   
  
Set GroupSet GroupSet GroupSet Group  -- Here you can group the parameters for better overview. Select a number of rows in the table and click on the button.  Here you can group the parameters for better overview. Select a number of rows in the table and click on the button. 
You can now enter a name for the group. A button appears on top of the table that allows you to open/close the group views like a You can now enter a name for the group. A button appears on top of the table that allows you to open/close the group views like a 
folder tree in Windows Explorer.folder tree in Windows Explorer.

COLUMNS IN THE SCANNERCOLUMNS IN THE SCANNER  

The table shows different columns depending on the indicators and strategies you are using. The number of columns added for The table shows different columns depending on the indicators and strategies you are using. The number of columns added for 
each indicator or strategy depends on the number of output data. each indicator or strategy depends on the number of output data. 

l For each indicator, all columns with a nonFor each indicator, all columns with a non--static output are displayed. For example, for the "Bollinger Band" indicator there static output are displayed. For example, for the "Bollinger Band" indicator there 
are three columns, for the "Elder Ray" indicator two columns (and two invisible columns with static values).are three columns, for the "Elder Ray" indicator two columns (and two invisible columns with static values).  

l For strategies, the two columns "Position" and "Position Size" are displayed over all strategies. The parameters of the single For strategies, the two columns "Position" and "Position Size" are displayed over all strategies. The parameters of the single 
strategies are usually set to invisible in the Equilla code ("visuals" are "inactive"). If they were displayed, they might also strategies are usually set to invisible in the Equilla code ("visuals" are "inactive"). If they were displayed, they might also 
interfere with the statistics, which is usually not desired. When at least one strategy is available, you can add columns for interfere with the statistics, which is usually not desired. When at least one strategy is available, you can add columns for 
statistical output like "Total Net Profit".statistical output like "Total Net Profit".  

SORTING THE COLUMNSSORTING THE COLUMNS  

You can sort the columns in the scanner by clicking on the column header. A little triangle appears, pointing up or down depending You can sort the columns in the scanner by clicking on the column header. A little triangle appears, pointing up or down depending 
on the sorting direction. To change the direction, click on the column header again. on the sorting direction. To change the direction, click on the column header again.   
  
Alternatively, rightAlternatively, right--click into the column and select the sort direction in the context menu. click into the column and select the sort direction in the context menu. 

COLUMN GROUPINGCOLUMN GROUPING  

This function in the This function in the ColumnsColumns button menu leads to a new row in the table top. If groups are already defined, a button appears for  button menu leads to a new row in the table top. If groups are already defined, a button appears for 
them. them.   
  

Scanner buttons in the toolbarScanner buttons in the toolbar
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You can start a group by dragging a table row in this new row at the table top, or by selecting a row and clicking on You can start a group by dragging a table row in this new row at the table top, or by selecting a row and clicking on Set GroupSet GroupSet GroupSet Group in  in 
the toolbar under the toolbar under Home > Table > ColumnsHome > Table > Columns..

ADD/REMOVE COLUMNSADD/REMOVE COLUMNS  

With this function in the With this function in the ColumnsColumns button menu, you can set columns in the table to visible or invisible. button menu, you can set columns in the table to visible or invisible.  
  
In the list, all available columns are sorted by categories. Standard columns like price or symbol information are available; so are a In the list, all available columns are sorted by categories. Standard columns like price or symbol information are available; so are a 
large number of statistical values for trading systems. If an indicator offers additional information, it appears as an entry here too. large number of statistical values for trading systems. If an indicator offers additional information, it appears as an entry here too.   
  
Select the entries for all columns you want to display, or click on Select the entries for all columns you want to display, or click on Show AllShow AllShow AllShow All to select all entries. to select all entries.

MANAGE STRATEGIES AND INDICATORSMANAGE STRATEGIES AND INDICATORS  

With this function in the With this function in the ColumnsColumns button menu, you can  button menu, you can 

l set the processing order of the selected indicators and strategies. To do so, select an entry and click the set the processing order of the selected indicators and strategies. To do so, select an entry and click the Move upMove upMove upMove up//Move Move Move Move 
downdowndowndown buttons. The indicators and strategies are applied in this order to every single symbol (sequential processing). buttons. The indicators and strategies are applied in this order to every single symbol (sequential processing).  

l remove indicators or strategies from the scanner by selecting them and clicking the remove indicators or strategies from the scanner by selecting them and clicking the RemoveRemoveRemoveRemove button. button.  

FORMAT OPTIONSFORMAT OPTIONS  

In the Scanner, the following buttons are available in the toolbar.In the Scanner, the following buttons are available in the toolbar.  
  
StylesStylesStylesStyles  -- Here you can set the display options of the table, e.g. gray background with orange and yellow text. Here you can set the display options of the table, e.g. gray background with orange and yellow text.  
  
SessionsSessionsSessionsSessions  -- Here you can set the trading times. You can find more information in the chapter  Here you can set the trading times. You can find more information in the chapter Sessions, Holidays and PropertiesSessions, Holidays and Properties..  
  
Price EditorPrice EditorPrice EditorPrice Editor  -- Here you can manually edit prices of symbols. You can find more information in the chapter  Here you can manually edit prices of symbols. You can find more information in the chapter Price EditorPrice Editor..

SCAN RESULTSSCAN RESULTS  

The Scanner fills the table with the results from the indicators for all symbols in the table. This may take awhile. If you stop the The Scanner fills the table with the results from the indicators for all symbols in the table. This may take awhile. If you stop the 
scanning while it is in progress, the results up to that point are saved and available in the table. scanning while it is in progress, the results up to that point are saved and available in the table. 

FILTER THE RESULTSFILTER THE RESULTS  

To get a better overview of important results, you can filter the scan result display.To get a better overview of important results, you can filter the scan result display.  
  
Click on the button Click on the button Edit FilterEdit FilterEdit FilterEdit Filter in the toolbar under  in the toolbar under Home > Table > FilterHome > Table > Filter to open the menu for the filter criteria. There, you can set  to open the menu for the filter criteria. There, you can set 
up e.g. a filter with which you search for an RSI >1 to find the strongest symbols. up e.g. a filter with which you search for an RSI >1 to find the strongest symbols.   
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You can find more information in the chapter You can find more information in the chapter FilterFilter..

USING THE RESULTS WITH DRAG&DROPUSING THE RESULTS WITH DRAG&DROP  

USE SYMBOLS IN ANOTHER TABLEUSE SYMBOLS IN ANOTHER TABLE  

You can reuse symbols from a Scanner in a Watchlist, a Portfolio or another Scanner. You can reuse symbols from a Scanner in a Watchlist, a Portfolio or another Scanner. 

1.1. If you want to start with a new table, open one by clicking the button If you want to start with a new table, open one by clicking the button ScannerScannerScannerScanner (or Portfolio or Watchlist) in the  (or Portfolio or Watchlist) in the InsertInsertInsertInsert tab of  tab of 
the toolbar and closing the wizard with the toolbar and closing the wizard with DoneDoneDoneDone. An empty table is opened. Alternatively, you can use existing tables.. An empty table is opened. Alternatively, you can use existing tables.  

2.2. In the Scanner, click into a table cell of the symbol you want to reuse. A little plus sign and a rectangle appear under the In the Scanner, click into a table cell of the symbol you want to reuse. A little plus sign and a rectangle appear under the 
mouse cursor. Now drag the cursor into the other table. The symbol is copied into the table.mouse cursor. Now drag the cursor into the other table. The symbol is copied into the table.  

In a similar way, you can drag symbols from a Portfolio or Watchlist into a Scanner. In a similar way, you can drag symbols from a Portfolio or Watchlist into a Scanner. 

SAVING SYMBOLS IN A SCANNER AS SYMBOL LISTSAVING SYMBOLS IN A SCANNER AS SYMBOL LIST  

From within the Scanner, you can save interesting symbols as a new symbol list.From within the Scanner, you can save interesting symbols as a new symbol list.

1.1. To save the symbols as a new list, click on the entry To save the symbols as a new list, click on the entry New Symbol ListNew Symbol ListNew Symbol ListNew Symbol List in the  in the Related TasksRelated Tasks area of the symbol manager in  area of the symbol manager in 
the toolbox. Choose the option the toolbox. Choose the option UserUserUserUser----Defined Symbol ListDefined Symbol ListDefined Symbol ListDefined Symbol List and name the list but keep it empty. and name the list but keep it empty.  

2.2. In the Scanner, click into a table cell of the symbol you want to reuse. (By pressing In the Scanner, click into a table cell of the symbol you want to reuse. (By pressing ShiftShiftShiftShift or  or CtrlCtrlCtrlCtrl while clicking with the  while clicking with the 
mouse, you can select more than one row.) A small plus sign and a rectangle appear below the cursor.mouse, you can select more than one row.) A small plus sign and a rectangle appear below the cursor.  

3.3. Since a first click opens the properties tab, click again on the button Since a first click opens the properties tab, click again on the button Symbol ListsSymbol ListsSymbol ListsSymbol Lists in the toolbox to open the symbol  in the toolbox to open the symbol 
manager.manager.  

4.4. Drag the selected symbols to the new symbol list. The symbols are added to the list.Drag the selected symbols to the new symbol list. The symbols are added to the list.  

OPEN A OPEN A CHARTCHART FROM THE SCANNER AND PAGE THROUGH CHARTS FROM THE SCANNER AND PAGE THROUGH CHARTS  

To view the chart for a symbol from within the Scanner, open the context menu of the table row and select To view the chart for a symbol from within the Scanner, open the context menu of the table row and select OpenOpenOpenOpen for the entry  for the entry 
ChartChartChartChart. The Chart is drawn with the history length and period of the Scanner and includes all indicators and strategies you have set . The Chart is drawn with the history length and period of the Scanner and includes all indicators and strategies you have set 
up in the Scanner. The Chart will be linked automatically to the Scanner via up in the Scanner. The Chart will be linked automatically to the Scanner via symbol linkingsymbol linking..  
  
If you want to go through the whole list of symbols in a Scanner to see each chart, use the small, green arrow buttons to the right If you want to go through the whole list of symbols in a Scanner to see each chart, use the small, green arrow buttons to the right 
of the of the Command LineCommand Line. As soon as you open one chart of a Scanner entry, you can page through the full list of symbols this way.. As soon as you open one chart of a Scanner entry, you can page through the full list of symbols this way.

EXPORTING SCANNER DATAEXPORTING SCANNER DATA  

The table contents of the Scanner can be copied to other programs. For more information, see the chapter The table contents of the Scanner can be copied to other programs. For more information, see the chapter PublishingPublishing..

EXAMPLE: HOW TO FIND THE STRONGEST VALUES IN THE NASDAQEXAMPLE: HOW TO FIND THE STRONGEST VALUES IN THE NASDAQ  

The following parameters can be used for finding the strongest Nasdaq values with the Scanner. The following parameters can be used for finding the strongest Nasdaq values with the Scanner.   
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Symbol list: Symbol list: 

l All symbols of the All symbols of the NSD.XNSD.XNSD.XNSD.X (take care that the index itself is not part of the list) (take care that the index itself is not part of the list)  
l History LengthHistory LengthHistory LengthHistory Length in the chart properties to "500" in the chart properties to "500"  

Indicator:Indicator:

l Relative Strength LevyRelative Strength LevyRelative Strength LevyRelative Strength Levy with  with PeriodPeriodPeriodPeriod 100 days 100 days  

Start the scanner for the symbols. After the scanning process, sort the table by the RSL columnStart the scanner for the symbols. After the scanning process, sort the table by the RSL column by clicking the RSL column header  by clicking the RSL column header 
(if necessary, repeat until the sorting direction is correct). At the top, the strongest Nasdaq value should be displayed.(if necessary, repeat until the sorting direction is correct). At the top, the strongest Nasdaq value should be displayed.    
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WATCHLIST 
The Watchlist in Tradesignal offers various functions for monitoring stocks The Watchlist in Tradesignal offers various functions for monitoring stocks 
in realtime. It is especially helpful for monitoring "ticking" instruments, i.e. in realtime. It is especially helpful for monitoring "ticking" instruments, i.e. 
instruments with currently changing quotations. Delayed instruments will instruments with currently changing quotations. Delayed instruments will 
also be updated automatically. also be updated automatically.   
  
Watchlists are useful for: Watchlists are useful for: 

l monitoring symbol lists for their current price developmentmonitoring symbol lists for their current price development  
l monitoring symbol lists for certain constellations of indicators and monitoring symbol lists for certain constellations of indicators and 

trading systemstrading systems  
l receiving alerts via mail or acoustic signal when prereceiving alerts via mail or acoustic signal when pre--defined triggers defined triggers 

are set offare set off  

With the Tradesignal Watchlist, you get an overview of symbol data in With the Tradesignal Watchlist, you get an overview of symbol data in 
easily manageable tables. Starting from them, you can open symbol charts easily manageable tables. Starting from them, you can open symbol charts 
and page through them for the whole symbol list. The cells with the latest changed values are displayed with colored background. and page through them for the whole symbol list. The cells with the latest changed values are displayed with colored background.   
  
The document type Watchlist has the following design parameters:The document type Watchlist has the following design parameters:

l The maximum history length is 5000.The maximum history length is 5000.  
l The maximum number of instruments is 501.The maximum number of instruments is 501.  
l The maximum number of indicators/strategies is 32.The maximum number of indicators/strategies is 32.  
l Indicators and strategies are processed sequentially, i.e. they are applied in the given sequence to each instrument, before Indicators and strategies are processed sequentially, i.e. they are applied in the given sequence to each instrument, before 

the next instrument is processed.the next instrument is processed.  

WATCHLIST SETUPWATCHLIST SETUP  

You can open a Watchlist with symbols in various ways.You can open a Watchlist with symbols in various ways.

WITH THE WIZARDWITH THE WIZARD  

When choosing one of the following methods, the wizard will open: When choosing one of the following methods, the wizard will open: 

l Click on the Click on the WatchlistWatchlistWatchlistWatchlist button in the  button in the InsertInsert tab of the toolbar. tab of the toolbar.  
l In the file menu, select In the file menu, select NewNewNewNew (key shortcut  (key shortcut Ctrl+Shift+NCtrl+Shift+NCtrl+Shift+NCtrl+Shift+N) to open the Create Item Wizard. Select ) to open the Create Item Wizard. Select WatchlistWatchlistWatchlistWatchlist..  
l Open the context menu of a symbol list in the toolbox and choose the entry Open the context menu of a symbol list in the toolbox and choose the entry Open in WatchlistOpen in WatchlistOpen in WatchlistOpen in Watchlist. (If selecting this for a . (If selecting this for a 

single symbol, it opens without a wizard.)single symbol, it opens without a wizard.)  

The Create Item wizard opens, in which you can select indicators and strategies in two more steps. Click on The Create Item wizard opens, in which you can select indicators and strategies in two more steps. Click on DoneDoneDoneDone to close the  to close the 
wizard and save the settings. wizard and save the settings. 

ADDING ONE OR MORE SYMBOLS MANUALLYADDING ONE OR MORE SYMBOLS MANUALLY  

WatchlistWatchlist
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You can also add single symbols or open a new Watchlist without using the wizard. You can also add single symbols or open a new Watchlist without using the wizard. 

l Open the context menu of a symbol or symbol list in the toolbox and choose the entry Open the context menu of a symbol or symbol list in the toolbox and choose the entry Insert SymbolInsert SymbolInsert SymbolInsert Symbol to add it to the active  to add it to the active 
Watchlist.Watchlist.  

l In the command line, enter a symbol shortcut, e.g. "DD NYS" and select In the command line, enter a symbol shortcut, e.g. "DD NYS" and select Add SymbolAdd SymbolAdd SymbolAdd Symbol to add it to the active Watchlist, or  to add it to the active Watchlist, or 
New WatchlistNew WatchlistNew WatchlistNew Watchlist for a new one. for a new one.  

l Via the symbol search. For this, click on the Via the symbol search. For this, click on the searchsearch button and select  button and select Insert the symbol into the selected workspace Insert the symbol into the selected workspace Insert the symbol into the selected workspace Insert the symbol into the selected workspace 
itemitemitemitem to add it to the Watchlist, or  to add it to the Watchlist, or Create a new WatchlistCreate a new WatchlistCreate a new WatchlistCreate a new Watchlist for a new one. for a new one.  

l You can also add symbols to a Portfolio via drag&drop from the toolbox or other documents.You can also add symbols to a Portfolio via drag&drop from the toolbox or other documents.  

The The History LengthHistory LengthHistory LengthHistory Length (candles/bars) that is regularly taken into account is 2. When you add an indicator, the length may be  (candles/bars) that is regularly taken into account is 2. When you add an indicator, the length may be 
increased if necessary for the indicator calculation. E.g., the Chande Momentum Oscillator sets the length to 16. If you go below increased if necessary for the indicator calculation. E.g., the Chande Momentum Oscillator sets the length to 16. If you go below 
this necessary length, indicators may not give results anymore. In this case, increase the length again. this necessary length, indicators may not give results anymore. In this case, increase the length again.   
  
When you select a symbol list (e.g. the Nasdaq), please ensure that the index itself is not included in the Watchlist. It makes no When you select a symbol list (e.g. the Nasdaq), please ensure that the index itself is not included in the Watchlist. It makes no 
sense to include an index in a list of symbols when searching for optimal trading parameters. (It is different if you trade in sense to include an index in a list of symbols when searching for optimal trading parameters. (It is different if you trade in 
certificates and the Watchlist is filled with index values.)certificates and the Watchlist is filled with index values.)

WATCHLIST PROPERTIESWATCHLIST PROPERTIES  

In the properties manager, you can edit the watchlist properties. Important parameters are:In the properties manager, you can edit the watchlist properties. Important parameters are:  
  
History LengthHistory LengthHistory LengthHistory Length  --  Enter the length of the history here (max. 5000).Enter the length of the history here (max. 5000).  
  
Min. Referenced BarsMin. Referenced BarsMin. Referenced BarsMin. Referenced Bars  --  Enter the minimum number of bars that should be used for calculating the values of indicators and Enter the minimum number of bars that should be used for calculating the values of indicators and 
strategies.strategies.  
  
In the In the IndicationsIndications area, you can enter the colors for changing values in the table. area, you can enter the colors for changing values in the table.  
  
Update IndicationsUpdate IndicationsUpdate IndicationsUpdate Indications  ––  Set the background color for table cells with values that changed since the last update, e.g. gray. Set the background color for table cells with values that changed since the last update, e.g. gray. Up MoveUp MoveUp MoveUp Move  
and and Down MoveDown MoveDown MoveDown Move  ––  Set the colors for increasing/decreasing values, e.g. green for up, red for down.Set the colors for increasing/decreasing values, e.g. green for up, red for down.

SAVING, RESTORING AND RESETTING DEFAULT SETTINGSSAVING, RESTORING AND RESETTING DEFAULT SETTINGS  

In the appearance area, you can find two important buttons. In the appearance area, you can find two important buttons. 

l Disk button (Save as Default) Disk button (Save as Default) --  Click here to save your current settings as the new default settings.Click here to save your current settings as the new default settings.  
l Restore button (Restore Default Settings, circled arrow) Restore button (Restore Default Settings, circled arrow) --  Click here to reset all settings to the default settings.Click here to reset all settings to the default settings.  

Not all settings can be saved like this. Not all settings can be saved like this. 

l The standard period and other user interface settings are entered in the The standard period and other user interface settings are entered in the Tradesignal OptionsTradesignal Options..  
l In the Watchlist, the order may be subject to changes depending on e.g. changing prices. In the In the Watchlist, the order may be subject to changes depending on e.g. changing prices. In the advanced Tradesignal advanced Tradesignal 

OptionsOptions, parameter , parameter Keep rows sorted in Portfolio and Watchlist (Secs.)Keep rows sorted in Portfolio and Watchlist (Secs.)Keep rows sorted in Portfolio and Watchlist (Secs.)Keep rows sorted in Portfolio and Watchlist (Secs.), you can set the time in seconds after which , you can set the time in seconds after which 
your original sorting order will be applied to the rows again.your original sorting order will be applied to the rows again.  

To restore the original default settings of your Tradesignal installation, click on the To restore the original default settings of your Tradesignal installation, click on the Restore Default SettingsRestore Default SettingsRestore Default SettingsRestore Default Settings button in the  button in the 
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Tradesignal OptionsTradesignal Options..

DELETING SYMBOLS FROM A WATCHLISTDELETING SYMBOLS FROM A WATCHLIST  

You can delete symbols from a Watchlist.You can delete symbols from a Watchlist.  

1.1. Select the symbols. You have the following options:Select the symbols. You have the following options:

¡ Press Press Ctrl+ACtrl+ACtrl+ACtrl+A to select all. to select all.  
¡ Press Press CtrlCtrlCtrlCtrl and click on single instruments to select them. and click on single instruments to select them.  
¡ Press Press ShiftShiftShiftShift and click on two instruments to select the instruments between them.. and click on two instruments to select the instruments between them..  

2.2. Press the Press the DelDelDelDel key to delete the selected instruments. key to delete the selected instruments.  

WATCHLIST BUTTONS IN THE TOOLBARWATCHLIST BUTTONS IN THE TOOLBAR  

PeriodPeriodPeriodPeriod  --  Here you can set the period that is to be used in the Watchlist Here you can set the period that is to be used in the Watchlist 
(this corresponds to the period settings for a chart). The symbols in the (this corresponds to the period settings for a chart). The symbols in the 
Watchlist are always called up with the default period at first. Watchlist are always called up with the default period at first.   
  
ColumnsColumnsColumnsColumns  --  Open the menu for the column settings of the Watchlist. Open the menu for the column settings of the Watchlist.   
  
Set GroupSet GroupSet GroupSet Group  --  Here you can group the parameters for better overview. Select Here you can group the parameters for better overview. Select 
a number of rows in the table and click on the button. You can now enter a a number of rows in the table and click on the button. You can now enter a 
name for the group. A button appears on top of the table that allows you to name for the group. A button appears on top of the table that allows you to 
open/close the group views like a folder tree in Windows Explorer.open/close the group views like a folder tree in Windows Explorer.

COLUMNS IN THE WATCHLISTCOLUMNS IN THE WATCHLIST  

The table shows different columns depending on the indicators and strategies you are using. The number of columns added for The table shows different columns depending on the indicators and strategies you are using. The number of columns added for 
each indicator or strategy depends on the number of output data. each indicator or strategy depends on the number of output data. 

l For each indicator, all columns with a nonFor each indicator, all columns with a non--static output are displayed. For example, for the "Bollinger Band" indicator there static output are displayed. For example, for the "Bollinger Band" indicator there 
are three columns, for the "Elder Ray" indicator two columns (and two invisible columns with static values).are three columns, for the "Elder Ray" indicator two columns (and two invisible columns with static values).  

l For strategies, the two columns "Position" and "Position Size" are displayed over all strategies. The parameters of the single For strategies, the two columns "Position" and "Position Size" are displayed over all strategies. The parameters of the single 
strategies are usually set to invisible in the Equilla code ("visuals" are "inactive"). If they were displayed, they might also strategies are usually set to invisible in the Equilla code ("visuals" are "inactive"). If they were displayed, they might also 
interfere with the statistics, which is usually not desired. When at least one strategy is available, you can add columns for interfere with the statistics, which is usually not desired. When at least one strategy is available, you can add columns for 
statistical output like "Total Net Profit".statistical output like "Total Net Profit".  

SORTING THE COLUMNSSORTING THE COLUMNS  

You can sort the columns in the Watchlist by clicking on the column header. A little triangle appears, pointing up or down You can sort the columns in the Watchlist by clicking on the column header. A little triangle appears, pointing up or down 
depending on the sorting direction. To change the direction, click on the column header again. depending on the sorting direction. To change the direction, click on the column header again.   
  

Watchlist buttons in the toolbarWatchlist buttons in the toolbar
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Alternatively, rightAlternatively, right--click into the column and select the sort direction in the context menu. click into the column and select the sort direction in the context menu. 

COLUMN GROUPINGCOLUMN GROUPING  

This function in the This function in the ColumnsColumns button menu leads to a new row in the table top. If groups are already defined, a button appears for  button menu leads to a new row in the table top. If groups are already defined, a button appears for 
them. them.   
  
You can start a group by dragging a table row to this new row at the table top, or by selecting a row and clicking on You can start a group by dragging a table row to this new row at the table top, or by selecting a row and clicking on Set GroupSet GroupSet GroupSet Group in  in 
the toolbar under the toolbar under Home > Table > ColumnsHome > Table > Columns..

ADD/REMOVE COLUMNSADD/REMOVE COLUMNS  

With this function in the With this function in the ColumnsColumns button menu, you can set columns in the table to visible or invisible. button menu, you can set columns in the table to visible or invisible.  
  
In the list, all available columns are sorted by categories. Standard columns like price or symbol information are available; so are a In the list, all available columns are sorted by categories. Standard columns like price or symbol information are available; so are a 
large number of statistical values for trading systems. If an indicator offers additional information, it appears as an entry here too. large number of statistical values for trading systems. If an indicator offers additional information, it appears as an entry here too.   
  
Select the entries for all columns you want to display, or click on Select the entries for all columns you want to display, or click on Show AllShow AllShow AllShow All to select all entries. to select all entries.

MANAGE STRATEGIES AND INDICATORSMANAGE STRATEGIES AND INDICATORS  

With this function in the With this function in the ColumnsColumns button menu, you can button menu, you can  

l set the processing order of the indicators and strategies by selecting an entry and clicking on set the processing order of the indicators and strategies by selecting an entry and clicking on Sort AscendingSort AscendingSort AscendingSort Ascending or  or Sort Sort Sort Sort 
DescendingDescendingDescendingDescending. The indicators and strategies are applied in this order to every single symbol (sequential processing).. The indicators and strategies are applied in this order to every single symbol (sequential processing).  

l delete indicators and strategies by selecting an entry and clicking on delete indicators and strategies by selecting an entry and clicking on RemoveRemoveRemoveRemove..  

FORMAT OPTIONSFORMAT OPTIONS  

In the Watchlist, the following Format buttons are available in the toolbar.In the Watchlist, the following Format buttons are available in the toolbar.  
  
StylesStylesStylesStyles  -- Here you can set the display options of the table, e.g. gray background with orange and yellow text. You can find more  Here you can set the display options of the table, e.g. gray background with orange and yellow text. You can find more 
information in the chapter information in the chapter StylesStyles..  
  
SessionsSessionsSessionsSessions  -- Here you can set the trading times. You can find more information in the chapter  Here you can set the trading times. You can find more information in the chapter Sessions, Holidays and PropertiesSessions, Holidays and Properties..  
  
Price EditorPrice EditorPrice EditorPrice Editor  -- Here you can manually edit prices of symbols. You can find more information in the chapter  Here you can manually edit prices of symbols. You can find more information in the chapter Price EditorPrice Editor..

ANALYZE THE WATCHLIST RESULTSANALYZE THE WATCHLIST RESULTS  

The watchlist shows a table of the results of the indicator analysis over all symbols in the list. The data is displayed in real time. The watchlist shows a table of the results of the indicator analysis over all symbols in the list. The data is displayed in real time. 
Therefore, it is not necessary to explicitly scan the Watchlist to see the current data.Therefore, it is not necessary to explicitly scan the Watchlist to see the current data.
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OPEN A CHART FROM WITH THE WATCHLIST AND PAGE THROUGH CHARTSOPEN A CHART FROM WITH THE WATCHLIST AND PAGE THROUGH CHARTS  

To view the chart for a symbol from within the Watchlist, open the context menu of the table row and select To view the chart for a symbol from within the Watchlist, open the context menu of the table row and select OpenOpenOpenOpen for the entry  for the entry 
ChartChartChartChart. The chart is drawn with the history length and period of the Watchlist and includes all indicators and strategies you have . The chart is drawn with the history length and period of the Watchlist and includes all indicators and strategies you have 
set up in the Watchlist. The Chart will be linked automatically to the Watchlist via set up in the Watchlist. The Chart will be linked automatically to the Watchlist via symbol linkingsymbol linking..  
  
If you want to go through the whole list of symbols in a Watchlist to see each chart, use the small, green arrow buttons to the right If you want to go through the whole list of symbols in a Watchlist to see each chart, use the small, green arrow buttons to the right 
of the of the Command LineCommand Line. As soon as you open one chart of a Watchlist entry, you can page through the full list of symbols this way.. As soon as you open one chart of a Watchlist entry, you can page through the full list of symbols this way.

USING THE RESULTS WITH DRAG&DROPUSING THE RESULTS WITH DRAG&DROP  

USE SYMBOLS IN ANOTHER TABLEUSE SYMBOLS IN ANOTHER TABLE  

You can reuse symbols from a Watchlist in a Portfolio, a Scanner or another Watchlist. You can reuse symbols from a Watchlist in a Portfolio, a Scanner or another Watchlist.   
  
If you want to start with a new table, open one by clicking the button If you want to start with a new table, open one by clicking the button WatchlistWatchlistWatchlistWatchlist (or Scanner or Portfolio) in the  (or Scanner or Portfolio) in the InsertInsertInsertInsert tab of the  tab of the 
toolbar and closing the wizard with toolbar and closing the wizard with DoneDoneDoneDone. An empty table is opened. Alternatively, you can use existing tables.. An empty table is opened. Alternatively, you can use existing tables.  
  
In the Watchlist, click into a table cell of the symbol you want to reuse. A little plus sign and a rectangle appear under the mouse In the Watchlist, click into a table cell of the symbol you want to reuse. A little plus sign and a rectangle appear under the mouse 
cursor. Now drag the cursor into the other table. The symbol is copied into the table.cursor. Now drag the cursor into the other table. The symbol is copied into the table.    
  
In a similar way, you can drag symbols from a Scanner or Portfolio into a Watchlist. In a similar way, you can drag symbols from a Scanner or Portfolio into a Watchlist. 

SAVING SYMBOLS IN A WATCHLIST AS SYMBOL LISTSAVING SYMBOLS IN A WATCHLIST AS SYMBOL LIST  

From within the Watchlist, you can save interesting symbols as a new symbol list.From within the Watchlist, you can save interesting symbols as a new symbol list.

1.1. To save the symbols as a new list, click on the entry To save the symbols as a new list, click on the entry New Symbol ListNew Symbol ListNew Symbol ListNew Symbol List in the  in the Related TasksRelated Tasks area of the symbol manager in  area of the symbol manager in 
the toolbox. Choose the option the toolbox. Choose the option UserUserUserUser----Defined Symbol ListDefined Symbol ListDefined Symbol ListDefined Symbol List and name the list but keep it empty. and name the list but keep it empty.  

2.2. In the Watchlist, click into a table cell of the symbol you want to reuse. (By pressing In the Watchlist, click into a table cell of the symbol you want to reuse. (By pressing ShiftShiftShiftShift or  or CtrlCtrlCtrlCtrl while clicking with the  while clicking with the 
mouse, you can select more than one row.) A small plus sign and a rectangle appear below the cursor.mouse, you can select more than one row.) A small plus sign and a rectangle appear below the cursor.  

3.3. Since a first click opens the properties tab, click again on the button Since a first click opens the properties tab, click again on the button Symbol ListsSymbol ListsSymbol ListsSymbol Lists in the toolbox to open the symbol  in the toolbox to open the symbol 
manager.manager.  

4.4. Drag the selected symbols to the new symbol list. The symbols are added to the list.Drag the selected symbols to the new symbol list. The symbols are added to the list.  

EXPORTING WATCHLIST DATAEXPORTING WATCHLIST DATA  

The table contents of the Watchlist can be copied to other programs. For more information, see the chapter The table contents of the Watchlist can be copied to other programs. For more information, see the chapter PublishingPublishing..

EXAMPLE: PARAMETERS FOR A WATCHLISTEXAMPLE: PARAMETERS FOR A WATCHLIST  

The following parameters could be used for a Watchlist for index values:The following parameters could be used for a Watchlist for index values:  
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Symbol list:Symbol list:

l all symbols of the .NDX.X (make sure that the index is not part of the list)all symbols of the .NDX.X (make sure that the index is not part of the list)  

Indicators:Indicators:

l Net ChangeNet ChangeNet ChangeNet Change (Change) (Change)  
l Net % ChangeNet % ChangeNet % ChangeNet % Change (Change in %) (Change in %)  

Thus configured, the Watchlist offers all important information at a glance. Save the workspace to keep the Watchlist settings.Thus configured, the Watchlist offers all important information at a glance. Save the workspace to keep the Watchlist settings.    
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CONTINUOUS CONTRACTS 
UserUser--defined continuations, (UDC) are constructed price time series for futures. Futures are forward contracts offered on basis of defined continuations, (UDC) are constructed price time series for futures. Futures are forward contracts offered on basis of 
commodities, stocks, indexes, currencies or assets. All futures have a fixed expiration date. Therefore, the history length of futures commodities, stocks, indexes, currencies or assets. All futures have a fixed expiration date. Therefore, the history length of futures 
is limited and ends on the day of expiration. For analysis and testing of trading systems this poses a problem since the available is limited and ends on the day of expiration. For analysis and testing of trading systems this poses a problem since the available 
data for each contract is too small.data for each contract is too small.  
  
The solution to this problem is continuous contracts, which include the concatenated price data of expired contracts. You can use The solution to this problem is continuous contracts, which include the concatenated price data of expired contracts. You can use 
continuous contracts for continuous contracts for 

l longlong--term analysis of future marketsterm analysis of future markets  
l searching seasonal trends in future marketssearching seasonal trends in future markets  
l trading system tests over longer historiestrading system tests over longer histories  

Tradesignal offers several ways to set up continuous contracts. Depending on your data provider, you have the choice between Tradesignal offers several ways to set up continuous contracts. Depending on your data provider, you have the choice between 
several adjustment and adaptation functions. This way, you can add your own creations to the continuous contracts offered by your several adjustment and adaptation functions. This way, you can add your own creations to the continuous contracts offered by your 
data provider. The result and all its included calculations is saved as a symbol, which allows further handling and analysis. data provider. The result and all its included calculations is saved as a symbol, which allows further handling and analysis. 

SET UP A USERSET UP A USER--DEFINED CONTINUATIONDEFINED CONTINUATION  

Since a userSince a user--defined continuation (UDC) acts like a normal symbol, it is set defined continuation (UDC) acts like a normal symbol, it is set 
up via the context menu of a symbol list. up via the context menu of a symbol list. 

1.1. Select Select New SymbolNew SymbolNew SymbolNew Symbol in the context menu of a symbol list. in the context menu of a symbol list.  
2.2. Choose the option Choose the option UserUserUserUser----defined continuationdefined continuationdefined continuationdefined continuation..  

The userThe user--defined continuation wizard opens. defined continuation wizard opens.   
  
Note that depending on your data provider, some of the following options Note that depending on your data provider, some of the following options 
and adaptation methods might not be available (grayed out). and adaptation methods might not be available (grayed out).   
  
Setting up an UCD is done in four steps.Setting up an UCD is done in four steps.

CONTRACT SELECTIONCONTRACT SELECTION  
UserUser--Defined Continuation WizardDefined Continuation Wizard
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Future Root CodeFuture Root CodeFuture Root CodeFuture Root Code  -- Enter a Future Root Code, for example "S" for  Enter a Future Root Code, for example "S" for 
soybeans.soybeans.  
  
Starting Contract YearStarting Contract YearStarting Contract YearStarting Contract Year  -- Enter the starting year for the futures. Enter the starting year for the futures.  
  
Next Contract to SelectNext Contract to SelectNext Contract to SelectNext Contract to Select  -- If no special specifications have to be met for  If no special specifications have to be met for 
the contracts, select an entry from the list. However, for several reasons, the contracts, select an entry from the list. However, for several reasons, 
some contracts are not handled the same way at all times of the year and some contracts are not handled the same way at all times of the year and 
therefore should be exempted from the history. Therfore there is a way to therefore should be exempted from the history. Therfore there is a way to 
exempt contracts: exempt contracts: 

l Exclude the contracts of one or more defined months. For this option, Exclude the contracts of one or more defined months. For this option, 
select or deselect the check boxes in front of theselect or deselect the check boxes in front of the  

l months' names. You can also click the months' names. You can also click the AllAllAllAll button for all months, or the  button for all months, or the 
QuartersQuartersQuartersQuarters buttons to select contracts from March, June, September and  buttons to select contracts from March, June, September and 
December. Please note that this options only applies to contracts of a monthly expiring nature.December. Please note that this options only applies to contracts of a monthly expiring nature.

l Exclude the contracts of one or more defined week days. For this option, select or deselect the check boxes in front of the Exclude the contracts of one or more defined week days. For this option, select or deselect the check boxes in front of the 
days' names. Please note that this option only applies the contracts that are of a daily expiring nature.days' names. Please note that this option only applies the contracts that are of a daily expiring nature.  

As of version 6.2 of Tradesignal if you use the TMDS as your data provider you can additionally select whether the adjustment As of version 6.2 of Tradesignal if you use the TMDS as your data provider you can additionally select whether the adjustment 
calculation should be done on the server or on the client, what until now was the only possible way. Server side calculation is calculation should be done on the server or on the client, what until now was the only possible way. Server side calculation is 
used by default if available because it is faster and less resource consuming. Some options will not be available in this case. used by default if available because it is faster and less resource consuming. Some options will not be available in this case. 
Therefore it is possible to switch back to client side calculation by selecting the checkbox Therefore it is possible to switch back to client side calculation by selecting the checkbox Enable client side calculation Enable client side calculation Enable client side calculation Enable client side calculation 
optionsoptionsoptionsoptions. All other data providers do not offer this option thus the client side calculation will always be used and cannot get . All other data providers do not offer this option thus the client side calculation will always be used and cannot get 
switched off.switched off.

ROLLOVER METHODROLLOVER METHOD  

Here you can define the rollover method. You can either use fixed intervals Here you can define the rollover method. You can either use fixed intervals 
or let the market define the rollover moment. For the latter, conditions or let the market define the rollover moment. For the latter, conditions 
based on open interest and trading volume are available. based on open interest and trading volume are available. 

ROLLOVER TRIGGERROLLOVER TRIGGER  

Rollover strictly on the expiration day of the contractRollover strictly on the expiration day of the contractRollover strictly on the expiration day of the contractRollover strictly on the expiration day of the contract  -- The history of  The history of 
the new contract is connected to the history of the expiring contract on the the new contract is connected to the history of the expiring contract on the 
expiration date. expiration date.   
  
Rollover strictly on a specific day of the expiration month of the Rollover strictly on a specific day of the expiration month of the Rollover strictly on a specific day of the expiration month of the Rollover strictly on a specific day of the expiration month of the 
contractcontractcontractcontract  -- For this method, you can define on which day of the expiration  For this method, you can define on which day of the expiration 
month the rollover will take place.month the rollover will take place.    
  
Rollover a number of days before the expiration day of the contractRollover a number of days before the expiration day of the contractRollover a number of days before the expiration day of the contractRollover a number of days before the expiration day of the contract  
-- For this method, you can define a number of days before the expiration day on which the rollover will take place.  For this method, you can define a number of days before the expiration day on which the rollover will take place.   
  

Contract SelectionContract Selection

Rollover MethodRollover Method
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Rollover a number of days before the expiration month of the contractRollover a number of days before the expiration month of the contractRollover a number of days before the expiration month of the contractRollover a number of days before the expiration month of the contract  -- For this method, you can define a number of days  For this method, you can define a number of days 
before the expiration month on which the rollover will take place. before the expiration month on which the rollover will take place.   
  
Rollover when Open Interest of the next contract exceeds the current contractRollover when Open Interest of the next contract exceeds the current contractRollover when Open Interest of the next contract exceeds the current contractRollover when Open Interest of the next contract exceeds the current contract  -- The rollover date is controlled by the  The rollover date is controlled by the 
market. When the open interest of the next contract exceeds that of the current contract, the rollover takes place.market. When the open interest of the next contract exceeds that of the current contract, the rollover takes place.  
  
Rollover when Volume of the next contract exceeds the current contractRollover when Volume of the next contract exceeds the current contractRollover when Volume of the next contract exceeds the current contractRollover when Volume of the next contract exceeds the current contract  -- The rollover date is controlled by the market.  The rollover date is controlled by the market. 
When the trading volume of the next contract exceeds that of the current contract, the rollover takes place. When the trading volume of the next contract exceeds that of the current contract, the rollover takes place.   
  
Rollover when Open Interest OR Volume of the next contract exceeds the current contractRollover when Open Interest OR Volume of the next contract exceeds the current contractRollover when Open Interest OR Volume of the next contract exceeds the current contractRollover when Open Interest OR Volume of the next contract exceeds the current contract  -- This is a hybrid of the two  This is a hybrid of the two 
previous methods. The rollover takes place when either the open interest or the trading volume of the new contract exceeds that of previous methods. The rollover takes place when either the open interest or the trading volume of the new contract exceeds that of 
the current contract. The rollover date is controlled by the market.the current contract. The rollover date is controlled by the market.  
  
Rollover when Open Interest AND Volume of the next contract exceeds the current contractRollover when Open Interest AND Volume of the next contract exceeds the current contractRollover when Open Interest AND Volume of the next contract exceeds the current contractRollover when Open Interest AND Volume of the next contract exceeds the current contract  -- This is a hybrid of the two  This is a hybrid of the two 
previous methods. The rollover takes place when both the open interest and the trading volume of the new contract exceed that of previous methods. The rollover takes place when both the open interest and the trading volume of the new contract exceed that of 
the current contract. The rollover date is controlled by the market.the current contract. The rollover date is controlled by the market.

ROLLOVER TRIGGER OPTIONSROLLOVER TRIGGER OPTIONS  

The volume or open interest conditions can be tracked for several days. The volume or open interest conditions can be tracked for several days.   
  
Trading days before expiryTrading days before expiryTrading days before expiryTrading days before expiry  -- Set the number of days for tracking. Select  Set the number of days for tracking. Select 
all (*) or the number of days (0all (*) or the number of days (0--31) from the list.31) from the list.  
  
Consecutive trigger occurrencesConsecutive trigger occurrencesConsecutive trigger occurrencesConsecutive trigger occurrences  -- Select the number of triggers that  Select the number of triggers that 
have to be set off (1have to be set off (1--4).4).

ROLLOVER ROLLOVER -- ADVANCED OPTIONS ADVANCED OPTIONS  

For some methods, the For some methods, the AdvancedAdvancedAdvancedAdvanced button is available. It opens another  button is available. It opens another 
dialog in which you can set rollover intraday details for trading periods dialog in which you can set rollover intraday details for trading periods 
shorter than a day.shorter than a day.  
  
Use data only from the expiring contractUse data only from the expiring contractUse data only from the expiring contractUse data only from the expiring contract  -- On the expiration date, only contract data of the expiring contract are taken into  On the expiration date, only contract data of the expiring contract are taken into 
account for the calculation.account for the calculation.    
  
Use data only from the continuing contractUse data only from the continuing contractUse data only from the continuing contractUse data only from the continuing contract  -- On the expiration date, only contract data of the new contract are taken into  On the expiration date, only contract data of the new contract are taken into 
account for the calculation.account for the calculation.  
  
Combine data from both contracts into a single candleCombine data from both contracts into a single candleCombine data from both contracts into a single candleCombine data from both contracts into a single candle  -- The data of both contracts is used to calculate a combined value. The data of both contracts is used to calculate a combined value.    
  
Include nonInclude nonInclude nonInclude non----trading days in all interval calculationstrading days in all interval calculationstrading days in all interval calculationstrading days in all interval calculations  -- Select this option to include non Select this option to include non--trading days into the calculation for trading days into the calculation for 
intervals of the rollover triggers.intervals of the rollover triggers.  
  
Force rollover to occur at the following timeForce rollover to occur at the following timeForce rollover to occur at the following timeForce rollover to occur at the following time  -- For trading periods shorter than a day, you can set the time. Enter the hours and  For trading periods shorter than a day, you can set the time. Enter the hours and 

Rollover TriggerRollover Trigger
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minutes in the respective fields.minutes in the respective fields.

DATA ADJUSTMENTDATA ADJUSTMENT  

UserUser--defined contracts are constructed by mathematical concatenation of defined contracts are constructed by mathematical concatenation of 
price histories of single contracts. This is done to avoid the soprice histories of single contracts. This is done to avoid the so--called called 
rollover gaps, price differences between the expiring and the new rollover gaps, price differences between the expiring and the new 
contracts. However, this may result in side effects like extreme price contracts. However, this may result in side effects like extreme price 
divergence in past histories of continuous contracts as compared to the divergence in past histories of continuous contracts as compared to the 
originally traded contracts. Choose the data adjustment method depending originally traded contracts. Choose the data adjustment method depending 
on your preferences or to avoid certain side effects.on your preferences or to avoid certain side effects.

DATA ADJUSTMENT METHODDATA ADJUSTMENT METHOD  

No AdjustmentNo AdjustmentNo AdjustmentNo Adjustment  -- The data of the contracts is simply concatenated without  The data of the contracts is simply concatenated without 
further adjustments. This results in a large price gap at each rollover date. further adjustments. This results in a large price gap at each rollover date. 
However, the advantage is that even histories in the distant past still show However, the advantage is that even histories in the distant past still show 
the real traded prices. the real traded prices.   
  
Backward AdjustmentBackward AdjustmentBackward AdjustmentBackward Adjustment  -- The history of the expiring contract is adjusted to the price of the next contract, i.e. either raised or  The history of the expiring contract is adjusted to the price of the next contract, i.e. either raised or 
lowered. For each additionally concatenated contract, the complete past history is adjusted this way. Therefore, the resulting data lowered. For each additionally concatenated contract, the complete past history is adjusted this way. Therefore, the resulting data 
for the distant past is very different from the actually traded prices. It is also possibly to receive negative (nonsensical) values in the for the distant past is very different from the actually traded prices. It is also possibly to receive negative (nonsensical) values in the 
process.process.  
  
Forward AdjustmentForward AdjustmentForward AdjustmentForward Adjustment  -- The history of the new contract is adjusted to the price of the expiring contract.  The history of the new contract is adjusted to the price of the expiring contract.   
  
Proportional AdjustmentProportional AdjustmentProportional AdjustmentProportional Adjustment  -- For this, the complete history is calculated anew. All past prices are multiplied with the ratio of the  For this, the complete history is calculated anew. All past prices are multiplied with the ratio of the 
input fields (see below). This way, no negative values can result since the values are multiplied instead of subtracted.input fields (see below). This way, no negative values can result since the values are multiplied instead of subtracted.

FIELDS WITH WHICH TO CALCULATE THE ADJUSTMENTFIELDS WITH WHICH TO CALCULATE THE ADJUSTMENT  

Select which fields the chosen adjustment method should be based on.Select which fields the chosen adjustment method should be based on.  
  
Closing price of both contractsClosing price of both contractsClosing price of both contractsClosing price of both contracts  -- The calculation is based on the closing prices. The calculation is based on the closing prices.  
  
Open of new contract; Close of expiring contractOpen of new contract; Close of expiring contractOpen of new contract; Close of expiring contractOpen of new contract; Close of expiring contract  -- The calculation is based on the close of the expiring and the open of the  The calculation is based on the close of the expiring and the open of the 
new contract. new contract.   
  
Opening price of both contractsOpening price of both contractsOpening price of both contractsOpening price of both contracts  -- The calculation is based on the opening prices. The calculation is based on the opening prices.  
  
Average price of both contractsAverage price of both contractsAverage price of both contractsAverage price of both contracts  -- The calculation is based on an average, namely (Highest High + Lowest Low / 2) of both  The calculation is based on an average, namely (Highest High + Lowest Low / 2) of both 
contracts.contracts.

Data AdjustmentData Adjustment
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ADVANCED OPTIONS FOR THE ADAPTATIONADVANCED OPTIONS FOR THE ADAPTATION  

For some settings, an additional dialog is available under For some settings, an additional dialog is available under Advanced...Advanced...Advanced...Advanced.... Here you can define which contract data should be used . Here you can define which contract data should be used 
for calculating the price difference.for calculating the price difference.    
  
The bar after the rollover dayThe bar after the rollover dayThe bar after the rollover dayThe bar after the rollover day    
  
Same day as the rollover daySame day as the rollover daySame day as the rollover daySame day as the rollover day

SUMMARYSUMMARY  

In the summary you can see an overview of your settings. You can also select the option In the summary you can see an overview of your settings. You can also select the option Create a New chart using this UDC Create a New chart using this UDC Create a New chart using this UDC Create a New chart using this UDC 
when the wizard finisheswhen the wizard finisheswhen the wizard finisheswhen the wizard finishes..

MANAGE CONTINUOUS CONTRACTSMANAGE CONTINUOUS CONTRACTS  

Via the context menu of the contract symbol you can reach all other functions for the contract:Via the context menu of the contract symbol you can reach all other functions for the contract:

l You can use continuous contracts in the documents You can use continuous contracts in the documents ChartChart, , Market ProfileMarket Profile, , WatchlistWatchlist, , ScannerScanner and  and PortfolioPortfolio..  
l You can copy, rename or delete contracts.You can copy, rename or delete contracts.  
l You can open the userYou can open the user--defined continuation wizard to edit the adjustment and calculation methods. To do so, select defined continuation wizard to edit the adjustment and calculation methods. To do so, select Edit Edit Edit Edit 

Continuation SymbolContinuation SymbolContinuation SymbolContinuation Symbol in the context menu. in the context menu.  

EXAMPLE: CREATING A CONTINUOUS CONTRACT FOR FUTURESEXAMPLE: CREATING A CONTINUOUS CONTRACT FOR FUTURES  

1.1. In the toolbox, click on In the toolbox, click on Symbol ListsSymbol ListsSymbol ListsSymbol Lists..  
2.2. Click on Click on New SymbolNew SymbolNew SymbolNew Symbol to open the Symbol wizard. to open the Symbol wizard.  
3.3. Select Select useruseruseruser----defined continuationdefined continuationdefined continuationdefined continuation and click on  and click on NextNextNextNext. The user. The user--defined continuation (UDC) wizard opens.defined continuation (UDC) wizard opens.  

In the UDC wizard: In the UDC wizard: 

1.1. For For Future Root CodeFuture Root CodeFuture Root CodeFuture Root Code, enter a symbol/shortcut, e.g. "S" for soybeans. (Futures are not automatically available for all , enter a symbol/shortcut, e.g. "S" for soybeans. (Futures are not automatically available for all 
account types. Contact Tradesignal for an upgrade, if necessary.)account types. Contact Tradesignal for an upgrade, if necessary.)  

2.2. From the list of contract series, select the top entry so that all available contracts will be taken into account.From the list of contract series, select the top entry so that all available contracts will be taken into account.  
3.3. Click on Click on QuartersQuartersQuartersQuarters to select the four months in which quarters end. to select the four months in which quarters end.  
4.4. Click on Click on NextNextNextNext..  
5.5. As trigger for the concatenation, select As trigger for the concatenation, select Rollover when volume of the next contract exceeds the current contractRollover when volume of the next contract exceeds the current contractRollover when volume of the next contract exceeds the current contractRollover when volume of the next contract exceeds the current contract..  
6.6. Click on Click on NextNextNextNext..  
7.7. Select Select Proportional AdjustmentProportional AdjustmentProportional AdjustmentProportional Adjustment and  and closing prices of both contractsclosing prices of both contractsclosing prices of both contractsclosing prices of both contracts as fields for the calculation. as fields for the calculation.  
8.8. Click on Click on NextNextNextNext..  
9.9. Check the Check the Create a new chart using this UDC when the wizard finishesCreate a new chart using this UDC when the wizard finishesCreate a new chart using this UDC when the wizard finishesCreate a new chart using this UDC when the wizard finishes option and click on  option and click on DoneDoneDoneDone..  

10.10. Enter a name for the contract.Enter a name for the contract.  

The continuous contract now appears as symbol in the symbol list.The continuous contract now appears as symbol in the symbol list.
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LINKSLINKS  

l www.worldlinkfutures.comwww.worldlinkfutures.com  
l www.premiumdata.netwww.premiumdata.net  
l www.futuresknowledge.comwww.futuresknowledge.com  
l wikipedia.orgwikipedia.org  

LITERATURELITERATURE  

l Fundamental Analysis Fundamental Analysis -- Jack D. Schwager Jack D. Schwager  
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MARKET DEPTH 
The market depth data offer a list of the best bid and ask orders in The market depth data offer a list of the best bid and ask orders in 
streaming view and are instrumental for assessing the current state of streaming view and are instrumental for assessing the current state of 
stocks. This kind of information is also called Level II. It is especially stocks. This kind of information is also called Level II. It is especially 
important for day and intraday trading. important for day and intraday trading. 

l Most of the data and charts in Tradesignal offer Most of the data and charts in Tradesignal offer Level ILevel ILevel ILevel I data, i.e.  data, i.e. 
you receive price information based on the last trade (or ask price, if you receive price information based on the last trade (or ask price, if 
no trade has taken place).no trade has taken place).  

l In case of In case of Level IILevel IILevel IILevel II data, however, you can see current bid and ask  data, however, you can see current bid and ask 
orders for a stock. This way, you have an immediate insight into the orders for a stock. This way, you have an immediate insight into the 
order books of the traders or ECN. The available details depend on the data provider.order books of the traders or ECN. The available details depend on the data provider.  

The market depth data give you:The market depth data give you:

l insight into current bid and ask prices.insight into current bid and ask prices.  
l insight into upcoming trades.insight into upcoming trades.  
l insight into the liquidity of the market.insight into the liquidity of the market.  
l the ability to see and judge current trends, accurate to the second.the ability to see and judge current trends, accurate to the second.  
l the ability to learn about support and resistance price levels (lower and upper limit of price movements).the ability to learn about support and resistance price levels (lower and upper limit of price movements).  
l insights into the activity of individual market makers (if source given by the data provider).insights into the activity of individual market makers (if source given by the data provider).  

In Tradesignal, three views are available for market depth analysis:In Tradesignal, three views are available for market depth analysis:

l Level IILevel IILevel IILevel II displays the current status of the order books (available data depends on data provider). displays the current status of the order books (available data depends on data provider).  
l Price LadderPrice LadderPrice LadderPrice Ladder gives a visual overview of the Level II data, as size bars for each offered bid/ask price as well as a bid/ask  gives a visual overview of the Level II data, as size bars for each offered bid/ask price as well as a bid/ask 

ratio curve.ratio curve.  
l Time and SalesTime and SalesTime and SalesTime and Sales displays the current prices, sizes and actual transactions in real time. displays the current prices, sizes and actual transactions in real time.  

OPENING THE MARKET DEPTH VIEWSOPENING THE MARKET DEPTH VIEWS  

1.1. To open one or all of the available market depth views, click on the button "Market Depth" in the To open one or all of the available market depth views, click on the button "Market Depth" in the InsertInsertInsertInsert tab of the toolbar. tab of the toolbar.  
2.2. Choose a view in the pull down menu or choose "Full Market Depth view" for all.Choose a view in the pull down menu or choose "Full Market Depth view" for all.  

In principle, you can display market depth data for all traded stocks. However, in the case of rarely traded stocks, the views may In principle, you can display market depth data for all traded stocks. However, in the case of rarely traded stocks, the views may 
remain empty or may be updated infrequently.remain empty or may be updated infrequently.

PROPERTIESPROPERTIES  

l Display UnitsDisplay UnitsDisplay UnitsDisplay Units: Here you can set up the way the prices should be displayed (default: 2 decimal places). When you choose : Here you can set up the way the prices should be displayed (default: 2 decimal places). When you choose 
fraction display, the new field 'Fraction Precision" appears. Here you can set the maximum number of decimal places to be fraction display, the new field 'Fraction Precision" appears. Here you can set the maximum number of decimal places to be 
used in case the fraction cannot be expressed by an integral numerator.used in case the fraction cannot be expressed by an integral numerator.  

l LayoutLayoutLayoutLayout: Here you can switch between the available market depth views.: Here you can switch between the available market depth views.  

Market DepthMarket Depth
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LEVEL IILEVEL II  

In the Level II view you can see the bid (buying) and ask (selling) orders In the Level II view you can see the bid (buying) and ask (selling) orders 
and their respective size for the chosen stock. The price levels are colorand their respective size for the chosen stock. The price levels are color--
coded. Besides the price ladder (see below) there are three areas:coded. Besides the price ladder (see below) there are three areas:

l Overview: On the upper left, you can find a compressed overview of Overview: On the upper left, you can find a compressed overview of 
the bid and ask prices, the respective sizes and the spread between the bid and ask prices, the respective sizes and the spread between 
the prices.the prices.  

l Bid / Size: Here you can see the offered bid prices and their size. Bid / Size: Here you can see the offered bid prices and their size. 
The best price (highest selling price) is shown on top.The best price (highest selling price) is shown on top.  

l Ask / Size: Here you can see the offered ask prices and their size. Ask / Size: Here you can see the offered ask prices and their size. 
The best price (lowest selling price) is shown on top.The best price (lowest selling price) is shown on top.  

On top of the Level II window, you can find a line with the Level I data (open, high, total, et al.).On top of the Level II window, you can find a line with the Level I data (open, high, total, et al.).  
  
The first line of the two areas, with the highest bid and lowest ask, is called "inside market" and traditionally displayed in yellow. The first line of the two areas, with the highest bid and lowest ask, is called "inside market" and traditionally displayed in yellow. 
The market depth corresponds to the number of visible price levels (default: 10). You can change the default in the properties. The market depth corresponds to the number of visible price levels (default: 10). You can change the default in the properties.   
  
The details of the Level II data depend on the data provider.The details of the Level II data depend on the data provider.

PROPERTIES PROPERTIES   

l Show Bid/Ask SizeShow Bid/Ask SizeShow Bid/Ask SizeShow Bid/Ask Size: When this is set to true, the offered sizes are displayed as numbers in the bars of the price ladder.: When this is set to true, the offered sizes are displayed as numbers in the bars of the price ladder.  
l Bid/Ask OrderingBid/Ask OrderingBid/Ask OrderingBid/Ask Ordering: Allows you to toggle the order of bid and ask in the price ladder (has no effect on the ratio field below : Allows you to toggle the order of bid and ask in the price ladder (has no effect on the ratio field below 

the price ladder).the price ladder).  
l Highlight SourceHighlight SourceHighlight SourceHighlight Source: When this is set to true, orders by the same source in the bid/ask areas are highlighted when clicking on : When this is set to true, orders by the same source in the bid/ask areas are highlighted when clicking on 

one of the orders (only available if source given).one of the orders (only available if source given).  
l SmoothingSmoothingSmoothingSmoothing: Here you can enter how many successive ticks should be averaged in the bid/ask ratio to generate a smoother : Here you can enter how many successive ticks should be averaged in the bid/ask ratio to generate a smoother 

curve in the display.curve in the display.  
l LevelsLevelsLevelsLevels: Here you can set how many price levels should be displayed in the bid/ask areas.: Here you can set how many price levels should be displayed in the bid/ask areas.  
l DepthDepthDepthDepth: Shows the data base used for each line in the overview (e.g. "2*4" for 2 summarized bids and 4 summarized asks).: Shows the data base used for each line in the overview (e.g. "2*4" for 2 summarized bids and 4 summarized asks).  
l SourceSourceSourceSource: Displays the individual market maker or ECN in the first column of the bid/ask areas (available data depending on : Displays the individual market maker or ECN in the first column of the bid/ask areas (available data depending on 

the data provider).the data provider).  
l TimeTimeTimeTime: If set to visible, the time column is displayed in the bid/ask areas (available data depending on the data provider).: If set to visible, the time column is displayed in the bid/ask areas (available data depending on the data provider).  

PRICE LADDERPRICE LADDER  

Level IILevel II
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The price ladder offers a visual overview of the Level II data. The price The price ladder offers a visual overview of the Level II data. The price 
ladder is a regular part of the Level II view but can also be displayed ladder is a regular part of the Level II view but can also be displayed 
individually. In the case of individual display, a line with the Level I data individually. In the case of individual display, a line with the Level I data 
(open, high, total, et al.) is displayed on top.(open, high, total, et al.) is displayed on top.  
  
The price ladder view consists of:The price ladder view consists of:

l The price ladder itself. In it, the sizes of bid and ask orders are The price ladder itself. In it, the sizes of bid and ask orders are 
displayed as colored bars for each price. This way, you can easily displayed as colored bars for each price. This way, you can easily 
see any existing imbalance between selling and buying orders and see any existing imbalance between selling and buying orders and 
also estimate in which direction the price is likely to move. The also estimate in which direction the price is likely to move. The 
display order of bid and ask can be set in the properties.display order of bid and ask can be set in the properties.  

l A curve display for the bid/ask ratio (below the price ladder). The upper red area corresponds to the bid orders, the lower A curve display for the bid/ask ratio (below the price ladder). The upper red area corresponds to the bid orders, the lower 
green area to the ask orders. In case of bid overbalance, the curve moves into the red area and prices are likely to move up. green area to the ask orders. In case of bid overbalance, the curve moves into the red area and prices are likely to move up. 
In case of an ask overweight, the curve moves down into the green area and prices are likely to drop. A curve on the border In case of an ask overweight, the curve moves down into the green area and prices are likely to drop. A curve on the border 
between the areas shows a balanced market.between the areas shows a balanced market.  

For the price ladder properties, see the section For the price ladder properties, see the section Level IILevel II..

TIME AND SALESTIME AND SALES  

Time and Sales shows a streaming display of price and size of orders and Time and Sales shows a streaming display of price and size of orders and 
trades as a table. It allows you to see the up and down ticks of the stock trades as a table. It allows you to see the up and down ticks of the stock 
price at a glance. Individual market makers or ECN are not available here.price at a glance. Individual market makers or ECN are not available here.  
  
The default color settings of the text are:The default color settings of the text are:

l Price changes to best bid price ("To Bid") are shown in red.Price changes to best bid price ("To Bid") are shown in red.  
l Price changes to best ask price ("To Ask") are shown in green.Price changes to best ask price ("To Ask") are shown in green.  
l Last, i.e. real trades that correspond to Level I information, are Last, i.e. real trades that correspond to Level I information, are 

shown in black.shown in black.  

l If the price changes in comparison to the previous bid/ask price, its If the price changes in comparison to the previous bid/ask price, its 
background color changes accordingly and an additional plus/minus sign is background color changes accordingly and an additional plus/minus sign is 
displayed.displayed.

PROPERTIESPROPERTIES  

l History LengthHistory LengthHistory LengthHistory Length: Here you can enter the maximum number of : Here you can enter the maximum number of 
transactions to be stored in the table. Note: Upon changing this transactions to be stored in the table. Note: Upon changing this 
value, there might be a noticeable wait while the system updates the historical information.value, there might be a noticeable wait while the system updates the historical information.  

l DateDateDateDate: When this is set to visible, the current date is shown in an additional column.: When this is set to visible, the current date is shown in an additional column.  
l Condition CodesCondition CodesCondition CodesCondition Codes: When this is set to visible, the conditions are written out in an additional column (e.g., "At Ask").: When this is set to visible, the conditions are written out in an additional column (e.g., "At Ask").  

Price LadderPrice Ladder

Time and SalesTime and Sales
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FILTER 
The filter is an important instrument for filtering the results of the optimizer and scanner for certain values. The filter is an important instrument for filtering the results of the optimizer and scanner for certain values. 

FILTER VALUESFILTER VALUES  

The filtering proceeds in two steps: The filtering proceeds in two steps: 

1.1. Click the Click the Edit FilterEdit FilterEdit FilterEdit Filter button in the  button in the ToolbarToolbar under  under Home > Table > Home > Table > 
filterfilter to set up a filter. to set up a filter.  

FILTER SET UPFILTER SET UP  

When setting up the filter, you define one or more criteria that form the When setting up the filter, you define one or more criteria that form the 
filter. You have the following options:filter. You have the following options:

l NewNewNewNew  -- Starts a new filter. An existing filter will be deleted. It is not  Starts a new filter. An existing filter will be deleted. It is not 
possible to set up and save several filters. However, you can enter possible to set up and save several filters. However, you can enter 
parallel filters combined by parallel filters combined by OROROROR. A dialog opens. Here you can enter . A dialog opens. Here you can enter 
which column should be tested with which operator (=, >, <...) which column should be tested with which operator (=, >, <...) 
Confirm with Confirm with OKOKOKOK..  

l EditEditEditEdit  -- Opens the dialog as explained above, in which you can edit  Opens the dialog as explained above, in which you can edit 
the selected filter criteria.the selected filter criteria.  

l DeleteDeleteDeleteDelete  -- Deletes the selected line in the filter. Deletes the selected line in the filter.  

l OROROROR  -- Choose this to enter other possible criteria sets. This way, you  Choose this to enter other possible criteria sets. This way, you 
may avoid setting up new filters. Enter all important filters with OR may avoid setting up new filters. Enter all important filters with OR 
between them. The ones that don't apply are ignored.between them. The ones that don't apply are ignored.  

l Move up/Move downMove up/Move downMove up/Move downMove up/Move down  -- With these buttons you can move a  With these buttons you can move a 
criterion up and down in the appliance sequence.criterion up and down in the appliance sequence.  

ADVANCED FILTER OPTIONSADVANCED FILTER OPTIONS  

Click on Click on Show Advanced OptionsShow Advanced OptionsShow Advanced OptionsShow Advanced Options to display additional options: to display additional options:

l Show all filtered rowsShow all filtered rowsShow all filtered rowsShow all filtered rows  -- All rows of the table are shown. An additional column named  All rows of the table are shown. An additional column named FilterFilterFilterFilter appears, in which rows are  appears, in which rows are 
labeledlabeled "true" or "not true". "true" or "not true".  

l Alternatively you can combine the row display with another condition by selecting an Equilla formula in the list or entering a Alternatively you can combine the row display with another condition by selecting an Equilla formula in the list or entering a 
new one. In this case, only filtered rows that fulfill the second condition are displayed.new one. In this case, only filtered rows that fulfill the second condition are displayed.  

This option is only available for This option is only available for ScannerScanner documents. documents.

Filter buttons in the toolbarFilter buttons in the toolbar

Create a new filterCreate a new filter
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EXAMPLE EXAMPLE -- FILTERING FOR STRONGEST VALUES FILTERING FOR STRONGEST VALUES  

1.1. Open a new scanner and fill it with the 50 symbols of the "Dow Jones Industry", for example. Add the indicator Open a new scanner and fill it with the 50 symbols of the "Dow Jones Industry", for example. Add the indicator Relative Relative Relative Relative 
Strength LevyStrength LevyStrength LevyStrength Levy..  

2.2. Perform the scan.Perform the scan.  
3.3. Click the Click the Edit FilterEdit FilterEdit FilterEdit Filter button in the  button in the toolbartoolbar to open the filter criteria dialog. to open the filter criteria dialog.  
4.4. Click the Click the NewNewNewNew button and choose the column "RSL" for testing. That's the relative Strength Levy indicator we have entered in  button and choose the column "RSL" for testing. That's the relative Strength Levy indicator we have entered in 

the scanner.the scanner.  
5.5. Select the operator > and enter the number "1" as the value to be tested against. Confirm your settings.Select the operator > and enter the number "1" as the value to be tested against. Confirm your settings.  

As a result you get a filtered list that includes only stocks with a Relative Strength Levy of more than 1.As a result you get a filtered list that includes only stocks with a Relative Strength Levy of more than 1.    
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BAR CHART 
Bar charts are among the most common chart types and give information Bar charts are among the most common chart types and give information 
about open, high, low and close prices, price developments and the about open, high, low and close prices, price developments and the 
magnitude of price movements. magnitude of price movements.   
  
The bar chart can be set as the default chart type in Tradesignal, see The bar chart can be set as the default chart type in Tradesignal, see 
chapter chapter ChartChart. . 

TRADING INFORMATION IN BAR CHARTSTRADING INFORMATION IN BAR CHARTS  

The following information is available in a bar chart: The following information is available in a bar chart: 

l The highest price, given by the top point of the barThe highest price, given by the top point of the bar  
l The lowest price, given by the lowest point of the barThe lowest price, given by the lowest point of the bar  
l The open price, given by the left vertical lineThe open price, given by the left vertical line  
l The close price, given by the right vertical lineThe close price, given by the right vertical line  
l The direction of the price movement, given by the relative positions The direction of the price movement, given by the relative positions 

of the left and right vertical lines. If the left one is below the right of the left and right vertical lines. If the left one is below the right 
one, prices have risen during the trading period. Otherwise, prices one, prices have risen during the trading period. Otherwise, prices 
have fallen.have fallen.  

l The direction of the price movement, given by the color of the bars. The direction of the price movement, given by the color of the bars. 
The usual color setting is red for falling and black for rising prices. The usual color setting is red for falling and black for rising prices. 
The colors can be edited in the chart properties.The colors can be edited in the chart properties.  

l The strength of the price movement, given by the total length of the The strength of the price movement, given by the total length of the 
bar (difference between high and low).bar (difference between high and low).  

GENERAL CHART PROPERTIESGENERAL CHART PROPERTIES  

When the chart is active, you can edit the chart properties in the toolbox, for example the history length, the axes and legends.When the chart is active, you can edit the chart properties in the toolbox, for example the history length, the axes and legends.  
  
You can alsoYou can also

l set the trading period, see the chapter set the trading period, see the chapter Timespans and PeriodsTimespans and Periods. Note that it is not possible to use bar charts when using ticks . Note that it is not possible to use bar charts when using ticks 
as periods.as periods.  

l change the time span. In this case, several bars of a time span are combined to a "meta bar" to display the trading activity change the time span. In this case, several bars of a time span are combined to a "meta bar" to display the trading activity 
of several periods. For example, if you choose "Current Quarter", three meta bars based on the monthly dates are displayed.of several periods. For example, if you choose "Current Quarter", three meta bars based on the monthly dates are displayed.  

l change the chart look, see the chapter change the chart look, see the chapter Chart PropertiesChart Properties..  

CONTENTCONTENT--DEPENDENT CHART SETTINGSDEPENDENT CHART SETTINGS  

A Bar ChartA Bar Chart

A Single BarA Single Bar
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In the properties of the displayed stock (symbol), you can find additional parameters. Besides the In the properties of the displayed stock (symbol), you can find additional parameters. Besides the Standard PropertiesStandard Properties, you can find , you can find 
specific parameters for this chart type.specific parameters for this chart type.  
  
BarsBars Properties Properties  
  
Bullish ColorBullish ColorBullish ColorBullish Color  -- Here you can select a color and transparency for upward bars.  Here you can select a color and transparency for upward bars.   
  
Bearish ColorBearish ColorBearish ColorBearish Color  -- Here you can select a color and transparency for downward bars. Here you can select a color and transparency for downward bars.    
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CANDLESTICK CHART 
Starting in the 17th century, the candlestick chart pattern was used in Starting in the 17th century, the candlestick chart pattern was used in 
Japan. Used by Charles Dow in 1900, it was the American trader Steve Japan. Used by Charles Dow in 1900, it was the American trader Steve 
Nison who brought candlestick charts back to the awareness of western Nison who brought candlestick charts back to the awareness of western 
traders. Today, candlestick charts are one of the most common chart types.traders. Today, candlestick charts are one of the most common chart types.  
  
Candlestick charts give information about the open, high, low and close Candlestick charts give information about the open, high, low and close 
prices and about the direction and magnitude of the price movement. It is prices and about the direction and magnitude of the price movement. It is 
this wealth of information and the distinct patterns that make the this wealth of information and the distinct patterns that make the 
candlestick charts so interesting. The direction and movement of prices can candlestick charts so interesting. The direction and movement of prices can 
be better perceived than by using bars. More complex candlestick patterns be better perceived than by using bars. More complex candlestick patterns 
are often used as the basis for trading decisions. are often used as the basis for trading decisions.   
  
The candlestick chart is the default chart type in Tradesignal. See also the The candlestick chart is the default chart type in Tradesignal. See also the 
chapter chapter ChartChart..

TRADING INFORMATION IN CANDLESTICKSTRADING INFORMATION IN CANDLESTICKS  

The following information is available in the candle body and the shadows The following information is available in the candle body and the shadows 
(the lines on bottom and top, also called wicks):(the lines on bottom and top, also called wicks):

l The high of the trading period, given by the end of the upper The high of the trading period, given by the end of the upper 
shadow.shadow.  

l The low of the trading period, given by the end of the lower The low of the trading period, given by the end of the lower 
shadow.shadow.  

l The open price, given by the body edge; either the bottom line in the The open price, given by the body edge; either the bottom line in the 
case of an upwards development, or the top line in the case of a case of an upwards development, or the top line in the case of a 
downwards development.downwards development.  

l The close price, given by the body edge; either the top line in the The close price, given by the body edge; either the top line in the 
case of an upward development, or the bottom line in the case of a case of an upward development, or the bottom line in the case of a 
downward development.downward development.  

l The direction of the price movement, given by the body color. Colors The direction of the price movement, given by the body color. Colors 
are usually red or black for falling and green or white for rising are usually red or black for falling and green or white for rising 
prices. The color settings can be changed.prices. The color settings can be changed.  

l The magnitude of the price movement, given by the length of the body and the shadows. The total length of a candlestick The magnitude of the price movement, given by the length of the body and the shadows. The total length of a candlestick 
between the wicks is the difference between high and low.between the wicks is the difference between high and low.  

More information can be gathered when several candlesticks are seen in context. Patterns of up to three candles are used to take a More information can be gathered when several candlesticks are seen in context. Patterns of up to three candles are used to take a 
closer look at the price movements and their quality. For example, candles with bodies of the same color show more pronounced closer look at the price movements and their quality. For example, candles with bodies of the same color show more pronounced 
trends. Trading is often done based on a mixture of candlestick pattern analysis and other methods.trends. Trading is often done based on a mixture of candlestick pattern analysis and other methods.

TWO SIMPLE CANDLE EXAMPLESTWO SIMPLE CANDLE EXAMPLES  

A Candlestick ChartA Candlestick Chart

A Single CandlestickA Single Candlestick
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THE HAMMERTHE HAMMER  

The hammer was named for its characteristic shape and the relationship to The hammer was named for its characteristic shape and the relationship to 
the Japanese sign for "hammering a floor". It has a large lower shadow the Japanese sign for "hammering a floor". It has a large lower shadow 
with a small body on top, meaning a long downward movement stopped with a small body on top, meaning a long downward movement stopped 
(and changed direction) during the trading period.(and changed direction) during the trading period.    
  
An ideal hammer has a small white body, showing that a bullish trend An ideal hammer has a small white body, showing that a bullish trend 
won out. The hammer should have no upper shadow, meaning that the won out. The hammer should have no upper shadow, meaning that the 
close corresponded to the high in the trading period. In combination with close corresponded to the high in the trading period. In combination with 
analysis methods like moving average and other support signals, a hammer analysis methods like moving average and other support signals, a hammer 
may be a good entry signal.may be a good entry signal.

THE DOJITHE DOJI  

A doji is a common candle that has a very small or no body at all. If the A doji is a common candle that has a very small or no body at all. If the 
body is small, the color can be ignored. A distinct doji has very large body is small, the color can be ignored. A distinct doji has very large 
shadows of similar size. shadows of similar size.   
  
A doji signals that for all the trading over the day, the market and its forces A doji signals that for all the trading over the day, the market and its forces 
are in equilibrium. The opening and close price are almost the same. are in equilibrium. The opening and close price are almost the same.   
  
The doji itself only shows a kind of "frozen" state, of indecision. However, The doji itself only shows a kind of "frozen" state, of indecision. However, 
it gathers importance depending on the surrounding patterns. Price it gathers importance depending on the surrounding patterns. Price 
movements taking place after a doji often signal new trends or a trend movements taking place after a doji often signal new trends or a trend 
inversion. Therefore, dojis are good support signals for resistance and support lines.inversion. Therefore, dojis are good support signals for resistance and support lines.

GENERAL CHART PROPERTIESGENERAL CHART PROPERTIES  

When the chart is active, you can edit the chart properties in the toolbox, for example the history length, the axes and legends.When the chart is active, you can edit the chart properties in the toolbox, for example the history length, the axes and legends.  
  
You can alsoYou can also

l set the trading period and timespans, see the chapter set the trading period and timespans, see the chapter Timespans and PeriodsTimespans and Periods..  
l change the chart look, see the chapter change the chart look, see the chapter Chart PropertiesChart Properties..  

CONTENTCONTENT--DEPENDENT CHART SETTINGSDEPENDENT CHART SETTINGS  

In the properties of the displayed stock (symbol), you can find additional parameters. Besides the In the properties of the displayed stock (symbol), you can find additional parameters. Besides the Standard PropertiesStandard Properties, you can find , you can find 
specific parameters for this chart type.specific parameters for this chart type.  
  
CandlesCandles Properties Properties  

HammerHammer

DojiDoji
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Border ColorBorder ColorBorder ColorBorder Color  -- Here you can select a color for the border.  Here you can select a color for the border.   
  
Show FrameShow FrameShow FrameShow Frame  -- Here you can select whether the candle frame will be displayed or hidden.  Here you can select whether the candle frame will be displayed or hidden.   
  
Bullish ColorBullish ColorBullish ColorBullish Color  -- Here you can select a color and opacity for upward candles.  Here you can select a color and opacity for upward candles.   
  
Bearish ColorBearish ColorBearish ColorBearish Color  -- Here you can select a color and opacity for downward candles. Here you can select a color and opacity for downward candles.

INDICATORS AND STRATEGIESINDICATORS AND STRATEGIES  

In the indicator overview, you can find the indicator In the indicator overview, you can find the indicator Candle PatternCandle PatternCandle PatternCandle Pattern which includes a long list of typical candlestick patterns to  which includes a long list of typical candlestick patterns to 
choose from. You can edit these patterns in the graph properties in the toolbox. The set pattern is displayed in the graph. choose from. You can edit these patterns in the graph properties in the toolbox. The set pattern is displayed in the graph.   
  
In the strategies overview, you can find strategies such as In the strategies overview, you can find strategies such as Candle Bearish Engulfing Candle Bearish Engulfing Candle Bearish Engulfing Candle Bearish Engulfing ---- Exit Exit Exit Exit, , Candle Big White Candlestick Candle Big White Candlestick Candle Big White Candlestick Candle Big White Candlestick ----    
ExitExitExitExit, and many more that you can apply to your candlestick chart. , and many more that you can apply to your candlestick chart. 

LINKS AND BOOKSLINKS AND BOOKS  

Candlestick Charts in the WikipediaCandlestick Charts in the Wikipedia    
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LINE CHART 
Line charts are a classic type of chart, in which data points are connected Line charts are a classic type of chart, in which data points are connected 
by a line, e.g. physical data in axes of coordinates. The line chart can be by a line, e.g. physical data in axes of coordinates. The line chart can be 
set as the default chart type in Tradesignal, see chapter set as the default chart type in Tradesignal, see chapter ChartChart..    
  
In Tradesignal, line charts are used for displaying: In Tradesignal, line charts are used for displaying: 

l time lines for symbols, e.g. for Open, High, Low or Closetime lines for symbols, e.g. for Open, High, Low or Close  
l indicator resultsindicator results  
l performance development of a trading systemperformance development of a trading system  
l additional information like fundamental data and market depth additional information like fundamental data and market depth 

indices.indices.  

The line chart is the simplest chart type for stocks. From trading period to trading period, the line is extended for new prices. The line chart is the simplest chart type for stocks. From trading period to trading period, the line is extended for new prices.   
  
For symbols, the lines are usually drawn for closing prices.For symbols, the lines are usually drawn for closing prices.

GENERAL CHART PROPERTIESGENERAL CHART PROPERTIES  

When the chart is active, you can edit the chart properties in the toolbox, for example the history length, the axes and legends.When the chart is active, you can edit the chart properties in the toolbox, for example the history length, the axes and legends.  
  
You can also You can also 

l set the period and time span, see the chapter set the period and time span, see the chapter Timespans and PeriodsTimespans and Periods..  
l change the chart look, see the chapter change the chart look, see the chapter Chart PropertiesChart Properties..  

CONTENTCONTENT--DEPENDENT CHART SETTINGSDEPENDENT CHART SETTINGS  

In the properties of the displayed stock (symbol), you can find additional parameters. Besides the In the properties of the displayed stock (symbol), you can find additional parameters. Besides the Standard PropertiesStandard Properties, you can find , you can find 
specific parameters for this chart type.specific parameters for this chart type.  
  
InstrumentInstrument Properties Properties  
  
InputInputInputInput  -- Select which data to use for calculating the chart (Open, High, Close, Low, Volume).  Select which data to use for calculating the chart (Open, High, Close, Low, Volume).   
  
LineLine Properties Properties  
  
ColorColorColorColor  -- Here you can select a color for the line.  Here you can select a color for the line.   
  
WidthWidthWidthWidth  -- Here you can set a line width by entering a number. Here you can set a line width by entering a number.  
  
StyleStyleStyleStyle  -- Here you can select a line style, e.g. solid or dotted. Here you can select a line style, e.g. solid or dotted.  
  

Line ChartLine Chart
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ShadowShadowShadowShadow  -- Here you can set a shadow for emphasizing the line with a 3D effect. Four settings are available. Here you can set a shadow for emphasizing the line with a 3D effect. Four settings are available.    
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STEPPED LINE CHART 
The stepped line chart is a variation of the normal line chart. The price The stepped line chart is a variation of the normal line chart. The price 
levels are connected not by direct lines but at right angles. Stepped line levels are connected not by direct lines but at right angles. Stepped line 
charts can only be used for stocks. charts can only be used for stocks. 

GENERAL CHART PROPERTIESGENERAL CHART PROPERTIES  

When the chart is active, you can edit the chart properties in the toolbox, When the chart is active, you can edit the chart properties in the toolbox, 
for example the history length, the axes and legends.for example the history length, the axes and legends.  
  
You can also You can also 

l set the period and time span, see the chapter set the period and time span, see the chapter Timespans and PeriodsTimespans and Periods..  
l change the chart look, see the chapter change the chart look, see the chapter Chart PropertiesChart Properties..  

CONTENTCONTENT--DEPENDENT CHART SETTINGSDEPENDENT CHART SETTINGS  

In the properties of the displayed stock (symbol), you can find additional parameters. Besides the In the properties of the displayed stock (symbol), you can find additional parameters. Besides the Standard PropertiesStandard Properties, you can find , you can find 
specific parameters for this chart type.specific parameters for this chart type.  
  
InstrumentInstrument Properties Properties  
  
InputInputInputInput  -- Select which data to use for calculating the chart (Open, High, Close, Low, Volume).  Select which data to use for calculating the chart (Open, High, Close, Low, Volume).   
  
Stepped LineStepped Line Properties Properties  
  
ColorColorColorColor  -- Here you can select a color for the line.  Here you can select a color for the line.   
  
WidthWidthWidthWidth  -- Here you can set a line width by entering a number. Here you can set a line width by entering a number.  
  
StyleStyleStyleStyle  -- Here you can select a line style, e.g. solid or dotted. Here you can select a line style, e.g. solid or dotted.  
  
ShadowShadowShadowShadow  -- Here you can set a shadow for emphasizing the line with a 3D effect. Four settings are available. Here you can set a shadow for emphasizing the line with a 3D effect. Four settings are available.    

Stepped Line ChartStepped Line Chart
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SYMBOL CHART 
The symbol chart is a variation of a normal line chart, displaying the The symbol chart is a variation of a normal line chart, displaying the 
chosen input (open, close, high...) as unconnected symbols. Several symbol chosen input (open, close, high...) as unconnected symbols. Several symbol 
types can be set for the display. types can be set for the display. 

GENERAL CHART PROPERTIESGENERAL CHART PROPERTIES  

When the chart is active, you can edit the chart properties in the toolbox, When the chart is active, you can edit the chart properties in the toolbox, 
for example the history length, the axes and legends.for example the history length, the axes and legends.  
  
You can also You can also 

l set the period and time span, see the chapter set the period and time span, see the chapter Timespans and PeriodsTimespans and Periods..  
l change the chart look, see the chapter change the chart look, see the chapter Chart PropertiesChart Properties..  

CONTENTCONTENT--DEPENDENT CHART SETTINGSDEPENDENT CHART SETTINGS  

In the properties of the displayed stock (symbol), you can find additional parameters. Beside the In the properties of the displayed stock (symbol), you can find additional parameters. Beside the Standard PropertiesStandard Properties, you can find , you can find 
specific parameters for this chart type.specific parameters for this chart type.  
  
InstrumentInstrument Properties Properties  
  
InputInputInputInput  -- Select which data to use for calculating the chart (Open, High, Close, Low, Volume).  Select which data to use for calculating the chart (Open, High, Close, Low, Volume).   
  
Dotted LineDotted Line Properties Properties  
  
StyleStyleStyleStyle  -- Here you can select a symbol style, e.g. circles, squares etc. Here you can select a symbol style, e.g. circles, squares etc.  
  
SizeSizeSizeSize  -- Here you can set the symbol size. Here you can set the symbol size.  
  
Border ColorBorder ColorBorder ColorBorder Color  -- Here you can select a border color for the symbol.  Here you can select a border color for the symbol.   
  
Fill ColorFill ColorFill ColorFill Color  -- Here you can select a fill color for the symbol. Here you can select a fill color for the symbol.    

Symbol ChartSymbol Chart
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FILLED AREA CHART 
Filled area charts, as indicated by the name, are charts in which filled Filled area charts, as indicated by the name, are charts in which filled 
areas between selected input data is displayed. You can use filled area areas between selected input data is displayed. You can use filled area 
charts for: charts for: 

l Drawing a filled area between the prices and the base line (default)Drawing a filled area between the prices and the base line (default)  
l Drawing a filled area between different price levelsDrawing a filled area between different price levels  

Filled area charts are not useful for detailed symbol analysis, as too much Filled area charts are not useful for detailed symbol analysis, as too much 
information is lost in this kind of charting. information is lost in this kind of charting. 

GENERAL CHART PROPERTIESGENERAL CHART PROPERTIES  

When the chart is active, you can edit the chart properties in the toolbox, for example the history length, the axes and legends.When the chart is active, you can edit the chart properties in the toolbox, for example the history length, the axes and legends.  
  
You can also You can also 

l set the period and time span, see the chapter set the period and time span, see the chapter Timespans and PeriodsTimespans and Periods..  
l change the chart look, see the chapter change the chart look, see the chapter Chart PropertiesChart Properties..  

CONTENTCONTENT--DEPENDENT CHART SETTINGSDEPENDENT CHART SETTINGS  

In the properties of the displayed stock (symbol), you can find additional parameters. Besides the In the properties of the displayed stock (symbol), you can find additional parameters. Besides the Standard PropertiesStandard Properties, you can find , you can find 
specific parameters for this chart type.specific parameters for this chart type.  
  
InstrumentInstrument Properties Properties  
  
BaselineBaselineBaselineBaseline  -- Here you can set a value for the price baseline, e.g. raise the baseline to "40". Here you can set a value for the price baseline, e.g. raise the baseline to "40".  
  
Input AInput AInput AInput A  -- Select the data to be used as upper line of the area (Open, High, Close, Low or Volume).  Select the data to be used as upper line of the area (Open, High, Close, Low or Volume).   
  
Input BInput BInput BInput B  -- Select the data to be used as lower line of the area (Open, High, Close, Low, Volume or Baseline). Select the data to be used as lower line of the area (Open, High, Close, Low, Volume or Baseline).  
  
Filled AreaFilled Area Properties Properties  
  
Color 1Color 1Color 1Color 1  -- Here you can select a color for the top line.  Here you can select a color for the top line.   
  
Color 1Color 1Color 1Color 1  -- Here you can select a color for the bottom line.  Here you can select a color for the bottom line.   
  
Area ColorArea ColorArea ColorArea Color  -- Here you can set a color and transparency for the filled area. Here you can set a color and transparency for the filled area.    

Filled Area ChartFilled Area Chart
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FOREST CHART 
Forest charts are histograms. For each input value in the timeline, a bar Forest charts are histograms. For each input value in the timeline, a bar 
(also called "needle") is drawn. (also called "needle") is drawn.   
  
Forest charts are not useful for detailed symbol analysis, as too much Forest charts are not useful for detailed symbol analysis, as too much 
information is lost in this kind of charting. They are more commonly used information is lost in this kind of charting. They are more commonly used 
for indicators, where relative changes per day can be emphasized by for indicators, where relative changes per day can be emphasized by 
needles in different colors.needles in different colors.    
  
In Tradesignal, forest charts can be used for:In Tradesignal, forest charts can be used for:

l symbol prices (by selecting the entry in the chart menu)symbol prices (by selecting the entry in the chart menu)  
l the trading the trading VolumeVolumeVolumeVolume (in the stock properties in the toolbox; this is available as an addition for every chart type) (in the stock properties in the toolbox; this is available as an addition for every chart type)  
l indicators; however, for those, the equilla scripts have to be adapted. You can find a tutorial for doing so in the chapter indicators; however, for those, the equilla scripts have to be adapted. You can find a tutorial for doing so in the chapter 

Displaying a Momentum Indicator as Forest ChartDisplaying a Momentum Indicator as Forest Chart..  

GENERAL CHART PROPERTIESGENERAL CHART PROPERTIES  

When the chart is active, you can edit the chart properties in the toolbox, for example the history length, the axes and legends.When the chart is active, you can edit the chart properties in the toolbox, for example the history length, the axes and legends.  
  
You can also You can also 

l set the period and time span, see the chapter set the period and time span, see the chapter Timespans and PeriodsTimespans and Periods..  
l change the chart look, see the chapter change the chart look, see the chapter Chart PropertiesChart Properties..  

CONTENTCONTENT--DEPENDENT CHART SETTINGSDEPENDENT CHART SETTINGS  

In the properties of the displayed stock (symbol), you can find additional parameters. Besides the In the properties of the displayed stock (symbol), you can find additional parameters. Besides the Standard PropertiesStandard Properties, you can find , you can find 
specific parameters for this chart type.specific parameters for this chart type.  
  
InstrumentInstrument Properties Properties  
  
InputInputInputInput  -- Select which data to use for calculating the chart (Open, High, Close, Low, Volume).  Select which data to use for calculating the chart (Open, High, Close, Low, Volume).   
  
HistogramHistogram Properties Properties  
  
Histogram ColorHistogram ColorHistogram ColorHistogram Color  -- Here you can select a color for the histogram bars. Here you can select a color for the histogram bars.    

Forest ChartForest Chart



:: www.tradesignal.comwww.tradesignal.com

Tradesignal GmbHTradesignal GmbH Page 91Page 91 Version 7.0Version 7.0

TUTORIAL INDICATOR AS FOREST 
To display indicators as a forest chart, the indicator code has to be adapted To display indicators as a forest chart, the indicator code has to be adapted 
accordingly. In the following tutorial, we show you how to set up a accordingly. In the following tutorial, we show you how to set up a 
Momentum indicator as a forest chart with the needles in two different Momentum indicator as a forest chart with the needles in two different 
colors, depending on their direction.colors, depending on their direction.

THE "NORMAL" MOMENTUM INDICATORTHE "NORMAL" MOMENTUM INDICATOR  

You can find the normal Momentum Indicator in the list of all indicators in You can find the normal Momentum Indicator in the list of all indicators in 
the the ToolboxToolbox. Right. Right--click the indicator to open the context menu and choose click the indicator to open the context menu and choose 
EditEditEditEdit. The editor with the indicator's equilla code opens.. The editor with the indicator's equilla code opens.    
  

Meta:  

Synopsis( "The Momentum indicator utilizes price and volume statistics for predicting 

the strength or weakness of a current market and any overbought or oversold conditions, and 

may indicate turning points within the market." ), 

ShortCode( "MOM" ), 

SubChart( True ); 

 

Inputs:  

Price( Close ),  

Period( 10, 1 ), 

ShowAlerts( False ); 

 

DrawLine( Momentum( Price, Period ), "MOM" ); 

DrawLine( 0, "Zero Line", StyleDot ); 

 

CheckForCrossAlert( Plot1, 0, "Momentum", "Zero Line", ShowAlerts ); 

 

// *** Copyright SystemSoft GmbH *** 

// *** www.tradesignal.com *** 

COPY THE MOMENTUM INDICATOR CODE AS BASIS FOR THE NEW INDICATORCOPY THE MOMENTUM INDICATOR CODE AS BASIS FOR THE NEW INDICATOR  

1.1. Click on Click on New IndicatorNew IndicatorNew IndicatorNew Indicator in the  in the Related TasksRelated Tasks area of the toolbox to start a new indicator. Call it  area of the toolbox to start a new indicator. Call it Momentum ForestMomentum Forest..  
2.2. Copy the equilla code of the Momentum indicator into the new, empty editor window.Copy the equilla code of the Momentum indicator into the new, empty editor window.  

To do so, select the complete code with To do so, select the complete code with CTRL+ACTRL+ACTRL+ACTRL+A. Then copy the contents with . Then copy the contents with CTRL+CCTRL+CCTRL+CCTRL+C. Click into the new, empty editor window . Click into the new, empty editor window 
and press and press CTRL+VCTRL+VCTRL+VCTRL+V to insert the copied contents. Alternatively, you can find all these functions in the context menu of the editor,  to insert the copied contents. Alternatively, you can find all these functions in the context menu of the editor, 
which you can open by rightwhich you can open by right--clicking the editor window.clicking the editor window.

EDITING THE MOMENTUM FOREST INDICATOR FOR DISPLAY AS A FOREST CHARTEDITING THE MOMENTUM FOREST INDICATOR FOR DISPLAY AS A FOREST CHART  

Forest ChartForest Chart
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First, you have to delete some lines in the code we do not want to use:First, you have to delete some lines in the code we do not want to use:

l ShowAlerts( False );ShowAlerts( False ); (make sure that the line above ends with a  (make sure that the line above ends with a 
semicolon ";")semicolon ";")  

l CheckForCrossAlert( Plot1, 0, "Momentum", "Zero Line", CheckForCrossAlert( Plot1, 0, "Momentum", "Zero Line", 
ShowAlerts );ShowAlerts );  

Then you need two variables for your indicator:Then you need two variables for your indicator:

l one variable to save the momentum calculationone variable to save the momentum calculation  
l one variable to save the color setting for the forest displayone variable to save the color setting for the forest display  

For this, enter the following lines beneath the For this, enter the following lines beneath the InputsInputs area: area:

Variables:  

momValue, forestColor; 

  
  
Below this, enter the formula for the Momentum calculation:Below this, enter the formula for the Momentum calculation:  
  

//Calculate Momentum 

momValue = Momentum( Price, Period ); 

  
  
Now you need the condition for the needle colors. If the Momentum rises in comparison to the previous day, the needle should be Now you need the condition for the needle colors. If the Momentum rises in comparison to the previous day, the needle should be 
displayed in green; otherwise, the needle should be red. displayed in green; otherwise, the needle should be red.   
  

//Set color depending on the change in comparison to the previous day 

if momValue > momValue[1] then 

forestColor = DarkGreen 

else 

forestColor = Red; 

  
  
To display the result as forest chart, you have to substitute the first DrawLine line with the following: To display the result as forest chart, you have to substitute the first DrawLine line with the following:   
  

//Drawing command with color variable  

DrawForest(0, momValue,"Zero","MomentumUp",thick,forestColor,true); 

  
  
The color of the needle is given by the dynamically set variable The color of the needle is given by the dynamically set variable forestColorforestColor. The base line remains unchanged. . The base line remains unchanged.   
  

HTML Editor with Indicator CodeHTML Editor with Indicator Code
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In the META area of the code you can now edit the synopsis and enter a specific ShortCode. With the latter, you can later call up In the META area of the code you can now edit the synopsis and enter a specific ShortCode. With the latter, you can later call up 
your new indicator from the command line.your new indicator from the command line.

COMPILING AND APPLYING THE MOMENTUM FOREST INDICATORCOMPILING AND APPLYING THE MOMENTUM FOREST INDICATOR  

Meta:  

Synopsis( "The Momentum Forest is a variation of the Momentum Indicator, displaying the 

values in Forest fashion with color coding for up/down development. The Momentum indicator 

utilizes price and volume statistics for predicting the strength or weakness of a current 

market and any overbought or oversold conditions, and may indicate turning points within the 

market." ), 

ShortCode( "MOMF" ), 

SubChart( True ); 

 

Inputs:  

Price( Close ),  

Period( 10, 1 ); 

 

Variables:  

momValue, forestColor; 

 

//Calculate Momentum 

momValue = Momentum( Price, Period ); 

 

//Set color depending on the change in comparison to the previous day 

if momValue > momValue[1] then 

forestColor = DarkGreen 

else 

forestColor = Red; 

 

//Drawing command with color variable  

DrawForest(0, MomValue,"Zero","MomentumUp",thick,forestColor,true); 

DrawLine( 0, "ZeroLine", StyleDot) 

 

// *** Copyright tradesignal GmbH *** 

// *** www.tradesignal.com *** 

  
  
Compile the indicator by pressing the Compile the indicator by pressing the F7F7F7F7 key or by clicking the  key or by clicking the Compile ScriptCompile ScriptCompile ScriptCompile Script button in the Equilla menu in the toolbar.  button in the Equilla menu in the toolbar.   
  
The indicator is now available in the indicator list in the toolbox. From there, you can apply it to a chart by either pulling it into a The indicator is now available in the indicator list in the toolbox. From there, you can apply it to a chart by either pulling it into a 
chart via drag&drop or by selecting chart via drag&drop or by selecting ApplyApplyApplyApply from the context menu. from the context menu.    
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LINKED FOREST CHART 
The linked forest differs only marginally from the The linked forest differs only marginally from the Forest ChartForest Chart. The top of . The top of 
the needles are connected by a line. Other than that, the chart is identical the needles are connected by a line. Other than that, the chart is identical 
to the forest chart.to the forest chart.  
  
This chart is less helpful for symbol charting, as the connection with the This chart is less helpful for symbol charting, as the connection with the 
baseline can lead to distorted values for longer histories.baseline can lead to distorted values for longer histories.

GENERAL CHART PROPERTIESGENERAL CHART PROPERTIES  

When the chart is active, you can edit the chart properties in the toolbox, for example the history length, the axes and legends.When the chart is active, you can edit the chart properties in the toolbox, for example the history length, the axes and legends.  
  
You can also You can also 

l set the period and time span, see the chapter set the period and time span, see the chapter Timespans and PeriodsTimespans and Periods..  
l change the chart look, see the chapter change the chart look, see the chapter Chart PropertiesChart Properties..  

CONTENTCONTENT--DEPENDENT CHART SETTINGSDEPENDENT CHART SETTINGS  

You can find the symbol parameters in the properties of the displayed stock (symbol), see the chapter You can find the symbol parameters in the properties of the displayed stock (symbol), see the chapter Forest ChartForest Chart..    

Linked Forest ChartLinked Forest Chart
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CANDLE VOLUME CHART 
Candle volume charts combine charts of prices and volumes. The following Candle volume charts combine charts of prices and volumes. The following 
information is available: information is available: 

l The high of the trading period, given by the end of the upper The high of the trading period, given by the end of the upper 
shadow.shadow.  

l The low of the trading period, given by the end of the lower The low of the trading period, given by the end of the lower 
shadow.shadow.  

l The open price, given by the body edge; either the bottom line in the The open price, given by the body edge; either the bottom line in the 
case of an upwards development, or the top line in the case of a case of an upwards development, or the top line in the case of a 
downwards development.downwards development.  

l The close price, given by the body edge; either the top line in the The close price, given by the body edge; either the top line in the 
case of an upward development, or the bottom line in the case of a downward development.case of an upward development, or the bottom line in the case of a downward development.  

l The direction of the price movement, given by the body color. Colors are usually red or black for falling and green or white The direction of the price movement, given by the body color. Colors are usually red or black for falling and green or white 
for rising prices. The color settings can be changed.for rising prices. The color settings can be changed.  

l The magnitude of the price movement, given by the length of the body and the shadows. The total length of a candlestick The magnitude of the price movement, given by the length of the body and the shadows. The total length of a candlestick 
between the wicks is the difference between high and low.between the wicks is the difference between high and low.  

l The trading volume, given by the width of the candle body.The trading volume, given by the width of the candle body.  

Candle volume charts are a mixture of candlestick and equi volume charts. The candle interpretation is the same as for Candle volume charts are a mixture of candlestick and equi volume charts. The candle interpretation is the same as for Candlestick Candlestick 
ChartsCharts, but the width of the candle depends on volume, not on time. The difference to , but the width of the candle depends on volume, not on time. The difference to Equi Volume ChartsEqui Volume Charts is that, as opposed to  is that, as opposed to 
that chart type, the open and close prices are still available in the candle volume charts.that chart type, the open and close prices are still available in the candle volume charts.  

LIMITATIONSLIMITATIONS  

At each end of the quarter, there is an expiration date on which futures of stocks, indices and commodities expire and/or new At each end of the quarter, there is an expiration date on which futures of stocks, indices and commodities expire and/or new 
futures are issued. On these days, there are often extremely high trading volumes for symbols. Candle volume charts may be overly futures are issued. On these days, there are often extremely high trading volumes for symbols. Candle volume charts may be overly 
influenced by them, resulting in no sensible values for these dates. To avoid this issue, ignore these dates.influenced by them, resulting in no sensible values for these dates. To avoid this issue, ignore these dates.

GENERAL CHART PROPERTIESGENERAL CHART PROPERTIES  

When the chart is active, you can edit the chart properties in the toolbox, for example the history length, the axes and legends.When the chart is active, you can edit the chart properties in the toolbox, for example the history length, the axes and legends.  
  
You can also You can also 

l set the period and time span, see the chapter set the period and time span, see the chapter Timespans and PeriodsTimespans and Periods..  
l change the chart look, see the chapter change the chart look, see the chapter Chart PropertiesChart Properties..  

CONTENTCONTENT--DEPENDENT CHART SETTINGSDEPENDENT CHART SETTINGS  

In the properties of the displayed stock (symbol), you can find additional parameters. Besides the In the properties of the displayed stock (symbol), you can find additional parameters. Besides the Standard PropertiesStandard Properties, you can find , you can find 
specific parameters for this chart type.specific parameters for this chart type.  
  

Candle Volume ChartCandle Volume Chart
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Candle VolumeCandle Volume Properties Properties  
  
Border ColorBorder ColorBorder ColorBorder Color  -- Here you can select a color for the border.  Here you can select a color for the border.   
  
Show FrameShow FrameShow FrameShow Frame  -- Here you can select whether the candle frame will be displayed or hidden.  Here you can select whether the candle frame will be displayed or hidden.   
  
Bullish ColorBullish ColorBullish ColorBullish Color  -- Here you can select a color and opacity for upward candles.  Here you can select a color and opacity for upward candles.   
  
Bearish ColorBearish ColorBearish ColorBearish Color  -- Here you can select a color and opacity for downward candles. Here you can select a color and opacity for downward candles.    
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EQUI VOLUME CHART 
Equivolume charts are a combination of price movement and trading Equivolume charts are a combination of price movement and trading 
volume charts. The chart gives information on high, low, volume and price volume charts. The chart gives information on high, low, volume and price 
direction per trading period. direction per trading period.   
  
Equivolume charts were introduced by Richard W. Arms Jr. It was wellEquivolume charts were introduced by Richard W. Arms Jr. It was well--
known that the trading volume was an important criterion for assessing the known that the trading volume was an important criterion for assessing the 
current and future situation in the market. Arms consequently introduced current and future situation in the market. Arms consequently introduced 
the volume the volume -- which up to that date was only displayed as an additional  which up to that date was only displayed as an additional 
histogram histogram -- into the chart itself by plotting price versus volume. This way,  into the chart itself by plotting price versus volume. This way, 
information about open and close prices and the normal time line are lost.information about open and close prices and the normal time line are lost.

TRADING INFORMATION IN EQUI VOLUME CHARTSTRADING INFORMATION IN EQUI VOLUME CHARTS  

The following information is available in the boxes:The following information is available in the boxes:

l The high per trading period, given by the top line of the boxThe high per trading period, given by the top line of the box  
l The low per trading period, given by the bottom line of the boxThe low per trading period, given by the bottom line of the box  
l The trading volume, given by the width of the box. Because of this display choice, the timeline information is distorted.The trading volume, given by the width of the box. Because of this display choice, the timeline information is distorted.  
l The direction of the price movement, given by the box color. Colors are usually red or black for falling and green or white for The direction of the price movement, given by the box color. Colors are usually red or black for falling and green or white for 

rising prices. The color settings can be changed.rising prices. The color settings can be changed.  

The open and close prices are not given in this chart type. However, this limitation is compensated by the strong visual display of The open and close prices are not given in this chart type. However, this limitation is compensated by the strong visual display of 
buying powers and selling pressures within a market.buying powers and selling pressures within a market.

PATTERN IN EQUIVOLUME CHARTSPATTERN IN EQUIVOLUME CHARTS  

Equi Volume ChartEqui Volume Chart
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In equivolume charts, four typical patterns can be found that give In equivolume charts, four typical patterns can be found that give 
information on the current market and trends, similar to single candles in information on the current market and trends, similar to single candles in 
candlestick charts. See the graphic for more details.candlestick charts. See the graphic for more details.    
  
Narrow BarsNarrow BarsNarrow BarsNarrow Bars  -- Usually seen in balanced markets. The price movements  Usually seen in balanced markets. The price movements 
result from relatively small trading volumes. Several consecutive narrow result from relatively small trading volumes. Several consecutive narrow 
bars may signal a distinctive trend setting in, though not as strong as one bars may signal a distinctive trend setting in, though not as strong as one 
indicated by power bars, see below. indicated by power bars, see below.   
  
SquaresSquaresSquaresSquares  -- The price spans are small although there is significant trading  The price spans are small although there is significant trading 
activity. The pattern may indicate resistance areas in the chart or appear activity. The pattern may indicate resistance areas in the chart or appear 
exactly at the point of trend or resistance lines. Insecurity rules the market, exactly at the point of trend or resistance lines. Insecurity rules the market, 
and the resulting wins and losses were achieved under counter pressure.and the resulting wins and losses were achieved under counter pressure.  
  
OversquaresOversquaresOversquaresOversquares  -- Both sides of the market are strongly into trading. Large ask  Both sides of the market are strongly into trading. Large ask 
volumes have met large bid volumes. The price span is very small. The volumes have met large bid volumes. The price span is very small. The 
pattern can be interpreted as trend reversal and be combined with other pattern can be interpreted as trend reversal and be combined with other 
triggers in charts.triggers in charts.  
  
Power BarsPower BarsPower BarsPower Bars  -- Named after the snack food. In an equivolume chart, Power  Named after the snack food. In an equivolume chart, Power 
Bars result from a large price movement based on an active market. They Bars result from a large price movement based on an active market. They 
can be interpreted as important breaks and be combined with other triggers can be interpreted as important breaks and be combined with other triggers 
in charts.in charts.

GENERAL CHART PROPERTIESGENERAL CHART PROPERTIES  

When the chart is active, you can edit the chart properties in the toolbox, When the chart is active, you can edit the chart properties in the toolbox, 
for example the history length, the axes and legends.for example the history length, the axes and legends.  
  
You can also You can also 

l set the period and time span, see the chapter set the period and time span, see the chapter Timespans and PeriodsTimespans and Periods..  
l change the chart look, see the chapter change the chart look, see the chapter Chart PropertiesChart Properties..  

CONTENTCONTENT--DEPENDENT CHART SETTINGSDEPENDENT CHART SETTINGS  

In the properties of the displayed stock (symbol), you can find additional parameters. Besides the In the properties of the displayed stock (symbol), you can find additional parameters. Besides the Standard PropertiesStandard Properties, you can find , you can find 
specific parameters for this chart type.specific parameters for this chart type.  
  
Equi VolumeEqui Volume Properties Properties  
  
Border ColorBorder ColorBorder ColorBorder Color  -- Here you can select a color for the border.  Here you can select a color for the border.   
  

A Single BarA Single Bar

Bar SchemataBar Schemata

Equi Volume PatternEqui Volume Pattern
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Show FrameShow FrameShow FrameShow Frame  -- Here you can select whether the candle frame will be displayed or hidden.  Here you can select whether the candle frame will be displayed or hidden.   
  
Bullish ColorBullish ColorBullish ColorBullish Color  -- Here you can select a color and opacity for upward boxes.  Here you can select a color and opacity for upward boxes.   
  
Bearish ColorBearish ColorBearish ColorBearish Color  -- Here you can select a color and opacity for downward boxes. Here you can select a color and opacity for downward boxes.

LINKSLINKS  

Equivolume Charts by Richard ArmsEquivolume Charts by Richard Arms    
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KAGI CHART 
Kagi charts originated in Japan like the Kagi charts originated in Japan like the Candlestick ChartsCandlestick Charts. They are . They are 
related to related to RenkoRenko and  and Three Line BreakThree Line Break charts. charts.  
  
A Kagi chart consists of vertical lines that are connected by horizontal lines. A Kagi chart consists of vertical lines that are connected by horizontal lines. 
The direction of the vertical lines is drawn depending on the price The direction of the vertical lines is drawn depending on the price 
movements. The time relation, trading volume and chart information such movements. The time relation, trading volume and chart information such 
as high and low prices are not taken into account. as high and low prices are not taken into account.   
  
Kagi charts display the bid and ask, i.e. the trend of the market. Kagi charts display the bid and ask, i.e. the trend of the market. 

CONSTRUCTION AND INFORMATION IN A KAGI CHARTCONSTRUCTION AND INFORMATION IN A KAGI CHART  

In a Kagi chart, a vertical line is drawn as long as the current price direction is maintained. If a trend reversal takes place in the In a Kagi chart, a vertical line is drawn as long as the current price direction is maintained. If a trend reversal takes place in the 
price development, the price has to be at least as large as the defined reversal amount to cause a trend reversal in the chart. In price development, the price has to be at least as large as the defined reversal amount to cause a trend reversal in the chart. In 
case of a trend reversal, a horizontal line is drawn to the next "column" and a vertical line is started in the other price direction. case of a trend reversal, a horizontal line is drawn to the next "column" and a vertical line is started in the other price direction.   
  
The time elapsed is unimportant for this kind of charting. The time axis is not linear.The time elapsed is unimportant for this kind of charting. The time axis is not linear.  
  
Increasing and decreasing prices are shown in different colors, e.g. black/red. The colors can be set in the properties. Increasing and decreasing prices are shown in different colors, e.g. black/red. The colors can be set in the properties.   
  
When trading with Kagi charts, remember that the filtering effect inherent to the method leads to delayed signal generation.When trading with Kagi charts, remember that the filtering effect inherent to the method leads to delayed signal generation.

GENERAL CHART PROPERTIESGENERAL CHART PROPERTIES  

When the chart is active, you can edit the chart properties in the toolbox, for example the history length, the axes and legends.When the chart is active, you can edit the chart properties in the toolbox, for example the history length, the axes and legends.  
  
You can also You can also 

l set the period and time span, see the chapter set the period and time span, see the chapter Timespans and PeriodsTimespans and Periods..  
l change the chart look, see the chapter change the chart look, see the chapter Chart PropertiesChart Properties..  

CONTENTCONTENT--DEPENDENT CHART SETTINGSDEPENDENT CHART SETTINGS  

In the properties of the displayed stock (symbol), you can find additional parameters. Besides the In the properties of the displayed stock (symbol), you can find additional parameters. Besides the Standard PropertiesStandard Properties, you can find , you can find 
specific parameters for this chart type.specific parameters for this chart type.  
  
InstrumentInstrument Properties Properties  
  
ReversalReversalReversalReversal  -- Enter a reversal value here. In case of a trend change, the price has to move by at least the reversal amount before a  Enter a reversal value here. In case of a trend change, the price has to move by at least the reversal amount before a 

Kagi ChartKagi Chart
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new vertical line in the opposite direction is drawn in the Kagi chart. new vertical line in the opposite direction is drawn in the Kagi chart.   
  
KagiKagi Properties Properties  
  
Bullish ColorBullish ColorBullish ColorBullish Color  -- Here you can select a color for the bullish line.  Here you can select a color for the bullish line.   
  
Bullish WidthBullish WidthBullish WidthBullish Width  -- Here you can set a bullish line width by entering a number. Here you can set a bullish line width by entering a number.  
  
Bearish ColorBearish ColorBearish ColorBearish Color  -- Here you can select a color for the bearish line.  Here you can select a color for the bearish line.   
  
Bearish WidthBearish WidthBearish WidthBearish Width  -- Here you can set a bearish line width by entering a number. Here you can set a bearish line width by entering a number.

LINKS AND BOOKSLINKS AND BOOKS  

Beyond Candlesticks Beyond Candlesticks -- Steve Nison Steve Nison    
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RENKO CHART 
Renko charts originated in Japan like the Renko charts originated in Japan like the Candlestick ChartsCandlestick Charts. They are . They are 
related to related to KagiKagi and  and Three Line BreakThree Line Break charts. The name derived from the  charts. The name derived from the 
Japanese word Japanese word RengaRenga for bricks. for bricks.    
  
A Renko chart consists of bricks. Only one input, e.g. the daily close is A Renko chart consists of bricks. Only one input, e.g. the daily close is 
necessary for drawing a Renko chart. The time relation, trading volume and necessary for drawing a Renko chart. The time relation, trading volume and 
chart information such as high and low prices are not taken into account. chart information such as high and low prices are not taken into account.   
  
Renko charts show the trend of the market. Renko charts show the trend of the market. 

CONSTRUCTION AND INFORMATION IN A RENKO CHARTCONSTRUCTION AND INFORMATION IN A RENKO CHART  

In a Renko chart, a brick is drawn if the price moved by a defined amount, called the In a Renko chart, a brick is drawn if the price moved by a defined amount, called the bricksizebricksizebricksizebricksize. The price of the current day is . The price of the current day is 
always compared to the price of the last brick (which can be much older than a day). The Renko chart drops all price movements always compared to the price of the last brick (which can be much older than a day). The Renko chart drops all price movements 
smaller than the bricksize. Therefore, only major trends of a stock are visible in the Renko chart. Small movements fall out of the smaller than the bricksize. Therefore, only major trends of a stock are visible in the Renko chart. Small movements fall out of the 
graph.graph.  
  
The time elapsed is unimportant for this kind of charting. The time axis is not linear.The time elapsed is unimportant for this kind of charting. The time axis is not linear.  
  
Bricks of downward and upward direction are displayed in different colors, e.g. black/red. The colors can be set in the properties. Bricks of downward and upward direction are displayed in different colors, e.g. black/red. The colors can be set in the properties.   
  
When trading with Renko charts, remember that the filtering effect inherent to the method leads to delayed signal generation.When trading with Renko charts, remember that the filtering effect inherent to the method leads to delayed signal generation.

GENERAL CHART PROPERTIESGENERAL CHART PROPERTIES  

When the chart is active, you can edit the chart properties in the toolbox, for example the history length, the axes and legends.When the chart is active, you can edit the chart properties in the toolbox, for example the history length, the axes and legends.  
  
You can also You can also 

l set the period and time span, see the chapter set the period and time span, see the chapter Timespans and PeriodsTimespans and Periods..  
l change the chart look, see the chapter change the chart look, see the chapter Chart PropertiesChart Properties..  

CONTENTCONTENT--DEPENDENT CHART SETTINGSDEPENDENT CHART SETTINGS  

In the properties of the displayed stock (symbol), you can find additional parameters. Besides the In the properties of the displayed stock (symbol), you can find additional parameters. Besides the Standard PropertiesStandard Properties, you can find , you can find 
specific parameters for this chart type.specific parameters for this chart type.  
  
InstrumentInstrument Properties Properties  
  

Renko ChartRenko Chart
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InputInputInputInput  -- Select which data to use for calculating the chart (Open, High, Close, Low, Volume). Select which data to use for calculating the chart (Open, High, Close, Low, Volume).  
  
BricksizeBricksizeBricksizeBricksize  -- Enter how many ticks give a brick, or enter a percentage value (e.g. "10%"). The bricksize works like a noise filter. It  Enter how many ticks give a brick, or enter a percentage value (e.g. "10%"). The bricksize works like a noise filter. It 
defines how much the input has to move from the last given brick value before a new brick is drawn. defines how much the input has to move from the last given brick value before a new brick is drawn.   
  
ReversalReversalReversalReversal  -- Enter the number of bricks that have to be generated in the reverse direction to cause a change in trend. The higher the  Enter the number of bricks that have to be generated in the reverse direction to cause a change in trend. The higher the 
value, the stronger the trend reversal has to be to be displayed in the Renko chart. value, the stronger the trend reversal has to be to be displayed in the Renko chart.   
  
Compress BricksCompress BricksCompress BricksCompress Bricks  -- Here you can select whether bricks of the same price will be merged.  Here you can select whether bricks of the same price will be merged.   
  
Daily RestartDaily RestartDaily RestartDaily Restart  -- Here you can select whether the Renko chart calculation should start anew each day.  Here you can select whether the Renko chart calculation should start anew each day.   
  
Startvalue from OpenStartvalue from OpenStartvalue from OpenStartvalue from Open  -- Here you can select whether instead of the input given above, the open value should always be used as  Here you can select whether instead of the input given above, the open value should always be used as 
start value. start value.   
  
RenkoRenko Properties Properties  
  
ColorColorColorColor  -- Here you can select a color for the line border. Here you can select a color for the line border.  
  
Bullish ColorBullish ColorBullish ColorBullish Color  -- Here you can select a color and opacity for the bullish brick.  Here you can select a color and opacity for the bullish brick.   
  
Bearish ColorBearish ColorBearish ColorBearish Color  -- Here you can select a color and opacity for the bearish brick. Here you can select a color and opacity for the bearish brick.  
  
Open ColorOpen ColorOpen ColorOpen Color  -- Select the color for open bricks, i.e. if no close price is available yet.  Select the color for open bricks, i.e. if no close price is available yet.   
  
Show ThresholdsShow ThresholdsShow ThresholdsShow Thresholds  -- Here you can select whether the price levels that have to be crossed to result in new bricks should be  Here you can select whether the price levels that have to be crossed to result in new bricks should be 
displayed as small, rightdisplayed as small, right--aligned lines in the chart.aligned lines in the chart.  
  
Artificial Brick HighlightArtificial Brick HighlightArtificial Brick HighlightArtificial Brick Highlight  -- Here you can select whether bricks that were artificially created due to price gaps between bricks  Here you can select whether bricks that were artificially created due to price gaps between bricks 
should be highlighted by transparent colors. Select a transparency from the list.should be highlighted by transparent colors. Select a transparency from the list.

LINKS AND BOOKSLINKS AND BOOKS  

Beyond Candlesticks Beyond Candlesticks -- Steve Nison Steve Nison    
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THREE LINE BREAK CHART 
Three Line Break charts originated in Japan like the Three Line Break charts originated in Japan like the Candlestick ChartsCandlestick Charts. . 
They are related to They are related to KagiKagi and  and RenkoRenko charts. charts.  
  
A Three Line Break chart consists of vertical lines ("boxes") connected to A Three Line Break chart consists of vertical lines ("boxes") connected to 
each other. The direction of the lines is drawn based on price movements. each other. The direction of the lines is drawn based on price movements. 
The time relation, trading volume and chart information such as high and The time relation, trading volume and chart information such as high and 
low prices are not taken into account. low prices are not taken into account.   
  
Three Line Break charts are especially useful for detecting changes in Three Line Break charts are especially useful for detecting changes in 
trends. trends. 

CONSTRUCTION AND INFORMATION IN A THREECONSTRUCTION AND INFORMATION IN A THREE--LINELINE--BREAK CHARTBREAK CHART  

A Three Line Break chart differs from traditional chart types.A Three Line Break chart differs from traditional chart types.

l In principle, a new line is drawn when the price exceeds the previous price's high or low. If the price does not exceed the In principle, a new line is drawn when the price exceeds the previous price's high or low. If the price does not exceed the 
price benchmarks of the day before, no line is drawn.price benchmarks of the day before, no line is drawn.  

l For a "Three Line Break", the same rule applies; however, after three lines of the same color, the price must reverse the For a "Three Line Break", the same rule applies; however, after three lines of the same color, the price must reverse the 
amount of the last three lines to cause a trend change in the graph.amount of the last three lines to cause a trend change in the graph. Price movements that lead neither to a reversal nor to a  Price movements that lead neither to a reversal nor to a 
line of the current direction are ignored.line of the current direction are ignored.  

The number of lines taken into account for the break is given by the The number of lines taken into account for the break is given by the ReversalReversalReversalReversal parameter. For short parameter. For short--term trades it might be smaller term trades it might be smaller 
than 3, for longthan 3, for long--term trades 4 or higher. The setting "3" is the default value that gave the method its name. Please note that the term trades 4 or higher. The setting "3" is the default value that gave the method its name. Please note that the 
Reversal parameter gives the number of lines to be taken into account, not a fixed price value as for the related methods Kagi and Reversal parameter gives the number of lines to be taken into account, not a fixed price value as for the related methods Kagi and 
Renko. Therefore, the price at which the trend change occurs in the chart is relative.Renko. Therefore, the price at which the trend change occurs in the chart is relative.    
  
The time elapsed is unimportant for this kind of charting. The time axis is not linear.The time elapsed is unimportant for this kind of charting. The time axis is not linear.  
  
Lines (boxes) of downward and upward direction are displayed in different colors, e.g. black/red. The colors can be set in the Lines (boxes) of downward and upward direction are displayed in different colors, e.g. black/red. The colors can be set in the 
properties. properties.   
  
For a Three Line Break chart, a typical 'buy' signal is a trend change after three downwards lines, while a 'sell' signal is a trend For a Three Line Break chart, a typical 'buy' signal is a trend change after three downwards lines, while a 'sell' signal is a trend 
change after three upwards. Remember that the filtering effect inherent to the method leads to delayed signal generation.change after three upwards. Remember that the filtering effect inherent to the method leads to delayed signal generation.

GENERAL CHART PROPERTIESGENERAL CHART PROPERTIES  

When the chart is active, you can edit the chart properties in the toolbox, for example the history length, the axes and legends.When the chart is active, you can edit the chart properties in the toolbox, for example the history length, the axes and legends.  
  
You can also You can also 

l set the period and time span, see the chapter set the period and time span, see the chapter Timespans and PeriodsTimespans and Periods..  

Three Line Break ChartThree Line Break Chart
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l change the chart look, see the chapter change the chart look, see the chapter Chart PropertiesChart Properties..  

CONTENTCONTENT--DEPENDENT CHART SETTINGSDEPENDENT CHART SETTINGS  

In the properties of the displayed stock (symbol), you can find additional parameters. Besides the In the properties of the displayed stock (symbol), you can find additional parameters. Besides the Standard PropertiesStandard Properties, you can find , you can find 
specific parameters for this chart type.specific parameters for this chart type.  
  
InstrumentInstrument Properties Properties  
  
ReversalReversalReversalReversal  -- Enter the number of lines to be taken into account for determining trend reversals. Enter the number of lines to be taken into account for determining trend reversals.  
  
InputInputInputInput  -- Select which data to use for calculating the chart (Open, High, Close, Low, Volume). Select which data to use for calculating the chart (Open, High, Close, Low, Volume).  
  
Three Line BreakThree Line Break Properties Properties  
  
Border ColorBorder ColorBorder ColorBorder Color  -- Here you can select a color for the line border. Here you can select a color for the line border.  
  
Bullish ColorBullish ColorBullish ColorBullish Color  -- Here you can select a color for the bullish line.  Here you can select a color for the bullish line.   
  
Bearish ColorBearish ColorBearish ColorBearish Color  -- Here you can select a color for the bearish line. Here you can select a color for the bearish line.

LINKS AND BOOKSLINKS AND BOOKS  

Beyond Candlesticks Beyond Candlesticks -- Steve Nison Steve Nison    
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HEIKIN ASHI CHART 
At a first glance Heikin Ashi charts are very similar to At a first glance Heikin Ashi charts are very similar to Candlestick chartsCandlestick charts. It . It 
is also a charting style originally from Japan and uses candles to visualize is also a charting style originally from Japan and uses candles to visualize 
prices and their movement. Heikin Ashi charts are based on averaged prices and their movement. Heikin Ashi charts are based on averaged 
prices, a result of this is the noticeable absence of gaps between candle prices, a result of this is the noticeable absence of gaps between candle 
bodies which makes it easier to recognize price trends.bodies which makes it easier to recognize price trends.  
  
Like other candlestick charts it gives information about the open, high, low Like other candlestick charts it gives information about the open, high, low 
and close prices and about the direction and magnitude of the price and close prices and about the direction and magnitude of the price 
movement. It is this wealth of information and the distinct patterns that movement. It is this wealth of information and the distinct patterns that 
makes the candlestick charts so interesting. The direction and movement of makes the candlestick charts so interesting. The direction and movement of 
prices can be better perceived than by using bars. More complex candlestick patterns are often used as the basis for trading prices can be better perceived than by using bars. More complex candlestick patterns are often used as the basis for trading 
decisions.decisions.

FORMULASFORMULAS  

The Heikin Ashi chart type uses the following formulas to compute each candle's values.The Heikin Ashi chart type uses the following formulas to compute each candle's values.  
  
In the following equations let In the following equations let openopenopenopen, , closeclosecloseclose, , highhighhighhigh, , lowlowlowlow denote the input values and  denote the input values and haOpenhaOpenhaOpenhaOpen, , haClosehaClosehaClosehaClose, , haHighhaHighhaHighhaHigh and  and haLowhaLowhaLowhaLow the  the 
corresponding Heikin Ashi values.corresponding Heikin Ashi values.

For the first candle Heikin Ashi uses for its For the first candle Heikin Ashi uses for its haOpenhaOpenhaOpenhaOpen--value the value the openopenopenopen--value of the input, subsequent candles use the arithmetic value of the input, subsequent candles use the arithmetic 
average ofaverage of the previous candle's  the previous candle's haOpenhaOpenhaOpenhaOpen and  and haClosehaClosehaClosehaClose--values.values.

TRADING INFORMATION IN HEIKIN ASHITRADING INFORMATION IN HEIKIN ASHI  

A Heikin Ashi ChartA Heikin Ashi Chart

Heikin Ashi formulasHeikin Ashi formulas
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The following information is available in the candle body and the shadows The following information is available in the candle body and the shadows 
(the lines on bottom and top, also called wicks):(the lines on bottom and top, also called wicks):

l The high of the trading period, given by the end of the upper The high of the trading period, given by the end of the upper 
shadow.shadow.  

l The low of the trading period, given by the end of the lower The low of the trading period, given by the end of the lower 
shadow.shadow.  

l The open price, given by the body edge; either the bottom line in the The open price, given by the body edge; either the bottom line in the 
case of an upwards development, or the top line in the case of a case of an upwards development, or the top line in the case of a 
downwards development.downwards development.  

l The close price, given by the body edge; either the top line in the The close price, given by the body edge; either the top line in the 
case of an upward development, or the bottom line in the case of a case of an upward development, or the bottom line in the case of a 
downward development.downward development.  

l The direction of the price movement, given by the body color. Colors The direction of the price movement, given by the body color. Colors 
are usually red or black for falling and green or white for rising are usually red or black for falling and green or white for rising 
prices. The color settings can be changed.prices. The color settings can be changed.  

l The magnitude of the price movement, given by the length of the body and the shadows. The total length of a candlestick The magnitude of the price movement, given by the length of the body and the shadows. The total length of a candlestick 
between the wicks is the difference between high and low.between the wicks is the difference between high and low.  

More information can be gathered when several candlesticks are seen in context. Patterns of up to three candles are used to take a More information can be gathered when several candlesticks are seen in context. Patterns of up to three candles are used to take a 
closer look at the price movements and their quality. For example, candles with bodies of the same color show more pronounced closer look at the price movements and their quality. For example, candles with bodies of the same color show more pronounced 
trends. Trading is often done based on a mixture of candlestick pattern analysis and other methods.trends. Trading is often done based on a mixture of candlestick pattern analysis and other methods.

GENERAL CHART PROPERTIESGENERAL CHART PROPERTIES  

When the chart is active, you can edit the chart properties in the toolbox, for example the history length, the axes and legends.When the chart is active, you can edit the chart properties in the toolbox, for example the history length, the axes and legends.  
  
You can alsoYou can also

l set the trading period and timespans, see the chapter set the trading period and timespans, see the chapter Timespans and PeriodsTimespans and Periods..  
l change the chart look, see the chapter change the chart look, see the chapter Chart PropertiesChart Properties..  

CONTENTCONTENT--DEPENDENT CHART SETTINGSDEPENDENT CHART SETTINGS  

In the properties of the displayed stock (symbol), you can find additional parameters. Besides the In the properties of the displayed stock (symbol), you can find additional parameters. Besides the Standard PropertiesStandard Properties, you can find , you can find 
specific parameters for this chart type.specific parameters for this chart type.  
  
CandlesCandles Properties Properties  
  
Border ColorBorder ColorBorder ColorBorder Color  -- Here you can select a color for the border.  Here you can select a color for the border.   
  
Show FrameShow FrameShow FrameShow Frame  -- Here you can select whether the candle frame will be displayed or hidden.  Here you can select whether the candle frame will be displayed or hidden.   
  

A Single CandlestickA Single Candlestick
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Bullish ColorBullish ColorBullish ColorBullish Color  -- Here you can select a color and opacity for upward candles.  Here you can select a color and opacity for upward candles.   
  
Bearish ColorBearish ColorBearish ColorBearish Color  -- Here you can select a color and opacity for downward candles. Here you can select a color and opacity for downward candles.

INDICATORS AND STRATEGIESINDICATORS AND STRATEGIES  

In the indicator overview, you can find the indicator In the indicator overview, you can find the indicator Candle PatternCandle PatternCandle PatternCandle Pattern which includes a long list of typical candlestick patterns to  which includes a long list of typical candlestick patterns to 
choose from. You can edit these patterns in the graph properties in the toolbox. The set pattern is displayed in the graph. choose from. You can edit these patterns in the graph properties in the toolbox. The set pattern is displayed in the graph.   
  
In the strategies overview, you can find strategies such as In the strategies overview, you can find strategies such as Candle Bearish Engulfing Candle Bearish Engulfing Candle Bearish Engulfing Candle Bearish Engulfing ---- Exit Exit Exit Exit, , Candle Big White Candlestick Candle Big White Candlestick Candle Big White Candlestick Candle Big White Candlestick ----    
ExitExitExitExit, and many more that you can apply to your candlestick chart. , and many more that you can apply to your candlestick chart. 

LINKS AND BOOKSLINKS AND BOOKS  

l Candlestick Charts in the WikipediaCandlestick Charts in the Wikipedia  
l HeikinHeikin--Ashi from Dan VacluAshi from Dan Vaclu  
l HeikinHeikin--Ashi WebsiteAshi Website  
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POINT&FIGURE CHART 
Point and Figure Charts (P&F charts) are an old charting type that is Point and Figure Charts (P&F charts) are an old charting type that is 
independent of time. independent of time.   
  
P&F charts show two kinds of symbols. Depending on the price movement P&F charts show two kinds of symbols. Depending on the price movement 
and range, a number of symbols are drawn. The time relation and trading and range, a number of symbols are drawn. The time relation and trading 
volume are not taken into account. volume are not taken into account.   
  
Point and Figure charts are helpful for trend detection, as they show trends Point and Figure charts are helpful for trend detection, as they show trends 
as well as easily identifiable resistance and support zones. There are also as well as easily identifiable resistance and support zones. There are also 
Equilla indicatorsEquilla indicators for 45 degree trend lines and support resistance levels. for 45 degree trend lines and support resistance levels.

TRADING INFORMATION IN A P&F CHARTTRADING INFORMATION IN A P&F CHART  

A P&F chart consists of columns of symbols of the same type.A P&F chart consists of columns of symbols of the same type.

l Rising prices are drawn with crosses (also called Xs).Rising prices are drawn with crosses (also called Xs).  
l Falling prices are drawn with circles (also called Os).Falling prices are drawn with circles (also called Os).  

In a P&F chart these symbols are called boxes and cover a certain price range known as the box size. A new symbol is added to a In a P&F chart these symbols are called boxes and cover a certain price range known as the box size. A new symbol is added to a 
column once the price movement of the instrument exceeds the box size of the box in trend direction, i.e. in an Xcolumn once the price movement of the instrument exceeds the box size of the box in trend direction, i.e. in an X--column (rising column (rising 
prices) a new box is drawn when the prices reaches a value above the new box's price range. Movements below that value are prices) a new box is drawn when the prices reaches a value above the new box's price range. Movements below that value are 
ignored. This way, the box size determines how much the price movements are filtered. Large box sizes filter many movements. ignored. This way, the box size determines how much the price movements are filtered. Large box sizes filter many movements. 
Small box sizes show movements better, but also have a smaller filter effect.Small box sizes show movements better, but also have a smaller filter effect.  
  
The reversal parameter of a P&F chart dictates by how many box sizes the price movement has to change in order to establish a The reversal parameter of a P&F chart dictates by how many box sizes the price movement has to change in order to establish a 
new trend which also entails drawing a new column of the opposite type of boxes. For example: for a Reversal value of "3", after a new trend which also entails drawing a new column of the opposite type of boxes. For example: for a Reversal value of "3", after a 
breakout, the counter trend has to exceed three box sizes to change the trend in the chart. Please note that the Reversal parameter breakout, the counter trend has to exceed three box sizes to change the trend in the chart. Please note that the Reversal parameter 
gives the number of boxes to be taken into account, not a fixed price value as for the related methods Kagi and Renko. Therefore, gives the number of boxes to be taken into account, not a fixed price value as for the related methods Kagi and Renko. Therefore, 
the price at which the trend change occurs in the chart is relative. Price movements that lead neither to a reversal nor to a new the price at which the trend change occurs in the chart is relative. Price movements that lead neither to a reversal nor to a new 
symbol of the current direction are ignored. symbol of the current direction are ignored.   
  
The time elapsed is unimportant for this kind of charting. The time axis is not linear.The time elapsed is unimportant for this kind of charting. The time axis is not linear.  
  
Alternating months are displayed in different colors, e.g. black/red. The colors can be set in the properties. (The months are not Alternating months are displayed in different colors, e.g. black/red. The colors can be set in the properties. (The months are not 
relevant for the method, but are displayed for a better overview.)relevant for the method, but are displayed for a better overview.)

GENERAL CHART PROPERTIESGENERAL CHART PROPERTIES  

When the chart is active, you can edit the chart properties in the toolbox, for example the history length, the axes and legends.When the chart is active, you can edit the chart properties in the toolbox, for example the history length, the axes and legends.  
  
You can also You can also 

Point&Figure ChartPoint&Figure Chart
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l set the period and time span, see the chapter set the period and time span, see the chapter Timespans and PeriodsTimespans and Periods..  
l change the chart look, see the chapter change the chart look, see the chapter Chart PropertiesChart Properties..  

Select the grid style Select the grid style Graph PaperGraph Paper in the  in the Chart PropertiesChart Properties if you want the boxes of a P&F chart to be enclosed by grid lines. if you want the boxes of a P&F chart to be enclosed by grid lines.

CONTENTCONTENT--DEPENDENT CHART SETTINGSDEPENDENT CHART SETTINGS  

In the properties of the displayed instrument, you can find additional In the properties of the displayed instrument, you can find additional 
parameters. Besides the parameters. Besides the Standard PropertiesStandard Properties, you can find specific , you can find specific 
parameters for this chart type.parameters for this chart type.  
  
InstrumentInstrument Properties Properties  
  
Boxsize ModeBoxsize ModeBoxsize ModeBoxsize Mode  -- Enter a method to calculate the box size Enter a method to calculate the box size

l Constant priceConstant price  
l Constant pointsConstant points  
l Percentage of closePercentage of close, close value on , close value on Base DateBase DateBase DateBase Date is used is used  
l Average True RangeAverage True Range, values up to , values up to Base DateBase DateBase DateBase Date are used are used  
l LogarithmicLogarithmic, i.e. box size increases for rising prices, initial box size , i.e. box size increases for rising prices, initial box size 

is based on the open value on is based on the open value on Base DateBase DateBase DateBase Date  

BoxsizeBoxsizeBoxsizeBoxsize  -- Dependent on the selected  Dependent on the selected Boxsize ModeBoxsize ModeBoxsize ModeBoxsize Mode this value is  this value is 
interpreted asinterpreted as

l Constant priceConstant price: a price: a price  
l Constant pointsConstant points: a number of points: a number of points  
l Percentage of closePercentage of close: a percentage value: a percentage value  
l Average True RangeAverage True Range: the period of the ATR, i.e. a weighting factor applied to the EMA: the period of the ATR, i.e. a weighting factor applied to the EMA  
l LogarithmicLogarithmic: the percentage by which box sizes increase for rising prices: the percentage by which box sizes increase for rising prices  

l For the percentage based values, note that the % sign is implied.For the percentage based values, note that the % sign is implied.  
  
Base DateBase DateBase DateBase Date  -- This property is used for  This property is used for Percentage of closePercentage of close, , Average True RangeAverage True Range and  and LogarithmicLogarithmic. If an invalid date is specified or . If an invalid date is specified or 
the date is no longer available, it will be adjusted.the date is no longer available, it will be adjusted.  
  
ReversalReversalReversalReversal  -- Enter the number of boxes to be taken into account for a trend reversal.  Enter the number of boxes to be taken into account for a trend reversal.   
  
1111----Box reversalBox reversalBox reversalBox reversal  -- If the reversal property is set to one, this property determines if one If the reversal property is set to one, this property determines if one--box reversals are compressed into the next box reversals are compressed into the next 
column (Standard option), or if a new column is always created (New Column option).column (Standard option), or if a new column is always created (New Column option).  
  
HighHighHighHigh----LowLowLowLow  -- Select if boxes and reversals should be calculated against the high and low values instead of the close value. Select if boxes and reversals should be calculated against the high and low values instead of the close value.  
  
Initial TrendInitial TrendInitial TrendInitial Trend  -- Here you can choose how the to establish the initial trend. Possible methods are: Here you can choose how the to establish the initial trend. Possible methods are:

l HighHigh--Low RangeLow Range: At least : At least reversalreversalreversalreversal boxes must be spanned by the highest high and lowest low to establish a trend. boxes must be spanned by the highest high and lowest low to establish a trend. If this  If this 
happens on the first bar, the close value is compared to the midrange of high and low to determine if an X or O is drawn.happens on the first bar, the close value is compared to the midrange of high and low to determine if an X or O is drawn. If  If 

Boxsize modesBoxsize modes

Point&Figure PropertiesPoint&Figure Properties
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the trend is established on a later bar, the most recently updated extreme value (highest high or lowest low) determines the trend is established on a later bar, the most recently updated extreme value (highest high or lowest low) determines 
whether the first column contains X or O. This will always draw at least whether the first column contains X or O. This will always draw at least reversalreversalreversalreversal boxes in the first column. boxes in the first column.  

l HighHigh--Low Range (simplified)Low Range (simplified): This is similar to High: This is similar to High--Low Range, but establishes a trend on the first price movement, so it Low Range, but establishes a trend on the first price movement, so it 
may start a column with just one box.may start a column with just one box. (note: this mode was called  (note: this mode was called TraditionalTraditional in previous versions) in previous versions)  

l Close RangeClose Range: This mode also requires : This mode also requires reversalreversalreversalreversal boxes to be spanned by the highest and lowest value, but only considers  boxes to be spanned by the highest and lowest value, but only considers 
close prices.close prices. This will always draw at least  This will always draw at least reversalreversalreversalreversal boxes in the first column. boxes in the first column. (note: this mode was called  (note: this mode was called SmoothedSmoothed in  in 
previous versions)previous versions)  

l Two Box MethodTwo Box Method: This method compares the high and low prices of the first bar against high and low prices of subsequent : This method compares the high and low prices of the first bar against high and low prices of subsequent 
bars. If the high values are found to be at least one box apart, Xs will be drawn. If this is not the case the lows are bars. If the high values are found to be at least one box apart, Xs will be drawn. If this is not the case the lows are 
compared and if they are at least one box apart, Os will be drawn. This will always draw at least two boxes in the first compared and if they are at least one box apart, Os will be drawn. This will always draw at least two boxes in the first 
column.column.  

P&FP&F Properties Properties  
  
Color ChangeColor ChangeColor ChangeColor Change  -- Specifies under which circumstances the colors alternate. This property is available in Tradesignal 7.3 and above. Specifies under which circumstances the colors alternate. This property is available in Tradesignal 7.3 and above.

l MonthlyMonthly: The color changes as soon as a new month starts.: The color changes as soon as a new month starts.  
l WeeklyWeekly: The color changes as soon as a new week starts.: The color changes as soon as a new week starts.  
l DailyDaily: The color changes as soon as a new day starts.: The color changes as soon as a new day starts.  
l HourlyHourly: The color changes as soon as a new hour starts.: The color changes as soon as a new hour starts.  
l Every ColumnEvery Column: The color changes for every column. X columns are drawn using : The color changes for every column. X columns are drawn using Color 1Color 1Color 1Color 1 and O columns are drawn using  and O columns are drawn using 

Color 2Color 2Color 2Color 2..  

Color 1 / Color 2Color 1 / Color 2Color 1 / Color 2Color 1 / Color 2  -- Set the symbol colors for alternating months. The displayed symbols toggle between  Set the symbol colors for alternating months. The displayed symbols toggle between Color 1Color 1Color 1Color 1 and  and Color 2Color 2Color 2Color 2. In . In 
Tradesignal 7.3 and above the Tradesignal 7.3 and above the Color ChangeColor ChangeColor ChangeColor Change property controls how the colors alternate. property controls how the colors alternate.

INDICATORS ON POINT & FIGURE CHARTSINDICATORS ON POINT & FIGURE CHARTS  

Indicators and strategies can be applied to a Point & Figure chart like any other chart type. The main issue to be aware of is how Indicators and strategies can be applied to a Point & Figure chart like any other chart type. The main issue to be aware of is how 
the values for Open, High, Low and Close are interpreted. The box value at the top and bottom of a column will determine the high the values for Open, High, Low and Close are interpreted. The box value at the top and bottom of a column will determine the high 
and low respectively. The open will be equal to the low value for an X column and equal to the high for an O column. The close and low respectively. The open will be equal to the low value for an X column and equal to the high for an O column. The close 
will be equal to the high value for an X column and equal to the low for an O column. An additional field called will be equal to the high value for an X column and equal to the low for an O column. An additional field called MidpointMidpointMidpointMidpoint is  is 
available for input to an indicator, this will be the value of the middle box in a column, or the mean value between the two middle available for input to an indicator, this will be the value of the middle box in a column, or the mean value between the two middle 
boxes if a column has an even number of boxes.boxes if a column has an even number of boxes.  
  
To apply a Simple Moving Average to a Point & Figure chart using the column MidpointTo apply a Simple Moving Average to a Point & Figure chart using the column Midpoint

1.1. Drag and drop the indicator Drag and drop the indicator Moving Average SimpleMoving Average SimpleMoving Average SimpleMoving Average Simple from the Indicator Toolbox onto the point and figure chart. from the Indicator Toolbox onto the point and figure chart.  
2.2. Click on the moving average line in the chart (or the legend), to select the average.Click on the moving average line in the chart (or the legend), to select the average.  
3.3. In the Property Inspector, locate the In the Property Inspector, locate the PricePricePricePrice property for the moving average and change it to  property for the moving average and change it to MidpointMidpointMidpointMidpoint..  

LINKS AND BOOKSLINKS AND BOOKS  

Point and Figure ChartsPoint and Figure Charts  
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Point and Figure TutorialsPoint and Figure Tutorials  
  
The Complete Guide To PointThe Complete Guide To Point--AndAnd--Figure Charting Figure Charting -- H. Weber & K. Zieg H. Weber & K. Zieg  
  
The Definitive Guide to Point an Figure The Definitive Guide to Point an Figure -- J. Du Plessis J. Du Plessis  
  
The Essential Application for Forecasting and Tracking Market Prices The Essential Application for Forecasting and Tracking Market Prices -- T.J. Dorsey T.J. Dorsey    
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MARKET PROFILE 
Market Profile charts were invented in the 1980's. The goal was to offer a Market Profile charts were invented in the 1980's. The goal was to offer a 
better analysis method to traders at the US commodity markets. The better analysis method to traders at the US commodity markets. The 
development was done in cooperation between the trader Peter development was done in cooperation between the trader Peter 
Steidlmayer and the Chicago Board of Trade (CBOT). Steidlmayer and the Chicago Board of Trade (CBOT).   
  
Market Profile charts are different from the normal display of the price Market Profile charts are different from the normal display of the price 
movements versus the time line. While the prices are still given on the xmovements versus the time line. While the prices are still given on the x--
axis, the time line is given in units of "Time Price Opportunities" (TPO) that axis, the time line is given in units of "Time Price Opportunities" (TPO) that 
are marked with letters. This results in a more or less bellare marked with letters. This results in a more or less bell--shaped shaped 
distribution of the TPOs over the price span of the trading day. distribution of the TPOs over the price span of the trading day.   
  
Use the Market Profile chart forUse the Market Profile chart for

l Analyzing the distribution of trading activityAnalyzing the distribution of trading activity  
l Analyzing the "Fair Value" span with most of the trading activityAnalyzing the "Fair Value" span with most of the trading activity  
l Analyzing the volume distribution over the trading dayAnalyzing the volume distribution over the trading day  
l Analyzing of trend movementsAnalyzing of trend movements  

Tradesignal offers you Market Profile charts as a designated chart type. However, it is not available for all versions. As an Tradesignal offers you Market Profile charts as a designated chart type. However, it is not available for all versions. As an 
alternative for displaying the volume/price correlation, you can use the indicator "Price Volume Profile" that is delivered with alternative for displaying the volume/price correlation, you can use the indicator "Price Volume Profile" that is delivered with 
Tradesignal.Tradesignal.  
  
Due to the special focus of the tickDue to the special focus of the tick--based Market Profile, it is usually only displayed for one or two trading days. If you want to based Market Profile, it is usually only displayed for one or two trading days. If you want to 
display more than two trading days, the history length has to be set to the maximal value of 500000 ticks. If your data provider display more than two trading days, the history length has to be set to the maximal value of 500000 ticks. If your data provider 
offers this history length, you can display up to eight days as Market Profile.offers this history length, you can display up to eight days as Market Profile.

CREATING A MARKET PROFILECREATING A MARKET PROFILE  

For a Market Profile, stocks, futures, commodities, currencies etc. can be used as long as they show a high trading frequency per For a Market Profile, stocks, futures, commodities, currencies etc. can be used as long as they show a high trading frequency per 
day.day.  
  
For a quick look at the chart type, rightFor a quick look at the chart type, right--click on an index in the symbol list and select click on an index in the symbol list and select Open in Market ProfileOpen in Market ProfileOpen in Market ProfileOpen in Market Profile. . 

CONSTRUCTION AND INFORMATION IN A MARKET PROFILECONSTRUCTION AND INFORMATION IN A MARKET PROFILE  

The time units for the graph are fixed intervals called "Time Price Opportunities" (TPOs). They are basically trading periods. The The time units for the graph are fixed intervals called "Time Price Opportunities" (TPOs). They are basically trading periods. The 
standard setting is 30 minutes but can also be set to one hour. standard setting is 30 minutes but can also be set to one hour.   
  
For each TPO, a letter is used, starting with a capital "A". When the start of the trading is entered correctly, the "A" is displayed in For each TPO, a letter is used, starting with a capital "A". When the start of the trading is entered correctly, the "A" is displayed in 
the chart for the first price in the first TPO. For each new price level traded in that TPO, the letter "A" is added. The size of each the chart for the first price in the first TPO. For each new price level traded in that TPO, the letter "A" is added. The size of each 
price level is set in the price level is set in the Scale factorScale factorScale factorScale factor. For example, for a scale factor of "2", the price has to change 2 points (or cents) to open a . For example, for a scale factor of "2", the price has to change 2 points (or cents) to open a 

Market Profile ChartMarket Profile Chart
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new price level. new price level.   
  
After the first TPO, the price levels traded in the second TPO are displayed in the chart with a "B", in the third with "C" and so forth. After the first TPO, the price levels traded in the second TPO are displayed in the chart with a "B", in the third with "C" and so forth. 
  
  
The result of this continuous recording is a pictorial representation of the trading activity in relation to the time line. In the chart The result of this continuous recording is a pictorial representation of the trading activity in relation to the time line. In the chart 
given as example below, the price had a very small range for a while until it broke out. The large protrusion for the letters D and E given as example below, the price had a very small range for a while until it broke out. The large protrusion for the letters D and E 
shows that in the range of 6370 points, an equilibrium was formed. Such an equilibrium is called the shows that in the range of 6370 points, an equilibrium was formed. Such an equilibrium is called the Fair Value AreaFair Value Area. At the end . At the end 
of the trading day, the position of the of the trading day, the position of the Fair Value AreasFair Value Areas in regard to their position in the total price range can be evaluated.  in regard to their position in the total price range can be evaluated.   
  
As additional information, a brown and a black bar are displayed. The black bar spans 70% of the time with the highest trading As additional information, a brown and a black bar are displayed. The black bar spans 70% of the time with the highest trading 
activity. The brown bar spans 70% of the highest trading activity (in volume). The two rectangles mark the respective maxima. activity. The brown bar spans 70% of the highest trading activity (in volume). The two rectangles mark the respective maxima. 

ELEMENTS IN A MARKET PROFILE CHARTELEMENTS IN A MARKET PROFILE CHART  

BLACK FRAMED AREA IN THE EXAMPLE GRAPH BLACK FRAMED AREA IN THE EXAMPLE GRAPH   

Here, the price versus time is displayed. Each letter stands for a TPO (Time Here, the price versus time is displayed. Each letter stands for a TPO (Time 
Price Opportunity). Above this area, in the header of the chart, the Price Opportunity). Above this area, in the header of the chart, the 
following data is displayed (from top to bottom):following data is displayed (from top to bottom):

1.1. The highest price level tradedThe highest price level traded  
2.2. The lowest price level tradedThe lowest price level traded  
3.3. The ratio of number of letters and the high/low spanThe ratio of number of letters and the high/low span  

LIGHTLIGHT--GREEN FRAMED AREA IN THE EXAMPLE GRAPH GREEN FRAMED AREA IN THE EXAMPLE GRAPH   

Here you can find the number of traded contracts (contract volume) or the tick volume for each price level. In the example, 1302 Here you can find the number of traded contracts (contract volume) or the tick volume for each price level. In the example, 1302 
contracts were traded (bought and sold) in the price span 6381contracts were traded (bought and sold) in the price span 6381--6382. The displayed volume is specified with the parameter 6382. The displayed volume is specified with the parameter 
Volume TypeVolume TypeVolume TypeVolume Type in the properties. in the properties.

DARKDARK--GREEN FRAMED AREA IN THE EXAMPLE GRAPH GREEN FRAMED AREA IN THE EXAMPLE GRAPH   

Here you can find a brown bar that marks the range of 70 % of volume activity. The small rectangle marks the price level with the Here you can find a brown bar that marks the range of 70 % of volume activity. The small rectangle marks the price level with the 
highest volume activity. This point is called highest volume activity. This point is called Volume Point of ControlVolume Point of Control. Above this area, in the header of the chart, the following data . Above this area, in the header of the chart, the following data 
is displayed (from top to bottom): is displayed (from top to bottom): 

1.1. Volumes traded above the Point of ControlVolumes traded above the Point of Control  
2.2. Volumes traded below the Point of ControlVolumes traded below the Point of Control  
3.3. Total trading volumeTotal trading volume  

LIGHTLIGHT--BLUE FRAMED AREA IN THE EXAMPLE GRAPH BLUE FRAMED AREA IN THE EXAMPLE GRAPH   

Here you can find the sum of TPOs (periods) in which the respective price levels were traded. For example, the range 6376Here you can find the sum of TPOs (periods) in which the respective price levels were traded. For example, the range 6376--6377 6377 
was traded in a total of six periods.was traded in a total of six periods.

Market Profile DetailsMarket Profile Details
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DARKDARK--BLUE FRAMED AREA IN THE EXAMPLE GRAPH BLUE FRAMED AREA IN THE EXAMPLE GRAPH   

Here you can find the black bar that marks the range of 70% activity in the time line. The small rectangle marks the price level with Here you can find the black bar that marks the range of 70% activity in the time line. The small rectangle marks the price level with 
the highest trading activity. This point is called the highest trading activity. This point is called TPO Point of ControlTPO Point of Control..

MARKET PROFILE CHART PROPERTIESMARKET PROFILE CHART PROPERTIES  

Here you can find the most important parameters for this chart type. Here you can find the most important parameters for this chart type.   
  
History LengthHistory LengthHistory LengthHistory Length  -- The Market Profile is created on a tick basis. Enter the number of ticks to be loaded into the Market Profile. The  The Market Profile is created on a tick basis. Enter the number of ticks to be loaded into the Market Profile. The 
history length determines how many days will be displayed as Market Profile.history length determines how many days will be displayed as Market Profile.  
  
IntervalIntervalIntervalInterval  -- This is the interval that each TPO represents in the chart. The default value is 30 minutes but can also be set to 1 hour. This is the interval that each TPO represents in the chart. The default value is 30 minutes but can also be set to 1 hour.  
  
Scale FactorScale FactorScale FactorScale Factor  -- Enter the price span units. When the price moves by this span during a TPO, the current letter is drawn at that price  Enter the price span units. When the price moves by this span during a TPO, the current letter is drawn at that price 
level. For example, if the scale factor is "2" and the current price is at "6370" in the TPO "C", a new "C" is drawn in the line above level. For example, if the scale factor is "2" and the current price is at "6370" in the TPO "C", a new "C" is drawn in the line above 
the original one if the price moves up to 6372. the original one if the price moves up to 6372.   
  
Show GapsShow GapsShow GapsShow Gaps  -- Select here whether gaps in the trading (TPOs without trades) are to be displayed. Select here whether gaps in the trading (TPOs without trades) are to be displayed.    
  
Initial BalanceInitial BalanceInitial BalanceInitial Balance  -- Enter the number of TPOs that should be part of the start period. TPOs in the start period are labeled in a special  Enter the number of TPOs that should be part of the start period. TPOs in the start period are labeled in a special 
color. color.   
  
Start TimeStart TimeStart TimeStart Time  -- Here the time for the market start has to be entered, i.e. "9:30" for stock trading. This is important for a correct display  Here the time for the market start has to be entered, i.e. "9:30" for stock trading. This is important for a correct display 
of the Market Profile. of the Market Profile.   
  
Volume TypeVolume TypeVolume TypeVolume Type  -- Select here whether the volume should be displayed as  Select here whether the volume should be displayed as Contract VolumeContract VolumeContract VolumeContract Volume (number of traded contracts) or as  (number of traded contracts) or as Tick Tick Tick Tick 
VolumeVolumeVolumeVolume (number of ticks = trades for this price span; necessary for currencies, for example). The traded volumes are displayed to  (number of ticks = trades for this price span; necessary for currencies, for example). The traded volumes are displayed to 
the left of the letters (lightthe left of the letters (light--green area in the example chart).green area in the example chart).  
  
Zoom FactorZoom FactorZoom FactorZoom Factor  -- Here you can enter an optical zoom factor. The higher the number, the more the profile is magnified. Here you can enter an optical zoom factor. The higher the number, the more the profile is magnified.

LINKSLINKS  

Tradesignal Online LexikonTradesignal Online Lexikon    
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TEXT 
With the text tool, you can enter notes or captions into a chart, e.g. before With the text tool, you can enter notes or captions into a chart, e.g. before 
publishing it in the Tradesignal web forum. publishing it in the Tradesignal web forum.   
  
You can find the text tool in the You can find the text tool in the Chart Tools Chart Tools group in the group in the toolbartoolbar..

ENTERING TEXTENTERING TEXT  

1.1. Open a symbol chart.Open a symbol chart.  
2.2. Click on the text tool in the toolbar.Click on the text tool in the toolbar.  
3.3. Click into the chart. A text field with four anchor points appears.Click into the chart. A text field with four anchor points appears.  

Now you can enter the text.Now you can enter the text.

EDITING TEXTEDITING TEXT  

l To edit the text, click on it with the mouse (so that it is selected) and then click once again, so that the text field is To edit the text, click on it with the mouse (so that it is selected) and then click once again, so that the text field is 
highlighted. Now you can edit the text.highlighted. Now you can edit the text.  

l To move the text, drag it with the mouse (the mouse pointer turns into a hand symbol) and move it freely. Release the To move the text, drag it with the mouse (the mouse pointer turns into a hand symbol) and move it freely. Release the 
mouse button when done.mouse button when done.  

l You can duplicate the text by doubleYou can duplicate the text by double--clicking it.clicking it.  

l When the text is selected, you can edit the text properties in the toolbox.When the text is selected, you can edit the text properties in the toolbox.  

l To delete the text, rightTo delete the text, right--click on it and select click on it and select DeleteDeleteDeleteDelete from the context menu. Alternatively, select the text and press the  from the context menu. Alternatively, select the text and press the DELDELDELDEL  
key.key.  

PROPERTIESPROPERTIES  

FontFontFontFont  -- Here you can change the font type and size, e.g. to "Arial bold 10".  Here you can change the font type and size, e.g. to "Arial bold 10".   
  
ColorColorColorColor  -- Here you can change the text color, e.g. to red.  Here you can change the text color, e.g. to red.   
  
BackgroundBackgroundBackgroundBackground  -- Here you can set a background color and opacity for the text object, e.g. black.  Here you can set a background color and opacity for the text object, e.g. black.   
  
FrameFrameFrameFrame  -- Here you can select whether you want to display a frame (in the same color as the text) around the text. Here you can select whether you want to display a frame (in the same color as the text) around the text.    
  
AnchorAnchorAnchorAnchor  -- Here you can select how the text is placed in relation to the chart data. Choose an option from the drop Here you can select how the text is placed in relation to the chart data. Choose an option from the drop--down list.down list.    

TextText
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TREND LINE 
The simplest tool for a chart analysis is the trend line. With it, trends in The simplest tool for a chart analysis is the trend line. With it, trends in 
price movements can be visualized and emphasized. Trading decisions may price movements can be visualized and emphasized. Trading decisions may 
be based on analysis of trend lines. Trend lines may be used for: be based on analysis of trend lines. Trend lines may be used for: 

l Visualizing trendsVisualizing trends  
l Marking market phasesMarking market phases  
l Marking resistance and support levelsMarking resistance and support levels  

You can find the trend line tool in the You can find the trend line tool in the Chart Tools Chart Tools group in the group in the toolbartoolbar..

ENTERING A TREND LINEENTERING A TREND LINE  

1.1. Open a symbol chart.Open a symbol chart.  
2.2. Click on the trend line tool in the toolbar.Click on the trend line tool in the toolbar.  
3.3. Click into the chart to set the starting point of the trend line.Click into the chart to set the starting point of the trend line.  
4.4. Keep the mouse button pressed and move the pointer to the end point of the trend line. Release the mouse button.Keep the mouse button pressed and move the pointer to the end point of the trend line. Release the mouse button.  

You can align the anchor points of the trend line to a certain price level. To do so, activate the Snap Mode by clicking on the You can align the anchor points of the trend line to a certain price level. To do so, activate the Snap Mode by clicking on the 
magnet symbol in the toolbar. Now when you draw a trend line in the chart, it is positioned exactly at high and/or low points.magnet symbol in the toolbar. Now when you draw a trend line in the chart, it is positioned exactly at high and/or low points.

EDITING A TREND LINEEDITING A TREND LINE  

l To move the trend line, drag it with the mouse (the mouse pointer turns into a hand symbol) and move it freely. Release the To move the trend line, drag it with the mouse (the mouse pointer turns into a hand symbol) and move it freely. Release the 
mouse button when done.mouse button when done.  

l To change the trend line angle, click the anchor points of the line (the mouse pointer turns into an axis of coordinates To change the trend line angle, click the anchor points of the line (the mouse pointer turns into an axis of coordinates 
symbol) and drag into another position.symbol) and drag into another position.  

l Note that the trend line cannot be moved freely if the Snap Mode is active. If necessary, switch it off by clicking the magnet Note that the trend line cannot be moved freely if the Snap Mode is active. If necessary, switch it off by clicking the magnet 
symbol in the toolbar.symbol in the toolbar.

l You can duplicate a trend line in three ways (see the chapter You can duplicate a trend line in three ways (see the chapter Chart ToolsChart Tools).).  

l To extend the length of the trend line until the right or left edge of the chart, doubleTo extend the length of the trend line until the right or left edge of the chart, double--click on the respective anchor point at click on the respective anchor point at 
the end of the trend line.the end of the trend line.  

l When the trend line is selected, you can edit the properties in the toolbox.When the trend line is selected, you can edit the properties in the toolbox.  

l The alert function is available for the trend line. To set an alert, set the The alert function is available for the trend line. To set an alert, set the Alert ModeAlert ModeAlert ModeAlert Mode from  from DisabledDisabled to one of the options  to one of the options 
(see below).(see below).  

l To delete the trend line, rightTo delete the trend line, right--click on it and select click on it and select DeleteDeleteDeleteDelete from the context menu. Alternatively, select the trend line and  from the context menu. Alternatively, select the trend line and 
press the press the DELDELDELDEL key. key.  

USING THE MEASUREMENT FUNCTIONUSING THE MEASUREMENT FUNCTION  

Trend LineTrend Line
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In the trend line properties, you can switch on the measurement function. In the trend line properties, you can switch on the measurement function.   
  
The following information is displayed for the time axis:The following information is displayed for the time axis:

l Number of bars (trading periods) between the two anchor pointsNumber of bars (trading periods) between the two anchor points  
l Number of calendar days between the two anchor pointsNumber of calendar days between the two anchor points  

Example: "47 Bars (2d)"Example: "47 Bars (2d)"  
  
The following information is displayed for the price axis:The following information is displayed for the price axis:

l Absolute price difference between the price levels of the anchor pointsAbsolute price difference between the price levels of the anchor points  
l Relative price movement between the price levels of the anchor pointsRelative price movement between the price levels of the anchor points  
l Relative gradient between periods for the slope between the two anchor pointsRelative gradient between periods for the slope between the two anchor points  

Example: Example:   
  
"3.48 (+5.7)""3.48 (+5.7)"  
  
"0.07/Bar""0.07/Bar"

PROPERTIESPROPERTIES  

TREND LINE PROPERTIESTREND LINE PROPERTIES  

Extend LeftExtend LeftExtend LeftExtend Left//Extend RightExtend RightExtend RightExtend Right  -- Select whether the line is to be extended to the left and/or right until the edge of the chart. Select whether the line is to be extended to the left and/or right until the edge of the chart.

GRAPHIC PROPERTIESGRAPHIC PROPERTIES  

The following properties can be set for the trend line tool:The following properties can be set for the trend line tool:  
  
ColorColorColorColor  -- Here you can select a color for the line.  Here you can select a color for the line.   
  
WidthWidthWidthWidth  -- Here you can set a line width by entering a number. Here you can set a line width by entering a number.  
  
StyleStyleStyleStyle  -- Here you can select a line style, e.g. solid or dotted. Here you can select a line style, e.g. solid or dotted.  
  
ShadowShadowShadowShadow  -- Here you can set a shadow for emphasizing the line with a 3D effect. Four settings are available.  Here you can set a shadow for emphasizing the line with a 3D effect. Four settings are available.   
  
LabelLabelLabelLabel  -- Here you can set the value label for the last data point to visible or hidden. The label is only displayed when the trend line  Here you can set the value label for the last data point to visible or hidden. The label is only displayed when the trend line 
is drawn through, below or above the last data point (candle, bar etc.). In Tradesignal you can also specifiy the location at which is drawn through, below or above the last data point (candle, bar etc.). In Tradesignal you can also specifiy the location at which 
the label should be displayed.the label should be displayed.  
  
MeasurementMeasurementMeasurementMeasurement  -- Here you can switch the measurement function on or off. Here you can switch the measurement function on or off.
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ALERT PROPERTIESALERT PROPERTIES  

The trend line tool can be used with various kinds of alerts. The trend line tool can be used with various kinds of alerts.   
  
Alert DirectionAlert DirectionAlert DirectionAlert Direction  -- Here you can select from the list whether crossings of all types lead to alerts or only crossings in a certain  Here you can select from the list whether crossings of all types lead to alerts or only crossings in a certain 
direction.direction.  
  
Alert ModeAlert ModeAlert ModeAlert Mode  -- Here you can select an alert mode from the list. Select whether every crossing is considered or only one crossing per  Here you can select an alert mode from the list. Select whether every crossing is considered or only one crossing per 
trading period or trend line. trading period or trend line.   
  
Alert NameAlert NameAlert NameAlert Name  -- Here you can specify a name for alerts generated by this tool. It will be included in the signal field of the alert. Here you can specify a name for alerts generated by this tool. It will be included in the signal field of the alert.  
  
Alert TriggerAlert TriggerAlert TriggerAlert Trigger  -- Here you can select when an alert should be triggered. Here you can select when an alert should be triggered.

l CrossedCrossed: Triggers when the price crosses the tool, e.g. goes from below the tool to above the tool: Triggers when the price crosses the tool, e.g. goes from below the tool to above the tool  
l Hit or CrossedHit or Crossed: Same as above, but also triggers when the price merely hits the tool. This setting is useful for: Same as above, but also triggers when the price merely hits the tool. This setting is useful for a  a Point&Figure Point&Figure 

ChartChart..  

For further information on alert modes, see the chapter For further information on alert modes, see the chapter AlertsAlerts..    
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TREND CHANNEL 
The trend channel is a standard tool in chart analysis. It offers two parallel The trend channel is a standard tool in chart analysis. It offers two parallel 
lines that are helpful for visualizing trends. Trading decisions may be based lines that are helpful for visualizing trends. Trading decisions may be based 
on the trend channel's alert function. on the trend channel's alert function.   
  
Trend channels may be used for visualizing: Trend channels may be used for visualizing: 

l strong price movementsstrong price movements  
l resistance and support levelsresistance and support levels  
l chart patternschart patterns  
l sidewards marketssidewards markets  

You can find the trend channel tool in the You can find the trend channel tool in the Chart Tools Chart Tools group in the group in the toolbartoolbar..

ENTERING A TREND CHANNELENTERING A TREND CHANNEL  

1.1. Open a symbol chart.Open a symbol chart.  
2.2. Click on the trend channel tool in the toolbar.Click on the trend channel tool in the toolbar.  
3.3. Click into the chart to set the starting point of the trend channel.Click into the chart to set the starting point of the trend channel.  
4.4. Keep the mouse button pressed and move the pointer to the end point of the trend channel. Release the mouse button.Keep the mouse button pressed and move the pointer to the end point of the trend channel. Release the mouse button.  

You can align the anchor points of the trend channel to a certain price level. To do so, activate the Snap Mode by clicking on the You can align the anchor points of the trend channel to a certain price level. To do so, activate the Snap Mode by clicking on the 
magnet symbol in the toolbar. Now when you draw a trend channel in the chart, the middle line is positioned exactly at high magnet symbol in the toolbar. Now when you draw a trend channel in the chart, the middle line is positioned exactly at high 
and/or low points.and/or low points.

EDITING A TREND CHANNELEDITING A TREND CHANNEL  

l To move the trend channel, drag it with the mouse (the mouse pointer turns into a hand symbol) and move it freely. Release To move the trend channel, drag it with the mouse (the mouse pointer turns into a hand symbol) and move it freely. Release 
the mouse button when done.the mouse button when done.  

l To move the lines of the trend channels up or down, click the center point of a line (the mouse pointer changes into a double To move the lines of the trend channels up or down, click the center point of a line (the mouse pointer changes into a double 
arrow) and drag it.arrow) and drag it.  

l To change the trend channel angle, click the anchor points of the channel (the mouse pointer turns into an xTo change the trend channel angle, click the anchor points of the channel (the mouse pointer turns into an x--y axis symbol) y axis symbol) 
and drag into another position.and drag into another position.  

Note that the trend channel cannot be moved freely if the Snap Mode is active. If necessary, switch it off by clicking the magnet Note that the trend channel cannot be moved freely if the Snap Mode is active. If necessary, switch it off by clicking the magnet 
symbol in the toolbar. symbol in the toolbar. 

l You can duplicate a trend channel in three ways (see the chapter You can duplicate a trend channel in three ways (see the chapter Chart ToolsChart Tools).).  

l To extend the length of the trend channel until the right or left edge of the chart, doubleTo extend the length of the trend channel until the right or left edge of the chart, double--click on anchor points at the right or click on anchor points at the right or 
left end of the channel.left end of the channel.  

l When the trend channel is selected, you can edit the properties in the toolbox.When the trend channel is selected, you can edit the properties in the toolbox.  

l The alert function is available for the trend channel. To set an alert, set the The alert function is available for the trend channel. To set an alert, set the Alert ModeAlert ModeAlert ModeAlert Mode from  from DisabledDisabled to one of the options  to one of the options 

Trend ChannelTrend Channel
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(see below).(see below).  

l To delete the trend channel, rightTo delete the trend channel, right--click on it and select click on it and select DeleteDeleteDeleteDelete from the context menu. Alternatively, select the trend  from the context menu. Alternatively, select the trend 
channel and press the channel and press the DELDELDELDEL key. key.  

PROPERTIESPROPERTIES  

TREND CHANNEL PROPERTIESTREND CHANNEL PROPERTIES  

DistanceDistanceDistanceDistance  -- Here you can enter a distance between the two lines of the trend channel. The value changes if you move the lines  Here you can enter a distance between the two lines of the trend channel. The value changes if you move the lines 
independently. You can also directly enter the value here.independently. You can also directly enter the value here.  
  
Always parallelAlways parallelAlways parallelAlways parallel  -- Select whether the lines of the trend channel are always be kept parallel. (If you change the chart display from  Select whether the lines of the trend channel are always be kept parallel. (If you change the chart display from 
linear to logarithmic, the drawing elements in the chart may "bend" and change their angles. In the case of trend channels, this linear to logarithmic, the drawing elements in the chart may "bend" and change their angles. In the case of trend channels, this 
may lead to nonmay lead to non--parallel lines. Set the option to parallel lines. Set the option to truetrue to avoid this distortion.) to avoid this distortion.)  
  
Extend LeftExtend LeftExtend LeftExtend Left//Extend RightExtend RightExtend RightExtend Right  -- Select whether the lines are to be extended to the left and/or right until the edge of the chart. Select whether the lines are to be extended to the left and/or right until the edge of the chart.

GRAPHIC PROPERTIESGRAPHIC PROPERTIES  

The following properties can be set for the trend line tool:The following properties can be set for the trend line tool:  
  
ColorColorColorColor  -- Here you can select a color for the lines.  Here you can select a color for the lines.   
  
WidthWidthWidthWidth  -- Here you can set a line width by entering a number. Here you can set a line width by entering a number.  
  
StyleStyleStyleStyle  -- Here you can select a line style, e.g. solid or dotted. Here you can select a line style, e.g. solid or dotted.  
  
ShadowShadowShadowShadow  -- Here you can set a shadow for emphasizing the lines with a 3D effect. Four settings are available.  Here you can set a shadow for emphasizing the lines with a 3D effect. Four settings are available.   
  
Fill ColorFill ColorFill ColorFill Color  -- Here you can select a color and opacity for the channel area.  Here you can select a color and opacity for the channel area.   
  
LabelLabelLabelLabel  -- Here you can set the value label for the last data point to visible or hidden. The label is only displayed when the trend line  Here you can set the value label for the last data point to visible or hidden. The label is only displayed when the trend line 
is drawn through, below or above the last data point (candle, bar etc.). In Tradesignal you can also specifiy the location at which is drawn through, below or above the last data point (candle, bar etc.). In Tradesignal you can also specifiy the location at which 
the label should be displayed.the label should be displayed.

ALERT PROPERTIESALERT PROPERTIES  

The trend channel tool can be used with various kinds of alerts. The trend channel tool can be used with various kinds of alerts.   
  
Alert DirectionAlert DirectionAlert DirectionAlert Direction  -- Here you can select from the list whether crossings of all types lead to alerts or only crossings in a certain  Here you can select from the list whether crossings of all types lead to alerts or only crossings in a certain 
direction.direction.  
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Alert ModeAlert ModeAlert ModeAlert Mode  -- Here you can select an alert mode from the list. Select whether every crossing is considered or only one crossing per  Here you can select an alert mode from the list. Select whether every crossing is considered or only one crossing per 
trading period or trend line. trading period or trend line.   
  
Alert NameAlert NameAlert NameAlert Name  -- Here you can specify a name for alerts generated by this tool. It will be included in the signal field of the alert. Here you can specify a name for alerts generated by this tool. It will be included in the signal field of the alert.  
  
Alert TriggerAlert TriggerAlert TriggerAlert Trigger  -- Here you can select when an alert should be triggered. Here you can select when an alert should be triggered.

l CrossedCrossed: Triggers when the price crosses the tool, e.g. goes from below the tool to above the tool: Triggers when the price crosses the tool, e.g. goes from below the tool to above the tool  
l Hit or CrossedHit or Crossed: Same as above, but also triggers when the price merely hits the tool. This setting is useful for: Same as above, but also triggers when the price merely hits the tool. This setting is useful for a  a Point&Figure Point&Figure 

ChartChart..  
l BreakBreak--in/Breakin/Break--outout: Treats the tool not as two separate lines but as a channel instead and triggers an alert, when the price : Treats the tool not as two separate lines but as a channel instead and triggers an alert, when the price 

breaks into or out of the tool's channel.breaks into or out of the tool's channel.  

For further information on alert modes, see the chapter For further information on alert modes, see the chapter AlertsAlerts..    
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STOP LINE 
The stop line is a simple horizontal line that is defined by only the value on The stop line is a simple horizontal line that is defined by only the value on 
the price axis. Entered for one level, the line is extended to both sides of the price axis. Entered for one level, the line is extended to both sides of 
the chart. The stop line has an alert function and can be used for precise the chart. The stop line has an alert function and can be used for precise 
timing of buy and sell orders. The stop line may be used for timing of buy and sell orders. The stop line may be used for 

l drawing horizontal linesdrawing horizontal lines  
l marking resistance and support levelsmarking resistance and support levels  
l exactly measuring price movementsexactly measuring price movements  
l placing a line at a userplacing a line at a user--defined price leveldefined price level  

ENTERING A STOP LINEENTERING A STOP LINE  

1.1. Open a symbol chart.Open a symbol chart.  
2.2. Click on the stop line tool in the toolbar.Click on the stop line tool in the toolbar.  
3.3. Click into the chart. A horizontal stop line is drawn. The current value is given at the left side of the chart.Click into the chart. A horizontal stop line is drawn. The current value is given at the left side of the chart.  

You can align the anchor points of the stop line to a certain price level. To do so, activate the Snap Mode by clicking on the magnet You can align the anchor points of the stop line to a certain price level. To do so, activate the Snap Mode by clicking on the magnet 
symbol in the toolbar. Now when you enter a stop line in the chart, it is positioned exactly at a high or low point.symbol in the toolbar. Now when you enter a stop line in the chart, it is positioned exactly at a high or low point.

EDITING A STOP LINEEDITING A STOP LINE  

l To move the stop line, drag it with the mouse (the mouse pointer turns into a double arrow) and move it up or down. To move the stop line, drag it with the mouse (the mouse pointer turns into a double arrow) and move it up or down. 
Release the mouse button when done.Release the mouse button when done.  

Note that the stop line cannot be moved freely if the Snap Mode is active. If necessary, switch it off by clicking the magnet symbol Note that the stop line cannot be moved freely if the Snap Mode is active. If necessary, switch it off by clicking the magnet symbol 
in the toolbar. in the toolbar. 

l You can duplicate the stop line by doubleYou can duplicate the stop line by double--clicking it.clicking it.  

l When the stop line is selected, you can edit the properties in the toolbox.When the stop line is selected, you can edit the properties in the toolbox.  

l For the stop line, the alert function is available. To set an alert, set the For the stop line, the alert function is available. To set an alert, set the Alert ModeAlert ModeAlert ModeAlert Mode in the properties in the toolbox from  in the properties in the toolbox from 
DisabledDisabled to one of the options, see below. to one of the options, see below.  

l To delete the stop line, rightTo delete the stop line, right--click on it and select click on it and select DeleteDeleteDeleteDelete from the context menu. Alternatively, select the stop line and  from the context menu. Alternatively, select the stop line and 
press the press the DELDELDELDEL key. key.  

PROPERTIESPROPERTIES  

GRAPHIC PROPERTIESGRAPHIC PROPERTIES  

The following properties can be set for the trend line tool:The following properties can be set for the trend line tool:  

Stop LineStop Line
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ColorColorColorColor  -- Here you can select a color for the line.  Here you can select a color for the line.   
  
WidthWidthWidthWidth  -- Here you can set a line width by entering a number. Here you can set a line width by entering a number.  
  
StyleStyleStyleStyle  -- Here you can select a line style, e.g. solid or dotted. Here you can select a line style, e.g. solid or dotted.  
  
Label AlignmentLabel AlignmentLabel AlignmentLabel Alignment  -- Here you can set the value label to visible or hidden and align it to the stop line.  Here you can set the value label to visible or hidden and align it to the stop line. 

ALERT PROPERTIESALERT PROPERTIES  

The stop line tool can be used with various kinds of alerts. The stop line tool can be used with various kinds of alerts.   
  
Alert DirectionAlert DirectionAlert DirectionAlert Direction  -- Here you can select from the list, if crossings of all kinds lead to alerts or only crossings of a certain direction. Here you can select from the list, if crossings of all kinds lead to alerts or only crossings of a certain direction.  
  
Alert ModeAlert ModeAlert ModeAlert Mode  -- Here you can select an alert mode from the list. Select if every crossing is considered or only one crossing per  Here you can select an alert mode from the list. Select if every crossing is considered or only one crossing per 
trading period or trend line. trading period or trend line.   
  
Alert NameAlert NameAlert NameAlert Name  -- Here you can specify a name for alerts generated by this tool. It will be included in the signal field of the alert. Here you can specify a name for alerts generated by this tool. It will be included in the signal field of the alert.  
  
Alert TriggerAlert TriggerAlert TriggerAlert Trigger  -- Here you can select when an alert should be triggered. Here you can select when an alert should be triggered.

l CrossedCrossed: Triggers when the price crosses the tool, e.g. goes from below the tool to above the tool: Triggers when the price crosses the tool, e.g. goes from below the tool to above the tool  
l Hit or CrossedHit or Crossed: Same as above, but also triggers when the price merely hits the tool. This setting is useful for: Same as above, but also triggers when the price merely hits the tool. This setting is useful for a  a Point&Figure Point&Figure 

ChartChart..  

For further information on alert modes, see the chapter For further information on alert modes, see the chapter AlertsAlerts..    



:: www.tradesignal.comwww.tradesignal.com

Tradesignal GmbHTradesignal GmbH Page 127Page 127 Version 7.0Version 7.0

ANDREW'S PITCHFORK 
Andrew's Pitchfork (originally called "median line studies") is a drawing Andrew's Pitchfork (originally called "median line studies") is a drawing 
tool which, if correctly aligned, is also a geometric indicator. Andrew's tool which, if correctly aligned, is also a geometric indicator. Andrew's 
Pitchfork consists of three parallel lines and is especially useful for finding Pitchfork consists of three parallel lines and is especially useful for finding 
resistance and support levels.resistance and support levels.  
  
You can find the tool in the You can find the tool in the Chart Tools Chart Tools group in the group in the toolbartoolbar..

ENTERING ANDREW'S PITCHFORKENTERING ANDREW'S PITCHFORK  

Three points are necessary to enter a Andrew's Pitchfork.Three points are necessary to enter a Andrew's Pitchfork.

l The start (pivot) point of a trend (high or low). This is the starting point of the handle.The start (pivot) point of a trend (high or low). This is the starting point of the handle.  
l The two corner points of a major correction against the trend. These will be the starting points of the prongs.The two corner points of a major correction against the trend. These will be the starting points of the prongs.  

Proceed as follows:Proceed as follows:

1.1. Open a symbol chart.Open a symbol chart.  
2.2. Click on the Andrew's Pitchfork tool in the toolbar.Click on the Andrew's Pitchfork tool in the toolbar.  
3.3. Click into the chart on one of the corners of the correction movement.Click into the chart on one of the corners of the correction movement.  
4.4. Keep the mouse button pressed and move the pointer to the second corner of the correction movement. Release the mouse Keep the mouse button pressed and move the pointer to the second corner of the correction movement. Release the mouse 

button.button.  
5.5. Drag the start point (anchor point of the handle) to the correct position by moving it to theDrag the start point (anchor point of the handle) to the correct position by moving it to the start point of the trend. start point of the trend.  

The resulting pitchfork consists of a handle with a middle line and two prongs. All lines can serve as resistance and support levels The resulting pitchfork consists of a handle with a middle line and two prongs. All lines can serve as resistance and support levels 
in price movements.in price movements.

EDITING ANDREW'S PITCHFORKEDITING ANDREW'S PITCHFORK  

l To move Andrew's Pitchfork, drag it with the mouse (the mouse pointer turns into a hand symbol) and move it freely. To move Andrew's Pitchfork, drag it with the mouse (the mouse pointer turns into a hand symbol) and move it freely. 
Release the mouse button when done.Release the mouse button when done.  

l To change the direction of Andrew's Pitchfork, click the pivot point of the handle (the mouse pointer changes into an xTo change the direction of Andrew's Pitchfork, click the pivot point of the handle (the mouse pointer changes into an x--y axis y axis 
symbol) and move it. This will make the fork rotate.symbol) and move it. This will make the fork rotate.  

l You can edit the corner points of the prongs. Click these anchor points (the mouse pointer turns into an xYou can edit the corner points of the prongs. Click these anchor points (the mouse pointer turns into an x--y axis symbol) and y axis symbol) and 
drag them to another position. Due to the line coupling, the fork's appearance changes.drag them to another position. Due to the line coupling, the fork's appearance changes.  

l You can duplicate Andrew's Pitchfork by doubleYou can duplicate Andrew's Pitchfork by double--clicking on it.clicking on it.  

l When Andrew's Pitchfork is selected, you can edit the properties in the toolbox.When Andrew's Pitchfork is selected, you can edit the properties in the toolbox.  

l The alert function is available for Andrew's Pitchfork. To set an alert, set the The alert function is available for Andrew's Pitchfork. To set an alert, set the Alert ModeAlert ModeAlert ModeAlert Mode from  from DisabledDisabled to one of the  to one of the 
options (see below).options (see below).  

l To delete Andrew's Pitchfork, rightTo delete Andrew's Pitchfork, right--click on it and select click on it and select DeleteDeleteDeleteDelete from the context menu. Alternatively, select Andrew's  from the context menu. Alternatively, select Andrew's 

Andrew's PitchforkAndrew's Pitchfork
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Pitchfork and press the Pitchfork and press the DELDELDELDEL key. key.  

PROPERTIESPROPERTIES  

GRAPHIC PROPERTIESGRAPHIC PROPERTIES  

The following properties can be set for the Andrew's Pitchfork tool:The following properties can be set for the Andrew's Pitchfork tool:  
  
Handle ColorHandle ColorHandle ColorHandle Color  -- Here you can select a color for the handle line.  Here you can select a color for the handle line.   
  
Prongs ColorProngs ColorProngs ColorProngs Color  -- Here you can select a color for the prong lines.  Here you can select a color for the prong lines.   
  
WidthWidthWidthWidth  -- Here you can set a width for all lines by entering a number. Here you can set a width for all lines by entering a number.  
  
Handle StyleHandle StyleHandle StyleHandle Style  -- Here you can select a line style for the handle, e.g. solid or dotted. Here you can select a line style for the handle, e.g. solid or dotted.  
  
Prongs StyleProngs StyleProngs StyleProngs Style  -- Here you can select a line style for the prongs, e.g. solid or dotted. Here you can select a line style for the prongs, e.g. solid or dotted.  
  
ShadowShadowShadowShadow  -- Here you can set a shadow for emphasizing all lines with a 3D effect. Four settings are available.  Here you can set a shadow for emphasizing all lines with a 3D effect. Four settings are available.   
  
BaseBaseBaseBase  -- Here you can select whether the base line (the line connecting the two anchor points of the prongs) is to be visible or  Here you can select whether the base line (the line connecting the two anchor points of the prongs) is to be visible or 
hidden. hidden.   
  
LabelLabelLabelLabel  -- Here you can set the value label for the current data point to visible or hidden. In Tradesignal Here you can set the value label for the current data point to visible or hidden. In Tradesignal you can also specifiy the  you can also specifiy the 
location at which the label should be displayedlocation at which the label should be displayed

ALERT PROPERTIESALERT PROPERTIES  

The Andrew's Pitchfork tool can be used with various kinds of alerts. The Andrew's Pitchfork tool can be used with various kinds of alerts.   
  
Alert DirectionAlert DirectionAlert DirectionAlert Direction  -- Here you can select from the list whether crossings of all types lead to alerts or only crossings in a certain  Here you can select from the list whether crossings of all types lead to alerts or only crossings in a certain 
direction.direction.  
  
Alert ModeAlert ModeAlert ModeAlert Mode  -- Here you can select an alert mode from the list. Select whether every crossing is considered or only one crossing per  Here you can select an alert mode from the list. Select whether every crossing is considered or only one crossing per 
trading period or trend line. trading period or trend line.   
  
Alert NameAlert NameAlert NameAlert Name  -- Here you can specify a name for alerts generated by this tool. It will be included in the signal field of the alert. Here you can specify a name for alerts generated by this tool. It will be included in the signal field of the alert.  
  
Alert TriggerAlert TriggerAlert TriggerAlert Trigger  -- Here you can select when an alert should be triggered. Here you can select when an alert should be triggered.

l CrossedCrossed: Triggers when the price crosses the tool, e.g. goes from below the tool to above the tool: Triggers when the price crosses the tool, e.g. goes from below the tool to above the tool  
l Hit or CrossedHit or Crossed: Same as above, but also triggers when the price merely hits the tool. This setting is useful for: Same as above, but also triggers when the price merely hits the tool. This setting is useful for a  a Point&Figure Point&Figure 

ChartChart..  
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l BreakBreak--in/Breakin/Break--outout: Treats the tool not as two separate lines but as a channel instead and triggers an alert, when the price : Treats the tool not as two separate lines but as a channel instead and triggers an alert, when the price 
breaks into or out of the tool's channel.breaks into or out of the tool's channel.  

For further information on alert modes, see the chapter For further information on alert modes, see the chapter AlertsAlerts..

LINKS AND BOOKSLINKS AND BOOKS  

http://www.investopedia.com/articles/forex/05/AndrewsPitchfork.asphttp://www.investopedia.com/articles/forex/05/AndrewsPitchfork.asp    
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LINEAR REGRESSION CHANNEL 
The linear regression channel is a drawing tool with a calculation function. The linear regression channel is a drawing tool with a calculation function. 
You as the user define the start and end point of the channel as well as the You as the user define the start and end point of the channel as well as the 
calculation method for the outer lines. The definite position of the channel calculation method for the outer lines. The definite position of the channel 
in the chart, however, results from the calculation of the midin the chart, however, results from the calculation of the mid--line. line.   
  
The midThe mid--line of the channel is calculated on the basis of linear regression line of the channel is calculated on the basis of linear regression 
with the with the least square methodleast square method. In this method, the line that is drawn . In this method, the line that is drawn 
through a number of data points effectively reflects the trend. The channel through a number of data points effectively reflects the trend. The channel 
is constructed with lines above and below the midis constructed with lines above and below the mid--line, in defined line, in defined 
distances.distances.  
  
The linear regression channel may be used for:The linear regression channel may be used for:

l visualizing trendsvisualizing trends  
l searching swing pointssearching swing points  
l finding resistance and support levelsfinding resistance and support levels  

You can find the tool in the You can find the tool in the Chart Tools Chart Tools group in the group in the toolbartoolbar..

ENTERING A LINEAR REGRESSION CHANNELENTERING A LINEAR REGRESSION CHANNEL  

1.1. Open a symbol chart.Open a symbol chart.  
2.2. Click on the linear regression channel tool in the toolbar.Click on the linear regression channel tool in the toolbar.  
3.3. Click into the chart to set the starting point of the linear regression channel.Click into the chart to set the starting point of the linear regression channel.  
4.4. Keep the mouse button pressed and move the pointer to the end point of the linear regression channel. Release the mouse Keep the mouse button pressed and move the pointer to the end point of the linear regression channel. Release the mouse 

button.button.  

By default, the linear regression channel is drawn with a standard deviation of "2" from the linear regression line. Therefore, the By default, the linear regression channel is drawn with a standard deviation of "2" from the linear regression line. Therefore, the 
width of the channel depends on the price volatility over the time span between the channel start and end.width of the channel depends on the price volatility over the time span between the channel start and end.  
  
Since the linear regression channel is based on calculation, it aligns to the data points almost as if in Snap Mode.Since the linear regression channel is based on calculation, it aligns to the data points almost as if in Snap Mode.

EDITING A LINEAR REGRESSION CHANNELEDITING A LINEAR REGRESSION CHANNEL  

l To move the linear regression channel, drag it with the mouse (the mouse pointer turns into a hand symbol) and move it. To move the linear regression channel, drag it with the mouse (the mouse pointer turns into a hand symbol) and move it. 
Release the mouse button when done. Note that since the linear regression channel is based on calculation, it aligns to the Release the mouse button when done. Note that since the linear regression channel is based on calculation, it aligns to the 
data points almost as if in Snap Mode.data points almost as if in Snap Mode.  

l To extend the length of the linear regression channel, i.e. the data points used for calculation, click an anchor point at the To extend the length of the linear regression channel, i.e. the data points used for calculation, click an anchor point at the 
end of the middle line (the mouse pointer changes into a double arrow) and drag it.end of the middle line (the mouse pointer changes into a double arrow) and drag it.  

l To extend the length of the channel until the right or left edge of the chart, doubleTo extend the length of the channel until the right or left edge of the chart, double--click on the respective anchor point at the click on the respective anchor point at the 

Linear Regression ChannelLinear Regression Channel
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end of the middle line.end of the middle line.  

l You can duplicate a linear regression channel by doubleYou can duplicate a linear regression channel by double--clicking on it.clicking on it.  

l When the linear regression channel is selected, you can edit the properties in the toolbox.When the linear regression channel is selected, you can edit the properties in the toolbox.  

l You can edit the width of the linear regression channel either by changing the You can edit the width of the linear regression channel either by changing the StdDevStdDevStdDevStdDev parameters for the Standard  parameters for the Standard 
Deviation or by selecting another calculation method for the channel (see below).Deviation or by selecting another calculation method for the channel (see below).  

l The alert function is available for the linear regression channel. To set an alert, set the The alert function is available for the linear regression channel. To set an alert, set the Alert ModeAlert ModeAlert ModeAlert Mode from  from DisabledDisabled to one of  to one of 
the options (see below).the options (see below).  

l To delete the linear regression channel, rightTo delete the linear regression channel, right--click on it and select click on it and select DeleteDeleteDeleteDelete from the context menu. Alternatively, select the  from the context menu. Alternatively, select the 
linear regression channel and press the linear regression channel and press the DELDELDELDEL key. key.  

PROPERTIESPROPERTIES  

REGRESSION CHANNEL PROPERTIESREGRESSION CHANNEL PROPERTIES  

Extend LeftExtend LeftExtend LeftExtend Left//Extend RightExtend RightExtend RightExtend Right  -- Select if the channel is to be extended to the left and/or right until the edge of the chart. Select if the channel is to be extended to the left and/or right until the edge of the chart.  
  
Channel MethodChannel MethodChannel MethodChannel Method  -- Select the method that will be used for calculating the channel:  Select the method that will be used for calculating the channel: 

l Standard DeviationStandard DeviationStandard DeviationStandard Deviation  -- The width of the channel is given by the measured standard deviation in the channel's time span.  The width of the channel is given by the measured standard deviation in the channel's time span. 
The The StDvs upStDvs upStDvs upStDvs up and  and StDvs downStDvs downStDvs downStDvs down parameters give the offset (above and below) from the regression line. parameters give the offset (above and below) from the regression line.  

l High / LowHigh / LowHigh / LowHigh / Low  -- The channel includes the highest and lowest price within the time span. This channel method is similar to the  The channel includes the highest and lowest price within the time span. This channel method is similar to the 
classic classic Trend ChannelTrend Channel..  

l PercentagePercentagePercentagePercentage  -- The width is given as percentage of the price at the last anchor point. The  The width is given as percentage of the price at the last anchor point. The %%%% parameter gives the offset from  parameter gives the offset from 
the regression line.the regression line.  

GRAPHIC PROPERTIESGRAPHIC PROPERTIES  

The following properties can be set for the linear regression tool:The following properties can be set for the linear regression tool:  
  
ColorColorColorColor  -- Here you can select a color for the lines.  Here you can select a color for the lines.   
  
WidthWidthWidthWidth  -- Here you can set a line width by entering a number. Here you can set a line width by entering a number.  
  
StyleStyleStyleStyle  -- Here you can select a line style, e.g. solid or dotted. Here you can select a line style, e.g. solid or dotted.  
  
ShadowShadowShadowShadow  -- Here you can set a shadow for emphasizing the lines with a 3D effect. Four settings are available.  Here you can set a shadow for emphasizing the lines with a 3D effect. Four settings are available.   
  
Fill ColorFill ColorFill ColorFill Color  -- Here you can select a color and opacity for the channel area.  Here you can select a color and opacity for the channel area.   
  
LabelLabelLabelLabel  -- Here you can set the value label for the current data point to visible or hidden. In Tradesignal Here you can set the value label for the current data point to visible or hidden. In Tradesignal you can also specifiy the  you can also specifiy the 
location at which the label should be displayed.location at which the label should be displayed.
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ALERT PROPERTIESALERT PROPERTIES  

The linear regression channel tool can be used with various kinds of alerts. The linear regression channel tool can be used with various kinds of alerts.   
  
Alert DirectionAlert DirectionAlert DirectionAlert Direction  -- Here you can select from the list whether crossings of all types lead to alerts or only crossings in a certain  Here you can select from the list whether crossings of all types lead to alerts or only crossings in a certain 
direction.direction.  
  
Alert ModeAlert ModeAlert ModeAlert Mode  -- Here you can select an alert mode from the list. Select whether every crossing is considered or only one crossing per  Here you can select an alert mode from the list. Select whether every crossing is considered or only one crossing per 
trading period or trend line. trading period or trend line.   
  
Alert NameAlert NameAlert NameAlert Name  -- Here you can specify a name for alerts generated by this tool. It will be included in the signal field of the alert. Here you can specify a name for alerts generated by this tool. It will be included in the signal field of the alert.  
  
Alert TriggerAlert TriggerAlert TriggerAlert Trigger  -- Here you can select when an alert should be triggered. Here you can select when an alert should be triggered.

l CrossedCrossed: Triggers when the price crosses the tool, e.g. goes from below the tool to above the tool: Triggers when the price crosses the tool, e.g. goes from below the tool to above the tool  
l Hit or CrossedHit or Crossed: Same as above, but also triggers when the price merely hits the tool. This setting is useful for: Same as above, but also triggers when the price merely hits the tool. This setting is useful for a  a Point&Figure Point&Figure 

ChartChart..  
l BreakBreak--in/Breakin/Break--outout: Treats the tool not as two separate lines but as a channel instead and triggers an alert, when the price : Treats the tool not as two separate lines but as a channel instead and triggers an alert, when the price 

breaks into or out of the tool's channel.breaks into or out of the tool's channel.  

For further information on alert modes, see the chapter For further information on alert modes, see the chapter AlertsAlerts..

LINKS AND BOOKSLINKS AND BOOKS  

"Trading the Regression Channel" "Trading the Regression Channel" -- Gilbert Raff Gilbert Raff    
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GANN LINE 
The Gann line is a drawing tool based on the analysis methods of W.D. The Gann line is a drawing tool based on the analysis methods of W.D. 
Gann. In his publications around 1929 Gann presented methods based on Gann. In his publications around 1929 Gann presented methods based on 
the premise that the market obeys mathematical the premise that the market obeys mathematical --  geometrical geometrical --  laws. laws.   
  
He proposed a relation between the price dimension and time dimension, He proposed a relation between the price dimension and time dimension, 
which construct a price pattern. Thus the idea of constructing trend lines which construct a price pattern. Thus the idea of constructing trend lines 
based on angles and time was born. based on angles and time was born.   
  
You can use Gann lines for You can use Gann lines for 

l Marking trends in price movementsMarking trends in price movements  
l Searching support and resistance price levelsSearching support and resistance price levels  

You can find the Gann line in the You can find the Gann line in the Chart ToolsChart Tools group in the  group in the toolbartoolbar..

ENTERING A GANN LINEENTERING A GANN LINE  

1.1. Open a symbol chart.Open a symbol chart.  
2.2. Click on the Gann line tool in the toolbar.Click on the Gann line tool in the toolbar.  
3.3. Click into the chart to set the starting point.Click into the chart to set the starting point.  

The Gann line is drawn. The default setting of the Gann line is an angle of 45°. This complies to a 1:1 ratio of time and price. The The Gann line is drawn. The default setting of the Gann line is an angle of 45°. This complies to a 1:1 ratio of time and price. The 
angle results from the property angle results from the property RunsRunsRunsRuns ( (RisesRisesRisesRises is a calculated value). Change the  is a calculated value). Change the RunsRunsRunsRuns value to change the angles. With a  value to change the angles. With a RunsRunsRunsRuns  
value of 2, a 1:2 ratio results.value of 2, a 1:2 ratio results.

EDITING A GANN LINEEDITING A GANN LINE  

l To move the Gann line, drag the line, i.e. the anchor point, with the mouse (the mouse pointer turns into a hand symbol) To move the Gann line, drag the line, i.e. the anchor point, with the mouse (the mouse pointer turns into a hand symbol) 
and move it freely. Release the mouse button when done.and move it freely. Release the mouse button when done.  

l You can duplicate a Gann line by doubleYou can duplicate a Gann line by double--clicking on it.clicking on it.  

l When the Gann line is selected, you can edit the properties in the toolbox.When the Gann line is selected, you can edit the properties in the toolbox.  

l To delete the Gann line, rightTo delete the Gann line, right--click on it and select click on it and select DeleteDeleteDeleteDelete from the context menu. Alternatively, select the Gann line and  from the context menu. Alternatively, select the Gann line and 
press the press the DELDELDELDEL key. key.  

PROPERTIESPROPERTIES  

RunsRunsRunsRuns  --  Here you can enter how many candles/bars a price on the price axis should represent. Here you can enter how many candles/bars a price on the price axis should represent.   
  
RisesRisesRisesRises  --  This value is calculated from the This value is calculated from the RunsRunsRunsRuns value and the line properties when first drawing the Gann line. Will not be adapted  value and the line properties when first drawing the Gann line. Will not be adapted 

Gann LineGann Line
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when you move or edit the Gann line. when you move or edit the Gann line.   
  
ColorColorColorColor  --  Here you can edit the line color, e.g. to red. Here you can edit the line color, e.g. to red.   
  
WidthWidthWidthWidth  --  Here you change the thickness of the guide line in pixels, e.g. to "3".Here you change the thickness of the guide line in pixels, e.g. to "3".  
  
StyleStyleStyleStyle  --  Here you can edit the line style, e.g. set it to "Dot".Here you can edit the line style, e.g. set it to "Dot".

LINKSLINKS  

W.D.Gann InvestopediaW.D.Gann Investopedia    
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ARROW 
Like the guide line and other tools, the arrow helps you to illustrate special Like the guide line and other tools, the arrow helps you to illustrate special 
situations in charts. This, in addition with analysis tools, allows you to situations in charts. This, in addition with analysis tools, allows you to 
create more meaningful charts.create more meaningful charts.  
  
You can find the arrow tool in the You can find the arrow tool in the Chart Tools Chart Tools group in the group in the toolbartoolbar..

ENTERING AN ARROWENTERING AN ARROW  

1.1. Open a symbol chart.Open a symbol chart.  
2.2. Click on the arrow tool in the toolbar.Click on the arrow tool in the toolbar.  
3.3. Click into the chart to set the starting point.Click into the chart to set the starting point.  
4.4. Keep the mouse button pressed while moving the pointer to the end point, and release it there.Keep the mouse button pressed while moving the pointer to the end point, and release it there.  

At the start point, a text box appears. It includes general chart information and analysis results (open, high, low...) for the data At the start point, a text box appears. It includes general chart information and analysis results (open, high, low...) for the data 
encompassed by the arrow. encompassed by the arrow.   
  
You can align the anchor points of the arrow to a certain price level. To do so, activate the Snap Mode by clicking on the magnet You can align the anchor points of the arrow to a certain price level. To do so, activate the Snap Mode by clicking on the magnet 
symbol in the toolbar. Now when you draw an arrow in the chart, it is positioned exactly at high and/or low points.symbol in the toolbar. Now when you draw an arrow in the chart, it is positioned exactly at high and/or low points.

EDITING AN ARROWEDITING AN ARROW  

l To move the arrow, drag it with the mouse (the mouse pointer turns into a hand symbol) and move it freely. Release the To move the arrow, drag it with the mouse (the mouse pointer turns into a hand symbol) and move it freely. Release the 
mouse button when done. Note that although the text box will move with the arrow, the text box contents will not be mouse button when done. Note that although the text box will move with the arrow, the text box contents will not be 
refreshed. This might mislead you in interpretation.refreshed. This might mislead you in interpretation.  

l To change the arrow angle, click an anchor point of the arrow (the mouse pointer turns into an xTo change the arrow angle, click an anchor point of the arrow (the mouse pointer turns into an x--y axis symbol) and drag it to y axis symbol) and drag it to 
another position.another position.  

Note that the arrow cannot be moved freely if the Snap Mode is active. If necessary, switch it off by clicking the magnet symbol in Note that the arrow cannot be moved freely if the Snap Mode is active. If necessary, switch it off by clicking the magnet symbol in 
the toolbar. the toolbar. 

l You can duplicate an arrow by doubleYou can duplicate an arrow by double--clicking on it.clicking on it.  

l When the arrow is selected, you can edit the properties in the toolbox.When the arrow is selected, you can edit the properties in the toolbox.  

l To delete the arrow, rightTo delete the arrow, right--click on it and select click on it and select DeleteDeleteDeleteDelete from the context menu. Alternatively, select the trend line and press  from the context menu. Alternatively, select the trend line and press 
the the DELDELDELDEL key. key.  

PROPERTIESPROPERTIES  

User TextUser TextUser TextUser Text  -- Here you can enter a title for the text box, which will be displayed as its header line. Here you can enter a title for the text box, which will be displayed as its header line.  
  

ArrowArrow
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WidthWidthWidthWidth  -- Here you can enter the thickness of the arrow in pixel, e.g. "3". Here you can enter the thickness of the arrow in pixel, e.g. "3".  
  
Arrowhead AngleArrowhead AngleArrowhead AngleArrowhead Angle  -- Here you can set how narrow (small number) or wide (high number) the arrowhead will be. Here you can set how narrow (small number) or wide (high number) the arrowhead will be.  
  
Arrowhead SizeArrowhead SizeArrowhead SizeArrowhead Size  -- Here you can set the length of the arrowhead.  Here you can set the length of the arrowhead.   
  
Step ModeStep ModeStep ModeStep Mode  -- Here you can select whether the line between the start and end point is to be straight or stepped (bent shortly below  Here you can select whether the line between the start and end point is to be straight or stepped (bent shortly below 
the end point).the end point).  
  
Arrowhead ShapeArrowhead ShapeArrowhead ShapeArrowhead Shape  -- Here you can select between four different shapes, e.g. "triangular".  Here you can select between four different shapes, e.g. "triangular".   
  
StyleStyleStyleStyle  -- Here you can select the line style of the arrow, e.g. "Dot".  Here you can select the line style of the arrow, e.g. "Dot".   
  
Arrow Border ColorArrow Border ColorArrow Border ColorArrow Border Color  -- Here you can edit the arrow color. Here you can edit the arrow color.  
  
Arrow Fill ColorArrow Fill ColorArrow Fill ColorArrow Fill Color  -- Here you can edit the fill color for the arrowhead. Here you can edit the fill color for the arrowhead.  
  
AutotextAutotextAutotextAutotext  -- Here you can set how many details are displayed in the text box. The box can include basic chart information or also  Here you can set how many details are displayed in the text box. The box can include basic chart information or also 
indicator data etc.indicator data etc.  
  
Autotext Fill ColorAutotext Fill ColorAutotext Fill ColorAutotext Fill Color  -- Here you can edit the background color for the text box.  Here you can edit the background color for the text box.   
  
Autotext ColorAutotext ColorAutotext ColorAutotext Color  -- Here you can edit the text color in the text box. Here you can edit the text color in the text box.  
  
Guide LineGuide LineGuide LineGuide Line  -- Select if the guide line should always be visible. Otherwise it will be temporarily displayed to help you setting the  Select if the guide line should always be visible. Otherwise it will be temporarily displayed to help you setting the 
exact arrow's end point.exact arrow's end point.    
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GUIDE LINE 
The guide line is a tool for marking events in a trading period. With it, you The guide line is a tool for marking events in a trading period. With it, you 
can easily emphasize a candle, a bar or the signal of an indicator. In can easily emphasize a candle, a bar or the signal of an indicator. In 
Tradesignal, the guide line comes with a date label. Tradesignal, the guide line comes with a date label.   
  
You can find the guide line in the You can find the guide line in the Chart ToolsChart Tools group in the  group in the toolbartoolbar..

ENTERING A GUIDE LINEENTERING A GUIDE LINE  

1.1. Open a symbol chart.Open a symbol chart.  
2.2. Click on the guide line tool in the toolbar.Click on the guide line tool in the toolbar.  
3.3. Click into the chart to set the anchor point of the guide line.Click into the chart to set the anchor point of the guide line.  

The guide line is drawn into the graph. The default setting of the tool is that a guide line drawn in a chart will be displayed in all The guide line is drawn into the graph. The default setting of the tool is that a guide line drawn in a chart will be displayed in all 
subcharts. However, you can move or delete this guide line only in the chart in which it was originally drawn, because only there subcharts. However, you can move or delete this guide line only in the chart in which it was originally drawn, because only there 
can you take hold of it with the mouse.can you take hold of it with the mouse.  
  
You can align the guide line to a certain price level. To do so, activate the Snap Mode by clicking on the magnet symbol in the You can align the guide line to a certain price level. To do so, activate the Snap Mode by clicking on the magnet symbol in the 
toolbar. Now when you draw the guide line in the chart, it is positioned exactly at high and/or low points.toolbar. Now when you draw the guide line in the chart, it is positioned exactly at high and/or low points.

EDITING A GUIDE LINEEDITING A GUIDE LINE  

l To move the guide line, drag it with the mouse (the mouse pointer turns into a vertical double arrow symbol) and move it To move the guide line, drag it with the mouse (the mouse pointer turns into a vertical double arrow symbol) and move it 
freely. Release the mouse button when done.freely. Release the mouse button when done.  

Note that the guideNote that the guide line cannot be moved freely if the Snap Mode is active. If necessary, switch it off by clicking the magnet  line cannot be moved freely if the Snap Mode is active. If necessary, switch it off by clicking the magnet 
symbol in the toolbar. symbol in the toolbar. 

l You can duplicate a guide line by doubleYou can duplicate a guide line by double--clicking on it.clicking on it.  

l When the guide line is selected, you can edit the properties in the toolbox.When the guide line is selected, you can edit the properties in the toolbox.  

l To delete the guide line, rightTo delete the guide line, right--click on it and select click on it and select DeleteDeleteDeleteDelete from the context menu. Alternatively, select the trend line and  from the context menu. Alternatively, select the trend line and 
press the press the DELDELDELDEL key. key.  

PROPERTIESPROPERTIES  

ColorColorColorColor  -- Here you can edit the line color, e.g. to red.  Here you can edit the line color, e.g. to red.   
  
StyleStyleStyleStyle  -- Here you can edit the line style, e.g. set it to "Dot".  Here you can edit the line style, e.g. set it to "Dot".   
  
WidthWidthWidthWidth  -- Here you change the thickness of the guide line in pixel, e.g. to "3". Here you change the thickness of the guide line in pixel, e.g. to "3".  
  

Guide LineGuide Line
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ScopeScopeScopeScope  -- Here you can select whether the guide line is displayed only in the graph in which it was drawn or in all of them (default). Here you can select whether the guide line is displayed only in the graph in which it was drawn or in all of them (default).
  
LabelLabelLabelLabel  -- Here you can select whether the data point label with date and time (for shorter periods) is visible or hidden in the chart. In  Here you can select whether the data point label with date and time (for shorter periods) is visible or hidden in the chart. In 
Tradesignal you can also specify the the text orientation.Tradesignal you can also specify the the text orientation.  
  
Label AlignmentLabel AlignmentLabel AlignmentLabel Alignment  -- Here you can select at which location the label should be displayed. Here you can select at which location the label should be displayed.    
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ELLIPSE 
The ellipse is a simple drawing object. Typically ellipses are used for The ellipse is a simple drawing object. Typically ellipses are used for 
highlighting the expansion of a consolidation zone, based on the idea of a highlighting the expansion of a consolidation zone, based on the idea of a 
harmonic price movement. harmonic price movement.   
  
You can find the ellipse tool in the You can find the ellipse tool in the Chart ToolsChart Tools group in the  group in the toolbartoolbar..

ENTERING AN ELLIPSEENTERING AN ELLIPSE  

1.1. Open a symbol chart.Open a symbol chart.  
2.2. Click on the ellipse line tool in the toolbar.Click on the ellipse line tool in the toolbar.  
3.3. Click into the chart to set the anchor point.Click into the chart to set the anchor point.  
4.4. Keep the mouse button pressed and draw the ellipse. Release the mouse button when done.Keep the mouse button pressed and draw the ellipse. Release the mouse button when done.  

EDITING AN ELLIPSEEDITING AN ELLIPSE  

l To move the ellipse, drag it with the mouse (the mouse pointer turns into a hand symbol) and move it freely. Release the To move the ellipse, drag it with the mouse (the mouse pointer turns into a hand symbol) and move it freely. Release the 
mouse button when done.mouse button when done.  

l You can duplicate an ellipse by doubleYou can duplicate an ellipse by double--clicking on it.clicking on it.  

l When the ellipse is selected, you can edit the properties in the toolbox.When the ellipse is selected, you can edit the properties in the toolbox.  

l To delete the ellipse, rightTo delete the ellipse, right--click on it and select click on it and select DeleteDeleteDeleteDelete from the context menu. Alternatively, select the ellipse and press  from the context menu. Alternatively, select the ellipse and press 
the the DELDELDELDEL key. key.  

PROPERTIESPROPERTIES  

Fill ColorFill ColorFill ColorFill Color  -- Here you can set up which color and opacity you want to use for the ellipse area. The higher the opacity, the lower the  Here you can set up which color and opacity you want to use for the ellipse area. The higher the opacity, the lower the 
transparency, i.e. the less you can see the original chart behind it. transparency, i.e. the less you can see the original chart behind it.   
  
Border ColorBorder ColorBorder ColorBorder Color  -- Here you can set the border color of the ellipse. Here you can set the border color of the ellipse.    

EllipseEllipse
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RECTANGLE 
The rectangle is a simple drawing tool. Typically rectangles are used for The rectangle is a simple drawing tool. Typically rectangles are used for 
highlighting meanhighlighting mean--reverting markets, support and resistance price levels or reverting markets, support and resistance price levels or 
chart patterns.chart patterns.  
  
You can find the rectangle tool in the You can find the rectangle tool in the Chart ToolsChart Tools group in the  group in the toolbartoolbar..

ENTERING A RECTANGLEENTERING A RECTANGLE  

1.1. Open a symbol chart.Open a symbol chart.  
2.2. Click on the rectangle tool in the toolbar.Click on the rectangle tool in the toolbar.  
3.3. Click into the chart to set the anchor point.Click into the chart to set the anchor point.  
4.4. Keep the mouse button pressed and draw the rectangle. Release the mouse button when done.Keep the mouse button pressed and draw the rectangle. Release the mouse button when done.  

EDITING A RECTANGLEEDITING A RECTANGLE  

l To move the rectangle, drag it with the mouse (the mouse pointer turns into a hand symbol) and move it freely. Release the To move the rectangle, drag it with the mouse (the mouse pointer turns into a hand symbol) and move it freely. Release the 
mouse button when done.mouse button when done.  

l To move single sides of the rectangle up/down or left/right, click an anchor point in the middle of a side and drag it.To move single sides of the rectangle up/down or left/right, click an anchor point in the middle of a side and drag it.  

l To change the size of the rectangle, click an anchor point in the corner of the rectangle and drag it.To change the size of the rectangle, click an anchor point in the corner of the rectangle and drag it.  

l You can duplicate a rectangle by doubleYou can duplicate a rectangle by double--clicking on it.clicking on it.  

l When the rectangle is selected, you can edit the properties in the toolbox.When the rectangle is selected, you can edit the properties in the toolbox.  

l To delete the rectangle, rightTo delete the rectangle, right--click on it and select click on it and select DeleteDeleteDeleteDelete from the context menu. Alternatively, select the rectangle and  from the context menu. Alternatively, select the rectangle and 
press the press the DELDELDELDEL key. key.  

PROPERTIESPROPERTIES  

Fill ColorFill ColorFill ColorFill Color  -- Here you can set up which color and opacity you want to use for the rectangle area. The higher the opacity, the lower  Here you can set up which color and opacity you want to use for the rectangle area. The higher the opacity, the lower 
the transparency, i.e. the less you can see the original chart behind it. the transparency, i.e. the less you can see the original chart behind it.   
  
Border ColorBorder ColorBorder ColorBorder Color  -- Here you can set the border color of the rectangle. Here you can set the border color of the rectangle.    

RectangleRectangle
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CIRCLE 
The circle is a simple drawing object. Typically circles are used for The circle is a simple drawing object. Typically circles are used for 
highlighting intersections of trend lines, chart patterns or target prices.highlighting intersections of trend lines, chart patterns or target prices.  
  
You can find the circle tool in the You can find the circle tool in the Chart ToolsChart Tools group in the  group in the toolbartoolbar..

ENTERING A CIRCLEENTERING A CIRCLE  

1.1. Open a symbol chart.Open a symbol chart.  
2.2. Click on the circle tool in the toolbar.Click on the circle tool in the toolbar.  
3.3. Click into the chart to set the anchor point.Click into the chart to set the anchor point.  
4.4. Keep the mouse button pressed and draw the circle. Release the mouse button when done.Keep the mouse button pressed and draw the circle. Release the mouse button when done.  

EDITING A CIRCLEEDITING A CIRCLE  

l To move the circle, drag it with the mouse (the mouse pointer turns into a hand symbol) and move it freely. Release the To move the circle, drag it with the mouse (the mouse pointer turns into a hand symbol) and move it freely. Release the 
mouse button when done.mouse button when done.  

l You can duplicate a circle by doubleYou can duplicate a circle by double--clicking on it.clicking on it.  

l When the circle is selected, you can edit the properties in the toolbox.When the circle is selected, you can edit the properties in the toolbox.  

l To delete the circle, rightTo delete the circle, right--click on it and select click on it and select DeleteDeleteDeleteDelete from the context menu. Alternatively, select the circle and press the  from the context menu. Alternatively, select the circle and press the 
DELDELDELDEL key. key.  

PROPERTIESPROPERTIES  

Fill ColorFill ColorFill ColorFill Color  -- Here you can set the color and opacity for the circle area. The higher the opacity, the lower the transparency, i.e. the  Here you can set the color and opacity for the circle area. The higher the opacity, the lower the transparency, i.e. the 
less you can see the original chart behind it. less you can see the original chart behind it.   
  
Border ColorBorder ColorBorder ColorBorder Color  -- Here you can set the border color of the circle. Here you can set the border color of the circle.    

CircleCircle
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ARC 
The arc is a simple drawing object useful for highlighting special situations The arc is a simple drawing object useful for highlighting special situations 
in a chart. in a chart.   
  
You can find the arc tool in the You can find the arc tool in the Chart ToolsChart Tools group in the  group in the toolbartoolbar..

ENTERING AN ARCENTERING AN ARC  

1.1. Open a symbol chart.Open a symbol chart.  
2.2. Click on the arc tool in the toolbar.Click on the arc tool in the toolbar.  
3.3. Click into the chart to set the anchor point.Click into the chart to set the anchor point.  
4.4. Keep the mouse button pressed and draw the arc. Release the mouse button when done.Keep the mouse button pressed and draw the arc. Release the mouse button when done.  

EDITING AN ARCEDITING AN ARC  

l To move the arc, drag it with the mouse (the mouse pointer turns into a hand symbol) and move it freely. Release the mouse To move the arc, drag it with the mouse (the mouse pointer turns into a hand symbol) and move it freely. Release the mouse 
button when done.button when done.  

l To change the size of the arc, click on an anchor point surrounding the arc and drag it.To change the size of the arc, click on an anchor point surrounding the arc and drag it.  

l You can duplicate an arc by doubleYou can duplicate an arc by double--clicking on it.clicking on it.  

l When the arc is selected, you can edit the properties in the toolbox.When the arc is selected, you can edit the properties in the toolbox.  

l To delete the arc, rightTo delete the arc, right--click on it and select click on it and select DeleteDeleteDeleteDelete from the context menu. Alternatively, select the arc and press the  from the context menu. Alternatively, select the arc and press the DELDELDELDEL  
key.key.  

PROPERTIESPROPERTIES  

Fill ColorFill ColorFill ColorFill Color  -- Here you can set the color and opacity for the arc area. The higher the opacity, the lower the transparency, i.e. the less  Here you can set the color and opacity for the arc area. The higher the opacity, the lower the transparency, i.e. the less 
you can see the original chart behind it. you can see the original chart behind it.   
  
Border ColorBorder ColorBorder ColorBorder Color  -- Here you can set the border color of the arc. Here you can set the border color of the arc.    

ArcArc
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FIBONACCI RETRACEMENTS 
Fib. Retracements are a drawing tool with a calculation function. You as Fib. Retracements are a drawing tool with a calculation function. You as 
the user define the start and end point of the price levels that are to be the user define the start and end point of the price levels that are to be 
used for the calculation. You can base your decision on price or correction used for the calculation. You can base your decision on price or correction 
movements. movements.   
  
Between these two price levels, the retracement lines are drawn according Between these two price levels, the retracement lines are drawn according 
to the numerical proportion of the to the numerical proportion of the Fibonacci numerical seriesFibonacci numerical series. The . The 
calculation is based on the calculation is based on the golden sectiongolden section. The theory behind using Fib. . The theory behind using Fib. 
Retracements for chart analysis is that price movements have rhythms Retracements for chart analysis is that price movements have rhythms 
similar to natural processes. similar to natural processes.   
  
Fib. Retracements may be used for:Fib. Retracements may be used for:

l finding course aims of correction movementsfinding course aims of correction movements  
l finding course aims of trend movementsfinding course aims of trend movements  
l finding price targets of breakoutsfinding price targets of breakouts  
l judging the market and its trendsjudging the market and its trends  
l finding potential entry points at swing pointsfinding potential entry points at swing points  

You can find the tool in the You can find the tool in the Chart Tools Chart Tools group in the group in the toolbartoolbar..

ENTERING FIBONACCI RETRACEMENTSENTERING FIBONACCI RETRACEMENTS  

1.1. Open a symbol chart.Open a symbol chart.  
2.2. Click on the Fib. Retracements tool in the toolbar.Click on the Fib. Retracements tool in the toolbar.  
3.3. Click into the chart to set the start point of the price development (this is the 0% level).Click into the chart to set the start point of the price development (this is the 0% level).  
4.4. Keep the mouse button pressed and move the pointer to the end point of the price development (this is the 100% level). Keep the mouse button pressed and move the pointer to the end point of the price development (this is the 100% level). 

Release the mouse button.Release the mouse button.  

Between the 0 and 100% levels, the calculated lines are drawn. The horizontal position of the anchor points can be changed Between the 0 and 100% levels, the calculated lines are drawn. The horizontal position of the anchor points can be changed 
without effect. Only the distance between the resulting lines is important. without effect. Only the distance between the resulting lines is important.   
  
For extrapolating values beyond the 100% level, you can set the corresponding lines to visible (e.g. for 138.2% and 161.8%). To do For extrapolating values beyond the 100% level, you can set the corresponding lines to visible (e.g. for 138.2% and 161.8%). To do 
so, select the check boxes in the property inspector in the toolbar.so, select the check boxes in the property inspector in the toolbar.

DIRECTIONDIRECTION--DEPENDENT ANALYSISDEPENDENT ANALYSIS  

Fib. RetracementFib. Retracement
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For the sensible usage of the Fib. Retracements, it is important to enter the For the sensible usage of the Fib. Retracements, it is important to enter the 
lines correctly into the chart. The start and end points have to be placed lines correctly into the chart. The start and end points have to be placed 
differently depending on whether you wish to analyze correction differently depending on whether you wish to analyze correction 
movements or trend movements. movements or trend movements. 

ANALYSIS OF UPWARDS MOVEMENTSANALYSIS OF UPWARDS MOVEMENTS  

l For finding possible correction levels in an upwards movement, For finding possible correction levels in an upwards movement, 
draw the line from the high to the low point of the movement. This draw the line from the high to the low point of the movement. This 
puts the 0% level at the high and the 100% level at the low point. puts the 0% level at the high and the 100% level at the low point. 
The standard lines that are displayed separate the trend movement The standard lines that are displayed separate the trend movement 
into the possible correction levels.into the possible correction levels.  

l To find possible future price levels of an upwards movement, To find possible future price levels of an upwards movement, 
however, draw the line from the low to the high point. Then set the however, draw the line from the low to the high point. Then set the 
levels beyond 100% to visible by selecting them in the properties.levels beyond 100% to visible by selecting them in the properties.  

ANALYSIS OF DOWNWARDS MOVEMENTSANALYSIS OF DOWNWARDS MOVEMENTS  

l For finding possible correction levels in a downwards movement, For finding possible correction levels in a downwards movement, 
draw the line from the low to the high point of the movement. This draw the line from the low to the high point of the movement. This 
puts the 0% level at the low and the 100% level at the high point. The standard lines that are displayed separate the trend puts the 0% level at the low and the 100% level at the high point. The standard lines that are displayed separate the trend 
movement into the possible correction levels.movement into the possible correction levels.  

l To find possible future price levels of a downwards movement, however, draw the line from the high to the low point. Then To find possible future price levels of a downwards movement, however, draw the line from the high to the low point. Then 
set the levels beyond 100% to visible by selecting them in the properties.set the levels beyond 100% to visible by selecting them in the properties.  

EDITING FIB. RETRACEMENTSEDITING FIB. RETRACEMENTS  

l To change the 0% and 100% marks, click the anchor point of the respective line (the mouse pointer changes into an xTo change the 0% and 100% marks, click the anchor point of the respective line (the mouse pointer changes into an x--y axis y axis 
symbol) and move it. The line positions will be adapted accordingly.symbol) and move it. The line positions will be adapted accordingly.  

l To move Fib. Retracements, drag them with the mouse (the mouse pointer turns into a hand symbol) and move it freely. To move Fib. Retracements, drag them with the mouse (the mouse pointer turns into a hand symbol) and move it freely. 
Release the mouse button when done.Release the mouse button when done.  

l You can edit the ratio of each Fib. line in the retracements. To do so, click on the numbers next to the check boxes (in the You can edit the ratio of each Fib. line in the retracements. To do so, click on the numbers next to the check boxes (in the 
properties) and enter new values.properties) and enter new values.  

l You can duplicate the Fib. Retracements by doubleYou can duplicate the Fib. Retracements by double--clicking on them.clicking on them.  

l When the Fib. Retracements are selected, you can edit the properties in the toolbox.When the Fib. Retracements are selected, you can edit the properties in the toolbox.  

l The alert function is available for Fib. Retracements. To set an alert, set the The alert function is available for Fib. Retracements. To set an alert, set the Alert ModeAlert ModeAlert ModeAlert Mode from  from DisabledDisabled to one of the options  to one of the options 
(see below).(see below).  

l To delete the Fib. Retracements, rightTo delete the Fib. Retracements, right--click on them and select click on them and select DeleteDeleteDeleteDelete  from the context menu. Alternatively, select the Fib. from the context menu. Alternatively, select the Fib. 
Retracements and press the Retracements and press the DELDELDELDEL key. key.  

Upwards MovementUpwards Movement

Downwards MovementDownwards Movement
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PROPERTIESPROPERTIES  

FIB. RETRACEMENTS PROPERTIESFIB. RETRACEMENTS PROPERTIES  

% 1, % 2...% 1, % 2...% 1, % 2...% 1, % 2...  -- Select from the list of available Fib. levels the ones you want to display. You can edit the values by clicking on the  Select from the list of available Fib. levels the ones you want to display. You can edit the values by clicking on the 
numbers to the right of the check boxes and entering new ones. numbers to the right of the check boxes and entering new ones.   
  
Extend LeftExtend LeftExtend LeftExtend Left//Extend RightExtend RightExtend RightExtend Right  -- Select whether the lines are to be extended to the left and/or right until the edge of the chart. Select whether the lines are to be extended to the left and/or right until the edge of the chart.  
  
ModusModusModusModus  -- Select whether the lines are to be displayed in linear or logarithmic scale. Select whether the lines are to be displayed in linear or logarithmic scale.

GRAPHIC PROPERTIESGRAPHIC PROPERTIES  

The following properties can be set for the Fib. Retracements tool:The following properties can be set for the Fib. Retracements tool:  
  
ColorColorColorColor  -- Here you can select a line color.  Here you can select a line color.   
  
WidthWidthWidthWidth  -- Here you can set a width for all lines by entering a number. Here you can set a width for all lines by entering a number.  
  
StyleStyleStyleStyle  -- Here you can select a line style, e.g. solid or dotted. Here you can select a line style, e.g. solid or dotted.  
  
LabelsLabelsLabelsLabels  -- Here you can set the value label for the lines to visible or hidden. In Tradesignal you can also specifiy the location at  Here you can set the value label for the lines to visible or hidden. In Tradesignal you can also specifiy the location at 
which the label should be displayed.which the label should be displayed.  
  
Show Guide LineShow Guide LineShow Guide LineShow Guide Line  -- Here you can select whether the guide line (the line connecting the two anchor points of the 0% and 100%  Here you can select whether the guide line (the line connecting the two anchor points of the 0% and 100% 
lines) is visible or hidden.lines) is visible or hidden.

ALERT PROPERTIESALERT PROPERTIES  

The Retracements tool can be used with various kinds of alerts. The Retracements tool can be used with various kinds of alerts.   
  
Alert DirectionAlert DirectionAlert DirectionAlert Direction  -- Here you can select from the list whether crossings of all types lead to alerts or only crossings in a certain  Here you can select from the list whether crossings of all types lead to alerts or only crossings in a certain 
direction.direction.  
  
Alert ModeAlert ModeAlert ModeAlert Mode  -- Here you can select an alert mode from the list. Select whether crossing raises an alert always, once per bar or once  Here you can select an alert mode from the list. Select whether crossing raises an alert always, once per bar or once 
overall.overall.  
  
Alert NameAlert NameAlert NameAlert Name  -- Here you can specify a name for alerts generated by this tool. It will be included in the signal field of the alert. Here you can specify a name for alerts generated by this tool. It will be included in the signal field of the alert.  
  
Alert TriggerAlert TriggerAlert TriggerAlert Trigger  -- Here you can select when an alert should be triggered. Here you can select when an alert should be triggered.

l CrossedCrossed: Triggers when the price crosses the tool, e.g. goes from below the tool to above the tool: Triggers when the price crosses the tool, e.g. goes from below the tool to above the tool  
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l Hit or CrossedHit or Crossed: Same as above, but also triggers when the price merely hits the tool. This setting is useful for: Same as above, but also triggers when the price merely hits the tool. This setting is useful for a  a Point&Figure Point&Figure 
ChartChart..  

For further information on alert modes, see For further information on alert modes, see AlertsAlerts..    
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FIBONACCI EXTENSIONS 
Fibonacci Extensions is a drawing tool with a calculation function. You as Fibonacci Extensions is a drawing tool with a calculation function. You as 
the user define the start on a significant swing low, then drag your mouse the user define the start on a significant swing low, then drag your mouse 
and click on the most recent swing high. Finally, drag your mouse down and click on the most recent swing high. Finally, drag your mouse down 
and click on any of the retracement levels.and click on any of the retracement levels.  
  
Between these three price levels, the extension lines are projected Between these three price levels, the extension lines are projected 
according to the numerical proportion of the according to the numerical proportion of the Fibonacci numerical seriesFibonacci numerical series. . 
The calculation is based on the The calculation is based on the golden sectiongolden section. The theory behind using . The theory behind using 
Fibonacci Extensions for chart analysis is that price movements have Fibonacci Extensions for chart analysis is that price movements have 
rhythms similar to natural processes. rhythms similar to natural processes.   
  
Most traders use Fibonacci Extensions in combination with other technical indicators/patterns to help them determine appropriate Most traders use Fibonacci Extensions in combination with other technical indicators/patterns to help them determine appropriate 
target prices.target prices.  
  
You can find the tool in the You can find the tool in the Chart Tools Chart Tools group in the group in the toolbartoolbar..

ENTERING FIBONACCI EXTENSIONSENTERING FIBONACCI EXTENSIONS  

1.1. Open a symbol chart.Open a symbol chart.  
2.2. Click on the Fibonacci Extensions tool in the toolbar.Click on the Fibonacci Extensions tool in the toolbar.  
3.3. Click into the chart to set the low swing point.Click into the chart to set the low swing point.  
4.4. Keep the mouse button pressed and move the pointer to a swing high. Release the mouse button.Keep the mouse button pressed and move the pointer to a swing high. Release the mouse button.  

The third point will be automatically calculated, but may be repositioned later by clicking and dragging it. For extrapolating values The third point will be automatically calculated, but may be repositioned later by clicking and dragging it. For extrapolating values 
beyond the 100% level, you can set the corresponding lines to visible (e.g. for 138.2% and 161.8%). To do so, select the check beyond the 100% level, you can set the corresponding lines to visible (e.g. for 138.2% and 161.8%). To do so, select the check 
boxes in the property inspector in the toolbar.boxes in the property inspector in the toolbar.

DIRECTIONDIRECTION--DEPENDENT ANALYSISDEPENDENT ANALYSIS  

For the sensible usage of the Fibonacci Extensions, it is important to enter the lines correctly into the chart. The start and end points For the sensible usage of the Fibonacci Extensions, it is important to enter the lines correctly into the chart. The start and end points 
have to be placed appropriately depending on whether you wish to analyze correction movements or trend movements. have to be placed appropriately depending on whether you wish to analyze correction movements or trend movements. 

EDITING FIBONACCI EXTENSIONSEDITING FIBONACCI EXTENSIONS  

l To change the marks, click the anchor point of the respective line (the mouse pointer changes into an xTo change the marks, click the anchor point of the respective line (the mouse pointer changes into an x--y axis symbol) and y axis symbol) and 
move it. The line positions will be adapted accordingly.move it. The line positions will be adapted accordingly.  

l To move Fibonacci Extensions, drag them with the mouse (the mouse pointer turns into a hand symbol) and move it freely. To move Fibonacci Extensions, drag them with the mouse (the mouse pointer turns into a hand symbol) and move it freely. 
Release the mouse button when done.Release the mouse button when done.  

Fibonacci ExtensionsFibonacci Extensions
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l You can edit the ratio of each Fibonacci line in the extension. To do so, click on the numbers next to the check boxes (in the You can edit the ratio of each Fibonacci line in the extension. To do so, click on the numbers next to the check boxes (in the 
properties) and enter new values.properties) and enter new values.  

l You can duplicate the Fibonacci Extensions by doubleYou can duplicate the Fibonacci Extensions by double--clicking on them.clicking on them.  

l When the Fibonacci Extensions is selected, you can edit the properties in the toolbox.When the Fibonacci Extensions is selected, you can edit the properties in the toolbox.  

l The alert function is available for Fibonacci Extensions. To set an alert, set the The alert function is available for Fibonacci Extensions. To set an alert, set the Alert ModeAlert ModeAlert ModeAlert Mode from  from DisabledDisabled to one of the  to one of the 
options (see below).options (see below).  

l To delete the Fibonacci Extensions, rightTo delete the Fibonacci Extensions, right--click on them and select click on them and select DeleteDeleteDeleteDelete from the context menu. Alternatively, select the  from the context menu. Alternatively, select the 
Fibonacci Extensions and press the Fibonacci Extensions and press the DELDELDELDEL key. key.  

l You can extend the Fibonacci lines by either clicking and dragging an end on either side, or enabling the You can extend the Fibonacci lines by either clicking and dragging an end on either side, or enabling the Extend LeftExtend Left or  or 
Extend RightExtend Right properties in the Inspector. properties in the Inspector.  

PROPERTIESPROPERTIES  

FIBONACCI EXTENSIONS PROPERTIESFIBONACCI EXTENSIONS PROPERTIES  

% 1, % 2...% 1, % 2...% 1, % 2...% 1, % 2...  -- Select from the list of available Fib. levels the ones you want to display. You can edit the values by clicking on the  Select from the list of available Fib. levels the ones you want to display. You can edit the values by clicking on the 
numbers to the right of the check boxes and entering new ones. numbers to the right of the check boxes and entering new ones.   
  
Extend LeftExtend LeftExtend LeftExtend Left//Extend RightExtend RightExtend RightExtend Right  -- Select whether the lines are to be extended to the left and/or right until the edge of the chart. Select whether the lines are to be extended to the left and/or right until the edge of the chart.  
  
ModeModeModeMode  -- Select whether the lines are to be displayed in linear or logarithmic scale. Select whether the lines are to be displayed in linear or logarithmic scale.

GRAPHIC PROPERTIESGRAPHIC PROPERTIES  

The following properties can be set for the Fibonacci Extensions tool:The following properties can be set for the Fibonacci Extensions tool:  
  
ColorColorColorColor  -- Here you can select a line color.  Here you can select a line color.   
  
WidthWidthWidthWidth  -- Here you can set a width for all lines by entering a number. Here you can set a width for all lines by entering a number.  
  
StyleStyleStyleStyle  -- Here you can select a line style, e.g. solid or dotted. Here you can select a line style, e.g. solid or dotted.  
  
LabelsLabelsLabelsLabels  -- Here you can set the value label for the lines to visible or hidden. In Tradesignal you can also specify the location at  Here you can set the value label for the lines to visible or hidden. In Tradesignal you can also specify the location at 
which the label should be displayed.which the label should be displayed.  
  
Show Guide LineShow Guide LineShow Guide LineShow Guide Line  -- Here you can select whether the guide line Here you can select whether the guide line is visible or hidden. is visible or hidden.

ALERT PROPERTIESALERT PROPERTIES  

The Extensions tool can be used with various kinds of alerts. The Extensions tool can be used with various kinds of alerts.   
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Alert DirectionAlert DirectionAlert DirectionAlert Direction  -- Here you can select from the list whether crossings of all types lead to alerts or only crossings in a certain  Here you can select from the list whether crossings of all types lead to alerts or only crossings in a certain 
direction.direction.  
  
Alert ModeAlert ModeAlert ModeAlert Mode  -- Here you can select an alert mode from the list. Select whether crossing raises an alert always, once per bar or once  Here you can select an alert mode from the list. Select whether crossing raises an alert always, once per bar or once 
overall.overall.  
  
Alert NameAlert NameAlert NameAlert Name  -- Here you can specify a name for alerts generated by this tool. It will be included in the signal field of the alert. Here you can specify a name for alerts generated by this tool. It will be included in the signal field of the alert.  
  
Alert TriggerAlert TriggerAlert TriggerAlert Trigger  -- Here you can select when an alert should be triggered. Here you can select when an alert should be triggered.

l CrossedCrossed: Triggers when the price crosses the tool, e.g. goes from below the tool to above the tool: Triggers when the price crosses the tool, e.g. goes from below the tool to above the tool  
l Hit or CrossedHit or Crossed: Same as above, but also triggers when the price merely hits the tool. This setting is useful for: Same as above, but also triggers when the price merely hits the tool. This setting is useful for a  a Point&Figure Point&Figure 

ChartChart..  

For further information on alert modes, see For further information on alert modes, see AlertsAlerts..    
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FIBONACCI TIME PROJECTION 
Fib. Time Projection is a drawing tool with a calculation function. You as Fib. Time Projection is a drawing tool with a calculation function. You as 
the user define two anchor points at extremes, i.e. either high or low points the user define two anchor points at extremes, i.e. either high or low points 
in the chart.in the chart.    
  
The Fib. Time Projection then extends the distance between the two anchor The Fib. Time Projection then extends the distance between the two anchor 
points in the time line with a number of vertical lines. The lines are points in the time line with a number of vertical lines. The lines are 
calculated by multiplying the distance between the anchor point with the calculated by multiplying the distance between the anchor point with the 
Fibonacci numbersFibonacci numbers. The result is a number of projection lines that can be . The result is a number of projection lines that can be 
useful for finding swing points in charts.useful for finding swing points in charts.  
  
Fib. Time Projections may be used for:Fib. Time Projections may be used for:

l finding possible swing pointsfinding possible swing points  
l finding time aims for current price movementsfinding time aims for current price movements  

You can find the tool in the You can find the tool in the Chart Tools Chart Tools group in the group in the toolbartoolbar..

ENTERING FIBONACCI TIME PROJECTIONENTERING FIBONACCI TIME PROJECTION  

1.1. Open a symbol chart.Open a symbol chart.  
2.2. Click on the Fib. Time Projection tool in the toolbar.Click on the Fib. Time Projection tool in the toolbar.  
3.3. Click into the chart on a high or low point to set the first anchor point.Click into the chart on a high or low point to set the first anchor point.  
4.4. Keep the mouse button pressed and move the pointer to another high or low point of a similar price level in the chart. Keep the mouse button pressed and move the pointer to another high or low point of a similar price level in the chart. 

Release the mouse button.Release the mouse button.  

In a time projection, the Fib. lines are drawn to the right of the anchor points. The vertical position of the anchor points can be In a time projection, the Fib. lines are drawn to the right of the anchor points. The vertical position of the anchor points can be 
changed without effect. Only the distance between the anchor points is important. changed without effect. Only the distance between the anchor points is important.   
  
For extrapolating values beyond the 100% level, you can set the corresponding lines to visible (e.g. for 138.2% and 161.8%). To do For extrapolating values beyond the 100% level, you can set the corresponding lines to visible (e.g. for 138.2% and 161.8%). To do 
so, select the check boxes in the property inspector in theso, select the check boxes in the property inspector in the toolbar. toolbar.

EDITING FIB. TIME PROJECTIONEDITING FIB. TIME PROJECTION  

l To move the anchor points, click on the respective point (the mouse pointer changes into an xTo move the anchor points, click on the respective point (the mouse pointer changes into an x--y axis symbol) and move it. y axis symbol) and move it. 
The line positions will be adapted accordingly.The line positions will be adapted accordingly.  

l To move the Fib. Time Projection, drag it with the mouse (the mouse pointer turns into a hand symbol) and move it freely. To move the Fib. Time Projection, drag it with the mouse (the mouse pointer turns into a hand symbol) and move it freely. 
Release the mouse button when done.Release the mouse button when done.  

l You can edit the ratio of each Fib. line in the retracements. To do so, click on the numbers next to the check boxes (in the You can edit the ratio of each Fib. line in the retracements. To do so, click on the numbers next to the check boxes (in the 
properties) and enter new values.properties) and enter new values.  

l You can duplicate the Fib. Time Projection by doubleYou can duplicate the Fib. Time Projection by double--clicking on it.clicking on it.  

Fibonacci Time ProjectionFibonacci Time Projection
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l When the Fib. Time Projection is selected, you can edit the properties in the toolbox.When the Fib. Time Projection is selected, you can edit the properties in the toolbox.  

l To delete the Fib. Time Projection, rightTo delete the Fib. Time Projection, right--click on it and select click on it and select DeleteDeleteDeleteDelete from the context menu. Alternatively, select the Fib.  from the context menu. Alternatively, select the Fib. 
Time Projection and press the Time Projection and press the DELDELDELDEL key. key.  

PROPERTIESPROPERTIES  

FIB. TIME PROJECTION PROPERTIESFIB. TIME PROJECTION PROPERTIES  

% 1, % 2...% 1, % 2...% 1, % 2...% 1, % 2...  -- Select from the list of available Fib. levels the ones you want to display. You can edit the values by clicking on the  Select from the list of available Fib. levels the ones you want to display. You can edit the values by clicking on the 
numbers to the right of the check boxes and entering new ones. numbers to the right of the check boxes and entering new ones. 

GRAPHIC PROPERTIESGRAPHIC PROPERTIES  

The following properties can be set for the Fib. Time Projection tool:The following properties can be set for the Fib. Time Projection tool:  
  
ColorColorColorColor  -- Here you can select a line color.  Here you can select a line color.   
  
WidthWidthWidthWidth  -- Here you can set a width for all lines by entering a number. Here you can set a width for all lines by entering a number.  
  
StyleStyleStyleStyle  -- Here you can select a line style, e.g. solid or dotted. Here you can select a line style, e.g. solid or dotted.  
  
Label PlacementLabel PlacementLabel PlacementLabel Placement  -- Here you can set whether and where the value labels for the lines will be displayed, bottom or top.  Here you can set whether and where the value labels for the lines will be displayed, bottom or top.   
  
Show Guide LineShow Guide LineShow Guide LineShow Guide Line  -- Here you can select whether the guide line (the line connecting the two anchor points) is to be visible or  Here you can select whether the guide line (the line connecting the two anchor points) is to be visible or 
hidden.hidden.    
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FIBONACCI TIME ZONES 
Fib. Timezones is a drawing tool with a calculation function. You as the Fib. Timezones is a drawing tool with a calculation function. You as the 
user define two anchor points at extremes, i.e. either high or low points in user define two anchor points at extremes, i.e. either high or low points in 
the chart.the chart.    
  
The Fib. Timezones then extends the distance between the two anchor The Fib. Timezones then extends the distance between the two anchor 
points in the time line with a number of vertical lines. The lines are points in the time line with a number of vertical lines. The lines are 
calculated by multiplying the distance between the anchor point with the calculated by multiplying the distance between the anchor point with the 
Fibonacci numbersFibonacci numbers. The result is a number of timezone lines that can be . The result is a number of timezone lines that can be 
useful for finding swing points in charts.useful for finding swing points in charts.  
  
Fib. Timezones may be used for:Fib. Timezones may be used for:

l finding possible swing pointsfinding possible swing points  
l finding time aims for current price movementsfinding time aims for current price movements  

You can find the tool in the You can find the tool in the Chart Tools Chart Tools group in the group in the toolbartoolbar..

ENTERING FIBONACCI TIMEZONESENTERING FIBONACCI TIMEZONES  

1.1. Open a symbol chart.Open a symbol chart.  
2.2. Click on the Fib. Timezones tool in the toolbar.Click on the Fib. Timezones tool in the toolbar.  
3.3. Click into the chart on a high or low point to set the first anchor point.Click into the chart on a high or low point to set the first anchor point.  
4.4. Keep the mouse button pressed and move the pointer to another high or low point of a similar price level in the chart. Keep the mouse button pressed and move the pointer to another high or low point of a similar price level in the chart. 

Release the mouse button.Release the mouse button.  

In a timezone projection, the Fib. lines are drawn to the right of the anchor points. The vertical position of the anchor points can be In a timezone projection, the Fib. lines are drawn to the right of the anchor points. The vertical position of the anchor points can be 
changed without effect. Only the distance between the anchor points is important. changed without effect. Only the distance between the anchor points is important.   
  
For extrapolating values beyond the 100% level, you can set the corresponding lines to visible (e.g. for 138.2 and 161.8%). To do For extrapolating values beyond the 100% level, you can set the corresponding lines to visible (e.g. for 138.2 and 161.8%). To do 
so, select the check boxes in the property inspector in theso, select the check boxes in the property inspector in the toolbar. toolbar.

EDITING FIB. TIMEZONESEDITING FIB. TIMEZONES  

l To move the anchor points, click on the respective point (the mouse pointer changes into an xTo move the anchor points, click on the respective point (the mouse pointer changes into an x--y axis symbol) and move it. y axis symbol) and move it. 
The line positions will be adapted accordingly.The line positions will be adapted accordingly.  

l To move the Fib. Timezones, drag it with the mouse (the mouse pointer turns into a hand symbol) and move it freely. To move the Fib. Timezones, drag it with the mouse (the mouse pointer turns into a hand symbol) and move it freely. 
Release the mouse button when done.Release the mouse button when done.  

l You can edit the ratio of each Fib. line in the retracements. To do so, click on the numbers next to the check boxes (in the You can edit the ratio of each Fib. line in the retracements. To do so, click on the numbers next to the check boxes (in the 
properties) and enter new values.properties) and enter new values.  

l You can duplicate the Fib. Timezones by doubleYou can duplicate the Fib. Timezones by double--clicking on it.clicking on it.  

Fibonacci TimezonesFibonacci Timezones



:: www.tradesignal.comwww.tradesignal.com

Tradesignal GmbHTradesignal GmbH Page 153Page 153 Version 7.0Version 7.0

l When the Fib. Timezones is selected, you can edit the properties in the toolbox.When the Fib. Timezones is selected, you can edit the properties in the toolbox.  

l To delete the Fib. Timezones, rightTo delete the Fib. Timezones, right--click on it and select click on it and select DeleteDeleteDeleteDelete from the context menu. Alternatively, select the Fib.  from the context menu. Alternatively, select the Fib. 
Timezones and press the Timezones and press the DELDELDELDEL key. key.  

PROPERTIESPROPERTIES  

The following properties can be set for the Fib. Timezones tool:The following properties can be set for the Fib. Timezones tool:  
  
ColorColorColorColor  -- Here you can select a line color.  Here you can select a line color.   
  
WidthWidthWidthWidth  -- Here you can set a width for all lines by entering a number. Here you can set a width for all lines by entering a number.  
  
StyleStyleStyleStyle  -- Here you can select a line style, e.g. solid or dotted. Here you can select a line style, e.g. solid or dotted.    
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FIBONACCI ARCS 
Fib. Arcs are a drawing tool with a calculation function. You as the user Fib. Arcs are a drawing tool with a calculation function. You as the user 
define the start and end point of the price levels that are to be used for the define the start and end point of the price levels that are to be used for the 
calculation. The Fib. Arcs are then calculated and drawn, similar to the Fib. calculation. The Fib. Arcs are then calculated and drawn, similar to the Fib. 
Retracements. The theory behind using Retracements. The theory behind using Fibonacci numbersFibonacci numbers for chart analysis  for chart analysis 
is that price movements have rhythms similar to natural processes. is that price movements have rhythms similar to natural processes.   
  
You may use Fibonacci Arcs forYou may use Fibonacci Arcs for

l finding consolidation aims in price movementsfinding consolidation aims in price movements  
l finding resistance and support levelsfinding resistance and support levels  

You can find the tool in the You can find the tool in the Chart Tools Chart Tools group in the group in the toolbartoolbar..

ENTERING FIBONACCI ARCSENTERING FIBONACCI ARCS  

1.1. Open a symbol chart.Open a symbol chart.  
2.2. Click on the Fib. Arcs tool in the toolbar.Click on the Fib. Arcs tool in the toolbar.  
3.3. Click into the chart, for example a high point.Click into the chart, for example a high point.  
4.4. Keep the mouse button pressed and move the pointer to the next low point. Release the mouse button.Keep the mouse button pressed and move the pointer to the next low point. Release the mouse button.  

Between the anchor points, the calculated arcs are drawn.Between the anchor points, the calculated arcs are drawn.  
  
For extrapolating values beyond the 100% level, you can set the corresponding arcs to visible (e.g. for 138.2 and 161.8%). To do so, For extrapolating values beyond the 100% level, you can set the corresponding arcs to visible (e.g. for 138.2 and 161.8%). To do so, 
select the check boxes in the property inspector in the toolbar.select the check boxes in the property inspector in the toolbar.

EDITING FIB. ARCS EDITING FIB. ARCS   

l To move the baseline, click the respective anchor point (the mouse pointer changes into an xTo move the baseline, click the respective anchor point (the mouse pointer changes into an x--y axis symbol) and move it. y axis symbol) and move it. 
The arcs will be adapted accordingly. Depending on the position of the middle to the outer anchor point, the arcs are drawn The arcs will be adapted accordingly. Depending on the position of the middle to the outer anchor point, the arcs are drawn 
upwards or downwards.upwards or downwards.  

l To move Fib. Arcs, drag them with the mouse (the mouse pointer turns into a hand symbol) and move them freely. Release To move Fib. Arcs, drag them with the mouse (the mouse pointer turns into a hand symbol) and move them freely. Release 
the mouse button when done.the mouse button when done.  

l You can edit the ratio of each Fib. line in the arcs. To do so, click on the numbers next to the check boxes (in the properties) You can edit the ratio of each Fib. line in the arcs. To do so, click on the numbers next to the check boxes (in the properties) 
and enter new values.and enter new values.  

l You can duplicate the Fib. Arcs by doubleYou can duplicate the Fib. Arcs by double--clicking on them.clicking on them.  

l When the Fib. Arcs are selected, you can edit the properties in the toolbox.When the Fib. Arcs are selected, you can edit the properties in the toolbox.  

l To delete the Fib. Arcs, rightTo delete the Fib. Arcs, right--click on them and select click on them and select DeleteDeleteDeleteDelete from the context menu. Alternatively, select the Fib. Arcs and  from the context menu. Alternatively, select the Fib. Arcs and 
press the press the DELDELDELDEL key. key.  

Fibonacci ArcsFibonacci Arcs
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PROPERTIESPROPERTIES  

FIB. ARCS PROPERTIESFIB. ARCS PROPERTIES  

% 1, % 2...% 1, % 2...% 1, % 2...% 1, % 2...  -- Select from the list of available Fib. levels the ones you want to display. You can edit the values by clicking on the  Select from the list of available Fib. levels the ones you want to display. You can edit the values by clicking on the 
numbers to the right of the check boxes and entering new ones. numbers to the right of the check boxes and entering new ones. 

GRAPHIC PROPERTIESGRAPHIC PROPERTIES  

The following properties can be set for the Fib. Arcs tool:The following properties can be set for the Fib. Arcs tool:  
  
ColorColorColorColor  -- Here you can select a line color.  Here you can select a line color.   
  
WidthWidthWidthWidth  -- Here you can set a width for all lines by entering a number. Here you can set a width for all lines by entering a number.  
  
StyleStyleStyleStyle  -- Here you can select a line style, e.g. solid or dotted. Here you can select a line style, e.g. solid or dotted.    
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FIBONACCI FANS 
Fib. Fans are a drawing tool with a calculation function. You as the user Fib. Fans are a drawing tool with a calculation function. You as the user 
define the start and end point of the price levels that are to be used for the define the start and end point of the price levels that are to be used for the 
calculation. The Fib. Fans are then calculated and drawn, similar to the Fib. calculation. The Fib. Fans are then calculated and drawn, similar to the Fib. 
Retracements. The theory behind using Retracements. The theory behind using Fibonacci numbersFibonacci numbers for chart analysis  for chart analysis 
is that price movements have rhythms similar to natural processes. is that price movements have rhythms similar to natural processes.   
  
You may use Fib. Fans forYou may use Fib. Fans for

l finding support lines in upwards movementsfinding support lines in upwards movements  
l finding resistance levels in downwards movementsfinding resistance levels in downwards movements  

You can find the tool in the You can find the tool in the Chart Tools Chart Tools group in the group in the toolbartoolbar..

ENTERING FIBONACCI FANSENTERING FIBONACCI FANS  

1.1. Open a symbol chart.Open a symbol chart.  
2.2. Click on the Fib. Fans tool in the toolbar.Click on the Fib. Fans tool in the toolbar.  
3.3. Click into the chart to set an extreme point, for example at a high.Click into the chart to set an extreme point, for example at a high.  
4.4. Keep the mouse button pressed and move the pointer to the next diametrical extreme, for example a low point. Release the Keep the mouse button pressed and move the pointer to the next diametrical extreme, for example a low point. Release the 

mouse button.mouse button.  

Between the anchor points, the calculated fans are drawn. They can be seen as resistance and support levels.Between the anchor points, the calculated fans are drawn. They can be seen as resistance and support levels.  
  
For extrapolating values beyond the 100% level, you can set the corresponding fans to visible (e.g. for 138.2% and 161.8%). To do For extrapolating values beyond the 100% level, you can set the corresponding fans to visible (e.g. for 138.2% and 161.8%). To do 
so, select the check boxes in the property inspector in the toolbar.so, select the check boxes in the property inspector in the toolbar.

EDITING FIB. FANS EDITING FIB. FANS   

l To move the baseline, click the respective anchor point (the mouse pointer changes into an xTo move the baseline, click the respective anchor point (the mouse pointer changes into an x--y axis symbol) and move it. y axis symbol) and move it. 
The fans will be adapted accordingly. Depending on the position of the middle to the outer anchor point, the fans are drawn The fans will be adapted accordingly. Depending on the position of the middle to the outer anchor point, the fans are drawn 
upwards or downwards.upwards or downwards.  

l To move Fib. Fans, drag them with the mouse (the mouse pointer turns into a hand symbol) and move them freely. Release To move Fib. Fans, drag them with the mouse (the mouse pointer turns into a hand symbol) and move them freely. Release 
the mouse button when done.the mouse button when done.  

l You can edit the ratio of each Fib. line in the fans. To do so, click on the numbers next to the check boxes (in the properties) You can edit the ratio of each Fib. line in the fans. To do so, click on the numbers next to the check boxes (in the properties) 
and enter new values.and enter new values.  

l You can duplicate the Fib. Fans by doubleYou can duplicate the Fib. Fans by double--clicking on them.clicking on them.  

l When the Fib. Fans are selected, you can edit the properties in the toolbox.When the Fib. Fans are selected, you can edit the properties in the toolbox.  

l To delete the Fib. Fans, rightTo delete the Fib. Fans, right--click on them and select click on them and select DeleteDeleteDeleteDelete from the context menu. Alternatively, select the Fib. Fans and  from the context menu. Alternatively, select the Fib. Fans and 
press the press the DELDELDELDEL key. key.  

Fibonacci FansFibonacci Fans
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PROPERTIESPROPERTIES  

FIB. FANS PROPERTIESFIB. FANS PROPERTIES  

% 1, % 2...% 1, % 2...% 1, % 2...% 1, % 2...  -- Select from the list of available Fib. levels the ones you want to display. You can edit the values by clicking on the  Select from the list of available Fib. levels the ones you want to display. You can edit the values by clicking on the 
numbers to the right of the check boxes and entering new ones. numbers to the right of the check boxes and entering new ones. 

GRAPHIC PROPERTIESGRAPHIC PROPERTIES  

The following properties can be set for the Fib. Fans tool:The following properties can be set for the Fib. Fans tool:  
  
ColorColorColorColor  -- Here you can select a line color.  Here you can select a line color.   
  
WidthWidthWidthWidth  -- Here you can set a width for all lines by entering a number. Here you can set a width for all lines by entering a number.  
  
StyleStyleStyleStyle  -- Here you can select a line style, e.g. solid or dotted. Here you can select a line style, e.g. solid or dotted.    
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CHART 
Charts are graphical displays of prices for stocks, commodities, indices or Charts are graphical displays of prices for stocks, commodities, indices or 
funds. They can be used for: funds. They can be used for: 

l Supporting trading decisions by following price development.Supporting trading decisions by following price development.  
l Making trading decisions solely on the basis of price development.Making trading decisions solely on the basis of price development.  
l Gathering information about possible future price developments.Gathering information about possible future price developments.  
l Preparing analysis for past price developments.Preparing analysis for past price developments.  
l Visually following symbol positions.Visually following symbol positions.  
l Systematically developing signals for portfolio trading.Systematically developing signals for portfolio trading.  
l Graphically displaying trading system results.Graphically displaying trading system results.  
l Graphically displaying mathematical and statistical calculations.Graphically displaying mathematical and statistical calculations.  
l Visualizing the performance development of a symbol.Visualizing the performance development of a symbol.  

With the help of simple methods it is possible to process price developments from the past to allow prognosis for the future. These With the help of simple methods it is possible to process price developments from the past to allow prognosis for the future. These 
methods are known by the term "chart analysis".methods are known by the term "chart analysis".  
  
Charts have the following design parameters:Charts have the following design parameters:

l The maximum number of tools per charts is 250 (e.g. text elements, chart tools.The maximum number of tools per charts is 250 (e.g. text elements, chart tools.  
l The maximum history length is 500000.The maximum history length is 500000.  
l The maximum number of instruments per chart is 12 (including the subcharts, e.g. 6 instruments with one indicator each).The maximum number of instruments per chart is 12 (including the subcharts, e.g. 6 instruments with one indicator each).  

For additional information, also see these related topics:For additional information, also see these related topics:

l In the chapters In the chapters Using IndicatorsUsing Indicators and  and Using StrategiesUsing Strategies, you can find information on how to add these to the chart for chart , you can find information on how to add these to the chart for chart 
analysis. It is also possible to analysis. It is also possible to change their outputchange their output using the available chart types. using the available chart types.  

l In the chapter In the chapter Chart ToolsChart Tools you find information on how to add and use these drawing tools for your chart analysis. you find information on how to add and use these drawing tools for your chart analysis.  
l In the chapter In the chapter Timespans and PeriodsTimespans and Periods you can find information on how to toggle quickly between different trading periods,  you can find information on how to toggle quickly between different trading periods, 

how to define your own periods and how to set the visible time span and which prehow to define your own periods and how to set the visible time span and which pre--defined time spans are available.defined time spans are available.  
l In the chapter In the chapter Chart PropertiesChart Properties you can find information about layout settings that define the appearance of the chart and the  you can find information about layout settings that define the appearance of the chart and the 

displayed symbols. You can also find out about displayed symbols. You can also find out about stylesstyles and  and templatestemplates that allow you saving your own configuration and  that allow you saving your own configuration and 
applying them to other charts.applying them to other charts.  

l In the chapter In the chapter PublishingPublishing you can find information on how to print your chart, save an image of it, or send it via E you can find information on how to print your chart, save an image of it, or send it via E--mail or mail or 
Tradesignal Online forum to other users.Tradesignal Online forum to other users.  

AVAILABLE CHART TYPESAVAILABLE CHART TYPES  

A ChartA Chart

SymbolSymbolSymbolSymbol NameNameNameName DescriptionDescriptionDescriptionDescription

Bar ChartBar Chart Plots price movement; vertical bars indicate range; markers on the bar show open and close pricesPlots price movement; vertical bars indicate range; markers on the bar show open and close prices

Candlestick ChartCandlestick Chart Price chart that shows the open, high, low, and close prices over a given time periodPrice chart that shows the open, high, low, and close prices over a given time period
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Line ChartLine Chart Plots a line connecting consecutive pricesPlots a line connecting consecutive prices

Stepped Line ChartStepped Line Chart Similar to a line chart where price levels are connected to form a sequence of discrete stepsSimilar to a line chart where price levels are connected to form a sequence of discrete steps

Symbol ChartSymbol Chart Plots symbols at each pricePlots symbols at each price

Filled Area ChartFilled Area Chart Plots a filled region between two pricesPlots a filled region between two prices

Forest ChartForest Chart Plots a histogram between prices by timePlots a histogram between prices by time

Linked Forest ChartLinked Forest Chart A forest chart with a line joining the columnsA forest chart with a line joining the columns

Candle Volume ChartCandle Volume Chart A candlestick chart with the width of each candle representing the volumeA candlestick chart with the width of each candle representing the volume

Equi Volume ChartEqui Volume Chart Plots vertical bars showing price movement with the widths representing the volumePlots vertical bars showing price movement with the widths representing the volume

Kagi ChartKagi Chart Plots lines with different line width, independent of the time linePlots lines with different line width, independent of the time line

Renko ChartRenko Chart
Plots a sequence of ascending and descending bricks to indicate price movement, independent of Plots a sequence of ascending and descending bricks to indicate price movement, independent of 
the time linethe time line

Three Line Break Three Line Break 
ChartChart

Plots a sequence of bricks depending on close prices, independent of the time linePlots a sequence of bricks depending on close prices, independent of the time line

Heikin Ashi ChartHeikin Ashi Chart Similar to candlesticks, but uses averaged pricesSimilar to candlesticks, but uses averaged prices

Point&Figure ChartPoint&Figure Chart Plots price increases and decreases as a series of stacked Xs and Os, independent of the time linePlots price increases and decreases as a series of stacked Xs and Os, independent of the time line
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WAYS OF CALLING UP A CHARTWAYS OF CALLING UP A CHART  

There are three main routes for calling up a chart for a commercial paper:There are three main routes for calling up a chart for a commercial paper:

l If you kIf you know the ticker symbol, enter it in the command line. (Tip: You can find ticker symbols in the now the ticker symbol, enter it in the command line. (Tip: You can find ticker symbols in the Symbol SearchSymbol Search.).)  
l If you don't know the ticker symbol of the commercial paper, you can find it in the If you don't know the ticker symbol of the commercial paper, you can find it in the symbol listssymbol lists..  
l If you receive an EIf you receive an E--Mail with charts, you can save them and call up the charts.Mail with charts, you can save them and call up the charts.  

You can also open symbols in You can also open symbols in subchartssubcharts..

CALLING UP A CHART VIA THE COMMAND LINECALLING UP A CHART VIA THE COMMAND LINE  

1.1. Type the ticker symbol (e.g. CAT) in the command line.Type the ticker symbol (e.g. CAT) in the command line.  
2.2. Press ENTER. Alternatively, you can choose the entry Press ENTER. Alternatively, you can choose the entry New ChartNew ChartNew ChartNew Chart from the pull from the pull--down menudown menu..   

CALLING UP A CHART FROM A SYMBOL LISTCALLING UP A CHART FROM A SYMBOL LIST  

For this you need to have a For this you need to have a symbol listsymbol list, e.g. one for the USA Dow Jones., e.g. one for the USA Dow Jones.

1.1. Click on the yellow star symbol in the lower area of the tool bar. The symbol list manager opens.Click on the yellow star symbol in the lower area of the tool bar. The symbol list manager opens.  
2.2. DoubleDouble--click on the symbol list to open it. There are two ways to open a chart for a list entry:click on the symbol list to open it. There are two ways to open a chart for a list entry:

1.1. If the working area doesn't display a chart, or if you want to substitute the symbols in an existing chart, doubleIf the working area doesn't display a chart, or if you want to substitute the symbols in an existing chart, double--click click 
on the list entry.on the list entry.  

2.2. If you want to open a new chart, rightIf you want to open a new chart, right--click on the list entry and choose click on the list entry and choose New ChartNew ChartNew ChartNew Chart from the context menu. from the context menu.  

Now you can use the two green arrow buttons right next to the command line to move through the list and get each entry displayed Now you can use the two green arrow buttons right next to the command line to move through the list and get each entry displayed 
in the chart.in the chart.    
  
Tip: You can also open the symbol list as a table in the Tip: You can also open the symbol list as a table in the ScannerScanner, the , the WatchlistWatchlist and as  and as PortfolioPortfolio and call up a new chart by right and call up a new chart by right--
clicking on a table entry and choosing clicking on a table entry and choosing New ChartNew ChartNew ChartNew Chart from the context menu. from the context menu.

CALLING UP A CHART FROM AN ECALLING UP A CHART FROM AN E--MAILMAIL  

Tradesignal offers you the option to send charts or whole workspaces by ETradesignal offers you the option to send charts or whole workspaces by E--Mail. In a similar way, you can import these sent Mail. In a similar way, you can import these sent 
objects into the program. objects into the program. 

1.1. If you receive an EIf you receive an E--mail with a workspace, save it locally. We recommend that you choose the folder mail with a workspace, save it locally. We recommend that you choose the folder Tradesignal FilesTradesignal Files  
which is located in which is located in Personal FolderPersonal Folder..  

2.2. Update the list of workspaces by rightUpdate the list of workspaces by right--clicking in the toolbar on the folder clicking in the toolbar on the folder Tradesignal FilesTradesignal Files and choosing  and choosing UpdateUpdateUpdateUpdate. The . The 
saved workspace appears in the list of workspaces and can be opened from there.saved workspace appears in the list of workspaces and can be opened from there.  

Market ProfileMarket Profile Inserts a market profile chart (various price and turnover data) in the workspaceInserts a market profile chart (various price and turnover data) in the workspace
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COPY, PASTE AND DELETE CHARTSCOPY, PASTE AND DELETE CHARTS  

You can edit charts with the functions in the You can edit charts with the functions in the EditEdit group in the toolbar: group in the toolbar:  

l CopyCopyCopyCopy  -- Copy the current chart configuration into your Windows clipboard. Copy the current chart configuration into your Windows clipboard.  

l PastePastePastePaste  -- Paste the copied chart configuration into a currently opened chart, a new workspace, an office document or an  Paste the copied chart configuration into a currently opened chart, a new workspace, an office document or an 
image processing application.image processing application.  

l DeleteDeleteDeleteDelete  -- Delete the currently active chart. Delete the currently active chart.  

NAVIGATION IN THE CHARTNAVIGATION IN THE CHART  

To activate a chart, click on its tab. In the active chart, the small plug symbol on the lower right of the chart or a portfolio is visible, To activate a chart, click on its tab. In the active chart, the small plug symbol on the lower right of the chart or a portfolio is visible, 
see the chapter see the chapter Automatic Order RoutingAutomatic Order Routing..  
  
The axes and visible areas can be set up relatively flexible. To return to the default settings, you can either press the key The axes and visible areas can be set up relatively flexible. To return to the default settings, you can either press the key F8F8F8F8 or click  or click 
on the axes symbol on the lower right of the chart. More information you can find in the chapter on the axes symbol on the lower right of the chart. More information you can find in the chapter Timespans and PeriodsTimespans and Periods..

MOVE (SCROLL) AXESMOVE (SCROLL) AXES  

You can move (scroll) the xYou can move (scroll) the x-- and y and y--axes (usually time and price axes) by clicking on them with the mouse and keeping the mouse axes (usually time and price axes) by clicking on them with the mouse and keeping the mouse 
button pressed while moving it up/down or left/right. button pressed while moving it up/down or left/right.   
  
Alternatively, you can scroll the axes by pressing the cursor keys (up/down, left/right). To speed up the scrolling, press the Alternatively, you can scroll the axes by pressing the cursor keys (up/down, left/right). To speed up the scrolling, press the STRGSTRGSTRGSTRG  
key in addition to the cursor keys.key in addition to the cursor keys.

STRETCH/SHRINK AXESSTRETCH/SHRINK AXES  

You can change the scale of the axes, so that more or less of the range is You can change the scale of the axes, so that more or less of the range is 
shown. To do this, click on it with the right mouse button and keep it shown. To do this, click on it with the right mouse button and keep it 
pressed while moving the mouse left/right or up/down. pressed while moving the mouse left/right or up/down.   
  
Alternatively, keep the SHIFT key pressed while pressing the cursor keys Alternatively, keep the SHIFT key pressed while pressing the cursor keys 
(up/down, left/right).(up/down, left/right).

USE THE XUSE THE X--AXIS SCROLLBARAXIS SCROLLBAR  

You can also scroll the xYou can also scroll the x--axis by using the scrollbar, which is situated on axis by using the scrollbar, which is situated on 
the lower right corner, to the left of the axes symbol. Click on it and keep the mouse button pressed to drag the scrollbar to the left the lower right corner, to the left of the axes symbol. Click on it and keep the mouse button pressed to drag the scrollbar to the left 
or right. The scroll speed depends on how much the time axis is currently stretched or shrunk.or right. The scroll speed depends on how much the time axis is currently stretched or shrunk.

PANORAMIC SCROLLBARPANORAMIC SCROLLBAR  

Chart with shortened axesChart with shortened axes
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In Tradesignal you can use the panoramic scrollbar to move (scroll) the xIn Tradesignal you can use the panoramic scrollbar to move (scroll) the x--
axis by dragging it or clicking on the axis itself. The background always axis by dragging it or clicking on the axis itself. The background always 
shows all available data as a shows all available data as a filled area chartfilled area chart to give you additional  to give you additional 
information about your current viewport. It is possible to stretch/shrink information about your current viewport. It is possible to stretch/shrink 
(zoom) the axis by dragging the grippers of the new panoramic scrollbar. (zoom) the axis by dragging the grippers of the new panoramic scrollbar. 
New buttons replacing the axes button makes it easy to toggle between New buttons replacing the axes button makes it easy to toggle between 
normal and panoramic scrollbar or show recent/all data. In the normal and panoramic scrollbar or show recent/all data. In the chart chart 
propertiesproperties you can change the height of the panoramic scrollbar or switch  you can change the height of the panoramic scrollbar or switch 
to the normal one.to the normal one.

CHANGE SCALE ALIGNCHANGE SCALE ALIGN  

You can change the scale align for the yYou can change the scale align for the y--axis via the properties inspector (left, right, left/right), or via the chart legend (left and axis via the properties inspector (left, right, left/right), or via the chart legend (left and 
right). right).   
  
For the latter, click on the chart legend and and keep the mouse button pressed while dragging it to the left or right side of the For the latter, click on the chart legend and and keep the mouse button pressed while dragging it to the left or right side of the 
chart, until a little arrow symbol appears. Then release the mouse button. This way, you can drag and drop the scale to the left or chart, until a little arrow symbol appears. Then release the mouse button. This way, you can drag and drop the scale to the left or 
right side of the chart.right side of the chart.

USE THE ZOOM FUNCTIONUSE THE ZOOM FUNCTION  

If you want to take a closer look at certain chart regions, price patterns or If you want to take a closer look at certain chart regions, price patterns or 
signals of trading systems, the Zoom function is the right tool.signals of trading systems, the Zoom function is the right tool.  

1.1. Activate the Zoom tool by clicking on the small icon with a Activate the Zoom tool by clicking on the small icon with a 
magnifying glass and a plus symbol in the magnifying glass and a plus symbol in the ChartChart area of the toolbar. area of the toolbar.  

2.2. Click on the first corner of the area you want to enlarge.Click on the first corner of the area you want to enlarge.  
3.3. Draw the rectangle around the area.Draw the rectangle around the area.  
4.4. Release the mouse button. The area is zoomed.Release the mouse button. The area is zoomed.  

To reset the Zoom and return to the previous view, click into an empty area To reset the Zoom and return to the previous view, click into an empty area 
of the chart with the activated Zoom tool. of the chart with the activated Zoom tool.   
  
To deactivate the Zoom tool, click on another tool like the select tool or target cursor. Alternatively, rightTo deactivate the Zoom tool, click on another tool like the select tool or target cursor. Alternatively, right--click into the chart and click into the chart and 
then click with the left mouse button into the empty area next to the context menu. This way, you return to the select mode. then click with the left mouse button into the empty area next to the context menu. This way, you return to the select mode. 
Although the second variant may sound complicated, it's a lot faster than the first one.Although the second variant may sound complicated, it's a lot faster than the first one.

USE THE TARGET CURSORUSE THE TARGET CURSOR  

Chart with panoramic scrollbarChart with panoramic scrollbar

Chart with zoomed areaChart with zoomed area
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To retrieve detailed information about the region below the mouse cursor, To retrieve detailed information about the region below the mouse cursor, 
you can use the Target Cursor. you can use the Target Cursor.   
  
Activate the Target Cursor by clicking on the small crossActivate the Target Cursor by clicking on the small cross--hairs icon in the hairs icon in the 
ChartChart area of the toolbar. When you click into the chart now, information  area of the toolbar. When you click into the chart now, information 
about that position, the trading period, prices, indicators, etc. is displayed about that position, the trading period, prices, indicators, etc. is displayed 
in a popin a pop--up window. This window remains visible as long as the Target up window. This window remains visible as long as the Target 
Cursor is active. Cursor is active.   
  
To return to the select mode, click on the select mode button in the toolbar. To return to the select mode, click on the select mode button in the toolbar. 
Alternatively, rightAlternatively, right--click into the chart and then click with the left mouse button into the empty area next to the context menu. This click into the chart and then click with the left mouse button into the empty area next to the context menu. This 
way, you return to the select mode. Although the second variant may sound complicated, it is a lot faster than the first one.way, you return to the select mode. Although the second variant may sound complicated, it is a lot faster than the first one.  
  
You can change the appearance of the Target Cursor in the chart properties, You can change the appearance of the Target Cursor in the chart properties, Target Cursor StyleTarget Cursor StyleTarget Cursor StyleTarget Cursor Style. Select . Select Thin LineThin LineThin LineThin Line or  or Whole Whole Whole Whole 
ColumnColumnColumnColumn..  
  
To have a temporary "target cursor" with an information popTo have a temporary "target cursor" with an information pop--up, click and keep pressed the left mouse button in the select mode. up, click and keep pressed the left mouse button in the select mode. 
The mouse pointer changes into a target cursor and a popThe mouse pointer changes into a target cursor and a pop--up window with information appears. The window disappears when you up window with information appears. The window disappears when you 
release the mouse button.release the mouse button.  

CONTEXT MENUS IN THE CHARTCONTEXT MENUS IN THE CHART  

If you rightIf you right--click on an element in the chart, a context menu opens, offering you various functions for this element. The most click on an element in the chart, a context menu opens, offering you various functions for this element. The most 
important functions are: important functions are: 

l Delete the selected elementDelete the selected element  
l Show properties of the selected elementShow properties of the selected element  
l For the symbol: starting the price editor and trading time manager, changing the period, saving chart as template, report bad For the symbol: starting the price editor and trading time manager, changing the period, saving chart as template, report bad 

ticks, ticks, trade symboltrade symbol (automatically opens the order bar). (automatically opens the order bar).  
l For the indicators / trading systems: starting the program editor, request online information.For the indicators / trading systems: starting the program editor, request online information.  

SUBCHARTSSUBCHARTS  

Subcharts are a special form of chart. They can be recognized by not having their own tab. Subcharts can have the same date axis Subcharts are a special form of chart. They can be recognized by not having their own tab. Subcharts can have the same date axis 
or a different one than the main chart. As subcharts, the following documents can be displayed: symbols, indicators, strategies, or a different one than the main chart. As subcharts, the following documents can be displayed: symbols, indicators, strategies, 
equity curves (e.g. of the portfolio).equity curves (e.g. of the portfolio).

OPENING A SUBCHARTOPENING A SUBCHART  

To open an instrument as a subchart, proceed as follows:To open an instrument as a subchart, proceed as follows:

1.1. Click on the symbol button in the toolbox to open the symbol lists manager.Click on the symbol button in the toolbox to open the symbol lists manager.  
2.2. DoubleDouble--click on the symbol list to open it.click on the symbol list to open it.  

Using the Target CursorUsing the Target Cursor
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3.3. RightRight--click on a symbol in the list to open the context menu. You have two options:click on a symbol in the list to open the context menu. You have two options:  

l

l If you want to open the subchart with the same time axis as the main chart, select If you want to open the subchart with the same time axis as the main chart, select Insert SymbolInsert SymbolInsert SymbolInsert Symbol from the context  from the context 
menu.menu.  

l If you want to open the subchart with its own time axis, select If you want to open the subchart with its own time axis, select Insert Symbol with new Date ScaleInsert Symbol with new Date ScaleInsert Symbol with new Date ScaleInsert Symbol with new Date Scale from the context  from the context 
menu. (The ymenu. (The y--axes are always independent of each other.)axes are always independent of each other.)  

The subchart opens below the main chart in the same tab.The subchart opens below the main chart in the same tab.    
  
Note that this action also depends on the option Note that this action also depends on the option Open symbols in their own subchartOpen symbols in their own subchartOpen symbols in their own subchartOpen symbols in their own subchart. This defines how the program reacts to . This defines how the program reacts to 
Insert SymbolInsert SymbolInsert SymbolInsert Symbol. If the option is selected, symbols are opened in a subchart. Otherwise, the symbol gets added to the existing chart.. If the option is selected, symbols are opened in a subchart. Otherwise, the symbol gets added to the existing chart.

CLOSING A SUBCHARTCLOSING A SUBCHART  

To close a single subchart, click on the To close a single subchart, click on the xxxx button in the upper right corner of the subchart. Alternatively, right button in the upper right corner of the subchart. Alternatively, right--click into the subchart click into the subchart 
and select and select Delete subchartDelete subchartDelete subchartDelete subchart from the context menu.  from the context menu.   
  
When you close a chart, all its subcharts are closed automatically. When you close a chart, all its subcharts are closed automatically. 

NAVIGATION IN SUBCHARTSNAVIGATION IN SUBCHARTS  

l To maximize a subchart, click on the button with the window symbol in the upper right corner of the subchart. Two little To maximize a subchart, click on the button with the window symbol in the upper right corner of the subchart. Two little 
arrow buttons appear (right/left). Click on them to move between subcharts.arrow buttons appear (right/left). Click on them to move between subcharts.  

l To display all subcharts again, click on the button with the staggered windows.To display all subcharts again, click on the button with the staggered windows.  

To activate a subchart, click on the subchart legend. In the active subchart, the small plug symbol is visible on the lower right, just To activate a subchart, click on the subchart legend. In the active subchart, the small plug symbol is visible on the lower right, just 
like for the chart. (See the chapter like for the chart. (See the chapter Automatic Order RoutingAutomatic Order Routing).).

EDITING SUBCHART PROPERTIESEDITING SUBCHART PROPERTIES  

When you change the trading period for a chart via the When you change the trading period for a chart via the PeriodPeriodPeriodPeriod button of the command line (see the chapter  button of the command line (see the chapter Timespans and Timespans and 
PeriodsPeriods), the period for all subcharts is changed accordingly. ), the period for all subcharts is changed accordingly.   
  
To change the period for a single subchart, rightTo change the period for a single subchart, right--click into the subchart and select another click into the subchart and select another Period for ObjectPeriod for ObjectPeriod for ObjectPeriod for Object in the context menu. in the context menu.

MOVING INSTRUMENTS BETWEEN (SUBMOVING INSTRUMENTS BETWEEN (SUB--)CHARTS)CHARTS  

If an instrument is opened in a chart and you would like to move it into a subchart, you can drag and drop the instrument.If an instrument is opened in a chart and you would like to move it into a subchart, you can drag and drop the instrument.  

1.1. Click on the instrument in the legend and drag the instrument down. A little downClick on the instrument in the legend and drag the instrument down. A little down--pointing arrow is added to the mouse pointing arrow is added to the mouse 
cursor.cursor.  

2.2. Drop the legend into another subchart or pull it down until the edge of the window, so that a new subchart is opened.Drop the legend into another subchart or pull it down until the edge of the window, so that a new subchart is opened.  

In the same way, you can move instruments from one subchart into another or into the main chart. This way, you can display two In the same way, you can move instruments from one subchart into another or into the main chart. This way, you can display two 
symbols together in one chart even though the option symbols together in one chart even though the option Open Symbols in their own SubchartOpen Symbols in their own SubchartOpen Symbols in their own SubchartOpen Symbols in their own Subchart in the  in the Tradesignal OptionsTradesignal Options is active. is active.



:: www.tradesignal.comwww.tradesignal.com

Tradesignal GmbHTradesignal GmbH Page 165Page 165 Version 7.0Version 7.0

INDICATORS AND STRATEGIES IN SUBCHARTSINDICATORS AND STRATEGIES IN SUBCHARTS  

Whether an indicator is opened in a subchart depends on their Equilla programming. You can move indicators by dragging them Whether an indicator is opened in a subchart depends on their Equilla programming. You can move indicators by dragging them 
into other (subinto other (sub--)charts, as described above. To which instrument an indicator is applied to is given in the indicator legend and is )charts, as described above. To which instrument an indicator is applied to is given in the indicator legend and is 
independent from the arrangement on the user interface. (See also the chapter independent from the arrangement on the user interface. (See also the chapter Using IndicatorsUsing Indicators.) .)   
  
For strategies, the same rules apply in principle. However, usually their graphic output are only a few arrows at the instrument For strategies, the same rules apply in principle. However, usually their graphic output are only a few arrows at the instrument 
curve. As this doesn't make not much sense in a subchart, most strategies are opened in the same (subcurve. As this doesn't make not much sense in a subchart, most strategies are opened in the same (sub--)chart as the instrument )chart as the instrument 
they are applied to.they are applied to.

SET NEW DEFAULT CHART STYLESET NEW DEFAULT CHART STYLE  

When Tradesignal is first installed, the default chart style is the candlestick When Tradesignal is first installed, the default chart style is the candlestick 
chart. However, you can also set the bar and line chart as default. Proceed chart. However, you can also set the bar and line chart as default. Proceed 
as follows:as follows:

1.1. Open the File menu.Open the File menu.  
2.2. Select the Select the Tradesignal OptionsTradesignal OptionsTradesignal OptionsTradesignal Options..  
3.3. Open the Open the ChartChartChartChart settings. settings.  
4.4. In the In the Default Chart StyleDefault Chart Style area, select whether you want the  area, select whether you want the 

candlestick, line, or bar chart as standard. Confirm the new settings candlestick, line, or bar chart as standard. Confirm the new settings 
by clicking by clicking OKOKOKOK..  

As of now, all new charts are displayed according to the new default As of now, all new charts are displayed according to the new default 
setting.setting.

COMPARING SYMBOLSCOMPARING SYMBOLS  

If you want to compare several symbols in the chart, it may be essential to normalize their measuring unit to get meaningful If you want to compare several symbols in the chart, it may be essential to normalize their measuring unit to get meaningful 
results. Tradesignal offers you different possibilities to achieve this goal. The following examples use Tradesignal Realtime as data results. Tradesignal offers you different possibilities to achieve this goal. The following examples use Tradesignal Realtime as data 
provider:provider:

CURRENCY CONVERSIONCURRENCY CONVERSION  

If you are trading the same symbol on different exchanges you may encounter the problem that they are displayed in different If you are trading the same symbol on different exchanges you may encounter the problem that they are displayed in different 
currencies. The following example shows you how to unify the currency in the chart:currencies. The following example shows you how to unify the currency in the chart:

1.1. Open a chart with Microsoft, Open a chart with Microsoft, MSFT NASMSFT NASMSFT NASMSFT NAS, a symbol traded on the American market in , a symbol traded on the American market in US DollarsUS Dollars..  
2.2. Add another Microsoft symbol traded on a different exchange, e.g. Add another Microsoft symbol traded on a different exchange, e.g. MSF GERMSF GERMSF GERMSF GER, which is traded in Germany in , which is traded in Germany in EuroEuro..  
3.3. Select the symbol traded in Germany in the chart and change the currency to Select the symbol traded in Germany in the chart and change the currency to US DollarsUS DollarsUS DollarsUS Dollars in the instrument properties. in the instrument properties.  
4.4. Select the first Microsoft symbol and add the Select the first Microsoft symbol and add the Spread DiffSpread DiffSpread DiffSpread Diff indicator from the Tradesignal package. In the dialog, choose the  indicator from the Tradesignal package. In the dialog, choose the 

symbol traded in Germany as second input.symbol traded in Germany as second input.  

Please note that the currency conversion is not available for all symbols, such as indices which are displayed in index points. The Please note that the currency conversion is not available for all symbols, such as indices which are displayed in index points. The 

Chart settings in the Tradesignal OptionsChart settings in the Tradesignal Options
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list of available currencies depends on the selected data provider.list of available currencies depends on the selected data provider.

UNIT CONVERSIONUNIT CONVERSION  

Unit conversion can be interesting for comparing symbols that are traded in different measurement units, e.g. barrel, bushel, tons, Unit conversion can be interesting for comparing symbols that are traded in different measurement units, e.g. barrel, bushel, tons, 
etc. This information and the list of available units and used abbreviations depends on the data provider .etc. This information and the list of available units and used abbreviations depends on the data provider .  
  
Example for soy beans and soy oil:Example for soy beans and soy oil:

1.1. Create aCreate a  Continuous ContractContinuous Contract for soy beans and choose  for soy beans and choose SSSS as Future Root Code. The future is traded in US Cent per  as Future Root Code. The future is traded in US Cent per Bushel Bushel Bushel Bushel 
(Bsh)(Bsh)(Bsh)(Bsh)..  

2.2. Create another Continuous Contract for soy oil and choose Create another Continuous Contract for soy oil and choose BOBOBOBO as Future Root Code. This one is traded in US Cent per  as Future Root Code. This one is traded in US Cent per PoundPoundPoundPound
(Lbs)(Lbs)(Lbs)(Lbs)..  

3.3. Add both UDCs to a chart and select the soy oil symbol.Add both UDCs to a chart and select the soy oil symbol.  
4.4. Change the unit in the instrument properties from Change the unit in the instrument properties from LbsLbsLbsLbs to  to BshBshBshBsh..  
5.5. Add one of the Add one of the SpreadSpreadSpreadSpread indicators from the Tradesignal package to display the difference. indicators from the Tradesignal package to display the difference.  

DISPLAY UNITDISPLAY UNIT  

Symbols can have different display units which refer to the displayed numbers of decimal places. For example, the Dow Jones Symbols can have different display units which refer to the displayed numbers of decimal places. For example, the Dow Jones 
index has two decimal places while the Euro has four decimal places. This is how you normalize the display of symbols in the index has two decimal places while the Euro has four decimal places. This is how you normalize the display of symbols in the 
chart:chart:

1.1. Create a chart with the Dow Jones, Create a chart with the Dow Jones, .DJI.DJI.DJI.DJI..  
2.2. Add the Euro (Add the Euro (EURUSDEURUSDEURUSDEURUSD) symbol to the chart) symbol to the chart and select it. and select it.  
3.3. Open the properties and change the instrument property Open the properties and change the instrument property Display UnitDisplay UnitDisplay UnitDisplay Unit to  to 0.010.010.010.01 to display the Euro with two decimal places. to display the Euro with two decimal places.  

The default value is provided by the data provider. It can be changed in the session properties for each symbol by opening the The default value is provided by the data provider. It can be changed in the session properties for each symbol by opening the 
Session Manager via the context menu or the toolbar.Session Manager via the context menu or the toolbar.  
  
Tip:Tip:Tip:Tip: You can change the display unit also for indicator and strategy outputs. Select the element in the chart and change the value  You can change the display unit also for indicator and strategy outputs. Select the element in the chart and change the value 
in the properties. The default value of the output is based on the underlying symbol display unit.in the properties. The default value of the output is based on the underlying symbol display unit.  
  
The display unit is also available in the The display unit is also available in the ScannerScanner, , WatchlistWatchlist and  and PortfolioPortfolio and can be used to align the decimal point for all symbols  and can be used to align the decimal point for all symbols 
below each other in the chart.below each other in the chart.

SEASONAL CHARTSSEASONAL CHARTS  

With the With the seasonal modeseasonal mode in the chart properties, Tradesignal offers you the ability to overlay the prices of different years for one or  in the chart properties, Tradesignal offers you the ability to overlay the prices of different years for one or 
more symbols. Comparing the symbols this way emphasizes seasonal pattern, e.g. if used with commodities that have seasonal more symbols. Comparing the symbols this way emphasizes seasonal pattern, e.g. if used with commodities that have seasonal 
variations. See the article variations. See the article Seasonal ChartSeasonal Chart for more details for more details

PERCENT PERFORMANCE CHARTSPERCENT PERFORMANCE CHARTS  

You can display the price movements of a symbol as percentage increase/decrease relative to a start price by using You can display the price movements of a symbol as percentage increase/decrease relative to a start price by using percent percent 
performance transformationperformance transformation. This makes it easier to compare the performance of symbols since their absolute price values are . This makes it easier to compare the performance of symbols since their absolute price values are 
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converted to relative price movements. See the article converted to relative price movements. See the article Percent PerformancePercent Performance for more details. for more details.

SEMISEMI--LOGARITHMIC DISPLAYLOGARITHMIC DISPLAY  

The value axis can be displayed using a logarithmic scale. This is mainly The value axis can be displayed using a logarithmic scale. This is mainly 
used for symbols with a long history, to emphasis fluctuations in prices. used for symbols with a long history, to emphasis fluctuations in prices. 
The changes are not displayed linearly but perceptually, therefore the The changes are not displayed linearly but perceptually, therefore the 
increase from 1 to 10 is identical to the increase from 10 to 100.increase from 1 to 10 is identical to the increase from 10 to 100.  
  
Example for changing the Dow Jones display from linear to logarithmic:Example for changing the Dow Jones display from linear to logarithmic:

1.1. Open a chart with the Dow Jones, Open a chart with the Dow Jones, '.DJI'.DJI.'.'  
2.2. Open the context menu for the symbol (see picture) and choose Open the context menu for the symbol (see picture) and choose 

LogarithmicLogarithmicLogarithmicLogarithmic. To return to the linear display, repeat this action but . To return to the linear display, repeat this action but 
select select LinearLinearLinearLinear instead. instead.  

You also have the option of inverting the value scale by selecting You also have the option of inverting the value scale by selecting InvertedInvertedInvertedInverted, , 
this will cause the lowest values to be displayed at the top.this will cause the lowest values to be displayed at the top.  
  
Please note that the left value axis can be separately changed in display if Please note that the left value axis can be separately changed in display if 
you have a second symbol in the chart.you have a second symbol in the chart.    

Context menu of value scaleContext menu of value scale
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CHART PROPERTIES 
Just as every chart analysis is governed by the individual preferences of Just as every chart analysis is governed by the individual preferences of 
each trader, the chart properties like colors, fonts and other optical settings each trader, the chart properties like colors, fonts and other optical settings 
can be adjusted to personal likings. You can use the chart properties and can be adjusted to personal likings. You can use the chart properties and 
the the stylesstyles and  and templatestemplates functions to do the following: functions to do the following:

l Adapt the charts to personal color and font preferencesAdapt the charts to personal color and font preferences  
l Optimize charts for usage in print or web mediaOptimize charts for usage in print or web media  
l ReRe--use the settings for other chartsuse the settings for other charts  
l Enhance the recognition factor of your work in publicationsEnhance the recognition factor of your work in publications  
l Define and use templates for the chart configurationDefine and use templates for the chart configuration  
l Define and use Style properties for Define and use Style properties for ChartsCharts and other documents like  and other documents like 

ScannersScanners, , WatchlistsWatchlists or  or PortfoliosPortfolios..  

SETTING THE CHART PROPERTIESSETTING THE CHART PROPERTIES  

As "Chart Properties", the following options should be included here:As "Chart Properties", the following options should be included here:

l You can edit the chart properties. To do this, open the toolbox and click on You can edit the chart properties. To do this, open the toolbox and click on ChartChartChartChart in the upper region of the property  in the upper region of the property 
inspector to see the parameters for axes, grid, legend etc. In case of strategies, more settings are available.inspector to see the parameters for axes, grid, legend etc. In case of strategies, more settings are available.  

l Some settings of the symbols are also reflected in the chart. To access these settings, click on the symbol in the upper Some settings of the symbols are also reflected in the chart. To access these settings, click on the symbol in the upper 
region of the property inspector. The parameters for volume and history length are available.region of the property inspector. The parameters for volume and history length are available.  

l You can set up the optical chart properties by using styles (preYou can set up the optical chart properties by using styles (pre--set or your own). If you have saved templates, you can also set or your own). If you have saved templates, you can also 
apply those to new charts.apply those to new charts.  

DISPLAYING THE PROPERTIES OF SELECTED ITEMSDISPLAYING THE PROPERTIES OF SELECTED ITEMS  

When you select an item in Tradesignal, its properties are displayed in the toolbox. For example, when you click on a chart, the When you select an item in Tradesignal, its properties are displayed in the toolbox. For example, when you click on a chart, the 
chart properties are displayed; when you click on a symbol, the symbol properties are displayed. chart properties are displayed; when you click on a symbol, the symbol properties are displayed.   
  
This is the default setting. However, you can change this by changing the setting for This is the default setting. However, you can change this by changing the setting for Automatically show properties when an Automatically show properties when an Automatically show properties when an Automatically show properties when an 
item is selecteditem is selecteditem is selecteditem is selected in the  in the AdvancedAdvanced area of the  area of the Tradesignal OptionsTradesignal Options..

SAVING, RESTORING AND RESETTING DEFAULT SETTINGSSAVING, RESTORING AND RESETTING DEFAULT SETTINGS  

On top of the chart properties in the properties manager, to the right, you can find two important buttons. On top of the chart properties in the properties manager, to the right, you can find two important buttons. 

l Disk button (Save as Default) Disk button (Save as Default) -- Click to save your current settings as the new default settings. Click to save your current settings as the new default settings.  
l Restore button (Restore Default Settings, circled arrow) Restore button (Restore Default Settings, circled arrow) -- Click to reset all settings to the default settings. Click to reset all settings to the default settings.  

Not all settings can be saved like this:Not all settings can be saved like this:

A ChartA Chart
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l Some chart settings are done in the Some chart settings are done in the Tradesignal OptionsTradesignal Options, like the history length, the default chart type etc., like the history length, the default chart type etc.  
l The standard period and other user interface settings are entered in the The standard period and other user interface settings are entered in the Tradesignal OptionsTradesignal Options..  

Some settings also do not make much sense as a default, like the value for a stop line. Some settings also do not make much sense as a default, like the value for a stop line.   
  
To restore the original default settings of your Tradesignal installation, click on the To restore the original default settings of your Tradesignal installation, click on the Restore Default SettingsRestore Default SettingsRestore Default SettingsRestore Default Settings button in the  button in the 
Tradesignal OptionsTradesignal Options..

CHART PROPERTIES IN THE TOOLBOXCHART PROPERTIES IN THE TOOLBOX  

Beside the color selectors for the background, date and value axis, you can Beside the color selectors for the background, date and value axis, you can 
also find parameters for the grid and the chart legend. also find parameters for the grid and the chart legend. 

CHARTCHART  

FontFontFontFont  -- Here you can select a font type (Tahoma, Arial...), font style (bold,  Here you can select a font type (Tahoma, Arial...), font style (bold, 
italic...) and font size. Click on the entry to open the dialog in which you italic...) and font size. Click on the entry to open the dialog in which you 
can edit the values.can edit the values.  
  
AutoAutoAutoAuto----Hide ScalesHide ScalesHide ScalesHide Scales  -- If activated, the scales are hidden if the chart is  If activated, the scales are hidden if the chart is 
displayed in a very small size. displayed in a very small size.   
  
BackgroundBackgroundBackgroundBackground  -- Open a dialog in which you can set a background color. You  Open a dialog in which you can set a background color. You 
can choose between solid colors or gradients (vertical or horizontal). To can choose between solid colors or gradients (vertical or horizontal). To 
create a gradient, you need to select two colors. For each of them, a color palette is available.create a gradient, you need to select two colors. For each of them, a color palette is available.  
  
Show GapsShow GapsShow GapsShow Gaps  -- Select whether times without trading should be invisible or visible in the chart. Select whether times without trading should be invisible or visible in the chart.  
  
History LengthHistory LengthHistory LengthHistory Length  -- Enter the length of the price history here. The maximum length in Tradesignal is 500000 data points, which  Enter the length of the price history here. The maximum length in Tradesignal is 500000 data points, which 
effectively means the length is limited by your data provider. effectively means the length is limited by your data provider.   
  
Refresh on Historic UpdatesRefresh on Historic UpdatesRefresh on Historic UpdatesRefresh on Historic Updates  -- Set to  Set to YesYesYesYes if the indicators/strategies should be recalculated when changing the data history.  if the indicators/strategies should be recalculated when changing the data history.   
  
Min. Referenced BarsMin. Referenced BarsMin. Referenced BarsMin. Referenced Bars  -- Enter the minimum number of bars that should be used for calculating the values of indicators and  Enter the minimum number of bars that should be used for calculating the values of indicators and 
strategies.strategies.  
  
Target Cursor StyleTarget Cursor StyleTarget Cursor StyleTarget Cursor Style  -- Here you can edit the style of the target cursor,  Here you can edit the style of the target cursor, Thin LineThin LineThin LineThin Line or  or Whole ColumnWhole ColumnWhole ColumnWhole Column. .   
  
Replace SymbolsReplace SymbolsReplace SymbolsReplace Symbols  -- Control how a symbol replace operation is performed with regard to unit and currency conversion. Control how a symbol replace operation is performed with regard to unit and currency conversion.  
  
TemplateTemplateTemplateTemplate  -- Shows if this chart is currently linked to a template file. Shows if this chart is currently linked to a template file.

DATE AXISDATE AXIS  

Chart in the property inspectorChart in the property inspector
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For the date axis, you can set the background color and font properties. In addition, you can also set whether the scrollbar should be For the date axis, you can set the background color and font properties. In addition, you can also set whether the scrollbar should be 
active. In Tradesignal you can toggle between the active. In Tradesignal you can toggle between the panoramic scrollbarpanoramic scrollbar and the normal one or adjust the height of the panoramic  and the normal one or adjust the height of the panoramic 
scrollbar.scrollbar.

VALUE AXISVALUE AXIS  

For the value axis, you can set the background color and font properties. In addition, you can set the axis to invisible to have more For the value axis, you can set the background color and font properties. In addition, you can set the axis to invisible to have more 
room for your graph. room for your graph. 

GRIDGRID  

A grid can be set up in the background of the chart. You can define the grid properties like line art, style (points, vertical, A grid can be set up in the background of the chart. You can define the grid properties like line art, style (points, vertical, 
horizontal...), and mode of the grid (plain or every second column colored). You can also set the background and column colors.horizontal...), and mode of the grid (plain or every second column colored). You can also set the background and column colors.

LEGENDLEGEND  

Here you can define the font settings and the way symbols, indicators and strategies are to be displayed in the legend. The Here you can define the font settings and the way symbols, indicators and strategies are to be displayed in the legend. The 
available parameters depend on the selected chart type. You also have the option to display net and percent change (relative to available parameters depend on the selected chart type. You also have the option to display net and percent change (relative to 
previous bar).previous bar).

PERCENT PERFORMANCEPERCENT PERFORMANCE  

This allows you to set This allows you to set global percent performance propertiesglobal percent performance properties which are used by all symbols in your chart.  which are used by all symbols in your chart. Percent performance Percent performance 
chartscharts allow you to easily  allow you to easily comparecompare the relative performance of multiple symbols. the relative performance of multiple symbols.

RISK ORDER APPEARANCERISK ORDER APPEARANCE  

If strategies are applied to the graph, you can define the optical qualities of the trading system signals here. You can set the colors If strategies are applied to the graph, you can define the optical qualities of the trading system signals here. You can set the colors 
of the arrows (pointing at events in the curve) and also define how much information should be displayed for the trades.of the arrows (pointing at events in the curve) and also define how much information should be displayed for the trades.

SYMBOL PROPERTIES IN THE TOOLBOXSYMBOL PROPERTIES IN THE TOOLBOX  
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Click on the symbol name on top of the property inspector in the toolbox to Click on the symbol name on top of the property inspector in the toolbox to 
edit the symbol properties. Depending on the symbol in the chart, you can edit the symbol properties. Depending on the symbol in the chart, you can 
do the following:do the following:

l Display the trading volume and define colors for rising/fallingDisplay the trading volume and define colors for rising/falling  
l Define the colors of candles, bars etc. in the chartDefine the colors of candles, bars etc. in the chart  
l Set other properties, e.g. "Open Interests" for FuturesSet other properties, e.g. "Open Interests" for Futures  

STANDARD PROPERTIES OF STOCKS IN CHARTSSTANDARD PROPERTIES OF STOCKS IN CHARTS  

In the property inspector of the displayed stock you can find the following In the property inspector of the displayed stock you can find the following 
parameters.parameters.  
  
ScaleScale Properties Properties  
  
Scale AlignScale AlignScale AlignScale Align  -- Select whether scales should be displayed left, right, or left and right. Select whether scales should be displayed left, right, or left and right.  
  
Scale LabelsScale LabelsScale LabelsScale Labels  -- Select whether the current price should be displayed as a special label on the scale. Select whether the current price should be displayed as a special label on the scale.    
  
LegendLegendLegendLegend  -- Here you can set the legend (top left of the chart) to either visible or hidden (invisible).  Here you can set the legend (top left of the chart) to either visible or hidden (invisible).   
  
VolumeVolume Properties Properties  
  
Volume BarsVolume BarsVolume BarsVolume Bars  -- Select whether the volume should be displayed as a forest (histogram) chart on the bottom of the chart. Select whether the volume should be displayed as a forest (histogram) chart on the bottom of the chart.  
  
Rising / Falling ColorRising / Falling ColorRising / Falling ColorRising / Falling Color  -- Here you can set the colors for the volume bars. Here you can set the colors for the volume bars.    
  
InstrumentInstrument Properties Properties  
  
Depending on the chart type, additional parameters may be available.Depending on the chart type, additional parameters may be available.  
  
Display UnitsDisplay UnitsDisplay UnitsDisplay Units  -- Here you can change the display units, e.g. with how many decimal places or fractions the prices should be  Here you can change the display units, e.g. with how many decimal places or fractions the prices should be 
displayed. The default display unit will be read from the symbol properties. You can customize the default display unit via displayed. The default display unit will be read from the symbol properties. You can customize the default display unit via 
sessionssessions..  
  
CurrencyCurrencyCurrencyCurrency  -- By default, the currency related to the exchange on which the symbol is traded will be displayed; you can change the  By default, the currency related to the exchange on which the symbol is traded will be displayed; you can change the 
default currency to your preferred one.default currency to your preferred one.    
  
Data QualityData QualityData QualityData Quality  -- Displays whether the data is realtime or delayed. Displays whether the data is realtime or delayed.  
  
ExchangeExchangeExchangeExchange  -- Displays the exchange at which the symbol is traded. Displays the exchange at which the symbol is traded.  
  
FIDFIDFIDFID  -- Here you can set which fields (Last, Bid, Ask) are used for chart calculation.  Here you can set which fields (Last, Bid, Ask) are used for chart calculation.   
  
UnitUnitUnitUnit  -- Here you can change the unit, e.g. Barrel, Bushel etc. Here you can change the unit, e.g. Barrel, Bushel etc. Whether this option is available depends on the used data provider. Whether this option is available depends on the used data provider.

Symbols in the property inspectorSymbols in the property inspector
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PERCENT PERFORMANCEPERCENT PERFORMANCE  

In this group are In this group are percent performancepercent performance  propertiesproperties for a specific symbol. This allows you to enable it only for certain symbols. for a specific symbol. This allows you to enable it only for certain symbols.

[CHART TYPE][CHART TYPE] PROPERTIES PROPERTIES  

In an additional area, you can find parameters depending on the chart type, e.g. bullish and bearish color settings.In an additional area, you can find parameters depending on the chart type, e.g. bullish and bearish color settings.

STYLES AND TEMPLATESSTYLES AND TEMPLATES  
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Tradesignal offers two functions for saving and reTradesignal offers two functions for saving and re--using settings for the using settings for the 
contents and display of charts. contents and display of charts. 

l Use styles to save the optical settings only.Use styles to save the optical settings only.  
l Use templates to save optical settings as well as indicators, Use templates to save optical settings as well as indicators, 

strategies and history length. Even the symbol is saved too, but only strategies and history length. Even the symbol is saved too, but only 
applied to empty charts.applied to empty charts.  

APPLY STYLES AND TEMPLATESAPPLY STYLES AND TEMPLATES  

To apply a style, click on the To apply a style, click on the StylesStylesStylesStyles button in the toolbar to open a list of  button in the toolbar to open a list of 
predefined styles. Here you can find the predefined styles as well as your predefined styles. Here you can find the predefined styles as well as your 
own styles. Select a style.own styles. Select a style.  
  
If the default settings of chart tools were changed in the properties and If the default settings of chart tools were changed in the properties and 
saved for a style, applying this style changes the default properties of these saved for a style, applying this style changes the default properties of these 
tools. However, this only lasts while the style is applied to that chart. tools. However, this only lasts while the style is applied to that chart. 
When using the chart tools in a new chart, the usual userWhen using the chart tools in a new chart, the usual user--defined settings defined settings 
are applied. are applied.   
  
To apply a template, click on the To apply a template, click on the TemplateTemplateTemplateTemplate button in the toolbox. Then  button in the toolbox. Then 
open the context menu of a template and choose open the context menu of a template and choose ApplyApplyApplyApply..

SAVE STYLES AND TEMPLATESSAVE STYLES AND TEMPLATES  

To save a style, click the To save a style, click the StylesStylesStylesStyles button to open the button menu and select  button to open the button menu and select 
Save StyleSave StyleSave StyleSave Style from the list. A dialog opens in which you can enter the name  from the list. A dialog opens in which you can enter the name 
and description of the template which will later appear in the list. and description of the template which will later appear in the list.   
  
To save a template, open the context menu of the symbol chart legend and To save a template, open the context menu of the symbol chart legend and 

Button menu "Styles"Button menu "Styles"

Templates in the toolboxTemplates in the toolbox

select select Save TemplateSave TemplateSave TemplateSave Template. Alternatively, select . Alternatively, select Home > Style > Templates > Home > Style > Templates > 
Save TemplateSave Template on the toolbar. A dialog opens in which you have to enter a  on the toolbar. A dialog opens in which you have to enter a 
name.name.    
  
For more information, see the chapter For more information, see the chapter StylesStyles and the chapter  and the chapter TemplatesTemplates..    
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CHART TOOLS 
Chart tools are the basic tools for your chart analysis. Tradesignal offers you Chart tools are the basic tools for your chart analysis. Tradesignal offers you 
a wide variety of chart tools that are flexible and can be individually a wide variety of chart tools that are flexible and can be individually 
configured. Many of the tools offer additional features like duplicating, configured. Many of the tools offer additional features like duplicating, 
extending, mirroring and free positioning. You can also change the graphic extending, mirroring and free positioning. You can also change the graphic 
display settings of tools. display settings of tools.   
  
Tip:Tip:Tip:Tip: The right The right--click context menu for a chart will always show a mini click context menu for a chart will always show a mini 
toolbar containing the available chart tool. This way, even if the Toolbar is toolbar containing the available chart tool. This way, even if the Toolbar is 
hidden, tools are easily accessible.hidden, tools are easily accessible.

CHART TOOLS OVERVIEWCHART TOOLS OVERVIEW  

Chart ToolsChart Tools

SymbolSymbolSymbolSymbol NameNameNameName DescriptionDescriptionDescriptionDescription

TextText Free text object in the chart.Free text object in the chart.

Fibonacci RetracementFibonacci Retracement
Grid consisting of retracement and projection lines on the basis of two anchor points spaced by Grid consisting of retracement and projection lines on the basis of two anchor points spaced by 
Fib. numbers.Fib. numbers.

Fibonacci ExtensionsFibonacci Extensions Grid consisting of extension lines on the basis of three anchor points.Grid consisting of extension lines on the basis of three anchor points.

Fibonacci Time Fibonacci Time 
ProjectionProjection

Grid projection of the distance between two anchor points into the future (time axis)Grid projection of the distance between two anchor points into the future (time axis)

Fibonacci Time ZonesFibonacci Time Zones Vertical grid of line spaced by Fib. numbers.Vertical grid of line spaced by Fib. numbers.

Fibonacci ArcsFibonacci Arcs Arc above a base line with two anchor points whose spacing corresponds to Fibonacci ratios.Arc above a base line with two anchor points whose spacing corresponds to Fibonacci ratios.

Fibonacci FansFibonacci Fans
Fan above a base line with two anchor points whose angle spacing corresponds to Fibonacci Fan above a base line with two anchor points whose angle spacing corresponds to Fibonacci 
ratios.ratios.

Trend LineTrend Line Line between two freely settable anchor pointsLine between two freely settable anchor points

Trend ChannelTrend Channel Trend channel between two freely settable anchor pointsTrend channel between two freely settable anchor points

Stop LineStop Line Horizontal line for marking price levelsHorizontal line for marking price levels

Andrew's PitchforkAndrew's Pitchfork
Three lines (one median, one support, one resistance) according to the analysis method by Three lines (one median, one support, one resistance) according to the analysis method by 
Andrew.Andrew.

Linear Regression Linear Regression 
ChannelChannel

Trend channel on the basis of a regression line between two anchor pointsTrend channel on the basis of a regression line between two anchor points
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WORKING WITH CHART TOOLSWORKING WITH CHART TOOLS  

INSERTING A DRAWING OBJECTINSERTING A DRAWING OBJECT  

To use a chart tool for entering a drawing or text object, click the respective icon. Then click into the chart and enter the object. The To use a chart tool for entering a drawing or text object, click the respective icon. Then click into the chart and enter the object. The 
detailed proceeding depends on the tool: for a line, you have to enter two anchor points, for a circle you only have to click into the detailed proceeding depends on the tool: for a line, you have to enter two anchor points, for a circle you only have to click into the 
chart once and then drag the cursor to draw the circle.chart once and then drag the cursor to draw the circle.

OPENING THE CONTEXT MENUOPENING THE CONTEXT MENU  

To open the context menu of a drawing object, rightTo open the context menu of a drawing object, right--click the object. click the object. 

MOVING AND SHAPING DRAWING OBJECTSMOVING AND SHAPING DRAWING OBJECTS  

Drawing objects can be moved freely and shaped in the chart, as long as the snap mode isn't active. Drawing objects can be moved freely and shaped in the chart, as long as the snap mode isn't active. 

l To move whole objects, click on the object. A small hand or, depending on the object, a double arrow appears. Keep the left To move whole objects, click on the object. A small hand or, depending on the object, a double arrow appears. Keep the left 
mouse button pressed and drag and drop the object.mouse button pressed and drag and drop the object.  

l To change the shape of a drawing object, e.g. for moving a single anchor point or for changing the dimensions of a circle, To change the shape of a drawing object, e.g. for moving a single anchor point or for changing the dimensions of a circle, 
click the anchor or boundary point, keep the mouse button pressed, and move the point.click the anchor or boundary point, keep the mouse button pressed, and move the point.  

In the case of trend lines, trend channels and Fibonacci retracements, you can also extend the line into the moving direction by In the case of trend lines, trend channels and Fibonacci retracements, you can also extend the line into the moving direction by 
doubledouble--clicking one of the anchors points. Alternatively, you can also choose clicking one of the anchors points. Alternatively, you can also choose Extend leftExtend leftExtend leftExtend left or  or Extend rightExtend rightExtend rightExtend right from the context menu.  from the context menu. 
The extended line ends at the edge of the chart. No additional anchor points are inserted.The extended line ends at the edge of the chart. No additional anchor points are inserted.

DUPLICATING OBJECTSDUPLICATING OBJECTS  

Gann LineGann Line 45 degree line according to the analysis method of Grad W.Gann45 degree line according to the analysis method of Grad W.Gann

ArrowArrow Arrow between two anchor points (automatic labeling possible)Arrow between two anchor points (automatic labeling possible)

Guide LineGuide Line Simple vertical line with date and timeSimple vertical line with date and time

EllipseEllipse Ellipse with arbitrary dimensions.Ellipse with arbitrary dimensions.

RectangleRectangle Rectangle with arbitrary dimensions.Rectangle with arbitrary dimensions.

CircleCircle Circle with arbitrary diameter.Circle with arbitrary diameter.

ArcArc SemiSemi--circle with arbitrary dimensions.circle with arbitrary dimensions.
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You can duplicate every drawing or text object by doubleYou can duplicate every drawing or text object by double--clicking the object or by choosing clicking the object or by choosing DuplicateDuplicateDuplicateDuplicate from the context menu. Upon  from the context menu. Upon 
duplication, all graphic properties like color, opacity, style, entered text or other specific settings are copied 1:1.duplication, all graphic properties like color, opacity, style, entered text or other specific settings are copied 1:1.    
  
In the case of trend lines and channels, three additional duplication methods are available:In the case of trend lines and channels, three additional duplication methods are available:  

l When you press the When you press the CTRLCTRLCTRLCTRL key while double key while double--clicking the object, the object is duplicated and the resulting copy is mirrored on clicking the object, the object is duplicated and the resulting copy is mirrored on 
the ythe y--axis. This way, the moving direction is inverted.axis. This way, the moving direction is inverted.  

l When you press both the When you press both the CTRLCTRLCTRLCTRL and  and ShiftShiftShiftShift keys while double keys while double--clicking the object, the object is duplicated and the resulting clicking the object, the object is duplicated and the resulting 
copy is mirrored on the xcopy is mirrored on the x--axis.axis.  

l When you press the When you press the SHIFTSHIFTSHIFTSHIFT key while double key while double--clicking the object, the object is duplicated and the resulting copy is moved to clicking the object, the object is duplicated and the resulting copy is moved to 
the end point of the original object in moving direction. This way, lines and channels of the same direction and angle can be the end point of the original object in moving direction. This way, lines and channels of the same direction and angle can be 
lined up with the first object.lined up with the first object.  

DELETING DRAWING OBJECTSDELETING DRAWING OBJECTS  

To delete a single drawing or text object, select the object (in select mode) To delete a single drawing or text object, select the object (in select mode) 
and press the Del key. Alternatively you can choose and press the Del key. Alternatively you can choose DeleteDeleteDeleteDelete from the  from the 
context menu. If there are several objects under the mouse cursor, a context menu. If there are several objects under the mouse cursor, a 
selection list will be displayed. There will be no further confirmation selection list will be displayed. There will be no further confirmation 
dialog. dialog. 

DELETING TOOLS FROM THE MANAGE OBJECTS DIALOGDELETING TOOLS FROM THE MANAGE OBJECTS DIALOG  

To delete all drawing and text objects in the chart, click the iconTo delete all drawing and text objects in the chart, click the icon

in the chart tools group, you will be shown then in the chart tools group, you will be shown then Manage ObjectsManage ObjectsManage ObjectsManage Objects dialog  dialog 
where all tools in the chart can be selected or removed.where all tools in the chart can be selected or removed.  
  
The The Manage ObjectsManage ObjectsManage ObjectsManage Objects dialog also provides functions to perform bulk remove operations based on the selected tool in the dialog: dialog also provides functions to perform bulk remove operations based on the selected tool in the dialog:

l Remove all toolsRemove all tools  
l Remove only tools before the selected toolRemove only tools before the selected tool  
l Remove all tools of the same type as the selected toolRemove all tools of the same type as the selected tool  

Multiple tools in the Multiple tools in the Manage ObjectsManage ObjectsManage ObjectsManage Objects dialog can selected at once by holding the  dialog can selected at once by holding the CtrlCtrl key when clicking on them. Selecting the  key when clicking on them. Selecting the 
DeleteDeleteDeleteDelete option with multiple selected items will delete them all. option with multiple selected items will delete them all.  
  
Items will only be deleted when the Items will only be deleted when the OKOKOKOK button is clicked, if a tool is not desired to be removed, either click the  button is clicked, if a tool is not desired to be removed, either click the UndoUndo button next to  button next to 
a tool marked to be deleted, or click a tool marked to be deleted, or click CancelCancelCancelCancel to abort all changes. to abort all changes.

SELECTING SPECIFIC TOOLS IN A CHARTSELECTING SPECIFIC TOOLS IN A CHART  

The tools tab of the The tools tab of the Manage ObjectsManage ObjectsManage ObjectsManage Objects dialog shows all tools in the selected chart. This list can be sorted, grouped and filtered as  dialog shows all tools in the selected chart. This list can be sorted, grouped and filtered as 
desired in order to locate the required tools.desired in order to locate the required tools.  
  

Removing tools with the Manage Objects dialogRemoving tools with the Manage Objects dialog
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Once an item of interest has been located, clicking on the Once an item of interest has been located, clicking on the Select the toolSelect the toolSelect the toolSelect the tool button next to the item will select this tool in the chart  button next to the item will select this tool in the chart 
(the property inspector will display the items properties). Selecting the (the property inspector will display the items properties). Selecting the Scroll to toolScroll to toolScroll to toolScroll to tool button will scroll the chart to the location of  button will scroll the chart to the location of 
the tool.the tool.  
  
To sort the tools by a specific column, click on the column's header (click a second time for a reverse sort).To sort the tools by a specific column, click on the column's header (click a second time for a reverse sort).  
  
To group by a specific column, drag the column header to the area above the list (drag the column away form this area to remove To group by a specific column, drag the column header to the area above the list (drag the column away form this area to remove 
the grouping)the grouping)  
  
To filter the list, hover the mouse over a column header, and click on the little filter icon that appears in the top right of the header. To filter the list, hover the mouse over a column header, and click on the little filter icon that appears in the top right of the header. 
A list of possible filters will be displayed and can be freely selected.A list of possible filters will be displayed and can be freely selected.

LEAVING THE DRAWING MODELEAVING THE DRAWING MODE  

You can leave the chart tool mode byYou can leave the chart tool mode by

l rightright--clicking within the chartclicking within the chart  
l by clicking the select tool in the chart tools group.by clicking the select tool in the chart tools group.  

Note that with the iconNote that with the icon

(Auto reset) in the chart tools group, you set a configuration so that after each chart tool use, the application automatically reverts (Auto reset) in the chart tools group, you set a configuration so that after each chart tool use, the application automatically reverts 
into the select mode.into the select mode.

SETTINGS AND PROPERTIESSETTINGS AND PROPERTIES  

SNAP MODESNAP MODE  

Click the magnet iconClick the magnet icon

to activate the snap mode. In the snap mode, the anchor points are drawn to the closest high or low point for exact positioning.to activate the snap mode. In the snap mode, the anchor points are drawn to the closest high or low point for exact positioning.  
  
Example: If you set the first anchor point of a trend line close to a low point and then move the second anchor point across the Example: If you set the first anchor point of a trend line close to a low point and then move the second anchor point across the 
chart, it will move along the other low points. chart, it will move along the other low points. 

AUTO RESETAUTO RESET  

The standard setting is that once you selected a chart tool, you can enter as many objects into the chart as you want. This is the The standard setting is that once you selected a chart tool, you can enter as many objects into the chart as you want. This is the 
optimal setting for e.g. entering a multiple line chart analysis. optimal setting for e.g. entering a multiple line chart analysis.   
  
However, if you don't want to do that, you can use the auto reset mode. To set this option, click theHowever, if you don't want to do that, you can use the auto reset mode. To set this option, click the
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icon. Upon auto reset, the application automatically reverts into select mode after each use of a chart tool. To add another drawing icon. Upon auto reset, the application automatically reverts into select mode after each use of a chart tool. To add another drawing 
object, you then have to select a chart tool again. object, you then have to select a chart tool again.   
  
Click theClick the

icon again to leave the auto reset mode. icon again to leave the auto reset mode. 

DISPLAY PREFERENCESDISPLAY PREFERENCES  

In the property inspector you can edit various display settings for the objects. To change these settings, select the object and then In the property inspector you can edit various display settings for the objects. To change these settings, select the object and then 
click the respective property.click the respective property.  

ALERTS AND DRAWING OBJECTSALERTS AND DRAWING OBJECTS  

You can assign alerts to drawing objects. You can find more about this option in the chapter You can assign alerts to drawing objects. You can find more about this option in the chapter AlertsAlerts. . 

SAVE YOUR SETTINGS AS STANDARDSAVE YOUR SETTINGS AS STANDARD  

To save your personal settings as the new default for a tool, click the disc icon at the top of the property inspector and confirm the To save your personal settings as the new default for a tool, click the disc icon at the top of the property inspector and confirm the 
prompt with OK. prompt with OK.   
  
The next time you use a chart tool, your saved settings will be used.The next time you use a chart tool, your saved settings will be used.    
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TIMESPANS AND PERIODS 
For analyzing stocks and securities, not only the navigational features of the For analyzing stocks and securities, not only the navigational features of the 
chart but also other settings are important, like the period and timespan chart but also other settings are important, like the period and timespan 
settings. Change them to: settings. Change them to: 

l Analyze price movements and trends over various time resolutionsAnalyze price movements and trends over various time resolutions  
l Detect trends over longer time periods (days, months, years)Detect trends over longer time periods (days, months, years)  
l Compare the performance of normalized timespansCompare the performance of normalized timespans  
l Optimize the chart display according to your preferencesOptimize the chart display according to your preferences  
l Change the signal generation frequency of a trading systemChange the signal generation frequency of a trading system  
l Adapt the visible data to the analysis horizonAdapt the visible data to the analysis horizon  

You can set the trading period not only in the chart but also in the You can set the trading period not only in the chart but also in the PortfolioPortfolio, the , the ScannerScanner and the  and the WatchlistWatchlist. All paragraphs in this . All paragraphs in this 
text apply analogously. text apply analogously. 

CHANGE THE PERIODCHANGE THE PERIOD  

You can change the period for all instruments in an active chart in two You can change the period for all instruments in an active chart in two 
ways:ways:

l Via the button Via the button PeriodPeriodPeriodPeriod under  under Home > DataHome > Data on the  on the ToolbarToolbar. Click on . Click on 
the button to open the button menu and select a period.the button to open the button menu and select a period.  

l Via the command line by entering certain shortcuts, for example "w" Via the command line by entering certain shortcuts, for example "w" 
for week or "5h" for five hours. You can find the list of all shortcuts for week or "5h" for five hours. You can find the list of all shortcuts 
in the chapter in the chapter Command LineCommand Line..  

If you want to change the period for all instruments in all charts press If you want to change the period for all instruments in all charts press CtrlCtrlCtrlCtrl  
while selecting a period.while selecting a period.  
  
To change the period of a single instrument in a chart, rightTo change the period of a single instrument in a chart, right--click on the click on the 
chart legend of the instrument and change the chart legend of the instrument and change the Period for ObjectPeriod for ObjectPeriod for ObjectPeriod for Object in the  in the 
context menu.context menu.  
  
A trading period is the unit that corresponds to a price in the plot. Trading A trading period is the unit that corresponds to a price in the plot. Trading 
periods are necessary for the financial market to be able to compare periods are necessary for the financial market to be able to compare 
analysis methods, trading systems and price patterns independently of the actual value or day of time. analysis methods, trading systems and price patterns independently of the actual value or day of time. 

KINDS OF TRADING PERIODSKINDS OF TRADING PERIODS  

Trading periods come in three types:Trading periods come in three types:

l Periods based on price fixing Periods based on price fixing -- in this case, the price is plotted for a defined number of ticks. This kind of period results in a  in this case, the price is plotted for a defined number of ticks. This kind of period results in a 
nonnon--linear time scale in the chart. Three periods are available: 1, 10 or 25 ticks.linear time scale in the chart. Three periods are available: 1, 10 or 25 ticks.  

l TimeTime--dependent period dependent period -- In this case, time units are used, like hour, day, month and year. Several standard time units are  In this case, time units are used, like hour, day, month and year. Several standard time units are 

Timespan and Period icons in the toolbarTimespan and Period icons in the toolbar

Button menu PeriodButton menu Period
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offered as quick settings.offered as quick settings.  

l Periods based on traded shares Periods based on traded shares -- In this case, a defined number of shares are accumulated to a trading period for this  In this case, a defined number of shares are accumulated to a trading period for this 
security. For example, you can set that for each 1000 shares, a price should be plotted. This kind of period results in a nonsecurity. For example, you can set that for each 1000 shares, a price should be plotted. This kind of period results in a non--
linear time scale in the chart. Several quick settings are available, from 1000 to 50000 shares.linear time scale in the chart. Several quick settings are available, from 1000 to 50000 shares.  

DEFINE YOUR OWN TRADING PERIODDEFINE YOUR OWN TRADING PERIOD  

You can define your own trading period by selecting the entry You can define your own trading period by selecting the entry Other PeriodOther PeriodOther PeriodOther Period in the period button menu.  in the period button menu.   
  
As a trading period, you can set every number divisible by 1 as a time and calendar unit, or set an arbitrary number for ticks and As a trading period, you can set every number divisible by 1 as a time and calendar unit, or set an arbitrary number for ticks and 
shares.shares.

CHANGE THE TIMESPANCHANGE THE TIMESPAN  

For an active chart, you can find the timespan button in the For an active chart, you can find the timespan button in the ChartChart group in  group in 
the the ToolbarToolbar. Click on the small arrow to open the timespan menu. Select a . Click on the small arrow to open the timespan menu. Select a 
setting. setting.   
  
If you want to change the timespan for all instruments in all charts press If you want to change the timespan for all instruments in all charts press 
Ctrl while selecting a timespan.Ctrl while selecting a timespan.  
  
The timespan is the span visible in the chart history without scrolling. You The timespan is the span visible in the chart history without scrolling. You 
can use given settings or define your own timespans.can use given settings or define your own timespans.  

KINDS OF TIMESPANSKINDS OF TIMESPANS  

Several settings are available for the timespan:Several settings are available for the timespan:  
  
Current (Minute, Hour...)Current (Minute, Hour...)Current (Minute, Hour...)Current (Minute, Hour...)  -- Display only the current minute, hour etc. Display only the current minute, hour etc.  
  
Recent HistoryRecent HistoryRecent HistoryRecent History (F8, default)  (F8, default) -- In all chart types in which trading periods are linear with time, the "Recent History" is a length of 63  In all chart types in which trading periods are linear with time, the "Recent History" is a length of 63 
past trading periods and 7 empty periods of free space to the right of the current period. In charts types with a nonpast trading periods and 7 empty periods of free space to the right of the current period. In charts types with a non--linear time axes, linear time axes, 
the view is adapted to what viewers might perceive as optimal arrangement.the view is adapted to what viewers might perceive as optimal arrangement.  
  
Full HistoryFull HistoryFull HistoryFull History (Ctrl + F8)  (Ctrl + F8) -- Show the data as set in  Show the data as set in History LengthHistory LengthHistory LengthHistory Length in the property inspector (default 1000, maximum 500000). in the property inspector (default 1000, maximum 500000).

DEFINE YOUR OWN TIMESPANSDEFINE YOUR OWN TIMESPANS  

To set exact timespans, call up To set exact timespans, call up Fixed Date RangeFixed Date RangeFixed Date RangeFixed Date Range or  or Sliding Date RangeSliding Date RangeSliding Date RangeSliding Date Range in the timespan button menu. in the timespan button menu.  
  
Fixed Date RangeFixed Date RangeFixed Date RangeFixed Date Range  -- Here you can define a start point for a timespan of a fixed length. Pre Here you can define a start point for a timespan of a fixed length. Pre--set values are the current time and date. set values are the current time and date. 
Click the arrow next to the Click the arrow next to the Date fromDate fromDate fromDate from field to open a calendar to choose a date from. For the timespan, any number divisible by 1  field to open a calendar to choose a date from. For the timespan, any number divisible by 1 

Button menu TimespanButton menu Timespan
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is possible. By default, the timespan is displayed from the start point into the future. Select is possible. By default, the timespan is displayed from the start point into the future. Select Span backwards from specified Span backwards from specified Span backwards from specified Span backwards from specified 
datedatedatedate to display the timespan from the start point into the past.  to display the timespan from the start point into the past.   
  
Sliding Date RangeSliding Date RangeSliding Date RangeSliding Date Range  -- Here you can define a timespan of a fixed length that constantly begins with the last price of the current  Here you can define a timespan of a fixed length that constantly begins with the last price of the current 
trading period. For the timespan, any number divisible by 1 is possible.trading period. For the timespan, any number divisible by 1 is possible.    
  
With the key With the key F8F8F8F8 or a click on the axes symbol on the lower right of the chart you return to the standard setting  or a click on the axes symbol on the lower right of the chart you return to the standard setting Recent HistoryRecent HistoryRecent HistoryRecent History..    
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USING TEMPLATES 
In templates you can save all graphic settings of a chart as well as any included indicators, strategies, and the history length as a In templates you can save all graphic settings of a chart as well as any included indicators, strategies, and the history length as a 
template for future charts.template for future charts.  
  
Templates are handled like documents in the toolbox. Therefore, functions like package management and color tagging are Templates are handled like documents in the toolbox. Therefore, functions like package management and color tagging are 
available. available. 

SAVE A TEMPLATESAVE A TEMPLATE  

To save a template, a chart has to be active.To save a template, a chart has to be active.

1.1. Select Select Save TemplateSave TemplateSave TemplateSave Template in the context menu of the chart legend.  in the context menu of the chart legend. 
Alternatively, click on Alternatively, click on Home > Style > Template > Save TemplateHome > Style > Template > Save Template in  in 
the the ToolbarToolbar..  

2.2. Enter a name.Enter a name.  
3.3. Either select Either select Create inCreate inCreate inCreate in to choose an existing package for saving the  to choose an existing package for saving the 

template, or set up a new one.template, or set up a new one.  
4.4. Confirm with Confirm with OKOKOKOK to save the template. to save the template.  

You can find all available templates in the toolbox under the button You can find all available templates in the toolbox under the button 
TemplatesTemplatesTemplatesTemplates..

APPLY A TEMPLATEAPPLY A TEMPLATE  

1.1. Click the button Click the button TemplatesTemplatesTemplatesTemplates in the toolbox. in the toolbox.  
2.2. Drag and drop a template into a selected chart or double click on it. All previously saved settings (including the securities, Drag and drop a template into a selected chart or double click on it. All previously saved settings (including the securities, 

parameters of indicators and strategies, and the history length) are displayed in the chart. Alternatively, choose parameters of indicators and strategies, and the history length) are displayed in the chart. Alternatively, choose ApplyApplyApplyApply from  from 
the context menu of the template.the context menu of the template.  

If you apply a template to an existing chart, the symbols of the chart are used instead of the symbols saved in the template. If you apply a template to an existing chart, the symbols of the chart are used instead of the symbols saved in the template.   
  
Once a template has been applied to a chart, the chart is linked to that template. Any changes to the template will be Once a template has been applied to a chart, the chart is linked to that template. Any changes to the template will be 
automatically applied to the chart. The template used by a chart can be seen in the property inspector.automatically applied to the chart. The template used by a chart can be seen in the property inspector.  
  
To detach a chart from its template select the chart and then click on To detach a chart from its template select the chart and then click on Home > Style > Templates > Detach TemplateHome > Style > Templates > Detach Template on the Toolbar. on the Toolbar.  
  

Template manager in the toolboxTemplate manager in the toolbox

To temporarily disable the automatic updating of charts when the template changes, uncheck the box in the options under To temporarily disable the automatic updating of charts when the template changes, uncheck the box in the options under File > File > 
Options > Advanced > TemplatesOptions > Advanced > Templates..

MANAGE TEMPLATESMANAGE TEMPLATES  
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In the template manager in the toolbar, you can access various functions via the context menu:In the template manager in the toolbar, you can access various functions via the context menu:

l You can You can applyapplyapplyapply the template to the current chart or  the template to the current chart or openopenopenopen it in a new chart. it in a new chart.  

l You can You can renamerenamerenamerename or  or deletedeletedeletedelete templates. templates.  

l You can define a template as default with You can define a template as default with Set DefaultSet DefaultSet DefaultSet Default. The default template is then applied to all new charts. To return to . The default template is then applied to all new charts. To return to 
the Tradesignal default, select the Tradesignal default, select Clear DefaultClear DefaultClear DefaultClear Default..  

l You can use color tags on templates.You can use color tags on templates.  
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STYLES 
With styles, you can edit the graphic properties of With styles, you can edit the graphic properties of ChartChart, , ScannerScanner, , WatchlistWatchlist, , PortfolioPortfolio, , Market DepthMarket Depth, and , and NewsNews..  
  
You can do the following:You can do the following:

l assign existing stylesassign existing styles  
l save current settings as a new custom stylesave current settings as a new custom style  
l edit styles in style managementedit styles in style management  

APPLY STYLEAPPLY STYLE  

When a document of a type listed above is open, you can find the When a document of a type listed above is open, you can find the StyleStyle  
area in the area in the ToolbarToolbar..  
  
Click on the Click on the StylesStylesStylesStyles button to open the menu.  button to open the menu. 

l To apply a style to a single document, simply click on it in the list.To apply a style to a single document, simply click on it in the list.  
l To apply a style to all currently open documents (in all workspaces), To apply a style to all currently open documents (in all workspaces), 

press the press the CtrlCtrlCtrlCtrl key while clicking on the style. key while clicking on the style.  

The style is applied immediately.The style is applied immediately.

SAVE STYLESAVE STYLE  

1.1. Open the Open the StylesStylesStylesStyles button menu and click the entry  button menu and click the entry Save StyleSave StyleSave StyleSave Style.. A  A 
dialog opens.dialog opens.  

2.2. Enter a name for the style.Enter a name for the style.  
3.3. Enter a description (optional). This is the text that will later appear Enter a description (optional). This is the text that will later appear 

in the Styles button menu.in the Styles button menu.  
4.4. You can choose whether this style should be used as standard for this document type. In addition, you can choose whether You can choose whether this style should be used as standard for this document type. In addition, you can choose whether 

the style should be the style should be applied to all open documents of this typeapplied to all open documents of this typeapplied to all open documents of this typeapplied to all open documents of this type..  
5.5. Save the style by clicking Save the style by clicking OKOKOKOK..  

MANAGE STYLESMANAGE STYLES  

Styles button menu in the toolbarStyles button menu in the toolbar
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To manage styles, open the To manage styles, open the StylesStylesStylesStyles button menu and choose the entry  button menu and choose the entry 
Manage StylesManage StylesManage StylesManage Styles. A dialog opens.. A dialog opens.  
  
Open the tab of the document type for which you want to edit the styles. Open the tab of the document type for which you want to edit the styles.   
  
Click the Click the Set as DefaultSet as DefaultSet as DefaultSet as Default button to use the selected style as new standard  button to use the selected style as new standard 
for documents of that type. If you click for documents of that type. If you click Clear DefaultClear DefaultClear DefaultClear Default, the Tradesignal , the Tradesignal 
standard is used again. standard is used again.   
  
If you have saved your own styles, you can If you have saved your own styles, you can editediteditedit them (only name and  them (only name and 
description) and description) and deletedeletedeletedelete them. them.    

Style ManagementStyle Management



:: www.tradesignal.comwww.tradesignal.com

Tradesignal GmbHTradesignal GmbH Page 186Page 186 Version 7.0Version 7.0

FORWARD CURVE 
A Forward Curve in Tradesignal allows commodity traders to obtain a A Forward Curve in Tradesignal allows commodity traders to obtain a 
visualization of the forward or futures prices on a given date for a given visualization of the forward or futures prices on a given date for a given 
commodity.commodity.  
  
The Forward Curve plots the current price of a given forward contract The Forward Curve plots the current price of a given forward contract 
against the expiration date of the contract. The current prices or prices from against the expiration date of the contract. The current prices or prices from 
any previous day may be plotted in such a way.any previous day may be plotted in such a way.  
  
Forward Curves are available in Tradesignal, making them usable in the Forward Curves are available in Tradesignal, making them usable in the 
same way as other charts, i.e. you can apply same way as other charts, i.e. you can apply indicatorsindicators and  and strategiesstrategies to  to 
them.them.

FORWARD CURVES IN TRADESIGNALFORWARD CURVES IN TRADESIGNAL  

CREATING A FORWARD CURVE CHARTCREATING A FORWARD CURVE CHART  

You can access the Forward Curve Wizard from the You can access the Forward Curve Wizard from the ToolbarToolbar by clicking on  by clicking on 
the the Forward CurveForward CurveForward CurveForward Curve button in the  button in the InsertInsertInsertInsert tab. It allows you to select symbol  tab. It allows you to select symbol 
lists containing commodities or other futures and set the lists containing commodities or other futures and set the Date alignmentDate alignmentDate alignmentDate alignment  
and and DisplacementDisplacementDisplacementDisplacement  propertiesproperties..  
  
You can also drag a symbol list of commodities onto a chart, this will You can also drag a symbol list of commodities onto a chart, this will 
prompt you if you want to create a Forward Curve or insert all symbols prompt you if you want to create a Forward Curve or insert all symbols 
contained in the list into the chart. If you enter the symbol shortcut for a contained in the list into the chart. If you enter the symbol shortcut for a 
continuous contractcontinuous contract, e.g. , e.g. "Sc1""Sc1" for a contract series for soy beans, into the  for a contract series for soy beans, into the 
command linecommand line, you can select the option , you can select the option New Forward CurveNew Forward CurveNew Forward CurveNew Forward Curve from the  from the 
dropdrop--down menu.down menu.  
  
You can also create a forward curve from a userYou can also create a forward curve from a user--defined list of forward defined list of forward 
contract symbols. Please be aware that for this feature to work, it will be contract symbols. Please be aware that for this feature to work, it will be 
necessary to manually mark existing usernecessary to manually mark existing user--defined lists as supporting forward curves using the defined lists as supporting forward curves using the Allow Forward CurvesAllow Forward CurvesAllow Forward CurvesAllow Forward Curves option in the  option in the 
list's list's context menucontext menu..  
  
If you want to display the names of each contract as a label near each price point, you can If you want to display the names of each contract as a label near each price point, you can applyapply the supplied  the supplied Forward Curve Forward Curve Forward Curve Forward Curve 
LabelLabelLabelLabel indicator. indicator.

PROPERTIES OF A FORWARD CURVE CHARTPROPERTIES OF A FORWARD CURVE CHART  

You can edit the You can edit the propertiesproperties of a Forward Curve chart either during its creation in the wizard or use the property inspector in the  of a Forward Curve chart either during its creation in the wizard or use the property inspector in the 
ToolboxToolbox..  
  

Forward Curve in TradesignalForward Curve in Tradesignal

Forward Curve WizardForward Curve Wizard
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There are two properties specific to Forward Curves:There are two properties specific to Forward Curves:

l Date AlignmentDate AlignmentDate AlignmentDate Alignment  -- The expiry date of each contract will be aligned according to this setting, useful if you want to align  The expiry date of each contract will be aligned according to this setting, useful if you want to align 
multiple different forward curves.multiple different forward curves.  

l DisplacementDisplacementDisplacementDisplacement  -- The displacement property governs what value to show for each contract in the forward curve. A value of 0  The displacement property governs what value to show for each contract in the forward curve. A value of 0 
means means use the current valueuse the current value, 1 means , 1 means use the value of the previous baruse the value of the previous bar, etc., etc.  
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PERCENT PERFORMANCE 
A percent performance chart offers an easy way to A percent performance chart offers an easy way to comparecompare the  the 
performance of multiple symbols.performance of multiple symbols.  
  
It shows the percentage increase or decrease of a symbol relative to its It shows the percentage increase or decrease of a symbol relative to its 
price at a given price at a given start datestart datestart datestart date, which may be selected globally in , which may be selected globally in Chart Chart 
PropertiesProperties in the section  in the section Global Percent Performance PropertiesGlobal Percent Performance Properties or for each  or for each 
symbol in the symbol in the Symbol Percent Performance PropertiesSymbol Percent Performance Properties..  
  
You can create a percent performance chart either by setting the properties You can create a percent performance chart either by setting the properties 
on an existing chart or by using the percent performance wizard in the on an existing chart or by using the percent performance wizard in the 
toolbartoolbar to create a new chart. to create a new chart.

PERCENT PERFORMANCE WIZARDPERCENT PERFORMANCE WIZARD  

The Percent Performance Wizards allows you to select up to 50 symbols The Percent Performance Wizards allows you to select up to 50 symbols 
from your from your symbol listssymbol lists and to choose between several chart styles for your  and to choose between several chart styles for your 
new chart.new chart.  
  
You can also set the global You can also set the global start datestart datestart datestart date in the wizard. If you do not select a  in the wizard. If you do not select a 
start datestart datestart datestart date, the first available price will be used., the first available price will be used.

GLOBAL PERCENT PERFORMANCE PROPERTIESGLOBAL PERCENT PERFORMANCE PROPERTIES  

Found in the property inspector of the Found in the property inspector of the chartchart this group of properties allows  this group of properties allows 
you to enable/disable the percent performance transformation for all you to enable/disable the percent performance transformation for all 
symbols in your chart and to select a new start date.symbols in your chart and to select a new start date.

l % Performance% Performance% Performance% Performance  -- Can be set to  Can be set to ActiveActiveActiveActive or  or InactiveInactiveInactiveInactive..  
l Start DateStart DateStart DateStart Date  -- The price at this date will be used as a base value  The price at this date will be used as a base value 

from which the percent increase/decrease is calculated. If none is selected the first price is used.from which the percent increase/decrease is calculated. If none is selected the first price is used.  

SYMBOL PERCENT PERFORMANCE PROPERTIESSYMBOL PERCENT PERFORMANCE PROPERTIES  

Percent performance chartPercent performance chart

Percent performance wizardPercent performance wizard

Global propertiesGlobal properties
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The properties in the group The properties in the group % performance% performance of the  of the symbolsymbol properties apply  properties apply 
only to the selected symbol.only to the selected symbol.

l % Performance% Performance% Performance% Performance  --  DefaultDefaultDefaultDefault uses the global setting,  uses the global setting, OnOnOnOn//OffOffOffOff are  are 
always on/off ignoring the global setting, always on/off ignoring the global setting, On (Custom Start Date)On (Custom Start Date)On (Custom Start Date)On (Custom Start Date)  
uses the uses the Start DateStart DateStart DateStart Date below. below.  

l Custom Start DateCustom Start DateCustom Start DateCustom Start Date  -- The price at this date will be used as a base  The price at this date will be used as a base 
value from which the percent increase/decrease is calculated if in value from which the percent increase/decrease is calculated if in 
On (Custom Start DateOn (Custom Start DateOn (Custom Start DateOn (Custom Start Date. Otherwise the global . Otherwise the global Start DateStart DateStart DateStart Date is used. is used.  

l Base ValueBase ValueBase ValueBase Value  -- Select which price field (close, open, ...) you want to use. Select which price field (close, open, ...) you want to use.  

Symbol propertiesSymbol properties
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SEASONAL CHART 
With the seasonal mode, Tradesignal offers you the ability to overlay the With the seasonal mode, Tradesignal offers you the ability to overlay the 
prices of different years for one or more symbols. Comparing the symbols prices of different years for one or more symbols. Comparing the symbols 
this way emphasizes seasonal pattern, e.g. if used with commodities that this way emphasizes seasonal pattern, e.g. if used with commodities that 
have seasonal variations.have seasonal variations.

PROPERTIES OF A SEASONAL CHARTPROPERTIES OF A SEASONAL CHART  

If enabled, the seasonal properties group will be displayed in the If enabled, the seasonal properties group will be displayed in the chart chart 
propertiesproperties, allowing you to customize the seasonal view:, allowing you to customize the seasonal view:

l End MonthEnd MonthEnd MonthEnd Month  -- Specify the end month on the seasonal date scale. Specify the end month on the seasonal date scale.  
l End DayEnd DayEnd DayEnd Day  -- Specify which day of the month should be the final day on the seasonal date scale. Specify which day of the month should be the final day on the seasonal date scale.  
l Preceding MonthsPreceding MonthsPreceding MonthsPreceding Months  -- Specify how many preceding months until the end month should be displayed on the seasonal date  Specify how many preceding months until the end month should be displayed on the seasonal date 

scale.scale.  
l DisplacementDisplacementDisplacementDisplacement  -- Use this setting to display the symbols displaced, so that they align to the selected end day with/without  Use this setting to display the symbols displaced, so that they align to the selected end day with/without 

any weekend gaps closed.any weekend gaps closed.  

SEASONAL CHART WIZARDSEASONAL CHART WIZARD  

The Seasonal Chart Wizard in Tradesignal, which is found in the The Seasonal Chart Wizard in Tradesignal, which is found in the ToolbarToolbar, , 
allows you to select a list of futures and to display them in a seasonal allows you to select a list of futures and to display them in a seasonal 
chart with the option of adding a Seasonal Average Indicator which shows chart with the option of adding a Seasonal Average Indicator which shows 
the average price across all contracts in the contract series.the average price across all contracts in the contract series.

EXAMPLEEXAMPLE  

Example on how to compare expired wheat future contracts in seasonal Example on how to compare expired wheat future contracts in seasonal 
mode:mode:

1.1. Open a chart with the expired December wheat contract from 2007, Open a chart with the expired December wheat contract from 2007, 
W 2007ZW 2007ZW 2007ZW 2007Z..  

2.2. Add a previous year contract which also expired in December, e.g. Add a previous year contract which also expired in December, e.g. 
W 2006ZW 2006ZW 2006ZW 2006Z..  

3.3. Select the chart. In the chart properties of the date axis, change the Select the chart. In the chart properties of the date axis, change the ModeModeModeMode property to  property to SeasonalSeasonalSeasonalSeasonal..  

The symbols will now be displayed below each other.The symbols will now be displayed below each other.    

A Seasonal ChartA Seasonal Chart

Seasonal Chart WizardSeasonal Chart Wizard
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TOTAL COMMISSION AND SLIPPAGE 
Here you can find detailed information on the commission and slippage key figures in the Here you can find detailed information on the commission and slippage key figures in the Performance ReportPerformance Report..

TOTAL COMMISSIONTOTAL COMMISSION  

This sum is an important, but often overlooked key figure. It shows you how much money you spent only for the trading activities. This sum is an important, but often overlooked key figure. It shows you how much money you spent only for the trading activities. 
Usually, this sum has to be set in relation to the system profitUsually, this sum has to be set in relation to the system profit . The ratio should lie far on the profitable side. . The ratio should lie far on the profitable side.

TOTAL SLIPPAGETOTAL SLIPPAGE  

Usually, the slippage is seen as an uncertainty factor. Between signal generation, order entry and order filling there is a time in Usually, the slippage is seen as an uncertainty factor. Between signal generation, order entry and order filling there is a time in 
which the price moves, possibly against you. which the price moves, possibly against you.   
  
To see the effects of such price movements in the backtest, the slippage is subtracted from the profit or is added to the loss. The To see the effects of such price movements in the backtest, the slippage is subtracted from the profit or is added to the loss. The 
sum shows you how much smaller the realized profit would be in comparison to the maximum in the backtest.sum shows you how much smaller the realized profit would be in comparison to the maximum in the backtest.    
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MAX. DRAWDOWN 
Here you can find detailed information on the drawdown key figures in the Here you can find detailed information on the drawdown key figures in the Performance ReportPerformance Report..

MAX. DRAWDOWNMAX. DRAWDOWN  

A phase of declining profit is called a drawdown phase. The key figure A phase of declining profit is called a drawdown phase. The key figure 
Max. Drawdown displays the highest absolute profit drawdown in the time Max. Drawdown displays the highest absolute profit drawdown in the time 
range of the test. The Performance Report also shows the date on which range of the test. The Performance Report also shows the date on which 
that max. drawdown occurred.that max. drawdown occurred.  
  
A drawdown phase starts when at a profit maximum a declining A drawdown phase starts when at a profit maximum a declining 
development starts with one negative trade. Often, a series of losses and development starts with one negative trade. Often, a series of losses and 
overly small profits adds up to a longer drawdown phase. The size and overly small profits adds up to a longer drawdown phase. The size and 
time range of the drawdown are important criteria for evaluating a trading time range of the drawdown are important criteria for evaluating a trading 
system.system.  
  
The drawdown is calculated on basis of closed positions. Therefore, it does not reflect that for held positions, much larger The drawdown is calculated on basis of closed positions. Therefore, it does not reflect that for held positions, much larger 
drawdowns might take place. drawdowns might take place. 

MAX. INTRADAY DRAWDOWNMAX. INTRADAY DRAWDOWN  

The key figure is calculated on basis of the complete profit, including open positions. Therefore, it includes all price movements The key figure is calculated on basis of the complete profit, including open positions. Therefore, it includes all price movements 
that cause a drawdown for open positions, although these drawdowns might be reduced or neutral once the position is closed. that cause a drawdown for open positions, although these drawdowns might be reduced or neutral once the position is closed.   
  
With the help of this key figure you get an impression of the maximum loss of your system, i.e. the losses you should be prepared With the help of this key figure you get an impression of the maximum loss of your system, i.e. the losses you should be prepared 
for financially and mentally.for financially and mentally.    

Performance ReportPerformance Report
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FROEHLICH FACTOR 
The Froehlich Factor (FF) is a complex key figure that is supposed to The Froehlich Factor (FF) is a complex key figure that is supposed to 
measure the quality of the trading system results. measure the quality of the trading system results.   
  
Using the Froehlich Factor, the changes in quality of a system can be Using the Froehlich Factor, the changes in quality of a system can be 
investigated. This key figure also takes into account that rare extreme investigated. This key figure also takes into account that rare extreme 
values can distort the system performance. Because of this, the biggest values can distort the system performance. Because of this, the biggest 
deviations from the standard are used as divisors in the calculation.deviations from the standard are used as divisors in the calculation.    
  
The formula of the FF is calculated as follows: The formula of the FF is calculated as follows: 

Netto Profit * Percent Winning Trades * (Profit Factor * (Average Win / Average Loss)

              Max. Winning Trade + Max. Losing Trade + Max. Drawdown 

  
  
A value of FF = 5 for intraday and of FF > 10 for EOD systems should be expected, according to Stefan Froehlich.A value of FF = 5 for intraday and of FF > 10 for EOD systems should be expected, according to Stefan Froehlich.    

Performance ReportPerformance Report
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SHARPE RATIO 
The Sharpe Ratio is a key figure for the profitability of an investment in The Sharpe Ratio is a key figure for the profitability of an investment in 
relation to its risk. It gives a feeling for the profit/risk ratio during the trade.relation to its risk. It gives a feeling for the profit/risk ratio during the trade.  
  
The calculation is based on a reference value for a "riskThe calculation is based on a reference value for a "risk--free investment", free investment", 
for example a bond or a fixed deposit account. On this basis, the resulting for example a bond or a fixed deposit account. On this basis, the resulting 
interest for the investment is calculated. When calculating the risk of a interest for the investment is calculated. When calculating the risk of a 
trade, the standard deviation is used as a measure of the volatility.trade, the standard deviation is used as a measure of the volatility.  
  
The Sharpe Ratio is calculated for monthly periods, like the profits and the The Sharpe Ratio is calculated for monthly periods, like the profits and the 
volatility.volatility.

AVERAGE SHARPE RATIOAVERAGE SHARPE RATIO  

The Average Sharpe Ratio is identical to the Sharpe Ratio but calculated over the whole history length. Since it is based on longer The Average Sharpe Ratio is identical to the Sharpe Ratio but calculated over the whole history length. Since it is based on longer 
periods, the result is more averaged than the original key figure.periods, the result is more averaged than the original key figure.    

Performance ReportPerformance Report
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PERCENT PROFITABLE 
Percent Profitable is a key figure in the Percent Profitable is a key figure in the Performance ReportPerformance Report. With this key . With this key 
figure you get an information about the percentage of profitable trades in figure you get an information about the percentage of profitable trades in 
relation to all trades. This value is an important piece of information for relation to all trades. This value is an important piece of information for 
testing and optimizing your trading system.testing and optimizing your trading system.  
  
However, it cannot be evaluated without context. Depending on the However, it cannot be evaluated without context. Depending on the 
configuration of the trading systems, completely different hit rates can configuration of the trading systems, completely different hit rates can 
result. result. 

l TrendTrend--following systems usually show lower hit rates, but the following systems usually show lower hit rates, but the 
profit/loss ratio is higher.profit/loss ratio is higher.  

l Trading systems with higher hit rates often have a smaller profit/loss ratio, which is additionally influenced by the increased Trading systems with higher hit rates often have a smaller profit/loss ratio, which is additionally influenced by the increased 
cost caused by larger trading volumes.cost caused by larger trading volumes.  

Percent Profitable Trades = (Number of Winning Trades / Total Number of Trades) * 100 

Performance ReportPerformance Report
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AVERAGE TRADE NET PROFIT 
Here you can find detailed information about the Average Trade key figures Here you can find detailed information about the Average Trade key figures 
in the in the '''Tradesignal Performance Report''''''Tradesignal Performance Report'''..  
  
In the Performance Report, all figures are displayed as cumulated valued In the Performance Report, all figures are displayed as cumulated valued 
for all trades and also for long and short trades separately. for all trades and also for long and short trades separately. 

AVERAGE TRADE NETTO PROFITAVERAGE TRADE NETTO PROFIT  

This value gives the average profit of all trades for the data. For this, the This value gives the average profit of all trades for the data. For this, the 
Total Netto ProfitTotal Netto ProfitTotal Netto ProfitTotal Netto Profit is divided by the  is divided by the Total Number of TradesTotal Number of TradesTotal Number of TradesTotal Number of Trades. The . The 
Average Trade Netto Profit is a key figure of the trading system statistics. With its help, different results for one or several systems Average Trade Netto Profit is a key figure of the trading system statistics. With its help, different results for one or several systems 
can be compared. The value should also be compared to the commission and slippage per trade. It helps you estimate the can be compared. The value should also be compared to the commission and slippage per trade. It helps you estimate the 
probability that after deducting all costs, the trading system will still be profitable. probability that after deducting all costs, the trading system will still be profitable.   
  

Average Trade Netto Profit = Total Netto Profit / Total Number of Trades 

AVERAGE WINNING TRADEAVERAGE WINNING TRADE  

This key figure gives the average of all profitable trades. Compare this value with the average of all losing trades to get an This key figure gives the average of all profitable trades. Compare this value with the average of all losing trades to get an 
impression of the trading system performance. impression of the trading system performance.   
  

Average Winning Trade = Gross Profit / Number of Winning Trades 

AVERAGE LOSING TRADEAVERAGE LOSING TRADE  

This key figure gives the average of all losing trades. Compare this value with the average of all winning trades to get an This key figure gives the average of all losing trades. Compare this value with the average of all winning trades to get an 
impression of the trading system performance. impression of the trading system performance.   
  

Average LosingTrade = Gross Loss / Number of Losing Trades 

RATIO AVERAGE WINNING TRADE / AVERAGE LOSING TRADERATIO AVERAGE WINNING TRADE / AVERAGE LOSING TRADE  

This key figure gives the ratio of the two key figures above. It is important for judging the system performance. By combining it This key figure gives the ratio of the two key figures above. It is important for judging the system performance. By combining it 
with further figures, e.g. for the number of loss and win trades, the potential of the system can be estimated.with further figures, e.g. for the number of loss and win trades, the potential of the system can be estimated.

LARGEST WINNING TRADELARGEST WINNING TRADE  

This key figures gives the largest single profit of the data set. It is often preferable to ignore this value and to remove it from the This key figures gives the largest single profit of the data set. It is often preferable to ignore this value and to remove it from the 

Performance ReportPerformance Report
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backtest result. This way, random results are less likely to influence your system. backtest result. This way, random results are less likely to influence your system. 

LARGEST LOSING TRADELARGEST LOSING TRADE  

This key figures gives the largest single loss of the data set. The explanation given above applies. It is often preferable to ignore This key figures gives the largest single loss of the data set. The explanation given above applies. It is often preferable to ignore 
this value.this value.    
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USING TRADING STRATEGIES 
A trading system is a collection of rules and functions from which trading decisions of any kind result. To this collection, rules for A trading system is a collection of rules and functions from which trading decisions of any kind result. To this collection, rules for 
money and risk management are added. Modern computer software also supports the fully mechanized trade, up to the order money and risk management are added. Modern computer software also supports the fully mechanized trade, up to the order 
routing to the broker. Trading systems are used to: routing to the broker. Trading systems are used to: 

l Test a set of rules for future real tradeTest a set of rules for future real trade  
l Guarantee the smooth execution of trading decisionsGuarantee the smooth execution of trading decisions  
l Sidestep human weaknesses like fear and insecuritySidestep human weaknesses like fear and insecurity  
l Procure stable results based on clear rulesProcure stable results based on clear rules  
l Automate trades based on a complex set of rulesAutomate trades based on a complex set of rules  
l Trade many different symbols or systems at the same time.Trade many different symbols or systems at the same time.  

Tradesignal offers you a broad range of tools for the development, testing, and operation of complex trading systems:Tradesignal offers you a broad range of tools for the development, testing, and operation of complex trading systems:

l StrategiesStrategies are written in  are written in EquillaEquilla and can be edited and adapted to your needs. and can be edited and adapted to your needs.  

l Money ManagementMoney Management with options for position sizing and risk management. with options for position sizing and risk management.  

l Analysis of the possible trading system turnover in the Analysis of the possible trading system turnover in the Performance ReportPerformance Report..  

l Search for the most profitable and stable trading system configuration with the Search for the most profitable and stable trading system configuration with the OptimizerOptimizer..  

l Mechanical trading with Mechanical trading with Automatic Order RoutingAutomatic Order Routing..  

l AlertsAlerts issued when critical limits (values or graphic lines) are intersected in defined directions. issued when critical limits (values or graphic lines) are intersected in defined directions.  

l An easy start with the An easy start with the Trading Strategy WizardTrading Strategy Wizard that offers more than 300 strategies in a modular system, as well as new  that offers more than 300 strategies in a modular system, as well as new 
indicators and strategies for download from Tradesignal.indicators and strategies for download from Tradesignal.  

All of these tools are intended to help you configure and optimize your own systems.All of these tools are intended to help you configure and optimize your own systems.    
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TRADING STRATEGY WIZARD 
Trading strategies are an important tool for many traders who seek success Trading strategies are an important tool for many traders who seek success 
at the market independent of their personal feelings, fears and insecurities. at the market independent of their personal feelings, fears and insecurities. 
For this aim, Tradesignal offers many preFor this aim, Tradesignal offers many pre--defined indicators and strategies, defined indicators and strategies, 
which can be expanded by adjusting existing strategies or developing new which can be expanded by adjusting existing strategies or developing new 
strategies in Equilla.strategies in Equilla.  
  
As an alternative, Tradesignal offers a Trading Strategy Wizard to support As an alternative, Tradesignal offers a Trading Strategy Wizard to support 
you in assembling a strategy. Instead of scripting, simply combine lists, you in assembling a strategy. Instead of scripting, simply combine lists, 
conditions, expressions and patterns. The wizard helps you to conditions, expressions and patterns. The wizard helps you to 

l swiftly create trading strategiesswiftly create trading strategies  
l modify your strategies and customize itmodify your strategies and customize it  

Strategies created in the wizard can be used in the Strategies created in the wizard can be used in the ChartChart, , ScannerScanner, , 
WatchlistWatchlist, , PortfolioPortfolio or the  or the OptimizerOptimizer. For all adjustable parameters, the wizard automatically creates "Input Declarations" so that . For all adjustable parameters, the wizard automatically creates "Input Declarations" so that 
you can edit the parameters in the property inspector and the Optimizer. you can edit the parameters in the property inspector and the Optimizer. 

CREATING A TRADING STRATEGYCREATING A TRADING STRATEGY  

Trading Strategy WizardTrading Strategy Wizard
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1.1. In the toolbox, click on the In the toolbox, click on the StrategiesStrategiesStrategiesStrategies button. button.  
2.2. In the In the Related TasksRelated Tasks area, select  area, select New StrategyNew StrategyNew StrategyNew Strategy..  
3.3. In the next dialog, select the option In the next dialog, select the option Use the Trading Strategy Use the Trading Strategy Use the Trading Strategy Use the Trading Strategy 

WizardWizardWizardWizard..  

In the following window, the strategy rules are defined. Rules can be In the following window, the strategy rules are defined. Rules can be 
assigned to each trading order, and several trading orders can be set up for assigned to each trading order, and several trading orders can be set up for 
the strategy. For condition details, see below. the strategy. For condition details, see below. 

1.1. Click Click NewNewNewNew to enter a new order. to enter a new order.  
2.2. Enter a Enter a name for the ordername for the ordername for the ordername for the order (optional), to distinguish between  (optional), to distinguish between 

different entry and exit methods.different entry and exit methods.  
3.3. Select an entry or exit method.Select an entry or exit method.  
4.4. Enter an order type.Enter an order type.  
5.5. Select Select Generate reversed trading conditionGenerate reversed trading conditionGenerate reversed trading conditionGenerate reversed trading condition to generate also the  to generate also the 

reversed order (for example, for a "buy long" generate a "sell long" reversed order (for example, for a "buy long" generate a "sell long" 
with reversed conditions).with reversed conditions).  

6.6. Enter the Order Settings and click on Enter the Order Settings and click on NextNextNextNext..  
7.7. In the next window, enter the conditions.In the next window, enter the conditions.  

You can now edit the conditions further by clicking on You can now edit the conditions further by clicking on EditEditEditEdit next to the  next to the 
Expression fields. The Expression fields. The Build ExpressionBuild Expression dialog opens. Here you can define  dialog opens. Here you can define 
how the value is to be calculated. Select the option how the value is to be calculated. Select the option Make an inputMake an inputMake an inputMake an input to  to 
make this value appear as parameter in the strategy properties and the make this value appear as parameter in the strategy properties and the 
OptimizerOptimizer. .   
  
You can also change the operators that link the expressions. Select one You can also change the operators that link the expressions. Select one 
from the list. from the list.   
  
Click the Click the DoneDoneDoneDone buttons to save the expressions/strategy. buttons to save the expressions/strategy.

ENTRY AND EXIT METHODSENTRY AND EXIT METHODS  

The trading methods are roughly divided into exit and entry orders.The trading methods are roughly divided into exit and entry orders.

ENTRY METHODSENTRY METHODS  

The following two methods create orders that open a position.The following two methods create orders that open a position.    
  
Enter Long (Buy)Enter Long (Buy)Enter Long (Buy)Enter Long (Buy)  -- A buying order is created.  A buying order is created.   
  
Enter Short (Sell)Enter Short (Sell)Enter Short (Sell)Enter Short (Sell)  -- A short sale order is created.  A short sale order is created. 

EXIT METHODSEXIT METHODS  

The opened Trading Strategy WizardThe opened Trading Strategy Wizard

New StrategyNew Strategy
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The following two methods create orders that close an existing position.The following two methods create orders that close an existing position.    
  
Exit Long (Sell)Exit Long (Sell)Exit Long (Sell)Exit Long (Sell)  -- A selling order is created to close a long position (a fraction or all of it).  A selling order is created to close a long position (a fraction or all of it).   
  
Exit Short (Cover)Exit Short (Cover)Exit Short (Cover)Exit Short (Cover)  -- A buying order is generated to cover a short position.  A buying order is generated to cover a short position. 

STOP LOSS, TRAILING STOP AND PROFIT TARGETSTOP LOSS, TRAILING STOP AND PROFIT TARGET  

Stop LossStop LossStop LossStop Loss  -- An order is created that closes the current position after reaching the defined loss.  An order is created that closes the current position after reaching the defined loss.   
  
Profit TargetProfit TargetProfit TargetProfit Target  -- An order is created that closes the position after reaching the defined profit.  An order is created that closes the position after reaching the defined profit.   
  
Break EvenBreak EvenBreak EvenBreak Even  -- An order is created that prevents a position from causing losses after having made a profit.  An order is created that prevents a position from causing losses after having made a profit.   
  
Trailing Stop (Amount)Trailing Stop (Amount)Trailing Stop (Amount)Trailing Stop (Amount)  -- An order is created that follows the position development. When the position moves with the desired  An order is created that follows the position development. When the position moves with the desired 
trend, the order "trails" behind. When the position moves against the desired trend, the position is closed after a certain decline in trend, the order "trails" behind. When the position moves against the desired trend, the position is closed after a certain decline in 
profit, defined as amount. profit, defined as amount.   
  
Trailing Stop (Percent)Trailing Stop (Percent)Trailing Stop (Percent)Trailing Stop (Percent)  -- An order is created that follows the position development. After a defined profit target, the stop order is  An order is created that follows the position development. After a defined profit target, the stop order is 
activated. The position is closed after a certain decline in profit, defined in percent.activated. The position is closed after a certain decline in profit, defined in percent.

TRADING TYPESTRADING TYPES  

A order type has to be assigned to each order. It defines when the order is executed. For two order types, additional conditions are A order type has to be assigned to each order. It defines when the order is executed. For two order types, additional conditions are 
available to control the execution.available to control the execution.    
  
This Bar on Close (TBOC)This Bar on Close (TBOC)This Bar on Close (TBOC)This Bar on Close (TBOC)  -- The order is submitted at the end of the trading. In the settings of the Order Routing in the  The order is submitted at the end of the trading. In the settings of the Order Routing in the Tradesignal Tradesignal 
OptionsOptions, you can define at what distance to the real trading end a TBOC order is created and possibly routed. In backtests, the close , you can define at what distance to the real trading end a TBOC order is created and possibly routed. In backtests, the close 
price of the trading period is taken as execution price.price of the trading period is taken as execution price.    
  
Next Bar at Market (NBAM)Next Bar at Market (NBAM)Next Bar at Market (NBAM)Next Bar at Market (NBAM)  -- The order is submitted at the opening of the next trading period. In backtests, the open price of the  The order is submitted at the opening of the next trading period. In backtests, the open price of the 
trading period is taken as execution price. trading period is taken as execution price.   
  
Next Bar at Price Stop (NBPS)Next Bar at Price Stop (NBPS)Next Bar at Price Stop (NBPS)Next Bar at Price Stop (NBPS)  -- The order is submitted during the next trading period. For a buy order, the price has to cross the  The order is submitted during the next trading period. For a buy order, the price has to cross the 
given price limit, for a short sale the price has to be undercut. This way, the position is opened when the trend moves into the given price limit, for a short sale the price has to be undercut. This way, the position is opened when the trend moves into the 
preferred direction.preferred direction.    
  
Next Bar at Price Limit (NBPL)Next Bar at Price Limit (NBPL)Next Bar at Price Limit (NBPL)Next Bar at Price Limit (NBPL)  -- The order is submitted during the next trading period. For a buy order, the price has to undercut  The order is submitted during the next trading period. For a buy order, the price has to undercut 
the given price limit, for a short sale the price has to be crossed. the given price limit, for a short sale the price has to be crossed.   
  
This Bar at Market (TBAM)This Bar at Market (TBAM)This Bar at Market (TBAM)This Bar at Market (TBAM)  -- The order is submitted during the current trading period. It is executed instantly. The order is submitted during the current trading period. It is executed instantly.

ORDER SETTINGSORDER SETTINGS  
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For each order, either you can define it so that the quantity of shares to be traded can be entered in the property inspector (For each order, either you can define it so that the quantity of shares to be traded can be entered in the property inspector (Money Money 
ManagementManagement), or you can enter a fixed quantity here. ), or you can enter a fixed quantity here.   
  
Setting quantities in the property inspector has the benefit of making it possible to use Setting quantities in the property inspector has the benefit of making it possible to use position sizing methodsposition sizing methods that are offered in  that are offered in 
Tradesignal. This way, the quantities can be adapted dynamically in your trading system.Tradesignal. This way, the quantities can be adapted dynamically in your trading system.

TRADING CONDITION TEMPLATESTRADING CONDITION TEMPLATES  

The trading conditions are largely based on preThe trading conditions are largely based on pre--defined Equilla scripts that defined Equilla scripts that 
include indicators, calculate chart patterns or search for candlestick include indicators, calculate chart patterns or search for candlestick 
patterns. For the signal generation, there are typically two expressions patterns. For the signal generation, there are typically two expressions 
necessary, for example ""indicator XYZ crosses over the average ABC". The necessary, for example ""indicator XYZ crosses over the average ABC". The 
calculation of the indicator and its average are all included in Equilla calculation of the indicator and its average are all included in Equilla 
scripts that are combined and connected by operators in the Wizard.scripts that are combined and connected by operators in the Wizard.  
  
The templates for signal generation are roughly listed by categories. At the The templates for signal generation are roughly listed by categories. At the 
top of the list, you can find three categories that generate signals based on top of the list, you can find three categories that generate signals based on 
the the Standard Price SeriesStandard Price SeriesStandard Price SeriesStandard Price Series, , Position basedPosition basedPosition basedPosition based, or based on , or based on Date and Date and Date and Date and 
TimeTimeTimeTime. Below these entries, you can find a long list of indicators, followed . Below these entries, you can find a long list of indicators, followed 
by candlestick patterns and chart patterns. by candlestick patterns and chart patterns. 

STANDARD PRICE SERIESSTANDARD PRICE SERIES  

These signals are based on the price of the underlying stock. The signals are generated depending on comparisons of the current These signals are based on the price of the underlying stock. The signals are generated depending on comparisons of the current 
price to past prices. This way, changes in directions and the highest and close prices can be calculated.price to past prices. This way, changes in directions and the highest and close prices can be calculated.  

POSITIONS BASEDPOSITIONS BASED  

These signals are based on the developments of existing positions. These signals are based on the developments of existing positions. 

DATE AND TIMEDATE AND TIME  

These signals are connected to certain dates or times. This way, you can create seasonal entries, for example. You can also create These signals are connected to certain dates or times. This way, you can create seasonal entries, for example. You can also create 
intraday strategies that are traded only within or outside of a certain time frame.intraday strategies that are traded only within or outside of a certain time frame.

INDICATORSINDICATORS  

This is the largest category. Here you can find all indicators included in the delivery. For each indicator, a folder with various signal This is the largest category. Here you can find all indicators included in the delivery. For each indicator, a folder with various signal 
variations is available. Crossings with lines, values or extremes, changes in directions and comparisons to historic values like variations is available. Crossings with lines, values or extremes, changes in directions and comparisons to historic values like 
averages are offered.averages are offered.

Trading ConditionsTrading Conditions
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CANDLESTICK PATTERNCANDLESTICK PATTERN  

Here you can find a number of candlestick patterns. For each pattern, a folder with various signal variations is available. Usually, Here you can find a number of candlestick patterns. For each pattern, a folder with various signal variations is available. Usually, 
these consist of bullish and bearish patterns. Some signals are also available with trend filters. these consist of bullish and bearish patterns. Some signals are also available with trend filters.   
  
Candlestick patterns offer one to two parameters. The first is used to define a candle body. The body is compared to the average Candlestick patterns offer one to two parameters. The first is used to define a candle body. The body is compared to the average 
candle body size of the given period. If a second parameter is available, it defines the period for an average that is used as trend candle body size of the given period. If a second parameter is available, it defines the period for an average that is used as trend 
filter. In this case, the pattern only causes a signal if it is complete and has the right position for the trend filter. filter. In this case, the pattern only causes a signal if it is complete and has the right position for the trend filter. 

CHART PATTERNCHART PATTERN  

Some common chart patterns are available here. For each pattern, a folder with a bullish and bearish pattern is available.Some common chart patterns are available here. For each pattern, a folder with a bullish and bearish pattern is available.

EDITING A GENERATED SYSTEMEDITING A GENERATED SYSTEM  

WITH THE WIZARDWITH THE WIZARD  

Any trading system generated in the Strategy Wizard can also be edited in the Strategy Wizard again. For this, rightAny trading system generated in the Strategy Wizard can also be edited in the Strategy Wizard again. For this, right--click on the click on the 
strategy in the chart legend or the toolbox to open the context menu, and select strategy in the chart legend or the toolbox to open the context menu, and select Edit with Strategy WizardEdit with Strategy WizardEdit with Strategy WizardEdit with Strategy Wizard. .   
  
In the Strategy Wizard, click on In the Strategy Wizard, click on EditEditEditEdit to edit the trading system. You can enter new conditions and rules or edit and delete old ones.  to edit the trading system. You can enter new conditions and rules or edit and delete old ones. 

MANUALLY IN THE EDITORMANUALLY IN THE EDITOR  

You can also open and edit a strategy in the You can also open and edit a strategy in the Equilla EditorEquilla Editor. However, please note that you will not be able to open the wizard for . However, please note that you will not be able to open the wizard for 
this strategy again if you made changes to it in the editor.this strategy again if you made changes to it in the editor.    
  
To open the trading system in the editor, rightTo open the trading system in the editor, right--click on the name of the strategy in the chart legend or the toolbar, and select click on the name of the strategy in the chart legend or the toolbar, and select EditEditEditEdit  
from the context menu. The from the context menu. The Equilla EditorEquilla Editor opens in which you can edit the source code.  opens in which you can edit the source code.   
  
A strategy may look as follows in the editor:A strategy may look as follows in the editor:  
  

// Automatically generated by the Trading Strategy Wizard (1541647255) 

 

Inputs:  

CandleRawBigWhitePeriod( 5 ), 

CandleRawBigBlackPeriod( 5 ), 

Price1( Close ), 

XAveragePeriod1( 30 ), 

XAveragePeriod2( 60 ); 

 

Variables:  
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TRUEVALUE_VAR1, 

XAVERAGE_VAR1, 

XAVERAGE_VAR2; 

 

TRUEVALUE_VAR1 = TrueValue( ); 

XAVERAGE_VAR1 = XAverage( Price1, XAveragePeriod1 ); 

XAVERAGE_VAR2 = XAverage( Price1, XAveragePeriod2 ); 

 

 

If CandleRawBigWhite( CandleRawBigWhitePeriod ) = TRUEVALUE_VAR1 Then 

Buy ( "Long Candle" ) Next Bar At Market; 

 

If CandleRawBigBlack( CandleRawBigBlackPeriod ) = TRUEVALUE_VAR1 Then 

Short ( "Short Candle" ) Next Bar At Market; 

 

If XAVERAGE_VAR1 Crosses Under XAVERAGE_VAR2 Then 

Sell ( "Long Exit" ) Next Bar At Market; 

 

If XAVERAGE_VAR1 Crosses Over XAVERAGE_VAR2 Then 

Cover Next Bar At Market; 
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MONEY MANAGEMENT 
Any method for sensible capital and risk management is assembled under Any method for sensible capital and risk management is assembled under 
the concept Money Management. You can use Money Management for the the concept Money Management. You can use Money Management for the 
following: following: 

l Setting the initial capital of a trading systemSetting the initial capital of a trading system  
l Setting the trading costsSetting the trading costs  
l Controlling the fundamental trading system functionsControlling the fundamental trading system functions  
l Controlling the alerts generated by the trading systemControlling the alerts generated by the trading system  
l Setting basic risk parametersSetting basic risk parameters  

Tradesignal offers Money Management functions for Tradesignal offers Money Management functions for ChartsCharts, , ScannersScanners, , 
PortfoliosPortfolios and  and WatchlistsWatchlists. You can also read them out with Equilla code . You can also read them out with Equilla code 
and use them in your own trading systems. This way, you always have and use them in your own trading systems. This way, you always have 
access to information like initial capital, trading costs etc. Other access to information like initial capital, trading costs etc. Other 
functionalities that are not part of the standard settings can be set up with functionalities that are not part of the standard settings can be set up with 
strategies that are partly included in the delivery.strategies that are partly included in the delivery.  

CONFIGURING THE MONEY MANAGEMENTCONFIGURING THE MONEY MANAGEMENT  

At the top of the properties window, select the At the top of the properties window, select the Money ManagementMoney ManagementMoney ManagementMoney Management entry to open the settings.  entry to open the settings. 

GENERALGENERAL  

Start DateStart DateStart DateStart Date  -- Here you can set a date at which the trade engine should start trading. If not set, it will start trading at the first  Here you can set a date at which the trade engine should start trading. If not set, it will start trading at the first 
available data point.available data point.  
  
End DateEnd DateEnd DateEnd Date  -- Here you can set a date at which the trade engine should stop trading. If not set, it will continue trading indefinitely. Here you can set a date at which the trade engine should stop trading. If not set, it will continue trading indefinitely.  
  
Initial CapitalInitial CapitalInitial CapitalInitial Capital  -- Here you can set the initial capital for the current trading system. This is an extremely important value for  Here you can set the initial capital for the current trading system. This is an extremely important value for 
calculating performance, profits, losses, etc. A system that is profitable for $100.000 might well be a losing system at $10.000.calculating performance, profits, losses, etc. A system that is profitable for $100.000 might well be a losing system at $10.000.  
  
Intrabar Tick Simulation %Intrabar Tick Simulation %Intrabar Tick Simulation %Intrabar Tick Simulation %  -- Enter the percentage of the price span (high Enter the percentage of the price span (high--low) that is used for the generation of an artificial tick low) that is used for the generation of an artificial tick 
in case of a stop or limit order being executed.in case of a stop or limit order being executed. This way, the behavior of the real price is simulated even though only the high,  This way, the behavior of the real price is simulated even though only the high, 
low, open and close values are available. The default value is "10%".low, open and close values are available. The default value is "10%".  
  
The The Generate OrdersGenerate OrdersGenerate OrdersGenerate Orders property specifies when orders can be generated by the running strategies. property specifies when orders can be generated by the running strategies.

l IntrabarIntrabarIntrabarIntrabar  -- Orders can be generated with every intra Orders can be generated with every intra--bar update (for every tick).bar update (for every tick).  
l On Bar CloseOn Bar CloseOn Bar CloseOn Bar Close  -- Orders can only be generated when the bar closes. This mode is especially useful when a signal might be  Orders can only be generated when the bar closes. This mode is especially useful when a signal might be 

invalidated before the bar closes, which typically happens when the signals are generated based on compressed chart types invalidated before the bar closes, which typically happens when the signals are generated based on compressed chart types 
like Point and Figure, Renko, Three Line Break and Kagi (these chart types can all remove bars resulting in trades being like Point and Figure, Renko, Three Line Break and Kagi (these chart types can all remove bars resulting in trades being 
executed at prices that may not be reflected in a bar when it is closed).executed at prices that may not be reflected in a bar when it is closed).  

Money ManagementMoney Management
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The The Realtime Price SourceRealtime Price SourceRealtime Price SourceRealtime Price Source property controls which prices are used to fill orders in real time. Tradesignal supports two modes:  property controls which prices are used to fill orders in real time. Tradesignal supports two modes: 
bid/askbid/ask and  and lastlast..

l Bid/AskBid/AskBid/AskBid/Ask  -- Tradesignal uses the best bid / best ask data provided by either the broker (if an order routing module has been  Tradesignal uses the best bid / best ask data provided by either the broker (if an order routing module has been 
connected) or the data provider. If neither the broker nor the data provider is delivering bid/ask prices, Tradesignal uses the connected) or the data provider. If neither the broker nor the data provider is delivering bid/ask prices, Tradesignal uses the 
last price instead (for example in the case of indices). Best bid and best ask prices are generated when a market participant last price instead (for example in the case of indices). Best bid and best ask prices are generated when a market participant 
wants to buy or sell a number of shares/contracts while a last price represents an actual trade that has been made. wants to buy or sell a number of shares/contracts while a last price represents an actual trade that has been made. 
Therefore this option has the benefit of more accurate fills for your orders. The caveat is however that the results collected in Therefore this option has the benefit of more accurate fills for your orders. The caveat is however that the results collected in 
real time will not match the results of backreal time will not match the results of back--testing which will always only use the last price.testing which will always only use the last price.  

l LastLastLastLast  --  Tradesignal uses the last price delivered by the data provider. This is the same price as the one used to backTradesignal uses the last price delivered by the data provider. This is the same price as the one used to back--test the test the 
strategy. A last tick represents a trade that has been made in the market. When using this mode, Tradesignal can only fill strategy. A last tick represents a trade that has been made in the market. When using this mode, Tradesignal can only fill 
and order after a trade has been made, even if there was a matching offer/request in the market prior to the trade. This and order after a trade has been made, even if there was a matching offer/request in the market prior to the trade. This 
mode ensures that real time results are closer to backmode ensures that real time results are closer to back--test results.test results.  

STATISTICS CURRENCYSTATISTICS CURRENCY  

When trading multiple instruments that are quoted in different currencies, aggregated statistic values can become meaningless.For When trading multiple instruments that are quoted in different currencies, aggregated statistic values can become meaningless.For 
example when adding the net profit of $5 and example when adding the net profit of $5 and ¥¥10 it is not enough to simply add the two numbers. In order to solve this both 10 it is not enough to simply add the two numbers. In order to solve this both 
values need to be converted to the same currency before adding them.This can be either of the two given currencies or a third one. values need to be converted to the same currency before adding them.This can be either of the two given currencies or a third one. 
In the example both values could be converted to $, In the example both values could be converted to $, ¥ ¥ or something else like or something else like €€..  
  
CurrencyCurrencyCurrencyCurrency  --  The currency global statistic values should be calculated in. The available currencies are depended on your selected The currency global statistic values should be calculated in. The available currencies are depended on your selected 
data provider.data provider.  
  
Calculation ModeCalculation ModeCalculation ModeCalculation Mode  --  Selects the method that is used to calculate the currency conversion factors for the current bar.Selects the method that is used to calculate the currency conversion factors for the current bar.

l Close of Previous BarClose of Previous BarClose of Previous BarClose of Previous Bar  --  Use the currency values at the close of the previous bar.Use the currency values at the close of the previous bar.  
l Arithmetic MeanArithmetic MeanArithmetic MeanArithmetic Mean  --  Calculates the arithmetic mean of Open, High, Low and Close at the current bar.Calculates the arithmetic mean of Open, High, Low and Close at the current bar.  
l MidrangeMidrangeMidrangeMidrange  --  Uses the average of the highest and lowest currency value at the current bar.Uses the average of the highest and lowest currency value at the current bar.  
l Arithmetic Mean without OpenArithmetic Mean without OpenArithmetic Mean without OpenArithmetic Mean without Open  --  The average of High, Low and Close currency values at the current bar.The average of High, Low and Close currency values at the current bar.  
l Close Weighted MeanClose Weighted MeanClose Weighted MeanClose Weighted Mean  --  Calculate the arithmetic mean of High, Low and 2x Close at the current bar.Calculate the arithmetic mean of High, Low and 2x Close at the current bar.  
l Open Weighted MeanOpen Weighted MeanOpen Weighted MeanOpen Weighted Mean  --  Calculate the arithmetic mean of 2x Open, High and Low at the current bar.Calculate the arithmetic mean of 2x Open, High and Low at the current bar.  

Apply To RiskApply To RiskApply To RiskApply To Risk  --  When this option is enabled currency conversion options will also be applied to automatic stop calculations.All When this option is enabled currency conversion options will also be applied to automatic stop calculations.All 
numeric values in the numeric values in the Slippage and CommissionSlippage and Commission and the  and the RiskRisk sections are assumed to be given in the global statistics currency. sections are assumed to be given in the global statistics currency.

SLIPPAGE AND COMMISSIONSLIPPAGE AND COMMISSION  

For realistic results in the backtest and the performance evaluation of a trading system, it is important to include the trading costs For realistic results in the backtest and the performance evaluation of a trading system, it is important to include the trading costs 
in the calculation. Two parameters are available: in the calculation. Two parameters are available: 

SLIPPAGESLIPPAGE  

The slippage is the possible difference between the price at the trading signal and the real price at order execution. Usually, some The slippage is the possible difference between the price at the trading signal and the real price at order execution. Usually, some 
time passes between the order signal and the actual order execution, in which the price might move against the trader. You can time passes between the order signal and the actual order execution, in which the price might move against the trader. You can 
enter the slippage per trade or share. enter the slippage per trade or share.   
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Slippage/TradeSlippage/TradeSlippage/TradeSlippage/Trade  --  Assumed Slippage per Order (independent of the number of shares), either as absolute number or as percent Assumed Slippage per Order (independent of the number of shares), either as absolute number or as percent 
value (for this, enter a % character after the number).value (for this, enter a % character after the number).  
  
Slippage/ShareSlippage/ShareSlippage/ShareSlippage/Share  --  Assumed Slippage per Shares (independent of the number of trades), either as absolute number or as percent Assumed Slippage per Shares (independent of the number of trades), either as absolute number or as percent 
value (for this, enter a % character after the number).value (for this, enter a % character after the number).

COMMISSIONCOMMISSION  

The commission includes all costs of the stock exchange and broker. You can enter the commission per trade or share. In addition, The commission includes all costs of the stock exchange and broker. You can enter the commission per trade or share. In addition, 
you can enter a commission flat rate, if your broker offers such trading conditions.you can enter a commission flat rate, if your broker offers such trading conditions.  
  
Commission/TradeCommission/TradeCommission/TradeCommission/Trade  --  Commission per order (independent of the number of shares), either as absolute number or as percent value Commission per order (independent of the number of shares), either as absolute number or as percent value 
(for this, enter a % character after the number).(for this, enter a % character after the number).  
  
Commission/ShareCommission/ShareCommission/ShareCommission/Share  --  Commission per shares (independent of the number of trades), either as absolute number or as percent value Commission per shares (independent of the number of trades), either as absolute number or as percent value 
(for this, enter a % character after the number).(for this, enter a % character after the number).  
  
Min. CommissionMin. CommissionMin. CommissionMin. Commission  -- Minimum commission costs per order (if set by your broker). Minimum commission costs per order (if set by your broker).  
  
Max. CommissionMax. CommissionMax. CommissionMax. Commission  -- Maximum commission costs per order (if set by your broker). Maximum commission costs per order (if set by your broker).

POSITION SIZINGPOSITION SIZING  

Default QuantityDefault QuantityDefault QuantityDefault Quantity  -- Enter the minimum number of shares that should be traded per order. Enter the minimum number of shares that should be traded per order.  
  
Max SharesMax SharesMax SharesMax Shares  -- Enter the maximum number of shares for this position (maximum position size). Orders that would lead to a higher  Enter the maximum number of shares for this position (maximum position size). Orders that would lead to a higher 
position size will not get placed.position size will not get placed.  
  
PyramidingPyramidingPyramidingPyramiding  -- Some trading systems work with position legs, meaning that after a first trading signal, newer signals will lead to  Some trading systems work with position legs, meaning that after a first trading signal, newer signals will lead to 
further trading activities depending on the market movement. For example, the position size may be increased or decreased for a further trading activities depending on the market movement. For example, the position size may be increased or decreased for a 
high volatility. As default, this option is inactive. If you choose pyramiding, two settings are available:high volatility. As default, this option is inactive. If you choose pyramiding, two settings are available:

l Yes, DifferentYes, DifferentYes, DifferentYes, Different  -- Further shares will be purchased in case of trading signals different to the one that caused the first action. Further shares will be purchased in case of trading signals different to the one that caused the first action.  
l Yes, AllYes, AllYes, AllYes, All  -- Further shares will be purchased in case of trading signals of any kind. Further shares will be purchased in case of trading signals of any kind.  

If you select pyramiding, you can enter a maximum number of open entries (If you select pyramiding, you can enter a maximum number of open entries (Max. Open EntriesMax. Open EntriesMax. Open EntriesMax. Open Entries).).

RISKRISK  

Here you can find static risk settings like Stop Loss and Trailing Stop and also more dynamic parameters. In the following, the Here you can find static risk settings like Stop Loss and Trailing Stop and also more dynamic parameters. In the following, the 
parameters in the Money Management properties and their corresponding parameters in the Money Management properties and their corresponding Equilla functionsEquilla functions are given. are given.  
  
Stop ModeStop ModeStop ModeStop Mode  -- Stop Mode has to be chosen in combination with the Stop Loss and Trailing Stop.  Stop Mode has to be chosen in combination with the Stop Loss and Trailing Stop. 

l In In ContractContractContractContract mode (corresponding to  mode (corresponding to ShareShareShareShare), the settings of Stop Loss and Trailing Stop are interpreted in relation to each ), the settings of Stop Loss and Trailing Stop are interpreted in relation to each 
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share. For example, a Stop Loss of "100" is taken into account for each contract, independent of the position size. If the price share. For example, a Stop Loss of "100" is taken into account for each contract, independent of the position size. If the price 
drops by 100 from the starting value, the Stop Loss is set off.drops by 100 from the starting value, the Stop Loss is set off.  

l In In PositionPositionPositionPosition mode, the settings of Stop Loss and Trailing Stop are interpreted in relation to the complete position. For  mode, the settings of Stop Loss and Trailing Stop are interpreted in relation to the complete position. For 
example, a Stop Loss of "100" will cause a position to be closed when the total loss is 100. This might actually be four example, a Stop Loss of "100" will cause a position to be closed when the total loss is 100. This might actually be four 
points per share for Futures or one dollar for one hundred stocks.points per share for Futures or one dollar for one hundred stocks.  

SetStopMode(Mode) 

SetStopShare // Alias to SetStopContract 

SetStopContract 

SetStopPosition 

  
  
Profit TargetProfit TargetProfit TargetProfit Target  -- This value in currency or points (depending on the security) gives the profit the position has to reach to be closed  This value in currency or points (depending on the security) gives the profit the position has to reach to be closed 
instantly. Profit targets may help you to stabilize your trading results over a longer time span. instantly. Profit targets may help you to stabilize your trading results over a longer time span.   
  

SetStopProfitTarget(Value) 

  
  
Stop LossStop LossStop LossStop Loss  -- This value in currency or points (depending on the security) gives the maximum acceptable loss after the entry, at  This value in currency or points (depending on the security) gives the maximum acceptable loss after the entry, at 
which point the position is instantly closed. A Stop Loss can protect you from overly high losses and secure your financial ability to which point the position is instantly closed. A Stop Loss can protect you from overly high losses and secure your financial ability to 
act in the future. act in the future.   
  

SetStopLoss(Value) 

  
  
Break EvenBreak EvenBreak EvenBreak Even  -- This value in currency or points (depending on the security) gives the profit of the position that has to be reached  This value in currency or points (depending on the security) gives the profit of the position that has to be reached 
before a position is closed once the market moves against it. It is based on the idea that positions that were once in the profit area before a position is closed once the market moves against it. It is based on the idea that positions that were once in the profit area 
should notshould not move into a loss. Instead, they are closed, for example to cover the trading expenses. move into a loss. Instead, they are closed, for example to cover the trading expenses.  

SetStopBreakEven(Value) 

  
  
Profit TrailingProfit TrailingProfit TrailingProfit Trailing  -- This value in currency or points (depending on the security) gives the maximum drawback of a position profit  This value in currency or points (depending on the security) gives the maximum drawback of a position profit 
before the position is closed. This is a simple method with which to avoid losing achieved profit.before the position is closed. This is a simple method with which to avoid losing achieved profit.    
  

SetStopProfitTrailing(Value) 

  
  
% Trailing (Floor)% Trailing (Floor)% Trailing (Floor)% Trailing (Floor)  -- This is a more flexible version of the Profit Trailing stop. With the Floor parameter you enter a profit target at  This is a more flexible version of the Profit Trailing stop. With the Floor parameter you enter a profit target at 
which the trailing stop will get activated. With the which the trailing stop will get activated. With the % Trailing (%)% Trailing (%)% Trailing (%)% Trailing (%) parameter you set the maximum loss (in percent) of the  parameter you set the maximum loss (in percent) of the 
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position profit before the position is closed.position profit before the position is closed.    
  

SetStopPercentTrailing(ProfitTarget, PercentLoss) 

  
  
Include Commission/SlippageInclude Commission/SlippageInclude Commission/SlippageInclude Commission/Slippage  -- Here you can choose whether the values for commission and slippage you entered in the above  Here you can choose whether the values for commission and slippage you entered in the above 
areas of the Money Management should be taken into account for the risk calculation.areas of the Money Management should be taken into account for the risk calculation.

ALERTSALERTS  

Here you can select four possible situations (Order added, changed, cancelled, filled) in which an alert shall be issued. You can Here you can select four possible situations (Order added, changed, cancelled, filled) in which an alert shall be issued. You can 
find more information in the find more information in the AlertsAlerts chapter. chapter.

STRATEGIES FOR MONEY MANAGEMENTSTRATEGIES FOR MONEY MANAGEMENT  

In the scope of delivery for Tradesignal, several strategiesIn the scope of delivery for Tradesignal, several strategies can be found that you can use for Money Management. can be found that you can use for Money Management.  

STOPS AND EXITSSTOPS AND EXITS  

Fast Profit ExitFast Profit Exit  -- Exits a position if it yields profit the day after entry. Exits a position if it yields profit the day after entry.    
  
Peak ExitPeak Exit  -- Exits a position if it made a profit and the trade changes direction against you. It is based on a complex calculation that  Exits a position if it made a profit and the trade changes direction against you. It is based on a complex calculation that 
includes an Average True Range indicator. includes an Average True Range indicator.   
  
Percent Trailing StopPercent Trailing Stop  -- Corresponds to the setting in the Money Management area.  Corresponds to the setting in the Money Management area.   
  
Profit Target ExitProfit Target Exit  -- Corresponds to the setting in the Money Management area.  Corresponds to the setting in the Money Management area.   
  
Profit Trailing StopProfit Trailing Stop  -- Corresponds to the simple Trailing Stop in the Money Management area.  Corresponds to the simple Trailing Stop in the Money Management area.   
  
Stop LossStop Loss  -- Corresponds to the Stop Loss setting in the Money Management area. Corresponds to the Stop Loss setting in the Money Management area.  
  
Timed ExitTimed Exit  -- Exits a position at a given time of day, e.g. "1900". Exits a position at a given time of day, e.g. "1900".    
  
Timed Exit (Bars)Timed Exit (Bars)  -- Exits the position at a given number of trading periods.  Exits the position at a given number of trading periods. 

POSITION SIZINGPOSITION SIZING  

Position Sizing Position Sizing -- Fixed Fractional Fixed Fractional  -- Sets the position size depending on given fractions of capital.  Sets the position size depending on given fractions of capital.   
  
Position Sizing Position Sizing -- Fixed Fractional Percent Fixed Fractional Percent  -- Uses a combination of the method above and other methods to define the fraction size.  Uses a combination of the method above and other methods to define the fraction size.   
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Position Sizing Position Sizing -- Fixed Percent Fixed Percent  -- Uses a defined percentage of the capital for defining the position size.  Uses a defined percentage of the capital for defining the position size.   
  
Position Sizing Position Sizing -- Fixed Risk Fixed Risk  -- Measures the volatility in the market and scales the position size accordingly. Especially useful in  Measures the volatility in the market and scales the position size accordingly. Especially useful in 
combination with a Volatility Stop. combination with a Volatility Stop.   
  
Position Sizing Position Sizing -- Market's Money Market's Money  -- Sets the position size depending on the performance of the trading system. If the total  Sets the position size depending on the performance of the trading system. If the total 
performance is in the profitable area, more positions are entered. If the performance is negative, the position size is reduced.performance is in the profitable area, more positions are entered. If the performance is negative, the position size is reduced.    
  
Position Sizing Position Sizing -- Percent Volatility Percent Volatility  -- This is a variant of the Fixed Risk method, in which position sizing is scaled depending on the  This is a variant of the Fixed Risk method, in which position sizing is scaled depending on the 
volatility of the market.volatility of the market.

MONEY MANAGEMENT AND EQUILLAMONEY MANAGEMENT AND EQUILLA  

Several parameters that have to do with Money Management can be read out or set with Equilla commands. This way, you are in Several parameters that have to do with Money Management can be read out or set with Equilla commands. This way, you are in 
complete control of share numbers, open prices, commissions and slippage. complete control of share numbers, open prices, commissions and slippage.   
  
Read slippage: Read slippage:   
  

//Gives the slippage according to the Money Management parameters 

Value1 = Slippage( Price, Quantity ); 

  
  
Read commission: Read commission:   
  

//Gives the commission according to the Money Management parameters  

Value1 = Commission( Price, Quantity); 

  
  
Read initial capital: Read initial capital:   
  

//Gives the initial capital according to the Money Management parameters 

Value1 = InitalCapital; 

  
  
In addition, you can read out many more parameters of open and close positions. See the chapter In addition, you can read out many more parameters of open and close positions. See the chapter Equilla FunctionsEquilla Functions for more  for more 
information.information.

EXAMPLE: PARAMETERS FOR A SIMPLE TRADING SYSTEMEXAMPLE: PARAMETERS FOR A SIMPLE TRADING SYSTEM  
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The following parameters could be used for a trading system with Money Management based on Candlestick Engulfing Patterns:The following parameters could be used for a trading system with Money Management based on Candlestick Engulfing Patterns:  
  
Chart: Chart: 

l .NDX.X.NDX.X.NDX.X.NDX.X  
l History LengthHistory LengthHistory LengthHistory Length in the chart properties to "2000" in the chart properties to "2000"  

Strategies:Strategies:

l Candle Bearish Engulfing Candle Bearish Engulfing Candle Bearish Engulfing Candle Bearish Engulfing ---- Entry Entry Entry Entry  
l Candle Bullish Engulfing Candle Bullish Engulfing Candle Bullish Engulfing Candle Bullish Engulfing ---- Entry Entry Entry Entry  

Money Management:Money Management:

l Slippage/TradeSlippage/TradeSlippage/TradeSlippage/Trade to 2 points to 2 points  
l Commission/TradeCommission/TradeCommission/TradeCommission/Trade to 2 points to 2 points  
l Default QuantityDefault QuantityDefault QuantityDefault Quantity to 10 contracts to 10 contracts  

l Stop ModeStop ModeStop ModeStop Mode to "Contract" to "Contract"  
l Profit TargetProfit TargetProfit TargetProfit Target activate with a value of "225" (click on the number next to the checkbox and edit it) activate with a value of "225" (click on the number next to the checkbox and edit it)  
l Stop LossStop LossStop LossStop Loss activate with a value of "40" (click on the number next to the checkbox and edit it) activate with a value of "40" (click on the number next to the checkbox and edit it)  
l % Trailing (Floor)% Trailing (Floor)% Trailing (Floor)% Trailing (Floor) to 75 points to 75 points  
l % Trailing (%)% Trailing (%)% Trailing (%)% Trailing (%) to 5 points to 5 points  

Now a first trading system is configured. You can find more strategies for Stops, Position Sizing and Statistics under Now a first trading system is configured. You can find more strategies for Stops, Position Sizing and Statistics under Add StrategyAdd StrategyAdd StrategyAdd Strategy  
in the toolbar.in the toolbar.    
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PORTFOLIO 
The Portfolio in Tradesignal is a basket of securities that are traded by one The Portfolio in Tradesignal is a basket of securities that are traded by one 
or more trading systems. You can use the Portfolio to do the following: or more trading systems. You can use the Portfolio to do the following: 

l Trade several securities in a trading system.Trade several securities in a trading system.  
l Use trading systems for a list of securitiesUse trading systems for a list of securities  
l Trade an account of several securities by defined rules for money Trade an account of several securities by defined rules for money 

and risk managementand risk management  
l Trade with trading systems automatically via a brokerTrade with trading systems automatically via a broker  

Like the Watchlist, the Portfolio is updated automatically. The data is Like the Watchlist, the Portfolio is updated automatically. The data is 
displayed in realtime. The cells with the latest changed values are displayed in realtime. The cells with the latest changed values are 
displayed with colored background. displayed with colored background.   
  
The important difference from Scanner and Watchlist is that the Portfolio handles the included instruments as a whole. This results The important difference from Scanner and Watchlist is that the Portfolio handles the included instruments as a whole. This results 
in the following:in the following:

l In indicators and strategies, you can access data of other instruments in the Portfolio. (This is not possible in a Watchlist.)In indicators and strategies, you can access data of other instruments in the Portfolio. (This is not possible in a Watchlist.)  
l Indicators and strategies are each applied to all instruments in the Portfolio. For example, indicator 1 is applied to all Indicators and strategies are each applied to all instruments in the Portfolio. For example, indicator 1 is applied to all 

instruments, then indicator 2 etc. This allows you using scripts to filter the instruments for the next steps. This is also the instruments, then indicator 2 etc. This allows you using scripts to filter the instruments for the next steps. This is also the 
reason why a Portfolio cannot be displayed in a chart. (In comparison, in the Scanner, Watchlist and Chart, the reason why a Portfolio cannot be displayed in a chart. (In comparison, in the Scanner, Watchlist and Chart, the 
indicators/strategies are applied to each instrument, i.e. indicator 1 and 2 to instrument A, then both to instrument B etc.)indicators/strategies are applied to each instrument, i.e. indicator 1 and 2 to instrument A, then both to instrument B etc.)  

l The Money Management in the Portfolio refers to the complete Portfolio. (In Scanner and Watchlist, the Money The Money Management in the Portfolio refers to the complete Portfolio. (In Scanner and Watchlist, the Money 
Management applies to the single instruments.)Management applies to the single instruments.)  

For the idea of using scripts as filters in the Portfolio analysis, two strategies are available in Tradesignal: "Portfolio Top Dogs For the idea of using scripts as filters in the Portfolio analysis, two strategies are available in Tradesignal: "Portfolio Top Dogs 
Picker" and "Portfolio Top Dogs Trader". First, apply the picker to pick the ten best instruments of the last year and invest into them Picker" and "Portfolio Top Dogs Trader". First, apply the picker to pick the ten best instruments of the last year and invest into them 
in equal shares, then use the trader to trade these ten instruments. in equal shares, then use the trader to trade these ten instruments.   
  
The document type Portfolio has the following design parameters:The document type Portfolio has the following design parameters:

l The maximum history length (in this case of the equity chart) is 500000.The maximum history length (in this case of the equity chart) is 500000.  
l The maximum number of instruments is 101.The maximum number of instruments is 101.  
l The maximum number of indicators/strategies is 32.The maximum number of indicators/strategies is 32.  
l Indicators and strategies are processed vertically, i.e. each is applied to all instruments before the next indicator/strategy is Indicators and strategies are processed vertically, i.e. each is applied to all instruments before the next indicator/strategy is 

applied (see above).applied (see above).  

PORTFOLIO SETUPPORTFOLIO SETUP  

You can open a Portfolio with symbols in various ways.You can open a Portfolio with symbols in various ways.

WITH THE WIZARDWITH THE WIZARD  

When choosing one of the following methods, the wizard will open: When choosing one of the following methods, the wizard will open: 

PortfolioPortfolio



:: www.tradesignal.comwww.tradesignal.com

Tradesignal GmbHTradesignal GmbH Page 216Page 216 Version 7.0Version 7.0

l Click on the Click on the PortfolioPortfolioPortfolioPortfolio button in the  button in the InsertInsert tab of the toolbar. tab of the toolbar.  
l In the file menu, select In the file menu, select NewNewNewNew (key shortcut  (key shortcut Ctrl+Shift+NCtrl+Shift+NCtrl+Shift+NCtrl+Shift+N) to open the Create Item Wizard. Select ) to open the Create Item Wizard. Select PortfolioPortfolioPortfolioPortfolio..  
l Open the context menu of a symbol list in the toolbox and choose the entry Open the context menu of a symbol list in the toolbox and choose the entry Open in PortfolioOpen in PortfolioOpen in PortfolioOpen in Portfolio. (If selecting this for a single . (If selecting this for a single 

symbol, it opens without a wizard.)symbol, it opens without a wizard.)  

The Create Item wizard opens, in which you can select indicators and strategies in two more steps. Click on The Create Item wizard opens, in which you can select indicators and strategies in two more steps. Click on DoneDoneDoneDone to close the  to close the 
wizard and save the settings. wizard and save the settings. 

ADDING ONE OR MORE SYMBOLS MANUALLYADDING ONE OR MORE SYMBOLS MANUALLY  

You can also add single symbols or open a new Portfolio without using the wizard. You can also add single symbols or open a new Portfolio without using the wizard. 

l Open the context menu of a symbol or symbol list in the toolbox and choose the entry Open the context menu of a symbol or symbol list in the toolbox and choose the entry Insert SymbolInsert SymbolInsert SymbolInsert Symbol to add it to the active  to add it to the active 
Portfolio.Portfolio.  

l In the command line, enter a symbol shortcut, e.g. "DD NYS" and select In the command line, enter a symbol shortcut, e.g. "DD NYS" and select Add SymbolAdd SymbolAdd SymbolAdd Symbol to add it to a Portfolio, or  to add it to a Portfolio, or New New New New 
PortfolioPortfolioPortfolioPortfolio for a new one. for a new one.  

l Via the symbol search. For this, click on the Via the symbol search. For this, click on the searchsearch button and select  button and select Insert the symbol into the selected workspace Insert the symbol into the selected workspace Insert the symbol into the selected workspace Insert the symbol into the selected workspace 
itemitemitemitem to add it to the Portfolio, or  to add it to the Portfolio, or Create a new PortfolioCreate a new PortfolioCreate a new PortfolioCreate a new Portfolio for a new one. for a new one.  

l You can also add symbols to a Portfolio via drag&drop from the toolbox or other documents.You can also add symbols to a Portfolio via drag&drop from the toolbox or other documents.  

The The History LengthHistory LengthHistory LengthHistory Length (candles/bars) that is regularly taken into account is 2. When you add an indicator, the length may be  (candles/bars) that is regularly taken into account is 2. When you add an indicator, the length may be 
increased if necessary for the indicator calculation. E.g., the Chande Momentum Oscillator sets the length to 16. If you go below increased if necessary for the indicator calculation. E.g., the Chande Momentum Oscillator sets the length to 16. If you go below 
this necessary length, indicators may not give results anymore. In this case, increase the length again. this necessary length, indicators may not give results anymore. In this case, increase the length again.   
  
When you select a symbol list (e.g. the Nasdaq), please ensure that the index itself is not included in the Portfolio. It makes no When you select a symbol list (e.g. the Nasdaq), please ensure that the index itself is not included in the Portfolio. It makes no 
sense to include an index in a list of symbols when searching for optimal trading parameters.sense to include an index in a list of symbols when searching for optimal trading parameters.

PORTFOLIO PROPERTIESPORTFOLIO PROPERTIES  

In the properties manager, you can edit the portfolio Properties. Important parameters are:In the properties manager, you can edit the portfolio Properties. Important parameters are:  
  
History LengthHistory LengthHistory LengthHistory Length  --  Enter the length of the history here (max. 500000).Enter the length of the history here (max. 500000).  
  
Min. Referenced BarsMin. Referenced BarsMin. Referenced BarsMin. Referenced Bars  --  Enter the minimum number of bars that should be used for calculating the values of indicators and Enter the minimum number of bars that should be used for calculating the values of indicators and 
strategies.strategies.  
  
In the In the IndicationsIndications area, you can enter the colors for changing values in the table. area, you can enter the colors for changing values in the table.  
  
Update IndicationsUpdate IndicationsUpdate IndicationsUpdate Indications  ––  Set the background color for table cells with values changed since the last update, e.g. gray. Set the background color for table cells with values changed since the last update, e.g. gray. Up MoveUp MoveUp MoveUp Move and  and 
Down MoveDown MoveDown MoveDown Move  ––  Set the colors for increasing/decreasing values, e.g. green for up, red for down.Set the colors for increasing/decreasing values, e.g. green for up, red for down.  
  
In the areas In the areas Equity ColorsEquity Colors and  and Equity Chart AppearanceEquity Chart Appearance, you can change the settings for the equity chart., you can change the settings for the equity chart.

SAVING, RESTORING AND RESETTING DEFAULT SETTINGSSAVING, RESTORING AND RESETTING DEFAULT SETTINGS  
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In the appearance area, you can find two important buttons. In the appearance area, you can find two important buttons. 

l Disk button (Save as Default) Disk button (Save as Default) --  Click here to save your current settings as the new default settings.Click here to save your current settings as the new default settings.  
l Restore button (Restore Default Settings, circled arrow) Restore button (Restore Default Settings, circled arrow) --  Click here to reset all settings to the default settings.Click here to reset all settings to the default settings.  

Not all settings can be saved like this. Not all settings can be saved like this. 

l The standard period and other user interface settings are entered in the The standard period and other user interface settings are entered in the Tradesignal OptionsTradesignal Options..  
l In the Portfolio, the order may be subject to changes depending on e.g. changing prices. In the In the Portfolio, the order may be subject to changes depending on e.g. changing prices. In the advanced Tradesignal advanced Tradesignal 

OptionsOptions, parameter , parameter Keep rows sorted in Portfolio and Watchlist (Secs.)Keep rows sorted in Portfolio and Watchlist (Secs.)Keep rows sorted in Portfolio and Watchlist (Secs.)Keep rows sorted in Portfolio and Watchlist (Secs.), you can set the time in seconds after which , you can set the time in seconds after which 
your original sorting order will be applied to the rows again. You can also can enter default values for the history length in your original sorting order will be applied to the rows again. You can also can enter default values for the history length in 
Portfolio Default History LengthPortfolio Default History LengthPortfolio Default History LengthPortfolio Default History Length, for daily, intraday and tick lists., for daily, intraday and tick lists.  

To restore the original default settings of your Tradesignal installation, click on the To restore the original default settings of your Tradesignal installation, click on the Restore Default SettingsRestore Default SettingsRestore Default SettingsRestore Default Settings button in the  button in the 
Tradesignal OptionsTradesignal Options..

DELETING SYMBOLS FROM A PORTFOLIODELETING SYMBOLS FROM A PORTFOLIO  

You can delete symbols from a portfolio.You can delete symbols from a portfolio.  

1.1. Select the symbols. You have the following options:Select the symbols. You have the following options:

¡ Press Press Ctrl+ACtrl+ACtrl+ACtrl+A to select all. to select all.  
¡ Press Press CtrlCtrlCtrlCtrl and click on single instruments to select them. and click on single instruments to select them.  
¡ Press Press ShiftShiftShiftShift and click on two instruments to select the instruments between them.. and click on two instruments to select the instruments between them..  

2.2. Press the Press the DelDelDelDel key to delete the selected instruments. key to delete the selected instruments.  

PORTFOLIO BUTTONS IN THE TOOLBARPORTFOLIO BUTTONS IN THE TOOLBAR  

PeriodPeriodPeriodPeriod  -- Here you can set the period that is to be used in the Portfolio (this  Here you can set the period that is to be used in the Portfolio (this 
corresponds to the period settings for a chart). The symbols in the Portfolio corresponds to the period settings for a chart). The symbols in the Portfolio 
are always called up with the default period at first. are always called up with the default period at first.   
  
ColumnsColumnsColumnsColumns  -- Open the menu for the column settings of the Portfolio.  Open the menu for the column settings of the Portfolio.   
  
Set GroupSet GroupSet GroupSet Group  -- Here you can group the parameters for better overview. Select  Here you can group the parameters for better overview. Select 
a number of rows in the table and click on the button. You can now enter a name for the group. A button appears on top of the a number of rows in the table and click on the button. You can now enter a name for the group. A button appears on top of the 
table that allows you to open/close the group views like a folder tree in Windows Explorer. table that allows you to open/close the group views like a folder tree in Windows Explorer. 

COLUMNS IN THE PORTFOLIOCOLUMNS IN THE PORTFOLIO  

The table shows different columns depending on the indicators and strategies you are using. The number of columns added for The table shows different columns depending on the indicators and strategies you are using. The number of columns added for 
each indicator or strategy depends on the number of output data. each indicator or strategy depends on the number of output data. 

l For each indicator, all columns with a nonFor each indicator, all columns with a non--static output are displayed. For example, for the "Bollinger Band" indicator there static output are displayed. For example, for the "Bollinger Band" indicator there 
are three columns, for the "Elder Ray" indicator two columns (and two invisible columns with static values).are three columns, for the "Elder Ray" indicator two columns (and two invisible columns with static values).  

Portfolio buttons in the toolbarPortfolio buttons in the toolbar
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l For strategies, the two columns "Position" and "Position Size" are displayed over all strategies. The parameters of the single For strategies, the two columns "Position" and "Position Size" are displayed over all strategies. The parameters of the single 
strategies are usually set to invisible in the Equilla code ("visuals" are "inactive"). If they were displayed, they might also strategies are usually set to invisible in the Equilla code ("visuals" are "inactive"). If they were displayed, they might also 
interfere with the statistics, which is usually not desired. When at least one strategy is available, you can add columns for interfere with the statistics, which is usually not desired. When at least one strategy is available, you can add columns for 
statistical output like "Total Net Profit".statistical output like "Total Net Profit".  

SORTING THE COLUMNSSORTING THE COLUMNS  

You can sort the columns in the Portfolio by clicking on the column header. A little triangle appears, pointing up or down You can sort the columns in the Portfolio by clicking on the column header. A little triangle appears, pointing up or down 
depending on the sorting direction. To change the direction, click on the column header again. depending on the sorting direction. To change the direction, click on the column header again.   
  
Alternatively, rightAlternatively, right--click into the column and select the sort direction in the context menu. click into the column and select the sort direction in the context menu. 

COLUMN GROUPINGCOLUMN GROUPING  

This function in the This function in the ColumnsColumns button menu leads to a new row in the table top. If groups are already defined, a button appears for  button menu leads to a new row in the table top. If groups are already defined, a button appears for 
them. them.   
  
You can start a group by dragging a table row in this new row at the table top, or by selecting a row and clicking on You can start a group by dragging a table row in this new row at the table top, or by selecting a row and clicking on Set GroupSet GroupSet GroupSet Group  
under under Home > Table > ColumnsHome > Table > Columns on the toolbar. on the toolbar.

ADD/REMOVE COLUMNSADD/REMOVE COLUMNS  

With this function in the With this function in the ColumnsColumns button menu you can set columns in the table to visible or invisible. button menu you can set columns in the table to visible or invisible.  
  
In the list, all available columns are sorted by categories. Standard columns like price or symbol information are available, as well In the list, all available columns are sorted by categories. Standard columns like price or symbol information are available, as well 
as a large numbers of statistical values for trading systems. If an indicator offers additional information, it appears as an entry here as a large numbers of statistical values for trading systems. If an indicator offers additional information, it appears as an entry here 
too. too.   
  
Select the entries for all columns you want to display, or click on Select the entries for all columns you want to display, or click on Show AllShow AllShow AllShow All for selecting all entries. for selecting all entries.

MANAGE STRATEGIES AND INDICATORSMANAGE STRATEGIES AND INDICATORS  

With this function in the With this function in the ColumnsColumns button menu you can button menu you can  

l set the processing order of the indicators and strategies by selecting an entry and clicking on set the processing order of the indicators and strategies by selecting an entry and clicking on Sort AscendingSort AscendingSort AscendingSort Ascending or  or Sort Sort Sort Sort 
DescendingDescendingDescendingDescending. Remember that indicators/strategies are processed vertically, i.e. each is applied to all instruments before the . Remember that indicators/strategies are processed vertically, i.e. each is applied to all instruments before the 
next indicator/strategy is applied.next indicator/strategy is applied.  

l delete indicators and strategies by selecting an entry and clicking on delete indicators and strategies by selecting an entry and clicking on RemoveRemoveRemoveRemove..  

FORMAT OPTIONSFORMAT OPTIONS  

In the Portfolio, the following In the Portfolio, the following FormatFormat buttons are available in the toolbar. buttons are available in the toolbar.  
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StylesStylesStylesStyles  -- Here you can set the display options of the table, e.g. gray background with orange and yellow text. You can find more  Here you can set the display options of the table, e.g. gray background with orange and yellow text. You can find more 
information in the chapter information in the chapter StylesStyles..  
  
SessionsSessionsSessionsSessions  -- Here you can set the trading times. You can find more information in the chapter  Here you can set the trading times. You can find more information in the chapter Sessions, Holidays and PropertiesSessions, Holidays and Properties..  
  
Price EditorPrice EditorPrice EditorPrice Editor  -- Here you can manually edit prices of symbols. You can find more information in the chapter  Here you can manually edit prices of symbols. You can find more information in the chapter Price EditorPrice Editor..

ANALYZE THE PORTFOLIOANALYZE THE PORTFOLIO  

You can apply indicators and strategies to the Portfolio. In addition, the Portfolio contents can be combined with other functions. You can apply indicators and strategies to the Portfolio. In addition, the Portfolio contents can be combined with other functions. 

OPTIMIZE A STRATEGY IN A PORTFOLIOOPTIMIZE A STRATEGY IN A PORTFOLIO  

You can start the You can start the OptimizerOptimizer directly from within the Portfolio. This way, you can optimize the strategies for all symbols of the  directly from within the Portfolio. This way, you can optimize the strategies for all symbols of the 
Portfolio. Portfolio.   
  
Click on the button Click on the button OptimizeOptimizeOptimizeOptimize in the group  in the group StrategiesStrategies of the toolbar to start the Optimizer. You have the choice between several  of the toolbar to start the Optimizer. You have the choice between several 
methods, and you can choose the parameters that should be used for optimizing. The Optimizer then runs through all chosen methods, and you can choose the parameters that should be used for optimizing. The Optimizer then runs through all chosen 
parameters for the symbols included in the Portfolio. parameters for the symbols included in the Portfolio.   
  
You can find more information in the chapter You can find more information in the chapter OptimizerOptimizer..

ACTIVATE THE ORDER ROUTING FOR A PORTFOLIOACTIVATE THE ORDER ROUTING FOR A PORTFOLIO  

You can use Automatic Order Routing for a Portfolio. The following You can use Automatic Order Routing for a Portfolio. The following 
conditions have to be met:conditions have to be met:

l The Order Routing has to be set up correctly. See the chapter The Order Routing has to be set up correctly. See the chapter 
Automatic Order RoutingAutomatic Order Routing..  

l The Option The Option Strategy Automation OptionStrategy Automation OptionStrategy Automation OptionStrategy Automation Option has to be set. For this,  has to be set. For this, 
click on the small plug symbol in the lower right corner of the equity click on the small plug symbol in the lower right corner of the equity 
subchart to open the menu, and select your broker.subchart to open the menu, and select your broker.  

Afterwards, the Order Routing can be started via the entry Afterwards, the Order Routing can be started via the entry Start Automatic Start Automatic Start Automatic Start Automatic 
Order RoutingOrder RoutingOrder RoutingOrder Routing in the  in the Order RoutingOrder RoutingOrder RoutingOrder Routing tab in the toolbar. tab in the toolbar.

USE THE POSITION MANAGER WITH THE PORTFOLIOUSE THE POSITION MANAGER WITH THE PORTFOLIO  

As soon as you have assigned strategies to a Portfolio, you can also open the Position Manager for it. If not defined otherwise, the As soon as you have assigned strategies to a Portfolio, you can also open the Position Manager for it. If not defined otherwise, the 
Position Manager uses the position information of the current workspace, in this case the symbols in the Portfolio. To avoid losing Position Manager uses the position information of the current workspace, in this case the symbols in the Portfolio. To avoid losing 
the overview, it is useful to use the filter function for searching information for specific symbols.the overview, it is useful to use the filter function for searching information for specific symbols.  
  
You can find more information in the chapter You can find more information in the chapter Position ManagerPosition Manager..

Starting the Order Routing in the PortfolioStarting the Order Routing in the Portfolio
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USE THE PERFORMANCE REPORT WITH A PORTFOLIOUSE THE PERFORMANCE REPORT WITH A PORTFOLIO  

You can generate a Performance Report for a Portfolio. The resulting report will include performance information for the complete You can generate a Performance Report for a Portfolio. The resulting report will include performance information for the complete 
Portfolio as well as for each symbol. Portfolio as well as for each symbol.   
  
You can find more information in the chapterYou can find more information in the chapter  Performance ReportPerformance Report..

MONEY MANAGEMENTMONEY MANAGEMENT  

The global Money Management settings can also be used for the Portfolio. Note that in the Portfolio, the Money Management is The global Money Management settings can also be used for the Portfolio. Note that in the Portfolio, the Money Management is 
applied to all instruments as a whole. You can enter the initial capital and values for Stop Loss and Trailing Stop. It is also applied to all instruments as a whole. You can enter the initial capital and values for Stop Loss and Trailing Stop. It is also 
reasonable to use some of the Position Sizing strategies offered by the software. This allows you to distribute the available capital reasonable to use some of the Position Sizing strategies offered by the software. This allows you to distribute the available capital 
onto the symbols in the Portfolio as positions of the same size. onto the symbols in the Portfolio as positions of the same size.   
  
You can find more information in the chapter You can find more information in the chapter Money ManagementMoney Management..

CHANGE THE HISTORY LENGTH OF THE PORTFOLIOCHANGE THE HISTORY LENGTH OF THE PORTFOLIO  

You can set the history length of the Portfolios in the properties of the Portfolio, setting You can set the history length of the Portfolios in the properties of the Portfolio, setting History LengthHistory LengthHistory LengthHistory Length. Keep in mind that for long . Keep in mind that for long 
histories and large portfolios, a considerable computational effort results, which may impair your computer's free resources. histories and large portfolios, a considerable computational effort results, which may impair your computer's free resources. 
Therefore, it is recommended that backtests and the real trades should be performed in separate workspaces with different history Therefore, it is recommended that backtests and the real trades should be performed in separate workspaces with different history 
lengths. lengths. 

SORT THE COLUMNSSORT THE COLUMNS  

You can sort the Portfolio columns by clicking on the respective column header. A small triangle appears (pointing up or down, You can sort the Portfolio columns by clicking on the respective column header. A small triangle appears (pointing up or down, 
depending on the sorting direction). To change the direction, click on the column header again. Alternative you can use the sorting depending on the sorting direction). To change the direction, click on the column header again. Alternative you can use the sorting 
from the context menu. Click with the right mouse button inside of the column and choose the sort direction.from the context menu. Click with the right mouse button inside of the column and choose the sort direction.

OPEN A CHART FROM WITH THE PORTFOLIO AND PAGE THROUGH CHARTSOPEN A CHART FROM WITH THE PORTFOLIO AND PAGE THROUGH CHARTS  

To view the chart for a symbol from within the Portfolio, open the context menu of the table row and select To view the chart for a symbol from within the Portfolio, open the context menu of the table row and select OpenOpenOpenOpen for the entry  for the entry 
ChartChartChartChart. The chart is opened with the selected symbol, its period and all included indicators and strategies. The Chart will also be . The chart is opened with the selected symbol, its period and all included indicators and strategies. The Chart will also be 
linked automatically to the Portfolio via linked automatically to the Portfolio via symbol linkingsymbol linking. Please note that in contrast to . Please note that in contrast to ScannerScanner and  and WatchlistWatchlist, the history length of , the history length of 
the portfolio will not be used. the portfolio will not be used.   
  
If you want to go through the whole list of symbols in a Portfolio to see each chart, use the small, green arrow buttons to the right If you want to go through the whole list of symbols in a Portfolio to see each chart, use the small, green arrow buttons to the right 
of the of the Command LineCommand Line. As soon as you open one chart of a Portfolio entry, you can page through the full list of symbols this way.. As soon as you open one chart of a Portfolio entry, you can page through the full list of symbols this way.

USING THE RESULTS WITH DRAG&DROPUSING THE RESULTS WITH DRAG&DROP  

USE SYMBOLS IN ANOTHER TABLEUSE SYMBOLS IN ANOTHER TABLE  
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You can reuse symbols from a Portfolio in a Watchlist, a Scanner or another Portfolio. You can reuse symbols from a Portfolio in a Watchlist, a Scanner or another Portfolio.   
  
If you want to start with a new table, open one by clicking the button If you want to start with a new table, open one by clicking the button PortfolioPortfolioPortfolioPortfolio (or Scanner or Watchlist) in the  (or Scanner or Watchlist) in the InsertInsertInsertInsert tab of the  tab of the 
toolbar and closing the wizard with toolbar and closing the wizard with DoneDoneDoneDone. An empty table is opened. Alternatively, you can use existing tables.. An empty table is opened. Alternatively, you can use existing tables.  
  
In the Portfolio, click into a table cell of the symbol you want to reuse. A little plus sign and a rectangle appear under the mouse In the Portfolio, click into a table cell of the symbol you want to reuse. A little plus sign and a rectangle appear under the mouse 
cursor. Now drag the cursor into the other table. The symbol is copied into the table.cursor. Now drag the cursor into the other table. The symbol is copied into the table.    
  
In a similar way, you can drag symbols from a Scanner or Watchlist into a Portfolio. In a similar way, you can drag symbols from a Scanner or Watchlist into a Portfolio. 

SAVING SYMBOLS IN A PORTFOLIO AS SYMBOL LISTSAVING SYMBOLS IN A PORTFOLIO AS SYMBOL LIST  

From within the Portfolio, you can save interesting symbols as a new symbol list.From within the Portfolio, you can save interesting symbols as a new symbol list.

1.1. To save the symbols as a new list, click on the entry To save the symbols as a new list, click on the entry New Symbol ListNew Symbol ListNew Symbol ListNew Symbol List in the  in the Related TasksRelated Tasks area of the symbol manager in  area of the symbol manager in 
the toolbox. Choose the option the toolbox. Choose the option UserUserUserUser----Defined Symbol ListDefined Symbol ListDefined Symbol ListDefined Symbol List and name the list but keep it empty. and name the list but keep it empty.  

2.2. In the Portfolio, click into a table cell of the symbol you want to reuse. (By pressing In the Portfolio, click into a table cell of the symbol you want to reuse. (By pressing ShiftShiftShiftShift or  or CtrlCtrlCtrlCtrl while clicking with the  while clicking with the 
mouse, you can select more than one row.) A small plus sign and a rectangle appear below the cursor.mouse, you can select more than one row.) A small plus sign and a rectangle appear below the cursor.  

3.3. Since a first click opens the properties tab, click again on the button Since a first click opens the properties tab, click again on the button Symbol ListsSymbol ListsSymbol ListsSymbol Lists in the toolbox to open the symbol  in the toolbox to open the symbol 
manager.manager.  

4.4. Drag the selected symbols to the new symbol list. The symbols are added to the list.Drag the selected symbols to the new symbol list. The symbols are added to the list.  

EXPORTING PORTFOLIO DATAEXPORTING PORTFOLIO DATA  

The table contents of the Portfolio can be copied to other programs. For more information, see the chapter The table contents of the Portfolio can be copied to other programs. For more information, see the chapter PublishingPublishing..    
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POSITION MANAGER 
The Position Manager is the central hub for trading system information. In The Position Manager is the central hub for trading system information. In 
case several trading systems are active in one or more charts, all case several trading systems are active in one or more charts, all 
information about held positions and pending orders etc. is displayed. This information about held positions and pending orders etc. is displayed. This 
way, you have a complete overview over your current trading system way, you have a complete overview over your current trading system 
activities. Use the Position Manager for the following: activities. Use the Position Manager for the following: 

l Keeping an overview of open positionsKeeping an overview of open positions  
l Keeping an overview of working ordersKeeping an overview of working orders  
l Keeping an overview of filled or canceled ordersKeeping an overview of filled or canceled orders  
l Tracking the current position developmentTracking the current position development  

Tradesignal offers you a clearly arranged Position Manager that includes all Tradesignal offers you a clearly arranged Position Manager that includes all 
important information. It is designed as an automatically updating table with a few categories. important information. It is designed as an automatically updating table with a few categories. 

POSITION MANAGER SETUPPOSITION MANAGER SETUP  

OPEN A POSITION MANAGEROPEN A POSITION MANAGER  

In order to use the Position Manager, you have to do the following: In order to use the Position Manager, you have to do the following: 

1.1. Set up a chart.Set up a chart.  
2.2. Set up a trading system with strategies (otherwise, no positions can be calculated).Set up a trading system with strategies (otherwise, no positions can be calculated).  
3.3. Open the Position Manager, for example by clicking on the button Open the Position Manager, for example by clicking on the button Position ManagerPosition ManagerPosition ManagerPosition Manager in the toolbar. The new  in the toolbar. The new Position Position 

ManagerManager group appears. group appears.  
4.4. Click the small plug symbol on the lower right of the chart to open the menu Click the small plug symbol on the lower right of the chart to open the menu Strategy Automation OptionsStrategy Automation OptionsStrategy Automation OptionsStrategy Automation Options. Choose the . Choose the 

entry entry Position Manager OnlyPosition Manager OnlyPosition Manager OnlyPosition Manager Only..  

Now the connection with the Position Manager is set up. You can find the current positions on the tab Now the connection with the Position Manager is set up. You can find the current positions on the tab PositionsPositionsPositionsPositions..  
  
The Position Manager collects all information from its start to its closure. No data is saved within the workspace. Therefore, when The Position Manager collects all information from its start to its closure. No data is saved within the workspace. Therefore, when 
you close the workspace that includes the Position Manager, the next time you open the workspace the Position Manager starts by you close the workspace that includes the Position Manager, the next time you open the workspace the Position Manager starts by 
collecting new information. collecting new information.   
  
You can set up one Position Manager for each workspace.You can set up one Position Manager for each workspace.

POSITION MANAGER BUTTONS IN THE PROPERTY INSPECTORPOSITION MANAGER BUTTONS IN THE PROPERTY INSPECTOR  

Monitor All WorkspacesMonitor All WorkspacesMonitor All WorkspacesMonitor All Workspaces  -- Usually, the Position Manager only collects information for the trading system of the currently active  Usually, the Position Manager only collects information for the trading system of the currently active 
workspace. Click this button to collect information for all workspaces. workspace. Click this button to collect information for all workspaces.   
  
Show Flat PositionsShow Flat PositionsShow Flat PositionsShow Flat Positions  -- Select this if positions that went to zero should also be displayed. Select this if positions that went to zero should also be displayed.  
  
Font SizeFont SizeFont SizeFont Size  -- Select the size of font to use in the position manager. Select the size of font to use in the position manager.

Position ManagerPosition Manager
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THE POSITION MANAGER CATEGORIESTHE POSITION MANAGER CATEGORIES  

ORDER TRACKERORDER TRACKER  

In this category you can find a list of all generated orders. It lists In this category you can find a list of all generated orders. It lists 
information on the time and date of the purchase, the entry price, the information on the time and date of the purchase, the entry price, the 
profit/loss and the strategy that caused the order. In the Order Tracker you profit/loss and the strategy that caused the order. In the Order Tracker you 
can follow all trading system activities in the workspace.can follow all trading system activities in the workspace.  

POSITIONSPOSITIONS  

In this category you can find all currently held positions. It lists information In this category you can find all currently held positions. It lists information 
on time and date of the purchase, the entry price, current price and on time and date of the purchase, the entry price, current price and 
profit/loss, the strategy that caused the order, and the broker, in case it was profit/loss, the strategy that caused the order, and the broker, in case it was 
bought via Automatic Order Routing. The minimum size of each position is bought via Automatic Order Routing. The minimum size of each position is 
defined by the defined by the Default QuantityDefault QuantityDefault QuantityDefault Quantity parameters in the Money Management of  parameters in the Money Management of 
the chart.the chart.

WORKING ORDERSWORKING ORDERS  

In this category you can find all pending orders, for example orders with a In this category you can find all pending orders, for example orders with a 
limited validity that should be filled in at a certain time or for a certain limited validity that should be filled in at a certain time or for a certain 
priceprice

FILLED ORDERSFILLED ORDERS  

In this category you can find all orders that were filled, together with In this category you can find all orders that were filled, together with 
information on the time, price, quantity, the strategy that caused the order information on the time, price, quantity, the strategy that caused the order 
to be submitted, and the broker.to be submitted, and the broker.

CANCELLED ORDERSCANCELLED ORDERS  

In this category you can find all orders that were cancelled before being filled. This may include Stop Orders or other order types In this category you can find all orders that were cancelled before being filled. This may include Stop Orders or other order types 
that were cancelled by the trading system prematurely.that were cancelled by the trading system prematurely.

COLUMN SUMMARIESCOLUMN SUMMARIES  

The The PositionsPositionsPositionsPositions category supports column summaries. Right category supports column summaries. Right--clicking on the shaded bar at the bottom of the positions tab window clicking on the shaded bar at the bottom of the positions tab window 
will display a context menu for a specific column. This menu presents various predefined summary values that may be shown for will display a context menu for a specific column. This menu presents various predefined summary values that may be shown for 
that column (if applicable). The various summaries arethat column (if applicable). The various summaries are

Order TrackerOrder Tracker

PositionsPositions

Working OrdersWorking Orders
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l SumSum  
l Minimum ValueMinimum Value  
l Maximum ValueMaximum Value  
l Row CountRow Count  
l Average Value (Mean)Average Value (Mean)  

Multiple summaries may be displayed for a single column.Multiple summaries may be displayed for a single column.

CONDITIONAL ROW COLORINGCONDITIONAL ROW COLORING  

All categories support conditional row coloring and styling. Select the category to configure and the select All categories support conditional row coloring and styling. Select the category to configure and the select Home > Table > Home > Table > 
Columns > Conditional FormattingColumns > Conditional Formatting on the Toolbar to display the conditional formatting dialog. on the Toolbar to display the conditional formatting dialog.

1.1. Click the Click the Add new condition...Add new condition...Add new condition...Add new condition... link to add a new condition and name the rule. link to add a new condition and name the rule.  
2.2. In the condition field on the right, type the condition or use the In the condition field on the right, type the condition or use the ............ button to start the condition editor. button to start the condition editor.  
3.3. Select fore and background colors and optional font changes to use if the condition is met.Select fore and background colors and optional font changes to use if the condition is met.  
4.4. Add more conditions if desiredAdd more conditions if desired  
5.5. Select Select OKOKOKOK to apply the formatting. to apply the formatting.  

Conditions may be removed by clicking the Conditions may be removed by clicking the xxxx next to the conditions name in the conditional formatting dialog. next to the conditions name in the conditional formatting dialog.  
  
Please note:Please note:Please note:Please note: Conditional formatting will be saved with a style template for a position manager. Conditional formatting will be saved with a style template for a position manager.

FILTERING RESULTSFILTERING RESULTS  

There are multiple ways to filter the results displayed a category in the position managerThere are multiple ways to filter the results displayed a category in the position manager

l Quick filtering by clicking on Quick filtering by clicking on Home > Find > FindHome > Find > Find on the Toolbar, and typing a keyword, matching items will be highlighted,  on the Toolbar, and typing a keyword, matching items will be highlighted, 
not matching rows will be hidden.not matching rows will be hidden.  

l Show the Filter Editor by clicking on ''Home > Table > Filter > Edit Filter. The filter builder allows a filter to be visually Show the Filter Editor by clicking on ''Home > Table > Filter > Edit Filter. The filter builder allows a filter to be visually 
constructed using various Boolean operations and interactive components arranged in a tree structure. All following constructed using various Boolean operations and interactive components arranged in a tree structure. All following 
commands will also be visible in the Filter Editor if shown.commands will also be visible in the Filter Editor if shown.  

l Show the Auto Filter Row by clicking on Show the Auto Filter Row by clicking on Home > Table > Filter > Show Auto Filter RowHome > Table > Filter > Show Auto Filter Row on the toolbar. Only rows containing  on the toolbar. Only rows containing 
matching text entered in the filter row at the top of the column will be displayed.matching text entered in the filter row at the top of the column will be displayed.  

l Clicking the filter icon when hovering the mouse over a column title displays a list of possible filters for the selected Clicking the filter icon when hovering the mouse over a column title displays a list of possible filters for the selected 
column.column.  

If any filtering method other than Quick Filtering is active, a row will be displayed at the bottom of the Position Manager pane If any filtering method other than Quick Filtering is active, a row will be displayed at the bottom of the Position Manager pane 
showing the active filter conditions. This row has the following options.showing the active filter conditions. This row has the following options.

l A check box to temporarily disable/enable the filter.A check box to temporarily disable/enable the filter.  
l An An xxxx button to permanently remove the filter. button to permanently remove the filter.  
l A button labelled A button labelled Edit FilterEdit FilterEdit FilterEdit Filter that will show the Filter Editor dialog. that will show the Filter Editor dialog.  

ADDING, REMOVING AND REORDERING COLUMNSADDING, REMOVING AND REORDERING COLUMNS  
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Columns may be freely resized or repositioned via drag and drop. To add or remove columns, select Columns may be freely resized or repositioned via drag and drop. To add or remove columns, select Home > Table > Columns > Home > Table > Columns > 
Add/Remove ColumnsAdd/Remove Columns on the Toolbar, and drag and drop columns to and from the displayed dialog as desired. on the Toolbar, and drag and drop columns to and from the displayed dialog as desired.

EXPORTING POSITION MANAGER DATAEXPORTING POSITION MANAGER DATA  

The table contents of the Position Manager can be copied to other programs. For more information, see the chapter The table contents of the Position Manager can be copied to other programs. For more information, see the chapter Copying Copying 
Documents via the Windows ClipboardDocuments via the Windows Clipboard..

EXAMPLE FOR SETTING UP THE POSITION MANAGEREXAMPLE FOR SETTING UP THE POSITION MANAGER  

With the following parameters you can follow a security with a MACD Crossover System intraday.With the following parameters you can follow a security with a MACD Crossover System intraday.  
  
Chart:Chart:

l Select a security with a high turnover, e.g. "Apple Inc" (AAPL NAS)Select a security with a high turnover, e.g. "Apple Inc" (AAPL NAS)  
l Set Set PeriodPeriodPeriodPeriod to  to hourlyhourlyhourlyhourly  

Strategy:Strategy:

l MACD Crossover with Bearish on ShortentryMACD Crossover with Bearish on Shortentry  

1.1. In the In the InsertInsert group in the toolbar, click on  group in the toolbar, click on PositionsPositionsPositionsPositions..  
2.2. Click on the small plug symbol on the lower right and choose the option Click on the small plug symbol on the lower right and choose the option Position Manager OnlyPosition Manager OnlyPosition Manager OnlyPosition Manager Only..  
3.3. Click on the tab Click on the tab PositionPositionPositionPosition in the Position Manager to see the currently open positions. in the Position Manager to see the currently open positions.  
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OPTIMIZER 
The optimizing of trading systems is one of the software's most important functions, right after developing the system logic and its The optimizing of trading systems is one of the software's most important functions, right after developing the system logic and its 
programming. With an Optimizer, you can do the following: programming. With an Optimizer, you can do the following: 

l Evaluate the performance of a newly developed trading systemEvaluate the performance of a newly developed trading system  
l Select the settings that give the best performance for a trading systemSelect the settings that give the best performance for a trading system  
l Test trading systems for stability and profitabilityTest trading systems for stability and profitability  
l Generate statistical results for different parameter settingsGenerate statistical results for different parameter settings  
l Configure trading systems for the usage in the PortfolioConfigure trading systems for the usage in the Portfolio  

In Tradesignal, the Optimizer is also able to optimize "inIn Tradesignal, the Optimizer is also able to optimize "in--sample" and "outsample" and "out--ofof--sample" ranges with the start and end bars defined by sample" ranges with the start and end bars defined by 
you. This way you can see how the trading system acts over a defined time span and if the parameter settings could also be you. This way you can see how the trading system acts over a defined time span and if the parameter settings could also be 
applied successfully to other time spans.applied successfully to other time spans.  

START THE OPTIMIZERSTART THE OPTIMIZER  

To start the Optimizer Wizard you canTo start the Optimizer Wizard you can

l Click on the Click on the OptimizeOptimizeOptimizeOptimize button in the  button in the StrategiesStrategies area in the  area in the ToolbarToolbar or or  
l Select the menu entry Select the menu entry Optimize...Optimize...Optimize...Optimize... in the context menu of a symbol or symbol list in the  in the context menu of a symbol or symbol list in the Symbol ListsSymbol Lists toolbox. toolbox.  

CALL UP THE OPTIMIZER AND CHOOSE A METHODCALL UP THE OPTIMIZER AND CHOOSE A METHOD  

The Optimizer in Tradesignal offers you several optimization methods from The Optimizer in Tradesignal offers you several optimization methods from 
which you have to select the best one depending for your goals. Also note which you have to select the best one depending for your goals. Also note 
that some methods take longer to calculate the results than others. that some methods take longer to calculate the results than others. 

l Brute ForceBrute ForceBrute ForceBrute Force  -- Depending on the parameters to be optimized and the  Depending on the parameters to be optimized and the 
set boundary values, the Optimizer runs through all possible set boundary values, the Optimizer runs through all possible 
combinations of parameters. This method is especially useful if you combinations of parameters. This method is especially useful if you 
want to use the results for further analysis, e.g. in Excel. The want to use the results for further analysis, e.g. in Excel. The 
disadvantage is the possibly high number of combinations, which disadvantage is the possibly high number of combinations, which 
may lead to a long calculation time.may lead to a long calculation time.  

l GeneticGeneticGeneticGenetic  -- Depending on the parameters to be optimized and the set  Depending on the parameters to be optimized and the set 
boundary values, the Optimizer runs through the possible boundary values, the Optimizer runs through the possible 
combinations of parameters with genetic algorithms that strive to combinations of parameters with genetic algorithms that strive to 
find the best results. The advantage of the method is its lesser calculation time. The disadvantage is that the table of results find the best results. The advantage of the method is its lesser calculation time. The disadvantage is that the table of results 
does not include all possible combination of parameters.does not include all possible combination of parameters.  

l Walk ForwardWalk ForwardWalk ForwardWalk Forward  -- Depending on the parameters to be optimized and the set boundary values, this method outputs complete  Depending on the parameters to be optimized and the set boundary values, this method outputs complete 
results over defined ranges. You can define the length of the ranges. Tradesignal lists the results as "inresults over defined ranges. You can define the length of the ranges. Tradesignal lists the results as "in--sample" and "outsample" and "out--ofof--
sample" values. This way, you get an overview of the trading system works for smaller time samples and how stable the sample" values. This way, you get an overview of the trading system works for smaller time samples and how stable the 
results are. The advantages and disadvantages are the same as for "Brute Force".results are. The advantages and disadvantages are the same as for "Brute Force".  

OptimizerOptimizer
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l Walk Forward GeneticWalk Forward GeneticWalk Forward GeneticWalk Forward Genetic  -- This method combines the defined ranges with the genetic algorithm. The advantages and  This method combines the defined ranges with the genetic algorithm. The advantages and 
disadvantages are the same as for "Genetic".disadvantages are the same as for "Genetic".  

SET UP PARAMETERSET UP PARAMETER  

After choosing the method, you have to select the parameters you want to After choosing the method, you have to select the parameters you want to 
optimize. optimize. 

l In the list on the left, you can find all optimizable parameters that In the list on the left, you can find all optimizable parameters that 
are available from are available from Money ManagementMoney Management, and the input parameters of , and the input parameters of 
the included trading systems. (the included trading systems. (NoteNoteNoteNote: Parameters of indicators are : Parameters of indicators are 
also available for optimization in Tradesignal, which is useful if your also available for optimization in Tradesignal, which is useful if your 
trading system is based on the output of an indicator.)trading system is based on the output of an indicator.)  

l In the list on the right, the parameters to be optimized are to be In the list on the right, the parameters to be optimized are to be 
found.found.  

To move a parameter from the right to the left and vice versa, either select To move a parameter from the right to the left and vice versa, either select 
it and click on the respective doubleit and click on the respective double--arrow button, or doublearrow button, or double--click the click the 
parameter. parameter.   
  
You can also select more than one parameter at the same time by holding down the You can also select more than one parameter at the same time by holding down the ShiftShiftShiftShift key (selecting several consecutive  key (selecting several consecutive 
parameters) or the parameters) or the CtrlCtrlCtrlCtrl key (selecting several parameters) while clicking on the parameters. To move all parameters at once from  key (selecting several parameters) while clicking on the parameters. To move all parameters at once from 
one side to the other, select one side to the other, select Add AllAdd AllAdd AllAdd All or  or Remove AllRemove AllRemove AllRemove All..  
  
For the selected parameters, you can enter further values, e.g. for start, end and steps. For that, select the parameter in the list on For the selected parameters, you can enter further values, e.g. for start, end and steps. For that, select the parameter in the list on 
the right. The fields for the adjustable values show up at the bottom of the dialog.the right. The fields for the adjustable values show up at the bottom of the dialog.

(GENETIC OPTIMIZER) STATISTIC AND FINISHING CONDITION(GENETIC OPTIMIZER) STATISTIC AND FINISHING CONDITION  

For the genetic optimizer, you have to select which statistic should measure the success of the optimization. For the genetic optimizer, you have to select which statistic should measure the success of the optimization. 

l Select whether the Select whether the highesthighesthighesthighest or  or lowestlowestlowestlowest value should be used. value should be used.  
l Select the parameter that should be used as the key parameter for the evaluation (by default Select the parameter that should be used as the key parameter for the evaluation (by default Total Net ProfitTotal Net ProfitTotal Net ProfitTotal Net Profit).).  
l Select the instrument from which the statistic should be taken. To have a list of options here, independent graphs and Select the instrument from which the statistic should be taken. To have a list of options here, independent graphs and 

strategies have to be available in the current document.strategies have to be available in the current document.  

In the next step, you have to set the stop point for the genetic optimization: In the next step, you have to set the stop point for the genetic optimization: 

l After no better result was found (in minutes)After no better result was found (in minutes)After no better result was found (in minutes)After no better result was found (in minutes)  -- This can result in a long optimization duration, since you only set the  This can result in a long optimization duration, since you only set the 
time limit after finding the optimal value.time limit after finding the optimal value.  

l After a fixed period of time (in minutes)After a fixed period of time (in minutes)After a fixed period of time (in minutes)After a fixed period of time (in minutes)  -- This allows for a very quick optimization, but might give suboptimal results. This allows for a very quick optimization, but might give suboptimal results.  

DEFINE THE DATA RANGEDEFINE THE DATA RANGE  

Define how much of the historic data should be used for the optimization: Define how much of the historic data should be used for the optimization: 

l Use all available dataUse all available dataUse all available dataUse all available data  -- This corresponds to the  This corresponds to the History LengthHistory LengthHistory LengthHistory Length in the chart properties. in the chart properties.  

Optimizing ParametersOptimizing Parameters
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l Use data within the following range of barsUse data within the following range of barsUse data within the following range of barsUse data within the following range of bars  -- Set a range of data to be used. The maximum range is also given by the  Set a range of data to be used. The maximum range is also given by the 
History LengthHistory LengthHistory LengthHistory Length in the chart properties. in the chart properties.  

l Use data between the following datesUse data between the following datesUse data between the following datesUse data between the following dates  -- Set a Start and End date for the optimization. To change the dates, either click  Set a Start and End date for the optimization. To change the dates, either click 
on the calendar to select a date, or click in the area of day/month/year to change each of the values.on the calendar to select a date, or click in the area of day/month/year to change each of the values.  

(WALK FORWARD) DEFINE THE SAMPLES(WALK FORWARD) DEFINE THE SAMPLES  

For the Walk Forward methods, you can define the inFor the Walk Forward methods, you can define the in--samples and outsamples and out--ofof--
samples bars per sample. The method works as follows:samples bars per sample. The method works as follows:

1.1. If you set inIf you set in--sample to "100" and outsample to "100" and out--ofof--sample to "50", the sample to "50", the 
optimizer will use the first 100 bars after the start point for the optimizer will use the first 100 bars after the start point for the 
optimization, and then calculate the values for the next 50 bars with optimization, and then calculate the values for the next 50 bars with 
the results from the first 100.the results from the first 100.  

2.2. After this, the starting point is moved forward by the range of the After this, the starting point is moved forward by the range of the 
outout--ofof--sample length (50 bars), and the above described optimization sample length (50 bars), and the above described optimization 
calculation will be executed again.calculation will be executed again.  

This will be repeated as long as enough data is available to fill the inThis will be repeated as long as enough data is available to fill the in-- and  and 
outout--ofof--sample ranges.sample ranges.  
  
If you choose the option If you choose the option Anchor inAnchor inAnchor inAnchor in----sample: Start always at the beginning of specified data rangesample: Start always at the beginning of specified data rangesample: Start always at the beginning of specified data rangesample: Start always at the beginning of specified data range, the start point is not , the start point is not 
moved. Instead, the inmoved. Instead, the in--sample starts always at the beginning of the data range, so the insample starts always at the beginning of the data range, so the in--sample increases in size over time.sample increases in size over time.

START THE OPTIMIZERSTART THE OPTIMIZER  

Start the optimization by clicking on the Start the optimization by clicking on the OptimizeOptimizeOptimizeOptimize button in the wizard. button in the wizard.

OPTIMIZER BUTTONS IN THE TOOLBAROPTIMIZER BUTTONS IN THE TOOLBAR  

In the toolbar, the In the toolbar, the TableTable group offers the following functions: group offers the following functions:  
  
Start/PauseStart/PauseStart/PauseStart/Pause  -- Click on  Click on PausePausePausePause to get an intermediate result of the  to get an intermediate result of the 
optimization. You can start the optimizer again by clicking on optimization. You can start the optimizer again by clicking on StartStartStartStart. .   
  
StopStopStopStop  -- End the optimization. End the optimization.  
  
View in ChartView in ChartView in ChartView in Chart  -- Apply the values selected in the table. Use the context  Apply the values selected in the table. Use the context 
menu on the optimizer grid to open a new chart.menu on the optimizer grid to open a new chart.  
  
ColumnsColumnsColumnsColumns  -- Via this button menu you can find the following options: Via this button menu you can find the following options:

l Column GroupingColumn GroupingColumn GroupingColumn Grouping  -- Toggles between enable and disable column grouping. Toggles between enable and disable column grouping.  
l Add/Remove ColumnAdd/Remove ColumnAdd/Remove ColumnAdd/Remove Column  -- Here you can define which columns should be displayed (on the right) and which not (on the left).  Here you can define which columns should be displayed (on the right) and which not (on the left). 

The indicators correspond to the ones in the The indicators correspond to the ones in the Performance ReportPerformance Report..  
l Set Graph Axes as DefaultSet Graph Axes as DefaultSet Graph Axes as DefaultSet Graph Axes as Default  -- Choose this option to use the current chart settings as default in future charts. Choose this option to use the current chart settings as default in future charts.  

InIn-- und Out und Out--ofof--SampleSample

Optimizer group in the toolbarOptimizer group in the toolbar
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PROPERTY INSPECTOR SETTINGSPROPERTY INSPECTOR SETTINGS  

RunsRunsRunsRuns  -- Here you can find a list of all runs of the optimizer with date and time. Select an entry from the list to call up the data of  Here you can find a list of all runs of the optimizer with date and time. Select an entry from the list to call up the data of 
that run. Note that the list only displays multiple runs of a specific optimization (called up with that run. Note that the list only displays multiple runs of a specific optimization (called up with StartStartStartStart).). When you create another  When you create another 
optimization, the counter starts anew for this optimization and another graph and table with results will be displayed. optimization, the counter starts anew for this optimization and another graph and table with results will be displayed. 

ADVANCED OPTIMIZER SETTINGSADVANCED OPTIMIZER SETTINGS  

Via the Via the AdvancedAdvancedAdvancedAdvanced button you can open a dialog with more options.  button you can open a dialog with more options.   
  
Advanced General Optimizer OptionsAdvanced General Optimizer Options

l Number of optimizer threadsNumber of optimizer threadsNumber of optimizer threadsNumber of optimizer threads  -- Enter a number higher than one, if several optimization routes should be calculated at the  Enter a number higher than one, if several optimization routes should be calculated at the 
same time. You should change the value only if you have a computer with a multisame time. You should change the value only if you have a computer with a multi--processors and should ideally not be processors and should ideally not be 
higher than the amount of CPUs.higher than the amount of CPUs.  

l Thread PriorityThread PriorityThread PriorityThread Priority  -- Select  Select highhighhighhigh, , normalnormalnormalnormal or  or lowlowlowlow. This regulates how much system resources the Optimizer is allowed to use.. This regulates how much system resources the Optimizer is allowed to use.  
l Use a longer history length when optimizingUse a longer history length when optimizingUse a longer history length when optimizingUse a longer history length when optimizing  -- Allows you entering a history length independent of the chart properties. Allows you entering a history length independent of the chart properties.  
l AutoAutoAutoAuto----start Excel after optimizationstart Excel after optimizationstart Excel after optimizationstart Excel after optimization  -- If you select this option, the calculation results will be opened automatically in  If you select this option, the calculation results will be opened automatically in 

Excel after the optimization.Excel after the optimization.  

Advanced Genetic Optimizer OptionsAdvanced Genetic Optimizer Options

l Only keep better resultsOnly keep better resultsOnly keep better resultsOnly keep better results  -- Only the best results are kept and displayed. Only the best results are kept and displayed.  
l Show all ResultsShow all ResultsShow all ResultsShow all Results  -- This will keep and display all results. This may lead to a very long table. This will keep and display all results. This may lead to a very long table.  

POSSIBLE OPTIMIZATIONSPOSSIBLE OPTIMIZATIONS  

OPTIMIZING A SINGLE SECURITYOPTIMIZING A SINGLE SECURITY  

You can optimize a trading system for a single chart or symbol.You can optimize a trading system for a single chart or symbol.  

l If you have an active chart with a strategy, the If you have an active chart with a strategy, the OptimizeOptimizeOptimizeOptimize button in the symbol bar is available. Click on it to start the  button in the symbol bar is available. Click on it to start the 
Optimizer wizard.Optimizer wizard.  

l Alternatively, you can choose the entry Alternatively, you can choose the entry OptimizeOptimizeOptimizeOptimize in the context menu of a symbol. in the context menu of a symbol.  

OPTIMIZING A SYMBOL LISTOPTIMIZING A SYMBOL LIST  

You have several choices for starting the Optimizer for a list of symbols.You have several choices for starting the Optimizer for a list of symbols.

FULL SYMBOL LISTSFULL SYMBOL LISTS  

The easiest method is optimizing a complete symbol list. To do this, choose the entry The easiest method is optimizing a complete symbol list. To do this, choose the entry OptimizeOptimizeOptimizeOptimize in the context menu of a symbol  in the context menu of a symbol 
list.list.
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LIST IN THE SCANNER OR WATCHLISTLIST IN THE SCANNER OR WATCHLIST  

The second way is optimizing from within a The second way is optimizing from within a ScannerScanner or  or WatchlistWatchlist. When you have a list of symbols in the Scanner/Watchlist, click . When you have a list of symbols in the Scanner/Watchlist, click 
on the on the OptimizeOptimizeOptimizeOptimize button in the  button in the ToolbarToolbar..

SEVERAL SYMBOLS IN A CHARTSEVERAL SYMBOLS IN A CHART  

The third way is optimizing a The third way is optimizing a chartchart that includes on or more symbols. To do this, click on the  that includes on or more symbols. To do this, click on the OptimizeOptimizeOptimizeOptimize button in the  button in the ToolbarToolbar while  while 
the chart is active.the chart is active.

PORTFOLIOPORTFOLIO  

Another possibility is the optimization of a Portfolio. To start optimizing a Portfolio, click on the Another possibility is the optimization of a Portfolio. To start optimizing a Portfolio, click on the OptimizeOptimizeOptimizeOptimize button in the  button in the ToolbarToolbar  
while the Portfolio is active.while the Portfolio is active.  
  
The difference between a The difference between a PortfolioPortfolio and a  and a ScannerScanner, , WatchlistWatchlist or  or ChartChart with several symbols is the combination of strategies and a  with several symbols is the combination of strategies and a 
single account with several symbols in the Portfolio. This way, you can trade several symbols in one Portfolio and generate global single account with several symbols in the Portfolio. This way, you can trade several symbols in one Portfolio and generate global 
trading statistics. Therefore, you receive realistic results for the superposition of trading several symbols at various times in the trading statistics. Therefore, you receive realistic results for the superposition of trading several symbols at various times in the 
Optimizer. It allows you to test various trading systems and gives you access to all statistics resulting from all possible parameter Optimizer. It allows you to test various trading systems and gives you access to all statistics resulting from all possible parameter 
combinations. combinations. 

ANALYZING AND INTERPRETING THE OPTIMIZATION RESULTSANALYZING AND INTERPRETING THE OPTIMIZATION RESULTS  

USE THE TABLEUSE THE TABLE  

On the right side of the optimization window, a table with the optimization results is displayed. On the right side of the optimization window, a table with the optimization results is displayed. 

l You can change the sorting order by clicking on the column header. For example, sort for the longest period of a positive You can change the sorting order by clicking on the column header. For example, sort for the longest period of a positive 
trade.trade.  

l You can also group columns. For this, drag the column header into the very top of the table. This way, you can group any You can also group columns. For this, drag the column header into the very top of the table. This way, you can group any 
columns to one single group, which can be opened and closed much like the folder tree in Windows Explorer.columns to one single group, which can be opened and closed much like the folder tree in Windows Explorer.  

USE THE FILTERUSE THE FILTER  

Especially in large tables it is hard to keep the overview. It is also often preferable to ignore certain indicator values. To filter the Especially in large tables it is hard to keep the overview. It is also often preferable to ignore certain indicator values. To filter the 
view, click on the view, click on the Edit FilterEdit FilterEdit FilterEdit Filter button. A simple example would be filtering for "Total Net Profit > 0". button. A simple example would be filtering for "Total Net Profit > 0".  
  
You can find more information in the chapter You can find more information in the chapter FilterFilter..

APPLY RESULTS TO OTHER DOCUMENTSAPPLY RESULTS TO OTHER DOCUMENTS  

To apply optimized values to the optimized chart/portfolio, doubleTo apply optimized values to the optimized chart/portfolio, double--click the respective table row. You will be asked if you really click the respective table row. You will be asked if you really 
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want to apply the values. Note that you cannot apply single cell contents, only the full row.want to apply the values. Note that you cannot apply single cell contents, only the full row.  
  
To use the values in a new chart or portfolio, choose the options you prefer in the button menu To use the values in a new chart or portfolio, choose the options you prefer in the button menu View in ChartView in ChartView in ChartView in Chart in the Toolbar. in the Toolbar.

EXPORT OF OPTIMIZER RESULTSEXPORT OF OPTIMIZER RESULTS  

The results of the Optimizer can be exported via the file menu. Choose the menu entry The results of the Optimizer can be exported via the file menu. Choose the menu entry Export "Optimizer"Export "Optimizer"Export "Optimizer"Export "Optimizer" from the file menu. A  from the file menu. A 
request appears. Choose whether you want to export all runs or only the latest. The file dialog opens in which you can specify the request appears. Choose whether you want to export all runs or only the latest. The file dialog opens in which you can specify the 
directory, file name and file type for the export file before saving it.directory, file name and file type for the export file before saving it.

GRAPHIC ANALYSISGRAPHIC ANALYSIS  

The interpretation of statistic data is often easier when the data is The interpretation of statistic data is often easier when the data is 
visualized in a diagram. Tradesignal offers a visualization function. As soon visualized in a diagram. Tradesignal offers a visualization function. As soon 
as the Optimizer has finished (or is paused), you can find diagrams on the as the Optimizer has finished (or is paused), you can find diagrams on the 
left of the table. Three axes are available; values can be set via the dropleft of the table. Three axes are available; values can be set via the drop--
down lists. There are two kinds of diagrams:down lists. There are two kinds of diagrams:

3D (SURFACE) DIAGRAM3D (SURFACE) DIAGRAM  

This is the standard setting. Choose parameters of the trading system for This is the standard setting. Choose parameters of the trading system for 
both the xboth the x-- and y and y-- axes, and then select a key figure like "Total Net Profit"  axes, and then select a key figure like "Total Net Profit" 
for the zfor the z--axis.axis.  
  
The colored surface shows the development of the key figure in relation to the parameter combination. The different colors mark The colored surface shows the development of the key figure in relation to the parameter combination. The different colors mark 
different values of the key figure (green = positive, yellow = neutral, red = negative). Therefore, the diagram can be read as an different values of the key figure (green = positive, yellow = neutral, red = negative). Therefore, the diagram can be read as an 
elevation profile. When you click on a colored square, the corresponding row in the optimization results table is focused. In elevation profile. When you click on a colored square, the corresponding row in the optimization results table is focused. In 
addition, you can find a diagram with the key figure and the xaddition, you can find a diagram with the key figure and the x--axis parameter below the 3D profile.axis parameter below the 3D profile.

2D DIAGRAM2D DIAGRAM  

The simpler variant is the 2D profile. For this, select a key figure for the yThe simpler variant is the 2D profile. For this, select a key figure for the y--
axis and one of the parameters for the xaxis and one of the parameters for the x--axis. Set the zaxis. Set the z--axis to "none". This axis to "none". This 
way, you can have a look at the effect of a single parameter in the trading way, you can have a look at the effect of a single parameter in the trading 
system. The height of the columns shows the maximum values. The black system. The height of the columns shows the maximum values. The black 
lines in the columns mark the trading systems results.lines in the columns mark the trading systems results.  
  
The values of the tables and the diagrams are connected. The values of the tables and the diagrams are connected. 

l If you click on a value in the table, crossIf you click on a value in the table, cross--hairs mark the hairs mark the 
corresponding position in the diagram.corresponding position in the diagram.  

l If you click on a position in the surface or the column diagram, the If you click on a position in the surface or the column diagram, the 
corresponding value in the table is focused.corresponding value in the table is focused.  

In addition, you can see the numeric values of the position beneath the mouse cursor to the right of the diagram headlines.In addition, you can see the numeric values of the position beneath the mouse cursor to the right of the diagram headlines.

3D Diagram3D Diagram

2D Diagram2D Diagram
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EXAMPLE: OPTIMIZING THE STRATEGY BOLLINGER BAND BREAKOUT FOR APPLE COMPUTER, EXAMPLE: OPTIMIZING THE STRATEGY BOLLINGER BAND BREAKOUT FOR APPLE COMPUTER, 
INC. (AAPL NAS)INC. (AAPL NAS)  

1.1. Click on the Click on the Symbol ListsSymbol ListsSymbol ListsSymbol Lists button in the toolbox. button in the toolbox.  
2.2. Open the USA/S&P 100 [100]. (If this symbol list is not available, Open the USA/S&P 100 [100]. (If this symbol list is not available, 

download this list via download this list via New Symbol ListNew Symbol ListNew Symbol ListNew Symbol List in the  in the Related TaskRelated Task area.) area.)  
3.3. Search for the Apple Computer, In.c (AAPL NAS) symbol.Search for the Apple Computer, In.c (AAPL NAS) symbol.  
4.4. RightRight--click on the symbol and choose click on the symbol and choose Open in ChartOpen in ChartOpen in ChartOpen in Chart from the  from the 

context menu.context menu.  
5.5. In the In the Trading SystemTrading System group in the toolbar, click on  group in the toolbar, click on Add StrategyAdd StrategyAdd StrategyAdd Strategy..  
6.6. Select Select Bollinger Band BreakoutBollinger Band BreakoutBollinger Band BreakoutBollinger Band Breakout (in the tab  (in the tab Complete SystemsComplete Systems).).  
7.7. On the tab On the tab Position SizingPosition Sizing, select , select Position Sizing Position Sizing Position Sizing Position Sizing ---- Percent  Percent  Percent  Percent 

VolatilityVolatilityVolatilityVolatility..  
8.8. Click on Click on OKOKOKOK..  

The selected strategies are The selected strategies are appliedapplied to the chart with their default settings, next step is to optimize these settings to yield a higher  to the chart with their default settings, next step is to optimize these settings to yield a higher 
net profit for historic values.net profit for historic values.

1.1. In the toolbar, click on the In the toolbar, click on the OptimizeOptimizeOptimizeOptimize button. button.  
2.2. Select the method Select the method GeneticGeneticGeneticGenetic..  
3.3. Remove all select parameters from the list except Remove all select parameters from the list except PeriodPeriodPeriodPeriod and  and StdDevsStdDevsStdDevsStdDevs (for example by double (for example by double--clicking the parameters in clicking the parameters in 

the right list).the right list).  
4.4. You can select different ranges and step sizes for each parameter, but in this example we use the default settings.You can select different ranges and step sizes for each parameter, but in this example we use the default settings.  
5.5. Click to the next windows. For the finishing condition, select the fixed period of time and set it to "1" minute. Start the Click to the next windows. For the finishing condition, select the fixed period of time and set it to "1" minute. Start the 

Optimizer.Optimizer.  

The Optimizer calculates the best results for the strategy. After one minute, the Optimizer stops and the table of results is The Optimizer calculates the best results for the strategy. After one minute, the Optimizer stops and the table of results is 
displayed.displayed.    

Optimizing a strategyOptimizing a strategy
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PERFORMANCE REPORT 
The Performance Report offers statistical data from the operation or The Performance Report offers statistical data from the operation or 
backtest of a trading system. Use the Performance Report for the following: backtest of a trading system. Use the Performance Report for the following: 

l Evaluating the profitability of your trading systemEvaluating the profitability of your trading system  
l Finding out if a real trade would be reasonableFinding out if a real trade would be reasonable  
l Evaluating the risks that can develop during the tradeEvaluating the risks that can develop during the trade  
l Estimating the need for capitalEstimating the need for capital  
l Comparing the distribution of profits over timeComparing the distribution of profits over time  
l Keeping an eye on the development of real trading resultsKeeping an eye on the development of real trading results  

In the Performance Report, statistical results are offered as tables and In the Performance Report, statistical results are offered as tables and 
diagrams. diagrams.   
  
The navigation to the right of the performance report can be toggled by clicking on the small arrow tot he right of the title.The navigation to the right of the performance report can be toggled by clicking on the small arrow tot he right of the title.  
  
Control of which items get printed can be found in the Control of which items get printed can be found in the publishpublishpublishpublish group of the property inspector. group of the property inspector.

CALL UP THE PERFORMANCE REPORTCALL UP THE PERFORMANCE REPORT  

The Performance Report is available for The Performance Report is available for ChartCharts and s and PortfolioPortfolios.s.  
  
Click on the Click on the PerformancePerformancePerformancePerformance button in the  button in the Trading SystemTrading System group in the  group in the ToolbarToolbar to open it. The results are calculated for the current  to open it. The results are calculated for the current 
workspace.workspace.

STATISTIC VALUESSTATISTIC VALUES  

GLOBALGLOBAL  

This is the default setting. In this view, you can see the results for the complete history length as a Strategy Performance Report. This is the default setting. In this view, you can see the results for the complete history length as a Strategy Performance Report. 
The results are offered in three columns. The first column shows the respective key figure for all trades, the second for long trades The results are offered in three columns. The first column shows the respective key figure for all trades, the second for long trades 
onlyonly and the third for short trades.  and the third for short trades.   
  

Performance ReportPerformance Report

Key FigureKey FigureKey FigureKey Figure ExplanationExplanationExplanationExplanation
Total Net ProfitTotal Net Profit Sum of all trades (profit and loss trades) after subtraction of all costs and slippagesSum of all trades (profit and loss trades) after subtraction of all costs and slippages
Gross ProfitGross Profit Sum of all winning tradesSum of all winning trades
Gross LossGross Loss Sum of all losing tradesSum of all losing trades

Profit FactorProfit Factor
The ratio of Gross Profit and the negative Gross Loss. This factor is a benchmark for how large the The ratio of Gross Profit and the negative Gross Loss. This factor is a benchmark for how large the 
expected profit per units of capital would have been in the test data.expected profit per units of capital would have been in the test data.

Open Position P/LOpen Position P/L Value of an open position during the analysisValue of an open position during the analysis
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Total Number of TradesTotal Number of Trades Total number of tradesTotal number of trades
Percent ProfitablePercent Profitable Percentage of profitable trades for the total number of tradesPercentage of profitable trades for the total number of trades
Number of Winning Number of Winning 
TradesTrades

Number of profitable tradesNumber of profitable trades

Number of Losing TradesNumber of Losing Trades Number of unprofitable tradesNumber of unprofitable trades
Number of Even TradesNumber of Even Trades Number of trades closed with neutral resultNumber of trades closed with neutral result
Number of Winning BarsNumber of Winning Bars Number of trading periods/candles/bars over which the profitable trades lastedNumber of trading periods/candles/bars over which the profitable trades lasted
Number of Losing BarsNumber of Losing Bars Number of trading periods/candles/bars over which the unprofitable trades lastedNumber of trading periods/candles/bars over which the unprofitable trades lasted
Number of Even BarsNumber of Even Bars Number of trading periods/candles/bars over which the neutral trades lastedNumber of trading periods/candles/bars over which the neutral trades lasted
     
Average Trade Net ProfitAverage Trade Net Profit Average result of all trades, calculated as Net Profit/Total Number TradesAverage result of all trades, calculated as Net Profit/Total Number Trades
Average Winning TradeAverage Winning Trade Average profit of the winning trades, calculated as Gross Profit/Number Winning TradesAverage profit of the winning trades, calculated as Gross Profit/Number Winning Trades
Average Losing TradeAverage Losing Trade Average profit of the losing trades, calculated as Gross Loss/Number Losing TradesAverage profit of the losing trades, calculated as Gross Loss/Number Losing Trades
Ratio Average Win. / Ratio Average Win. / 
Average Los.Average Los.

Ratio of Average Profit/Average LossRatio of Average Profit/Average Loss

Largest Winning TradeLargest Winning Trade The largest profitThe largest profit
Largest Losing TradeLargest Losing Trade The largest lossThe largest loss
     
Max. Consecutive Max. Consecutive 
Winning TradesWinning Trades

Longest series of profitable tradesLongest series of profitable trades

Max. Consecutive Losing Max. Consecutive Losing 
TradesTrades

Longest series of unprofitable tradesLongest series of unprofitable trades

Average Bars in Total Average Bars in Total 
TradesTrades

Average number of periods per tradeAverage number of periods per trade

Total Bars in TradeTotal Bars in Trade Sum of all trading periods/candles/bars over which open positions were heldSum of all trading periods/candles/bars over which open positions were held
Average Bars in Winning Average Bars in Winning 
TradesTrades

Average duration of profitable trades in periods/candles/barsAverage duration of profitable trades in periods/candles/bars

Average Bars in Losing Average Bars in Losing 
TradesTrades

Average duration of unprofitable trades in periods/candles/barsAverage duration of unprofitable trades in periods/candles/bars

Average Bars in Even Average Bars in Even 
TradesTrades

Average duration of neutral trades in periods/candles/barsAverage duration of neutral trades in periods/candles/bars

Num. of Consecutive Num. of Consecutive 
Losing TradesLosing Trades

Length of the latest series of unprofitable tradesLength of the latest series of unprofitable trades

Num. of consecutive Num. of consecutive 
Winning TradesWinning Trades

Length of the latest series of profitable tradesLength of the latest series of profitable trades

     
Max. Shares / Contracts Max. Shares / Contracts 
HeldHeld

Biggest single positionBiggest single position

Total Shares / Contracts Total Shares / Contracts 
HeldHeld

Sum of all traded sharesSum of all traded shares

Total CommissionTotal Commission Sum of all costsSum of all costs
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On the left of the Performance Report, you can find further links to display trading system results as periods and graphic displays.On the left of the Performance Report, you can find further links to display trading system results as periods and graphic displays.

PERIODIC RESULTSPERIODIC RESULTS  

The returns are shown in three ways. As key figures, the Net Profit, The returns are shown in three ways. As key figures, the Net Profit, 
Number of Trades and Number of Trades and % Profitable% Profitable are displayed.  are displayed. 

l Returns/MonthReturns/MonthReturns/MonthReturns/Month  -- Display the performance development for each  Display the performance development for each 
month of the test period.month of the test period.  

l Returns/QuarterReturns/QuarterReturns/QuarterReturns/Quarter  -- Display the performance development for each  Display the performance development for each 
quarter (three months) of the test period.quarter (three months) of the test period.  

l Returns/YearReturns/YearReturns/YearReturns/Year  -- Display the performance development for each year  Display the performance development for each year 
of the test period.of the test period.  

It is possible to show column summaries in the footer of this view by rightIt is possible to show column summaries in the footer of this view by right--

Total SlippageTotal Slippage Sum of slippage over all tradesSum of slippage over all trades
Account Size RequiredAccount Size Required Necessary account size to trade the systemNecessary account size to trade the system
Return on AccountReturn on Account Percentage development of the invested capitalPercentage development of the invested capital
     
Sharpe RatioSharpe Ratio Index for the profitability of an investment compared to the riskIndex for the profitability of an investment compared to the risk
Average Sharpe RatioAverage Sharpe Ratio Sharpe Ratio over the full data rangeSharpe Ratio over the full data range
Froehlich FactorFroehlich Factor Complex indicator for evaluating the quality of the trading system resultsComplex indicator for evaluating the quality of the trading system results
Start DateStart Date Date of the first periodDate of the first period
End DateEnd Date Date of the last periodDate of the last period
Trading PeriodTrading Period Timespan of the data (History Length)Timespan of the data (History Length)

Time in the MarketTime in the Market
Number of days or intraday periods in which positions were open, including weekends and holidays Number of days or intraday periods in which positions were open, including weekends and holidays 
(absolute value)(absolute value)

Percent of Time in the Percent of Time in the 
MarketMarket

Percentage of days with open positionsPercentage of days with open positions

Max. DrawdownMax. Drawdown Largest cutback in profitLargest cutback in profit
Max. Drawdown DateMax. Drawdown Date Date of the largest cutback in profitDate of the largest cutback in profit
Max. Intraday DrawdownMax. Intraday Drawdown Largest cutback of profit since the last open equity maximumLargest cutback of profit since the last open equity maximum
Total PositionsTotal Positions Number of held positions. If partial trades are used, higher values result than for full trades.Number of held positions. If partial trades are used, higher values result than for full trades.
Position ChangesPosition Changes Number of switches between Long and Short tradesNumber of switches between Long and Short trades

Total Closed PositionsTotal Closed Positions
Number of positions kept by the system. If partial trades are used, this key figure is higher than the Number of positions kept by the system. If partial trades are used, this key figure is higher than the 
Total Number of Trades.Total Number of Trades.

Periodic ResultsPeriodic Results
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clicking on a column's footer and selecting one or more of the summary clicking on a column's footer and selecting one or more of the summary 
calculations.calculations.

GRAPHIC RESULTSGRAPHIC RESULTS  

For the graphic display, the two links offer four different diagrams:For the graphic display, the two links offer four different diagrams:  
  
Graphs Graphs -- Equity Equity::

l Equity by TradeEquity by TradeEquity by TradeEquity by Trade  -- The equities are shown in the trade sequence. The equities are shown in the trade sequence.  
l Equity by DateEquity by DateEquity by DateEquity by Date  -- The equities are shown in the sequence of dates. The equities are shown in the sequence of dates.  

Graph Graph -- Equity Underwater Equity Underwater, this means the drawdown/cutback:, this means the drawdown/cutback:

l Monthly Equity UnderwaterMonthly Equity UnderwaterMonthly Equity UnderwaterMonthly Equity Underwater  -- Phases in which the profit was declining, in absolute values of the traded currencies or  Phases in which the profit was declining, in absolute values of the traded currencies or 
units.units.  

l Monthly Equity Underwater (Percentage)Monthly Equity Underwater (Percentage)Monthly Equity Underwater (Percentage)Monthly Equity Underwater (Percentage)  -- Phases in which the profit was declining, in percentage values. This diagram  Phases in which the profit was declining, in percentage values. This diagram 
makes it possible to compare drawdown phases over longer time spans.makes it possible to compare drawdown phases over longer time spans.  

The chart styles and colors can be changed by selecting the options in the property inspector.The chart styles and colors can be changed by selecting the options in the property inspector.

DISPLAY BY TRADESDISPLAY BY TRADES  

Next to the links for the statistics you can find the list of trades sorted by Next to the links for the statistics you can find the list of trades sorted by 
date (50 trades/page by default). Click on a number link to view the trades.date (50 trades/page by default). Click on a number link to view the trades.  
  
To return to the statistics, click on To return to the statistics, click on StatisticsStatisticsStatisticsStatistics..  
  

  
  
It is possible to show column summaries in the footer of this view by rightIt is possible to show column summaries in the footer of this view by right--clicking on a column's footer and selecting one or more clicking on a column's footer and selecting one or more 
of the summary calculations.of the summary calculations.    

Drawdown AnalysisDrawdown Analysis

Display by TradesDisplay by Trades

ColumnColumnColumnColumn DescriptionDescriptionDescriptionDescription
## Serial number of the tradeSerial number of the trade
CommandCommand Labeling whether the trade was sell or buy, short or long.Labeling whether the trade was sell or buy, short or long.
SymbolSymbol Traded securityTraded security
Fill DateFill Date Day of the tradeDay of the trade
Fill PriceFill Price Exact price of the purchaseExact price of the purchase
ProfitProfit Absolute profit of the tradeAbsolute profit of the trade

SignalSignal
Part of the trading system that set off the trade, for example Part of the trading system that set off the trade, for example 
entry or stop indicatorsentry or stop indicators

Com.Com. Commission as entered in Money ManagementCommission as entered in Money Management
Slip.Slip. Slippage as entered in Money ManagementSlippage as entered in Money Management
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POSITION SIZING - VARIOUS METHODS 
In the course of their career, many traders realize that their success at the In the course of their career, many traders realize that their success at the 
market is less governed by entry signals, filter techniques or analysis market is less governed by entry signals, filter techniques or analysis 
routines. Money management, i.e. controlling the risks and the investment routines. Money management, i.e. controlling the risks and the investment 
of capital are the crucial factors for successful trading. One of the most of capital are the crucial factors for successful trading. One of the most 
important aspects of the money management is the position sizing, i.e. the important aspects of the money management is the position sizing, i.e. the 
number of shares/contracts per position. number of shares/contracts per position.   
  
In the following chapter, various methods are given for position sizing.In the following chapter, various methods are given for position sizing.

ADDING THE POSITION SIZING STRATEGIESADDING THE POSITION SIZING STRATEGIES  

1.1. In the In the Trading SystemsTrading Systems area of the toolbar, click on the  area of the toolbar, click on the Add Add Add Add 
StrategiesStrategiesStrategiesStrategies button. button.  

2.2. Click on the tab Click on the tab Position SizingPosition SizingPosition SizingPosition Sizing..  

Here you can select up to six strategies for position sizing to be added to your chart or portfolio.Here you can select up to six strategies for position sizing to be added to your chart or portfolio.

METHODSMETHODS  

FIXED FRACTIONALFIXED FRACTIONAL  

This position sizing model uses fixed fractions of capital the to specify This position sizing model uses fixed fractions of capital the to specify 
position size. There are four methods to specify the fraction multiplier. position size. There are four methods to specify the fraction multiplier.   
  
FixedFracModelFixedFracModelFixedFracModelFixedFracModel  -- Here you can choose between four models for the  Here you can choose between four models for the 
calculation of the fixed fractions: calculation of the fixed fractions: 

l UnitsUnitsUnitsUnits  -- Here you can enter a fixed amount of capital; for instance,  Here you can enter a fixed amount of capital; for instance, 
use 5000 to trade 1 contract for every 5000 euro (%Toinvest = 1 / X).use 5000 to trade 1 contract for every 5000 euro (%Toinvest = 1 / X).  

l MaxRiskMaxRiskMaxRiskMaxRisk  -- Here you can specify the expected biggest loss in points  Here you can specify the expected biggest loss in points 
to use this model.to use this model.  

l CapitalCapitalCapitalCapital  -- This is used for future trading only, you can take the margin into account. This is used for future trading only, you can take the margin into account.  

l FixRiskFixRiskFixRiskFixRisk  

FractionofCapitalFractionofCapitalFractionofCapitalFractionofCapital  -- Enter what fraction of capital (according to the calculation above) is to be used per trade.  Enter what fraction of capital (according to the calculation above) is to be used per trade.   
  
BiggestLossBiggestLossBiggestLossBiggestLoss  -- For the  For the MaxRiskMaxRisk model, enter the biggest loss in points here. model, enter the biggest loss in points here.  
  
XXXX  -- For the  For the UnitsUnitsUnitsUnits model, enter the "X" value here. model, enter the "X" value here.  
  
FixedRiskFixedRiskFixedRiskFixedRisk  -- When using the model  When using the model Fixed RiskFixed Risk, enter the value for the fixed risk in points here., enter the value for the fixed risk in points here.  

Add StrategyAdd Strategy

Example for Fixed FractionalExample for Fixed Fractional
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InitialMarginInitialMarginInitialMarginInitialMargin  -- Here you can enter the initial margin. It determines how much you can invest in order to ensure your account has  Here you can enter the initial margin. It determines how much you can invest in order to ensure your account has 
sufficient reserves to cover a potential margin callsufficient reserves to cover a potential margin call  
  
MaxLeverageMaxLeverageMaxLeverageMaxLeverage  -- Here you can enter the maximum leverage as multiplier that you have available. If you use 2x leverage, you get a  Here you can enter the maximum leverage as multiplier that you have available. If you use 2x leverage, you get a 
loan from the broker equivalent to 100% of your investment. loan from the broker equivalent to 100% of your investment.   
  
ReduceReduceReduceReduce  -- Some of the options may lead to overstepping the originally calculated investment capital or risk parameters. For such  Some of the options may lead to overstepping the originally calculated investment capital or risk parameters. For such 
cases, you can activate this option to ensure that the position sizes are reduced to meet the criteria of the main method.cases, you can activate this option to ensure that the position sizes are reduced to meet the criteria of the main method.  
  
Instrument CountInstrument CountInstrument CountInstrument Count  -- Here you can enter the number of instruments in the chart. This way, a portfolio can be simulated in a single  Here you can enter the number of instruments in the chart. This way, a portfolio can be simulated in a single 
chart. It allows you to distribute your available funds across multiple instruments in one chart.chart. It allows you to distribute your available funds across multiple instruments in one chart.

FIXED FRACTIONAL FIXED FRACTIONAL -- PERCENT PERCENT  

This position sizing model uses fixed fractions in percent of capital to This position sizing model uses fixed fractions in percent of capital to 
specify position size. There are four methods to specify the fraction specify position size. There are four methods to specify the fraction 
multiplier. multiplier.   
  
FixedFracModelFixedFracModelFixedFracModelFixedFracModel  -- Here you can choose between four models for the  Here you can choose between four models for the 
calculation of the fixed fractions: calculation of the fixed fractions: 

l UnitsUnitsUnitsUnits  -- Here you can enter a fixed amount of capital; for instance,  Here you can enter a fixed amount of capital; for instance, 
use 5000 to trade 1 contract for every 5000 euro (%Toinvest = 1 / X).use 5000 to trade 1 contract for every 5000 euro (%Toinvest = 1 / X).  

l MaxRiskMaxRiskMaxRiskMaxRisk  -- Here you can specify the expected biggest loss in points to use this model. Here you can specify the expected biggest loss in points to use this model.  

l CapitalCapitalCapitalCapital  -- This is used for future trading only, you can take the margin into account. This is used for future trading only, you can take the margin into account.  

l FixRiskFixRiskFixRiskFixRisk  --  

FractionofCapitalFractionofCapitalFractionofCapitalFractionofCapital  -- Enter what fraction of capital (according to the calculation above) is to be used per trade.  Enter what fraction of capital (according to the calculation above) is to be used per trade.   
  
BiggestLossPercentBiggestLossPercentBiggestLossPercentBiggestLossPercent  -- For the  For the MaxRiskMaxRisk model, enter the biggest loss in percent here. model, enter the biggest loss in percent here.  
  
XXXX  -- For the  For the UnitsUnitsUnitsUnits model, ener the "X" value here. model, ener the "X" value here.  
  
FixedRiskFixedRiskFixedRiskFixedRisk  -- When using the model  When using the model Fixed RiskFixed Risk, enter the value for the fixed risk in points here., enter the value for the fixed risk in points here.  
  
InitialMarginInitialMarginInitialMarginInitialMargin  -- Here you can enter the initial margin. It determines how much you can invest in order to ensure you account has  Here you can enter the initial margin. It determines how much you can invest in order to ensure you account has 
sufficient reserves to cover a potential margin call.sufficient reserves to cover a potential margin call.  
  
MaxLeverageMaxLeverageMaxLeverageMaxLeverage  -- Here you can enter the maximum leverage as multiplier that you have available. If you use 2x leverage, you get a  Here you can enter the maximum leverage as multiplier that you have available. If you use 2x leverage, you get a 
load for the broker equivalent to 100% of your investment. load for the broker equivalent to 100% of your investment.   
  
ReduceReduceReduceReduce  -- Some of the options may lead to overstepping the originally calculated investment capital or risk parameters. For such  Some of the options may lead to overstepping the originally calculated investment capital or risk parameters. For such 
cases, you can activate this option to ensure that the position sizes are reduced to meet the criteria of the main method.cases, you can activate this option to ensure that the position sizes are reduced to meet the criteria of the main method.  
  

Example for Fixed Fractional Example for Fixed Fractional -- Percent Percent
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Instrument CountInstrument CountInstrument CountInstrument Count  -- Here you can enter the number of instruments in the chart. This way, a portfolio can be simulated in a single  Here you can enter the number of instruments in the chart. This way, a portfolio can be simulated in a single 
chart. It allows you to distribute your available funds across multiple instruments in one chart.chart. It allows you to distribute your available funds across multiple instruments in one chart.

FIXED PERCENTFIXED PERCENT  

This method is one of the simplest. It invests a fixed percentage of the This method is one of the simplest. It invests a fixed percentage of the 
available capital and equity in the next trade. Neither the current market available capital and equity in the next trade. Neither the current market 
situation nor any information about past trades are considered.situation nor any information about past trades are considered.  
  
The example chart shows the strategy The example chart shows the strategy Stochastic Momentum Stochastic Momentum -- Entry Entry  
(delivered with Tradesignal). The position sizing strategy invests a fixed 5% (delivered with Tradesignal). The position sizing strategy invests a fixed 5% 
of the initial capital of 10000 USD into the first trade. The broker offers a of the initial capital of 10000 USD into the first trade. The broker offers a 
leverage of 1:20, so that with a capital of 10000leverage of 1:20, so that with a capital of 10000 EUR, 7784 shares at a  EUR, 7784 shares at a 
quote of 1.2846 USD can be traded.quote of 1.2846 USD can be traded.  
  

Example for Fixed PercentExample for Fixed Percent

OptionsOptionsOptionsOptionsOptions  
  
PercentToInvestPercentToInvestPercentToInvestPercentToInvest  -- Percent of initial capital to invest in the next trade. Percent of initial capital to invest in the next trade.  
  
FixedMarginFixedMarginFixedMarginFixedMargin  -- Here you can enter a fixed margin, e.g. when trading currencies. Here you can enter a fixed margin, e.g. when trading currencies.  
  
MaxSharesMaxSharesMaxSharesMaxShares  -- Here you can set a maximum share per position.  Here you can set a maximum share per position.   
  
ResetResetResetReset  -- Here you can specify after which time you take your profits from the market and the invested capital is reset to the original  Here you can specify after which time you take your profits from the market and the invested capital is reset to the original 
initial capital. You can choose between initial capital. You can choose between yearlyyearlyyearlyyearly, , monthlymonthlymonthlymonthly, , NeverNeverNeverNever (all capital is reinvested continuously) or  (all capital is reinvested continuously) or No Position SizingNo Position SizingNo Position SizingNo Position Sizing..  
  
Instrument CountInstrument CountInstrument CountInstrument Count  -- Here you can enter the number of instruments in the chart. This way, a portfolio can be simulated in a single  Here you can enter the number of instruments in the chart. This way, a portfolio can be simulated in a single 
chart. It allows you to distribute your available funds across multiple instruments in one chart.chart. It allows you to distribute your available funds across multiple instruments in one chart.

FIXED RISKFIXED RISK  

This position sizing model tries to determine what the risk of the next trade This position sizing model tries to determine what the risk of the next trade 
will be. A fixed percentage of the initial capital is risked with the next will be. A fixed percentage of the initial capital is risked with the next 
trade.trade.  
  
This method is especially useful when you define a stop loss for each This method is especially useful when you define a stop loss for each 
trade. The method calculates the volatility of the base value and multiplies trade. The method calculates the volatility of the base value and multiplies 
it with a factor set by you. This way, the position size can optimally be it with a factor set by you. This way, the position size can optimally be 
linked to the market conditions. linked to the market conditions.   
  
The method assumes that you are using a stop loss. It is recommended that you use a volatilityThe method assumes that you are using a stop loss. It is recommended that you use a volatility--driven stop. The position size is driven stop. The position size is 
calculated so that the maximum loss per trade set by you is not exceeded.calculated so that the maximum loss per trade set by you is not exceeded.  
  
The example chart shows the strategy The example chart shows the strategy Stochastic Momentum Stochastic Momentum -- Entry Entry (delivered with Tradesignal). Once the program has measured  (delivered with Tradesignal). Once the program has measured 

Example for Fixed RiskExample for Fixed Risk
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the volatility, the risked capital is divided by the volatility. If a leverage is used, it is included in the calculation. If you have set a the volatility, the risked capital is divided by the volatility. If a leverage is used, it is included in the calculation. If you have set a 
fixed margin, the risked capital is divided by the fixed margin. In all other cases, the calculated risked amount is divided by the fixed margin, the risked capital is divided by the fixed margin. In all other cases, the calculated risked amount is divided by the 
current close price of the base value. current close price of the base value.   
  
OptionsOptionsOptionsOptionsOptions  
  
PercentToInvestPercentToInvestPercentToInvestPercentToInvest  -- Percent of initial capital to invest in the next trade. Percent of initial capital to invest in the next trade.  
  
FixedMarginFixedMarginFixedMarginFixedMargin  -- Here you can enter a fixed margin, e.g. when trading currencies. Here you can enter a fixed margin, e.g. when trading currencies.  
  
MarketRiskMeasureMarketRiskMeasureMarketRiskMeasureMarketRiskMeasure  -- To measure the volatility of the base value, you can either use the standard deviation or the Average True  To measure the volatility of the base value, you can either use the standard deviation or the Average True 
Range.Range.  
  
RiskTimingRiskTimingRiskTimingRiskTiming  -- Set the calculation period for the volatility measurement. Set the calculation period for the volatility measurement.  
  
ResetResetResetReset  -- Here you can specify after which time you take your profits from the market and the invested capital is reset to the original  Here you can specify after which time you take your profits from the market and the invested capital is reset to the original 
initial capital. You can choose between initial capital. You can choose between yearlyyearlyyearlyyearly, , monthlymonthlymonthlymonthly, , NeverNeverNeverNever (all capital is reinvested continuously) or  (all capital is reinvested continuously) or No Position SizingNo Position SizingNo Position SizingNo Position Sizing..  
  
Instrument CountInstrument CountInstrument CountInstrument Count  -- Here you can enter the number of instruments in the chart. This way, a portfolio can be simulated in a single  Here you can enter the number of instruments in the chart. This way, a portfolio can be simulated in a single 
chart. It allows you to distribute your available funds across multiple instruments in one chart.chart. It allows you to distribute your available funds across multiple instruments in one chart.

PERCENT VOLATILITYPERCENT VOLATILITY  

This method works similar to the "Fixed Risk" method. It measures the This method works similar to the "Fixed Risk" method. It measures the 
volatility of the base value and scales the position sizing accordingly. As volatility of the base value and scales the position sizing accordingly. As 
additional parameter, you have to enter a multiplier for the maximum additional parameter, you have to enter a multiplier for the maximum 
expected loss. The result of the multiplication of this factor and the expected loss. The result of the multiplication of this factor and the 
measured volatility is used as basis for the calculation of the position measured volatility is used as basis for the calculation of the position 
sizing. sizing.   
  
OptionsOptionsOptionsOptionsOptionsFractionofCapitalFractionofCapitalFractionofCapitalFractionofCapital  -- Enter how much fraction of capital is to be  Enter how much fraction of capital is to be 
used for each trade.used for each trade.  
  
VolatilityModelVolatilityModelVolatilityModelVolatilityModel  -- To measure the volatility of the base value, you can use the Average True Range or the momentum. The  To measure the volatility of the base value, you can use the Average True Range or the momentum. The 
momentum is given as absolute value from one bar to the next one. With the result, a moving average over the "volatility period" is momentum is given as absolute value from one bar to the next one. With the result, a moving average over the "volatility period" is 
calculated for smoothing. calculated for smoothing.   
  
VolatilityPeriodVolatilityPeriodVolatilityPeriodVolatilityPeriod  -- Enter the period over which the volatility is calculated. Enter the period over which the volatility is calculated.  
  
BiggestVolaLossBiggestVolaLossBiggestVolaLossBiggestVolaLoss  --  -- Enter a multiplier for the measured volatility. This value gives the highest maximum loss possible as multiple  Enter a multiplier for the measured volatility. This value gives the highest maximum loss possible as multiple 
of the volatility. of the volatility.   
  
ProfitProfitProfitProfit (Factor Profit)  (Factor Profit) -- With this multiplier, the amount of accumulated gain is included in the calculation of position sizes. With this multiplier, the amount of accumulated gain is included in the calculation of position sizes.  
  
MaxLeverageMaxLeverageMaxLeverageMaxLeverage  -- Enter the maximal leverage. Enter the maximal leverage.  

Example for Percent VolatilityExample for Percent Volatility
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ReduceReduceReduceReduce  -- Some of the options may lead to overstepping the originally calculated investment capital or risk parameters. For such  Some of the options may lead to overstepping the originally calculated investment capital or risk parameters. For such 
cases, you can activate this option to ensure that the position sizes are reduced to meet the criteria of the main method.cases, you can activate this option to ensure that the position sizes are reduced to meet the criteria of the main method.  
  
Instrument CountInstrument CountInstrument CountInstrument Count  -- Here you can enter the number of instruments in the chart. This way, a portfolio can be simulated in a single  Here you can enter the number of instruments in the chart. This way, a portfolio can be simulated in a single 
chart. It allows you to distribute your available funds across multiple instruments in one chart.chart. It allows you to distribute your available funds across multiple instruments in one chart.

MARKET'S MONEYMARKET'S MONEY  

This method works similar to the This method works similar to the Percent Volatility methodPercent Volatility method method. In  method. In 
addition to it, it reinvests profits with leverage. If your capital has addition to it, it reinvests profits with leverage. If your capital has 
decreased, the position size will be reduced. decreased, the position size will be reduced.   
  
If If FactorProfitFactorProfitFactorProfitFactorProfit is set to the same value as  is set to the same value as BiggestVolaLossBiggestVolaLossBiggestVolaLossBiggestVolaLoss, the method , the method 
reacts identical to the "Percent Volatility" method.reacts identical to the "Percent Volatility" method.  
  

Example for Market's MoneyExample for Market's Money
OptionsOptionsOptionsOptionsOptions  
  
FractionofCapitalFractionofCapitalFractionofCapitalFractionofCapital  -- Enter how much fraction of capital is to be used for each trade. Enter how much fraction of capital is to be used for each trade.  
  
VolatilityModelVolatilityModelVolatilityModelVolatilityModel  -- To measure the volatility of the base value, you can use the Average True Range or the momentum. The  To measure the volatility of the base value, you can use the Average True Range or the momentum. The 
momentum is given as absolute value from one bar to the next one. With the result, a moving average over the "volatility period" is momentum is given as absolute value from one bar to the next one. With the result, a moving average over the "volatility period" is 
calculated for smoothing. calculated for smoothing.   
  
VolatilityPeriodVolatilityPeriodVolatilityPeriodVolatilityPeriod  -- Enter the period over which the volatility is calculated. Enter the period over which the volatility is calculated.  
  
BiggestVolaLossBiggestVolaLossBiggestVolaLossBiggestVolaLoss  --  -- Enter a multiplier for the measured volatility. This value gives the highest maximum loss possible as multiple  Enter a multiplier for the measured volatility. This value gives the highest maximum loss possible as multiple 
of the volatility. of the volatility.   
  
ProfitProfitProfitProfit (Factor Profit)  (Factor Profit) -- With this multiplier, the amount of accumulated gain is included in the calculation of position sizes. With this multiplier, the amount of accumulated gain is included in the calculation of position sizes.  
  
MaxLeverageMaxLeverageMaxLeverageMaxLeverage  -- Enter the maximal leverage. Enter the maximal leverage.  
  
ReduceReduceReduceReduce  -- Some of the options may lead to overstepping the originally calculated investment capital or risk parameters. For such  Some of the options may lead to overstepping the originally calculated investment capital or risk parameters. For such 
cases, you can activate this option to ensure that the position sizes are reduced to meet the criteria of the main method.cases, you can activate this option to ensure that the position sizes are reduced to meet the criteria of the main method.  
  
Instrument CountInstrument CountInstrument CountInstrument Count  -- Here you can enter the number of instruments in the chart. This way, a portfolio can be simulated in a single  Here you can enter the number of instruments in the chart. This way, a portfolio can be simulated in a single 
chart. It allows you to distribute your available funds across multiple instruments in one chart.chart. It allows you to distribute your available funds across multiple instruments in one chart.    
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AUTOMATIC ORDER ROUTING 
Under order routing, the routing of trading signals of a mechanical trading system to a connected broker is understood. The function Under order routing, the routing of trading signals of a mechanical trading system to a connected broker is understood. The function 
can be used to: can be used to: 

l Route signals of a trading system automatically to the stock exchange via a brokerRoute signals of a trading system automatically to the stock exchange via a broker  
l Route signals of a trading system manually to the stock exchange via a brokerRoute signals of a trading system manually to the stock exchange via a broker  
l Test a trading system under live conditions via the demo access of a brokerTest a trading system under live conditions via the demo access of a broker  

Please note that the automatic order routing is not available for every data provider.Please note that the automatic order routing is not available for every data provider.  
  
Note:Note:Note:Note:  
Data vendors (and 3rd party data files) may deliver erroneous data that may be represented as valid data. Data vendors may change Data vendors (and 3rd party data files) may deliver erroneous data that may be represented as valid data. Data vendors may change 
their interface at any time and without prior notice, such an update can introduce breaking changes. Access to data from a data their interface at any time and without prior notice, such an update can introduce breaking changes. Access to data from a data 
vendor may be delayed or fail due to network congestion, network errors, server outages, power failure and other factors.vendor may be delayed or fail due to network congestion, network errors, server outages, power failure and other factors.

HOW THE ORDER ROUTING WORKSHOW THE ORDER ROUTING WORKS  

To use the order routing function, a number of preferences have to be set:To use the order routing function, a number of preferences have to be set:

l Create an account and configure settings in the Create an account and configure settings in the Order Routing OptionsOrder Routing Options  
l Activating the order routing for a chart or portfolio in the Activating the order routing for a chart or portfolio in the Automation Options of the Trading SystemAutomation Options of the Trading System  
l Starting and stopping the order routing via the Starting and stopping the order routing via the Order RoutingOrder RoutingOrder RoutingOrder Routing toolbar, see the section  toolbar, see the section Button Menu Order RoutingButton Menu Order Routing..  

Several levels of automation are possible, up to fully automated trading without interference from outside. Several levels of automation are possible, up to fully automated trading without interference from outside.   
  
Important:Important:Important:Important: When automatic order routing is active a small routing icon will be displayed above the toolbar, to the left of the clock.  When automatic order routing is active a small routing icon will be displayed above the toolbar, to the left of the clock. 
This icon may be clicked to This icon may be clicked to Stop All Order RoutingStop All Order RoutingStop All Order RoutingStop All Order Routing..

ORDER ROUTING OPTIONSORDER ROUTING OPTIONS  

BROKER ACCOUNTSBROKER ACCOUNTS  

A A Broker AccountBroker Account is the terminology user in Tradesignal to refer to a  is the terminology user in Tradesignal to refer to a 
connection to an account with a specific broker and associated settings. It connection to an account with a specific broker and associated settings. It 
is possible to have multiple named broker accounts to the same physical is possible to have multiple named broker accounts to the same physical 
account at the same broker but with different settings. Doing so allows account at the same broker but with different settings. Doing so allows 
different strategies to be created for trading different security types with the different strategies to be created for trading different security types with the 
same physical account for example.same physical account for example.  
  
Important:Important:Important:Important: Some brokers do not provide a mechanism to take multiple  Some brokers do not provide a mechanism to take multiple 
manageable positions in the same security. Without this feature, it is not manageable positions in the same security. Without this feature, it is not 
possible to possible to correctlycorrectly manage multiple  manage multiple independentindependent strategy positions for the same security on the same physical account.  strategy positions for the same security on the same physical account. 
Tradesignal will prevent order routing from being started if it is already active for a given security on the same physical account in Tradesignal will prevent order routing from being started if it is already active for a given security on the same physical account in 

Order Routing in the Tradesignal OptionsOrder Routing in the Tradesignal Options
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such cases.such cases.

l Add a new broker accountAdd a new broker accountAdd a new broker accountAdd a new broker account  -- Accounts are added in the options menu under  Accounts are added in the options menu under File > Options > Order Routing > Broker File > Options > Order Routing > Broker 
AccountsAccounts by clicking on the  by clicking on the Add new broker accountAdd new broker accountAdd new broker accountAdd new broker account link. link.  

l Remove AccountRemove AccountRemove AccountRemove Account  -- Accounts can be removed by clicking the  Accounts can be removed by clicking the XXXX button next to the account in the list of accounts. button next to the account in the list of accounts.  
l Edit AccountEdit AccountEdit AccountEdit Account  --Account settings can be modified by clicking on the account name listed below Account settings can be modified by clicking on the account name listed below Order RoutingOrder RoutingOrder RoutingOrder Routing under  under File > File > 

OptionsOptions..  

CONFIGURATION OF THE ORDER ROUTING ACCOUNTCONFIGURATION OF THE ORDER ROUTING ACCOUNT  

In this menu, all settings for the broker account and the general handling of In this menu, all settings for the broker account and the general handling of 
the orders are entered. Do not change the port number and IP address.the orders are entered. Do not change the port number and IP address.  
  
Selection of the Broker and name for the account are only available in the Selection of the Broker and name for the account are only available in the 
wizard when first creating the account.wizard when first creating the account.

l Enter a name for the order routing accountEnter a name for the order routing accountEnter a name for the order routing accountEnter a name for the order routing account  -- Enter an account  Enter an account 
name that is used for this broker within Tradesignal.name that is used for this broker within Tradesignal.  

l PortPortPortPort  -- Port number of the broker's trading application, e.g. in IB  Port number of the broker's trading application, e.g. in IB 
TWS. TWS.   
(Please note: I you use more than one TWS on one machine, you (Please note: I you use more than one TWS on one machine, you 
have to change the portnumbers in the TWS. After this Enter these have to change the portnumbers in the TWS. After this Enter these 
Portnumber here. Otherwise the orders can appear in both TWS)Portnumber here. Otherwise the orders can appear in both TWS)  

l LocalhostLocalhostLocalhostLocalhost  -- IP of the broker's trading application. IP of the broker's trading application.  
l Account CodeAccount CodeAccount CodeAccount Code  -- Your account at the broker, e.g. the "Interactive Brokers Account Code" for IB.  Your account at the broker, e.g. the "Interactive Brokers Account Code" for IB.   

(Please note: The correct Account Number is only for synchonizing neccessary. The Orders will be directed to the TWS via (Please note: The correct Account Number is only for synchonizing neccessary. The Orders will be directed to the TWS via 
the correct Portnumber)the correct Portnumber)**Order TransmissionOrder TransmissionOrder TransmissionOrder Transmission  -- Select here whether the orders are routed in the  Select here whether the orders are routed in the AutomaticAutomaticAutomaticAutomatic or  or ManualManualManualManual  
mode.mode.  

l Action on Session EndAction on Session EndAction on Session EndAction on Session End  -- Configure here how orders shortly before the session end will be handled. They are either routed  Configure here how orders shortly before the session end will be handled. They are either routed 
to the broker as a market order (to the broker as a market order (Map Close Orders to Market OrderMap Close Orders to Market OrderMap Close Orders to Market OrderMap Close Orders to Market Order) before session end (also see the section ) before session end (also see the section OnOn--Close Close 
OrderOrder) or routed as ) or routed as Map Close Orders to MarketMap Close Orders to MarketMap Close Orders to MarketMap Close Orders to Market----OnOnOnOn----Close OrderClose OrderClose OrderClose Order. In the latter case, the execution depends on the . In the latter case, the execution depends on the 
definition for this order type at your broker. A "Market Order" is routed instantly, while a ""Market on Close Order" is routed definition for this order type at your broker. A "Market Order" is routed instantly, while a ""Market on Close Order" is routed 
at a certain time before the session end.at a certain time before the session end.  

l Log LevelLog LevelLog LevelLog Level  -- Here you can set the log level for details of the order processing and related tasks. The level  Here you can set the log level for details of the order processing and related tasks. The level SystemSystemSystemSystem logs the  logs the 
least detailed data, the level least detailed data, the level DetailsDetailsDetailsDetails the most. We recommend that you keep the default setting. the most. We recommend that you keep the default setting.  

The information appears in the output window in the lower area of the window. It can be opened by a click on the grip bar.The information appears in the output window in the lower area of the window. It can be opened by a click on the grip bar.  
  
Note:Note:Note:Note:  
Brokers may deliver erroneous data that may be represented as valid data. Brokers may change their interface at any time and Brokers may deliver erroneous data that may be represented as valid data. Brokers may change their interface at any time and 
without prior notice, such an update can introduce breaking changes. Instructions sent to a broker or access to quotes may be without prior notice, such an update can introduce breaking changes. Instructions sent to a broker or access to quotes may be 
delayed or fail due to congestion, network errors, server outages, power failure and other factors. Brokerdelayed or fail due to congestion, network errors, server outages, power failure and other factors. Broker--supplied software may be supplied software may be 
required for connection between Tradesignal and a broker. Such software may have stability issues or exhibit errors under some required for connection between Tradesignal and a broker. Such software may have stability issues or exhibit errors under some 
circumstances.circumstances.

Order Routing Account SettingsOrder Routing Account Settings
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ORDER CONFIRMATIONORDER CONFIRMATION  

In this menu, you define whether Tradesignal should send the orders In this menu, you define whether Tradesignal should send the orders 
automatically to the broker or if certain constraints should be applied to the automatically to the broker or if certain constraints should be applied to the 
order routing. order routing.   
  
Note that in the settings of the broker account, similar settings for order Note that in the settings of the broker account, similar settings for order 
routing are entered. However, those determine the behavior of the order routing are entered. However, those determine the behavior of the order 
software of the broker. software of the broker. 

l Manually confirm all ordersManually confirm all ordersManually confirm all ordersManually confirm all orders  -- Select this option for manual  Select this option for manual 
confirmation of automatically generated orders. There are several settings available, some of them depending on time. The confirmation of automatically generated orders. There are several settings available, some of them depending on time. The 
options range from indefinite waiting to order cancellation. If this is not set, orders will be automatically sent.options range from indefinite waiting to order cancellation. If this is not set, orders will be automatically sent.  

The remaining settings configure exceptions to manual confirmation, namely:The remaining settings configure exceptions to manual confirmation, namely:

l Send order cancellations without manual confirmationSend order cancellations without manual confirmation  
l Send order modifications without manual confirmationSend order modifications without manual confirmation  
l Wait only a specific period of time to obtain manual confirmation and then take a default action:Wait only a specific period of time to obtain manual confirmation and then take a default action:

¡ Do not place orderDo not place order  
¡ Do not place order and stop order routingDo not place order and stop order routing  
¡ Place the orderPlace the order  

INITIAL SYNCHRONIZATIONINITIAL SYNCHRONIZATION  

In this menu, you can define which actions are to be undertaken during the In this menu, you can define which actions are to be undertaken during the 
start process of the order routing.start process of the order routing.    
  
When starting the order routing, Tradesignal is able to synchronize the When starting the order routing, Tradesignal is able to synchronize the 
positions in the trading system with the account positions. Several options positions in the trading system with the account positions. Several options 
are available.are available.

l Do not modify the account position Do not modify the account position -- Positions are not changed. Positions are not changed.  
l Modify account to strategy position with the first entry order from the Modify account to strategy position with the first entry order from the 

strategy strategy -- The positions are only synchronized with the first entry  The positions are only synchronized with the first entry 
order. This standard setting minimizes the trading costs.order. This standard setting minimizes the trading costs.  

l Cancel pending orders and modify account position with the first entry order Cancel pending orders and modify account position with the first entry order -- Pending orders are canceled and the positions  Pending orders are canceled and the positions 
are synchronized with the first entry order after the start. This may cause increased trading costs.are synchronized with the first entry order after the start. This may cause increased trading costs.  

l Cancel pending orders and modify account position with a market order Cancel pending orders and modify account position with a market order -- Pending orders are canceled and the positions are  Pending orders are canceled and the positions are 
instantly synchronized with an order. This may cause increased trading costs.instantly synchronized with an order. This may cause increased trading costs.  

STOPPING ORDER ROUTINGSTOPPING ORDER ROUTING  

Here you can set what is to happen when the order routing is stopped.Here you can set what is to happen when the order routing is stopped.

Order Verification Settings in the Tradesignal OptionsOrder Verification Settings in the Tradesignal Options

Order Start/Stop Settings in the Tradesignal OptionsOrder Start/Stop Settings in the Tradesignal Options
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l Cancel pending orders Cancel pending orders -- Pending orders are canceled without closing positions. Pending orders are canceled without closing positions.  
l Cancel pending orders and close positions Cancel pending orders and close positions -- Pending orders are canceled and open positions are closed. Pending orders are canceled and open positions are closed.  
l Do not modify account position Do not modify account position -- Positions are not changed. Positions are not changed.  

SYNCHRONIZATIONSYNCHRONIZATION  

Here you can define how Tradesignal will react when the account positions Here you can define how Tradesignal will react when the account positions 
are no longer synchronized with the positions in the trading system. Several are no longer synchronized with the positions in the trading system. Several 
settings are available, from automatic synchronization with market orders settings are available, from automatic synchronization with market orders 
to the stop of the automatic order routing with an alert. to the stop of the automatic order routing with an alert.   
  
If the account and strategy positions are no longer synchronized:If the account and strategy positions are no longer synchronized:

l Cancel all pending orders and generate a market order to Cancel all pending orders and generate a market order to 
synchronize positions synchronize positions -- Pending orders are canceled and a new order  Pending orders are canceled and a new order 
is issued to instantly synchronize the positions. This may cause is issued to instantly synchronize the positions. This may cause 
increased trading costs, especially if the synchronization is increased trading costs, especially if the synchronization is 
frequently lost.frequently lost.  

l Cancel all pending orders, generate exit orders and synchronize with Cancel all pending orders, generate exit orders and synchronize with 
the next entry order the next entry order -- Pending orders are canceled, current positions are closed and new entry positions are opened. Pending orders are canceled, current positions are closed and new entry positions are opened. This  This 
may cause increased trading costs, especially if the synchronization is frequently lost.may cause increased trading costs, especially if the synchronization is frequently lost.  

l Synchronize position on the next entry order Synchronize position on the next entry order -- Pending orders remain open, and the positions are synchronized only with the  Pending orders remain open, and the positions are synchronized only with the 
next entry order issued from the trading system. The entry order is changed (increased/decreased) to include the position next entry order issued from the trading system. The entry order is changed (increased/decreased) to include the position 
synchronization. Note that this can only be done with a market order or one limit/stop order. Systems with several limit synchronization. Note that this can only be done with a market order or one limit/stop order. Systems with several limit 
orders, e.g. with limit order above and below the current quote, cannot be synchronized this way.orders, e.g. with limit order above and below the current quote, cannot be synchronized this way.  

l Cancel all pending orders, close account position and synchronize position with the next entry order Cancel all pending orders, close account position and synchronize position with the next entry order -- Pending orders are  Pending orders are 
canceled, current positions are closed and new entry positions are opened.canceled, current positions are closed and new entry positions are opened. This may cause increased trading costs,  This may cause increased trading costs, 
especially if the synchronization is frequently lost.especially if the synchronization is frequently lost.  

l Stop automatic order routing and notify user with an alert Stop automatic order routing and notify user with an alert -- The order routing is stopped (any pending orders and positions  The order routing is stopped (any pending orders and positions 
remain open).remain open).  

l Notify user with an alert Notify user with an alert -- The order routing is not stopped but an alert is issued. The order routing is not stopped but an alert is issued.  
l Do nothingDo nothing  

l Seconds to wait for account and strategy positions to synchronize Seconds to wait for account and strategy positions to synchronize -- Enter the duration in seconds that the synchronization  Enter the duration in seconds that the synchronization 
may take. If synchronization fails, the timeout counter below starts. An outmay take. If synchronization fails, the timeout counter below starts. An out--ofof--sync chart will be highlighted.sync chart will be highlighted.  

l Seconds to wait for account and strategy positions before synchronization timeout Seconds to wait for account and strategy positions before synchronization timeout -- Enter the duration in seconds before the  Enter the duration in seconds before the 
above entered settings for handling the synchronization loss are applied.above entered settings for handling the synchronization loss are applied.  

Note:Note:Note:Note: If the  If the Send OnSend OnSend OnSend On----Close orders a few minutes before session endClose orders a few minutes before session endClose orders a few minutes before session endClose orders a few minutes before session end option is enabled, the position sizes will not be  option is enabled, the position sizes will not be 
checked within the specified number of minutes before session end. As soon as the session is closed, Tradesignal will continue to checked within the specified number of minutes before session end. As soon as the session is closed, Tradesignal will continue to 
check the position sizes in order to ensure the strategy and account positions are synchronous.check the position sizes in order to ensure the strategy and account positions are synchronous.

STOP AND LIMIT ORDERSTOP AND LIMIT ORDER  

Tradesignal offers you two methods for how generated stop or limit orders are to be treated at the session end. These options Tradesignal offers you two methods for how generated stop or limit orders are to be treated at the session end. These options 
determine how much the back test results may differ from real trading results.determine how much the back test results may differ from real trading results.

Position Synchronization Settings in the Tradesignal OptionsPosition Synchronization Settings in the Tradesignal Options
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l Wait for Tradesignal to report a fill then send as a Market Order Wait for Tradesignal to report a fill then send as a Market Order -- Tradesignal issues a stop or limit order only after the last  Tradesignal issues a stop or limit order only after the last 
order was confirmed as filled by the broker.order was confirmed as filled by the broker.  

l Send the order to the broker asSend the order to the broker as--is; take no actions if the order is not filled as expected is; take no actions if the order is not filled as expected -- Tradesignal issues stop or limit  Tradesignal issues stop or limit 
orders independently of fill confirmations.orders independently of fill confirmations.  

l When using the IB TWS, this option should be deactivated. When the option is deactivated, the existing stop or limit orders are When using the IB TWS, this option should be deactivated. When the option is deactivated, the existing stop or limit orders are 
updated at every new bar/tick in Tradesignal. If the option is active, all existing orders are canceled and new orders are issued. updated at every new bar/tick in Tradesignal. If the option is active, all existing orders are canceled and new orders are issued. 
This may result in problems, especially for fastThis may result in problems, especially for fast--trading stocks or futures, as the orders cannot be canceled quickly enough by the trading stocks or futures, as the orders cannot be canceled quickly enough by the 
trading software.trading software.

ONON--CLOSE ORDERSCLOSE ORDERS  

Here you can define how an order is routed when it is classified as "onHere you can define how an order is routed when it is classified as "on--close" by the trading system.close" by the trading system.

l Send onSend on--close orders at the end of the sessionclose orders at the end of the session  

l Send OnSend On--Close orders a few minutes before session end Close orders a few minutes before session end -- Select this option if the on Select this option if the on--close order is to be issued before the close order is to be issued before the 
set session end. You can enter a time in set session end. You can enter a time in Number in MinutesNumber in MinutesNumber in MinutesNumber in Minutes or click on the spin buttons. Please note that you can set  or click on the spin buttons. Please note that you can set 
similar order routing settings in the account settings of the broker. If your broker supports real onsimilar order routing settings in the account settings of the broker. If your broker supports real on--close orders, you may be close orders, you may be 
able to send them right at the session end.able to send them right at the session end.  

l Cancel active limit and stop orders after onCancel active limit and stop orders after on--Close orders are generated Close orders are generated -- Select this option if unfilled stop or limit orders are  Select this option if unfilled stop or limit orders are 
to be canceled when an onto be canceled when an on--close order is generated. This will keep the system from accidentally filling several orders.close order is generated. This will keep the system from accidentally filling several orders.  

TIMETIME--ININ--FORCEFORCE  

l Orders should stay active until canceled Orders should stay active until canceled -- If selected, the order may stay active for longer than the trading day. If selected, the order may stay active for longer than the trading day.  
l Orders should stay active for the trading day Orders should stay active for the trading day -- If selected, the order is only active for the current day and deleted at session  If selected, the order is only active for the current day and deleted at session 

end, if not filled.end, if not filled.  

l Always generate new orders when a bar opens Always generate new orders when a bar opens -- Select so that pending orders are canceled and new orders are generated at  Select so that pending orders are canceled and new orders are generated at 
each new bar. This option should not be used for short time periods, but may make sense for trading systems with long each new bar. This option should not be used for short time periods, but may make sense for trading systems with long 
periods, e.g. weekly.periods, e.g. weekly.  

SYMBOL MAPPINGSYMBOL MAPPING  

"Symbol Mapping" in Tradesignal means mapping the symbols of the "Symbol Mapping" in Tradesignal means mapping the symbols of the 
online data provider and the broker that refer to the same underlying online data provider and the broker that refer to the same underlying 
instrument. instrument.   
  
For the order routing to work, the program has to know this mapping. The For the order routing to work, the program has to know this mapping. The 
correct settings are very important for trading. correct settings are very important for trading.   
  
Attention:Attention:Attention:Attention: If the wrong symbols are entered or mapped here, the wrong  If the wrong symbols are entered or mapped here, the wrong 
symbol may be traded by the broker in the worst case. symbol may be traded by the broker in the worst case. 

Symbol MappingSymbol Mapping
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EDITING SYMBOL MAPSEDITING SYMBOL MAPS  

l NewNewNewNew  -- Enter a new symbol map. A dialog opens, see next section. Enter a new symbol map. A dialog opens, see next section.  
l EditEditEditEdit  -- Edit the selected symbol map. Edit the selected symbol map.  
l DeleteDeleteDeleteDelete  -- Delete the selected symbol map. Delete the selected symbol map.  
l Delete AllDelete AllDelete AllDelete All  -- Delete all symbol maps. Delete all symbol maps.  

CONFIGURING ORDER ROUTING SYMBOL MAPPINGCONFIGURING ORDER ROUTING SYMBOL MAPPING  

In this dialog you can create a new symbol map or edit an existing map.In this dialog you can create a new symbol map or edit an existing map.  
  
Enter the symbol from the data provider:Enter the symbol from the data provider:Enter the symbol from the data provider:Enter the symbol from the data provider:  

l When a chart with a symbol is open and selected, this symbol is When a chart with a symbol is open and selected, this symbol is 
automatically entered here. Otherwise, click on the automatically entered here. Otherwise, click on the BrowseBrowseBrowseBrowse button  button 
to start the symbol search in Tradesignal. Note that many symbol to start the symbol search in Tradesignal. Note that many symbol 
names are a combination of symbol shortcut and exchange name.names are a combination of symbol shortcut and exchange name.  

Enter the symbol details for the broker:Enter the symbol details for the broker:Enter the symbol details for the broker:Enter the symbol details for the broker:  

l UnderlyingUnderlyingUnderlyingUnderlying  -- Enter the asset's underlying ticker symbol. Enter the asset's underlying ticker symbol.  
l ExchangeExchangeExchangeExchange  -- Select the exchange from the list at which the symbol  Select the exchange from the list at which the symbol 

is traded.is traded.  
l Security TypeSecurity TypeSecurity TypeSecurity Type  -- Select the symbol type from the list. Most brokers use this setting to assign the shortcut to the right  Select the symbol type from the list. Most brokers use this setting to assign the shortcut to the right 

exchange.exchange.  
l CurrencyCurrencyCurrencyCurrency  -- Select the currency delivered against the purchase of the underlying currency. Select the currency delivered against the purchase of the underlying currency.  
l Expiry DateExpiry DateExpiry DateExpiry Date  -- Enter an expiry date for the underlying, if available. Enter an expiry date for the underlying, if available.  

Attention:Attention: Please check the settings to ensure that the right symbols are ordered. Please check the settings to ensure that the right symbols are ordered.

ORDER ROUTING TOOLBARORDER ROUTING TOOLBAR  

Open this toolbar by clicking on the Open this toolbar by clicking on the Order RoutingOrder RoutingOrder RoutingOrder Routing tab above the toolbar. tab above the toolbar.

l Start Automatic Order RoutingStart Automatic Order RoutingStart Automatic Order RoutingStart Automatic Order Routing  -- Start the order routing for the  Start the order routing for the 
selected chart or portfolio. To start all order routings, press the selected chart or portfolio. To start all order routings, press the CtrlCtrlCtrlCtrl  
key while clicking.key while clicking.  

l Stop Automatic Order RoutingStop Automatic Order RoutingStop Automatic Order RoutingStop Automatic Order Routing  -- Stop the order routing for the  Stop the order routing for the 
selected chart or portfolio.selected chart or portfolio.  

l Stop All Automatic Order RoutingStop All Automatic Order RoutingStop All Automatic Order RoutingStop All Automatic Order Routing  -- Stop the order routing for all  Stop the order routing for all 
charts and portfolios.charts and portfolios.  

l Order Routing OptionsOrder Routing OptionsOrder Routing OptionsOrder Routing Options  -- Opens the  Opens the Order Routing OptionsOrder Routing Options in the  in the 
Tradesignal Options.Tradesignal Options.  

STRATEGY AUTOMATION OPTIONS STRATEGY AUTOMATION OPTIONS   

Order Routing Symbol Mapping DialogOrder Routing Symbol Mapping Dialog

Button Menu Order RoutingButton Menu Order Routing
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This menu is opened by clicking on the small plug symbol on the lower This menu is opened by clicking on the small plug symbol on the lower 
right of the chart or a portfolio.right of the chart or a portfolio. Here you can activate different levels of  Here you can activate different levels of 
automation for the order routing. The following settings are available: automation for the order routing. The following settings are available: 

l No Order RoutingNo Order RoutingNo Order RoutingNo Order Routing: Select this option if no automatic order routing : Select this option if no automatic order routing 
is used. No signals are output by the strategy. The Position Manager is used. No signals are output by the strategy. The Position Manager 
remains empty.remains empty.  

l Position Manager OnlyPosition Manager OnlyPosition Manager OnlyPosition Manager Only: Select this option to send the signals : Select this option to send the signals 
generated by the strategy to the Position Manager. To submit the generated by the strategy to the Position Manager. To submit the 
orders, you have to enter them manually into your broker's order orders, you have to enter them manually into your broker's order 
software.software.  

l BrokerBrokerBrokerBroker: Select this option to route the orders automatically. The : Select this option to route the orders automatically. The 
signals of the trading system are displayed in the Position Manager signals of the trading system are displayed in the Position Manager 
and also routed to the broker. The limitations for this automation are and also routed to the broker. The limitations for this automation are 
set in the set in the Order VerificationOrder Verification settings of the Order Routing Settings in  settings of the Order Routing Settings in 
the Tradesignal Options, see above.the Tradesignal Options, see above.  

After selecting an option, you can start the order routing from the After selecting an option, you can start the order routing from the Order RoutingOrder RoutingOrder RoutingOrder Routing button menu. Click on the  button menu. Click on the Start Automatic Start Automatic Start Automatic Start Automatic 
Order RoutingOrder RoutingOrder RoutingOrder Routing entry. entry.

CONTROLLING HOW AND WHEN ORDERS GET FILLED CONTROLLING HOW AND WHEN ORDERS GET FILLED   

When using order routing the one of the major issues is ensuring that fills generated in the strategy closely match fills in the When using order routing the one of the major issues is ensuring that fills generated in the strategy closely match fills in the 
brokerageaccount. The brokerageaccount. The Money ManagementMoney Management property  property Realtime Price SourceRealtime Price SourceRealtime Price SourceRealtime Price Source can be used to tell Tradesignal to use best bid and  can be used to tell Tradesignal to use best bid and 
best ask prices from the Broker instead of using last prices from the data source. The following settings are available:best ask prices from the Broker instead of using last prices from the data source. The following settings are available:

l Bid/AskBid/AskBid/AskBid/Ask  -- Tradesignal uses the best bid / best ask data provided by either the broker (if an order routing module has been  Tradesignal uses the best bid / best ask data provided by either the broker (if an order routing module has been 
connected) or the data provider. If neither the broker nor the data provider is delivering bid/ask prices, Tradesignal uses the connected) or the data provider. If neither the broker nor the data provider is delivering bid/ask prices, Tradesignal uses the 
last price instead (for example in the case of indices). Best bid and best ask prices are generated when a market participant last price instead (for example in the case of indices). Best bid and best ask prices are generated when a market participant 
wants to buy or sell a number of shares/contracts while a last price represents an actual trade that has been made. wants to buy or sell a number of shares/contracts while a last price represents an actual trade that has been made. 
Therefore this option has the benefit of more accurate fills for your orders. The caveat is however that the results collected in Therefore this option has the benefit of more accurate fills for your orders. The caveat is however that the results collected in 
real time will not match the results of backreal time will not match the results of back--testing which will always only use the last price.testing which will always only use the last price.  

l LastLastLastLast  -- Tradesignal uses the last price delivered by the data provider. This is the same price as the one used to back Tradesignal uses the last price delivered by the data provider. This is the same price as the one used to back--test the test the 
strategy. A last tick represents a trade that has been made in the market. When using this mode, Tradesignal can only fill strategy. A last tick represents a trade that has been made in the market. When using this mode, Tradesignal can only fill 
and order after a trade has been made, even if there was a matching offer/request in the market prior to the trade. This and order after a trade has been made, even if there was a matching offer/request in the market prior to the trade. This 
mode ensures that real time results are closer to backmode ensures that real time results are closer to back--test results.test results.  

Automatic Order Routing MenuAutomatic Order Routing Menu
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TRADESIGNAL OPTIONS 
In the Tradesignal options, you can find general settings for Tradesignal, for exampleIn the Tradesignal options, you can find general settings for Tradesignal, for example

l preferred view and chart typepreferred view and chart type  
l data connections and order routingdata connections and order routing  
l timescale and scope of data backuptimescale and scope of data backup  

You can open the window You can open the window Tradesignal OptionsTradesignal Options  

l by clicking on the by clicking on the FileFileFileFile menu in the header bar and selecting  menu in the header bar and selecting OptionsOptionsOptionsOptions from the menu, or from the menu, or  
l by doubleby double--clicking on the connection icon above the toolbar.clicking on the connection icon above the toolbar.  

In the following chapter, you will find information about the settings or links to other chapters with detailed information. In the following chapter, you will find information about the settings or links to other chapters with detailed information. 

SEARCHING THE OPTIONSSEARCHING THE OPTIONS  

In addition to drilling down search for an option by label, it is possible to use the search box located to the top left of the options In addition to drilling down search for an option by label, it is possible to use the search box located to the top left of the options 
pane to search for an option by keywordpane to search for an option by keyword

1.1. Enter the search term, e.g. "Excel"Enter the search term, e.g. "Excel"  

The available options matching the keywords will be displayed as you typeThe available options matching the keywords will be displayed as you type  
  
To reset the search click the To reset the search click the XXXX button next to search box, or click on a options category. button next to search box, or click on a options category.

PERSONALIZEPERSONALIZE  

ON STARTUPON STARTUP  

Which workspaces to open automatically on start upWhich workspaces to open automatically on start up

LANGUAGELANGUAGE  

Which application language to use, changing this setting will require a Which application language to use, changing this setting will require a 
restart of the application.restart of the application.

TIMEZONETIMEZONE  

Set the local timezone. This setting is used to adjust time values in charts Set the local timezone. This setting is used to adjust time values in charts 
to the local timezone.to the local timezone.

THEMETHEME  

Tradesignal options Tradesignal options -- start view start view
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Which application theme to use.Which application theme to use.

EMAILEMAIL  

The settings to use when the application needs to send an email. To methods existThe settings to use when the application needs to send an email. To methods exist

l SMTPSMTPSMTPSMTP  -- Requires the SMTP servers details to be added. Most reliable solution for sending emails from the application. Requires the SMTP servers details to be added. Most reliable solution for sending emails from the application.  
l MAPIMAPIMAPIMAPI  -- Will use the locally installed email software to send emails. May cause problems with security settings. Will use the locally installed email software to send emails. May cause problems with security settings.  

TRADESIGNAL ONLINETRADESIGNAL ONLINE  

LogLog--in details for the Tradesignal Online website. The settings in this area are necessary if you want to publish material (such as a in details for the Tradesignal Online website. The settings in this area are necessary if you want to publish material (such as a 
chart) to the forums on Tradesignal Online (see the chapter chart) to the forums on Tradesignal Online (see the chapter PublishingPublishing). ). 

l UsernameUsernameUsernameUsername  -- Enter your Tradesignal Online user name. Enter your Tradesignal Online user name.  
l PasswordPasswordPasswordPassword  -- Enter your Tradesignal Online password. For security reasons, this is not displayed. Enter your Tradesignal Online password. For security reasons, this is not displayed.  

Click on "Create new forum account" to open the website account.Click on "Create new forum account" to open the website account.

RIBBON TOOLBARRIBBON TOOLBAR  

Tool to configure the Tool to configure the Quick Access ToolbarQuick Access Toolbar. All possible functions are listed in a tree in the left pane. These functions can be added . All possible functions are listed in a tree in the left pane. These functions can be added 
to the right pane and will appear in the Quick Access Toolbar above the regular toolbar. Options next to each Toolbar item allow it to the right pane and will appear in the Quick Access Toolbar above the regular toolbar. Options next to each Toolbar item allow it 
to be repositioned, removed or grouped.to be repositioned, removed or grouped.

PRINTINGPRINTING  

Options to configure standard printing options, most notably the default watermark and header/footer layout.Options to configure standard printing options, most notably the default watermark and header/footer layout.

RESTORE DEFAULTSRESTORE DEFAULTS  

Clicking on this button will restore all system settings to their default values, a dialog will be displayed to confirm this action.Clicking on this button will restore all system settings to their default values, a dialog will be displayed to confirm this action.  
  
Individual settings may be restored to their factory setting by rightIndividual settings may be restored to their factory setting by right--clicking on the label for the option and selecting clicking on the label for the option and selecting ResetResetResetReset..

DATAFEEDSDATAFEEDS  

Detailed information about connecting online and offline data can be found in the chapter Detailed information about connecting online and offline data can be found in the chapter Data SourcesData Sources..

AUTOSAVE & BACKUPAUTOSAVE & BACKUP  

AUTO SAVEAUTO SAVE  
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l Automatically make a periodic recoverable backup of any open documentsAutomatically make a periodic recoverable backup of any open documentsAutomatically make a periodic recoverable backup of any open documentsAutomatically make a periodic recoverable backup of any open documents  --  This is the default setting. When This is the default setting. When 
selected, the work is saved in regular intervals (given by the parameter selected, the work is saved in regular intervals (given by the parameter Frequency in minutes to save open itemsFrequency in minutes to save open itemsFrequency in minutes to save open itemsFrequency in minutes to save open items) and ) and 
available as backup. You can edit the frequency value.available as backup. You can edit the frequency value.  

APPLICATION BACKUPAPPLICATION BACKUP  

Here you can enter settings for the backup of your current configuration. The following information is saved:Here you can enter settings for the backup of your current configuration. The following information is saved:

l Packages with all their files, including information whether they are writePackages with all their files, including information whether they are write--protected (date and time are not saved!)protected (date and time are not saved!)  
l Symbol listsSymbol lists  
l Symbol settings for automatic order routingSymbol settings for automatic order routing  
l User settingsUser settings  
l Edited quotation dataEdited quotation data  

This way you can save the current state of Tradesignal and then use the resulting backup to restore your settings on another This way you can save the current state of Tradesignal and then use the resulting backup to restore your settings on another 
computer computer --  or on your computer, for example after a new installation of the operating system. or on your computer, for example after a new installation of the operating system.   
  
The following options are available:The following options are available:

l Backup LocationBackup LocationBackup LocationBackup Location  --  This is the folder where the backups are saved to. To enter another one, click on This is the folder where the backups are saved to. To enter another one, click on BrowseBrowseBrowseBrowse and select one  and select one 
in the Windows file dialog.in the Windows file dialog.  

l Number of recent backups to keepNumber of recent backups to keepNumber of recent backups to keepNumber of recent backups to keep  --  This is the maximum number of backups that will be kept. When going beyond this This is the maximum number of backups that will be kept. When going beyond this 
number, old backups will be overwritten, starting with the oldest. Max. number is 100.number, old backups will be overwritten, starting with the oldest. Max. number is 100.  

l Create a backup when the application shuts downCreate a backup when the application shuts downCreate a backup when the application shuts downCreate a backup when the application shuts down  --  When selected, the data is saved as backup before shutdown.When selected, the data is saved as backup before shutdown.  
l Create daily backup atCreate daily backup atCreate daily backup atCreate daily backup at  --  Here you can enter a time at which the backup will take place. Note that this only will be done Here you can enter a time at which the backup will take place. Note that this only will be done 

as long as the application is running.as long as the application is running.  

Click on Click on Create Backup NowCreate Backup NowCreate Backup NowCreate Backup Now to create a backup for the current settings and data. to create a backup for the current settings and data.  
  
Click on Click on Restore BackupRestore BackupRestore BackupRestore Backup to restore an old backup. Select one of the available backup files from the dialog. Then choose whether  to restore an old backup. Select one of the available backup files from the dialog. Then choose whether 
you want to:you want to:

l Restore all files including settingsRestore all files including settingsRestore all files including settingsRestore all files including settings  ––  restore all saved data as listed above.restore all saved data as listed above.  
l Restore all package filesRestore all package filesRestore all package filesRestore all package files  ––  restore the package files only.restore the package files only.  

In addition, you can select the option In addition, you can select the option Restore exclusively missing filesRestore exclusively missing filesRestore exclusively missing filesRestore exclusively missing files so that already available files are not overwritten.  so that already available files are not overwritten. 
Confirm the warning. After the restoration, the application is closed so that the new settings can take effect upon restart. Confirm the warning. After the restoration, the application is closed so that the new settings can take effect upon restart.   
  
Note that all open workspaces have to be closed before restoring a backup. This is done fastest when you select Note that all open workspaces have to be closed before restoring a backup. This is done fastest when you select Close All Close All Close All Close All 
WorkspacesWorkspacesWorkspacesWorkspaces from the file menu. from the file menu.

ALERTSALERTS  

Detailed information about the alert setting options can be found in the chapter Detailed information about the alert setting options can be found in the chapter AlertsAlerts..

FOLDERSFOLDERS  
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PACKAGESPACKAGES  

Detailed information about the package options can be found in the chapter Detailed information about the package options can be found in the chapter Package and File ManagementPackage and File Management..

SHARED SYMBOL LIST FOLDERSSHARED SYMBOL LIST FOLDERS  

On this page you can add/remove folders containing symbol lists in XML On this page you can add/remove folders containing symbol lists in XML 
format as format as exportedexported from Tradesignal. from Tradesignal.  
  
By having these folders on a network share, you can share symbol lists By having these folders on a network share, you can share symbol lists 
between users.between users.

EQUILLA PATHSEQUILLA PATHS  

l CCCC----API Extension DLLsAPI Extension DLLsAPI Extension DLLsAPI Extension DLLs  --  In this folder, special Equilla interface files In this folder, special Equilla interface files 
are saved. Do not change this path.are saved. Do not change this path.  

l PrintToFile outputPrintToFile outputPrintToFile outputPrintToFile output  --  In this folder, files are written by Equilla In this folder, files are written by Equilla 
scripts (see the chapter scripts (see the chapter Data Output via File InterfaceData Output via File Interface).).  

RSS FEEDRSS FEED  

Here you can configure RSS feeds. RSS feeds are added to the news displayed in the news window. Here you can configure RSS feeds. RSS feeds are added to the news displayed in the news window. 

l NewNewNewNew  -- Add a new feed. A dialog opens where you can enter the URL of the feed. Make sure that it starts with "http://". Add a new feed. A dialog opens where you can enter the URL of the feed. Make sure that it starts with "http://".  
l EditEditEditEdit  -- Edit the URL of the selected RSS feed. Edit the URL of the selected RSS feed.  
l DeleteDeleteDeleteDelete  -- Remove the selected RSS feed from the list. Remove the selected RSS feed from the list.  

ORDER ROUTING MODULESORDER ROUTING MODULES  

Folder where order routing modules are located.Folder where order routing modules are located.

ORDER ROUTINGORDER ROUTING  

Detailed information about the order routing options can be found in the chapter Detailed information about the order routing options can be found in the chapter Order Routing OptionsOrder Routing Options..

ADVANCEDADVANCED  

Many options to configure default behavior are found in this section organized by the following categoriesMany options to configure default behavior are found in this section organized by the following categories

EQUILLA EXTENSIONEQUILLA EXTENSION  

Shared Symbol Lists FoldersShared Symbol Lists Folders
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These options are available in and offer the option to enable or disable support for Equilla extension DLLs.These options are available in and offer the option to enable or disable support for Equilla extension DLLs.

l No extensions allowedNo extensions allowedNo extensions allowedNo extensions allowed  
l Only C API extensions allowedOnly C API extensions allowedOnly C API extensions allowedOnly C API extensions allowed  -- Allows Equilla extensions that use the  Allows Equilla extensions that use the C APIC API. This is the default setting.. This is the default setting.  
l Only COM API extensions allowedOnly COM API extensions allowedOnly COM API extensions allowedOnly COM API extensions allowed  -- Allows Equilla extensions that use the  Allows Equilla extensions that use the COM APICOM API..  
l Both C and COM API extensions allowedBoth C and COM API extensions allowedBoth C and COM API extensions allowedBoth C and COM API extensions allowed  -- Extensions for both APIs are allowed. Extensions for both APIs are allowed.  

CHART STYLECHART STYLE  

l Default styleDefault styleDefault styleDefault style  -- The chart type that will be used for all newly created charts (excluding tick The chart type that will be used for all newly created charts (excluding tick--byby--tick charts).tick charts).  
l Tick chart styleTick chart styleTick chart styleTick chart style  -- The chart style to use for new tick The chart style to use for new tick--byby--tick charts.tick charts.  
l Value scale modeValue scale modeValue scale modeValue scale mode  -- The value scale mode to use for newly created charts (Linear or Logarithmic). The value scale mode to use for newly created charts (Linear or Logarithmic).  

INSTRUMENTSINSTRUMENTS  

This section allows configuration of the default history length to use for charts and other document types in various periods.This section allows configuration of the default history length to use for charts and other document types in various periods.

l Default periodDefault periodDefault periodDefault period  -- The default period to use for newly opened charts and lists. The default period is daily. The default period to use for newly opened charts and lists. The default period is daily.  
l Open instruments in a new subchartOpen instruments in a new subchartOpen instruments in a new subchartOpen instruments in a new subchart  -- Check this box to always add new instruments as a sub chart to an existing chart.  Check this box to always add new instruments as a sub chart to an existing chart. 

Uncheck the box to always add the new instrument to the main chart.Uncheck the box to always add the new instrument to the main chart.  
l Resolve ambiguous symbolsResolve ambiguous symbolsResolve ambiguous symbolsResolve ambiguous symbols  -- When a symbol is entered on the command line or in an inline instrument, this option  When a symbol is entered on the command line or in an inline instrument, this option 

determines how the symbol should be resolved to an instrument if the symbol is multiply defined.determines how the symbol should be resolved to an instrument if the symbol is multiply defined.  

WORKSPACESWORKSPACES  

l Maximum number of open workspacesMaximum number of open workspacesMaximum number of open workspacesMaximum number of open workspaces  -- Increase this number to allow more simultaneously open workspaces, the  Increase this number to allow more simultaneously open workspaces, the 
default is 30. Please note that opening more workspaces will require more system resources.default is 30. Please note that opening more workspaces will require more system resources.  

l Maximum number of items in a workspaceMaximum number of items in a workspaceMaximum number of items in a workspaceMaximum number of items in a workspace  -- increase this number to open more items in a workspace. The default value  increase this number to open more items in a workspace. The default value 
is 30. Please note that opening more items in a workspace will require more system resources.is 30. Please note that opening more items in a workspace will require more system resources.  

l Show close button on selected workspace tabShow close button on selected workspace tabShow close button on selected workspace tabShow close button on selected workspace tab  
l Hide titles of nonHide titles of nonHide titles of nonHide titles of non----selected workspace itemsselected workspace itemsselected workspace itemsselected workspace items  
l Show unremove bar at the bottom of the screenShow unremove bar at the bottom of the screenShow unremove bar at the bottom of the screenShow unremove bar at the bottom of the screen  -- When not checked the unremove option will be displayed at right of  When not checked the unremove option will be displayed at right of 

the application's title bar.the application's title bar.  
l Automatically close a floating desktop when the last workspace has been closedAutomatically close a floating desktop when the last workspace has been closedAutomatically close a floating desktop when the last workspace has been closedAutomatically close a floating desktop when the last workspace has been closed  
l Set the workspace tab button sizeSet the workspace tab button sizeSet the workspace tab button sizeSet the workspace tab button size  

PROPERTY INSPECTORPROPERTY INSPECTOR  

l Always show properties when a new item is selectedAlways show properties when a new item is selectedAlways show properties when a new item is selectedAlways show properties when a new item is selected  

COMMAND LINECOMMAND LINE  

l Generate OHLC outputs for oneGenerate OHLC outputs for oneGenerate OHLC outputs for oneGenerate OHLC outputs for one----line formulaline formulaline formulaline formula----based symbolsbased symbolsbased symbolsbased symbols  -- When this item is selected and a spread formula is  When this item is selected and a spread formula is 
entered on the command line, an instrument will be created with open, high, low and close values based on the entered entered on the command line, an instrument will be created with open, high, low and close values based on the entered 
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formula, instead of just using the close value.formula, instead of just using the close value.  
l Display security name for oneDisplay security name for oneDisplay security name for oneDisplay security name for one----line formulaline formulaline formulaline formula----based symbolsbased symbolsbased symbolsbased symbols  -- When this option is checked, the application will  When this option is checked, the application will 

substitute a symbols display name for the symbol in formulas.substitute a symbols display name for the symbol in formulas.  
l Correct symbols used in formulas used on the command lineCorrect symbols used in formulas used on the command lineCorrect symbols used in formulas used on the command lineCorrect symbols used in formulas used on the command line  -- This option prepends the prefix to a symbol used in a  This option prepends the prefix to a symbol used in a 

formula if it has been forgotten.formula if it has been forgotten.  
l Clear command line historyClear command line historyClear command line historyClear command line history  

SYMBOL LISTSSYMBOL LISTS  

l Show Symbol Lists toolbox after inserting a chart into a workspaceShow Symbol Lists toolbox after inserting a chart into a workspaceShow Symbol Lists toolbox after inserting a chart into a workspaceShow Symbol Lists toolbox after inserting a chart into a workspace  
l Use preferred period and FID when opening new charts from a symbol listUse preferred period and FID when opening new charts from a symbol listUse preferred period and FID when opening new charts from a symbol listUse preferred period and FID when opening new charts from a symbol list  -- Some symbols in a symbol list may also  Some symbols in a symbol list may also 

specify a preferred period and FID. If they do, and this option is selected, the instrument added to a chart will override the specify a preferred period and FID. If they do, and this option is selected, the instrument added to a chart will override the 
charts default FID and period and use the preferred settings instead.charts default FID and period and use the preferred settings instead.  

l Show all symbols collected on a DataConnect server in a separate symbol list.Show all symbols collected on a DataConnect server in a separate symbol list.Show all symbols collected on a DataConnect server in a separate symbol list.Show all symbols collected on a DataConnect server in a separate symbol list.  
l Symbol display formatSymbol display formatSymbol display formatSymbol display format  -- How symbols in the Symbol List toolbox show be displayed. How symbols in the Symbol List toolbox show be displayed.  

PERFORMANCEPERFORMANCE  

l Prevent system suspension/hibernation while the application is runningPrevent system suspension/hibernation while the application is runningPrevent system suspension/hibernation while the application is runningPrevent system suspension/hibernation while the application is running  
l Reduce the evaluation frequency for nonReduce the evaluation frequency for nonReduce the evaluation frequency for nonReduce the evaluation frequency for non----visible chartsvisible chartsvisible chartsvisible charts  
l Maximum visible instrumentsMaximum visible instrumentsMaximum visible instrumentsMaximum visible instruments  -- The maximum number of instruments that may be simultaneously open. The maximum number of instruments that may be simultaneously open.  
l Minimum memory for optimizer/scanner (MB)Minimum memory for optimizer/scanner (MB)Minimum memory for optimizer/scanner (MB)Minimum memory for optimizer/scanner (MB)  -- The minimum amount of system memory that must be available to start  The minimum amount of system memory that must be available to start 

a new scan or optimization task.a new scan or optimization task.  

INDICATORS & STRATEGIESINDICATORS & STRATEGIES  

l Automatically add the strategy equity indicator when strategies are added to a chartAutomatically add the strategy equity indicator when strategies are added to a chartAutomatically add the strategy equity indicator when strategies are added to a chartAutomatically add the strategy equity indicator when strategies are added to a chart  
l Do not show the input mapping dialog if all inputs can be automatically mappedDo not show the input mapping dialog if all inputs can be automatically mappedDo not show the input mapping dialog if all inputs can be automatically mappedDo not show the input mapping dialog if all inputs can be automatically mapped  
l Add colorAdd colorAdd colorAdd color----tagged indicators to the ribbontagged indicators to the ribbontagged indicators to the ribbontagged indicators to the ribbon  -- If an indicator in the Indicator toolbox is color If an indicator in the Indicator toolbox is color--tagged using the context tagged using the context 

menu (yellow, blue or red) and this option is checked. A button will be added to the menu (yellow, blue or red) and this option is checked. A button will be added to the FavoritesFavorites group of the ribbon that when  group of the ribbon that when 
clicked will add the indicator to a chart.clicked will add the indicator to a chart.  

l Add colorAdd colorAdd colorAdd color----tagged strategies to the ribbontagged strategies to the ribbontagged strategies to the ribbontagged strategies to the ribbon  -- If a strategy in the Strategies toolbox is color If a strategy in the Strategies toolbox is color--tagged using the context menu tagged using the context menu 
(yellow, blue or red) and this option is checked. A button will be added to the (yellow, blue or red) and this option is checked. A button will be added to the FavoritesFavorites group of the ribbon that when  group of the ribbon that when 
clicked will add the strategy to a chart.clicked will add the strategy to a chart.  

Clicking on the Clicking on the Recompile all user indicators and strategiesRecompile all user indicators and strategiesRecompile all user indicators and strategiesRecompile all user indicators and strategies will force all user indicators and strategies to be recompiled.  will force all user indicators and strategies to be recompiled. 
Progress will be shown and the result of the compilation indicated.Progress will be shown and the result of the compilation indicated.

SESSIONSSESSIONS  

It is possible to set here exactly when OnIt is possible to set here exactly when On--close orders are generated in order routing.close orders are generated in order routing.

CSV FILE EXPORTCSV FILE EXPORT  
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l Field separator when exporting dataField separator when exporting dataField separator when exporting dataField separator when exporting data  -- Default is a semi Default is a semi--colon character.colon character.  
l Language used for formatting numeric valuesLanguage used for formatting numeric valuesLanguage used for formatting numeric valuesLanguage used for formatting numeric values  
l Enclose values in quotesEnclose values in quotesEnclose values in quotesEnclose values in quotes  
l Export all optimizer runs in the optimizer resultsExport all optimizer runs in the optimizer resultsExport all optimizer runs in the optimizer resultsExport all optimizer runs in the optimizer results  

CLIPBOARDCLIPBOARD  

l Field separator when copying dataField separator when copying dataField separator when copying dataField separator when copying data  -- default is a tab character. default is a tab character.  
l Language used for formatting numeric valuesLanguage used for formatting numeric valuesLanguage used for formatting numeric valuesLanguage used for formatting numeric values  
l Enclose values in quotesEnclose values in quotesEnclose values in quotesEnclose values in quotes  

TEMPLATESTEMPLATES  

l Allow to update the templated charts when the base template changeAllow to update the templated charts when the base template changeAllow to update the templated charts when the base template changeAllow to update the templated charts when the base template change  -- If this option is checked, charts that have  If this option is checked, charts that have 
been created based on a template will automatically be updated when the templated is changed and saved.been created based on a template will automatically be updated when the templated is changed and saved.  
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ADVANCED INSTALLATION OPTIONS 
The information in this article is only relevant for system administrators The information in this article is only relevant for system administrators 
who need to use different settings or additional features of Tradesignal.who need to use different settings or additional features of Tradesignal.  
  
During installation of Tradesignal you can select During installation of Tradesignal you can select Show the advanced Show the advanced Show the advanced Show the advanced 
installation options page (recommended only for administrators)installation options page (recommended only for administrators)installation options page (recommended only for administrators)installation options page (recommended only for administrators)  
which allows you to specify some additional options.which allows you to specify some additional options.

PASSWORD PROTECT DACS IDPASSWORD PROTECT DACS ID  

With this option you can select a password for the DACS ID.With this option you can select a password for the DACS ID.

DATA PATHSDATA PATHS  

You can change both the application data and the user data path.You can change both the application data and the user data path.  
  
If you leave either of these fields blank, the default settings will be used.If you leave either of these fields blank, the default settings will be used.

SHARED DATACONNECT SETTINGSSHARED DATACONNECT SETTINGS  

You can specify the file location of an INI file containing connection settings for the Tradesignal DataConnect and You can specify the file location of an INI file containing connection settings for the Tradesignal DataConnect and external data external data 
sourcessources. This way there is a central point at which to configure connection settings for all your installations. This way there is a central point at which to configure connection settings for all your installations and new installations  and new installations 
are easily configured to use your existing data sources.are easily configured to use your existing data sources.  
  
This option sets the registry key This option sets the registry key HKLM\Software\SystemSoft\TradeSignalEnterprise\ConnectionSettingsFileHKLM\Software\SystemSoft\TradeSignalEnterprise\ConnectionSettingsFile..

UPDATE WEB SERVICEUPDATE WEB SERVICE  

This allows you to specify an URL which is to be checked periodically for updates of Tradesignal.This allows you to specify an URL which is to be checked periodically for updates of Tradesignal.  
  
If you select this option, the registry key If you select this option, the registry key HKLM\Software\SystemSoft\TradeSignalEnterprise\SiteUpdateServiceHKLM\Software\SystemSoft\TradeSignalEnterprise\SiteUpdateService will be set. will be set.    

Advanced Options during InstallationAdvanced Options during Installation
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ALERTS 
A very important feature of charting software is the alert function. It helps you keep an overview even when working with a large A very important feature of charting software is the alert function. It helps you keep an overview even when working with a large 
number of running processes and functions. Use the alert function in Tradesignal for the following:number of running processes and functions. Use the alert function in Tradesignal for the following:

l Trading systems that alert you of certain activitiesTrading systems that alert you of certain activities  
l Indicators that offer an inbuilt alert function in their codesIndicators that offer an inbuilt alert function in their codes  
l The chart tools trend line, trend channel, regression channel, stop line and the Fibonacci RetracementThe chart tools trend line, trend channel, regression channel, stop line and the Fibonacci Retracement  
l Your own programs in which you can include offer alertsYour own programs in which you can include offer alerts  

ALERT WINDOWALERT WINDOW  

There is a specific alert window on the bottom of the workspace. The There is a specific alert window on the bottom of the workspace. The 
displays differ slightly depending on the alert category. In Tradesignal you displays differ slightly depending on the alert category. In Tradesignal you 
can choose which columns to display for each category by selecting can choose which columns to display for each category by selecting 
Add/Remove columnsAdd/Remove columns from the alert window's context menu. from the alert window's context menu.

l Alerts coming from chart tools or indicators are listed in the "Indicators & Tools" tab, with the triggering symbol and reason, Alerts coming from chart tools or indicators are listed in the "Indicators & Tools" tab, with the triggering symbol and reason, 
for example a trend line crossing or an indicator crossing a signal line.for example a trend line crossing or an indicator crossing a signal line.  

l Alerts coming from trading systems are listed in the "Strategies" tab. Here, the triggering symbol and all events of the Alerts coming from trading systems are listed in the "Strategies" tab. Here, the triggering symbol and all events of the 
trading system are listed, like opened or canceled orders, and also feedback from your broker in case of activated automatic trading system are listed, like opened or canceled orders, and also feedback from your broker in case of activated automatic 
order routing. The latter depends on your settings in the order routing. The latter depends on your settings in the Order RoutingOrder Routing options. options.  

l Application level alerts such as losing the connection to your data feed are shown in the "Application" tab.Application level alerts such as losing the connection to your data feed are shown in the "Application" tab.  

Each tab will show the number of unread alerts next to the tab's icon.Each tab will show the number of unread alerts next to the tab's icon.

MAXIMIZING THE ALERT PANEMAXIMIZING THE ALERT PANE  

The small maximize icon shown directly below the alert pane tabs can be used to maximize the alert pane to fill the entire main The small maximize icon shown directly below the alert pane tabs can be used to maximize the alert pane to fill the entire main 
application window (with the exception of Toolbar and toolboxes). Clicking the same button a second time will restore the alert application window (with the exception of Toolbar and toolboxes). Clicking the same button a second time will restore the alert 
pane to its original position.pane to its original position.

COLLAPSING THE ALERT PANECOLLAPSING THE ALERT PANE  

The small minimize icon shown below the alert pane maximize button can be used to collapse the alert pane. When collapsed the The small minimize icon shown below the alert pane maximize button can be used to collapse the alert pane. When collapsed the 
alert pane will be shown as a single button (bearing an alert pane will be shown as a single button (bearing an iiii symbol) to the far right of the workspace tabs. If there are any unread  symbol) to the far right of the workspace tabs. If there are any unread 
alerts, the will be displayed next to this button.alerts, the will be displayed next to this button.

OUTPUT WINDOWOUTPUT WINDOW  

Alert area in the workspaceAlert area in the workspace
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The tab labeled "Output" contains the output of The tab labeled "Output" contains the output of Equilla'sEquilla's  Print()Print()Print()Print() command  command 
and also the errors and warnings generated by the Equilla compiler. The and also the errors and warnings generated by the Equilla compiler. The 
text box at the top allows filtering of its entries to show only matching text box at the top allows filtering of its entries to show only matching 
lines.lines.  
  
The output window contains a maximum number of 100,000 entries. If you The output window contains a maximum number of 100,000 entries. If you 
need a larger number of entries, you can edit the file tse.ini in the need a larger number of entries, you can edit the file tse.ini in the 
application data folder of Tradesignal by adding a value up to 10,000,000 application data folder of Tradesignal by adding a value up to 10,000,000 
for the setting for the setting MaxOutputMessageMaxOutputMessageMaxOutputMessageMaxOutputMessage in the  in the GeneralGeneralGeneralGeneral section. However be  section. However be 
advised that increasing this number may negatively affect your advised that increasing this number may negatively affect your 
performance.performance.

ALERTS IN TRADING SYSTEMSALERTS IN TRADING SYSTEMS  

ALERT FUNCTIONS IN INDICATORSALERT FUNCTIONS IN INDICATORS  

Many indicators included in the software are equipped with an alert Many indicators included in the software are equipped with an alert 
functionality. As default, the alerts are deactivated. However, you can functionality. As default, the alerts are deactivated. However, you can 
switch on the alerts by opening the property inspector in the toolbox and switch on the alerts by opening the property inspector in the toolbox and 
setting the option setting the option ShowAlertsShowAlertsShowAlertsShowAlerts to  to YesYes. As of that moment, signals like line . As of that moment, signals like line 
crossing or extremes are reported as alerts.crossing or extremes are reported as alerts.

ALERT FUNCTIONS IN MONEY MANAGEMENTALERT FUNCTIONS IN MONEY MANAGEMENT  

The The Money ManagementMoney Management alerts in four different situations: alerts in four different situations:

l Order addedOrder addedOrder addedOrder added  
l Order changedOrder changedOrder changedOrder changed  
l Order cancelledOrder cancelledOrder cancelledOrder cancelled  
l Order filledOrder filledOrder filledOrder filled  

The alerts are reported by the trading system. The alerts are reported by the trading system. 

ALERT FUNCTIONS IN CHART TOOLS ALARMALERT FUNCTIONS IN CHART TOOLS ALARM  

SET AN ALERT MODESET AN ALERT MODE  

Output area in the workspace showing compiler errorsOutput area in the workspace showing compiler errors

Detail: Alerts in the money management in the toolboxDetail: Alerts in the money management in the toolbox
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For the chart tools trend line, trend channel, regression channel, stop line For the chart tools trend line, trend channel, regression channel, stop line 
and Fibonacci Retracement, the following alert modes are available:and Fibonacci Retracement, the following alert modes are available:

l AlwaysAlwaysAlwaysAlways  -- An alert is always set off when the condition is met, e.g.  An alert is always set off when the condition is met, e.g. 
a line crossing. In realtime operation, this can result in multiple a line crossing. In realtime operation, this can result in multiple 
alerts from the same tool, if the stock crosses the line several times.alerts from the same tool, if the stock crosses the line several times.  

l Once Per BarOnce Per BarOnce Per BarOnce Per Bar  -- An alert is only set off once per Bar. For example, if  An alert is only set off once per Bar. For example, if 
the price crosses the threshold several times during the period, only the price crosses the threshold several times during the period, only 
one alert is issued and all others are ignored. Once a new Bar has one alert is issued and all others are ignored. Once a new Bar has 
been created, a new alert will be issued when the condition is met.been created, a new alert will be issued when the condition is met.  

l OnceOnceOnceOnce  -- An alert is set off only the first time the condition is met. All  An alert is set off only the first time the condition is met. All 
other events are ignored.other events are ignored.  

SET AN ALERT DIRECTIONSET AN ALERT DIRECTION  

You can also set an alert direction for the chart tools to define in which "direction" the crossing has to take place to set off an alert.You can also set an alert direction for the chart tools to define in which "direction" the crossing has to take place to set off an alert.

l AllAllAllAll  -- Alerts are set off no matter whether the lines are crossed downwards or upwards. Alerts are set off no matter whether the lines are crossed downwards or upwards.  

l Support (downwards)Support (downwards)Support (downwards)Support (downwards)  -- Alerts are only set off in the case of a downwards crossing. Alerts are only set off in the case of a downwards crossing.  

l Resistance (upwards)Resistance (upwards)Resistance (upwards)Resistance (upwards)  -- Alerts are only set off in the case of an upwards crossing. Alerts are only set off in the case of an upwards crossing.  

GLOBAL ALERT SETTINGS IN TRADESIGNALGLOBAL ALERT SETTINGS IN TRADESIGNAL  

In the In the Tradesignal OptionsTradesignal Options, you can define several global settings for the , you can define several global settings for the 
alert output, like an Ealert output, like an E--Mail address or the behavior for each type of alert.Mail address or the behavior for each type of alert.  
  
For this, open the file menu and select the For this, open the file menu and select the OptionsOptionsOptionsOptions entry. Then choose the  entry. Then choose the 
area area AlertsAlerts in the Options window. The following options are available: in the Options window. The following options are available:  
  
Alert options which can be configured per alert type:Alert options which can be configured per alert type:

l ActiveActiveActiveActive  -- Here you can enable or disable alerts of this type. Here you can enable or disable alerts of this type.  
l HighlightHighlightHighlightHighlight  -- With this option enabled, alerts are highlighted in the  With this option enabled, alerts are highlighted in the 

alert window and of alert window and of PopupPopupPopupPopup is enabled too, the popup window will  is enabled too, the popup window will 
not close automatically.not close automatically.  

l PopupPopupPopupPopup  -- If this option is enabled, the alert is displayed in a special popup on the bottom of your screen. If  If this option is enabled, the alert is displayed in a special popup on the bottom of your screen. If HighlightHighlightHighlightHighlight is also  is also 
enabled, the popup will be shown until closed, otherwise it will hide after a short amount of time.enabled, the popup will be shown until closed, otherwise it will hide after a short amount of time.  

l EEEE----MailMailMailMail  -- Enable this to send an E Enable this to send an E--Mail when an alert of this type is triggered. It is only sent when Mail when an alert of this type is triggered. It is only sent when Send an ESend an ESend an ESend an E----Mail when Mail when Mail when Mail when 
an alert occursan alert occursan alert occursan alert occurs is enabled. is enabled.  

l SoundSoundSoundSound  -- Here you can select whether an alert sound shall be played for each alert. Click on  Here you can select whether an alert sound shall be played for each alert. Click on ............ to choose a different sound  to choose a different sound 
file from a file dialog. To preview the sound, click on the triangle button.file from a file dialog. To preview the sound, click on the triangle button.  

General settings:General settings:

Choice of Alert Mode in the Chart ToolsChoice of Alert Mode in the Chart Tools

Alert Settings in the Tradesignal OptionsAlert Settings in the Tradesignal Options
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l Send an ESend an ESend an ESend an E----Mail when an alert occursMail when an alert occursMail when an alert occursMail when an alert occurs  -- By unchecking this, you can prevent E By unchecking this, you can prevent E--Mails from being sent when an alert is Mails from being sent when an alert is 
issued regardless of the setting per type. Select whether you want to send via the MAPI or SMTP protocol and enter the issued regardless of the setting per type. Select whether you want to send via the MAPI or SMTP protocol and enter the 
SMTP configuration, if necessary. You can send a test ESMTP configuration, if necessary. You can send a test E--Mail and also set an interval (shortest time between two sent EMail and also set an interval (shortest time between two sent E--
Mails).Mails).  
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PACKAGE AND FILE MANAGEMENT 
Packages correspond to folders on the computer and offer some additional functions for organizing and managing your data. Packages correspond to folders on the computer and offer some additional functions for organizing and managing your data.   
  
You can use packages for the following: You can use packages for the following: 

l Setting up a folder structure in the Tradesignal data folderSetting up a folder structure in the Tradesignal data folder  
l Sharing data with other usersSharing data with other users  
l Saving data for backupSaving data for backup  
l Export DataExport Data  

The following data can be saved in a package:The following data can be saved in a package:

l IndicatorsIndicators  
l StrategiesStrategies  
l FunctionsFunctions  
l TemplatesTemplates  
l Saved workspacesSaved workspaces  

Packages are compressed on export to reduce the file size. Equilla functions are automatically added to the package if necessary. Packages are compressed on export to reduce the file size. Equilla functions are automatically added to the package if necessary.   
  
When working with packages, please remember that they correspond to physical folders on your computer. Therefore, you can When working with packages, please remember that they correspond to physical folders on your computer. Therefore, you can -- by  by 
intention or by accident intention or by accident -- rename, move or delete these folders with a program like the Windows Explorer. The result of such  rename, move or delete these folders with a program like the Windows Explorer. The result of such 
actions may be that the packages are no longer visible in the package management of Tradesignal. As long as the folders still actions may be that the packages are no longer visible in the package management of Tradesignal. As long as the folders still 
exist, however, you can set up packages again, see the section exist, however, you can set up packages again, see the section Package Management in the Tradesignal OptionsPackage Management in the Tradesignal Options..

NEW PACKAGENEW PACKAGE  

l In the toolbox, click on In the toolbox, click on New PackageNew PackageNew PackageNew Package in the area  in the area Related TasksRelated Tasks to set up a new, empty package. A file dialog appears in  to set up a new, empty package. A file dialog appears in 
which you can either choose an existing folder or set up a new one via the button which you can either choose an existing folder or set up a new one via the button New FolderNew FolderNew FolderNew Folder..  

l Alternatively, you can set up a new package by way of its contents, as shown in the following example.Alternatively, you can set up a new package by way of its contents, as shown in the following example.  

EXAMPLE: SETTING UP NEW INDICATORS IN A NEW PACKAGEEXAMPLE: SETTING UP NEW INDICATORS IN A NEW PACKAGE  

1.1. Click the button Click the button IndicatorsIndicatorsIndicatorsIndicators in the  in the toolboxtoolbox..  
2.2. Click on Click on New IndicatorNew IndicatorNew IndicatorNew Indicator in the  in the Related TasksRelated Tasks area. The Create Item Wizard opens. area. The Create Item Wizard opens.  
3.3. Choose the option Choose the option Download an existing indicator from Tradesignal OnlineDownload an existing indicator from Tradesignal OnlineDownload an existing indicator from Tradesignal OnlineDownload an existing indicator from Tradesignal Online..  
4.4. Select one or more indicators.Select one or more indicators.  
5.5. Confirm with the button Confirm with the button DoneDoneDoneDone..  
6.6. You can then either save the new indicators in an existing package or in a new one by clicking the button You can then either save the new indicators in an existing package or in a new one by clicking the button New PackageNew PackageNew PackageNew Package. . 

Start a new package.Start a new package.  

Tradesignal sets up a new folder in which it saves the downloaded indicators. The new folder can be managed with the package Tradesignal sets up a new folder in which it saves the downloaded indicators. The new folder can be managed with the package 
and folder management in Tradesignal and also with the normal folder functions of the Windows file system.and folder management in Tradesignal and also with the normal folder functions of the Windows file system.
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SHOW AND HIDE PACKAGESSHOW AND HIDE PACKAGES  

With the help of packages you cannot only set up a file system with a subfolder structure, but also organize the contents of the With the help of packages you cannot only set up a file system with a subfolder structure, but also organize the contents of the 
toolbox windows. For the latter, however, the packages have to be displayed.toolbox windows. For the latter, however, the packages have to be displayed.    
  
You can toggle the package display by clicking on You can toggle the package display by clicking on Show/Hide PackagesShow/Hide PackagesShow/Hide PackagesShow/Hide Packages in the  in the Related TasksRelated Tasks area.  area. 

l If packages are shown, the objects (indicators, strategies, workspaces or Equilla functions) are sorted by packages. This is of If packages are shown, the objects (indicators, strategies, workspaces or Equilla functions) are sorted by packages. This is of 
little importance as long as you are only using the packages provided by Tradesignal.little importance as long as you are only using the packages provided by Tradesignal.  

l If packages are hidden, all objects are listed alphabetically without any further breakdown.If packages are hidden, all objects are listed alphabetically without any further breakdown.  

MOVE PACKAGE CONTENTSMOVE PACKAGE CONTENTS  

You can move contents like indicators or functions between packages. For this, the packages have to be displayed. You can move contents like indicators or functions between packages. For this, the packages have to be displayed. 

1.1. Open a tool window in the toolbox, for example Open a tool window in the toolbox, for example IndicatorsIndicatorsIndicatorsIndicators..  
2.2. Select an entry in the list and drag and drop it from one folder to the other.Select an entry in the list and drag and drop it from one folder to the other.  

The entry (e.g. the indicator) is moved between the Tradesignal packages as well as physically between the folders on the The entry (e.g. the indicator) is moved between the Tradesignal packages as well as physically between the folders on the 
computer.computer.

EXPORT OR MAIL PACKAGES EXPORT OR MAIL PACKAGES   

Packages can be exported. During export, the folder with all its contents Packages can be exported. During export, the folder with all its contents 
(workspaces, indicators etc.) and all necessary Equilla functions is saved as (workspaces, indicators etc.) and all necessary Equilla functions is saved as 
a compressed file. You can then use this file as a local backup or mail it to a compressed file. You can then use this file as a local backup or mail it to 
other users for sharing. other users for sharing. 

1.1. Select Select File > Options > Folders > Packages > Export Package fileFile > Options > Folders > Packages > Export Package file. A . A 
dialog opens.dialog opens.  

2.2. In the In the Choose PackageChoose Package area to the left, select the folder to be  area to the left, select the folder to be 
exported. The list will show all folders that are registered by exported. The list will show all folders that are registered by 
Tradesignal. (It is possible that folders below the main folder Tradesignal. (It is possible that folders below the main folder 
Tradesignal FilesTradesignal Files will not be shown because they were hidden in  will not be shown because they were hidden in 
the package management, see below.)the package management, see below.)  

SET THE EXPORT OPTIONSET THE EXPORT OPTION  

Select what you want to have exported:Select what you want to have exported:

l Export source code and compiled codeExport source code and compiled codeExport source code and compiled codeExport source code and compiled code  -- Select this option if the source code should be included, e.g. when sharing the  Select this option if the source code should be included, e.g. when sharing the 
package content with another user.package content with another user.  

l Export only compiled codeExport only compiled codeExport only compiled codeExport only compiled code  -- Select this option if the source code should not be included upon export, e.g. if you want to  Select this option if the source code should not be included upon export, e.g. if you want to 

Export a packageExport a package
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share the data with other users without giving them access to the original source code.share the data with other users without giving them access to the original source code.  
l Make exported packages readMake exported packages readMake exported packages readMake exported packages read----only when importedonly when importedonly when importedonly when imported  -- If you select this option, the contents of the package cannot be  If you select this option, the contents of the package cannot be 

edited after import.edited after import.  

SET THE EXPORT ROUTESET THE EXPORT ROUTE  

l Send via ESend via ESend via ESend via E----MailMailMailMail  -- If you select this and then click the  If you select this and then click the ExportExportExportExport button, your default mail program will be opened and the file  button, your default mail program will be opened and the file 
will be attached to a new mail.will be attached to a new mail.  

l Export fileExport fileExport fileExport file  -- Select this if you want to save the file to your computer. ''' Select this if you want to save the file to your computer. '''  
l BrowseBrowseBrowseBrowse and selecting another one (or changing the file name). Click the  and selecting another one (or changing the file name). Click the ExportExportExportExport button to start the export. button to start the export.  

IMPORT PACKAGEIMPORT PACKAGE  

An exported package can be imported into Tradesignal. For this, the An exported package can be imported into Tradesignal. For this, the 
package file has to be available on the hard drive of your computer or on a package file has to be available on the hard drive of your computer or on a 
removable storage drive that can be accessed from your computer. removable storage drive that can be accessed from your computer.   
  
You can import a package by doubleYou can import a package by double--clicking on it in Windows Explorer. (If clicking on it in Windows Explorer. (If 
you received the package as an Eyou received the package as an E--Mail attachment, you can either save it Mail attachment, you can either save it 
on your desktop or import it directly into Tradesignal by doubleon your desktop or import it directly into Tradesignal by double--clicking on clicking on 
it.)it.)  
  

Import a packageImport a package

Alternatively, you can select Alternatively, you can select File > Options > Folders > Packages > Import File > Options > Folders > Packages > Import 
package filepackage file. Select the package file in the file dialog and confirm the . Select the package file in the file dialog and confirm the 
import.import.  
  
The program then decompresses the data in the package file and creates a new folder with the package name below the main The program then decompresses the data in the package file and creates a new folder with the package name below the main 
folder folder Tradesignal FilesTradesignal Files. The new folder will appear in the toolbox window and the package management. . The new folder will appear in the toolbox window and the package management. 

PACKAGE MANAGEMENT IN THE TRADESIGNAL OPTIONSPACKAGE MANAGEMENT IN THE TRADESIGNAL OPTIONS  

Tradesignal offers you several functions for the management of packages. Tradesignal offers you several functions for the management of packages.   
  

Package management in the Tradesignal OptionsPackage management in the Tradesignal Options

To access these functions, navigate to the To access these functions, navigate to the File > Options > Folders > File > Options > Folders > 
PackagesPackages area.  area.   
  
You have the following options:You have the following options:

l Add a new packageAdd a new packageAdd a new packageAdd a new package  

l Attach to an existing packageAttach to an existing packageAttach to an existing packageAttach to an existing package  -- Access a previously hidden package. In this case, a file dialog opens in which you can  Access a previously hidden package. In this case, a file dialog opens in which you can 
find and select the package.find and select the package.  

l RemoveRemoveRemoveRemove  -- If you select a package and click the  If you select a package and click the XXXX next to it, you can either choose next to it, you can either choose
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¡ Remove this package, but leave its contents untouched so that other users can still access themRemove this package, but leave its contents untouched so that other users can still access themRemove this package, but leave its contents untouched so that other users can still access themRemove this package, but leave its contents untouched so that other users can still access them. In this . In this 
case the package is only removed from the folder structure in Tradesignal but the physical folder is still available.case the package is only removed from the folder structure in Tradesignal but the physical folder is still available.  

¡ Remove this package and permanently delete its contentsRemove this package and permanently delete its contentsRemove this package and permanently delete its contentsRemove this package and permanently delete its contents. In this case, all data will be removed from . In this case, all data will be removed from 
Tradesignal and also physically deleted from the hard drive.Tradesignal and also physically deleted from the hard drive.  

l RenameRenameRenameRename  -- Select the package a click the edit (pen) icon. The function renames both the package and the folder on the hard  Select the package a click the edit (pen) icon. The function renames both the package and the folder on the hard 
drive.drive.  

l Move up/Move downMove up/Move downMove up/Move downMove up/Move down  -- With these buttons you can change the folder sequence in Tradesignal. Note that if you have  With these buttons you can change the folder sequence in Tradesignal. Note that if you have 
functions/indicators/strategies of the same name in different folders, changes in sequence may have effects on the functions/indicators/strategies of the same name in different folders, changes in sequence may have effects on the 
processing order. When compiling an indicator/strategy, Tradesignal tries to find the necessary functions/indicators in the processing order. When compiling an indicator/strategy, Tradesignal tries to find the necessary functions/indicators in the 
same package. If they cannot be found there, all packages are searched according to the given sequence, and the first find is same package. If they cannot be found there, all packages are searched according to the given sequence, and the first find is 
used for the compilation.used for the compilation.  

l Alert on UpdateAlert on UpdateAlert on UpdateAlert on Update  -- Check the box if you want to be alerted to updates to the package. In combination with the checkbox  Check the box if you want to be alerted to updates to the package. In combination with the checkbox File File 
> Options > Alerts > Package Alerts > Show updates to packages as a top> Options > Alerts > Package Alerts > Show updates to packages as a top--most dialog with refresh optionmost dialog with refresh option this allows you to  this allows you to 
refresh packages as soon as they are updated.refresh packages as soon as they are updated.  

l Refresh contents of all packagesRefresh contents of all packagesRefresh contents of all packagesRefresh contents of all packages  -- The contents of the package folders are checked by Tradesignal only upon start.  The contents of the package folders are checked by Tradesignal only upon start. 
Therefore, if Tradesignal is running and files are changed outside of Tradesignal (added, renamed, or deleted), you need to Therefore, if Tradesignal is running and files are changed outside of Tradesignal (added, renamed, or deleted), you need to 
click click RefreshRefreshRefreshRefresh so that the package contents are updated in Tradesignal. This is especially important in cases such as: so that the package contents are updated in Tradesignal. This is especially important in cases such as:

¡ While Tradesignal was running,While Tradesignal was running, you received a workspace attached to an E you received a workspace attached to an E--mail and saved it into a package folder.mail and saved it into a package folder.  
¡ You are working with packages on a network drive and other users changed the package contents.You are working with packages on a network drive and other users changed the package contents.  

l You can find the You can find the RefreshRefreshRefreshRefresh function also in the context menu of packages in the toolbox. function also in the context menu of packages in the toolbox.

As a partial alternative to package management in the Tradesignal options, you can also create, rename or delete packages in the As a partial alternative to package management in the Tradesignal options, you can also create, rename or delete packages in the 
OpenOpen dialog. You can call up this dialog by opening the file menu and selecting  dialog. You can call up this dialog by opening the file menu and selecting OpenOpenOpenOpen, or by pressing the key combination , or by pressing the key combination Ctrl + Ctrl + Ctrl + Ctrl + 
OOOO..    
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PRINT 
Your charts, strategies, indicators or Equilla codes do not have to be limited to your computer. All documents can be published right Your charts, strategies, indicators or Equilla codes do not have to be limited to your computer. All documents can be published right 
out of Tradesignal (as printouts or files), for example in Internet forums, print media or by Eout of Tradesignal (as printouts or files), for example in Internet forums, print media or by E--Mail. In the other direction, it is also Mail. In the other direction, it is also 
possible to import documents in Tradesignal from Internet forums or by Epossible to import documents in Tradesignal from Internet forums or by E--Mail .Mail .  
  
This way, you can exchange content with friends, colleagues and supervisors and work on Equilla code together, for example.This way, you can exchange content with friends, colleagues and supervisors and work on Equilla code together, for example.  
  
For exchanging complete packages, please see the chapters For exchanging complete packages, please see the chapters Export PackagesExport Packages and  and Import PackagesImport Packages..

PRINTING CHARTS AND TABLESPRINTING CHARTS AND TABLES  

You can print all documents (Charts, Scanner, Watchlist, Equilla code etc.).You can print all documents (Charts, Scanner, Watchlist, Equilla code etc.).  
Click on the Click on the PrintPrintPrintPrint button in the  button in the FileFile menu. The Print Wizard opens. Here  menu. The Print Wizard opens. Here 
you can choose what in the currently selected workspace should be printed. you can choose what in the currently selected workspace should be printed. 
  
  
After selection, a After selection, a Print PreviewPrint Preview pane opens. Here you have the following  pane opens. Here you have the following 
options:options:

l PrintPrintPrintPrint  -- Start the printing. The standard Windows printer dialog  Start the printing. The standard Windows printer dialog 
opens.opens.  

l CopiesCopiesCopiesCopies  -- Number of copies of the workspace to print. Number of copies of the workspace to print.  

l PrinterPrinterPrinterPrinter  -- The printer to which to print. The printer to which to print.  

l Printer PropertiesPrinter PropertiesPrinter PropertiesPrinter Properties  -- Advanced configuration of the selected printer. Advanced configuration of the selected printer.  

l Items to PrintItems to PrintItems to PrintItems to Print  -- List of items in the workspace to print (including an  List of items in the workspace to print (including an 
extra page containing the workspace as a whole. The items are extra page containing the workspace as a whole. The items are 
printed in the order listed. The arrow buttons can be used to change printed in the order listed. The arrow buttons can be used to change 
the print order of the items.the print order of the items.  

l Chart ScalingChart ScalingChart ScalingChart Scaling  -- Determines how charts should be scaled to fit the  Determines how charts should be scaled to fit the 
printed page.printed page.  

Print OverviewPrint Overview

Edit Header/FooterEdit Header/Footer



:: www.tradesignal.comwww.tradesignal.com

Tradesignal GmbHTradesignal GmbH Page 267Page 267 Version 7.0Version 7.0

l Duplex ModeDuplex ModeDuplex ModeDuplex Mode  -- Depending on the duplex/simplex capabilities of  Depending on the duplex/simplex capabilities of 
the printer.the printer.  

l CollationCollationCollationCollation  -- Options to control how pages are collated. Options to control how pages are collated.  

l Paper SizePaper SizePaper SizePaper Size  -- Selection of the paper size. Selection of the paper size.  

l OrientationOrientationOrientationOrientation  -- Portrait or landscape. Portrait or landscape.  

l Color ModeColor ModeColor ModeColor Mode  -- Select whether the document should be printed in  Select whether the document should be printed in 
Full Color (with transparency)Full Color (with transparency)Full Color (with transparency)Full Color (with transparency) (24 bit RGB with alpha channel),  (24 bit RGB with alpha channel), 
Full Color (without transparency)Full Color (without transparency)Full Color (without transparency)Full Color (without transparency) (24 bit RGB without alpha  (24 bit RGB without alpha 
channel) or as channel) or as Black and WhiteBlack and WhiteBlack and WhiteBlack and White. If the image is scaled on your . If the image is scaled on your 
printer (e.g. into a larger format), select printer (e.g. into a larger format), select Full Color (without transparency)Full Color (without transparency)Full Color (without transparency)Full Color (without transparency) for better results. for better results.  

l MarginsMarginsMarginsMargins  -- Some predefined margin options. Margins can also be manually adjusted using click and drag directly in the  Some predefined margin options. Margins can also be manually adjusted using click and drag directly in the 
preview pane.preview pane.  

l Edit Header/FooterEdit Header/FooterEdit Header/FooterEdit Header/Footer  -- Shows the header/footer dialog where text and various macros can be set for the page header and  Shows the header/footer dialog where text and various macros can be set for the page header and 
footer. The alignment of text and font can also be changed. The following macros are available:footer. The alignment of text and font can also be changed. The following macros are available:

¡ Document titleDocument title  
¡ Page NumberPage Number  
¡ Page CountPage Count  
¡ Print DatePrint Date  
¡ Print TimePrint Time  
¡ Print UserPrint User  

l Edit WatermarkEdit WatermarkEdit WatermarkEdit Watermark  -- Show the watermark dialog where a watermark based on text or an image can be specified for each  Show the watermark dialog where a watermark based on text or an image can be specified for each 
page on the printed output. The watermark dialog presents many options to configure how the watermark is displayed, page on the printed output. The watermark dialog presents many options to configure how the watermark is displayed, 
includingincluding

¡ Text, Text direction, Font, Color and Size.Text, Text direction, Font, Color and Size.  
¡ Image file and alignment.Image file and alignment.  
¡ Translucency.Translucency.  
¡ Positioned in front or behind.Positioned in front or behind.  
¡ Page range to apply watermark to.Page range to apply watermark to.  

For a chart and performance report, you can find additional printFor a chart and performance report, you can find additional print--out options in the toolbox, category out options in the toolbox, category PublishPublishPublishPublish. You can change the . You can change the 
axes' colors and the header.axes' colors and the header.  
  
The print options selected for a workspace will be remembered following printing. General options for printing (including setting a The print options selected for a workspace will be remembered following printing. General options for printing (including setting a 
standard watermark and header/footer) are available in the options under standard watermark and header/footer) are available in the options under File > Options > Personalize > PrintingFile > Options > Personalize > Printing..

PRINT SCHEDULEPRINT SCHEDULE  

Edit WatermarkEdit Watermark
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If you want to print documents on a regular basis, e.g. an overview of If you want to print documents on a regular basis, e.g. an overview of 
important indexes every morning, you can use the print scheduling function important indexes every morning, you can use the print scheduling function 
of Tradesignal. In the schedule, you can set up the printing of any number of Tradesignal. In the schedule, you can set up the printing of any number 
of documents at any date and time. of documents at any date and time.   
  
To be available for this function, the documents have to be saved as a To be available for this function, the documents have to be saved as a 
package in workspaces. If the documents are not found there, either the package in workspaces. If the documents are not found there, either the 
wrong documents or none may be printed. Therefore, we recommend that wrong documents or none may be printed. Therefore, we recommend that 
you test each print schedule after its setyou test each print schedule after its set--up.up.  
  
To set up a print scheduleTo set up a print schedule

1.1. Open the desired workspaceOpen the desired workspace  
2.2. Select Select File > PrintFile > PrintFile > PrintFile > Print  
3.3. Click on Click on Add print scheduleAdd print scheduleAdd print scheduleAdd print schedule at the bottom left of the print pane to  at the bottom left of the print pane to 

display the print schedule optionsdisplay the print schedule options  
4.4. Select the desired print schedule settings and click Select the desired print schedule settings and click OKOKOKOK  

The dialog will be dismissed and a new entry in the The dialog will be dismissed and a new entry in the ScheduleScheduleScheduleSchedule section of  section of 
the print pane will be added. The buttons next to this entry can be used to the print pane will be added. The buttons next to this entry can be used to 
edit or remove the schedule. Multiple schedules can be added for the same edit or remove the schedule. Multiple schedules can be added for the same 
workspace.workspace.  
  
If any workspaces have print scheduling set, a small print icon will be If any workspaces have print scheduling set, a small print icon will be 
displayed above the Toolbar. Clicking on this button will display a dialog displayed above the Toolbar. Clicking on this button will display a dialog 
showing all scheduled printing jobs and provide buttons to edit or delete them.showing all scheduled printing jobs and provide buttons to edit or delete them.

OPTIONS FOR SCHEDULED PRINTINGOPTIONS FOR SCHEDULED PRINTING  

When the print schedule settings dialog is displayed, the following options are available. Where there is no option for printing the When the print schedule settings dialog is displayed, the following options are available. Where there is no option for printing the 
setting chosen from the workspace print pane will be used.setting chosen from the workspace print pane will be used.

l DaysDaysDaysDays  -- Which days of the week to print on. Which days of the week to print on.  

l TimeTimeTimeTime  -- At which time to print. To print at multiple times on the same day, add a second print schedule. At which time to print. To print at multiple times on the same day, add a second print schedule.  

l CopiesCopiesCopiesCopies  -- How many copies of the document to print. How many copies of the document to print.  

l Items to printItems to printItems to printItems to print  -- This option gives various ways to print different items in a workspace This option gives various ways to print different items in a workspace

¡ Items listed in the normal print settingsItems listed in the normal print settings  
¡ All items in the workspaceAll items in the workspace  
¡ All charts in the workspaceAll charts in the workspace  
¡ All lists in the workspace (Watchlists, etc.)All lists in the workspace (Watchlists, etc.)  
¡ All lists and all chartsAll lists and all charts  

l OrientationOrientationOrientationOrientation  -- When not using the normal print settings, it is also possible to set the orientation for ptinting. When not using the normal print settings, it is also possible to set the orientation for ptinting.  

l Alternate printerAlternate printerAlternate printerAlternate printer  -- It is possible to use either the printer settings from the normal print page, or to select an alternate  It is possible to use either the printer settings from the normal print page, or to select an alternate 

Print SchedulePrint Schedule
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printer, page size and duplex mode.printer, page size and duplex mode.  

Click Click OKOKOKOK to save the print schedule settings. to save the print schedule settings.

PUBLISHING WITH THE WINDOWS CHART VIEWERPUBLISHING WITH THE WINDOWS CHART VIEWER  

If you are often confronted with the task of creating publications with chart analysis, you can ease the work by using Tradesignal If you are often confronted with the task of creating publications with chart analysis, you can ease the work by using Tradesignal 
documents as Chart Viewer Object objects. This is a documents as Chart Viewer Object objects. This is a Windows ObjectWindows Object that can be used in many programs, e.g. word processing. that can be used in many programs, e.g. word processing.  
  
In the following paragraphs, you can find the stepIn the following paragraphs, you can find the step--byby--step instructions for MS Word (up to Word 2003) and MS Word 2007.step instructions for MS Word (up to Word 2003) and MS Word 2007.

MS WORD (UP TO WORD 2003)MS WORD (UP TO WORD 2003)  

1.1. Open your word processor.Open your word processor.  
2.2. From the From the InsertInsertInsertInsert menu, select the  menu, select the ObjectObjectObjectObject entry. entry.  
3.3. From the list of objects, select From the list of objects, select Tradesignal Chart ViewerTradesignal Chart ViewerTradesignal Chart ViewerTradesignal Chart Viewer..  
4.4. RightRight--click on the newly appearing border in the text document. The context menu opens.click on the newly appearing border in the text document. The context menu opens.  
5.5. From the context menu, select From the context menu, select Tradesignal Chart Viewer ObjectTradesignal Chart Viewer ObjectTradesignal Chart Viewer ObjectTradesignal Chart Viewer Object and then select  and then select PropertiesPropertiesPropertiesProperties from the submenu to edit  from the submenu to edit 

those.those.  

l Here you have to enter the package in which the requested workspace is saved.For example:Here you have to enter the package in which the requested workspace is saved.For example:

l Package: Package: Tradesignal FilesTradesignal Files  
l Workspace: Workspace: Chart NasdaqChart Nasdaq  

You can edit the format of the graph by editing the height and width. It is possible to enter more than one chart in the new You can edit the format of the graph by editing the height and width. It is possible to enter more than one chart in the new 
document.document.    
  
Save your document, e.g. as a template for your analysis. The name and folder can be freely chosen. Save your document, e.g. as a template for your analysis. The name and folder can be freely chosen.   
  
When you open the document again, the following steps are necessary to update the graph.When you open the document again, the following steps are necessary to update the graph.

1.1. Start Tradesignal.Start Tradesignal.  
2.2. RightRight--click in the graph in your document (e.g. in MS Word) to open the context menu.click in the graph in your document (e.g. in MS Word) to open the context menu.  
3.3. In the context menu, select the In the context menu, select the PropertiesPropertiesPropertiesProperties of the  of the Chart ViewerChart ViewerChart ViewerChart Viewer..  
4.4. Click on Click on UpdateUpdateUpdateUpdate and then on  and then on OKOKOKOK..  

The chart is now refreshed with the data given by Tradesignal.The chart is now refreshed with the data given by Tradesignal.

MS WORD 2007MS WORD 2007  

When using MS Word 2007, the "Developer" tab has to be available. If this is not the case, proceed as follows: When using MS Word 2007, the "Developer" tab has to be available. If this is not the case, proceed as follows: 

1.1. Click on the Microsoft Office button and then click on Click on the Microsoft Office button and then click on [program] Options[program] Options[program] Options[program] Options. The program is the name of the current program, . The program is the name of the current program, 
i.e. "Word".i.e. "Word".  

2.2. Click on Click on PopularPopularPopularPopular and check  and check Show Developer Tab in the RibbonShow Developer Tab in the RibbonShow Developer Tab in the RibbonShow Developer Tab in the Ribbon..  
3.3. Click on the tab Click on the tab DeveloperDeveloperDeveloperDeveloper..  
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4.4. In the controls, select In the controls, select LegacytoolsLegacytoolsLegacytoolsLegacytools. Then, under. Then, under  More ControlsMore ControlsMore ControlsMore Controls, select , select TradeSignal Chart ViewerTradeSignal Chart ViewerTradeSignal Chart ViewerTradeSignal Chart Viewer..  

In the configuration window, enter the package in which the requested workspace is saved. In the configuration window, enter the package in which the requested workspace is saved.   
  
For example:For example:

l Package: Package: Tradesignal FilesTradesignal Files  
l Workspace: Workspace: Chart NasdaqChart Nasdaq  

You can edit the format of the graph by editing the height and width. It is possible to enter more than one chart in the new You can edit the format of the graph by editing the height and width. It is possible to enter more than one chart in the new 
document.document.    
  
Save your document, e.g. as a template for your analysis. The name and folder can be freely chosen. Save your document, e.g. as a template for your analysis. The name and folder can be freely chosen.   
  
When you open the document again, the following steps are necessary to update the graph.When you open the document again, the following steps are necessary to update the graph.

1.1. Start Tradesignal.Start Tradesignal.  
2.2. RightRight--click in the graph in your document (e.g. in MS Word) to open the context menu.click in the graph in your document (e.g. in MS Word) to open the context menu.  
3.3. In the context menu, select the In the context menu, select the PropertiesPropertiesPropertiesProperties of the  of the Chart ViewerChart ViewerChart ViewerChart Viewer..  
4.4. Click on Click on UpdateUpdateUpdateUpdate and then on  and then on OKOKOKOK..  

The chart is now refreshed with the data given by Tradesignal.The chart is now refreshed with the data given by Tradesignal.

MS WORD 2010+MS WORD 2010+  

When using MS Word 2010 or above, the "Developer" tab has to be available. If this is not the case, proceed as follows: When using MS Word 2010 or above, the "Developer" tab has to be available. If this is not the case, proceed as follows: 

1.1. Click on the Click on the FileFileFileFile tab on the toolbar and then click on  tab on the toolbar and then click on OptionsOptionsOptionsOptions..  
2.2. Click on Click on Customize RibbonCustomize RibbonCustomize RibbonCustomize Ribbon and in the box on the far right that lists all ribbon tabs, check the option labelled  and in the box on the far right that lists all ribbon tabs, check the option labelled DeveloperDeveloperDeveloperDeveloper, , 

then click then click OKOKOKOK..  
3.3. Click on the tab Click on the tab DeveloperDeveloperDeveloperDeveloper..  
4.4. Ensure design mode is active by clicking on Ensure design mode is active by clicking on Design ModeDesign Mode button in the  button in the ControlsControlsControlsControls group if it is not highlighted. group if it is not highlighted.  
5.5. In the In the ControlsControlsControlsControls group, select  group, select Legacy ToolsLegacy ToolsLegacy ToolsLegacy Tools. Then, under. Then, under  More ControlsMore ControlsMore ControlsMore Controls, select , select Tradesignal Chart ViewerTradesignal Chart ViewerTradesignal Chart ViewerTradesignal Chart Viewer. The chart . The chart 

viewer object will be inserted into your document.viewer object will be inserted into your document.  
6.6. RightRight--click on the inserted object and select click on the inserted object and select Tradesignal Chart Viewer Object > EditTradesignal Chart Viewer Object > Edit to show the properties dialog. to show the properties dialog.  

In the properties dialog, enter the package in which the requested workspace is saved. In the properties dialog, enter the package in which the requested workspace is saved.   
  
For example:For example:

l Package: Package: Tradesignal FilesTradesignal Files  
l Workspace: Workspace: Chart NasdaqChart Nasdaq  

You can edit the format of the graph by editing the height and width. It is possible to enter more than one chart in the new You can edit the format of the graph by editing the height and width. It is possible to enter more than one chart in the new 
document.document.    
  
Save your document, e.g. as a template for your analysis. The name and folder can be freely chosen. Save your document, e.g. as a template for your analysis. The name and folder can be freely chosen.   
  
When you open the document again, the following steps are necessary to update the graph.When you open the document again, the following steps are necessary to update the graph.

1.1. Start Tradesignal.Start Tradesignal.  



:: www.tradesignal.comwww.tradesignal.com

Tradesignal GmbHTradesignal GmbH Page 271Page 271 Version 7.0Version 7.0

2.2. RightRight--click in the graph in your document (e.g. in MS Word) to open the context menu.click in the graph in your document (e.g. in MS Word) to open the context menu.  
3.3. In the context menu, select the In the context menu, select the PropertiesPropertiesPropertiesProperties of the  of the Chart ViewerChart ViewerChart ViewerChart Viewer..  
4.4. Click on Click on UpdateUpdateUpdateUpdate and then on  and then on OKOKOKOK..  

The chart is now refreshed with the data given by Tradesignal.The chart is now refreshed with the data given by Tradesignal.  
  
Please note: ActiveX Objects and AddPlease note: ActiveX Objects and AddPlease note: ActiveX Objects and AddPlease note: ActiveX Objects and Add----Ins from thirdIns from thirdIns from thirdIns from third----parties, will generally not work with 64parties, will generally not work with 64parties, will generally not work with 64parties, will generally not work with 64----bit versions of Microsoft bit versions of Microsoft bit versions of Microsoft bit versions of Microsoft 
Office.Office.Office.Office.    
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SAVE & SEND 

SENDING A WORKSPACE BY EMAILSENDING A WORKSPACE BY EMAIL  

You can send workspaces via Email right out of the Tradesignal. You can send workspaces via Email right out of the Tradesignal. 

1.1. Click on the Click on the File > Save & Send > Send Using EmailFile > Save & Send > Send Using EmailFile > Save & Send > Send Using EmailFile > Save & Send > Send Using Email button. The  button. The 
EE--Mail wizard opens.Mail wizard opens.  

2.2. Select whether to include a preview image of the workspace.Select whether to include a preview image of the workspace.  
3.3. Click Click Send EmailSend EmailSend EmailSend Email to open a new email and attach the workspace. to open a new email and attach the workspace.  

SENDING EQUILLA SCRIPTS VIA EMAILSENDING EQUILLA SCRIPTS VIA EMAIL  

To send an Equilla script and its dependent function files via emailTo send an Equilla script and its dependent function files via email

1.1. Open the desired Equilla script.Open the desired Equilla script.  
2.2. Select Select Editor > Export > Send by EmailEditor > Export > Send by EmailEditor > Export > Send by EmailEditor > Export > Send by Email on the Toolbar on the Toolbar  

l The Email client with attached portable script file and a code preview will be opened.The Email client with attached portable script file and a code preview will be opened.

IMPORTING WORKSPACES OR EQUILLA CODE FROM AN EMAILIMPORTING WORKSPACES OR EQUILLA CODE FROM AN EMAIL  

When you received an EWhen you received an E--mail with Tradesignal documents, you can import them into Tradesignal. mail with Tradesignal documents, you can import them into Tradesignal. 

1.1. Save the ESave the E--mail attachment in a folder that is also a package in Tradesignal.mail attachment in a folder that is also a package in Tradesignal.  
2.2. In Tradesignal, open the In Tradesignal, open the toolboxtoolbox..  
3.3. With packages displayed, rightWith packages displayed, right--click on the package and select click on the package and select RefreshRefreshRefreshRefresh from the context menu. from the context menu.  
4.4. When the display is refreshed, you can find the new documents in the package. You can then open them in Tradesignal.When the display is refreshed, you can find the new documents in the package. You can then open them in Tradesignal.  

POSTING DOCUMENTS IN INTERNET FORUMSPOSTING DOCUMENTS IN INTERNET FORUMS  

You can post documents from Tradesignal right into the Internet forum. To You can post documents from Tradesignal right into the Internet forum. To 
do so, you have to enter your user name and password in the do so, you have to enter your user name and password in the OptionsOptions under  under 
File > Options > Personalize > Tradesignal OnlineFile > Options > Personalize > Tradesignal OnlineFile > Options > Personalize > Tradesignal OnlineFile > Options > Personalize > Tradesignal Online..

CREATE A COPY FOR THE INTERNETCREATE A COPY FOR THE INTERNET  

1.1. Click on Click on File > Save & Send > Publish to Discussion ForumsFile > Save & Send > Publish to Discussion ForumsFile > Save & Send > Publish to Discussion ForumsFile > Save & Send > Publish to Discussion Forums. . 
The Publish wizard opens.The Publish wizard opens.  

2.2. Check the boxes of the items in the current workspace that you want to post.Check the boxes of the items in the current workspace that you want to post.  
3.3. Click Click Post to ForumPost to ForumPost to ForumPost to Forum  

1.1. After the copying, you can open the forum either in the current or in a new workspace. Alternatively, you can also click on After the copying, you can open the forum either in the current or in a new workspace. Alternatively, you can also click on 
CloseCloseCloseClose and open the forum in a new web browser. In all cases, the content of the Tradesignal Online clipboard is preserved. and open the forum in a new web browser. In all cases, the content of the Tradesignal Online clipboard is preserved.  

Sending Workspaces by EmailSending Workspaces by Email

Copying Documents to ForumsCopying Documents to Forums
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USE THE COPYUSE THE COPY  

To use the copied document(s), you have to be signed on to the website To use the copied document(s), you have to be signed on to the website tradesignalonline.comtradesignalonline.com. Then surf to the thread in which . Then surf to the thread in which 
you want to publish your document.you want to publish your document.  

1.1. Select either Select either New PostingNew PostingNew PostingNew Posting or reply to an existing one. In the lower area of the window, a field for text entry is displayed.  or reply to an existing one. In the lower area of the window, a field for text entry is displayed. 
To its right, you can find the contents of your Tradesignal Online To its right, you can find the contents of your Tradesignal Online ClipboardClipboardClipboardClipboard..  

2.2. Click on the contents to insert it in the posting. In the text field, an entry appears such as "[EQU=2132867]", referencing the Click on the contents to insert it in the posting. In the text field, an entry appears such as "[EQU=2132867]", referencing the 
contents. This unique entry cannot be edited further.contents. This unique entry cannot be edited further.  

IMPORTING CHARTS, WORKSPACES OR EQUILLA CODE FROM AN INTERNET FORUMIMPORTING CHARTS, WORKSPACES OR EQUILLA CODE FROM AN INTERNET FORUM  

You can download charts, workspaces and Equilla Codes from the internet forum for use in Tradesignal. You can download charts, workspaces and Equilla Codes from the internet forum for use in Tradesignal. 

1.1. In Tradesignal, select In Tradesignal, select File > Help > Discussion ForumsFile > Help > Discussion ForumsFile > Help > Discussion ForumsFile > Help > Discussion Forums..  
2.2. Surf to a thread or posting that includes a Tradesignal document.Surf to a thread or posting that includes a Tradesignal document.  
3.3. Click on the link Click on the link Import into TradesignalImport into TradesignalImport into TradesignalImport into Tradesignal. If a chart was created with Tradesignal Online, you can also click on it to open . If a chart was created with Tradesignal Online, you can also click on it to open 

it in Tradesignal. You can find more information on importing code in the chapter it in Tradesignal. You can find more information on importing code in the chapter Downloading an Indicator from Downloading an Indicator from 
Tradesignal OnlineTradesignal Online..  

SAVING DOCUMENTS AS IMAGESSAVING DOCUMENTS AS IMAGES  

You can save the workspace as image, e.g. to use it later in text documents You can save the workspace as image, e.g. to use it later in text documents 
or Eor E--Mails.Mails.    
  
Click on the Click on the File > Save & Send > Save ImageFile > Save & Send > Save Image. The . The Save ImageSave Image pane  pane 
opens. At the bottom of the pane you will see a preview of the image.opens. At the bottom of the pane you will see a preview of the image.

OPTIONS FOR SAVING AS IMAGEOPTIONS FOR SAVING AS IMAGE  

l Pick what you would like to save an image of, the entire workspace Pick what you would like to save an image of, the entire workspace 
or a single element in it..or a single element in it..  

l Enter an image size in pixels, inches or millimeters. Take care that Enter an image size in pixels, inches or millimeters. Take care that 
the freely adjustable height and width of the image do not lead to distortion.the freely adjustable height and width of the image do not lead to distortion.  

l Select the Select the Color ModeColor Mode, either , either ColorColorColorColor (color image with 24 bit RGB and alpha channel) or  (color image with 24 bit RGB and alpha channel) or Black and WhiteBlack and WhiteBlack and WhiteBlack and White (no colors). (no colors).  

l Select the resolution for the image. 96 DPI (dots per inch) is normal screen resolution, use higher resolutions if the image is Select the resolution for the image. 96 DPI (dots per inch) is normal screen resolution, use higher resolutions if the image is 
intended for print output or zooming out using interpolation is intended.intended for print output or zooming out using interpolation is intended.  

l Select whether to use interpolation. Interpolation will essentially render the image at the selected resolution, then scale it Select whether to use interpolation. Interpolation will essentially render the image at the selected resolution, then scale it 
down to fit the desired dimensions. This will create a zoomeddown to fit the desired dimensions. This will create a zoomed--out look to an image at the cost of some precision.out look to an image at the cost of some precision.  

Finally, either click on of the following buttons:Finally, either click on of the following buttons:

Saving Documents and Workspaces as ImagesSaving Documents and Workspaces as Images



:: www.tradesignal.comwww.tradesignal.com

Tradesignal GmbHTradesignal GmbH Page 274Page 274 Version 7.0Version 7.0

l Save ImageSave ImageSave ImageSave Image  -- This saves the selected item as an image file. A new dialog opens. Choose the target folder and the file  This saves the selected item as an image file. A new dialog opens. Choose the target folder and the file 
format. Six image formats are available: jpg, png, bmp, gif, tif and emf (emf is a scalable, vector format, although the format. Six image formats are available: jpg, png, bmp, gif, tif and emf (emf is a scalable, vector format, although the 
generated image may not be identical to the preview).generated image may not be identical to the preview).  

l Copy to ClipboardCopy to ClipboardCopy to ClipboardCopy to Clipboard  -- This generates a copy of the image in the Windows clipboard in bmp format. This generates a copy of the image in the Windows clipboard in bmp format.  

l Send EmailSend EmailSend EmailSend Email  -- Create the image in png format and attach it to a new email. Create the image in png format and attach it to a new email.  

SAVING PDF DOCUMENTSSAVING PDF DOCUMENTS  

Any items that can be printed can also be saved as a PDF file. To save a Any items that can be printed can also be saved as a PDF file. To save a 
PDF file click on PDF file click on File > Save & Send > Create PDFFile > Save & Send > Create PDF to display the PDF  to display the PDF 
preview pane.preview pane.  
  
The PDF preview pane present most of the same options that the print The PDF preview pane present most of the same options that the print 
preview pane offers, and uses previously saved settings associated with a preview pane offers, and uses previously saved settings associated with a 
workspace.workspace.

l Save as PDFSave as PDFSave as PDFSave as PDF  -- Save the PDF file. Save the PDF file.  

l Send by EmailSend by EmailSend by EmailSend by Email  -- Create a PDF file and attach it to a new Email. Create a PDF file and attach it to a new Email.  

l Items to PrintItems to PrintItems to PrintItems to Print  -- List of items in the workspace to print (including an  List of items in the workspace to print (including an 
extra page containing the workspace as a whole. The items are printed in the order listed. The arrow buttons can be used to extra page containing the workspace as a whole. The items are printed in the order listed. The arrow buttons can be used to 
change the print order of the items.change the print order of the items.  

l Chart ScalingChart ScalingChart ScalingChart Scaling  -- Determines how charts should be scaled to fit the printed page. Determines how charts should be scaled to fit the printed page.  

l Paper SizePaper SizePaper SizePaper Size  -- Selection of the paper size. Selection of the paper size.  

l OrientationOrientationOrientationOrientation  -- Portrait or landscape. Portrait or landscape.  

l Color ModeColor ModeColor ModeColor Mode  -- Select whether the document should be printed in  Select whether the document should be printed in Full Color (with transparency)Full Color (with transparency)Full Color (with transparency)Full Color (with transparency) (24 bit RGB with alpha  (24 bit RGB with alpha 
channel), channel), Full Color (without transparency)Full Color (without transparency)Full Color (without transparency)Full Color (without transparency) (24 bit RGB without alpha channel) or as  (24 bit RGB without alpha channel) or as Black and WhiteBlack and WhiteBlack and WhiteBlack and White. If the image is . If the image is 
scaled on your printer (e.g. into a larger format), select scaled on your printer (e.g. into a larger format), select Full Color (without transparency)Full Color (without transparency)Full Color (without transparency)Full Color (without transparency) for better results. for better results.  

l MarginsMarginsMarginsMargins  -- Some predefined margin options. Margins can also be manually adjusted using click and drag directly in the  Some predefined margin options. Margins can also be manually adjusted using click and drag directly in the 
preview pane.preview pane.  

l Edit Header/FooterEdit Header/FooterEdit Header/FooterEdit Header/Footer  -- Shows the header/footer dialog where text and various macros can be set for the page header and  Shows the header/footer dialog where text and various macros can be set for the page header and 
footer. The alignment of text and font can also be changed. The following macros are available:footer. The alignment of text and font can also be changed. The following macros are available:

¡ Document titleDocument title  
¡ Page NumberPage Number  
¡ Page CountPage Count  
¡ Print DatePrint Date  
¡ Print TimePrint Time  
¡ Print UserPrint User  

PDF WizardPDF Wizard
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l Edit WatermarkEdit WatermarkEdit WatermarkEdit Watermark  -- Show the watermark dialog where a watermark based on text or an image can be specified for each  Show the watermark dialog where a watermark based on text or an image can be specified for each 
page on the printed output. The watermark dialog presents many options to configure how the watermark is displayed, page on the printed output. The watermark dialog presents many options to configure how the watermark is displayed, 
includingincluding

¡ Text, Text direction, Font, Color and Size.Text, Text direction, Font, Color and Size.  
¡ Image file and alignment.Image file and alignment.  
¡ Translucency.Translucency.  
¡ Positioned in front or behind.Positioned in front or behind.  
¡ Page range to apply watermark to.Page range to apply watermark to.  

l Document PropertiesDocument PropertiesDocument PropertiesDocument Properties  -- Title, subject, author and keywords meta data that will be embedded in the PDF file. Title, subject, author and keywords meta data that will be embedded in the PDF file.  

l Protect file with a passwordProtect file with a passwordProtect file with a passwordProtect file with a password  -- When checked and the PDF is saved, a dialog will be displayed where the following  When checked and the PDF is saved, a dialog will be displayed where the following 
passwords can be setpasswords can be set

¡ Password to open the PDF documentPassword to open the PDF document  
¡ Password to edit the PDF documentPassword to edit the PDF document  
¡ Restrictions on printingRestrictions on printing  
¡ Restrictions on editingRestrictions on editing  
¡ Restrictions on copy portions of the fileRestrictions on copy portions of the file  

COPYING DOCUMENTS VIA THE WINDOWS CLIPBOARDCOPYING DOCUMENTS VIA THE WINDOWS CLIPBOARD  

If you want to transfer graphs and tables quickly to other documents, for example to further analyze the data, you can use the If you want to transfer graphs and tables quickly to other documents, for example to further analyze the data, you can use the 
Windows clipboard. This way, you can copy a chart into a text document or copy the results of the Optimizer into a table. This Windows clipboard. This way, you can copy a chart into a text document or copy the results of the Optimizer into a table. This 
copying also works with other tables or with Equilla codes. Instead of using the key combinations, you can also use the buttons in copying also works with other tables or with Equilla codes. Instead of using the key combinations, you can also use the buttons in 
the the EditEdit group of the toolbar. group of the toolbar.

COPYING CHARTSCOPYING CHARTS  

1.1. In an active chart, press the key combination In an active chart, press the key combination Ctrl + CCtrl + CCtrl + CCtrl + C to copy the chart. to copy the chart.  
2.2. Switch to the target document, e.g. publishing software.Switch to the target document, e.g. publishing software.  
3.3. There, press the key combination There, press the key combination Ctrl + VCtrl + VCtrl + VCtrl + V to paste the chart. to paste the chart.  

The chart is inserted in bitmap format.The chart is inserted in bitmap format.    
  
If the target document is a table, for example in MS Excel, you can copy the price data as well as any indicators or strategies If the target document is a table, for example in MS Excel, you can copy the price data as well as any indicators or strategies 
included in the chart into the Excel table. To do so, select the price data in Tradesignal and then drag the data into the Excel table included in the chart into the Excel table. To do so, select the price data in Tradesignal and then drag the data into the Excel table 
with the mouse.with the mouse.

COPYING TABLES COPYING TABLES   

1.1. Select the rows in the source table that you want to copy (the source may be a Scanner, Watchlist, Portfolio or Optimizer). Select the rows in the source table that you want to copy (the source may be a Scanner, Watchlist, Portfolio or Optimizer). 
To select all rows, press To select all rows, press Ctrl + ACtrl + ACtrl + ACtrl + A..  

2.2. Press Press Ctrl + CCtrl + CCtrl + CCtrl + C to copy the rows. to copy the rows.  
3.3. Switch to the target document, for example a Microsoft Excel table.Switch to the target document, for example a Microsoft Excel table.  
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4.4. Press Press Ctrl + VCtrl + VCtrl + VCtrl + V to paste the table contents into the target document. to paste the table contents into the target document.  

COPYING TEXTCOPYING TEXT  

1.1. Select the lines that you wan to copy, either in an Equilla Editor, an HTML Editor or a News window. To select all lines, Select the lines that you wan to copy, either in an Equilla Editor, an HTML Editor or a News window. To select all lines, 
press press Ctrl + ACtrl + ACtrl + ACtrl + A..  

2.2. Press Press Ctrl + CCtrl + CCtrl + CCtrl + C to copy the lines. to copy the lines.  
3.3. Switch to the target document, for example a text editor, and press Switch to the target document, for example a text editor, and press Ctrl + VCtrl + VCtrl + VCtrl + V to paste the contents. to paste the contents.  
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WEB BROWSER 
The scope of the stock market is not limited to one's own office. The scope of the stock market is not limited to one's own office. 
Information from all over the world has to be gathered and exchanged with Information from all over the world has to be gathered and exchanged with 
other users or colleagues. To do so, Tradesignal offers you an integrated other users or colleagues. To do so, Tradesignal offers you an integrated 
web browser. This way, you have access to the web contents of web browser. This way, you have access to the web contents of 
tradesignalonline.com and every other web page in the Internet. Use the tradesignalonline.com and every other web page in the Internet. Use the 
web browser forweb browser for

l surfing the Internetsurfing the Internet  
l communicating in Internet forumscommunicating in Internet forums  
l contacting the support staffcontacting the support staff  
l displaying webdisplaying web--based help contentsbased help contents  

Tradesignal also offers an Tradesignal also offers an HTML EditorHTML Editor as a language interface to  as a language interface to 
JavaScript. With it, many functions of the Tradesignal software can be controlled. You can program your own tools to make JavaScript. With it, many functions of the Tradesignal software can be controlled. You can program your own tools to make 
working with Tradesignal easier and faster. working with Tradesignal easier and faster.   
  
For information about distributing content on the Internet, for example in forums, please refer to the chapter For information about distributing content on the Internet, for example in forums, please refer to the chapter PublishingPublishing. . 

USING THE WEB BROWSERUSING THE WEB BROWSER  

In the In the InsertInsert tab in the toolbar, click on the button  tab in the toolbar, click on the button Web BrowserWeb BrowserWeb BrowserWeb Browser. An empty web browser opens.. An empty web browser opens.  
  
You can also open a web browser by entering a URL in the command line and selecting You can also open a web browser by entering a URL in the command line and selecting New BrowserNew BrowserNew BrowserNew Browser from the menu.  from the menu.   
  
To replace an existing website, enter the URL in the command line and select To replace an existing website, enter the URL in the command line and select Replace Web PageReplace Web PageReplace Web PageReplace Web Page from the menu. from the menu.  
  
To navigate back and forth between sites, click on the small green arrows to the right of the entry field in the command line.To navigate back and forth between sites, click on the small green arrows to the right of the entry field in the command line.  
  
To close a browser window, either press To close a browser window, either press Ctrl + F4Ctrl + F4Ctrl + F4Ctrl + F4 or open the context menu of the tab and select the entry  or open the context menu of the tab and select the entry Close [window Close [window Close [window Close [window 
name...]name...]name...]name...]..    

Web browserWeb browser
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HTML EDITOR 
Tradesignal possesses a builtTradesignal possesses a built--in HTML editor. With it, you can do the following:in HTML editor. With it, you can do the following:

l Use HTML code to design a GUI or control elements like buttons, lists or entry fieldsUse HTML code to design a GUI or control elements like buttons, lists or entry fields  
l Use active elements written in JavaScript (JS), for example to list all active workspaces. This way you can write control Use active elements written in JavaScript (JS), for example to list all active workspaces. This way you can write control 

elements that use program functions of Tradesignal.elements that use program functions of Tradesignal.  

USE THE HTML EDITOR USE THE HTML EDITOR   

Click on the Click on the InsertInsertInsertInsert tab on the toolbar then choose the entry  tab on the toolbar then choose the entry HTML PageHTML PageHTML PageHTML Page. .   
  
An editor window opens. In the toolbar, the An editor window opens. In the toolbar, the EditorEditor tab appears with the  tab appears with the 
following buttons: following buttons:   
  
Show BrowserShow BrowserShow BrowserShow Browser  -- Interprets the HTML or JavaScript Code and displays the  Interprets the HTML or JavaScript Code and displays the 
result in a browser. result in a browser.   
  
Show EditorShow EditorShow EditorShow Editor  -- Switch from the browser back to the editor.  Switch from the browser back to the editor.   
  
UndoUndoUndoUndo  -- Undo the last action (multiple undoes possible). Undo the last action (multiple undoes possible).  
  
RedoRedoRedoRedo  -- Repeat the last action (multiple repeats possible). Repeat the last action (multiple repeats possible).  
  
Select AllSelect AllSelect AllSelect All (Ctrl+A)  (Ctrl+A) -- Selects all code. You can use the standard Windows key commands to copy the code with "Ctrl+C" and then  Selects all code. You can use the standard Windows key commands to copy the code with "Ctrl+C" and then 
paste with "Ctrl+V", e.g. into a text editor. paste with "Ctrl+V", e.g. into a text editor.   
  
To display HTML or JS code, simply enter it in the HTML editor and click on To display HTML or JS code, simply enter it in the HTML editor and click on Show BrowserShow BrowserShow BrowserShow Browser. . 

SEARCH AND REPLACESEARCH AND REPLACE  

For editing the code, the For editing the code, the FindFind group in the toolbar is available. group in the toolbar is available.

l Click on Click on FindFindFindFind to enter a search term in a search pane. to enter a search term in a search pane.  
l Click on Click on Comment/Uncomment SelectionComment/Uncomment SelectionComment/Uncomment SelectionComment/Uncomment Selection to comment/uncomment selected lines using HTML comments. to comment/uncomment selected lines using HTML comments.  
l With With ReplaceReplaceReplaceReplace you can replace one or all appearances of a code text with another text. you can replace one or all appearances of a code text with another text.  
l For very long scripts, you can use For very long scripts, you can use Goto LineGoto LineGoto LineGoto Line to jump to a code line. to jump to a code line.  

JAVASCRIPT IN THE HTML EDITORJAVASCRIPT IN THE HTML EDITOR  

JavaScript offers you a connection to the inner workings of Tradesignal. With JS and a number of interface commands it is possible JavaScript offers you a connection to the inner workings of Tradesignal. With JS and a number of interface commands it is possible 
to control various functions of Tradesignal. Here a list of possible script commands: to control various functions of Tradesignal. Here a list of possible script commands:   
  

HTML EditorHTML Editor
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// Global variable to access the TSEPublic object, e.g.: 

// 

// var selectedWorkspace = TradeSignal.GetSelectedWorkspace(); 

// 

TradeSignal 

// The Tradesignal script root element, reachable with JavaScript by either using window.external or the TradeSignal global variable

class TSEPublic 

// Returns a collection of all saved workspaces  

GetSavedWorkspaces() : TSEWorkspaceCollection 

  

// Returns a collection of all open workspaces 

GetOpenWorkspaces() : TSEWorkspaceCollection  

// Returns the currently selected workspaces 

GetSelectedWorkspace() : TSEWorkspace   

// Returns the last selected workspace, selected before the 

// current workspace was selected, this is useful for operating 

// on a target workspace from within an HTML page in another 

// desktop 

GetLastSelectedWorkspace() : TSEWorkspace  

// Returns the total RAM managed and used by Tradesignal 

GetTotalMemory() : int    

// Returns the current timezone set by the user in 

// Olsen format (e.g. Europe/Berlin) 

GetUserTimeZone() : string  

// Returns the current version number of Tradesignal (x.y.z) 

GetVersion() : string   

 

// Like the Bang! Command !new 

Create( whatToCreate : string, parameters : string ) : TSEDocument   

// Opens a new chart and returns it with an instrument 

CreateNewChart( symbol : string ) : TSEDocument   

// Opens a new chart with an instrument optionally allowing 

// the chart type and scale alignment to be set. 

// Use a parameter string of the form: 

// 

//   "charttype=line(open); scale=left; subchart=false" 

// 

// valid values for scale are left|right|both 

// valid values for charttype are: 

//    line(field), bar, candlestick, candlevolume, 

//    equivolume, symbol(field), stepped(field), 

//    area(field1, field2), forest(field), linkedforest(field), 

//    renko(field), pointfigure, heikinashi, kagi, tlb 

// valid values for subchart are true|false 
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// valid values for field are open|close|high|low|volume|openinterest 

CreateNewChartEx(symbol : string, parameters : string) : TSEDocument 

// Opens a new Market Profile and returns it with an instrument 

CreateNewMarketProfile( symbol : string ) : TSEDocument   

// Opens a new chart and returns it with an indicator 

CreateNewInstantIndicator( equillaCode : string ) : TSEDocument     

// Opens a new chart and returns it with an indicator series    

CreateNewInstantIndicatorSeries( equillaCode : string ) : TSEDocument   

// Opens and returns a new webbrowser containing the given url 

CreateNewBrowser( url : string ) : TSEDocument    

// Opens and returns a new scanner with an instrument 

CreateNewMarketScanner( symbol : string ) : TSEDocument   

// Opens and returns a new workspace 

CreateNewWorkspace() : TSEWorkspace   

// Passes the entered key string as the value of an additional 

// parameter called sessionkey that will be appended to all 

// TXML data requests to a server identified by the URL  

// parameter  

SetMixinDataSessionKey(url : string, key : string)  

// Shows the Tradesignal Help 

ShowHelp()   

// Shows the Equilla Help  

ShowEquillaHelp()   

// A collection of workspaces. The collection is zero (0) based     

class TSEWorkspaceCollection  

// Returns the workspace of a certain position in the collection 

ItemAt( index : int ) : TSEWorkspace   

 

// Returns the number of workspaces in the collection 

GetLength() : int   

 

// Returns the workspace with a certain name 

Find( workspaceName : string ) : TSEWorkspace   

// An element representing a certain workspace in Tradesignal  

class TSEWorkspace 

// Returns the workspace title 

GetTitle() : string    

// Returns true in case the workspace is open, otherwise false 

IsOpen() : bool   

// Returns true in case the workspace is included in the currently open file list, otherwise false

IsRecent() : bool   

// Returns true if the workspace was open at the last shutdown of Tradesignal, otherwise false 

WasPreviouslyOpen() : bool   

// Opens the workspace or activates it, if it is already open 

Open() : bool   
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// Closes the workspace; optionally other saving dialogs can be suppressed 

Close( suppressDialogs : bool ) : bool   

 

// Like the Bang Command !new except that it selects the workspace first 

Create( whatToCreate : string, parameters : string ) : bool   

// Selects the workspace if it is open 

Select() : bool   

// Returns a collection of all documents in the workspace 

GetDocuments() : TSEDocumentCollection   

// Returns the currently selected document in the workspace 

GetSelectedDocument() : TSEDocument   

// A collection of workspace elements (documents), the collection is zero (0)  

// based  

class TSEDocumentCollection 

// Returns the document of a certain position in the collection 

ItemAt( index : int ) : TSEDocument   

// Returns the number of documents in the collection 

GetLength() : int   

// Returns the document with a certain name 

Find( wokspaceName : string ) : TSEDocument   

// An object which represents an element in the workspace, this could be  

// a Chart, Browser, Scanner, etc.  

class TSEDocument 

// Returns the document name 

GetDocumentTitle() : string   

// Returns the name of the selected element in the document 

GetSelectedItemTitle() : string   

 

// Returns the document type: Chart, Browser, TextEditor,  PriceEditor, 

//MarketProfile, MarketScanner, WorkspaceInterfaceScript, Statistics, Trades or Optimiser 

GetDocumentType() : string   

// Selects the document 

Select() : bool   

// Selects the document and executes !replace  

Replace( itemToReplaceSelectedItem : string ) : bool   

// Selects the document and executes !replaceall  

ReplaceAll( itemToReplaceAllCurrentItems : string ) : bool   

// Selects the document and executes !add  

Add( itemToAdd : string ) : bool   

// Selects the document and adds an item optionally allowing 

// the chart type, scale alignment and subchart to be set. 

// Use a parameter string of 

// the form: 

// 

//   "charttype=line(open); scale=left; subchart=false" 
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// 

// valid values for scale are left|right|both 

// valid values for charttype are: 

//    line(field), bar, candlestick, candlevolume, 

//    equivolume, symbol(field), stepped(field), 

//    area(field1, field2), forest(field), linkedforest(field), 

//    renko(field), pointfigure, heikinashi, kagi, tlb 

// valid values for subchart are true|false 

// valid values for field are open|close|high|low|volume|openinterest 

AddEx( itemToAdd : string, parameters : string) : bool 

// Selects the document and executes a setp property action, 

// valid property names and values are: 

// 

//   "period" ­ period in seconds (0 for tick, 86400 for daily) 

//   "dateaxismode" ­ normal|seasonal 

//   "historylength" ­ number of bars of data to load 

Set( propertyName : string, value : string ) : bool   

// Selects the document and executes sets the value for all 

// instruments in all subcharts, see Set() for available 

// properties 

SetAll (propertyName : string, value : string) : bool  

// Evaluates the Equilla Code and adds it to the document 

Eval( equillaScript : string ) : bool   

// Evaluates the Equilla Code Series and adds it to the document 

EvalSeries( equillaScript : string ) : bool   

// Selects the document and executes !close document  

Close() : bool   

EXAMPLE: LISTING ALL AVAILABLE WORKSPACES WITH JAVASCRIPTEXAMPLE: LISTING ALL AVAILABLE WORKSPACES WITH JAVASCRIPT  

In this tutorial we will design a simple JavaScript that will display a list of all available workspaces. In this tutorial we will design a simple JavaScript that will display a list of all available workspaces. 

STEP 1: START A HTML PAGE AND ENTER THE PAGE FRAMESTEP 1: START A HTML PAGE AND ENTER THE PAGE FRAME  

Open a new, empty workspace. Then open the button menu Open a new, empty workspace. Then open the button menu LayoutLayoutLayoutLayout and select the entry  and select the entry Insert HTML ElementInsert HTML ElementInsert HTML ElementInsert HTML Element. An empty HTML . An empty HTML 
editor opens. For a correct page frame, please enter the following source code:editor opens. For a correct page frame, please enter the following source code:  
  

<html> 

<head> 

<title>List Workspaces</title> 

</head> 

<body> 

</body> 
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</html> 

STEP 2: ADDING THE LIST ELEMENT AND THE SCRIPTING AREASTEP 2: ADDING THE LIST ELEMENT AND THE SCRIPTING AREA  

Now copy the following line between the Now copy the following line between the BodyBodyBodyBody Tags: Tags:  
  

<select name="Workspaces" style="position:absolute; left:10px; top:20px; width:150px" > 

</select> 

  
  
The line includes the HTML code for the list with position and width values. When you now click on The line includes the HTML code for the list with position and width values. When you now click on Show BrowserShow BrowserShow BrowserShow Browser in the toolbar,  in the toolbar, 
you can see the new page with an empty list. Click on you can see the new page with an empty list. Click on Show EditorShow EditorShow EditorShow Editor to edit the code again. to edit the code again.  
  
Now we can define the area for the JavaScript source code. Copy the following code into the line below the list. The code assigns Now we can define the area for the JavaScript source code. Copy the following code into the line below the list. The code assigns 
the collection of all saved workspaces to a variable. the collection of all saved workspaces to a variable.   
  

<script language="JavaScript" type="text/javascript"> 

//Array with workspaces and number of elements 

var savedCollection = TradeSignal.GetSavedWorkspaces(); 

var maxIter = savedCollection.GetLength(); 

</script> 

STEP 3: DESIGNING AND TESTING THE JAVASCRIPTSTEP 3: DESIGNING AND TESTING THE JAVASCRIPT  

In the upper part we have set up a HTML page and the basis for a In the upper part we have set up a HTML page and the basis for a 
JavaScript. The list of workspaces was copied into a variable. To be able JavaScript. The list of workspaces was copied into a variable. To be able 
to read out the list later, we need the number of included elements. This to read out the list later, we need the number of included elements. This 
value is also saved as a variable. value is also saved as a variable.   
  
In the following script, a reference to the list is set, so that we can add a In the following script, a reference to the list is set, so that we can add a 
list entry for every workspace in the collection. To read out the collection, list entry for every workspace in the collection. To read out the collection, 
we need a loop that runs over all workspaces. Add the following lines in we need a loop that runs over all workspaces. Add the following lines in 
the script area:the script area:  
  

//Reference to the list 

var listRef = document.getElementById("Workspaces"); 

//loop 

for( iter = 0; iter < maxIter; iter++ ) 

{ 

//Read the workspace names 

var wsName = savedCollection.ItemAt(iter).GetTitle(); 

Final script in the editorFinal script in the editor
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//Generate a list entry 

var listEntry = new Option(wsName, iter ); 

//Add the list entry to the list  

listRef.options[listRef.options.length] = listEntry; 

} 

THE COMPLETE SCRIPTTHE COMPLETE SCRIPT  

Here you can see the complete code of the script.Here you can see the complete code of the script.  
  

<html> 

<head> 

<title>List Workspaces</title> 

</head> 

<body> 

<select name="Workspaces" style="position:absolute; left:10px; top:20px; width:150px" > 

<script language="JavaScript" type="text/javascript"> 

//Array with workspaces and number of elements 

var savedCollection = TradeSignal.GetSavedWorkspaces(); 

var maxIter = savedCollection.GetLength(); 

//Reference to the list 

var listRef = document.getElementById("Workspaces"); 

//loop 

for( iter = 0; iter < maxIter; iter++ ) 

{ 

//Read the workspace names 

var wsName = savedCollection.ItemAt(iter).GetTitle(); 

//Generate a list entry 

var listEntry = new Option(wsName, iter ); 

//Add list entry to list  

listRef.options[listRef.options.length] = listEntry; 

} 

</script> 

</select> 

</body> 

</html> 

  
  
To view the result, click on To view the result, click on Show BrowserShow BrowserShow BrowserShow Browser again. A list of all workspaces appears. again. A list of all workspaces appears.    
  
Note that you cannot save the HTML script itself, only the workspace in which it was created.Note that you cannot save the HTML script itself, only the workspace in which it was created.    
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NEWS 
News is an important tool for the fundamental chartist to have at their News is an important tool for the fundamental chartist to have at their 
disposal and can be accessed from Tradesignal Standard Edition either disposal and can be accessed from Tradesignal Standard Edition either 
from a traditional news reader or as a study within a chart. Tradesignal from a traditional news reader or as a study within a chart. Tradesignal 
allows you to view both realtime news from your data feed and also to allows you to view both realtime news from your data feed and also to 
subscribe to RSS sources available via the Internet or a local intranet.subscribe to RSS sources available via the Internet or a local intranet.  
  
The Tradesignal news reader uses a split display to show recent headlines The Tradesignal news reader uses a split display to show recent headlines 
in the top pane, and the selected story in the bottom pane. The window in the top pane, and the selected story in the bottom pane. The window 
sizes can easily be adjusted by dragging the separator between the two sizes can easily be adjusted by dragging the separator between the two 
panes.panes.  
  
Use the news tools to:Use the news tools to:

l View realtime news as it happensView realtime news as it happens  
l View current news for a specific securityView current news for a specific security  
l View historic news in your chartsView historic news in your charts  
l Connect to RSS feeds to view any eventConnect to RSS feeds to view any event--based informationbased information  

NEWS SETUP NEWS SETUP   

You can view news stories in one of the following ways:You can view news stories in one of the following ways:

1.1. To view all recent news headlines, click on the To view all recent news headlines, click on the NewsNewsNewsNews button in the  button in the InsertInsert tab of the toolbar. tab of the toolbar.  
2.2. To view all headlines for a specific security, rightTo view all headlines for a specific security, right--click on a security in a click on a security in a chartchart, , watchlistwatchlist, , portfolioportfolio, , scannerscanner or  or symbol listsymbol list to  to 

show the context menu, then select the option show the context menu, then select the option OpenOpenOpenOpen, entry , entry NewsNewsNewsNews..  
3.3. To view news stories in a chart, drag & drop the To view news stories in a chart, drag & drop the NewsNewsNewsNews indicator from the toolbox onto a security in your chart. indicator from the toolbox onto a security in your chart.  

LINKING THE NEWS READER TO A WATCHLIST OR CHART LINKING THE NEWS READER TO A WATCHLIST OR CHART   

If you want to link a news reader so that it displays relevant news depending on what is currently selected in a watchlist or chart, If you want to link a news reader so that it displays relevant news depending on what is currently selected in a watchlist or chart, 
do the following:do the following:

1.1. RightRight--click on the tab above the chart or watchlist and pick a color under the click on the tab above the chart or watchlist and pick a color under the Symbol LinkSymbol Link menu. menu.  
2.2. Click on Click on NewsNewsNewsNews in the  in the InsertInsert tab of the toolbar to display a news reader. tab of the toolbar to display a news reader.  
3.3. RightRight--click on the tab above the news reader and pick the same color link you chose in the chart or watchlist.click on the tab above the news reader and pick the same color link you chose in the chart or watchlist.  

The headline list will now only show stories related to the selected item in the watchlist or chart. To change the displayed The headline list will now only show stories related to the selected item in the watchlist or chart. To change the displayed 
headline, just select a new item in your watchlist, or replace the item in your chart.headline, just select a new item in your watchlist, or replace the item in your chart.

WORKING WITH NEWS IN A CHART WORKING WITH NEWS IN A CHART   

The news readerThe news reader
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By applying the news indicator to a security in a chart as described above, you will get a historic overview of headlines related to By applying the news indicator to a security in a chart as described above, you will get a historic overview of headlines related to 
that security displayed as hyperlinks above the bar on which the news was published. Just click on one of the hyperlinks to open a that security displayed as hyperlinks above the bar on which the news was published. Just click on one of the hyperlinks to open a 
news reader in which you will see the full news story.news reader in which you will see the full news story.  
  
The news indicator is written in Equilla using the news API. Programmers can make use of this API to create their own indicators The news indicator is written in Equilla using the news API. Programmers can make use of this API to create their own indicators 
or indeed trading strategies based around realtime news. Please refer to the Equilla help system within Tradesignal for more or indeed trading strategies based around realtime news. Please refer to the Equilla help system within Tradesignal for more 
information on this API.information on this API.

FORMATTING OPTIONS FORMATTING OPTIONS   

The following settings can be used to customize the news window to your preference:The following settings can be used to customize the news window to your preference:  
  
Back colorBack colorBack colorBack color  -- Change the background color for news headlines and stories. Change the background color for news headlines and stories.  
  
Text colorText colorText colorText color  -- Change the text color. Change the text color.  
  
Font sizeFont sizeFont sizeFont size  -- Change the size of the text in headlines and stories. Change the size of the text in headlines and stories.  
  
Show timeShow timeShow timeShow time  -- Displays the time of the news story in the headline list. Displays the time of the news story in the headline list.  
  
Show sourceShow sourceShow sourceShow source  -- Displays the source (feed) of the news story in the headline list. Displays the source (feed) of the news story in the headline list.  
  
Browser alignmentBrowser alignmentBrowser alignmentBrowser alignment  -- Display the headline list to the top, right, bottom or left of the news story pane.  Display the headline list to the top, right, bottom or left of the news story pane. 

FILTER OPTIONS FILTER OPTIONS   

ShowShowShowShow  --  AllAll available news headlines; Headlines for a selected  available news headlines; Headlines for a selected symbolsymbol; ; StoriesStories for a given symbol on a specific day. for a given symbol on a specific day.  
  
SymbolSymbolSymbolSymbol  -- Displays the currently selected security for which headlines are shown. Displays the currently selected security for which headlines are shown.  
  
DaysDaysDaysDays  -- How many days of headlines should be displayed. How many days of headlines should be displayed.  
  
KeywordsKeywordsKeywordsKeywords  -- Show only headlines containing the entered keywords.  Show only headlines containing the entered keywords. RSS FeedsRSS FeedsRSS FeedsRSS Feeds  -- Displays how frequently (in seconds) the  Displays how frequently (in seconds) the 
headlines from RSS feeds should be updated.headlines from RSS feeds should be updated.  
  
Note: Note: Note: Note: You can save these settings as default by clicking on the small disk icon above the settings in the property inspector. You can save these settings as default by clicking on the small disk icon above the settings in the property inspector. 
Alternatively, you can create a news reader Alternatively, you can create a news reader stylestyle by selecting  by selecting Home > Style > Styles > Create StyleHome > Style > Styles > Create Style from the  from the FormatFormat group on the  group on the 
toolbar.toolbar.    
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EQUILLA BASICS 
With the programming language Equilla, Tradesignal offers you an easy to learn but powerful programming language. With its With the programming language Equilla, Tradesignal offers you an easy to learn but powerful programming language. With its 
help, you can easily perform even complex tasks. help, you can easily perform even complex tasks.   
  
Equilla resembles programming languages like Pascal or Visual Basic.Equilla resembles programming languages like Pascal or Visual Basic. All functions, indicators and strategies in Tradesignal are  All functions, indicators and strategies in Tradesignal are 
written in Equilla. (For the relationship between these three, see the chapter written in Equilla. (For the relationship between these three, see the chapter Introduction to Functions, Indicators and StrategiesIntroduction to Functions, Indicators and Strategies). ).   
  
The special benefits of Equilla are the extensions for the trading business. They allow you to translate your ideas about finance and The special benefits of Equilla are the extensions for the trading business. They allow you to translate your ideas about finance and 
analyses into executable routines. This way, you can write your own strategies, indicators or other applications for the various analyses into executable routines. This way, you can write your own strategies, indicators or other applications for the various 
software components of Tradesignal. Equilla helps you to solve your individual problems, to test new trading ideas and to work software components of Tradesignal. Equilla helps you to solve your individual problems, to test new trading ideas and to work 
outside the box of externally defined, inflexible procedures. outside the box of externally defined, inflexible procedures.   
  
To quickly get accustomed to Equilla, we recommend familiarity with a programming language. However, you can also learn to tap To quickly get accustomed to Equilla, we recommend familiarity with a programming language. However, you can also learn to tap 
the potential of Equilla by analyzing and editing available Equilla code (e.g. customizing an indicator).the potential of Equilla by analyzing and editing available Equilla code (e.g. customizing an indicator).  
  
Equilla scripts are edited in the Equilla scripts are edited in the Equilla EditorEquilla Editor, which supports you with color, which supports you with color--coding of the Equilla source code. In the editor, you coding of the Equilla source code. In the editor, you 
can also retrieve detailed information for Equilla functions via the context menu. can also retrieve detailed information for Equilla functions via the context menu.   
  
The Equilla chapters in this help are intended to be more of an introduction to the various topics. For an extensive documentation of The Equilla chapters in this help are intended to be more of an introduction to the various topics. For an extensive documentation of 
all features, please refer to all features, please refer to Tradesignal helpTradesignal help under the menu entry  under the menu entry Equilla Formula LanguageEquilla Formula LanguageEquilla Formula LanguageEquilla Formula Language. . 

SEQUENCE OF EVENTS WHEN COMPILING EQUILLA CODESEQUENCE OF EVENTS WHEN COMPILING EQUILLA CODE  

When compiling Equilla code into an executable Equilla program, it is important to remember that all Equilla scripts are saved in When compiling Equilla code into an executable Equilla program, it is important to remember that all Equilla scripts are saved in 
packagespackages. The compilation sequence partly depends on the sequence of these packages, which you can change in the . The compilation sequence partly depends on the sequence of these packages, which you can change in the Package Package 
Management in the Tradesignal OptionsManagement in the Tradesignal Options..

CALLING UP FUNCTIONS FROM INDICATORS/STRATEGIESCALLING UP FUNCTIONS FROM INDICATORS/STRATEGIES  

For indicators and strategies, functions are called up by their name (without information about their package). Tradesignal searches For indicators and strategies, functions are called up by their name (without information about their package). Tradesignal searches 
for the function in the following sequence:for the function in the following sequence:

1.1. in the same package as the indicator/strategyin the same package as the indicator/strategy  
2.2. in all packages, in the sequence given in the in all packages, in the sequence given in the Package Management in the Tradesignal OptionsPackage Management in the Tradesignal Options  

As soon as a function with the correct name is found, the search ends and this function is used. As soon as a function with the correct name is found, the search ends and this function is used.   
  
Therefore, if you move indicators/strategies to another package, it may give different results if another function is used due to the Therefore, if you move indicators/strategies to another package, it may give different results if another function is used due to the 
changed package sequence.changed package sequence.  
  
Exporting packages can also lead to problems, if packages exchanged with other users use functions from another package. If the Exporting packages can also lead to problems, if packages exchanged with other users use functions from another package. If the 
user has no function with the same name, the script will not compile; if the user has another or older version, the results for the user has no function with the same name, the script will not compile; if the user has another or older version, the results for the 
users may differ.users may differ.
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CALLING UP INDICATORS/STRATEGIES FROM SAVED DOCUMENTSCALLING UP INDICATORS/STRATEGIES FROM SAVED DOCUMENTS  

When saving a chart, scanner, watchlist or portfolio, not only all settings but also all applied indicators and strategies (including When saving a chart, scanner, watchlist or portfolio, not only all settings but also all applied indicators and strategies (including 
their respective package names) are saved. their respective package names) are saved.   
  
When the documents are opened again, Tradesignal checks whether a newer version of the indicator/strategy is available, and will When the documents are opened again, Tradesignal checks whether a newer version of the indicator/strategy is available, and will 
use that one if possible. Tradesignal searches in the following sequence:use that one if possible. Tradesignal searches in the following sequence:

1.1. in the packages as given in the saved documentin the packages as given in the saved document  
2.2. in all packages, in the sequence given in the in all packages, in the sequence given in the Package Management in the Tradesignal OptionsPackage Management in the Tradesignal Options  

If no newer version is to be found, the indicator/strategy as saved in the document is used.If no newer version is to be found, the indicator/strategy as saved in the document is used.    
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EQUILLA EDITOR 
For writing and editing scripts written in the Equilla language (which is inFor writing and editing scripts written in the Equilla language (which is in--built in Tradesignal), an Equilla editor is available. It built in Tradesignal), an Equilla editor is available. It 
supports programming by highlighting code areas and comments in different colors. supports programming by highlighting code areas and comments in different colors. 

OPENING THE EQUILLA EDITOROPENING THE EQUILLA EDITOR  

You can open the Equilla editor in two ways:You can open the Equilla editor in two ways:

l The editor opens when you edit a function, indicator or strategy. To The editor opens when you edit a function, indicator or strategy. To 
do so, open the respective list (functions, indicators or strategies) in do so, open the respective list (functions, indicators or strategies) in 
the toolbox. Then call up an entry for editing by either doublethe toolbox. Then call up an entry for editing by either double--
clicking on it or by selecting clicking on it or by selecting EditEditEditEdit from the context menu. The Equilla  from the context menu. The Equilla 
editor opens with the source code of the script.editor opens with the source code of the script.  

l To open an empty editor, you have to start a new script. To do so, To open an empty editor, you have to start a new script. To do so, 
select select New FunctionNew FunctionNew FunctionNew Function (or  (or New IndicatorNew IndicatorNew IndicatorNew Indicator or  or New StrategyNew StrategyNew StrategyNew Strategy) in the ) in the 
Related TaskRelated Task area in the toolbox. The area in the toolbox. The Create Item Wizard opens.  Create Item Wizard opens. 
Select the option Select the option Use the Equilla Formula Language to write Use the Equilla Formula Language to write Use the Equilla Formula Language to write Use the Equilla Formula Language to write 
the [...]the [...]the [...]the [...]. Enter a name and select a location for saving. Finish with . Enter a name and select a location for saving. Finish with DoneDoneDoneDone. An empty editor opens.. An empty editor opens.  

COLOR CODING IN THE EDITORCOLOR CODING IN THE EDITOR  

The source code is colorThe source code is color--coded. The following colors are possible:coded. The following colors are possible:  
  
BlueBlueBlueBlue: Signal words in the code (begin, end), declaration areas (meta, variables...), input types, commands (if then...), formatting : Signal words in the code (begin, end), declaration areas (meta, variables...), input types, commands (if then...), formatting 
(StyleSolid...), drawing commands (DrawText...).(StyleSolid...), drawing commands (DrawText...).  
  
RedRedRedRed: Content of synopsis, numeric values (e.g. close or true numbers like 1, 10, 30), true/false.: Content of synopsis, numeric values (e.g. close or true numbers like 1, 10, 30), true/false.  
  
For blue and bold red Equilla expressions, you can find additional information in Tradesignal. To display it, rightFor blue and bold red Equilla expressions, you can find additional information in Tradesignal. To display it, right--click on the click on the 
operator in question in the operator in question in the Equilla EditorEquilla Editor, e.g. , e.g. BeginBegin, and choose , and choose Lookup Equilla FunctionLookup Equilla FunctionLookup Equilla FunctionLookup Equilla Function from the context menu. A browser  from the context menu. A browser 
window opens with information on the operators and links to related functions.window opens with information on the operators and links to related functions.  
  
LilacLilacLilacLilac: Names of other functions.: Names of other functions.  
  
You can open these functions in the You can open these functions in the Equilla EditorEquilla Editor. To do so, right. To do so, right--click on the function and and choose click on the function and and choose OpenOpenOpenOpen from the context  from the context 
menu. The source code is opened in the menu. The source code is opened in the Equilla EditorEquilla Editor..  
  
GreenGreenGreenGreen: Comments: Comments  
  
BlackBlackBlackBlack: Anything else, like text, declared variables etc.: Anything else, like text, declared variables etc.

Equilla EditorEquilla Editor
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EDITING THE EQUILLA CODEEDITING THE EQUILLA CODE  

When the Equilla editor is open, the When the Equilla editor is open, the EditorEditor tab appears in the toolbar, with  tab appears in the toolbar, with 
the following buttons: the following buttons:   
  
Compile ScriptCompile ScriptCompile ScriptCompile Script (F7)  (F7) -- Use this to compile the script. Only compiled scripts  Use this to compile the script. Only compiled scripts 
can be used. Uncan be used. Un--compiled scripts are grayed out in the toolbox. In case of compiled scripts are grayed out in the toolbox. In case of 
script errors, error descriptions will be given in the lower area of the script errors, error descriptions will be given in the lower area of the 
workspace. For delivered scripts, compiling may lead to error messages if workspace. For delivered scripts, compiling may lead to error messages if 
the scripts are protected against overwriting.the scripts are protected against overwriting.  
  
UndoUndoUndoUndo (Ctrl+Z)  (Ctrl+Z) -- Undo the last action (multiple undoes possible, but none  Undo the last action (multiple undoes possible, but none 
after compiling). This way, you can undo an unintended deletion, for after compiling). This way, you can undo an unintended deletion, for 
example.example.  
  
RedoRedoRedoRedo (Ctrl+Shift+Z)  (Ctrl+Shift+Z) -- Repeat the last action (multiple repeats possible, but none after compiling). This way, you can insert a copied  Repeat the last action (multiple repeats possible, but none after compiling). This way, you can insert a copied 
text multiple times, for example.text multiple times, for example.  
  
Select AllSelect AllSelect AllSelect All (Ctrl+A)  (Ctrl+A) -- Selects all code. You can use the standard Windows key commands to copy the code with "Ctrl+C" and then  Selects all code. You can use the standard Windows key commands to copy the code with "Ctrl+C" and then 
paste with "Ctrl+V", e.g. into a text editor. paste with "Ctrl+V", e.g. into a text editor. 

SEARCH AND REPLACESEARCH AND REPLACE  

To edit the code, the To edit the code, the FindFind group in the toolbar is available. group in the toolbar is available.

l Click on Click on FindFindFindFind to enter a search term in the search pane. to enter a search term in the search pane.  
l Click on Click on Comment/Uncomment SelectionComment/Uncomment SelectionComment/Uncomment SelectionComment/Uncomment Selection to comment/uncomment selected lines of code using Equilla comments. to comment/uncomment selected lines of code using Equilla comments.  
l With With ReplaceReplaceReplaceReplace you can replace one or all appearances of a code text with another text. you can replace one or all appearances of a code text with another text.  
l For long scripts, you can use For long scripts, you can use Goto LineGoto LineGoto LineGoto Line to jump to a code line. to jump to a code line.  

APPLYING YOUR EQUILLA SCRIPTAPPLYING YOUR EQUILLA SCRIPT  

Scripts can only be applied once they have been compiled. After that, the new script can be used like any delivered function, Scripts can only be applied once they have been compiled. After that, the new script can be used like any delivered function, 
indicator or strategy. You can find more information in the chapter indicator or strategy. You can find more information in the chapter Introduction to Functions, Indicators and StrategiesIntroduction to Functions, Indicators and Strategies..    

Equilla Editor group in the toolbarEquilla Editor group in the toolbar
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EQUILLA DEBUGGER 
The Equilla debugger can be used to find and resolve problems in your Equilla scripts. It allows you to stop execution of your The Equilla debugger can be used to find and resolve problems in your Equilla scripts. It allows you to stop execution of your 
scripts, step through your source code and examine the state of variables used in your code.scripts, step through your source code and examine the state of variables used in your code.

CREATING A DEBUGGER DOCUMENTCREATING A DEBUGGER DOCUMENT  

To create a new debugger document, select the Insert group on the Toolbar To create a new debugger document, select the Insert group on the Toolbar 
and click on the Debugger button.After clicking on the Debugger debugger, and click on the Debugger button.After clicking on the Debugger debugger, 
a dialog will be displayed asking you which document you would like to a dialog will be displayed asking you which document you would like to 
debug. The dialog shows a list of all open desktops, workspaces and debug. The dialog shows a list of all open desktops, workspaces and 
documents and presents the following options:documents and presents the following options:

l SkipSkipSkipSkip  ––  Do not attach to a document yet. This is typically used if the Do not attach to a document yet. This is typically used if the 
document you want to debug isndocument you want to debug isn’’t open yet. You may execute the t open yet. You may execute the 
debuggers Attach command from the ribbon as soon as the debuggers Attach command from the ribbon as soon as the 
document you want to debug is ready to be used.document you want to debug is ready to be used.  

l AttachAttachAttachAttach  ––  Attaches the new debugger to the selected document.Attaches the new debugger to the selected document.  

l CancelCancelCancelCancel  ––  Abort the operation and do no create a new debugger Abort the operation and do no create a new debugger 
document.document.  

Please be aware that a debugger can only debug one document at a time Please be aware that a debugger can only debug one document at a time 
and only one debugger can be attached to a specific document. You may and only one debugger can be attached to a specific document. You may 
create multiple debuggers simultaneously and attached each of them to a separate document.create multiple debuggers simultaneously and attached each of them to a separate document.  
  
In order to be able to debug an indicator or strategy it has to be compiled using Tradesignal 7.0 or higher. Equilla scripts that have In order to be able to debug an indicator or strategy it has to be compiled using Tradesignal 7.0 or higher. Equilla scripts that have 
been compiled with earlier versions of Tradesignal will not show up in the debugger document.been compiled with earlier versions of Tradesignal will not show up in the debugger document.  
  
Please note:Please note:Please note:Please note: Only chart documents can be debugged.  Only chart documents can be debugged. 

THE DEBUGGER DOCUMENTTHE DEBUGGER DOCUMENT  

The debugger document enables you to debug your Equilla scripts. It The debugger document enables you to debug your Equilla scripts. It 
consists of the following components:consists of the following components:

l ScriptsScriptsScriptsScripts  ––  The debugger loads all scripts that are referenced in the The debugger loads all scripts that are referenced in the 
debugged document.debugged document.  

l Watch windowsWatch windowsWatch windowsWatch windows  ––  A set of watch windows that help you inspect A set of watch windows that help you inspect 
the state of your indicator or strategy. There are three predefined the state of your indicator or strategy. There are three predefined 
windows, showing common information and one window where windows, showing common information and one window where 
you can enter debug expressions on your own.you can enter debug expressions on your own.  

l Call StackCall StackCall StackCall Stack  ––  Shows the nesting level of your scripts while Shows the nesting level of your scripts while 

Debugger Attach DialogDebugger Attach Dialog

The debuggerThe debugger
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debugging.debugging.  
l BreakpointsBreakpointsBreakpointsBreakpoints  ––  Shows a list of all breakpoints that have been set up.Shows a list of all breakpoints that have been set up.  
l ObjectsObjectsObjectsObjects  ––  Provides a list of all Equilla indicators and strategies that are contained in the debugged document. You may Provides a list of all Equilla indicators and strategies that are contained in the debugged document. You may 

enable or disable the debugging of specific objects as you need.enable or disable the debugging of specific objects as you need.  

SCRIPTSSCRIPTS  

Every script referenced in the debugged document will be loaded automatically. Here you can inspect the source code, add or Every script referenced in the debugged document will be loaded automatically. Here you can inspect the source code, add or 
manipulate breakpoints or examine the state of variables as you need.manipulate breakpoints or examine the state of variables as you need.  
  
The debugger editor has all the same functionality as the normal The debugger editor has all the same functionality as the normal Equilla EditorEquilla Editor..  
  
To add a breakpoint, click on the left margin of the editor, select the Toggle Breakpoint command from the ribbon or use the To add a breakpoint, click on the left margin of the editor, select the Toggle Breakpoint command from the ribbon or use the 
corresponding context menu entry.corresponding context menu entry.  
  
While the execution is paused, you can examine the state of variables or evaluate Equilla expression by hovering over the While the execution is paused, you can examine the state of variables or evaluate Equilla expression by hovering over the 
corresponding text with your mouse. To evaluate an Equilla expression containing space characters, you have to select the whole corresponding text with your mouse. To evaluate an Equilla expression containing space characters, you have to select the whole 
expression in the editor before hovering over it.expression in the editor before hovering over it.  
  
Note:Note:Note:Note: If a script has been changed since the indicator or strategy has been compiled, the scripts tab will show a corresponding  If a script has been changed since the indicator or strategy has been compiled, the scripts tab will show a corresponding 
image. Please be aware that breakpoints and variables may behave unexpected in such a case.image. Please be aware that breakpoints and variables may behave unexpected in such a case.  
  
If the evaluation is paused, the source code line that is about to be evaluated will be highlighted in the source code editor. If the evaluation is paused, the source code line that is about to be evaluated will be highlighted in the source code editor. 
Additionally the margin will show an arrow icon on the corresponding line.Additionally the margin will show an arrow icon on the corresponding line.

WATCH WINDOWSWATCH WINDOWS  

The Equilla debugger provides a quick way to check the state of the The Equilla debugger provides a quick way to check the state of the 
document as a whole or of specific elements in it.document as a whole or of specific elements in it.

l Virtual MachineVirtual MachineVirtual MachineVirtual Machine  ––  This is a predefined view and cannot be This is a predefined view and cannot be 
modified. It shows information of all elements within the virtual modified. It shows information of all elements within the virtual 
machine. This includes all the indicator and strategies that have machine. This includes all the indicator and strategies that have 
been created as well as the instruments that are used to evaluate your scripts.been created as well as the instruments that are used to evaluate your scripts.  

l ThisThisThisThis  ––  This is a predefined view and cannot be modified. It provides access to the state of the currently debugged indicator This is a predefined view and cannot be modified. It provides access to the state of the currently debugged indicator 
or strategy. This includes general properties as well as the referenced parents and generated output data. You may also get or strategy. This includes general properties as well as the referenced parents and generated output data. You may also get 
access to child objects that have been applied to this indicator or strategy.access to child objects that have been applied to this indicator or strategy.  

l LocalsLocalsLocalsLocals  --  This is a predefined view and cannot be modified. This view provides access to all variables that are used in the This is a predefined view and cannot be modified. This view provides access to all variables that are used in the 
currently debugged indicator, strategy or Equilla function. While stepping through your code, this view will be updated currently debugged indicator, strategy or Equilla function. While stepping through your code, this view will be updated 
automatically to show only the variables that are relevant for the script that is about to be evaluated.automatically to show only the variables that are relevant for the script that is about to be evaluated.  

l WatchWatchWatchWatch  --  Use this view to track specific variables or Equilla expressions. The list of expressions will not change Use this view to track specific variables or Equilla expressions. The list of expressions will not change 
automatically while stepping through your code. To add an expression, simply type it into the list or use drag and drop to automatically while stepping through your code. To add an expression, simply type it into the list or use drag and drop to 
copy an expression from the source code editor or another watch window. The copy an expression from the source code editor or another watch window. The Quick WatchQuick WatchQuick WatchQuick Watch is an alternative to this view  is an alternative to this view 

Locals watch windowLocals watch window
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when the information for the inspected object or variable does not fit into the available space.when the information for the inspected object or variable does not fit into the available space.  

CALL STACKCALL STACK  

The call stack shows the currently evaluated script and line number. The The call stack shows the currently evaluated script and line number. The 
currently evaluated script is displayed on the top and the indicator or currently evaluated script is displayed on the top and the indicator or 
strategy script is displayed at the bottom. strategy script is displayed at the bottom.   
  
For Equilla functions, the passed parameters will be displayed as well. For Equilla functions, the passed parameters will be displayed as well. 
Please be aware that the same limitations as for the evaluation of debug Please be aware that the same limitations as for the evaluation of debug 
expression apply. Therefore the list of parameters might not be complete.expression apply. Therefore the list of parameters might not be complete.  
  
To navigate through the call stack, simple double click on an entry in the list. To navigate through the call stack, simple double click on an entry in the list. 

BREAKPOINTSBREAKPOINTS  

This view shows a list of all the breakpoints that have been set up for a This view shows a list of all the breakpoints that have been set up for a 
debugger. The displayed information includes the script file and line debugger. The displayed information includes the script file and line 
number, the breakpoint belongs to, as well as information about the state, number, the breakpoint belongs to, as well as information about the state, 
conditions and the action that should be taken when the breakpoint is hit.conditions and the action that should be taken when the breakpoint is hit.  
  

To modify an existing breakpoint, either enable or disable it using the check box at the front of the entry or right click on an entry to To modify an existing breakpoint, either enable or disable it using the check box at the front of the entry or right click on an entry to 
show up a context menu.The context menu provides access to the following commands:show up a context menu.The context menu provides access to the following commands:

l Enable/Disable breakpointEnable/Disable breakpointEnable/Disable breakpointEnable/Disable breakpoint  --  Enable or disable the selected breakpointEnable or disable the selected breakpoint  

l Remove BreakpointRemove BreakpointRemove BreakpointRemove Breakpoint  --  Delete the selected breakpointDelete the selected breakpoint  
l GotoGotoGotoGoto  --  Go to the source code line the breakpoint is attached to.Go to the source code line the breakpoint is attached to.  
l PropertiesPropertiesPropertiesProperties  --  Modify the breakpoint condition and action.Modify the breakpoint condition and action.  

BREAKPOINT PROPERTIESBREAKPOINT PROPERTIES  

Call stackCall stack

BreakpointsBreakpoints

StateStateStateState

The breakpoint is valid and enabled.The breakpoint is valid and enabled.

The breakpoint is valid, but currently disabled.The breakpoint is valid, but currently disabled.

The breakpoint cannot be mapped to any executable code.The breakpoint cannot be mapped to any executable code.



:: www.tradesignal.comwww.tradesignal.com

Tradesignal GmbHTradesignal GmbH Page 297Page 297 Version 7.0Version 7.0

Every breakpoint supports a range of properties to control its behavior. To Every breakpoint supports a range of properties to control its behavior. To 
examine or modify these properties, right click on a breakpoint and select examine or modify these properties, right click on a breakpoint and select 
PropertiesPropertiesPropertiesProperties from the context menu. from the context menu.  
  
Breakpoints can be configured to only pause evaluation under a certain Breakpoints can be configured to only pause evaluation under a certain 
condition. To make a breakpoint conditional, check the condition. To make a breakpoint conditional, check the Active the Active the Active the Active the 
breakpoint based on the following conditionbreakpoint based on the following conditionbreakpoint based on the following conditionbreakpoint based on the following condition option. Type the  option. Type the 
condition as Equilla code in the corresponding editor and specify how to condition as Equilla code in the corresponding editor and specify how to 
interpret the condition.interpret the condition.  
  
Beside conditions, you can also specify what to do when the break point is Beside conditions, you can also specify what to do when the break point is 
hit. The default behavior is to pause evaluation, but you can also specify hit. The default behavior is to pause evaluation, but you can also specify 
that the debugger should simply print a message to the output window. that the debugger should simply print a message to the output window. 
Available options are:Available options are:

l BreakBreakBreakBreak  ––  Pauses the evaluation when the breakpoint is hit. This is the default behavior.Pauses the evaluation when the breakpoint is hit. This is the default behavior.  

l Print a message on historic barsPrint a message on historic barsPrint a message on historic barsPrint a message on historic bars  ––  Prints the specified message when the breakpoint is hit while evaluating historic Prints the specified message when the breakpoint is hit while evaluating historic 
bars.bars.  

l Print a message on realPrint a message on realPrint a message on realPrint a message on real----time barstime barstime barstime bars  ––  Prints the specified message when the breakpoint is hit while evaluating realPrints the specified message when the breakpoint is hit while evaluating real--time time 
bars.bars.  

l Print a message on every barPrint a message on every barPrint a message on every barPrint a message on every bar  ––  Always prints the specified message when the breakpoint is hit.Always prints the specified message when the breakpoint is hit.  

l Continue executionContinue executionContinue executionContinue execution  ––  Specifies if the debugger should continue execution when the breakpoint is hit or if the evaluation Specifies if the debugger should continue execution when the breakpoint is hit or if the evaluation 
should be paused as it is done for standard breakpoints.should be paused as it is done for standard breakpoints.  

BREAKING ON RUNTIME ERRORSBREAKING ON RUNTIME ERRORS  

By default, if a runtime error occurs, the debugger will automatically break on the instruction that caused the error. This allows the By default, if a runtime error occurs, the debugger will automatically break on the instruction that caused the error. This allows the 
developer to identify exactly what went wrong, without having to manually set breakpoints to stop just before the error.developer to identify exactly what went wrong, without having to manually set breakpoints to stop just before the error.  
  
This feature may be enabled or disabled in the property inspector, using the This feature may be enabled or disabled in the property inspector, using the Break on Runtime ErrorBreak on Runtime Error property. property.  
  
In the case that runtime errors are disabled in a Equilla Script, the break point will still be triggered, although the execution can In the case that runtime errors are disabled in a Equilla Script, the break point will still be triggered, although the execution can 
then be resumed afterwards.then be resumed afterwards.

OBJECTSOBJECTS  

The objects view shows what objects are available for debugging. It also The objects view shows what objects are available for debugging. It also 
enables you to filter what items should be debugged. enables you to filter what items should be debugged.   
  
To enable or disable debugging for an object, simply set or clear the check To enable or disable debugging for an object, simply set or clear the check 
box in front of it.box in front of it.  
  
Use the context menu to toggle between these two modes.Use the context menu to toggle between these two modes.

Breakpoint Properties DialogBreakpoint Properties Dialog

Objects viewObjects view



:: www.tradesignal.comwww.tradesignal.com

Tradesignal GmbHTradesignal GmbH Page 298Page 298 Version 7.0Version 7.0

DEBUGGER COMMANDSDEBUGGER COMMANDS  

The debugger document supports the following commands:The debugger document supports the following commands:

DEBUG GROUPDEBUG GROUP  

l BreakBreakBreakBreak  --  Pauses the execution when the next evaluation starts. Please be aware that some new data has to arrive in order to Pauses the execution when the next evaluation starts. Please be aware that some new data has to arrive in order to 
trigger an evaluation. If the market is closed, the debugger will pause with the next tick that arrives.trigger an evaluation. If the market is closed, the debugger will pause with the next tick that arrives.  

l ContinueContinueContinueContinue  ––  Continues evaluation when the evaluation is paused.Continues evaluation when the evaluation is paused.  

l RestartRestartRestartRestart  --  Restarts the evaluation of the complete chart. All scripts will be reevaluated starting with bar 1.Restarts the evaluation of the complete chart. All scripts will be reevaluated starting with bar 1.  

l Step InStep InStep InStep In  ––  Steps into an Equilla script function, entering the next level in the call stack. If the next instruction is not an Steps into an Equilla script function, entering the next level in the call stack. If the next instruction is not an 
Equilla script function, this command acts like the Step Over command.Equilla script function, this command acts like the Step Over command.  

l Step OverStep OverStep OverStep Over  ––  Steps over the next line.Steps over the next line.  

l Step OutStep OutStep OutStep Out  ––  Steps out of the current Equilla script, going back one level in the call stack.Steps out of the current Equilla script, going back one level in the call stack.  

l Quick WatchQuick WatchQuick WatchQuick Watch  ––  Shows the quick watch dialog that can be used to evaluate Equilla expressions or inspect the state of Shows the quick watch dialog that can be used to evaluate Equilla expressions or inspect the state of 
variables and objects.variables and objects.  

l AttachAttachAttachAttach  ––  Attaches the debugger to a document.Attaches the debugger to a document.  

l DetachDetachDetachDetach  ––  Detaches the debugger from the currently debugged document.Detaches the debugger from the currently debugged document.  

BREAKPOINTS GROUPBREAKPOINTS GROUP  

l Toggle BreakpointToggle BreakpointToggle BreakpointToggle Breakpoint  ––  Adds a new or removes an existing breakpoint.Adds a new or removes an existing breakpoint.  

l Enable/DisableEnable/DisableEnable/DisableEnable/Disable  ––  Enables or disables an existing breakpoint.Enables or disables an existing breakpoint.  

l Remove BreakpointRemove BreakpointRemove BreakpointRemove Breakpoint  ––  Removes an existing breakpoint.Removes an existing breakpoint.  

PROPERTIESPROPERTIES  

The debugger document offers the following properties to be modified from the Property Inspector:The debugger document offers the following properties to be modified from the Property Inspector:

l Fontsize''' Fontsize''' ––  Controls the size of the text in the Equilla script views. The default value is 9.Controls the size of the text in the Equilla script views. The default value is 9.  

l Trace Order State Changes (Historic)Trace Order State Changes (Historic)Trace Order State Changes (Historic)Trace Order State Changes (Historic)  ––  Enables or disables the tracing of order state changes while evaluating historic Enables or disables the tracing of order state changes while evaluating historic 
data. The default value is false.data. The default value is false.  

l Trace Order State Changes (RealTrace Order State Changes (RealTrace Order State Changes (RealTrace Order State Changes (Real----time)time)time)time)  ––  Enables or disables the tracing of order state changes while evaluating realEnables or disables the tracing of order state changes while evaluating real--
time bars. The default value is false.time bars. The default value is false.  
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l QUICK WATCHQUICK WATCH  

The Quick Watch can be used to inspect the state of variables and object The Quick Watch can be used to inspect the state of variables and object 
and to evaluate Equilla expressions. and to evaluate Equilla expressions.   
  
While providing the same functionality as the Watch view it allows the While providing the same functionality as the Watch view it allows the 
resizing of the output area without affecting the general layout of the resizing of the output area without affecting the general layout of the 
debugger document. Therefor it can be used to quickly inspect the state of a debugger document. Therefor it can be used to quickly inspect the state of a 
variable or object even if the information does not fit into the space variable or object even if the information does not fit into the space 
available for the Watch view.available for the Watch view.

DEBUG EXPRESSIONSDEBUG EXPRESSIONS  

The Equilla debugger supports a wide range of debug expressions that can be evaluated in the The Equilla debugger supports a wide range of debug expressions that can be evaluated in the WatchWatchWatchWatch view or the  view or the Quick WatchQuick WatchQuick WatchQuick Watch  
dialog. This includes some predefined expressions that provide information about the debugged document or the currently dialog. This includes some predefined expressions that provide information about the debugged document or the currently 
debugged object.debugged object.

PREDEFINED EXPRESSIONSPREDEFINED EXPRESSIONS  

l VMVMVMVM  ––  This expression provides access to the state of the debugged document. This includes settings, references to all This expression provides access to the state of the debugged document. This includes settings, references to all 
instruments used in the document as well as all elements in the chart, like instruments, indicators, strategies and tools. instruments used in the document as well as all elements in the chart, like instruments, indicators, strategies and tools. 
When debugging strategies it also provides information about positions, orders and statistics.When debugging strategies it also provides information about positions, orders and statistics.  

l ThisThisThisThis  ––  This expression provides access to the state of the currently debugged object. This includes parent objects and input This expression provides access to the state of the currently debugged object. This includes parent objects and input 
instruments, as well as, error information, generated output data and trading related data.instruments, as well as, error information, generated output data and trading related data.  

EQUILLA EXPRESSIONSEQUILLA EXPRESSIONS  

In addition to the predefined debug expressions, you can evaluate standard Equilla code and evaluate it in the debugger. While you In addition to the predefined debug expressions, you can evaluate standard Equilla code and evaluate it in the debugger. While you 
can use all buildcan use all build--in Equilla functions, you cannot use any Equilla script function. in Equilla functions, you cannot use any Equilla script function.   
  
Valid examples, using only buildValid examples, using only build--in functions or standard operators:in functions or standard operators:

Sum(close, 10) / 10 

 

(Close[1] + Close) / 2 

Invalid example, using a script function rather than a build in function:Invalid example, using a script function rather than a build in function:

Average(Close, 10) 

Please be aware that some variable might not be available in the debugger. This is caused by code optimizations that are applied Please be aware that some variable might not be available in the debugger. This is caused by code optimizations that are applied 
to the source code when compiling it. This may result in variables being removed or replaced in order to save resources and to the source code when compiling it. This may result in variables being removed or replaced in order to save resources and 

Quick Watch DialogQuick Watch Dialog
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increase the evaluation speed. Additionally the compiler may reorder the instructions in its optimization phase, leading to increase the evaluation speed. Additionally the compiler may reorder the instructions in its optimization phase, leading to 
unexpected jumps while stepping through the code.unexpected jumps while stepping through the code.

CHARTCHART  

When attaching a debugger to a chart document, the chart will display a When attaching a debugger to a chart document, the chart will display a 
corresponding hint below the standard legend.corresponding hint below the standard legend.    

Debugged chartDebugged chart
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EQUILLA PROGRAM STRUCTURE AND SYNTAX 

META TAGSMETA TAGS  

The soThe so--called meta properties define the global functions of your indicator, for example if the indicator should be displayed in a called meta properties define the global functions of your indicator, for example if the indicator should be displayed in a 
window of its own or within another chart. You can also add information about how the indicator is calculated (Synopsis) and window of its own or within another chart. You can also add information about how the indicator is calculated (Synopsis) and 
define a ShortCode. The meta information area can usually be found in the beginning of the source code. You should adhere to this define a ShortCode. The meta information area can usually be found in the beginning of the source code. You should adhere to this 
convention. The area has to be introduced with the tagconvention. The area has to be introduced with the tag

Meta: 

  
  
The three most important pieces of meta information are: The three most important pieces of meta information are: 

Meta: 

 

//Description for the code 

Synopsis( " Text " ),  

//Define whether the indicator will be displayed in a separate sub­chart or not 

Subchart(True/False), 

//Define a ShortCode. By entering it in the command linethe indicator is called up. 

ShortCode("MyIndicator");  

INPUT DECLARATIONINPUT DECLARATION  

When applying an indicator to a chart, one or more parameters are available in the indicator properties. These parameters can be When applying an indicator to a chart, one or more parameters are available in the indicator properties. These parameters can be 
calculation periods, multiplications or lists. Usercalculation periods, multiplications or lists. User--specific parameters have to be declared in the input area of the source code. The specific parameters have to be declared in the input area of the source code. The 
area has to be introduced with the tagarea has to be introduced with the tag

Inputs: 

  
  

AVAILABLE INPUT TYPESAVAILABLE INPUT TYPES  

Inputs:  

//Switch for true/false /yes/no) choice. 

Visuals (true, false), 

 

//Input field for integers, followed by lower and upper 

//end of range. 
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Period(10, 1, 100), 

 

//Input field for decimal value; note that the  

//decimal point of the defining criterion. 

FactorOffSet( 1.25, 1.0, 5.0 ), 

 

//Input field for string; note that  

//the quotation marks are the defining criterion. 

UserName( "John Smith" ), 

 

//Input field for colors; the dialog is system­dependent. 

//The dialog generation also works for colors entered as 

//RGB values ( redValue, greenValue, blueValue ). 

//The values for redValue, greenValue und blueValue have to be between 

//0 and 255. 

PreferredColor( red ), 

 

//Generates a selection list for time lines. The list automatically 

//includes all time lines for the basic symbol. Usually, these are the  

//Open, High, Low, Close and Volume data. 

PriceValue( Close ), 

 

//Generates a selection list for the given words or strings. 

//The list is zero­based. 

Weekdays( Monday, Tuesday, Wednesday, Thursday, Friday, Saturday, Sunday ); 

EXAMPLES FOR USING THE INPUT TYPESEXAMPLES FOR USING THE INPUT TYPES  

//Example for querying a true/false (yes/no) boolean switch 

//When the switch is set to true (yes), a line is drawn: 

If Visuals = True Then 

DrawLine ( (High+Low)/2); 

 

//Example for using an integer input 

//The parameter 'Period' is declared as input, the given 

//value 10 for the period is passed to the average function. 

avgValue = Average( Close, Period ); 

Drawline( avgValue ); 

 

//Example for using a decimal number 

//The drawing function draws a continuous line which 

//corresponds to the value 'close * 1.25'. 

DrawLine( FactorOffSet * Close ); 
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//Example for using a string input 

//In the output window, 'John Smith' is displayed. 

Print( "UserName" ); 

 

//Example for using a color value as input 

//A red, solid line is drawn. 

DrawLine( Close, "Close Line", StyleSolid, 2, PreferredColor ); 

 

//Example for using a time line input 

//A line is drawn on the level of the close prices. 

DrawLine( PriceValue ); 

 

//Example for querying the selected entry in a list 

//In the output window, 'Monday' appears when selected. 

If Weekdays = "Monday" Then 

Print( "Monday" ); 

 

//In lists, index numbers are assigned to the entries.  

//As already mentioned, lists are zero­based, so Monday is "0" and Sunday is "6". 

//Instead of querying the string, the index number can be used instead.  

If Weekdays = 0 Then 

Print( "Monday" ); 

VARIABLE DECLARATIONVARIABLE DECLARATION  

WHAT ARE VARIABLES?WHAT ARE VARIABLES?  

Variables are data containers. To be able to use values like numbers, calculation results, user entries or prices, the values have to Variables are data containers. To be able to use values like numbers, calculation results, user entries or prices, the values have to 
be saved temporarily in variables. This way, each value has its own storage space and can be called up by the variable name. be saved temporarily in variables. This way, each value has its own storage space and can be called up by the variable name. 
Imagine variable to be like containers on a cargo ship. Each container has its own unique ID, with which to find the contents. Imagine variable to be like containers on a cargo ship. Each container has its own unique ID, with which to find the contents. 
When the booker needs to know the information in a container, he enters the unique ID into a computer, which returns the wanted When the booker needs to know the information in a container, he enters the unique ID into a computer, which returns the wanted 
information.information.

VALIDITY OF VARIABLESVALIDITY OF VARIABLES  

Variables are only valid within the script in a chart. It is not possible to use the value of variable "Period1" of the indicator Variables are only valid within the script in a chart. It is not possible to use the value of variable "Period1" of the indicator 
"Indicator1" in "Indicator2", since the second script has no access to the variable "Indicator1" in "Indicator2", since the second script has no access to the variable -- not even when both indicators are used in the  not even when both indicators are used in the 
same chart.same chart.    
  
The only exceptions to the rule are The only exceptions to the rule are global variablesglobal variables..

INITIALIZATION OF VARIABLES, AND FOR HOW LONG DO THEY KEEP THEIR VALUE?INITIALIZATION OF VARIABLES, AND FOR HOW LONG DO THEY KEEP THEIR VALUE?  
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Each Equilla script, e.g. an indicator, is processed once for each trading period. If the indicator is used in a daily chart, the indicator Each Equilla script, e.g. an indicator, is processed once for each trading period. If the indicator is used in a daily chart, the indicator 
is calculated once for each day in the chart. The variable is initialized at the first trading day in the chart. is calculated once for each day in the chart. The variable is initialized at the first trading day in the chart.   
  
If in the days following that, no new value is set for the variable, the value is kept until the last trading day in the chart. If a new If in the days following that, no new value is set for the variable, the value is kept until the last trading day in the chart. If a new 
value is set for the variable in between, it is kept until a new value is assigned or until the last trading day.value is set for the variable in between, it is kept until a new value is assigned or until the last trading day.

GENERATING VARIABLESGENERATING VARIABLES  

Variables are generated by being declared, i.e. given a name. Variables can only be defined within a certain code area. It has to be Variables are generated by being declared, i.e. given a name. Variables can only be defined within a certain code area. It has to be 
introduced with the tagintroduced with the tag

Variables: 

  
  
You have the following possible methods to declare a variable: You have the following possible methods to declare a variable: 

//Declare a variable by assigning a name 

Variables:  

myFirstVariable, mySecondVariable; 

 

//Declare a variable by assigning a name and value 

Variables:  

myFirstVariable( 10 ), mySecondVariable( myFirstVariable / 2 ); 

 

//Declare a variable by entering a string 

Variables:  

myFirstString ( "" ), mySecondString( "String test" ); 

 

//Declare a variable with color values 

Variables:  

myFirstColor( red ), mySecondColor( RGB (10, 20, 30) ); 

 

GLOBAL (SCRIPTGLOBAL (SCRIPT--INDEPENDENT) VARIABLESINDEPENDENT) VARIABLES  

As opposed to the statement above, you can use global variables under special circumstances. The limitation is that the scripts As opposed to the statement above, you can use global variables under special circumstances. The limitation is that the scripts 
have to be in the same chart or portfolio. A sub chart, for example an indicator chart, does not count as a full chart. Therefore, you have to be in the same chart or portfolio. A sub chart, for example an indicator chart, does not count as a full chart. Therefore, you 
can pass data between main and sub charts and between several Equilla scripts that are used within the same main/sub charts.can pass data between main and sub charts and between several Equilla scripts that are used within the same main/sub charts.  
  
To do so, global variables are available. A global variable consists of a "Namespace", which can be seen as the name of the cargo To do so, global variables are available. A global variable consists of a "Namespace", which can be seen as the name of the cargo 
ship, and a variable name, which can be seen as the container ID. Since global variables are valid across several scripts, they do ship, and a variable name, which can be seen as the container ID. Since global variables are valid across several scripts, they do 
not have to be defined in the "Variables:" area. It is enough to name the global variable in one script and assign a value this way.not have to be defined in the "Variables:" area. It is enough to name the global variable in one script and assign a value this way.    
  

//This is the way to set up a global variable 
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//The global variable with the Namespace 'global' and the name 

//'myFirstGlobalVar' is generated by assigning a value. 

//From this moment on, the value can be used in all  

//scripts in the same chart. 

global::myFirstGlobalVar = 100; 

 

//This is the way to read the value of a global variable. 

//In the output window, '100' is displayed. 

Variables:  

myNewVar; 

 

myNewVar = global::myFirstGlobalVar ; 

Print( myNewVar ); 

DECLARATION DETAIL FOR VARIABLES AND INPUTSDECLARATION DETAIL FOR VARIABLES AND INPUTS  

For variables as well as inputs, you can either enter several declarations in one line or each declaration in its own line. The For variables as well as inputs, you can either enter several declarations in one line or each declaration in its own line. The 
declarations have to be separated by commas. After the last declaration, a semideclarations have to be separated by commas. After the last declaration, a semi--colon has to be entered. colon has to be entered.   
  

//Declare inputs in one line 

Inputs:  

MyName( "Caspar David" ), YourName( "Peter King" ), HerName ( "Barbara Myers" ); 

 

//Declare inputs in several lines 

Inputs:  

MyName( "Caspar David" ),  

YourName( "Peter King" ),  

HerName ( "Barbara Myers" ); 

STRUCTURING SOURCE CODESTRUCTURING SOURCE CODE  

For a better readability and overview in the Equilla code, the source code should be wellFor a better readability and overview in the Equilla code, the source code should be well--structured. This also makes it easier to structured. This also makes it easier to 
find errors in the coding. For structuring, make use of indentions, comments and empty lines. Declare the variables and inputs in find errors in the coding. For structuring, make use of indentions, comments and empty lines. Declare the variables and inputs in 
separate lines instead of one line.separate lines instead of one line.

INDENTING SOURCE CODEINDENTING SOURCE CODE  

It is a standard programming technique to indent certain parts of the code by using the It is a standard programming technique to indent certain parts of the code by using the TabTabTabTab key. This way it is much easier to  key. This way it is much easier to 
understand the relations between code parts. This is especially useful in cases of loops or conditions. understand the relations between code parts. This is especially useful in cases of loops or conditions. 

//Indenting the code that is only run if the condition is met 
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If Bronto = "Saurus" Then 

DrawText( Close, "Run away!" ); 

 

//Cascading indenting of code to keep a better overview 

If condition = "met" Then 

Begin  

myFirstVar = 100; 

mySecondVar = 7; 

DrawLine( myFirstVar + mySecondVar ); 

End; 

 

//Each consecutive condition should also be indented  

If condition = "met" Then 

Begin  

myFirstVar = 100; 

mySecondVar = 7; 

//additional condition 

if Visuals = True Then 

DrawLine( myFirstVar + mySecondVar ); 

End; 

 

BRACKETING EXPRESSIONSBRACKETING EXPRESSIONS  

It is also recommended that you use bracketing for conditional queries or loops. This way, you avoid overly complicated code and It is also recommended that you use bracketing for conditional queries or loops. This way, you avoid overly complicated code and 
malfunctioning which may result from logical errors.malfunctioning which may result from logical errors.    
  

//Expressions in queries should be bracketed for two reasons 

//a) For better overview 

If ( myFirstVar = 100 ) and ( mySecondVar = 100 ) Then 

Begin 

//Here follow... 

//...expressions 

End; 

 

//b) For program logic  

If (myFirstVar = 100) AND ((mySecondVar = 100) OR (myThirdVar = 0)) Then  

Begin 

//This block is only executed if 

//myFirstVar and mySecondVar both have the value 100 

//or if myFirstVar has the value 100 and if myThirdVar has the value 0  

End; 
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Take a closer look at the second example. If the two brackets around the expressions linked by OR were not there, another meaning Take a closer look at the second example. If the two brackets around the expressions linked by OR were not there, another meaning 
would result. The condition would be met if "myFirstVar = 100 and mySecondVar = 100" OR "myThirdVar = 0". In this case, the code would result. The condition would be met if "myFirstVar = 100 and mySecondVar = 100" OR "myThirdVar = 0". In this case, the code 
would only be executed if "myFirstVar" were 100 and "mySecondVar" were 100 OR "myThirdVar" were 0, which was not meant to would only be executed if "myFirstVar" were 100 and "mySecondVar" were 100 OR "myThirdVar" were 0, which was not meant to 
be according to the definition given in the comments.be according to the definition given in the comments.  
  
In addition to the examples above, it may also be useful to set brackets around mathematical operators. In addition to the examples above, it may also be useful to set brackets around mathematical operators.   
  

//Are you sure what's meant here? 

myFirstVar = 100 * ( x + y * ( 10 / z ) ); 

 

//This way it is easier to read. 

myFirstVar = 100 * ( x + ( y * ( 10 / z ) ) ); 

INSERTING COMMENTSINSERTING COMMENTS  

As already seen, you can enter comments in the code. This is especially useful for two reasonsAs already seen, you can enter comments in the code. This is especially useful for two reasons

l Even in case of longer source code and more complex structures, good readability and comprehensibility are given. This Even in case of longer source code and more complex structures, good readability and comprehensibility are given. This 
way, you can correct or edit the code even after years.way, you can correct or edit the code even after years.  

l Outsiders are able to understand the code much faster.Outsiders are able to understand the code much faster.  

//This is a single line comment 

 

avgValue (Open) // You can also add a comment at the end of the line 

 

/*This is the start of a multiple line comment Comments are disregarded by the program 

interpreter, they are only displayed in the editor. With comments program parts can be 

deactivated for example for error search. ­­­This assignment of a calculation to a parameter 

is not executed Value1 = XAverage( Close, 10 ); This is the end of the comment */ 
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EQUILLA FUNCTIONS 

WHAT IS A FUNCTION?WHAT IS A FUNCTION?  

In programming languages, functions are subordinate portions of the code in which regularly used calculations and subroutines are In programming languages, functions are subordinate portions of the code in which regularly used calculations and subroutines are 
sourced out. For example, instead of writing the calculation of standard deviation again and again, the calculation is put into a sourced out. For example, instead of writing the calculation of standard deviation again and again, the calculation is put into a 
function. By calling up the function by its name function. By calling up the function by its name -- and passing the relevant parameter(s) for calculation  and passing the relevant parameter(s) for calculation -- the user receives the return  the user receives the return 
value as result.value as result.  
  
The call may look as follows:The call may look as follows:

/* With the following function you receive the standard deviation over a 10 day range. 

'StandardDev' is the Equilla function that contains the actual calculation. */ 

 

myStdAbw = StandardDev( Close, 10 , 0 ); 

  
  
This is the source code of the Equilla This is the source code of the Equilla StandardDevStandardDev::

Meta:  

Synopsis( "[Standard Deviation 1] Returns the Standard Deviation value for the current 

bar." ); 

 

Inputs:  

Price( NumericSeries ),  

Period( NumericSimple ),  

DataType( NumericSimple ); 

 

Variables:  

divisor, sumSquare, avg, i; 

 

StandardDev = 0; 

 

If DataType = 1 Then 

divisor = Period 

Else 

divisor = Period ­ 1; 

 

If divisor > 0 Then Begin 

avg = AverageFC( Price, Period ); 

sumSquare = 0; 

For i = 0 To Period ­ 1 Do 

sumSquare = sumSquare + Sqr( Price[i] ­ avg ); 
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If sumSquare > 0 Then 

StandardDev = Sqrt( sumSquare / divisor ); 

End 

// *** Copyright Tradesignal GmbH *** 

// *** www.tradesignal.com *** 

  
  
Another big advantage of functions is that you can call up the same functions from indicators and strategies. In fact, all indicators Another big advantage of functions is that you can call up the same functions from indicators and strategies. In fact, all indicators 
are based on functions are based on functions -- just as strategies are based on indicators.  just as strategies are based on indicators.   
  
You can find the functions that came with the program by clicking on the button You can find the functions that came with the program by clicking on the button FunctionsFunctionsFunctionsFunctions in the toolbox. To see the code of the  in the toolbox. To see the code of the 
function, rightfunction, right--click on it to open the context and select click on it to open the context and select EditEditEditEdit..

FUNCTION STRUCTUREFUNCTION STRUCTURE  

For the programming of Equilla functions, the same conditions apply as for all Equilla scripts, see the chapter For the programming of Equilla functions, the same conditions apply as for all Equilla scripts, see the chapter Equilla Program Equilla Program 
Structure and SyntaxStructure and Syntax. Minor divergences are given in the following paragraphs. . Minor divergences are given in the following paragraphs. 

FUNCTION NAMEFUNCTION NAME  

The function name is necessary to a) save the function in the file system and b) call up the function from within an Equilla script. The function name is necessary to a) save the function in the file system and b) call up the function from within an Equilla script. 
When choosing the name, take care that the name When choosing the name, take care that the name 

l is short and conciseis short and concise  
l relates to the contentsrelates to the contents  
l is not yet in use for another function (this might cause problems)is not yet in use for another function (this might cause problems)  

//The function Momentum gives the indicator of the same name as result 

myFirstVar = Momentum( PriceSerie, CalculationPeriod ); 

PASSING PARAMETERS UPON FUNCTION CALLPASSING PARAMETERS UPON FUNCTION CALL  

For the calculation of indicators, statistics and other values, certain information has to be given:For the calculation of indicators, statistics and other values, certain information has to be given:

l which data is to be used for calculationwhich data is to be used for calculation  
l which time range is to be used for calculationwhich time range is to be used for calculation  

When calling up the function, these parameters (separated by commas) have to be passed in brackets.When calling up the function, these parameters (separated by commas) have to be passed in brackets.  

/* The function 'Momentum' gives the indicator of the same name as result As parameter the 

function demands the data to be used for the Momentum and the time range over which to 

calculate. */ 

 

myFirstVar = Momentum( Close, 20 ); 
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INPUT DECLARATION IN FUNCTIONSINPUT DECLARATION IN FUNCTIONS  

In the source code of the function, any inputs from outside have to be declared. As opposed to the definition of indicators, the type In the source code of the function, any inputs from outside have to be declared. As opposed to the definition of indicators, the type 
of the input parameters has to be declared in functions.of the input parameters has to be declared in functions.  

Inputs:  

//A data series, e.g. prices, has to be declared as NumericSeries 

PriceValue( NumericSeries ), 

 

//Simple numeric values are declared as NumericSimple 

PeriodFast( NumericSimple ), 

 

//Booleans as true/false (yes/no) value are declared TrueFalseSimple 

DrawVisuals( TrueFalseSimple ), 

 

//Strings like words or symbols are declared as StringSimple 

UserName( StringSimple ), 

 

//If you want to pass data that will be modified within the function and the 

//resulting modified value is to be used outside of the function, you have 

//to declare this as NumericRef 

AdjustedPeriod( NumericRef ), 

 

//Arrays can have multiple dimensions in Equilla, each dimension also 

//declares an additional input for the function, in this example the 

//function expects a 2­dimensional array as input which will be accessible 

//with the name Array2D and the numeric inputs Rows and Columns which are 

//initialized to contain the lenght of the array in this dimension. 

Array2D [ Rows, Columns ] ( NumericArray ), 

 

//If you want to pass an extension object to a function, you have to declare 

//the input as ObjectSimple (available in Tradesignal 6.3 and above). 

ExtensionObject ( ObjectSimple ); 

  
  
Make sure to use the parameters in the same sequence as they are declared in the function. The names of parameters used inside Make sure to use the parameters in the same sequence as they are declared in the function. The names of parameters used inside 
of functions are independent of parameter names that are passed. Therefore you can use the parameter 'Period', which is passed of functions are independent of parameter names that are passed. Therefore you can use the parameter 'Period', which is passed 
when calling the function, under another name within the function. You only have to take care that the sequence of values passed when calling the function, under another name within the function. You only have to take care that the sequence of values passed 
is the same as in the declaration. is the same as in the declaration. 

VARIABLE DECLARATION IN FUNCTIONSVARIABLE DECLARATION IN FUNCTIONS  

The same conventions apply as described in The same conventions apply as described in Equilla BasicsEquilla Basics. You can also use variable names that are already in use in the main . You can also use variable names that are already in use in the main 
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program, as there is no danger of collision. program, as there is no danger of collision. 

RETURNING VALUESRETURNING VALUES  

Values that were calculated in the function usually should be available for further processing. To do so, the values have to be Values that were calculated in the function usually should be available for further processing. To do so, the values have to be 
"returned". The actual way of returning depends on which kind of value has to be returned. "returned". The actual way of returning depends on which kind of value has to be returned. 

RETURNING A SINGLE VALUERETURNING A SINGLE VALUE  

If only a single value has to be returned, this is usually done with the name of the function. In the calling script, the function is If only a single value has to be returned, this is usually done with the name of the function. In the calling script, the function is 
assigned to a declared variable. The variable takes up the calculation result and makes it available for further operations.assigned to a declared variable. The variable takes up the calculation result and makes it available for further operations.  
  

// In the calling script, the result of the Momentum calculation 

// is assigned to the variable myFirstVar 

 

myFirstVar = Momentum( Close, 20 ); 

  
  
In the source code of the function, the calculation result has to be assigned to the name of the function. In the source code of the function, the calculation result has to be assigned to the name of the function. 

Meta:  

Synopsis( "[Momentum] Returns the momentum of a series over a specified period." ); 

 

Inputs:  

Price( NumericSeries ),  

Period( NumericSimple ); 

 

//Assignment, i.e. returning the value 

 

Momentum = Price ­ Price[ Period ]; 

RETURNING SEVERAL VALUESRETURNING SEVERAL VALUES  

When you want to return more than one result from a function, you must use so called reference parameters. These parameters will When you want to return more than one result from a function, you must use so called reference parameters. These parameters will 
be passed into your function, modified within the function and then can be used. The following function shows two such reference be passed into your function, modified within the function and then can be used. The following function shows two such reference 
parameters that are set to the result of two different moving averages:parameters that are set to the result of two different moving averages:  
  

//Function: TwoSmoothMA 

Inputs:  

FastMA(NumericRef), // Notice how we declare the type of the inputs as numeric 

references 

SlowMA(NumericRef); // instead of numericseries or numericsimple. 
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Variables:  

smoothMA; 

 

smoothMA = Average(Close, 5); 

FastMA = Average(smoothMA, 10); 

SlowMA = Average(smoothMA, 50); 

TwoSmoothMA = 1; // A dummy return value that will not be used in this case. 

 

  
  
We can now use our new function in the following way:We can now use our new function in the following way:  
  

//Indicator: Two Smooth Averages 

Meta: 

SubChart(False); 

Variables:  

slowMA, fastMA; 

 

TwoSmoothMA(slowMA, fastMA); // The values for slowMA and fastMA are set in the function 

 

DrawLine(slowMA, "Slow"); 

DrawLine(fastMA, "Fast"); 

  
  
The advantage of using multiple output functions is that related operations can be nicely encapsulated, but more importantly that if The advantage of using multiple output functions is that related operations can be nicely encapsulated, but more importantly that if 
the result of each output rely on a shared calculated value, it is more efficient to do the shared part once rather than twice in two the result of each output rely on a shared calculated value, it is more efficient to do the shared part once rather than twice in two 
functions that return single values.functions that return single values.

RETRIEVING PAST VALUES WITH DISPLACEMENTSRETRIEVING PAST VALUES WITH DISPLACEMENTS  

By using displacements, for example "Price[i]", you can retrieve older function results. A good example for this would be the search By using displacements, for example "Price[i]", you can retrieve older function results. A good example for this would be the search 
for a breakout within the last 20 days' high or low. Please note that with the displacement attribute, past values are retrieved. for a breakout within the last 20 days' high or low. Please note that with the displacement attribute, past values are retrieved. 
Therefore "[1]" gives the value for yesterday, [2] the value of two days ago etc. Therefore "[1]" gives the value for yesterday, [2] the value of two days ago etc.   
  
AttentionAttention: Trying to retrieve values of functions that are not calculated continuously may result in wrong indicator results. This : Trying to retrieve values of functions that are not calculated continuously may result in wrong indicator results. This 
would be the case, for example, when the function call is in a subroutine that is not executed for each bar.would be the case, for example, when the function call is in a subroutine that is not executed for each bar.

ADDITIONAL INFORMATION FOR FUNCTIONSADDITIONAL INFORMATION FOR FUNCTIONS  

For all Equilla functions, you can find additional information in Tradesignal. To display it, open the source code in the For all Equilla functions, you can find additional information in Tradesignal. To display it, open the source code in the Equilla Equilla 
EditorEditor. Then right. Then right--click on the function in question, e.g. click on the function in question, e.g. DateTimeDateTime, and choose , and choose Lookup Equilla FunctionLookup Equilla FunctionLookup Equilla FunctionLookup Equilla Function from the context menu. A  from the context menu. A 
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window opens with information on the command and links to related functions.window opens with information on the command and links to related functions.    
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EQUILLA OPERATORS 
An important part of the scripts is the calculation of values. Often only basic arithmetic is necessary for these calculations, but An important part of the scripts is the calculation of values. Often only basic arithmetic is necessary for these calculations, but 
sometimes the tasks are more complex. Equilla places many operators for calculating and comparing values at your disposal.sometimes the tasks are more complex. Equilla places many operators for calculating and comparing values at your disposal.

CALCULATIONSCALCULATIONS  

BASIC ARITHMETICSBASIC ARITHMETICS  

For calculating values, the four basic arithmetic operations are available. These are used most often. For calculating values, the four basic arithmetic operations are available. These are used most often.   
  

Variables:  

myFirstVar, mySecondVar, myThirdVar; 

 

//Adding two values  

myFirstVar = mySecondVar + myThirdVar; 

 

//Subtracting two values 

myFirstVar = mySecondVar ­ myThirdVar; 

 

//Multiplying two values 

myFirstVar = mySecondVar * myThirdVar; 

 

/* When dividing two values, care has to be taken that no division by zero occurs (which may 

happen if price series are faulty and include a zero). In this case, Tradesignal instantly 

reports an error and stops the calculation. After a simple example for a division, two 

examples are given that are designed to prevent a division by zero. */ 

 

//Simple Division 

myFirstVar = mySecondVar / myThirdVar; 

 

//Query if Divisor = NULL  

If myThirdVar <> 0 Then 

myFirstVar = mySecondVar / myThirdVar 

 

//If myThirdVar is zero, the result of the  

//preceding trading period is used. 

//The alternative block starting with 'Else' 

//may be left out 

Else 

myFirstVar = myFirstVar [ 1 ]; 
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//The Equilla function ''Divide' is available for this task 

//The two operands have to be passed in brackets 

myFirstVar = Divide( mySecondVar , myThirdVar ); 

 

MATHEMATICAL FUNCTIONS FOR COMPLEX CALCULATIONSMATHEMATICAL FUNCTIONS FOR COMPLEX CALCULATIONS  

With some effort, every calculation can be performed. However, you can reduce the programming load by using functions already With some effort, every calculation can be performed. However, you can reduce the programming load by using functions already 
provided for special tasks. You can find a list of all functions by clicking the provided for special tasks. You can find a list of all functions by clicking the FunctionFunctionFunctionFunction button in the toolbox. To see the code,  button in the toolbox. To see the code, 
doubledouble--click the function or select click the function or select EditEditEditEdit from the context menu.  from the context menu.   
  
In the following, excerpts of some important functions and their use are given. In the following, excerpts of some important functions and their use are given.   
  

//No subchart 

Meta: 

Subchart( false ); 

 

//Declare period for calculation and variables 

Inputs:  

Period( 10 ); 

 

Variables:  

myFirstVar, mySecondVar, myThirdVar; 

 

 

/* This way you can find the highest value in a series. Please note: Parameter 1: The used 

data has to be given as a continuous series, either a price series or a value that is 

calculated or existent at each bar. Parameter 2: The calculation span gives the number of 

values from the past that are used in the calculation. In the example, period is set to 

'10'. */ 

 

//Example 1: finding the highest close 

myFirstVar = HHV( Close, Period ); 

 

//Example 2: finding the highest price span 

mySecondVar = High ­ Low; 

myFirstVar = HHV( mySecondVar, Period ); 

/* There is a similar function you can use for finding the lowest price in a series. Besides 

the different function name, all statements from above apply. */ 

 

//Example 1: finding the lowest close price 

myFirstVar = LLV( Close, Period ); 

 

//Example 2: finding the lowest price span 

mySecondVar = High ­ Low; 
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myFirstVar = LLV( mySecondVar, Period ); 

/* When working with data, you often do not know during the programming which values are 

less or greater than others. However, it is often important to pursue calculations with the 

greater or lesser of two values. For this task, the two functions MaxItems and MinItems are 

available. In both cases, two or more comma­separated values have to be passed in brackets. 

The functions then give the greatest or smallest value from a list of values. */ 

 

//Calculating the height of a candlestick body  

//without knowing if the close is below or above the open  

 

myFirstVar = MaxItems( Open, Close ) ­ MinItems( Open, Close ); 

 

//Extracting the decimal places of a value  

If isLastBar Then 

Begin 

myFirstVar = Frac( 5.5 ); 

Print( myFirstVar ); //0,5 is output  

End; 

 

//Finding the biggest integer that is smaller than the given value 

If isLastBar Then 

Begin 

myFirstVar = Floor( 5.5 ); 

Print( myFirstVar ); //5 is output 

End; 

 

//Finding the smallest integer that is greater than the given value 

If isLastBar Then 

Begin 

myFirstVar = Ceiling( 5.5 ); 

Print( myFirstVar ); //6 is output 

End; 

 

//Calculating the cosine of a value 

If isLastBar Then 

Begin 

myFirstVar = Cos( 5.5 ); 

Print( myFirstVar ); //0,7086697742913 is output 

End; 

COMPARISONSCOMPARISONS  
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When calculating an indicator, it is often necessary to compare values and then execute certain functions. For value comparison, When calculating an indicator, it is often necessary to compare values and then execute certain functions. For value comparison, 
several operators are available. several operators are available. 

SIMPLE COMPARISONS BETWEEN TWO VALUESSIMPLE COMPARISONS BETWEEN TWO VALUES  

//No subchart 

Meta: 

Subchart( false ); 

 

//Declare variables 

Variables:  

myFirstVar, mySecondVar, myThirdVar; 

 

//Query if two values are identical 

If isLastBar Then 

Begin 

If myFirstVar = mySecondVar Then 

Print( "Hello World" ); //Data is output if values are identical 

End; 

 

//Query if two values are unequal 

If isLastBar Then 

Begin 

If myFirstVar <> mySecondVar Then 

Print( "Hello World" ); // Data is output if values are unequal 

End; 

 

//Query if the first value is greater or equal to the second 

If isLastBar Then 

Begin 

If myFirstVar >= mySecondVar Then 

Print( "Hello World" ); // Data is output if the value is  

// greater or equal to the  

// second value 

End; 

 

//Query if the first value is smaller or equal to the second 

If isLastBar Then 

Begin 

If myFirstVar <= mySecondVar Then 

Print( "Hello World" ); // Data is output if the value is  

// smaller or equal to the  

// second value 

End; 
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COMPARISONS BETWEEN SEVERAL VALUES THROUGH COMBINATIONCOMPARISONS BETWEEN SEVERAL VALUES THROUGH COMBINATION  

//No subchart 

Meta: 

Subchart( false ); 

 

//Declare variables 

Variables:  

myFirstVar, mySecondVar, myThirdVar; 

 

//Combining two comparisons with the AND operator 

If isLastBar Then 

Begin 

If ( myFirstVar = mySecondVar ) AND ( myFirstVar = myThirdVar ) Then 

Print( "Hello World" ); //Data is output if both comparisons are true 

End; 

 

//Combining two comparisons with the OR operator 

If isLastBar Then 

Begin 

If ( myFirstVar = mySecondVar ) OR ( myFirstVar = myThirdVar ) Then 

Print( "Hello World" ); //Data is output if one comparison or both  

//are true 

End; 

 

//Combining two comparisons with the XOR operator 

If isLastBar Then 

Begin 

If ( myFirstVar = mySecondVar ) XOR ( myFirstVar = myThirdVar ) Then 

Print( "Hello World" ); //Data is output if one comparison is true  

//but not both 

End; 

FINDING CROSSING TIME SERIESFINDING CROSSING TIME SERIES  

One of the most important problems in indicators and strategies is the search for intersections between prices and averages, One of the most important problems in indicators and strategies is the search for intersections between prices and averages, 
indicators and alert lines etc. Tradesignal offers several functions for this task. indicators and alert lines etc. Tradesignal offers several functions for this task.   
  

//No subchart 

Meta: 

Subchart( false ); 
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//Set periods for calculation 

Inputs:  

PeriodFast( 10 , 1 ), 

PeriodSlow( 20 , 1 ); 

 

//Declare variables 

Variables:  

fastAvg, slowAvg; 

 

//Calculating a short average of close prices 

fastAvg = Average( Close, PeriodFast ); 

//Calculating a longer average of close prices 

slowAvg = Average( Close, PeriodSlow ); 

 

If isLastbar then 

Begin 

//Query if the faster average crosses over slower 

If fastAvg Crosses Over slowAvg Then 

Alert( "Average moves upwards" ); 

//Query if the faster average crosses under slower 

If fastAvg Crosses Under slowAvg Then 

Alert( "Average moves downwards" ); 

End; 
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EQUILLA LOOPS 
Loops serve to call functions multiple times without having to enter the function code again and again. This is especially useful in Loops serve to call functions multiple times without having to enter the function code again and again. This is especially useful in 
cases in which the number of necessary runs for the loop is calculated during program execution. cases in which the number of necessary runs for the loop is calculated during program execution.   
  
In this chapter, all loop types available in Equilla are described.In this chapter, all loop types available in Equilla are described.  
  
For all Equilla operators, you can find additional information in Tradesignal. To display it, open the source code in the For all Equilla operators, you can find additional information in Tradesignal. To display it, open the source code in the Equilla Equilla 
EditorEditor. Then right. Then right--click on the operator in question, e.g. click on the operator in question, e.g. BeginBegin, and choose , and choose Lookup Equilla FunctionLookup Equilla FunctionLookup Equilla FunctionLookup Equilla Function from the context menu. A  from the context menu. A 
window opens with information on the operators and links to related functions.window opens with information on the operators and links to related functions.

LOOPS WITH A DEFINITE NUMBER OF CYCLES (FOR...TO...DO)LOOPS WITH A DEFINITE NUMBER OF CYCLES (FOR...TO...DO)  

For this type of loop, start and end values are given. The number of cycles is given by their difference. For this type of loop, start and end values are given. The number of cycles is given by their difference.   
  

//This loop repeats the command 10 times 

For counter = 0 to 9 Do 

command; 

 

//This loop repeats the block of commands 10 times 

For counter = 0 to 9 Do 

Begin 

command1; 

command2; 

... 

commandX; 

End; 

  
  
You also have the option to rule with which steps the loop have to run. The standard for the step is 1. You also have the option to rule with which steps the loop have to run. The standard for the step is 1.   
  

//This loop repeats the command 5 times 

For counter = 0 to 9 Step 2 Do 

command; 

 

//This loop repeats the command 10 times with a negative incrementation 

For counter = 9 to 0 Step ­1 Do 

Print(Counter); 
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You also have the option to give the start and end value of the loop as variables. This way, the loop is more flexible and results of You also have the option to give the start and end value of the loop as variables. This way, the loop is more flexible and results of 
partial calculations or functions can be used as counters. partial calculations or functions can be used as counters. 

//This loop repeats the command 13 times 

Variables:  

startCount( 0 ), endCount( 12 ); 

 

For counter = startCount to endCount Do 

command; 

 

//This loop repeats the block of commands 13 times 

For counter = startCount to endCount Do 

Begin 

command1; 

command2; 

... 

commandX; 

End; 

CONDITIONCONDITION--CONTROLLED LOOPSCONTROLLED LOOPS  

The above presented type of loop uses a fixed value as a counter for the number of cycles. The values can be set by variables, but The above presented type of loop uses a fixed value as a counter for the number of cycles. The values can be set by variables, but 
these variables cannot be changed from within the loop. However, this is necessary in cases, for example, in which the number of these variables cannot be changed from within the loop. However, this is necessary in cases, for example, in which the number of 
cycles depends on the result of a calculation within the loop itself. cycles depends on the result of a calculation within the loop itself.   
  
For these cases, other types of loops exist. These loops run until a certain result or value in the cycle meets a certain condition. For these cases, other types of loops exist. These loops run until a certain result or value in the cycle meets a certain condition. 
There are two different subtypes of these loops: There are two different subtypes of these loops: 

LOOP WITH THE CONDITION BEFORE THE EXECUTION (WHILE...DO)LOOP WITH THE CONDITION BEFORE THE EXECUTION (WHILE...DO)  

The condition for the loop is checked before the loop is executed. The condition for the loop is checked before the loop is executed.   
  

//This loop runs 10 times ( 0­9 ) 

Variables:  

counter(10), sumCounter(0); 

 

While ( counter < sumCounter ) Do 

sumCounter = sumCounter + 1; 

  
  

//You can also run several commands as a block.  
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Variables:  

counter(10), sumCounter(0); 

 

While ( counter < sumCounter ) Do 

Begin 

sumCounter = sumCounter + 1; 

Print( sumCounter ); 

End; 

LOOPS WITH THE CONDITION AFTER THE EXECUTION (REPEAT...UNTIL)LOOPS WITH THE CONDITION AFTER THE EXECUTION (REPEAT...UNTIL)  

The condition for the loop is checked after each cycle run, i.e. after the calculation. The condition for the loop is checked after each cycle run, i.e. after the calculation.   
  

//This loop runs 10 times ( 0­9 ) 

Variables:  

counter(10), sumCounter(0); 

 

Repeat 

sumCounter = sumCounter + 1; 

Until ( sumCounter < counter ); 

  
  

//You can also run several commands as a block.  

Variables:  

counter(10), sumCounter(0); 

 

Repeat 

Begin 

sumCounter = sumCounter + 1; 

Print( sumCounter ); 

End; 

Until ( sumCounter < counter ); 
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EQUILLA CONDITIONS 
One of the most important aspects of programming indicators, strategies or other routines is the reaction to certain events, like One of the most important aspects of programming indicators, strategies or other routines is the reaction to certain events, like 
calculation results or user inputs. Without the control, activation or deactivation of program parts depending on those events, no calculation results or user inputs. Without the control, activation or deactivation of program parts depending on those events, no 
complex programming would be possible.complex programming would be possible.  
  
For all Equilla conditions, you can find additional information in TradeSignal. To display it, open the source code in the For all Equilla conditions, you can find additional information in TradeSignal. To display it, open the source code in the Equilla Equilla 
EditorEditor. Then right. Then right--click on the operator in question, e.g. click on the operator in question, e.g. ElseElse, and choose , and choose Lookup Equilla FunctionLookup Equilla FunctionLookup Equilla FunctionLookup Equilla Function from the context menu. A  from the context menu. A 
window opens with information on the operators and links to related functions.window opens with information on the operators and links to related functions.

SIMPLE CONDITION (IF ... THEN)SIMPLE CONDITION (IF ... THEN)  

You can use the key words You can use the key words If...ThenIf...ThenIf...ThenIf...Then to encapsulate one or more conditions. Depending on the results, different actions are  to encapsulate one or more conditions. Depending on the results, different actions are 
performed. The conditions can be combined by using the three operators And, Or and Xor (see the chapter performed. The conditions can be combined by using the three operators And, Or and Xor (see the chapter Equilla OperatorsEquilla Operators). ). 

//No subchart 

Meta: 

Subchart( false ); 

 

//A list with two input parameters is declared 

 

Inputs:  

commodities( Silver, Gold ); 

 

//Query if the first list entry is selected 

If Commodities = 0 Then 

Print( "Silver price rises." ) 

Else //If not selected, the alternative is processed 

Print( "Gold price rises." ); 

CONDITIONS WITH BRANCHING (IF...THEN...ELSE)CONDITIONS WITH BRANCHING (IF...THEN...ELSE)  

By entering an alternative command, your script can react to met and not met conditions likewise. When testing several cases at By entering an alternative command, your script can react to met and not met conditions likewise. When testing several cases at 
once, it is sensible to process them within the same context.once, it is sensible to process them within the same context.  
  

//No subchart 

Meta: 

Subchart( false ); 

 

//A list with three input parameters is declared 
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Inputs:  

commodities( Silver, Gold, Platin ); 

 

//Query if the first list entry is selected 

If Commodities = 0 Then 

Print( "Silver price rises." ) 

Else //If not selected, the alternative is processed 

Print( "Gold price rises." ); 

 

//Query if the first list entry is selected 

If Commodities = 0 Then 

Print( "Silver price rises." ) 

Else If Commodities = 1 Then //If not selected, the second alternative is checked 

Print( "Gold price rises." ) 

Else //Is it not selected, only the last possibility is left.  

Print( "Platin price rises." ); 

 

  
  
Please note that the line before the Else statement must not end with a semiPlease note that the line before the Else statement must not end with a semi--colon.colon.

NESTED CONDITIONSNESTED CONDITIONS  

You can put several statements into a block and nest queries. The following example shows how to write beginYou can put several statements into a block and nest queries. The following example shows how to write begin--end blocks and end blocks and 
nested conditions.nested conditions.  

//Important, this is not a working program. Do not attempt  

//to compile it in the editor. 

//We check the cucumber and want to buy a really fresh one only  

If cucumber = green Then 

Begin  

//The color meets our first condition, but is it also fresh? 

If ( cucumber = fresh ) Then  

Begin 

//The cucumber is fresh, we use it 

"Cut in slices"; 

"Add tomato slices"; 

"Add dressing"; 

//If it's Friday, add garlic 

If Today = Friday Then 

"Put lots of garlic in the dressing" 

Else //If it's not Friday, do not use garlic 

"Skip garlic"; 

End 
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Else //The cucumber was too soft and squashy, we try to buy another one. 

"Drive to another store"; 

End; 



:: www.tradesignal.comwww.tradesignal.com

Tradesignal GmbHTradesignal GmbH Page 326Page 326 Version 7.0Version 7.0

EQUILLA QUOTATIONS AND TIME PERIODS 
This entry is about quotations that are delivered by the provider and that you need as input values for the calculation of functions, This entry is about quotations that are delivered by the provider and that you need as input values for the calculation of functions, 
indicators and strategies. It also offers information on working with date and time date. In the end, you can find information and indicators and strategies. It also offers information on working with date and time date. In the end, you can find information and 
examples on how to find distinct bars in a chart.examples on how to find distinct bars in a chart.  
  
For all Equilla functions, you can find additional information in Tradesignal. To call it up, open the source code in the For all Equilla functions, you can find additional information in Tradesignal. To call it up, open the source code in the Equilla Equilla 
EditorEditor. Then right. Then right--click on the function in question, e.g. click on the function in question, e.g. AcceleratorAccelerator, and choose , and choose Lookup Equilla FunctionLookup Equilla FunctionLookup Equilla FunctionLookup Equilla Function from the context menu.  from the context menu. 
A window opens with information on the function and links to related functions.A window opens with information on the function and links to related functions.

DATA IN QUOTATION SERIESDATA IN QUOTATION SERIES  

The most important data needed for indicators are the quotations. These are delivered by the data provider and can be displayed in The most important data needed for indicators are the quotations. These are delivered by the data provider and can be displayed in 
a chart. In addition, you can use external quotations from locally saved files in Tradesignal. From most providers, you will receive a chart. In addition, you can use external quotations from locally saved files in Tradesignal. From most providers, you will receive 
the following data:the following data:

l OpenOpenOpenOpen  -- Opening price for each trading period Opening price for each trading period  
l HighHighHighHigh  -- High price for each trading period High price for each trading period  
l LowLowLowLow  -- Low price for each trading period Low price for each trading period  
l CloseCloseCloseClose  -- Closing price for each trading period Closing price for each trading period  
l VolumeVolumeVolumeVolume  -- Trading volume for each trading period Trading volume for each trading period  
l Open InterestOpen InterestOpen InterestOpen Interest  -- Open interest in the case of futures Open interest in the case of futures  

PARTICULARITIES OF VOLUME DATAPARTICULARITIES OF VOLUME DATA  

Two different definitions of trading volume are in existence, which are often confused.Two different definitions of trading volume are in existence, which are often confused.  

l The more meaningful definition is that the trading volume is given by the The more meaningful definition is that the trading volume is given by the number of traded stocks multiplied with its traded number of traded stocks multiplied with its traded 
priceprice. This way, the volume represents the amount of capital that was traded in the period.. This way, the volume represents the amount of capital that was traded in the period.  

l Differing from this, sometimes the trading volume is only given as Differing from this, sometimes the trading volume is only given as turnover in traded piecesturnover in traded pieces. This means only the number of . This means only the number of 
traded stocks is taken as volume, without information on the traded prices. The problem is that in this case, 100 stocks at traded stocks is taken as volume, without information on the traded prices. The problem is that in this case, 100 stocks at 
0.20 cents would yield the same volume as 100 stocks traded at $164.40. The number of pieces does not represent the 0.20 cents would yield the same volume as 100 stocks traded at $164.40. The number of pieces does not represent the 
capital used for the trades.capital used for the trades.  

Make sure to ask your data provider which kind of volume data is delivered. Depending on the volume interpretation, indicator data Make sure to ask your data provider which kind of volume data is delivered. Depending on the volume interpretation, indicator data 
and statistics have to be adapted or put into perspective.and statistics have to be adapted or put into perspective.

EXAMPLE: USING QUOTATIONS SERIES WITHOUT VOLUMEEXAMPLE: USING QUOTATIONS SERIES WITHOUT VOLUME  

/* The following example demonstrates the usage of quotations series without volume. Four 

variables are declared which will be used for each of the quotation series. Following this, 

an average is calculated for each series, saved in the variables and displayed as a 

candlestick chart in a new window. Remember that Equilla scripts are processed once for each 
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trading period. */ 

 

Meta: 

Subchart ( true );  

 

//The trading period for the average calculation is declared as input. 

//You can later edit the value in the properties of the indicator. 

 

Inputs:  

Period( 10, 1 ); 

 

//Variables are declared  

 

Variables:  

myOpenValue, myCloseValue, myLowValue, myHighValue, 

avgOpen, avgClose, avgLow, avgHigh; 

 

//Day for day is processed. For each trading day, the price is assigned to  

//the variables. 

myOpenValue = Open; 

myCloseValue = Close; 

myLowValue = Low; 

myHighValue = High; 

 

/* Now the average calculation follows, which is done once per trading day. The passing of 

the quotations to the calculation functions is especially complicated to demonstrate the 

underlying principle. Alternatively, you can pass the quotations to the functions directly. 

avgOpen = Average ( Open, Period ); avgClose = Average ( Close, Period ); avgLow = Average 

( Low, Period ); avgHigh = Average ( High, Period ); */ 

 

avgOpen = Average ( myOpenValue , Period ); 

avgClose = Average ( myCloseValue, Period ); 

avgLow = Average ( myLowValue, Period ); 

avgHigh = Average ( myHighValue, Period ); 

 

//With the result of the average calculations 

//candlesticks are drawn 

DrawCandleStick( avgOpen, avgHigh, avgLow, avgClose, Yellow, Red, DarkBlue ); 

 

INLINE INSTRUMENTS AND DATA INPUTSINLINE INSTRUMENTS AND DATA INPUTS  

Indicators can be used for more than just the quotations of a single basic symbol in the chart. Many indicators use the quotation Indicators can be used for more than just the quotations of a single basic symbol in the chart. Many indicators use the quotation 
series of more than one stock. The same applies to strategies, many of which are based on several symbols or different quotation series of more than one stock. The same applies to strategies, many of which are based on several symbols or different quotation 
series. For these calculations, the tools Inline Instruments and Data Inputs are available. series. For these calculations, the tools Inline Instruments and Data Inputs are available. 
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INLINE INSTRUMENTSINLINE INSTRUMENTS  

An inline instrument is a reference to the stock data which is used directly An inline instrument is a reference to the stock data which is used directly 
in the source code. You have to give the symbol and the relevant quotation in the source code. You have to give the symbol and the relevant quotation 
series. The following example calculates the difference between the series. The following example calculates the difference between the 
quotations of Puma and Adidas Salomon. The result is displayed in a quotations of Puma and Adidas Salomon. The result is displayed in a 
candlestick chart. It does not matter to which chart you apply this indicator candlestick chart. It does not matter to which chart you apply this indicator 
-- it always uses the given quotations of those two companies. Therefore,  it always uses the given quotations of those two companies. Therefore, 
inline instruments can be used for calculation with quotations that are not inline instruments can be used for calculation with quotations that are not 
a part of the current chart or portfolio.a part of the current chart or portfolio.  
  

//Generate a subchart 

Meta: 

Subchart( true ); 

 

//Declare variables 

Variables:  

openValue, highValue, lowValue, closeValue; 

 

/* Subtract the time series. By giving the symbol in the series, quotations can be used that 

are not part of the current chart. */ 

openValue = Open of 'pum ger' ­ Open of 'ads ger'; 

highValue = High of 'pum ger' ­ High of 'ads ger'; 

lowValue = Low of 'pum ger' ­ Low of 'ads ger'; 

closeValue = Close of 'pum ger' ­ Close of 'ads ger'; 

 

//Display result as candlesticks 

DrawCandleStick( openValue, highValue, lowValue, closeValue, White, Red, Black ); 

DYNAMIC INLINE INSTRUMENTSDYNAMIC INLINE INSTRUMENTS  

Tradesignal 6 offers you the ability to create inline instruments based on runtime information, e.g. the string inputs of an indicator Tradesignal 6 offers you the ability to create inline instruments based on runtime information, e.g. the string inputs of an indicator 
or strategy may be used instead of a constant string expression.or strategy may be used instead of a constant string expression.  
  
See the See the Equilla Formula LanguageEquilla Formula LanguageEquilla Formula LanguageEquilla Formula Language reference entry  reference entry InstrumentsInstrumentsInstrumentsInstruments in Tradesignal for more details on importing symbols. in Tradesignal for more details on importing symbols.  
  

//Import a single instrument and reference it in the script by using DrawLine on its 

variable 

Input:  

Symbol( "" ); 

 

Instruments:  

Using Inline InstrumentsUsing Inline Instruments
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mySymbol( Symbol ); 

 

DrawLine( mySymbol ); 

  
  
You can also create a list of inline instruments and reference any of the symbols in the list via its index which starts at zero.You can also create a list of inline instruments and reference any of the symbols in the list via its index which starts at zero.  
  

//Import a list of instruments and calculate the average price 

Input:  

ListSymbol( "" ); 

 

Instruments:  

myInstruments( List( ListSymbol ) ); 

 

Variables:  

prices( 0 ), i( 0 ); 

 

prices = 0; 

 

For i = 0 to Len( myInstruments ) ­ 1 Begin 

prices = prices + Close of myInstruments( i ); 

End; 

 

If Len( myInstruments ) != 0 Then 

DrawLine( prices / Len( myInstruments ), "Average" ); 

DATA INPUTSDATA INPUTS  

With data inputs, you can access different quotation series or other data in With data inputs, you can access different quotation series or other data in 
the chart or portfolio. The only condition is that those series are available the chart or portfolio. The only condition is that those series are available 
in the same chart or portfolio during runtime. For example, you can write an in the same chart or portfolio during runtime. For example, you can write an 
indicator displaying the spread between two time series without defining indicator displaying the spread between two time series without defining 
beforehand to which symbols the series belong. You simply start a chart beforehand to which symbols the series belong. You simply start a chart 
with two symbols and then apply the indicator. with two symbols and then apply the indicator.   
  
To recreate the indicator from above with data inputs instead of input To recreate the indicator from above with data inputs instead of input 
instruments, create a chart with Puma AG and Adidas Salomon AG. Now instruments, create a chart with Puma AG and Adidas Salomon AG. Now 
enter a new indicator. The quotations are used as data inputs. The first enter a new indicator. The quotations are used as data inputs. The first 
quotation series is referred to as "Data1", the second as "Data2" etc. Since up to twelve symbols can be displayed in a chart, you quotation series is referred to as "Data1", the second as "Data2" etc. Since up to twelve symbols can be displayed in a chart, you 
can enter up to 12 data inputs. can enter up to 12 data inputs. 

//Generate subchart 

Meta: 

Using Data Inputs in a ChartUsing Data Inputs in a Chart
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Subchart(true); 

 

//Using the data input parameters for the spread 

DrawCandleStick( Open of Data1 ­ Open of Data2, 

High of Data1 ­ High of Data2, 

Low of Data1 ­ Low of Data2,  

Close of Data1 ­ Close of Data2,  

white, red, black); 

DATE AND TIME FOR QUOTATION SERIESDATE AND TIME FOR QUOTATION SERIES  

The information is delivered with the price data, online or in files. For correct display of quotations, date and time are necessary. The information is delivered with the price data, online or in files. For correct display of quotations, date and time are necessary. 
This information is also often necessary for other functions, e.g. to recognize day changeThis information is also often necessary for other functions, e.g. to recognize day change--overs or certain days of time.overs or certain days of time.

HOW A CHART IS DRAWNHOW A CHART IS DRAWN  

The quotations are displayed linearly, from the first period (in the past) to the last. Usually, this is the current day or hour, The quotations are displayed linearly, from the first period (in the past) to the last. Usually, this is the current day or hour, 
depending on the time base of the chart. Within an Equilla script, the navigation is done with the consecutive number of the period depending on the time base of the chart. Within an Equilla script, the navigation is done with the consecutive number of the period 
(not the date or time). Therefore, if you want to use the close price of three days ago in your indicator, you need to(not the date or time). Therefore, if you want to use the close price of three days ago in your indicator, you need to write the script  write the script 
so that is goes three periods back in time. so that is goes three periods back in time.   
  
The date cannot be used for this kind of navigation. You cannot retrieve data such as price or volume with a date. However, you The date cannot be used for this kind of navigation. You cannot retrieve data such as price or volume with a date. However, you 
can read the date and time of each period for other uses, for example the output of date and time of certain price levels in a chart. can read the date and time of each period for other uses, for example the output of date and time of certain price levels in a chart. 

WHICH DATA IS OFFERED BY TRADESIGNAL?WHICH DATA IS OFFERED BY TRADESIGNAL?  

l DateDateDateDate  -- The date for the current period as numeric value: 1060609 ( this is the 09.06.2006 ) The date for the current period as numeric value: 1060609 ( this is the 09.06.2006 )  
l TimeTimeTimeTime  -- The time of the current period as numeric value: 1645 ( this is 16:45 ) The time of the current period as numeric value: 1645 ( this is 16:45 )  
l DateTimeDateTimeDateTimeDateTime  -- A combined expression that is already formatted: 2006/07/05 17:25:00.000 ( this is the 05.07.2006 1725) A combined expression that is already formatted: 2006/07/05 17:25:00.000 ( this is the 05.07.2006 1725)  

Extracting the data with code:Extracting the data with code:

//Date of the current trading day in a daily chart 

Variables:  

myDate; 

 

myDate = Date 

 

//In the output window, the date for each trading day in the chart 

//is displayed continuously.  

Print( myDate ); 
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//Time of the current period in an intraday chart  

Variables:  

myTime; 

 

myTime= Time; 

 

//In the output window, the time for each trading period in the chart 

//is displayed continuously.  

Print( myTime); 

FUNCTIONS FOR FORMATTING AND WORKING WITH DATE AND TIMEFUNCTIONS FOR FORMATTING AND WORKING WITH DATE AND TIME  

Above, the three basic time series for date and time are given. These data can be read for every period and be used further. In the Above, the three basic time series for date and time are given. These data can be read for every period and be used further. In the 
example above, the date and time were read and printed in the output window. However, it is often necessary to find out single example above, the date and time were read and printed in the output window. However, it is often necessary to find out single 
components of the date, for example the day of week, the calendar month or the current year. You may also want to use the given components of the date, for example the day of week, the calendar month or the current year. You may also want to use the given 
date and time values in another format than the one offered by the system.date and time values in another format than the one offered by the system.

FUNCTIONS FOR SPLITTING DATE AND TIMEFUNCTIONS FOR SPLITTING DATE AND TIME  

The following functions are not a complete list of all available functions. Only the most important ones are listed.The following functions are not a complete list of all available functions. Only the most important ones are listed.  
  
For returning date components, you can use the simple functions For returning date components, you can use the simple functions Year(date)Year(date), , Month (date)Month (date) etc. When entering "now" for the date,  etc. When entering "now" for the date, 
the current date is used. the current date is used.   
  
Instead of Instead of dayday, the function , the function DayOfMonthDayOfMonth can be used. can be used.  
  

//Example: Write the components of the current date and time to the output window: 

If IsLastBar Then 

Begin 

ClearDebug(); 

Print( "Year=" + CStr( Year( Now ) ) ); 

Print( "Month=" + CStr(Month( Now ) ) ); 

Print( "Day=" + CStr( Day( Now ) ) );  

Print( "Hour=" + CStr( Hour( Now ) ) ); 

Print( "Minute=" + CStr( Minute( Now ) ) ); 

Print( "Second=" + CStr( Second( Now ) ) ); 

Print( "MilliSecond=" + CStr( MilliSecond( Now ) ) ); 

End; 

  
  
To return parts of the To return parts of the DateTimeDateTime, the function , the function DatePartDatePart has to be used, defined as  has to be used, defined as DatePart( DateInterval, DateTime )DatePart( DateInterval, DateTime ). For the . For the 
definition of definition of DateTimeDateTime, see above. , see above.   
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The The DateIntervalDateInterval is a numeric constant representing a certain part of the DateTime. It is always constructed with a leading  is a numeric constant representing a certain part of the DateTime. It is always constructed with a leading IntervalInterval  
followed by a date or time expression.followed by a date or time expression.  
  

  
  

//Example: Write a date or time part to the output window: 

 

Input:  

Interval( iYear, iMonth, iDay, iHour, iMinute, iSecond ); 

 

Variables:  

name, part; 

 

If Interval = iYear Then Begin 

name = "Year"; 

part = Interval_Year; 

End Else If Interval = iMonth Then Begin 

name = "Month"; 

part = Interval_Month; 

End Else If Interval = iDay Then Begin 

name = "Day"; 

part = Interval_Day; 

End Else If Interval = iHour Then Begin 

name = "Hour"; 

part = Interval_Hour; 

End Else If Interval = iMinute Then Begin 

name = "Minute"; 

part = Interval_Minute; 

End Else If Interval = iSecond Then Begin 

name = "Second"; 

part = Interval_Second; 

End; 

 

IntervalIntervalIntervalInterval TimeTimeTimeTime
Interval_YearInterval_Year YearYear
Interval_MonthInterval_Month Month of Year (1Month of Year (1--12)12)
Interval_DayInterval_Day  
Interval_DayOfMonthInterval_DayOfMonth

Day of Month (1Day of Month (1--31)31)  
Day of Month (1Day of Month (1--31)31)

Interval_DayOfWeekInterval_DayOfWeek Day of Week (0Day of Week (0--6)6)
Interval_DayOfYearInterval_DayOfYear Day of Year (1Day of Year (1--365)365)
Interval_HourInterval_Hour HoursHours
Interval_MinuteInterval_Minute MinutesMinutes
Interval_SecondsInterval_Seconds SecondsSeconds
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Print( name + "=" + CStr( DatePart( part, DateTime ) ) ); 

FUNCTIONS FOR FORMATTING DATE AND TIME DATAFUNCTIONS FOR FORMATTING DATE AND TIME DATA  

The basic date and time entries are dry figures. The DateTime component The basic date and time entries are dry figures. The DateTime component 
is also not formatted according to European standard. To allow you to is also not formatted according to European standard. To allow you to 
generate various date and time formats, complex formatting functions are generate various date and time formats, complex formatting functions are 
available. Two important ones are described here. available. Two important ones are described here.   
  

/* With the following function, you can format a date 

so that it includes the full name of the month. The 

function has the DateTime parameter as input. The 

formatting possibilities are quite unlimited. */ 

 

//No subchart; output in the main chart 

Meta: 

Subchart ( false ); 

 

//Declaring variables for date and day 

Variables:  

myDate, myDay; 

 

//Reformatting the date, for example to 

myDate = FormatDate ( DateTime, "dd/mm/yyyy"); 

 

//Here the day is read 

myDay = DayOfWeek ( Date ); 

 

//Check if it is Monday ­ if yes, the text is  

//output in the chart 

if myDay = 1 Then 

DrawText ( High + Range(), "Monday", "Monday," + mydate, 10, blue ); 

 

  
  

/* The following function is similar to the FormatDate function. It serves for formatting 

the time data in user­defined formats. It is recommended to take a look at the Equilla help 

for further information. */ 

 

//No subchart; output in the main chart 

Meta: 

Subchart( false) ;  

 

Recognize MondayRecognize Monday

Display the time in a chartDisplay the time in a chart
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//Declaring the variables for time and the formatted time 

Variables:  

myTime, myFormatTime; 

 

//Here the time is read 

myTime = Time; 

 

//Here the time is reformatted with a separator 

myFormatTime = FormatTime( DateTime, "hh:mm"); 

 

//At five past nine, a message is displayed in the chart 

If Time = 0905 Then  

DrawText ( High + Range(); "Good morning!", "It is " +myFormatTime, 

10, blue); 

 

//At one o'clock, it's time for the lunch break 

If Time = 1300 Then 

DrawText ( High + Range(); "Lunch time!", "Go and have something to eat, it is " 

+myFormatTime, 10, blue); 

 

//At half past five, it's time for knocking off 

If Time = 1730 Then 

DrawText ( High + Range(); "Bye!", "Call it a day, it is " +myFormatTime,  

10, blue); 

INFORMATION ABOUT SPECIFIC PERIODS AND BARSINFORMATION ABOUT SPECIFIC PERIODS AND BARS  

In In Equilla Graphs, Outputs and AlertsEquilla Graphs, Outputs and Alerts you can find information on how the  you can find information on how the 
navigation in a chart can be controlled by an Equilla script. Reference navigation in a chart can be controlled by an Equilla script. Reference 
values are used that can also be interpreted as step sizes. Much as in a values are used that can also be interpreted as step sizes. Much as in a 
game, where a figure makes 6 steps forwards or backwards, the program game, where a figure makes 6 steps forwards or backwards, the program 
navigates through the time series. navigates through the time series. 

//Reading the date of three days ago 

myPrevDate = Date[ 3 ]; 

 

//Reading the close price of five days ago 

myPrevClose = Close[ 5 ]; 

  
  
From each period in a chart, you have access to all other data and prices in the chart by going back or forward in the data. To do so, From each period in a chart, you have access to all other data and prices in the chart by going back or forward in the data. To do so, 
some useful functions are available in Tradesignal, which can be used with Equilla.some useful functions are available in Tradesignal, which can be used with Equilla.  

Displaying continuous bar numbersDisplaying continuous bar numbers
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/* The parameter 'CurrentBar' gives the reference number of the current period The number is 

listed consecutively, as can be seen in the chart. */ 

 

//Output to be done in the main chart 

Meta: 

Subchart( false ); 

 

Variables:  

myBarNum; 

 

//The numeric value CurrentBar is converted into a string 

myBarNum = CStr( CurrentBar ); 

 

DrawText( High + Range(), "Bar numbers", myBarNum, 10, blue); 

  
  
For many applications it is important to execute a specific action at the very beginning or ending of a chart. For example, variables For many applications it is important to execute a specific action at the very beginning or ending of a chart. For example, variables 
are often set at the first bar. Two important functions are offered by Tradesignal for this purpose.are often set at the first bar. Two important functions are offered by Tradesignal for this purpose.

l With the first function, you can read out how many bars (periods, candlesticks) are loaded in the chart.With the first function, you can read out how many bars (periods, candlesticks) are loaded in the chart.  
l With the second function, a flag is set which is "true" when the last bar is reached.With the second function, a flag is set which is "true" when the last bar is reached.  

//We set two variables at the first bar 

Variables:  

myEntryCondition, myExitCondition, myBarNums;  

 

//We look for the first bar  

If CurrentBar = 1 Then 

Begin 

myEntryCondition = false; 

myExitCondition = false; 

End; 

/* We look for the last bar. This time we use the number of total bars in the chart which we 

get with the variable 'LastBar'. */ 

 

If CurrentBar = LastBar Then 

Begin 

myBarNums = LastBar; 

Print ( myBarNums ); 

End; 

 

//To find the last bar, you can also use the  

//function 'IsLastBar' which is a boolean. 
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If isLastBar = True Then 

Begin 

myBarNums = LastBar; 

Print ( myBarNums ); 

End; 

  
  
Last not least it is often important to know the current time base of the indicator. For this, the constant "TimeBase" is available. Last not least it is often important to know the current time base of the indicator. For this, the constant "TimeBase" is available. 
With it you get the number of seconds spanned by each bar. With some mathematics, we can quickly find out if the indicator is in With it you get the number of seconds spanned by each bar. With some mathematics, we can quickly find out if the indicator is in 
a day chart or one with a five minute span. a day chart or one with a five minute span.   
  

Variables:  

outputString(""); 

 

If CurrentBar = 1 Then 

Begin 

//Checking for a day chart 

if TimeBase = 86400 Then 

outputString="d";  

//Checking for a one hour time base  

if TimeBase = 3600 Then 

outputString="1h";  

//Checking for a five minute time base 

if TimeBase = 300 Then 

outputString="5m";  

//Checking for a one minute time base 

if TimeBase = 60 Then 

outputString="1m";  

End; 

 

//At the last bar, the output is written 

//into the output window 

If isLastBar Then 

Print ( outputString ); 
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EQUILLA GRAPHS, OUTPUTS AND ALERTS 
There are several ways to offer data, calculation results, symbols and reports to the users. One of the most important functions is There are several ways to offer data, calculation results, symbols and reports to the users. One of the most important functions is 
the graphic display of indicators and other information. Tradesignal offers output functions for text and reports and an alert function. the graphic display of indicators and other information. Tradesignal offers output functions for text and reports and an alert function. 
  
  
For all Equilla operators, you can find additional information in Tradesignal. To display it, open the source code in the For all Equilla operators, you can find additional information in Tradesignal. To display it, open the source code in the Equilla Equilla 
EditorEditor. Then right. Then right--click on the operator in question, e.g. click on the operator in question, e.g. BeginBegin, and choose , and choose Lookup Equilla FunctionLookup Equilla FunctionLookup Equilla FunctionLookup Equilla Function from the context menu. A  from the context menu. A 
window opens with information on the operators and links to related functions.window opens with information on the operators and links to related functions.

DRAWING LINES, AREAS, SYMBOLS OR TEXT IN A CHARTDRAWING LINES, AREAS, SYMBOLS OR TEXT IN A CHART  

With the drawing statements, usually indicators and graphs related to them are generated. An indicator usually consists of a line or With the drawing statements, usually indicators and graphs related to them are generated. An indicator usually consists of a line or 
histogram. Some indicators also use filled areas or symbols or offer information as text. histogram. Some indicators also use filled areas or symbols or offer information as text.   
  
In this chapter, you can find general information on using colors, line width, symbols and their most important applications. When In this chapter, you can find general information on using colors, line width, symbols and their most important applications. When 
you enter a drawing statement in the editor, you can find all parameters and their sequence in the tooltip. Parameters that are not you enter a drawing statement in the editor, you can find all parameters and their sequence in the tooltip. Parameters that are not 
mandatory are labeled with "optional". mandatory are labeled with "optional". 

BASICS OF DRAWING STATEMENTSBASICS OF DRAWING STATEMENTS  

Here you can find information on using drawing statements, why they should have captions and how the displacement function can Here you can find information on using drawing statements, why they should have captions and how the displacement function can 
be used to move the graphic display in the timeline. The most important parameters are given.be used to move the graphic display in the timeline. The most important parameters are given.

CAPTIONSCAPTIONS  

A caption should be entered for each statement. This is especially useful when several drawing statements are used in the same A caption should be entered for each statement. This is especially useful when several drawing statements are used in the same 
chart. The captions have two important functions:chart. The captions have two important functions:

l The drawing statements are more easily identified in the property inspector.The drawing statements are more easily identified in the property inspector.  
l In the tooltips and the target cursor mode in the chart, values are displayed for all graphic objects under the cursor. The In the tooltips and the target cursor mode in the chart, values are displayed for all graphic objects under the cursor. The 

value interpretation is easier when the drawing statements are named.value interpretation is easier when the drawing statements are named.  

If no caption is given, each drawing statement is labeled with "Plot" and a consecutive number.If no caption is given, each drawing statement is labeled with "Plot" and a consecutive number.

DISPLACEMENTDISPLACEMENT  
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Equilla scripts are executed once per bar. By using soEquilla scripts are executed once per bar. By using so--called displacements, called displacements, 
for example "Price[i]", you can retrieve older function results. In a similar for example "Price[i]", you can retrieve older function results. In a similar 
way, drawing statements can be displaced. For this, the Displacement way, drawing statements can be displaced. For this, the Displacement 
parameter has to be added directly after the statement. Enter a positive parameter has to be added directly after the statement. Enter a positive 
value in square brackets [ ] to move it into the past, and a negative value to value in square brackets [ ] to move it into the past, and a negative value to 
move it into the future.move it into the future.  
  
Example for a displacement:Example for a displacement:

// Generate no subchart 

Meta: 

Subchart( false ); 

 

//Execute at last bar 

If isLastBar Then 

Begin 

DrawSymbol[3] (Low[3], "Past", SymbolSquare, 30, black, blue ); 

DrawSymbol[­3] (Low, "Future", SymbolSquare, 30, black, blue ); 

End; 

PARAMETERSPARAMETERS  

For all drawing statements, optional parameters can be specified. These are caption, line width, symbol size, colors etc. These For all drawing statements, optional parameters can be specified. These are caption, line width, symbol size, colors etc. These 
parameters can be given by variables which can be changed at runtime (see some of the examples below). Feel free to experiment parameters can be given by variables which can be changed at runtime (see some of the examples below). Feel free to experiment 
with the options.with the options.    
  
Especially interesting is using dynamic color values. Each component of the color values of RGB and HSV modes can be changed. Especially interesting is using dynamic color values. Each component of the color values of RGB and HSV modes can be changed. 
The opacity can also be set. The opacity can also be set.   
  
Design parameters like line or symbols styles can also be entered numerically. However, while this saves space, the full parameter Design parameters like line or symbols styles can also be entered numerically. However, while this saves space, the full parameter 
names are easier to read and remember.names are easier to read and remember.

DRAWING STATEMENTS AND SYNTAXDRAWING STATEMENTS AND SYNTAX  

Below, the most commonly used drawing statements and their syntax are listed. In the thumbnails, screenshots with graphs and Below, the most commonly used drawing statements and their syntax are listed. In the thumbnails, screenshots with graphs and 
source code are given.source code are given.

DRAWLINE ( )DRAWLINE ( )  

Displacement exampleDisplacement example
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With this statement, a line is drawn. Style, size and color can be specified. With this statement, a line is drawn. Style, size and color can be specified. 
Constant values or definable parameters (e.g. results or calculations) can Constant values or definable parameters (e.g. results or calculations) can 
be used.be used.    
  

DrawLine[ Displacement ]( Value, "caption", Style, 

LineWidth, Color );  

  
  
Example for a sine curve:Example for a sine curve:

// Generate subchart 

Meta: 

Subchart( true ); 

 

//Declare variables 

Variables:  

mySinValue, counter; 

 

//Assign a value to the variable 

mySinValue = Sin(counter); 

counter = counter + 1; 

 

//Draw the values as a solid red 2 pixel line 

DrawLine( mySinValue, "Sinus", StyleSolid,2, Red ); 

DRAWFOREST ( )DRAWFOREST ( )  

With this statement, a forest graph (histogram) is drawn. Typically the start With this statement, a forest graph (histogram) is drawn. Typically the start 
value is the base line. The color, start and end point of needles can be value is the base line. The color, start and end point of needles can be 
specified. This way, not only can indicators be drawn but the forest can specified. This way, not only can indicators be drawn but the forest can 
also be used for generating grids.also be used for generating grids.    
  

DrawForest[ Displacement ]( StartValue, EndValue, 

"caption1", "caption2",  

NeedleSize, NeedleColor, LinkForest True/False ); 

  
  
Example for an indicator displayed as forest:Example for an indicator displayed as forest:

// Generate no subchart 

Meta: 

Subchart( false ); 

 

Line exampleLine example

Forest exampleForest example
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Inputs:  

Period( 20, 1 ); 

 

//Declare variables  

Variables:  

myOwnIndicator; 

 

//Create the indicator 

myOwnIndicator = RSI ( Momentum (Close, Period), 5 ); 

 

//Display indicator as forest 

DrawForest( 0, myOwnIndicator, "Basis", "MEI", thick, blue, false ); 

DRAWAREA ( )DRAWAREA ( )  

With this statement, an area is drawn between two values of the scale.With this statement, an area is drawn between two values of the scale.  
Colors and opacity can be set.Colors and opacity can be set.  

DrawArea[ Displacement ]( Value1, Value2, "caption1", 

"caption2", FillColor,  

LineColor1, LineColor2 );  

  
  
Example for drawing an area with color gradient:Example for drawing an area with color gradient:

// Generate a subchart 

Meta: 

Subchart( true ); 

 

//Declare variables 

Variables:  

counter, colorValue; 

 

//Change the counter in a loop  

if counter <= 254 then 

counter = counter + 1; 

 

//Reset the counter at 255 

Else  

counter = 0; 

 

//Set the RGB color value with a dynamic value. 

 

Area exampleArea example
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colorValue = RGB( counter, 150, 150 ); 

 

//Set opacity. 

 

colorValue = TransparentColor ( colorValue, counter ); 

 

//Draw the area between the positive and negative values of 

//'counter', with black border lines.  

 

DrawArea( counter, Neg( counter ), "Up", "Down", colorValue, Black, Black); 

DRAWSYMBOL ( )DRAWSYMBOL ( )  

With this statement, symbol charts with circles, start, dots, triangles etc. With this statement, symbol charts with circles, start, dots, triangles etc. 
can be drawn. The size and colors can be controlled dynamically. can be drawn. The size and colors can be controlled dynamically. 

DrawSymbol[ Displacement ]( Value, "caption", 

SymbolStyle, SymbolSize,  

SymbolBorderColor, SymbolFillColor );  

  
  
Example for drawing triangles (pointing up or down, depending on the Example for drawing triangles (pointing up or down, depending on the 
curves):curves):

// Generate no subchart 

Meta: 

Subchart( false ); 

 

//Declare input 

Inputs:  

Period( 20, 1 ); 

 

//Declare variables 

Variables:  

avgValue; 

 

//Calculate the average close price  

avgValue = XAverage ( Close, Period ); 

 

//Display an triangle pointing upward, if  

//the price crosses above the average. 

If Close Crosses over avgValue Then 

DrawSymbol( High, "CrossUp", SymbolTriangleUp, 20, black, darkgreen); 

 

Symbols exampleSymbols example
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//Display an triangle pointing downward, if  

//the price crosses below the average. 

If Close Crosses under avgValue Then 

DrawSymbol( Low, "CrossUp", SymbolTriangleDown, 20, black, darkgreen); 

 

//The average itself is displayed as line. 

DrawLine( avgValue, "Average", StyleSolid, 2, black ); 

DRAWTEXT ( )DRAWTEXT ( )  

With this statement, text is output. Variables like font size, color, style etc. With this statement, text is output. Variables like font size, color, style etc. 
can be specified. can be specified. 

DrawText[ Displacement ]( Value, "caption", 

textoutput, FontSize, FontColor,  

FontStyle, URL );  

  
  
Example for text output:Example for text output:

//Generate no subchart 

Meta: 

Subchart( false ); 

 

//Declare input 

Inputs:  

Period( 10, 1 ); 

 

//Declare variables 

Variables:  

avgValue; 

 

//Calculate the average close price  

avgValue = WAverage ( Close, Period ); 

 

//When the average turns up, text is added to the  

//Low of the last day.  

If TurnsUp( avgValue, 2, 1 ) Then 

DrawText[1]( Low[1], "Up", "Bottom", 10, Darkgreen);  

 

//When the average turns down, text is added to the  

//High of the last day.  

If TurnsDown( avgValue, 2, 1 ) Then 

DrawText[1]( High[1], "Down", "Top", 10, Red );  

Output text exampleOutput text example



:: www.tradesignal.comwww.tradesignal.com

Tradesignal GmbHTradesignal GmbH Page 343Page 343 Version 7.0Version 7.0

DRAWBAR ( )DRAWBAR ( )  

With this statement, a bar chart is drawn. Each of the four values With this statement, a bar chart is drawn. Each of the four values -- open,  open, 
high, low, close high, low, close -- can be chosen freely. This way, indicators can also be  can be chosen freely. This way, indicators can also be 
drawn as bars.drawn as bars.  
  
In this statement no caption needs to be specified, as it can only be used In this statement no caption needs to be specified, as it can only be used 
once in each script. once in each script. 

DrawBar[ Displacement ]( Open, High, Low, Close, 

BullishColor, BearishColor )  

  
  
Example for modified OHLC values as bars (Heikin Ashi method):Example for modified OHLC values as bars (Heikin Ashi method):

//Generate a subchart 

Meta: 

Subchart( true ); 

 

//Declare input 

Inputs:  

Period( 14, 1 ); 

 

//Declare variables 

Variables:  

avgOpen, avgHigh, avgLow, avgClose; 

 

//Calculate the average for all quotes.  

avgOpen = XAverage( Open, Period );  

avgHigh = XAverage( High, Period );  

avgLow = XAverage( Low, Period );  

avgClose = XAverage( Close, Period );  

 

//Display bars. 

DrawBar ( avgOpen, avgHigh, avgLow, avgClose, DarkGreen, Red ); 

DRAWCANDLESTICK ( )DRAWCANDLESTICK ( )  

Bar chart exampleBar chart example
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With this statement, a candlestick chart is drawn. Each of the four values With this statement, a candlestick chart is drawn. Each of the four values --  
open, high, low, close open, high, low, close -- can be set freely. This way, indicators can also be  can be set freely. This way, indicators can also be 
drawn as candlesticks. drawn as candlesticks.   
  
In this statement no caption needs to be specified, as it can only be used In this statement no caption needs to be specified, as it can only be used 
once in each script. once in each script. 

DrawCandleStick[ Displacement ]( Open, High, Low, 

Close, BullishColor, BearishColor,  

BorderColor ) 

  
  
Example for modified OHLC display as candlesticks (Heikin Ashi method):Example for modified OHLC display as candlesticks (Heikin Ashi method):

//Generate a subchart 

Meta: 

Subchart( true ); 

 

//Declare input 

Inputs:  

Period( 14, 1 ); 

 

//Declare variables 

Variables:  

haOpen, haHigh, haLow, haClose; 

 

//Calculate the Heikin Ashi values 

If ( CurrentBar = 1 ) Then 

Begin 

haOpen = Open; 

haClose = Close; 

End 

Else 

Begin 

haOpen = (haOpen[1] + haClose[1]) / 2); 

haClose = (open + high + low + close) / 4); 

End; 

 

haHigh = MaxItems( high, haOpen, haClose ); 

haLow = MinItems( low, haOpen, haClose ); 

 

//Draw the Heikin Ashi values as candlesticks. 

DrawCandlestick ( haOpen, haHigh, haLow, haClose, DarkGreen, Red, DarkGray ); 

Candlesticks exampleCandlesticks example
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DRAWPRICEMARKER ( )DRAWPRICEMARKER ( )  

This draws a horizontal marker at the given price next to the price scale or aligned to the last bar. Price markers will only be drawn This draws a horizontal marker at the given price next to the price scale or aligned to the last bar. Price markers will only be drawn 
on the last bar of a chart. Additionally, price markers are only valid for one evaluation run. When an update occurs, all existing on the last bar of a chart. Additionally, price markers are only valid for one evaluation run. When an update occurs, all existing 
price markers will be deleted. Price markers are always drawn behind any other chart.price markers will be deleted. Price markers are always drawn behind any other chart.

DrawPriceMarker( Price1, Price2, Width, FillColor, BorderColor, BorderThickness, Alignment, 

Label, LabelSize, LabelColor, LabelOptions ) 

  
  
In contrast to drawing functions like DrawLine(), DrawPriceMarker () does not procure series data. Therefore the output from this In contrast to drawing functions like DrawLine(), DrawPriceMarker () does not procure series data. Therefore the output from this 
function cannot be used from client scripts.Example for markers for all stop and limit order active on the current bar:function cannot be used from client scripts.Example for markers for all stop and limit order active on the current bar:

Meta: 

SubChart( False ); 

 

Variables:  

order, price, type, extent( 10 ); 

 

If IsLastBar Then Begin 

For order = 1 To GetActiveOrderCount Begin 

price = GetActiveOrderPrice( order ); 

type = GetActiveOrderType( order ); 

If type = OrderTypeLimit Then 

DrawPriceMarker( price, price, extent, Blue, Blue ) 

Else If type = OrderTypeStop Then 

DrawPriceMarker( price, price, extent, Red, Red ); 

End; 

End; 

DRAWING TOOLS WITH SPECIAL FUNCTIONSDRAWING TOOLS WITH SPECIAL FUNCTIONS  

For the two drawing tools For the two drawing tools DrawTrendLine()DrawTrendLine()DrawTrendLine()DrawTrendLine() and  and DrawRectangle()DrawRectangle()DrawRectangle()DrawRectangle(), special functions are available in Equilla to draw with and , special functions are available in Equilla to draw with and 
manipulate these tools.manipulate these tools.  
  
These special functions are passed as These special functions are passed as (tool) flags(tool) flags. They allow actions, for example expanding a rectangle into the "past" with . They allow actions, for example expanding a rectangle into the "past" with 
"ToolLeftExtend". "ToolLeftExtend".   
  
In contrast to drawing functions like Drawline(), the output generated by the tool functions is valid for display in a chart only.In contrast to drawing functions like Drawline(), the output generated by the tool functions is valid for display in a chart only.  
  
You can find more information on DrawTrendLine(), DrawRectangle()You can find more information on DrawTrendLine(), DrawRectangle() and the flags in Tradesignal help under  and the flags in Tradesignal help under Equilla Formula Equilla Formula Equilla Formula Equilla Formula 
LanguageLanguageLanguageLanguage, menu entry , menu entry ToolsToolsToolsTools..
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DRAWTRENDLINE ( )DRAWTRENDLINE ( )  

This draws a trendline into a chart.This draws a trendline into a chart.  
  

DrawTrendline( StartDate, StartTime, StartPrice, EndDate, EndTime, EndPrice, Style, Width, 

Color, Flags ) 

  
  
The flags are special functions like ToolExtendLeft, ToolExtendTop etc.The flags are special functions like ToolExtendLeft, ToolExtendTop etc.    
  
Example for a trendline drawn at the highest high of the last bars:Example for a trendline drawn at the highest high of the last bars:  
  

Input:  

Price( High ), 

Period( 10, 1 ); 

 

Variables:  

highVal; 

 

If IsLastBar Then 

Begin 

// Remove any trendline from the previous bars 

While ( ToolGetFirst() <> ­2 ) 

ToolDelete( ToolGetFirst() ); 

 

// calculate the highest high  

highVal = HHV( Price, Period ); 

 

// draw the trendline 

DrawTrendline( DateTime[10], highVal, DateTime, highVal ); 

End; 

DRAWRECTANGLE ( )DRAWRECTANGLE ( )  

This draws a rectangle into the chart.This draws a rectangle into the chart.  
  

DrawRectangle( StartDate, StartTime, StartPrice, EndDate, EndTime, EndPrice, BorderColor, 

FillColor, Flags ) 

  
  
The flags are special functions like ToolExtendLeft, ToolExtendTop etc.The flags are special functions like ToolExtendLeft, ToolExtendTop etc.    
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Input:  

LongColor( ColorGreen ), 

FlatColor( Transparent ), 

ShortColor( ColorRed ); 

 

Variables:  

color,  

flags( ToolDrawInBackground + ToolExtendBottom + ToolExtendLeft + ToolExtendRight + 

ToolExtendTop ); 

 

// Select the background color 

If MarketPosition = MarketPositionLong Then 

farbe = LongColor 

Else If MarketPosition = MarketPositionFlat Then 

farbe = FlatColor 

Else If MarketPosition = MarketPositionShort Then 

farbe = ShortColor; 

 

// Remove all previously drawn rectangles 

While ( ToolGetFirst() <> ­2 )  

ToolDelete( ToolGetFirst() ); 

 

// Draw a rectangle in the background 

DrawRectangle( Date, Time, Close, Date, Time, Close, color, color, flags ); 

CHANGE THE CHART TYPE OF AN INDICATOR/STRATEGYCHANGE THE CHART TYPE OF AN INDICATOR/STRATEGY  

You can change the output of an You can change the output of an indicatorindicator or  or strategystrategy in a chart (which is using one of the drawing functions described above)  in a chart (which is using one of the drawing functions described above) 
without changing or recompiling the script. For this, select the indicator or strategy and open the without changing or recompiling the script. For this, select the indicator or strategy and open the Chart TypesChart Types button menu in the  button menu in the 
ChartChart group in the toolbar. Then select the new chart type from the list. group in the toolbar. Then select the new chart type from the list.

SMALL EXCURSION IN CHROMATICSSMALL EXCURSION IN CHROMATICS  

In Equilla, there are several ways to enter colors. A number of color definitions can be entered as names. The usual ones are the In Equilla, there are several ways to enter colors. A number of color definitions can be entered as names. The usual ones are the 
standard colors like red, darkgreen, blue, black, magenta etc. The list of predefined colors offers many more colors.standard colors like red, darkgreen, blue, black, magenta etc. The list of predefined colors offers many more colors.  
  
Beyond that, the two color models HSV and RGB are available. When you define a color, for example in the color dialog in the Beyond that, the two color models HSV and RGB are available. When you define a color, for example in the color dialog in the 
property inspector, the RGB and HSV values are given below the color areas. With these values, every possible color can be property inspector, the RGB and HSV values are given below the color areas. With these values, every possible color can be 
entered.entered.
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THE TWO COLOR MODELSTHE TWO COLOR MODELS  

//Ouput in a subchart 

Meta: 

Subchart( true ); 

 

//Color values can be saved in variables 

Variables:  

myFirstRGBColor, myFirstHSVColor; 

 

//Color as RGB value 

myFirstRGBColor = RGB( 100, 30, 250 ); 

 

//Color as HSV value 

myFirstHSVColor = HSV( 100, 230, 250 ); 

 

//Lines in RGB color  

DrawLine( 100, "RGB color", StyleSolid, 5, myFirstRGBColor ); 

 

//Lines in HSV color 

DrawLine( ­100, "HSV color", StyleSolid, 5, myFirstHSVColor ); 

USING OPACITY (TRANSPARENCY)USING OPACITY (TRANSPARENCY)  

For every color, you can define an opacity value. This works for all colors, the standard colors as well as colors given by RGB or For every color, you can define an opacity value. This works for all colors, the standard colors as well as colors given by RGB or 
HSV values. Once again, color values can be given by variables which can be combined with opacity.HSV values. Once again, color values can be given by variables which can be combined with opacity.  
  

//Open a subchart 

Meta: 

Subchart( true ); 

 

//Change this input value to see the opacity  

//effect in the chart 

Inputs:  

Transparency( 200, 1 ); 

 

//Color settings can be given as variables 

Variables:  

myFirstRGBColor, MyFirstTransparentColor; 

 

//Compose an RGB value  

myFirstRGBColor = RGB( 100, 30, 250 ); 
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//Add Opacity 

myFirstTransparentColor = TransparentColor( myFirstRGBColor, Transparency ); 

 

//Draw an area with a transparent fill color 

DrawArea( 100, ­100, "Up", "Down", myFirstTransparentColor, black, black ); 

OUTPUT OF DATA IN THE OUTPUT WINDOWOUTPUT OF DATA IN THE OUTPUT WINDOW  

The The output windowoutput window is used for the output of data or text with the  is used for the output of data or text with the PrintPrint statement. For example, you can output your own statistical  statement. For example, you can output your own statistical 
or temporary results.or temporary results.  
  
As a developer, it is often necessary to have detailed information about the program flow. With the As a developer, it is often necessary to have detailed information about the program flow. With the PrintPrint function, a parameter  function, a parameter 
output can be generated (emulating a debug mode) that helps finding eventual errors. output can be generated (emulating a debug mode) that helps finding eventual errors. 

//Let the program communicate 

Variables:  

myDate, myFutureDate; 

 

myDate = FormatDate( DateTime, "dd.mm.yyyy"); 

myFutureDate = FormatDate( DateTime, "dd.mm.yyyy")[­1]; 

 

Print( "I'm just editing the: " + myDate + ", after that, " + 

myFutureDate + " will be next."); 

 

/* In the output window, the following appears: I'm just editing the: 2007/06/12, after 

that, 2007/06/14 will be next. */ 

DATA OUTPUT VIA FILE INTERFACEDATA OUTPUT VIA FILE INTERFACE  

Tradesignal offers the option to write data directly into a file. You can find the setting for the target folder of the PrintToFile Tradesignal offers the option to write data directly into a file. You can find the setting for the target folder of the PrintToFile 
function in the function in the Tradesignal OptionsTradesignal Options, tab , tab EquillaEquilla. In the statement, only the file name can be specified.. In the statement, only the file name can be specified.  

Variables:  

fileName("UserStat.txt"); 

 

if isLastBar Then 

PrintToFile( fileName, "Indicator was last used at: " +  

FormatDate( DateTime, "yyyy/mm/dd")); 

/* A file is created with the entry: 'Indicator was last used at 2006/04/30' */ 
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As long as you do not change or delete the file, Tradesignal appends each new line to the end of the file. This way, a history of As long as you do not change or delete the file, Tradesignal appends each new line to the end of the file. This way, a history of 
entries results. If you want to ensure by way of a script that an existing file is used, you can delete that file. entries results. If you want to ensure by way of a script that an existing file is used, you can delete that file. 

Variables:  

fileName("UserStat.txt"); 

 

if isLastBar Then 

Begin 

//RemoveFile deletes the file 

RemoveFile( fileName ); 

PrintToFile( fileName, "Indicator was last used at: " +  

FormatDate( DateTime, "yyyy/mm/dd")); 

End; 

/* A file is created with the entry: 'Indicator was last used at 2006/04/30' At each start 

of the indicator, the existing file is deleted first. */ 

ALERT OUTPUTALERT OUTPUT  

General information on how to set up and use the alert function can be General information on how to set up and use the alert function can be 
found in found in AlertsAlerts. You also have the option to output alerts via Equilla. . You also have the option to output alerts via Equilla. 
Please note that an alert is only output if generated at the last bar of the Please note that an alert is only output if generated at the last bar of the 
chart. Therefore it does not matter at which position in the script the alert chart. Therefore it does not matter at which position in the script the alert 
function is placed, since it is only executed when the last bar is reached. function is placed, since it is only executed when the last bar is reached.   
  

Variables:  

myAlertText(""); 

 

If isLastBar Then 

Begin 

myAlertText = "The prices break down!" 

alert( myAlertText ); 

End; 

An Alert WindowAn Alert Window
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EQUILLA ARRAYS 
The following article offers an introduction to arrays in Equilla.The following article offers an introduction to arrays in Equilla.  
  
Arrays in Equilla are similar to those in other programming languages. They are data fields designed to contain large quantities of Arrays in Equilla are similar to those in other programming languages. They are data fields designed to contain large quantities of 
data. Each piece of data can be retrieved via the unique position (index) in the array. With the help of additional functions delivered data. Each piece of data can be retrieved via the unique position (index) in the array. With the help of additional functions delivered 
with Tradesignal, a wide range of applications can be covered with arrays.with Tradesignal, a wide range of applications can be covered with arrays.  
  
Arrays are set to replace the Arrays are set to replace the Equilla VectorsEquilla Vectors of earlier Tradesignal versions. Any current script with vectors can easily be modified  of earlier Tradesignal versions. Any current script with vectors can easily be modified 
to use arrays instead.to use arrays instead.

WHAT IS AN ARRAY?WHAT IS AN ARRAY?  

In In the basic Equilla articlethe basic Equilla article, variables were introduced as being "containers with an identification number". Via the name of the , variables were introduced as being "containers with an identification number". Via the name of the 
variable, existing contents can be called up or new contents can be assigned to the variable. variable, existing contents can be called up or new contents can be assigned to the variable.   
  
While you can only save one value per variable, arrays are a lot more flexible While you can only save one value per variable, arrays are a lot more flexible -- an infinite number of values can be put into an  an infinite number of values can be put into an 
array. To expand the container comparison: arrays are containers that include an unlimited number of storage spaces, like boxes in array. To expand the container comparison: arrays are containers that include an unlimited number of storage spaces, like boxes in 
a container. Each box can be retrieved by its index (unique position in the array).a container. Each box can be retrieved by its index (unique position in the array).  
  
By taking this container analogy one step further to a stack of containers, we get to multidimensional arrays, most commonly By taking this container analogy one step further to a stack of containers, we get to multidimensional arrays, most commonly 
described as arrays of arrays.described as arrays of arrays.

ARRAY DECLARATIONARRAY DECLARATION  

An array is treated similar to a variable. They are declared in a special declaration block starting with the keyword An array is treated similar to a variable. They are declared in a special declaration block starting with the keyword ArraysArrays. The . The 
name of the array variable has to be followed by a pair of square brackets.name of the array variable has to be followed by a pair of square brackets.

Arrays:  

myVeryFirstArray[]; 

This array is initally empty and can later be resized to hold as many items as you wish to store in it.This array is initally empty and can later be resized to hold as many items as you wish to store in it.  
  
If you know in advance how many items you want to store in your array and don't want to be able to resize it at a later time, you If you know in advance how many items you want to store in your array and don't want to be able to resize it at a later time, you 
can declare it in this way.can declare it in this way.

Arrays:  

myFixedSizeArray[10]; 

This creates an array with a maximum valid index of 10, but since indices start at 0, you can store 11 items in this array. Builtin This creates an array with a maximum valid index of 10, but since indices start at 0, you can store 11 items in this array. Builtin 
functions ignore index 0, so you should not use this place if you plan to use the builtin functions.functions ignore index 0, so you should not use this place if you plan to use the builtin functions.  
  
The declaration of a multidimensional array looks like this:The declaration of a multidimensional array looks like this:
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Arrays:  

my2DArray[3,4]; 

This array can be interpreted as a spreadsheet having rows and columns.This array can be interpreted as a spreadsheet having rows and columns.  
  
[0,0] [0,1] [0,2] [0,3] [0,4][0,0] [0,1] [0,2] [0,3] [0,4]  
  
[1,0] [1,1] [1,2] [1,3] [1,4][1,0] [1,1] [1,2] [1,3] [1,4]  
  
[2,0] [2,1] [2,2] [2,3] [2,4][2,0] [2,1] [2,2] [2,3] [2,4]  
  
[3,0] [3,1] [3,2] [3,3] [3,4][3,0] [3,1] [3,2] [3,3] [3,4]  
  
A builtin function would ignore any index containing a 0, but you are free to use these items to store e.g. sums per row and A builtin function would ignore any index containing a 0, but you are free to use these items to store e.g. sums per row and 
column.column.  
  
As with variables, you can create a global array. This way it is possible to call up the array from several scripts. Global array are As with variables, you can create a global array. This way it is possible to call up the array from several scripts. Global array are 
defined just like global variables by adding a namespace for your global variables and :: in front of the array name.defined just like global variables by adding a namespace for your global variables and :: in front of the array name.  
  

Arrays:  

myGlobals::myGlobalArray[]; 

ACCESSING ITEMS IN AN ARRAYACCESSING ITEMS IN AN ARRAY  

The storage places inside an array are adressed using the array name followed by the unique index in square brackets.The storage places inside an array are adressed using the array name followed by the unique index in square brackets.  
  

Arrays:  

myArray[10]; 

// assigns 23 to the storage place with index 1 

myArray[1] = 23; 

// prints the value contained in storage place with index 1, i.e. 23 

Print( myArray[1] ); 

Arrays can include all data types available in Equilla. Arrays can include all data types available in Equilla. 

OUTPUT CATENATED DATAOUTPUT CATENATED DATA  

If you want to output the complete content of a array in a quick and easy way, you can use several builtin functions. You can just If you want to output the complete content of a array in a quick and easy way, you can use several builtin functions. You can just 
use the print command and all items stored in the array will be printed.use the print command and all items stored in the array will be printed.  
  

Arrays:  
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myArray[]; 

// fill the array with some values 

FillArray( myArray, 12, 4, 2, 23 ); 

// output all values using the print command 

Print( myArray ); 

// Print( myArray ) does the same as 

// Print( myArray[1], myArray[2], myArray[3], myArray[4] ) 

In the output window appearsIn the output window appears

12  4  2  23 

  
  
Or you can use Join() and have all items printed on a separate line using the string constant NewLine.Or you can use Join() and have all items printed on a separate line using the string constant NewLine.

Arrays:  

myArray[]; 

// fill the array with some values 

FillArray( myArray, 12, 4, 2, 23 ); 

// output all values separated by a newline 

Print( Join( NewLine, myArray ) ); 

Output window showsOutput window shows

12 

4 

2 

23 

READING THE ARRAY PROPERTIESREADING THE ARRAY PROPERTIES  

Some useful functions are available for reading the array properties. For example, by using the Some useful functions are available for reading the array properties. For example, by using the ArrayLength( )ArrayLength( ) function, you receive  function, you receive 
the array size, i.e. the number of items in it.the array size, i.e. the number of items in it.    
  
With other functions you gain information about the highest or lowest value in an array (and their unique index in the array).With other functions you gain information about the highest or lowest value in an array (and their unique index in the array).

l ArrayLength( ArrayName )ArrayLength( ArrayName )  -- Returns the size of the array. Returns the size of the array.  
l HighestArray( ArrayName )HighestArray( ArrayName )  -- Returns the highest value in the array. Returns the highest value in the array.  
l IndexOfHighestArray( ArrayName )IndexOfHighestArray( ArrayName )  -- Returns the index of the highest value in the array. Returns the index of the highest value in the array.  
l LowestArray( ArrayName )LowestArray( ArrayName )  -- Returns the lowest value in the array. Returns the lowest value in the array.  
l IndexOfLowestArray( ArrayName )IndexOfLowestArray( ArrayName )  -- Returns the index of the lowest value in the array. Returns the index of the lowest value in the array.  

With the following little routine you can test the functions listed above. When you change the content of the With the following little routine you can test the functions listed above. When you change the content of the FillArray( )FillArray( ) function,  function, 
different values will be output.different values will be output.  
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Variables:  

OutputText; 

Arrays:  

myArray[]; 

If isLastBar Then 

Begin 

//Fill the array with values 

FillArray( myArray, 2, 4, 6, 8, 10, 2, 3, 5 ); 

//Output array contents 

Print( "Array Contents: " + Join( ", ", myArray ) ); 

//Read the number of elements 

OutputText = "Number of Elements: " + ArrayLength( myArray); 

//Output in the output window 

Print( OutputText); 

//Retrieve the highest value 

OutputText = "Highest Value: " + HighestArray( myArray); 

//Retrieve unique ID / position of highest value 

OutputText = OutputText + " ­ at position No.: " +  

IndexOfHighestArray( myArray); 

//Output in the output window 

Print( OutputText); 

//Retrieve the lowest value 

OutputText = "Lowest Value: " + LowestArray( myArray); 

//Retrieve unique ID / position of lowest value 

OutputText = OutputText + " ­ at position No.: " +  

IndexOfLowestArray( myArray); 

//Output in the output window 

Print( OutputText); 

End; 

  
  
In the output window, the following appears: In the output window, the following appears: 

Array contents: 2, 4, 6, 8, 10, 2, 3, 5 

Number of elements: 8 

Highest value: 10 ­ at position No.: 5 

Lowest value: 2 ­ at position No.: 1 

OVERVIEW OF ALL ARRAY FUNCTIONS OVERVIEW OF ALL ARRAY FUNCTIONS   

In the following you can find a list of all array functions in Equilla. More information and examples for each function you can find In the following you can find a list of all array functions in Equilla. More information and examples for each function you can find 
in the Tradesignal help under in the Tradesignal help under Equilla Formula LanguageEquilla Formula LanguageEquilla Formula LanguageEquilla Formula Language, menu entry , menu entry ArraysArraysArraysArrays. .   
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To open the Tradesignal help, click on the button with the yellow question mark in the toolbox or in the header bar. In the Equilla To open the Tradesignal help, click on the button with the yellow question mark in the toolbox or in the header bar. In the Equilla 
editor, you can also righteditor, you can also right--click on an Equilla function and select click on an Equilla function and select Lookup Equilla FunctionLookup Equilla FunctionLookup Equilla FunctionLookup Equilla Function. .   
  

FunctionFunctionFunctionFunction DescriptionDescriptionDescriptionDescription
AppendArrayAppendArray Apppends an array or a single variable to another array.Apppends an array or a single variable to another array.
ArrayLengthArrayLength Returns the length (and maximum index) of an array.Returns the length (and maximum index) of an array.
Array_CopyArray_Copy Copies some elements from one array to another.Copies some elements from one array to another.
Array_GetTypeArray_GetType Returns the type of the array elements.Returns the type of the array elements.
Array_SortArray_Sort Sorts a range of elements in an array.Sorts a range of elements in an array.
Array_SumArray_Sum Returns the sum of all elements or the number of true values in case of booleans.Returns the sum of all elements or the number of true values in case of booleans.
AverageArrayAverageArray Returns the (mean) average of all or some elements of the array.Returns the (mean) average of all or some elements of the array.
AvgDeviationArrayAvgDeviationArray Returns the average deviation of all or some elements of the array.Returns the average deviation of all or some elements of the array.
BinarySearchArrayBinarySearchArray Returns the position of a given value using a binary search.Returns the position of a given value using a binary search.
ClearArrayClearArray Clears an array and resets it to its initial state.Clears an array and resets it to its initial state.
CompareArrayCompareArray Compares one array to another.Compares one array to another.
CopyArrayCopyArray Copy all or some elements from one array to another.Copy all or some elements from one array to another.
CreateSortedIndexArrayCreateSortedIndexArray Creates a sorted index into another array.Creates a sorted index into another array.
FillArrayFillArray Fills an array with the given values.Fills an array with the given values.
GetArrayDimensionsGetArrayDimensions Returns the number of dimensions of an array.Returns the number of dimensions of an array.
HarmonicMeanArrayHarmonicMeanArray Returns the harmonic mean of all or some elements of the array.Returns the harmonic mean of all or some elements of the array.
HighestArrayHighestArray Returns the highest value in the array.Returns the highest value in the array.
IndexOfHighestArrayIndexOfHighestArray Returns the index of the highest value in the array.Returns the index of the highest value in the array.
IndexOfLowestArrayIndexOfLowestArray Returns the lowest value in the array.Returns the lowest value in the array.
InsertAtArrayInsertAtArray Inserts a value into an array at a given index.Inserts a value into an array at a given index.
InsertSortedArrayInsertSortedArray Inserts a value into an array keeping it sorted.Inserts a value into an array keeping it sorted.
KurtosisArrayKurtosisArray Returns the Kurtosis value of all or some elements of the array.Returns the Kurtosis value of all or some elements of the array.
LowestArrayLowestArray Returns the lowest value in the array.Returns the lowest value in the array.
MedianArrayMedianArray Returns the median of all or some elements of the array.Returns the median of all or some elements of the array.
RemoveAtArrayRemoveAtArray Removes an element at a given index from the array.Removes an element at a given index from the array.
SearchArraySearchArray Returns the position of a given value.Returns the position of a given value.
SetArrayLengthSetArrayLength Shrinks or grows a dynamic array.Shrinks or grows a dynamic array.
SetValRangeArraySetValRangeArray Sets a range of elements to a given value.Sets a range of elements to a given value.
SkewnessArraySkewnessArray Returns the skewness of all or some elements of the array.Returns the skewness of all or some elements of the array.
Sort2DArraySort2DArray Sorts a 2Sorts a 2--dimensional array by columns.dimensional array by columns.
SortArraySortArray Sorts some or all elements of an array.Sorts some or all elements of an array.
StdDeviationArrayStdDeviationArray Returns the standard deviation of all or some elements of the array.Returns the standard deviation of all or some elements of the array.
StdErrorArrayStdErrorArray Returns the standard error of all or some elements of the array.Returns the standard error of all or some elements of the array.
SummationArraySummationArray Returns the sum of all or some elements of the array.Returns the sum of all or some elements of the array.
SummationRecArraySummationRecArray Returns the sum of reciprocals of all or some elements of the array.Returns the sum of reciprocals of all or some elements of the array.
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SummationSqrArraySummationSqrArray Returns the sum of squares of all or some elements of the array.Returns the sum of squares of all or some elements of the array.
VarianceArrayVarianceArray Returns the variance of all or some elements of the array.Returns the variance of all or some elements of the array.
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EQUILLA VECTORS 
The following article offers an introduction to vectors in Equilla. Vectors are deprecated in Tradesignal and are superseded by The following article offers an introduction to vectors in Equilla. Vectors are deprecated in Tradesignal and are superseded by 
arraysarrays..  
  
Vectors in Equilla are the same kind of construction as those called arrays in other programming languages. They are data fields Vectors in Equilla are the same kind of construction as those called arrays in other programming languages. They are data fields 
designed to contain large quantities of data. Each piece of data can be retrieved via the unique position (index) in the vector. With designed to contain large quantities of data. Each piece of data can be retrieved via the unique position (index) in the vector. With 
the help of additional functions delivered with Tradesignal, a wide range of applications can be covered with vectors.the help of additional functions delivered with Tradesignal, a wide range of applications can be covered with vectors.

WHAT IS A VECTOR?WHAT IS A VECTOR?  

In In the basic Equilla articlethe basic Equilla article, variables were introduced as being "containers with an identification number". Via the name of the , variables were introduced as being "containers with an identification number". Via the name of the 
variable, existing contents can be called up or new contents can be assigned to the variable. variable, existing contents can be called up or new contents can be assigned to the variable.   
  
While you can only save one value per variable, vectors are a lot more flexible While you can only save one value per variable, vectors are a lot more flexible -- an infinite number of values can be put into a  an infinite number of values can be put into a 
vector. To expand the container comparison: vectors are containers that include an unlimited number of storage spaces, like boxes vector. To expand the container comparison: vectors are containers that include an unlimited number of storage spaces, like boxes 
in a container. Each box can be retrieved by its index (unique position in the vector).in a container. Each box can be retrieved by its index (unique position in the vector).

VECTOR DECLARATIONVECTOR DECLARATION  

A vector is treated similar to a variable. In the variable declaration, the vector has to be defined and named. The keyword A vector is treated similar to a variable. In the variable declaration, the vector has to be defined and named. The keyword VectorVector  
has to be added in brackets.has to be added in brackets.

Variables:  

myVeryFirstVector( Vector ); 

  
  
When you forget the keyword When you forget the keyword VectorVector, a variable of this name is available but without the vector properties. , a variable of this name is available but without the vector properties.   
  
As with variables, you can create a global vector. This way it is possible to call up the vector from several scripts. Global vectors As with variables, you can create a global vector. This way it is possible to call up the vector from several scripts. Global vectors 
are defined as follows: are defined as follows: 

Variables:  

myVeryFirstGlobalVector( GlobalVector ); 

READ AND WRITE DATAREAD AND WRITE DATA  

Vectors offer the two basic features Vectors offer the two basic features ReadVector()ReadVector() and  and WriteVector()WriteVector(). Both functions need the name and the unique index to address . Both functions need the name and the unique index to address 
the right storage place. When writing a vector, you also need to pass the content to be written. the right storage place. When writing a vector, you also need to pass the content to be written.   
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Vectors can include all data types available in Equilla. Vectors can include all data types available in Equilla. 

WRITE DATAWRITE DATA  

Data is written into the vector with the Data is written into the vector with the WriteVector ( )WriteVector ( ) function. As parameters, the vector name and the value to be written have to  function. As parameters, the vector name and the value to be written have to 
be passed. The size of the vector is automatically adapted to the highest used index. Therefore, the possible length of the future be passed. The size of the vector is automatically adapted to the highest used index. Therefore, the possible length of the future 
vector is irrelevant for the calculation. vector is irrelevant for the calculation.   
  

Variables:  

myVeryFirstVector( Vector ); 

 

If isLastBar Then 

Begin 

//The string 'Hello' is written at the position with ID 0  

WriteVector( myVeryFirstVector, 0, "Hello"); 

//The string 'Rene' is written at the position with ID 1  

WriteVector( myVeryFirstVector, 1, " Rene"); 

End; 

OUTPUT CATENATED DATAOUTPUT CATENATED DATA  

If you want to output the complete content of a vector in a quick and easy way, you can use the function If you want to output the complete content of a vector in a quick and easy way, you can use the function FormatVectorFormatVector. It is part of . It is part of 
the delivered functions and catenates all elements of a vector to one string. This can then be output with the print command. The the delivered functions and catenates all elements of a vector to one string. This can then be output with the print command. The 
function is especially useful if you want to keep track of the values while programming. function is especially useful if you want to keep track of the values while programming.   
  
We expand the source code given above:We expand the source code given above:

Variables:  

myVeryFirstVector( Vector ); 

 

If isLastBar Then 

Begin 

//The string 'Hello' is written at the position with ID 0  

WriteVector( myVeryFirstVector, 0, "Hello"); 

//The string 'Rene' is written at the position with ID 1  

WriteVector( myVeryFirstVector, 1, " Rene"); 

Print( FormatVector( myVeryFirstVector )); 

End; 

  
  
In the output window, the line "Hello Rene" appears.In the output window, the line "Hello Rene" appears.
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READ DATAREAD DATA  

Vector data can be read with the Vector data can be read with the ReadVector ( )ReadVector ( ) function. As parameters, the vector name and the index have to be passed. function. As parameters, the vector name and the index have to be passed.    
  
Make sure that the program does not try to read from nonMake sure that the program does not try to read from non--existing positions. When this happens, Tradesignal aborts the execution existing positions. When this happens, Tradesignal aborts the execution 
with an error message in the chart legend. with an error message in the chart legend. 

Variables:  

myVeryFirstVector( Vector ), OutputText; 

 

If isLastBar Then 

Begin 

//The string 'Hello' is written at the position with ID 0  

WriteVector( myVeryFirstVector, 0, "Hello"); 

//The string 'Rene' is written at the position with ID 1  

WriteVector( myVeryFirstVector, 1, " Rene"); 

OutputText = ReadVector( myVeryFirstVector, 0 ); 

OutputText = OutputText + ReadVector( myVeryFirstVector, 1 ); 

Print( OutputText ); 

End; 

  
  
In the output window, the line "Hello Rene" appears.In the output window, the line "Hello Rene" appears.

READING THE VECTOR PROPERTIESREADING THE VECTOR PROPERTIES  

Some useful functions are available for reading the vector properties. For example, by using the Some useful functions are available for reading the vector properties. For example, by using the VectorLength( )VectorLength( ) function, you  function, you 
receive the vector size, i.e. the number of included elements.receive the vector size, i.e. the number of included elements.    
  
With other functions you gain information about the highest or lowest value in a vector (and their unique IDs in the vector). Please With other functions you gain information about the highest or lowest value in a vector (and their unique IDs in the vector). Please 
note that a vector indexing always starts at zero. The first index is zero, the second is one and so on.note that a vector indexing always starts at zero. The first index is zero, the second is one and so on.  

l VectorLength( VectorName )VectorLength( VectorName )  -- Offers the number of elements. Offers the number of elements.  
l HighestVector( VectorName )HighestVector( VectorName )  -- Offers the highest value in the vector as result. Offers the highest value in the vector as result.  
l IndexOfHighestVector( VectorName )IndexOfHighestVector( VectorName )  -- Offers the unique ID of the highest value in the vector. Offers the unique ID of the highest value in the vector.  
l LowestVector( VectorName )LowestVector( VectorName )  -- Offers the lowest value in the vector as result. Offers the lowest value in the vector as result.  
l IndexOfLowestVector( VectorName )IndexOfLowestVector( VectorName )  -- Offers the unique ID of the lowest value in the vector. Offers the unique ID of the lowest value in the vector.  

With the following little routine you can test the functions listed above. When you change the content of the With the following little routine you can test the functions listed above. When you change the content of the FillVector( )FillVector( ) function,  function, 
different values will be output.different values will be output.  

Variables:  

myVeryFirstVector ( Vector ), OutputText; 
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If isLastBar Then 

Begin 

//Fill the vector with values 

FillVector( myVeryFirstVector , 2,4,6,8,10,2,3,5 ); 

//Output vector contents 

Print( "Vector Contents: " + FormatVector( myVeryFirstVector )); 

//Read the number of elements 

OutputText = "Number of Elements: " + VectorLength( myVeryFirstVector ); 

//Output in the output window 

Print( OutputText); 

//Retrieve the highest value 

OutputText = "Highest Value: " + HighestVector( myVeryFirstVector ); 

//Retrieve unique ID / position of highest value 

OutputText = OutputText + " ­ at position No.: " +  

IndexOfHighestVector( myVeryFirstVector ); 

//Output in the output window 

Print( OutputText); 

//Retrieve the lowest value 

OutputText = "Lowest Value: " + LowestVector( myVeryFirstVector ); 

//Retrieve unique ID / position of lowest value 

OutputText = OutputText + " ­ at position No.: " +  

IndexOfLowestVector( myVeryFirstVector ); 

//Output in the output window 

Print( OutputText); 

End; 

  
  
In the output window, the following appears: In the output window, the following appears: 

Vector contents: '2', '4', '6', '8', '10', '2', '3', '5' 

Number of elements: 8 

Highest value: 10 ­ at position No.: 4 

Lowest value: 2 ­ at position No.: 0 

FILL VECTORS WITH CONTENT AND DELETE CONTENTFILL VECTORS WITH CONTENT AND DELETE CONTENT  

To write a defined number of values into a vector, use the function To write a defined number of values into a vector, use the function FillVector( VectorName, Value1, Value2, ..)FillVector( VectorName, Value1, Value2, ..). This function was . This function was 
already used in the example above. already used in the example above.   
  
To delete the content of a vector, use the function To delete the content of a vector, use the function ClearVector(VectorName)ClearVector(VectorName). This function deletes all elements in a vector and . This function deletes all elements in a vector and 
resets its size to zero. Use this function when you reuse vectors in your program, except in cases when you want to use old vector resets its size to zero. Use this function when you reuse vectors in your program, except in cases when you want to use old vector 
data. data.   
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Let us expand the source code of the example above by adding the delete function: Let us expand the source code of the example above by adding the delete function: 

Variables:  

myVeryFirstVector ( Vector ), OutputText; 

 

If isLastBar Then 

Begin 

//Fill the vector with values 

FillVector( myVeryFirstVector , 2,4,6,8,10,2,3,5 ); 

//Output vector contents 

Print( "Vector Contents: " + FormatVector( myVeryFirstVector )); 

//Read the number of elements 

OutputText = "Number of Elements: " + VectorLength( myVeryFirstVector ); 

//Output in the output window 

Print( OutputText); 

//Retrieve the highest value 

OutputText = "Highest Value: " + HighestVector( myVeryFirstVector ); 

//Retrieve unique ID / position of highest value 

OutputText = OutputText + " ­ at position No.: " +  

IndexOfHighestVector( myVeryFirstVector ); 

//Output in the output window 

Print( OutputText); 

//Retrieve the lowest value 

OutputText = "Lowest Value: " + LowestVector( myVeryFirstVector ); 

//Retrieve unique ID / position of lowest value 

OutputText = OutputText + " ­ at position No.: " +  

IndexOfLowestVector( myVeryFirstVector ); 

//Output in the output window 

Print( OutputText); 

 

Print( "Vector deleted!" ); 

ClearVector( myVeryFirstVector ); 

 

Print( "Vector contents: " + FormatVector( myVeryFirstVector )); 

 

//Repeat all analysis: 

OutputText = "Number of Elements: " + VectorLength( myVeryFirstVector ); 

//Output in the output window 

Print( OutputText); 

//Retrieve the highest value 

OutputText = "Highest Value: " + HighestVector( myVeryFirstVector ); 

//Retrieve unique ID / position of highest value 

OutputText = OutputText + " ­ at position No.: " +  

IndexOfHighestVector( myVeryFirstVector ); 

//Output in the output window 
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Print( OutputText); 

//Retrieve the lowest value 

OutputText = "Lowest Value: " + LowestVector( myVeryFirstVector ); 

//Retrieve unique ID / position of lowest value 

OutputText = OutputText + " ­ at position No.: " +  

IndexOfLowestVector( myVeryFirstVector ); 

//Output in the output window 

End; 

  
  
In the output window, the following appears: In the output window, the following appears: 

Vector contents: '2', '4', '6', '8', '10', '2', '3', '5' 

Number of elements: 8 

Highest value: 10 ­ at position No.: 4 

Highest value: 2 ­ at position No.: 0 

Vector deleted! 

Vector contents:  

Number of elements: 0 

Highest value: 0 ­ at position No.: ­1 

Highest value: 0 ­ at position No.: ­1 

  
  
As you can see, the vector is empty after the deletion. Due to this, some functions output an error with the result "As you can see, the vector is empty after the deletion. Due to this, some functions output an error with the result "--1".1".

FINDING AND SORTING DATAFINDING AND SORTING DATA  

Some useful functions are available to navigate in a vector.Some useful functions are available to navigate in a vector.    
  
To find data in a vector, use the function To find data in a vector, use the function SearchVector( VectorName, SearchedValue)SearchVector( VectorName, SearchedValue). .   
  
To sort data, use the function To sort data, use the function SortVector( VectorName, SortAscending )SortVector( VectorName, SortAscending ). .   
  
To demonstrate the sorting, we modify the indicator of the deletion example. We simply exchangeTo demonstrate the sorting, we modify the indicator of the deletion example. We simply exchange the  the ClearVector( VectorName )ClearVector( VectorName )  
function with the sorting function function with the sorting function SortVector( VectorName, SortAscending )SortVector( VectorName, SortAscending ). You can change the sorting direction with true/false. . You can change the sorting direction with true/false. 
Enter true for ascending and false for descending order.Enter true for ascending and false for descending order.    
  

Variables:  

myVeryFirstVector ( Vector ), OutputText; 

 

If isLastBar Then 

Begin 



:: www.tradesignal.comwww.tradesignal.com

Tradesignal GmbHTradesignal GmbH Page 363Page 363 Version 7.0Version 7.0

//Fill the vector with values 

FillVector( myVeryFirstVector , 2,4,6,8,10,2,3,5 ); 

//Output vector contents 

Print( "Vector Contents: " + FormatVector( myVeryFirstVector )); 

//Read the number of elements 

OutputText = "Number of Elements: " + VectorLength( myVeryFirstVector ); 

//Output in the output window 

Print( OutputText); 

//Retrieve the highest value 

OutputText = "Highest Value: " + HighestVector( myVeryFirstVector ); 

//Retrieve unique ID / position of highest value 

OutputText = OutputText + " ­ at position No.: " +  

IndexOfHighestVector( myVeryFirstVector ); 

//Output in the output window 

Print( OutputText); 

//Retrieve the lowest value 

OutputText = "Lowest Value: " + LowestVector( myVeryFirstVector ); 

//Retrieve unique ID / position of lowest value 

OutputText = OutputText + " ­ at position No.: " +  

IndexOfLowestVector( myVeryFirstVector ); 

//Output in the output window 

Print( OutputText); 

 

SortVector( myVeryFirstVector , true ); 

 

//Repeat the analysis: 

Print( "Vector contents: " + FormatVector( myVeryFirstVector )); 

//Fill the vector with values 

FillVector( myVeryFirstVector , 2,4,6,8,10,2,3,5 ); 

//Output vector contents 

Print( "Vector Contents: " + FormatVector( myVeryFirstVector )); 

//Read the number of elements 

OutputText = "Number of Elements: " + VectorLength( myVeryFirstVector ); 

//Output in the output window 

Print( OutputText); 

//Retrieve the highest value 

OutputText = "Highest Value: " + HighestVector( myVeryFirstVector ); 

//Retrieve unique ID / position of highest value 

OutputText = OutputText + " ­ at position No.: " +  

IndexOfHighestVector( myVeryFirstVector ); 

//Output in the output window 

Print( OutputText); 

//Retrieve the lowest value 

OutputText = "Lowest Value: " + LowestVector( myVeryFirstVector ); 

//Retrieve unique ID / position of lowest value 
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OutputText = OutputText + " ­ at position No.: " +  

IndexOfLowestVector( myVeryFirstVector ); 

//Output in the output window 

Print( OutputText); 

End; 

  
  
In the output window, the following appears: In the output window, the following appears:   
  

Vector contents: '2', '4', '6', '8', '10', '2', '3', '5' 

Number of elements: 8 

Highest value: 10 ­ at position No.: 4 

Lowest value: 2 ­ at position No.: 0 

Vector contents: '2', '2', '3', '4', '5', '6', '8', '10' 

Number of elements: 8 

Highest value: 10 ­ at position No.: 7 

Lowest value: 2 ­ at position No.: 0 

  
  
Here is an example for the search function. The wanted value is "10".Here is an example for the search function. The wanted value is "10".  

Variables:  

myVeryFirstVector ( Vector ) 

 

If isLastBar Then 

Begin 

//Fill the vector with values 

FillVector( myVeryFirstVector , 2,4,6,8,10,2,3,5 ); 

//Search the vector for a value 

Print( "The wanted value 10 is at position No.: " +  

SearchVector( myVeryFirstVector, 10 )); 

 End; 

  
  
In the output window appears: In the output window appears: 

Vector content: '2', '4', '6', '8', '10', '2', '3', '5' 

The wanted value 10 is at position No.: 4 

OVERVIEW OF ALL VECTOR FUNCTIONS OVERVIEW OF ALL VECTOR FUNCTIONS   
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In the following you can find a list of all vector functions in Equilla. More information and examples for each vector you can find in In the following you can find a list of all vector functions in Equilla. More information and examples for each vector you can find in 
the Tradesignal help under the Tradesignal help under Equilla Formula LanguageEquilla Formula LanguageEquilla Formula LanguageEquilla Formula Language, menu entry , menu entry VectorsVectorsVectorsVectors. .   
  
To open the Tradesignal help, click on the button with the yellow question mark in the toolbox or in the header bar. In the Equilla To open the Tradesignal help, click on the button with the yellow question mark in the toolbox or in the header bar. In the Equilla 
editor, you can also righteditor, you can also right--click on an Equilla function and select click on an Equilla function and select Lookup Equilla FunctionLookup Equilla FunctionLookup Equilla FunctionLookup Equilla Function. .   
  

VectorVectorVectorVector FunktionFunktionFunktionFunktion
AppendVector()AppendVector() Appends the contects of one vector onto the end of another vector.Appends the contects of one vector onto the end of another vector.
AverageVector()AverageVector() Returns the average value (mean) of the elements in a vector.Returns the average value (mean) of the elements in a vector.
AvgDeviationVector()AvgDeviationVector() Returns the average deviation of the elements in a vector.Returns the average deviation of the elements in a vector.
BinarySearchVector()BinarySearchVector() Returns the position of an element with a specific value in a vector using a binary search.Returns the position of an element with a specific value in a vector using a binary search.
ClearVector()ClearVector() Clears the contents of a vector and sets its size to zero (0).Clears the contents of a vector and sets its size to zero (0).
CompareVector()CompareVector() Compares the elements in one vector to those in another vector.Compares the elements in one vector to those in another vector.
CopyVector()CopyVector() Copies some or all of the elements from one vector to another.Copies some or all of the elements from one vector to another.
CreateSortedIndexVectorCreateSortedIndexVector
()()

Creates a sorted index to a vector. The vector containing the actual data will remain unchanged.Creates a sorted index to a vector. The vector containing the actual data will remain unchanged.

FillVector()FillVector() Fills a vector with the specified elements.Fills a vector with the specified elements.
GlobalVector()GlobalVector() Returns a newly created vector that can be shared between scripts.Returns a newly created vector that can be shared between scripts.
HarmonicMeanVector()HarmonicMeanVector() Returns the harmonic mean of the values in a vector.Returns the harmonic mean of the values in a vector.
HighestVector()HighestVector() Returns the highest element in a vector.Returns the highest element in a vector.
IndexOfHighestVector()IndexOfHighestVector() Returns the zero based index of the first occurrence of the highest element in a vector.Returns the zero based index of the first occurrence of the highest element in a vector.
IndexOfLowestVector()IndexOfLowestVector() Returns the zero based index of the first occurrence of the lowest element in a vector.Returns the zero based index of the first occurrence of the lowest element in a vector.
KurtosisVector()KurtosisVector() Returns the Kurtosis value of the elements in a vector.Returns the Kurtosis value of the elements in a vector.
LowestVector()LowestVector() Returns the lowest element in a vector.Returns the lowest element in a vector.
MedianVector()MedianVector() Returns the median of the elements in a vector.Returns the median of the elements in a vector.
ReadVector()ReadVector() Returns the value stored at a specific index within a vector.Returns the value stored at a specific index within a vector.
ReadVectorIndirect()ReadVectorIndirect() Returns the value stored at a certain index within the data vector.Returns the value stored at a certain index within the data vector.
SearchVector()SearchVector() Returns the position of an element with a specific value in a vector.Returns the position of an element with a specific value in a vector.
SetMaxIndexVector()SetMaxIndexVector() Sets the largest index value for this vector.Sets the largest index value for this vector.
SetValRangeVector()SetValRangeVector() Sets a range of elements in a vector to a specified value.Sets a range of elements in a vector to a specified value.
SkewnessVector()SkewnessVector() Returns the skewness (the degree of asymmetry) of the elements in a vector.Returns the skewness (the degree of asymmetry) of the elements in a vector.
SortVector()SortVector() Sorts the contents of the vector.Sorts the contents of the vector.
StdDeviationVector()StdDeviationVector() Returns the standard deviation of the elements in a vector.Returns the standard deviation of the elements in a vector.
StdErrorVector()StdErrorVector() Returns the standard error of the elements in a vector.Returns the standard error of the elements in a vector.
SummationRecVector()SummationRecVector() Returns the sum of reciprocals of each element in a vector.Returns the sum of reciprocals of each element in a vector.
SummationSqrVector()SummationSqrVector() Returns the sum of squares of each element in a vector.Returns the sum of squares of each element in a vector.
SummationVector()SummationVector() Returns the sum of all, or a range of elements in the vector.Returns the sum of all, or a range of elements in the vector.
VarianceVector()VarianceVector() Returns the variance of the elements in a vector.Returns the variance of the elements in a vector.
Vector()Vector() Returns a newly created vector.Returns a newly created vector.
VectorLength()VectorLength() Returns the number of elements stored in a vector..Returns the number of elements stored in a vector..
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WriteVector()WriteVector() Writes a value to a specific index within a vector.Writes a value to a specific index within a vector.

WriteVectorIndirect()WriteVectorIndirect()
Writes a value to a specific index within a vector. The index into the data vector will be looked up via Writes a value to a specific index within a vector. The index into the data vector will be looked up via 
the index vector.the index vector.
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EXTENDING EQUILLA 
Tradesignal offers two ways of extending the equilla programming language. Tradesignal offers two ways of extending the equilla programming language. 

CC--API EXTENSIONSAPI EXTENSIONS  

CC--API extensions are supported for backwards compatibility. They work by exporting functions from dlls that are placed in a special API extensions are supported for backwards compatibility. They work by exporting functions from dlls that are placed in a special 
folder. These functions can be referenced from equilla using the folder. These functions can be referenced from equilla using the ImportImport statement. For a detailed documentation read the article  statement. For a detailed documentation read the article CC--
API ExtensionsAPI Extensions..

COMCOM--API EXTENSIONSAPI EXTENSIONS  

These Extensions have been introduced with Tradesignal 6.3 and are the preferred way of extending equilla. You can implement These Extensions have been introduced with Tradesignal 6.3 and are the preferred way of extending equilla. You can implement 
these extensions using programming languages like C#, C++ or any other language that can output COM compatible dlls. COM these extensions using programming languages like C#, C++ or any other language that can output COM compatible dlls. COM 
Extensions allow an Extensions allow an ObjectObject style syntax to access the implemented methods. For a detailed documentation read the article  style syntax to access the implemented methods. For a detailed documentation read the article COMCOM--
API ExtensionsAPI Extensions..    
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INTRODUCTION TO FUNCTIONS, INDICATORS AND 
STRATEGIES 
The hub of all analysis methods in Tradesignal is the available functions, indicators and strategies.The hub of all analysis methods in Tradesignal is the available functions, indicators and strategies.  
  
All three tools are written in All three tools are written in Equilla CodeEquilla Code. This is a Tradesignal. This is a Tradesignal--specific programming language similar to Algol or Visual Basic. specific programming language similar to Algol or Visual Basic. 
No programming knowledge is necessary as long as you use the delivered functions, indicators or strategies. However, if you are No programming knowledge is necessary as long as you use the delivered functions, indicators or strategies. However, if you are 
interested in programming, see the interested in programming, see the Equilla BasicsEquilla Basics chapters for details. chapters for details.

TOOL CHARACTERISTICSTOOL CHARACTERISTICS  

FUNCTIONSFUNCTIONS  

l Functions are subordinate portions of the code in which regularly used calculations and subroutines are sourced out. For Functions are subordinate portions of the code in which regularly used calculations and subroutines are sourced out. For 
example, instead of writing the code for the standard deviation again and again, the calculation is put into a function. By example, instead of writing the code for the standard deviation again and again, the calculation is put into a function. By 
calling up the function by its name calling up the function by its name -- and passing the relevant parameter(s) for calculation  and passing the relevant parameter(s) for calculation -- the user receives the return value  the user receives the return value 
as a result.as a result.  

l A function cannot be applied to a chart directly.A function cannot be applied to a chart directly.  

You can find more information in the chapter You can find more information in the chapter Equilla FunctionsEquilla Functions..

INDICATORSINDICATORS  

l Indicators are mathematical calculations that can be applied to symbol data for technical analysis.Indicators are mathematical calculations that can be applied to symbol data for technical analysis.  
l Indicators can be applied to charts or other indicators, watchlists, portfolios etc.Indicators can be applied to charts or other indicators, watchlists, portfolios etc.  

You can find more information in the chapter You can find more information in the chapter Using IndicatorsUsing Indicators..

STRATEGIESSTRATEGIES  

l Strategies combine the results of indicators with certain rules and conditions for signal generation, to help setting up a Strategies combine the results of indicators with certain rules and conditions for signal generation, to help setting up a 
sophisticated trading system.sophisticated trading system.  

l Strategies can be applied to charts, indicators, watchlists, portfolios etc.Strategies can be applied to charts, indicators, watchlists, portfolios etc.  

You can find more information in the chapter You can find more information in the chapter Using StrategiesUsing Strategies..

EXAMPLE VOLATILITYEXAMPLE VOLATILITY  

l The function "Volatility" calculates the standard deviation from the moving average of the close price.The function "Volatility" calculates the standard deviation from the moving average of the close price.  

l The indicator "Volatility Ratio" uses the Volatility function over two different periods and then calculates the ratio of the two The indicator "Volatility Ratio" uses the Volatility function over two different periods and then calculates the ratio of the two 
results. A Volatility Ratio above 0.5 signals a breakout.results. A Volatility Ratio above 0.5 signals a breakout.  

l The strategy "Volatility Ratio Breakout The strategy "Volatility Ratio Breakout -- Exit" combines the indicator with an Ehlers filter, so that long or short positions are  Exit" combines the indicator with an Ehlers filter, so that long or short positions are 
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closed depending on the development of the volatility.closed depending on the development of the volatility.  

EXAMPLE BOLLINGER BANDSEXAMPLE BOLLINGER BANDS  

l The function "BollingerBands" calculates a simple moving average and an upper and lower standard deviation as bands.The function "BollingerBands" calculates a simple moving average and an upper and lower standard deviation as bands.  

l The indicator "Bollinger Bands" calculates and draws the resulting bands. In the property inspector of the toolbox, the The indicator "Bollinger Bands" calculates and draws the resulting bands. In the property inspector of the toolbox, the 
parameters price (close, high...), period, and standard deviation can be edited.parameters price (close, high...), period, and standard deviation can be edited.  

l The strategy "Bollinger Lower Band The strategy "Bollinger Lower Band -- Entry" combines the results of the indicator with entry signal generation. Entry" combines the results of the indicator with entry signal generation.  

EQUILLA CODE OF THE BOLLINGERBANDS FUNCTIONEQUILLA CODE OF THE BOLLINGERBANDS FUNCTION  

Meta:  

Synopsis( "[Bollinger Bands] Calculates the Bollinger band values for the upper and 

lower deviation bands and the simple moving average and returns them as output parameters. 

Bollinger Bands are an indicator that allows users to compare volatility and relative price 

levels over a period time. The three calculated values are designed to encompass the 

majority of a security's price action. Sharp price increases or decreases (volatility) will 

lead to a widening of the band. Consolidation will result to a thinning of the bands." ); 

 

Inputs:  

Price( NumericSeries ),  

Period( NumericSimple ),  

StdDevs( NumericSimple ), 

RefMidBand( NumericRef ), 

RefUpperBand( NumericRef ), 

RefLowerBand( NumericRef ); 

 

Variables:  

distance, sumSqr, i; 

 

RefMidBand = AverageFC( Price, Period ); 

 

sumSqr = 0; 

For i = 0 To Period ­ 1 Do 

sumSqr = sumSqr + Sqr( Price[i] ­ RefMidBand ); 

 

If sumSqr > 0 And Period > 0 Then  

distance = Sqrt( sumSqr / Period ) * StdDevs 

Else  

distance = 0; 

 

RefUpperBand = RefMidBand + distance; 
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RefLowerBand = RefMidBand ­ distance; 

 

BollingerBands = 1; 

 

// *** Copyright Tradesignal GmbH *** 

// *** www.tradesignal.com *** 

 

EQUILLA CODE OF THE BOLLINGERBANDS INDICATOREQUILLA CODE OF THE BOLLINGERBANDS INDICATOR  

Meta:  

Synopsis( "Bollinger Bands are an indicator that allows users to compare volatility and 

relative price levels over a period time. The indicator consists of a moving average and two 

bands drawn two standard deviations from the average. These three bands are designed to 

encompass the majority of a security's price action. Sharp price increases or decreases 

(volatility) will lead to a widening of the band. Consolidation will result to a thinning of 

the bands." ), 

ShortCode( "BBD" ), 

SubChart( False ); 

 

Inputs:  

Price( Close ),  

Period( 20, 1 ),  

StdDevs( 2.0, 0.0 ); 

 

Variables:  

avg, lowerBand, upperBand; 

 

BollingerBands( Price, Period, StdDevs, avg, upperBand, lowerBand ); 

 

DrawLine( avg, "Mid Line", StyleDot ); 

DrawArea( upperBand, lowerBand, "Upper Band", "Lower Band" ); 

 

// *** Copyright Tradesignal GmbH ***  

// *** www.tradesignal.com *** 

 

EQUILLA CODE OF THE "BOLLINGER LOWER BAND EQUILLA CODE OF THE "BOLLINGER LOWER BAND -- ENTRY" STRATEGY ENTRY" STRATEGY  

Meta: 

Synopsis( "Generates a long entry signal when the Close crosses over the Bollinger Lower 

Band value, and/or generates a short entry signal when the Close crosses under the Bollinger 

Lower Band value. Bollinger Bands are an indicator that allows users to compare volatility 

and relative price levels over a period time. The indicator consists of a moving average and 

two bands drawn two standard deviations from the average. These three bands are designed to 
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encompass the majority of a security's price action. Sharp price increases or decreases 

(volatility) will lead to a widening of the band. Consolidation will result to a thinning of 

the bands." ); 

 

Inputs:  

Price( Close ),  

Period( 20, 1 ),  

StdDevs( 2.0, 0.0 ), 

EntryMethod ( LongEntry, ShortEntry, Both ) = Both, 

Visuals( False ); 

 

Variables:  

longSig, shortSig, avg, upperBand, lowerBand; 

 

BollingerBands( Price, Period, StdDevs, avg, upperBand, lowerBand ); 

 

longSig = ( Close Crosses Over lowerBand ) And ( EntryMethod <> ShortEntry ); 

shortSig = ( Close Crosses Under lowerBand ) And ( EntryMethod <> LongEntry ); 

 

If longSig Then 

Buy( "BollingerLWR" ) Next Bar at Market 

Else If shortSig Then 

Short( "BollingerLWR" ) Next Bar at Market; 

 

If Visuals Then  

DrawLine( lowerBand, "BollingerLowerBand", StyleSolid, 2 ); 

 

// *** Copyright Tradesignal GmbH *** 

// *** www.tradesignal.com *** 
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USING INDICATORS 
Technical indicators are mathematical calculations based on securities and additional data. You can use indicators forTechnical indicators are mathematical calculations based on securities and additional data. You can use indicators for

l Signal generation in mechanical trading systemsSignal generation in mechanical trading systems  
l Detecting trends in symbol chartsDetecting trends in symbol charts  
l Supporting trading decisionsSupporting trading decisions  
l Supporting chart analysisSupporting chart analysis  

In Tradesignal, indicators are available which were developed based on material from various sources (publications, media or inIn Tradesignal, indicators are available which were developed based on material from various sources (publications, media or in--
house development). For all indicators, additional information on the source, the calculation basis, the interpretation of results and house development). For all indicators, additional information on the source, the calculation basis, the interpretation of results and 
the appliance is offered.the appliance is offered.  
  
The indicators in Tradesignal are written in Equilla. You can find more information in the The indicators in Tradesignal are written in Equilla. You can find more information in the Equilla BasicsEquilla Basics chapters.  chapters. 

APPLYING INDICATORSAPPLYING INDICATORS  

APPLYING INDICATORS TO CHARTS OR INDICATORSAPPLYING INDICATORS TO CHARTS OR INDICATORS  

You can apply an indicator to a chart (or an indicator) in various ways.You can apply an indicator to a chart (or an indicator) in various ways.  
Applying from the indicator list in the toolbox:Applying from the indicator list in the toolbox:

1.1. Open the indicator list in the toolbox by clicking on the Open the indicator list in the toolbox by clicking on the IndicatorsIndicatorsIndicatorsIndicators  
button.button.  

2.2. Apply the indicator:Apply the indicator:

1.1. By drag and drop: Click on the indicator, keep the mouse By drag and drop: Click on the indicator, keep the mouse 
button pressed and drag the indicator into the chart.button pressed and drag the indicator into the chart.  

2.2. By doubleBy double--click: Doubleclick: Double--click on the indicator.click on the indicator.  
3.3. From the context menu: RightFrom the context menu: Right--click on the indicator and click on the indicator and 

choose choose ApplyApplyApplyApply from the context menu. from the context menu.  

Applying via the command line in the toolbar:Applying via the command line in the toolbar:

1.1. Enter a shortcode in the command line, for example "BBD".Enter a shortcode in the command line, for example "BBD".  
2.2. Select the Select the Add IndicatorAdd IndicatorAdd IndicatorAdd Indicator option in the drop option in the drop--down menu.down menu.  

DATA INPUT SELECTIONDATA INPUT SELECTION  
Detail: Indicator view in the toolboxDetail: Indicator view in the toolbox
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If you apply an indicator which uses more than one data input the data If you apply an indicator which uses more than one data input the data 
input selection dialog (see image) is displayed. It allows you to select input selection dialog (see image) is displayed. It allows you to select 
either an already existing chart object or to open a new symbol via the either an already existing chart object or to open a new symbol via the 
symbol listssymbol lists or  or symbol searchsymbol search. There also is an . There also is an optionoption to always display  to always display 
this dialog so you can apply indicators to symbols which are not this dialog so you can apply indicators to symbols which are not 
themselves displayed.themselves displayed.

APPLICATION RULESAPPLICATION RULES  

l The indicator is applied to the active chart or subchart, except when The indicator is applied to the active chart or subchart, except when 
using drag and drop.using drag and drop.  

l By default, indicators are applied to the top entry in the chart or By default, indicators are applied to the top entry in the chart or 
subchart legend.subchart legend.  

l When you drag the indicator onto a certain entry in the legend of a When you drag the indicator onto a certain entry in the legend of a 
chart or subchart (for example another indicator), the indicator is applied to this entry.chart or subchart (for example another indicator), the indicator is applied to this entry.  

l Whether a subchart is created for an indicator depends on the meta tag "subchart" in the Equilla Code of the indicator (see Whether a subchart is created for an indicator depends on the meta tag "subchart" in the Equilla Code of the indicator (see 
the chapter the chapter Equilla Program Structure and SyntaxEquilla Program Structure and Syntax).).  

You can see in the legend how to which entry the indicator is applied. It is constructed as You can see in the legend how to which entry the indicator is applied. It is constructed as Indicator[Var1, Var2...] value Indicator[Var1, Var2...] value Indicator[Var1, Var2...] value Indicator[Var1, Var2...] value 
{applied to}{applied to}{applied to}{applied to}..  
  
Example:Example:

l Chart: DAX PChart: DAX P--IN. [.DAX LAST 1 hour]...IN. [.DAX LAST 1 hour]...  
l Subchart#1: Accelerator [Close, 10, 13] 32.02 {.DAX}Subchart#1: Accelerator [Close, 10, 13] 32.02 {.DAX}  
l Subchart#2: Average True Range [14] 122.44 {Accelerator}Subchart#2: Average True Range [14] 122.44 {Accelerator}  

EXAMPLE: APPLYING BOLLINGER BANDS TO A CHARTEXAMPLE: APPLYING BOLLINGER BANDS TO A CHART  

Detail: Entering a shortcode in the commandlineDetail: Entering a shortcode in the commandline

Data input selection dialogData input selection dialog
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1.1. Open the .NDX in a chart and set the time span to "1 Year" (via the Open the .NDX in a chart and set the time span to "1 Year" (via the 
"Fixed Data Range" entry)."Fixed Data Range" entry).  

2.2. In the indicator list in the toolbox, search for "Bollinger Bands".In the indicator list in the toolbox, search for "Bollinger Bands".  
3.3. Drag the indicator into the graph. The Bollinger Bands are calculated Drag the indicator into the graph. The Bollinger Bands are calculated 

for the .NDX and enfold the line.for the .NDX and enfold the line.  

EXAMPLE: APPLYING BOLLINGER BANDS TO AN INDICATOREXAMPLE: APPLYING BOLLINGER BANDS TO AN INDICATOR  

A popular combination is the "Relative Strength Index" (RSI) with added A popular combination is the "Relative Strength Index" (RSI) with added 
Bollinger Bands. Proceed as follows:Bollinger Bands. Proceed as follows:

1.1. To your chart, apply the "Relative Strength Index" (RSI) indicator as To your chart, apply the "Relative Strength Index" (RSI) indicator as 
described above. The result is displayed in a subchart.described above. The result is displayed in a subchart.  

2.2. Select the RSI subchart by clicking into the subchart.Select the RSI subchart by clicking into the subchart.  
3.3. Now apply the "Bollinger Bands" (BBD) indicators to the RSI subchart. The Bollinger Bands are calculated for the RSI and Now apply the "Bollinger Bands" (BBD) indicators to the RSI subchart. The Bollinger Bands are calculated for the RSI and 

enfold its line.enfold its line.  

APPLYING INDICATORS TO SCANNER, WATCHLIST OR PORTFOLIOAPPLYING INDICATORS TO SCANNER, WATCHLIST OR PORTFOLIO  

You can also apply indicators to symbol tables such as the You can also apply indicators to symbol tables such as the ScannerScanner, , WatchlistWatchlist or  or PortfolioPortfolio. . 

l When creating a new Scanner, Watchlist or Portfolio, you can directly add indicators (and strategies).When creating a new Scanner, Watchlist or Portfolio, you can directly add indicators (and strategies).  

l For existing tables, you can add indicators to the selected table by using one of the methods described above. A new column For existing tables, you can add indicators to the selected table by using one of the methods described above. A new column 
is added for the results.is added for the results.  

EXAMPLE: SCANNER WITH INDICATOREXAMPLE: SCANNER WITH INDICATOR  

TheThe Scanner is intended for screening a high number or securities for certain criteria. For example, create a Relative Strength list for  Scanner is intended for screening a high number or securities for certain criteria. For example, create a Relative Strength list for 
the hundred Nasdaq values by adding the "Relative Strength Levy" (RLS) to the Scanner and starting the scan. The new column is the hundred Nasdaq values by adding the "Relative Strength Levy" (RLS) to the Scanner and starting the scan. The new column is 
added and displays the RLS for each instrument.added and displays the RLS for each instrument.  

EXAMPLE: WATCHLIST WITH INDICATOREXAMPLE: WATCHLIST WITH INDICATOR  

The Watchlist is intended for realtime data. For example, drag the Momentum indicator into the table, enter a short trading period The Watchlist is intended for realtime data. For example, drag the Momentum indicator into the table, enter a short trading period 
and activate the alert function of the indicator. Now Tradesignal issues an alert any time a value in the Watchlist triggers a and activate the alert function of the indicator. Now Tradesignal issues an alert any time a value in the Watchlist triggers a 
Momentum signal.Momentum signal.

APPLYING INDICATORS VIA THE COMMAND LINEAPPLYING INDICATORS VIA THE COMMAND LINE  

SHORTCODESSHORTCODES  

All indicators delivered with Tradesignal feature a shortcode. These are part of the original programming in the Equilla code and All indicators delivered with Tradesignal feature a shortcode. These are part of the original programming in the Equilla code and 
should not be changed. Via the command line, an indicator can be applied to Charts, Scanners, Watchlists, and Portfolios. This is should not be changed. Via the command line, an indicator can be applied to Charts, Scanners, Watchlists, and Portfolios. This is 
faster than applying indicators from the toolbox.faster than applying indicators from the toolbox.  

Detail: Applying Bollinger Bands to the .NDXDetail: Applying Bollinger Bands to the .NDX
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The shortcodes can be looked up in the tooltips of indicators in the toolbox. To display a tooltip, move the mouse over the indicator The shortcodes can be looked up in the tooltips of indicators in the toolbox. To display a tooltip, move the mouse over the indicator 
entry. entry. 

EQUILLA CODEEQUILLA CODE  

Basically, indicators are constructed so that the calculations are done in functions. An Equilla function can be entered in the Basically, indicators are constructed so that the calculations are done in functions. An Equilla function can be entered in the Equilla Equilla 
EditorEditor as well as the command line. With a bit of practice, it is possible to enter creative combinations without spending much  as well as the command line. With a bit of practice, it is possible to enter creative combinations without spending much 
time on programming. You can find the list of available Equilla functions in the toolbox by clicking on time on programming. You can find the list of available Equilla functions in the toolbox by clicking on FunctionsFunctionsFunctionsFunctions. Most names are . Most names are 
constructed to make the connections between the indicators and their functions obvious.constructed to make the connections between the indicators and their functions obvious.

EXAMPLE FOR DIRECTLY ENTERING AN INDICATOREXAMPLE FOR DIRECTLY ENTERING AN INDICATOR  

To apply an RSI (smoothed by an Exponential Moving Average), proceed as follows:To apply an RSI (smoothed by an Exponential Moving Average), proceed as follows:

1.1. Open or activate a chart.Open or activate a chart.  
2.2. Enter the following code in the command line:Enter the following code in the command line:  

Drawline(XAverage(RSI(Close,14),5)) 

and select the option and select the option Add formulaAdd formulaAdd formulaAdd formula in the drop in the drop--down menu.down menu.  
  
You can find more information in the chapter You can find more information in the chapter Command LineCommand Line..

DELETING INDICATORSDELETING INDICATORS  

DELETING AN INDICATOR FROM THE CHARTDELETING AN INDICATOR FROM THE CHART  

There are two ways to delete an indicator from a chart:There are two ways to delete an indicator from a chart:

l The indicator is displayed in the legend at the top left of the chart or subchart. RightThe indicator is displayed in the legend at the top left of the chart or subchart. Right--click on the entry to open the context click on the entry to open the context 
menu and select menu and select DeleteDeleteDeleteDelete..  

l Alternatively, select the entry in the legend and press the Alternatively, select the entry in the legend and press the DELDELDELDEL key. key.  

To delete a complete subchart of an indicator, click on the X button on the top right. Empty subcharts are closed automatically. To delete a complete subchart of an indicator, click on the X button on the top right. Empty subcharts are closed automatically. 

DELETING AN INDICATOR FROM A SCANNER, WATCHLIST OR PORTFOLIODELETING AN INDICATOR FROM A SCANNER, WATCHLIST OR PORTFOLIO  

l To delete an indicator from a table, rightTo delete an indicator from a table, right--click on the table header and select click on the table header and select Add/Remove ColumnsAdd/Remove ColumnsAdd/Remove ColumnsAdd/Remove Columns..  
l Alternatively, click on the Alternatively, click on the ColumnsColumnsColumnsColumns button and select  button and select Add/Remove ColumnsAdd/Remove ColumnsAdd/Remove ColumnsAdd/Remove Columns from the button menu. You can find more  from the button menu. You can find more 

information in the chapters information in the chapters ScannerScanner, , WatchlistWatchlist and  and PortfolioPortfolio..  

REMOVING AN INDICATOR FROM TRADESIGNALREMOVING AN INDICATOR FROM TRADESIGNAL  
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To delete an indicator from the list in Tradesignal, rightTo delete an indicator from the list in Tradesignal, right--click the indicator in the toolbox and select click the indicator in the toolbox and select DeleteDeleteDeleteDelete from the context menu.  from the context menu. 
A warning asks you to confirm the deletion.A warning asks you to confirm the deletion.

CREATING A NEW INDICATORCREATING A NEW INDICATOR  

To create a new indicator, click on the link To create a new indicator, click on the link New IndicatorNew IndicatorNew IndicatorNew Indicator in the  in the Related Related 
TasksTasks area of the toolbox. A Wizard opens, offering two options: area of the toolbox. A Wizard opens, offering two options:

l Use the Equilla Formula Language to write the indicatorUse the Equilla Formula Language to write the indicatorUse the Equilla Formula Language to write the indicatorUse the Equilla Formula Language to write the indicator  --  
Select this option if you want to write the indicator yourself. You Select this option if you want to write the indicator yourself. You 
can find more information in the chapter can find more information in the chapter Writing IndicatorsWriting Indicators..  

l Download an existing indicator from Tradesignal OnlineDownload an existing indicator from Tradesignal OnlineDownload an existing indicator from Tradesignal OnlineDownload an existing indicator from Tradesignal Online  --  
Select this option if you want to download a readySelect this option if you want to download a ready--made indicator made indicator 
from the website.from the website.  

DOWNLOADING AN INDICATOR FROM TRADESIGNAL DOWNLOADING AN INDICATOR FROM TRADESIGNAL 
ONLINEONLINE  

When you select the second option, the internal web browser opens and When you select the second option, the internal web browser opens and 
the entry "Indikatoren" in the Tradesignal lexicon appears. the entry "Indikatoren" in the Tradesignal lexicon appears.   
  
Click on an indicator in the list. The entry for this indicator opens. At the Click on an indicator in the list. The entry for this indicator opens. At the 
bottom of the page, you will find one or more Equilla scripts (if available) bottom of the page, you will find one or more Equilla scripts (if available) 
and saving options:and saving options:

l Quelltext anzeigenQuelltext anzeigenQuelltext anzeigenQuelltext anzeigen (show code)  (show code) ––  Displays the Equilla code in the Displays the Equilla code in the 
internal web browser. You can select and copy this code and, for internal web browser. You can select and copy this code and, for 
example, paste it into the Equilla editor in Tradesignal Standard example, paste it into the Equilla editor in Tradesignal Standard 
Edition.Edition.  

l Skript in Tradesignal Web Edition importierenSkript in Tradesignal Web Edition importierenSkript in Tradesignal Web Edition importierenSkript in Tradesignal Web Edition importieren (import into  (import into 
Tradesignal Web Edition) Tradesignal Web Edition) ––  Saves the script in Tradesignal Web Saves the script in Tradesignal Web 
Edition. You can then find it in the list of all indicators in the web edition. To save the script in the web edition, you have to Edition. You can then find it in the list of all indicators in the web edition. To save the script in the web edition, you have to 
be logged into the Tradesignal Online website. In the case of the error message "Not enough space to import the script", you be logged into the Tradesignal Online website. In the case of the error message "Not enough space to import the script", you 
are either not logged in or there is not enough web space left to save the script.are either not logged in or there is not enough web space left to save the script.  

l Skript in Tradesignal importierenSkript in Tradesignal importierenSkript in Tradesignal importierenSkript in Tradesignal importieren (import into Tradesignal Standard Edition)  (import into Tradesignal Standard Edition) ––  Saves the script in Tradesignal Standard Saves the script in Tradesignal Standard 
Edition. You can create the indicator in an existing package or create a new package.Edition. You can create the indicator in an existing package or create a new package.  

In the case of a new package, the following procedure is recommended:In the case of a new package, the following procedure is recommended:

1.1. Click on the button Click on the button New packageNew packageNew packageNew package..  
2.2. Select the main package Select the main package Tradesignal FilesTradesignal Files..  
3.3. Click on Click on New FolderNew FolderNew FolderNew Folder and enter the name "Personal Indicators". and enter the name "Personal Indicators".  
4.4. Confirm all settings by clicking on the Confirm all settings by clicking on the OKOKOKOK buttons. buttons.  

EDITING THE EQUILLA CODE OF AN INDICATOREDITING THE EQUILLA CODE OF AN INDICATOR  

Indicator Wizard Indicator Wizard --  start screenstart screen

Indicator Wizard Indicator Wizard --  download listdownload list
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l To edit the source code of an indicator, rightTo edit the source code of an indicator, right--click the indicator in the chart legend and select click the indicator in the chart legend and select Edit Equilla CodeEdit Equilla CodeEdit Equilla CodeEdit Equilla Code from the  from the 
context menu.context menu.  

l Alternatively, rightAlternatively, right--click the indicator in the toolbox and select click the indicator in the toolbox and select EditEditEditEdit from the context menu. from the context menu.  

The source code is opened in the The source code is opened in the Equilla EditorEquilla Editor..  
  
You can find more information in the You can find more information in the EquillaEquilla chapters. chapters.

INDICATOR PROPERTIESINDICATOR PROPERTIES  

The indicator properties are available either from the context menu in the The indicator properties are available either from the context menu in the 
chart or the property inspector in the toolbox. Select the indicator from the chart or the property inspector in the toolbox. Select the indicator from the 
list of elements at the top to open the properties. list of elements at the top to open the properties.   
  
Each indicator offers various parameters like display units, period, Each indicator offers various parameters like display units, period, 
weighting factors, multipliers etc. Often, values for additional scale units weighting factors, multipliers etc. Often, values for additional scale units 
like oversold or overbought levels are available. Enter all necessary like oversold or overbought levels are available. Enter all necessary 
parameters.parameters.  
  
For each element in an indicator (i.e. the indicator or its signal lines, For each element in an indicator (i.e. the indicator or its signal lines, 
graphic symbols or extrema), display properties can be entered such as line graphic symbols or extrema), display properties can be entered such as line 
widths, colors or shadows. widths, colors or shadows.   
  
For some Tradesignal indicators it is possible to set an alert, which will be For some Tradesignal indicators it is possible to set an alert, which will be 
created as soon as a defined condition is met, e.g. for SMA (when the created as soon as a defined condition is met, e.g. for SMA (when the 
Moving Average Simple crosses the main data curve). Moving Average Simple crosses the main data curve). AlertsAlerts will be  will be 
displayed as a flashing icon in the system tray and as a popup window by displayed as a flashing icon in the system tray and as a popup window by 
default. Furthermore, you can find information about all alerts generated by an indicator in the default. Furthermore, you can find information about all alerts generated by an indicator in the alert windowalert window on the  on the chart alertschart alertschart alertschart alerts  
tab.tab.

CHANGING THE EVALUATION ORDER OF INDICATORS AND STRATEGIESCHANGING THE EVALUATION ORDER OF INDICATORS AND STRATEGIES  

In some circumstances, indicators and strategies must be evaluated in a specific order. Normally this is taken care of by In some circumstances, indicators and strategies must be evaluated in a specific order. Normally this is taken care of by 
Tradesignal, however there are cases where it is not possible to automatically determine which item should go first. For example if Tradesignal, however there are cases where it is not possible to automatically determine which item should go first. For example if 
multiple indicators use the same Global Variables. By default, indicators and strategies are evaluated in the order they are added to multiple indicators use the same Global Variables. By default, indicators and strategies are evaluated in the order they are added to 
the chart, watchlist, scanner or portfolio. To change this orderthe chart, watchlist, scanner or portfolio. To change this order

1.1. Click on Click on Home > Chart > Manage ObjectsHome > Chart > Manage Objects on the toolbar to show the  on the toolbar to show the Manage Strategies and Indicators dialogManage Strategies and Indicators dialogManage Strategies and Indicators dialogManage Strategies and Indicators dialog..  
2.2. Click on the item in the list that needs to be evaluated differently.Click on the item in the list that needs to be evaluated differently.  
3.3. Click on the Click on the Move UpMove UpMove UpMove Up or  or Move DownMove DownMove DownMove Down buttons to reposition the item. Items closer to the top are evaluated earlier. buttons to reposition the item. Items closer to the top are evaluated earlier.  
4.4. Click Click OKOKOKOK to commit the changes. to commit the changes.  

Detail: Bollinger Bands PropertiesDetail: Bollinger Bands Properties
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WRITING INDICATORS 
In Tradesignal, many indicators are available, either delivered with the software or offered for download from the website.In Tradesignal, many indicators are available, either delivered with the software or offered for download from the website.    
  
However, wishes may remain unfulfilled or you may have new ideas that need to be tested. In these cases, you can always However, wishes may remain unfulfilled or you may have new ideas that need to be tested. In these cases, you can always 
program new indicators in Tradesignal by using the Equilla language. program new indicators in Tradesignal by using the Equilla language.   
  
In the following you will find an example showing how to write an indicator using Equilla. It is only intended to give you a basic In the following you will find an example showing how to write an indicator using Equilla. It is only intended to give you a basic 
introduction. For details on Equilla, please refer to the introduction. For details on Equilla, please refer to the Equilla BasicsEquilla Basics chapters. chapters.

PROGRAMMING TRADING BASED ON A RELATIVE STRENGTH INDEXPROGRAMMING TRADING BASED ON A RELATIVE STRENGTH INDEX  

CREATING THE INDICATORCREATING THE INDICATOR  

1.1. In the toolbox, click on the In the toolbox, click on the IndicatorsIndicatorsIndicatorsIndicators button. button.  
2.2. In the In the Related TasksRelated Tasks area, select  area, select New IndicatorNew IndicatorNew IndicatorNew Indicator..  
3.3. In the next dialog, select the option In the next dialog, select the option Use the Equilla Formula Use the Equilla Formula Use the Equilla Formula Use the Equilla Formula 

Language to write the indicatorLanguage to write the indicatorLanguage to write the indicatorLanguage to write the indicator..  
4.4. Select a folder, e.g. "Tradesignal Files".Select a folder, e.g. "Tradesignal Files".  
5.5. Type the name "RSIType the name "RSI--Bands".Bands".  
6.6. Click on Click on DoneDoneDoneDone..  

Now you can enter the source code of the indicator in the Now you can enter the source code of the indicator in the Equilla EditorEquilla Editor..

ENTERING THE META INFORMATIONENTERING THE META INFORMATION  

In the meta area, global information about the indicator and its display are entered. These are declared using meta tags. In the meta area, global information about the indicator and its display are entered. These are declared using meta tags.   
  

Meta: 

Subchart(false); 

DECLARING THE INPUT PARAMETERSDECLARING THE INPUT PARAMETERS  

In the input area, parameters are declared that can later be edited and changed by the user during indicator runtime. In this case, In the input area, parameters are declared that can later be edited and changed by the user during indicator runtime. In this case, 
these are mainly a smoothing factor and the calculation period. these are mainly a smoothing factor and the calculation period.   
  

Inputs:  

Period( 20 , 1 ), 

Smoothing( 10 , 1 ), 

Factor( 1.0 ); 

Writing a new indicatorWriting a new indicator
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DECLARING THE VARIABLESDECLARING THE VARIABLES  

Variables are data containers in which the values of calculation results are temporarily saved and therefore available for future use. Variables are data containers in which the values of calculation results are temporarily saved and therefore available for future use. 
  
  

Variables:  

rsiValue, upperBand, lowerBand, medLine; 

PERFORMING THE CALCULATIONSPERFORMING THE CALCULATIONS  

In this area, the actual calculations are done, whose results are displayed later. In our example, the continuous regression line is In this area, the actual calculations are done, whose results are displayed later. In our example, the continuous regression line is 
taken as midtaken as mid--line. With it, the Relative Strength Index is calculated, which is a measure for the strength and dynamics of the trend. line. With it, the Relative Strength Index is calculated, which is a measure for the strength and dynamics of the trend. 
The actual bands result from simply adding and subtracting the RSI from the midThe actual bands result from simply adding and subtracting the RSI from the mid--line.line.  
  

medLine = LinRegValue( Close, Smoothing, 0); 

rsiValue = RSI( Close, Period ); 

upperBand = medLine + ( rsiValue * factor ); 

lowerBand = medLine ­ ( rsiValue * factor ); 

INSERTING THE GRAPHINSERTING THE GRAPH  

Finally, the calculation results have to be displayed. This is usually done at the end of the indicator code. Finally, the calculation results have to be displayed. This is usually done at the end of the indicator code. 

DrawLine( medLine, "Average", StyleSolid, 1, black); 

DrawLine( upperBand, "Upper", StyleSolid, 2, red ); 

DrawLine( lowerBand, "Lower", StyleSolid, 2, darkgreen ); 

THE COMPLETE CODETHE COMPLETE CODE  

Meta: 

Subchart(false); 

 

Inputs:  

Period( 20 , 1 ), 

Smoothing( 10 , 1 ), 

Factor( 1.0 ); 

 

Variables:  

rsiValue, upperBand, lowerBand, medLine; 

 

medLine = LinRegValue( Close, Smoothing, 0); 



:: www.tradesignal.comwww.tradesignal.com

Tradesignal GmbHTradesignal GmbH Page 380Page 380 Version 7.0Version 7.0

rsiValue = RSI( Close, Period ); 

upperBand = medLine + ( rsiValue * factor ); 

lowerBand = medLine ­ ( rsiValue * factor ); 

 

DrawLine( medLine, "Average", StyleSolid, 1, black); 

DrawLine( upperBand, "Upper", StyleSolid, 2, red ); 

DrawLine( lowerBand, "Lower", StyleSolid, 2, darkgreen ); 

APPLYING THE INDICATORAPPLYING THE INDICATOR  

Compile the code either by pressing Compile the code either by pressing F7F7F7F7 or by clicking on the button  or by clicking on the button Compile ScriptCompile ScriptCompile ScriptCompile Script in the  in the Equilla EditorEquilla Editor group. The code is checked  group. The code is checked 
for errors, saved and then available in the list of indicators in the toolbox by the name "RSIfor errors, saved and then available in the list of indicators in the toolbox by the name "RSI--Bands".Bands".  
  
You can now apply it to a chart as described in You can now apply it to a chart as described in Using IndicatorsUsing Indicators, for example with drag and drop., for example with drag and drop.    
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USING STRATEGIES 
In the traditional sense, trading systems are compilations of rules from which trading decisions of any kind result. You can find In the traditional sense, trading systems are compilations of rules from which trading decisions of any kind result. You can find 
more information in the chapter more information in the chapter Using Trading StrategiesUsing Trading Strategies..    
  
One of the important aspects of trading systems is the strategies. Strategies combine indicators with entry and exit rules. One of the important aspects of trading systems is the strategies. Strategies combine indicators with entry and exit rules.   
  
In Tradesignal, strategies are available which were developed based on material from various sources (publications, media or inIn Tradesignal, strategies are available which were developed based on material from various sources (publications, media or in--
house development). For all strategies, additional information on the source, the calculation basis, the interpretation of results and house development). For all strategies, additional information on the source, the calculation basis, the interpretation of results and 
the appliance is offered.the appliance is offered.  
  
The strategies in Tradesignal are written in Equilla. You can find more information in the The strategies in Tradesignal are written in Equilla. You can find more information in the Equilla BasicsEquilla Basics chapters.  chapters. 

APPLYING STRATEGIESAPPLYING STRATEGIES  

APPLYING STRATEGIES TO CHARTS OR INDICATORSAPPLYING STRATEGIES TO CHARTS OR INDICATORS  

l You can apply a strategy to a chart by clicking on the You can apply a strategy to a chart by clicking on the Add StrategyAdd StrategyAdd StrategyAdd Strategy  
button under button under Home > Strategies/IndicatorsHome > Strategies/Indicators on the toolbar. This  on the toolbar. This 
opens a new dialog in which the strategies are sorted in categories opens a new dialog in which the strategies are sorted in categories 
and synopses are displayed (if the corresponding option is selected).and synopses are displayed (if the corresponding option is selected).  

l You can also apply a strategy to a chart (or an indicator) from the You can also apply a strategy to a chart (or an indicator) from the 
strategies list in the toolbox:strategies list in the toolbox:  

1.1. Open the strategy list in the toolbox by clicking on the Open the strategy list in the toolbox by clicking on the StrategiesStrategiesStrategiesStrategies  
button.button.  

2.2. Apply the strategy:Apply the strategy:

1.1. By drag and drop: Click on the strategy, keep the mouse By drag and drop: Click on the strategy, keep the mouse 
button pressed and drag the strategy into the chart.button pressed and drag the strategy into the chart.  

2.2. By doubleBy double--click: Doubleclick: Double--click on the strategy.click on the strategy.  
3.3. From the context menu: RightFrom the context menu: Right--click on the strategy and choose click on the strategy and choose 

ApplyApplyApplyApply from the context menu. from the context menu.  

Application RulesApplication RulesApplication RulesApplication Rules

l The strategy is applied to the active chart or subchart, except when The strategy is applied to the active chart or subchart, except when 
using drag and drop.using drag and drop.  

l By default, strategies are applied to the top entry in the chart or By default, strategies are applied to the top entry in the chart or 
subchart legend.subchart legend.  

l When you drag the strategy onto a certain entry in the legend of a When you drag the strategy onto a certain entry in the legend of a 
chart or subchart (for example an indicator), the strategy is applied to this entry.chart or subchart (for example an indicator), the strategy is applied to this entry.  

l Whether a subchart is created for a strategy depends on the meta tag "subchart" in the Equilla Code of the strategy (see the Whether a subchart is created for a strategy depends on the meta tag "subchart" in the Equilla Code of the strategy (see the 
chapter chapter Equilla Program Structure and SyntaxEquilla Program Structure and Syntax).).  

Window view "Add Strategy"Window view "Add Strategy"

Detail: Strategy view in the toolboxDetail: Strategy view in the toolbox
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You can see in the legend how to which entry the strategy is applied. It is constructed as You can see in the legend how to which entry the strategy is applied. It is constructed as   
  
Strategy[Var1, Var2...] value {applied to}Strategy[Var1, Var2...] value {applied to}Strategy[Var1, Var2...] value {applied to}Strategy[Var1, Var2...] value {applied to}..  
  
Example:Example:

l Chart: DAX PChart: DAX P--IN. [.DAX LAST 1 hour]...IN. [.DAX LAST 1 hour]...  
l Accelerator Accelerator -- Entry [10, 13, 5] {.DAX} Entry [10, 13, 5] {.DAX}  

Since a strategy combines indicators with various conditions, more parameters are possible than for indicators, e.g. for risk control.Since a strategy combines indicators with various conditions, more parameters are possible than for indicators, e.g. for risk control.

EXAMPLE: APPLYING A DMI CROSSOVER SYSTEM TO THE NASDAQEXAMPLE: APPLYING A DMI CROSSOVER SYSTEM TO THE NASDAQ  

OPEN AND EDIT A CHARTOPEN AND EDIT A CHART  

1.1. Enter the shortcut for the US Nasdaq ".NDX.X" in the Enter the shortcut for the US Nasdaq ".NDX.X" in the Command Command 
LineLine..  

2.2. Select the option Select the option New ChartNew ChartNew ChartNew Chart from the drop from the drop--down menu.down menu.  
3.3. RightRight--click into the empty area of the chart and select the click into the empty area of the chart and select the 

PropertiesPropertiesPropertiesProperties from the context menu. from the context menu.  
4.4. Set the Set the History LengthHistory LengthHistory LengthHistory Length to "2500" and press the ENTER key. to "2500" and press the ENTER key.  
5.5. DoubleDouble--click the time axis to display the full history.click the time axis to display the full history.  

SELECT THE STRATEGYSELECT THE STRATEGY  

1.1. Click on the Click on the StrategiesStrategiesStrategiesStrategies button in the  button in the ToolboxToolbox..  
2.2. Search for the two "DMI Cross Over" systems and drag them into the chart.Search for the two "DMI Cross Over" systems and drag them into the chart.  

ENTER SIMPLE RULES FOR RISK CONTROLENTER SIMPLE RULES FOR RISK CONTROL  

1.1. In the upper area of the property inspector, click on In the upper area of the property inspector, click on Money Money 
ManagementManagement..  

2.2. Go to the area Go to the area RiskRisk in the properties. in the properties.  
3.3. Set Set Stop ModeStop ModeStop ModeStop Mode to "Contract". to "Contract".  
4.4. Select Select Stop LossStop LossStop LossStop Loss and enter "75". and enter "75".  
5.5. Select Select Break EvenBreak EvenBreak EvenBreak Even and enter "50". and enter "50".  
6.6. Select Select Profit TargetProfit TargetProfit TargetProfit Target and enter "300". and enter "300".  

Now the strategy is configured.Now the strategy is configured.

APPLYING STRATEGIES TO SCANNER, WATCHLIST OR APPLYING STRATEGIES TO SCANNER, WATCHLIST OR 
PORTFOLIOPORTFOLIO  

You can apply strategies also to symbol tables such as the You can apply strategies also to symbol tables such as the ScannerScanner, , 
WatchlistWatchlist or  or PortfolioPortfolio. . 

DMI Crossover applied to the .NDX.XDMI Crossover applied to the .NDX.X

Detail: Money ManagementDetail: Money Management
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l When creating a new Scanner, Watchlist or Portfolio, you can When creating a new Scanner, Watchlist or Portfolio, you can 
directly add strategies (and indicators).directly add strategies (and indicators).  

l For existing tables, you can add strategies to the selected table by using one of the methods described above. A new column For existing tables, you can add strategies to the selected table by using one of the methods described above. A new column 
is added for the results.is added for the results.  

DELETING STRATEGIESDELETING STRATEGIES  

DELETING A STRATEGY FROM THE CHARTDELETING A STRATEGY FROM THE CHART  

There are two ways to delete a strategy from a chart:There are two ways to delete a strategy from a chart:

l The strategy is displayed in the legend at the top left of the chart or subchart. RightThe strategy is displayed in the legend at the top left of the chart or subchart. Right--click on the entry to open the context click on the entry to open the context 
menu and select menu and select DeleteDeleteDeleteDelete..  

l Alternatively, select the entry in the legend and press the Alternatively, select the entry in the legend and press the DELDELDELDEL key. key.  

To delete a complete subchart of a strategy, click on the X button on the top right. Empty subcharts are closed automatically. To delete a complete subchart of a strategy, click on the X button on the top right. Empty subcharts are closed automatically. 

DELETING A STRATEGY FROM A SCANNER, WATCHLIST OR PORTFOLIODELETING A STRATEGY FROM A SCANNER, WATCHLIST OR PORTFOLIO  

l To delete a strategy from a table, rightTo delete a strategy from a table, right--click on the table header and select click on the table header and select Add/Remove ColumnsAdd/Remove ColumnsAdd/Remove ColumnsAdd/Remove Columns..  
l Alternatively, click on the Alternatively, click on the ColumnsColumnsColumnsColumns button and select  button and select Add/Remove ColumnsAdd/Remove ColumnsAdd/Remove ColumnsAdd/Remove Columns from the button menu. You can find more  from the button menu. You can find more 

information in the chapters information in the chapters ScannerScanner, , WatchlistWatchlist and  and PortfolioPortfolio..  

REMOVING A STRATEGY FROM TRADESIGNALREMOVING A STRATEGY FROM TRADESIGNAL  

To delete a strategy from the list in Tradesignal, rightTo delete a strategy from the list in Tradesignal, right--click the strategy in the toolbox and select click the strategy in the toolbox and select DeleteDeleteDeleteDelete from the context menu. A  from the context menu. A 
warning asks you to confirm the deletion.warning asks you to confirm the deletion.

CREATING A NEW STRATEGYCREATING A NEW STRATEGY  

To create a new strategy, click on the link To create a new strategy, click on the link New StrategyNew StrategyNew StrategyNew Strategy in the  in the Related Related 
TasksTasks area of the toolbox. A Wizard opens, offering two options: area of the toolbox. A Wizard opens, offering two options:

l Use the Equilla Formula Language to write the strategyUse the Equilla Formula Language to write the strategyUse the Equilla Formula Language to write the strategyUse the Equilla Formula Language to write the strategy  --  
Select this option if you want to write the strategy yourself. You can Select this option if you want to write the strategy yourself. You can 
find more information in the chapter find more information in the chapter Writing StrategiesWriting Strategies..  

l Download an existing strategy from Tradesignal OnlineDownload an existing strategy from Tradesignal OnlineDownload an existing strategy from Tradesignal OnlineDownload an existing strategy from Tradesignal Online  --  
Select this option if you want to download a readySelect this option if you want to download a ready--made strategy made strategy 
from the website.from the website.  

l Use the Trading Strategy Wizard to create the strategyUse the Trading Strategy Wizard to create the strategyUse the Trading Strategy Wizard to create the strategyUse the Trading Strategy Wizard to create the strategy  --  
Select this option to use the Select this option to use the Trading Strategy WizardTrading Strategy Wizard. It supports you . It supports you 
in creating your own strategies without having to code in Equilla.in creating your own strategies without having to code in Equilla.  

Strategy Wizard Strategy Wizard -- start screen start screen
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DOWNLOADING A STRATEGY FROM TRADESIGNAL ONLINEDOWNLOADING A STRATEGY FROM TRADESIGNAL ONLINE  

When you select the second option, the internal web browser opens and When you select the second option, the internal web browser opens and 
the entry "Handelssysteme" (strategies) in the Tradesignal lexicon appears. the entry "Handelssysteme" (strategies) in the Tradesignal lexicon appears.   
  
Click on a strategy in the list. The entry for this strategy opens. At the Click on a strategy in the list. The entry for this strategy opens. At the 
bottom of the page, you will find one or more Equilla scripts (if available) bottom of the page, you will find one or more Equilla scripts (if available) 
and saving options:and saving options:

l Quelltext anzeigenQuelltext anzeigenQuelltext anzeigenQuelltext anzeigen (show code)  (show code) ––  Displays the Equilla code in the Displays the Equilla code in the 
internal web browser. You can select and copy this code and, for internal web browser. You can select and copy this code and, for 
example, paste it into the Equilla editor in the Tradesignal Standard example, paste it into the Equilla editor in the Tradesignal Standard 
Edition.Edition.  

l Skript in Tradesignal Web Edition importierenSkript in Tradesignal Web Edition importierenSkript in Tradesignal Web Edition importierenSkript in Tradesignal Web Edition importieren (import into  (import into 
Tradesignal Web Edition) Tradesignal Web Edition) ––  Saves the script in the Tradesignal Web Saves the script in the Tradesignal Web 
Edition. You can then find it in the list of all strategies in the web Edition. You can then find it in the list of all strategies in the web 
edition. To save the script in the web edition, you have to be logged into the Tradesignal Online website. In the case of the edition. To save the script in the web edition, you have to be logged into the Tradesignal Online website. In the case of the 
error message "Not enough space to import the script", you are either not logged in or there is not enough web space left to error message "Not enough space to import the script", you are either not logged in or there is not enough web space left to 
save the script.save the script.  

l Skript in Tradesignal Standard Edition importierenSkript in Tradesignal Standard Edition importierenSkript in Tradesignal Standard Edition importierenSkript in Tradesignal Standard Edition importieren (import into Tradesignal Standard Edition)  (import into Tradesignal Standard Edition) ––  Saves the script in the Saves the script in the 
Tradesignal Standard Edition. You can create the strategy in an existing package or create a new package.Tradesignal Standard Edition. You can create the strategy in an existing package or create a new package.  

In the case of a new package, the following procedure is recommended:In the case of a new package, the following procedure is recommended:

1.1. Click on the button Click on the button New packageNew packageNew packageNew package..  
2.2. Select the main package Select the main package Tradesignal FilesTradesignal Files..  
3.3. Click on Click on New FolderNew FolderNew FolderNew Folder and enter the name "Personal Strategies". and enter the name "Personal Strategies".  
4.4. Confirm all settings by clicking on the Confirm all settings by clicking on the OKOKOKOK buttons. buttons.  

EDITING THE EQUILLA CODE OF A STRATEGYEDITING THE EQUILLA CODE OF A STRATEGY  

l To edit the source code of a strategy, rightTo edit the source code of a strategy, right--click the strategy in the chart legend and select click the strategy in the chart legend and select Edit Equilla CodeEdit Equilla CodeEdit Equilla CodeEdit Equilla Code from the  from the 
context menu.context menu.  

l Alternatively, rightAlternatively, right--click the strategy in the toolbox and select click the strategy in the toolbox and select EditEditEditEdit from the context menu. from the context menu.  

The source code is opened in the The source code is opened in the Equilla EditorEquilla Editor..  
  
You can find more information in the You can find more information in the EquillaEquilla chapters. chapters.

STRATEGY PROPERTIESSTRATEGY PROPERTIES  

The strategy properties are available either from the context menu in the chart or the property inspector in the toolbox. Select the The strategy properties are available either from the context menu in the chart or the property inspector in the toolbox. Select the 
strategy from the list of elements at the top to open the properties. strategy from the list of elements at the top to open the properties.   
  

Strategy Wizard Strategy Wizard --  download listdownload list
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Each strategy offers various parameters such as display units, period, uplevel, entry/exit methods etc. Enter all necessary Each strategy offers various parameters such as display units, period, uplevel, entry/exit methods etc. Enter all necessary 
parameters.parameters.  
  
You can also edit the display properties of the trading system, e.g. the colors for long/short entries, price indicators, trade labels You can also edit the display properties of the trading system, e.g. the colors for long/short entries, price indicators, trade labels 
etc.etc.  
  
For some Tradesignal strategies it is possible to set an alert, which will be created as soon as a defined condition is met. For some Tradesignal strategies it is possible to set an alert, which will be created as soon as a defined condition is met. AlertsAlerts  
will be displayed as a flashing icon in the system tray and as a popup window by default. Furthermore, you can find information will be displayed as a flashing icon in the system tray and as a popup window by default. Furthermore, you can find information 
about all alerts in the about all alerts in the alert windowalert window. Added, cancelled or filled orders will be displayed on the . Added, cancelled or filled orders will be displayed on the all alertsall alerts tab. tab.

CONTROLLING HOW AND WHEN ORDERS GET FILLED CONTROLLING HOW AND WHEN ORDERS GET FILLED   

In addition to the strategy properties, order execution is affected by the global trading properties located in the In addition to the strategy properties, order execution is affected by the global trading properties located in the Money ManagementMoney Management  
section. This section controls how orders get generated and filled, specifies how the slippage and commission that should be taken section. This section controls how orders get generated and filled, specifies how the slippage and commission that should be taken 
into account and defines the standard risk stop settings. The following settings directly affect how orders generated in a strategy into account and defines the standard risk stop settings. The following settings directly affect how orders generated in a strategy 
get executed:get executed:  
  
The The Realtime Price SourceRealtime Price SourceRealtime Price SourceRealtime Price Source property controls which prices are used to fill orders in real time. Tradesignal supports two modes:  property controls which prices are used to fill orders in real time. Tradesignal supports two modes: 
bid/askbid/ask and  and lastlast..

l Bid/AskBid/AskBid/AskBid/Ask  -- Tradesignal uses the best bid / best ask data provided by either the broker (if an order routing module has been  Tradesignal uses the best bid / best ask data provided by either the broker (if an order routing module has been 
connected) or the data provider. If neither the broker nor the data provider is delivering bid/ask prices, Tradesignal uses the connected) or the data provider. If neither the broker nor the data provider is delivering bid/ask prices, Tradesignal uses the 
last price instead (for example in the case of indices). Best bid and best ask prices are generated when a market participant last price instead (for example in the case of indices). Best bid and best ask prices are generated when a market participant 
wants to buy or sell a number of shares/contracts while a last price represents an actual trade that has been made. wants to buy or sell a number of shares/contracts while a last price represents an actual trade that has been made. 
Therefore this option has the benefit of more accurate fills for your orders. The caveat is however that the results collected in Therefore this option has the benefit of more accurate fills for your orders. The caveat is however that the results collected in 
real time will not match the results of backreal time will not match the results of back--testing which will always only use the last price.testing which will always only use the last price.  

l LastLastLastLast  -- Tradesignal uses the last price delivered by the data provider. This is the same price as the one used to back Tradesignal uses the last price delivered by the data provider. This is the same price as the one used to back--test the test the 
strategy. A last tick represents a trade that has been made in the market. When using this mode, Tradesignal can only fill strategy. A last tick represents a trade that has been made in the market. When using this mode, Tradesignal can only fill 
and order after a trade has been made, even if there was a matching offer/request in the market prior to the trade. This and order after a trade has been made, even if there was a matching offer/request in the market prior to the trade. This 
mode ensures that real time results are closer to backmode ensures that real time results are closer to back--test results.test results.  

The The Generate OrdersGenerate OrdersGenerate OrdersGenerate Orders property specifies when orders can be generated by the running strategies. property specifies when orders can be generated by the running strategies.

l IntrabarIntrabarIntrabarIntrabar  -- Orders can be generated with every intra Orders can be generated with every intra--bar update (for every tick).bar update (for every tick).  
l On Bar CloseOn Bar CloseOn Bar CloseOn Bar Close  -- Orders can only be generated when the bar closes. This mode is especially useful when a signal might be  Orders can only be generated when the bar closes. This mode is especially useful when a signal might be 

invalidated before the bar closes, which typically happens when the signals are generated based on compressed chart types invalidated before the bar closes, which typically happens when the signals are generated based on compressed chart types 
like Point and Figure, Renko, Three Line Break and Kagi (these chart types can all remove bars resulting in trades being like Point and Figure, Renko, Three Line Break and Kagi (these chart types can all remove bars resulting in trades being 
executed at prices that may not be reflected in a bar when it is closed).executed at prices that may not be reflected in a bar when it is closed).  
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WRITING STRATEGIES 
In Tradesignal, many strategies are available, either delivered with the software or offered for download from the website.In Tradesignal, many strategies are available, either delivered with the software or offered for download from the website.  
  
However, wishes may remain unfulfilled or you may have new ideas that need to be tested. You can always use the However, wishes may remain unfulfilled or you may have new ideas that need to be tested. You can always use the Trading Trading 
Strategy WizardStrategy Wizard to design a new strategy. You can also program new strategies (or edit available ones) in Tradesignal by using the  to design a new strategy. You can also program new strategies (or edit available ones) in Tradesignal by using the 
Equilla language. Equilla language.   
  
In the following you will find an example showing how to write a strategy using Equilla. It is only intended to give you a basic In the following you will find an example showing how to write a strategy using Equilla. It is only intended to give you a basic 
introduction. For details on Equilla, please refer to articles in the introduction. For details on Equilla, please refer to articles in the Equilla BasicsEquilla Basics category. category.

PROGRAMMING A BOLLINGER BAND PROGRAMMING A BOLLINGER BAND -- RSI SYSTEM RSI SYSTEM  

The strategy calculates the Relative Strength Index for an instrument. Based The strategy calculates the Relative Strength Index for an instrument. Based 
on these values, Bollinger Bands are then constructed. The crossings on these values, Bollinger Bands are then constructed. The crossings 
between the RSI and the Bollinger Bands are used as trading signals. In between the RSI and the Bollinger Bands are used as trading signals. In 
addition, Stop Loss and Trailing Stop are calculated. The idea behind this addition, Stop Loss and Trailing Stop are calculated. The idea behind this 
setup is to substitute the static extremes of the Relative Strength Index setup is to substitute the static extremes of the Relative Strength Index 
with more flexible zones that adapt to the movements of the indicator.with more flexible zones that adapt to the movements of the indicator.  

CREATING THE STRATEGYCREATING THE STRATEGY  

1.1. In the toolbox, click on the In the toolbox, click on the StrategiesStrategiesStrategiesStrategies button. button.  
2.2. In the In the Related TasksRelated Tasks area, select  area, select New StrategyNew StrategyNew StrategyNew Strategy..  
3.3. In the next dialog, select the option In the next dialog, select the option Use the Equilla Formula Language to write the strategyUse the Equilla Formula Language to write the strategyUse the Equilla Formula Language to write the strategyUse the Equilla Formula Language to write the strategy..  
4.4. Select a folder, e.g. "Tradesignal Files".Select a folder, e.g. "Tradesignal Files".  
5.5. Type the name "BollingerType the name "Bollinger--RSIRSI--Bands".Bands".  
6.6. Click on Click on DoneDoneDoneDone..  

Now you can enter the source code of the strategy in the Now you can enter the source code of the strategy in the Equilla EditorEquilla Editor. The areas are described in the following sections. The . The areas are described in the following sections. The 
complete code can be found at the end of this article. complete code can be found at the end of this article. 

ENTERING THE HEADERENTERING THE HEADER  

In the header area, the input parameters of the used indicators and necessary variables are declared. In addition, we enter the meta In the header area, the input parameters of the used indicators and necessary variables are declared. In addition, we enter the meta 
information for the subchart creation. information for the subchart creation.   
  

//Creating a subchart 

Meta: 

SubChart( true ); 

 

//Defining the input parameters for the indicators 

Inputs:  

Writing a new strategyWriting a new strategy
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PeriodAvg( 20 , 1 ), 

PeriodStd( 10 , 1 ), 

FactorStd( 2.0 , 0.0 ), 

PeriodRSI( 14 , 1 ), 

PeriodATR( 10, 1 ), 

FactorAtr( 1.5, 0.0 ), 

PeriodTrail( 20 , 1 ), 

TradeMode( outsideIn, insideOut ); 

 

//Declaring the variables that we need for storing calculation results 

Variables:  

avgValue, upperBand, lowerBand, rsiValue, stdValue, atrValue,  

stopValue, trailValue, activeStop; 

PROGRAMMING THE CALCULATIONS FOR THE INDICATORS AND STOPS PROGRAMMING THE CALCULATIONS FOR THE INDICATORS AND STOPS   

In this part, the indicator calculations are entered. For most of them, we will use available In this part, the indicator calculations are entered. For most of them, we will use available Equilla FunctionsEquilla Functions. However, a new . However, a new 
calculation is written for the Bollinger Bands, as we want to use the RSI as their basis. calculation is written for the Bollinger Bands, as we want to use the RSI as their basis.   
  

//Calculating the RSI 

rsiValue = RSI( Close, PeriodRSI ); 

//Calculating the Bollinger Bands constituents (based on the RSI) 

avgValue = Average( rsiValue, PeriodAvg ); 

stdValue = StdDeviation( rsiValue, PeriodStd ); 

//The upper band is calculated with the average and the added standard deviation 

upperBand = avgValue + ( FactorStd * stdValue ); 

//The lower band is calculated with the average and the subtracted standard deviation 

lowerBand = avgValue ­ ( FactorStd * stdValue ); 

 

//Calculating the Average True Range for the Stop Loss 

atrValue = Average( TrueRange, PeriodAtr ); 

//Calculation the Average as Trailing Stop 

trailValue = XAverage( Close, PeriodTrail ); 

DEFINING TRADING CONDITIONS AND PROGRAMMING ORDER GENERATIONDEFINING TRADING CONDITIONS AND PROGRAMMING ORDER GENERATION  

In this part, the conditions for trading signals are defined and the orders are generated. Two modes are defined:In this part, the conditions for trading signals are defined and the orders are generated. Two modes are defined:

l The mode The mode outsideInoutsideInoutsideInoutsideIn is designed so that the RSI has to cut the Bollinger Bands from outside in for signal generation. This  is designed so that the RSI has to cut the Bollinger Bands from outside in for signal generation. This 
mode is preferable for correction movements.mode is preferable for correction movements.  

l The mode The mode insideOutinsideOutinsideOutinsideOut is designed so that the RSI has to cut the Bollinger Bands from inside out, i.e. in trend direction. This  is designed so that the RSI has to cut the Bollinger Bands from inside out, i.e. in trend direction. This 
mode is optimal for strong trends.mode is optimal for strong trends.  
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//Setting the trading conditions 

//Signals are generated when the RSI crosses the bands from outside in 

If TradeMode = 0 Then 

Begin 

//Sale when the RSI crosses the lower band from outside in.  

If rsiValue crosses over lowerBand Then 

Begin 

Buy("LongIn") Next Bar at Market; 

//Calculating the price for the Stop Loss 

stopValue = Close ­ ( FactorAtr * atrValue ); 

End; 

 

//Short sale when the RSI crosses the upper band from outside in. 

If rsiValue crosses under upperBand Then 

Begin 

Short("ShortIn") Next Bar at Market; 

//Calculating the price for the Stop Loss 

stopValue = Close + ( FactorAtr * atrValue ); 

End; 

End 

Else 

//Signals are generated when the RSI crosses the bands from inside out 

Begin 

//Sale when the RSI crosses the lower band from inside out.  

If rsiValue crosses over upperBand Then 

Begin 

Buy("LongOut") Next Bar at Market; 

//Calculating the price for the Stop Loss 

stopValue = Close ­ ( FactorAtr * atrValue ); 

End; 

//Short sale when the RSI crosses the upper band from inside out. 

If rsiValue crosses under lowerBand Then 

Begin 

Short("ShortOut") Next Bar at Market; 

//Calculating the price for the Stop Loss 

stopValue = Close + ( FactorAtr * atrValue ); 

End; 

End; 

HANDLING OF THE STOP LOSS PRICESHANDLING OF THE STOP LOSS PRICES  

For the Stop Loss, the For the Stop Loss, the Average True RangeAverage True Range (ATR) is calculated. The value for the initial stop results from the ATR multiplied with a  (ATR) is calculated. The value for the initial stop results from the ATR multiplied with a 
factor. As Trailing Stop, the factor. As Trailing Stop, the Exponential Moving AverageExponential Moving Average based on the instrument is calculated. If the price cuts this average  based on the instrument is calculated. If the price cuts this average 
inverse to the trade, the trade is closed. The program uses both stop values and compares which one is better positioned and more inverse to the trade, the trade is closed. The program uses both stop values and compares which one is better positioned and more 
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protective of the trade. That value is finally output as a stop order for the next trading period. protective of the trade. That value is finally output as a stop order for the next trading period.   
  

/* Here the handling of stop values is done: For long positions: The stop loss is valid as 

long as the trailing stop is below it. For short positions: The stop loss is valid as long 

as the trailing stop is above it. */ 

 

//Recognizing long positions 

If MarketPosition = MarketPositionLong Then 

Begin 

//If the stop loss is better positioned than the trailing stop 

//the stop loss is set 

If ( stopValue > trailValue ) Then 

Sell("Stop Loss") Next Bar at stopValue Stop; 

//If the trailing stop is better positioned than the stop loss 

//the trailing stop is set 

If ( trailValue > stopValue ) And ( trailValue < Close ) Then 

Sell("Trail") Next Bar at trailValue Stop; 

End; 

 

//Recognizing short positions 

If MarketPosition = MarketPositionShort Then 

Begin 

//If the stop loss is better positioned than the trailing stop 

//the stop loss is set 

If ( stopValue < trailValue ) Then 

Cover("Stop Loss") Next Bar at stopValue Stop; 

//If the trailing stop is better positioned than the stop loss 

//the trailing stop is set 

If ( trailValue < stopValue ) And ( trailValue > Close ) Then 

Cover("Trail") Next Bar at trailValue Stop; 

End; 

DISPLAYING THE INDICATORS IN SUBCHARTSDISPLAYING THE INDICATORS IN SUBCHARTS  

This is the easiest part. Only the indicators that are used for signal generation are displayed here.This is the easiest part. Only the indicators that are used for signal generation are displayed here.    
  

//Graphic display of indicators 

DrawLine( rsiValue, "RSI", StyleSolid, 1, blue ); 

DrawLIne( upperBand, "Upper Band", StyleSolid, 1, darkGreen ); 

DrawLIne( lowerBand, "Lower Band", StyleSolid, 1, red ); 

APPLYING THE STRATEGYAPPLYING THE STRATEGY  
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Compile the code either by pressing Compile the code either by pressing F7F7F7F7 or by clicking on the button  or by clicking on the button Compile ScriptCompile ScriptCompile ScriptCompile Script in the  in the Equilla EditorEquilla Editor group. The code is checked  group. The code is checked 
for errors, saved and then available in the list of strategies in the toolbox by the name "Bollingerfor errors, saved and then available in the list of strategies in the toolbox by the name "Bollinger--RSIRSI--Bands".Bands".  
  
You can now apply it to a chart it as described in You can now apply it to a chart it as described in Using StrategiesUsing Strategies, for example with drag and drop., for example with drag and drop.

THE COMPLETE CODETHE COMPLETE CODE  

//Creating a subchart 

Meta: 

SubChart( true ); 

 

//Defining the input parameters for the indicators 

Inputs:  

PeriodAvg( 20 , 1 ), 

PeriodStd( 10 , 1 ), 

FactorStd( 2.0 , 0.0 ), 

PeriodRSI( 14 , 1 ), 

PeriodATR( 10, 1 ), 

FactorAtr( 1.5, 0.0 ), 

PeriodTrail( 20 , 1 ), 

TradeMode( outsideIn, insideOut ); 

 

//Declaring the variables that we need for storing calculation results 

Variables:  

avgValue, upperBand, lowerBand, rsiValue, stdValue, atrValue,  

stopValue, trailValue, activeStop; 

 

//Calculating the RSI 

rsiValue = RSI( Close, PeriodRSI ); 

//Calculating the Bollinger Bands constituents (based on the RSI) 

avgValue = Average( rsiValue, PeriodAvg ); 

stdValue = StdDeviation( rsiValue, PeriodStd ); 

//The upper band is calculated with the average and the added standard deviation 

upperBand = avgValue + ( FactorStd * stdValue ); 

//The lower band is calculated with the average and the subtracted standard deviation 

lowerBand = avgValue ­ ( FactorStd * stdValue ); 

 

//Calculating the Average True Range for the Stop Loss 

atrValue = Average( TrueRange, PeriodAtr ); 

//Calculation the Average as Trailing Stop 

trailValue = XAverage( Close, PeriodTrail ); 

 

//Setting the trading conditions 
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//Signals are generated when RSI crosses the bands from outside in 

If TradeMode = 0 Then 

Begin 

//Sale when the RSI crosses the lower band from outside in.  

If rsiValue crosses over lowerBand Then 

Begin 

Buy("LongIn") Next Bar at Market; 

//Calculating the price for the Stop Loss 

stopValue = Close ­ ( FactorAtr * atrValue ); 

End; 

 

//Short sale when the RSI crosses the upper band from outside in. 

If rsiValue crosses under upperBand Then 

Begin 

Short("ShortIn") Next Bar at Market; 

//Calculating the price for the Stop Loss 

stopValue = Close + ( FactorAtr * atrValue ); 

End; 

End 

Else 

//Signals are generated when RSI crosses the bands from inside out 

Begin 

//Sale when the RSI crosses the upper band from inside out.  

If rsiValue crosses over upperBand Then 

Begin 

Buy("LongOut") Next Bar at Market; 

//Calculating the price for the Stop Loss 

stopValue = Close ­ ( FactorAtr * atrValue ); 

End; 

//Short sale when the RSI crosses the lower band from inside out. 

If rsiValue crosses under lowerBand Then 

Begin 

Short("ShortOut") Next Bar at Market; 

//Calculating the price for the Stop Loss 

stopValue = Close + ( FactorAtr * atrValue ); 

End; 

End; 

 

/* Here the handling of stop values is done: For long positions: The stop loss is valid as 

long as the trailing stop is below it. For short positions: The stop loss is valid as long 

as the trailing stop is above it. */ 

 

//Recognizing long positions 

If MarketPosition = MarketPositionLong Then 

Begin 
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//If the stop loss is better positioned than the trailing stop 

//the stop loss is set 

If ( stopValue > trailValue ) Then 

Sell("Stop Loss") Next Bar at stopValue Stop; 

//If the trailing stop is better positioned than the stop loss 

//the trailing stop is set 

If ( trailValue > stopValue ) And ( trailValue < Close ) Then 

Sell("Trail") Next Bar at trailValue Stop; 

End; 

 

//Recognizing short positions 

If MarketPosition = MarketPositionShort Then 

Begin 

//If the stop loss is better positioned than the trailing stop 

//the stop loss is set 

If ( stopValue < trailValue ) Then 

Cover("Stop Loss") Next Bar at stopValue Stop; 

//If the trailing stop is better positioned than the stop loss 

//the trailing stop is set 

If ( trailValue < stopValue ) And ( trailValue > Close ) Then 

Cover("Trail") Next Bar at trailValue Stop; 

End; 

 

//Graphic display of indicators 

DrawLine( rsiValue, "RSI", StyleSolid, 1, blue ); 

DrawLIne( upperBand, "Upper Band", StyleSolid, 1, darkGreen ); 

DrawLIne( lowerBand, "Lower Band", StyleSolid, 1, red ); 
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C-API EXTENSIONS 
Equilla, the formula language of Tradesignal, is a powerful way to describe your trading strategies. There are cases when you may Equilla, the formula language of Tradesignal, is a powerful way to describe your trading strategies. There are cases when you may 
need additional functionality which is not directly available in Equilla. To address this issue the language can be extended via need additional functionality which is not directly available in Equilla. To address this issue the language can be extended via 
Dynamic Link Libraries (DLLs) using the Equilla Extension Application Programmer's Interface (API).Dynamic Link Libraries (DLLs) using the Equilla Extension Application Programmer's Interface (API).

WHAT IS AN EQUILLA EXTENSION WHAT IS AN EQUILLA EXTENSION   

Equilla Extension libraries are DLLs containing one or more functions. These functions must have a specific signature in order to be Equilla Extension libraries are DLLs containing one or more functions. These functions must have a specific signature in order to be 
compliant with Equilla.compliant with Equilla.

HOW TO ACCESS AN EQUILLA EXTENSION FROM EQUILLA HOW TO ACCESS AN EQUILLA EXTENSION FROM EQUILLA   

To use an extension function from a script you have to first make sure the DLL is in the correct place on your system, and then you To use an extension function from a script you have to first make sure the DLL is in the correct place on your system, and then you 
must add a reference to the function at the start of your Equilla script. must add a reference to the function at the start of your Equilla script. 

WHERE TO PUT THE EQUILLA EXTENSION WHERE TO PUT THE EQUILLA EXTENSION   

All Equilla Extension libraries have to be placed in the directory where Tradesignal is installed.All Equilla Extension libraries have to be placed in the directory where Tradesignal is installed.  
  
You can specify a different directory for Extension DLLs in the options under You can specify a different directory for Extension DLLs in the options under File > Options > Folders > Equilla PathsFile > Options > Folders > Equilla Paths..

HOW TO USE EXTENSION FUNCTIONS HOW TO USE EXTENSION FUNCTIONS   

Assuming you have an Equilla Extension DLL called Assuming you have an Equilla Extension DLL called MyEquillaExtension.dllMyEquillaExtension.dll containing a function called  containing a function called MyMovingAverageMyMovingAverage that  that 
takes price and period parameters, you would first import the function using the following Equilla command:takes price and period parameters, you would first import the function using the following Equilla command:

Import( "MyMovingAverage", "MyEquillaExtension.dll" ); 

You can then use the function as you would use a normal Equilla function.You can then use the function as you would use a normal Equilla function.

DrawLine( MyMovingAverage( Close, 10 ), "Avg" ); 

Note:Note:Note:Note: Each function from the DLL must have it's own import statement. Each function from the DLL must have it's own import statement.

HOW TO IMPORT A FUNCTION THAT HAS THE SAME NAME AS AN EXISTING EQUILLA FUNCTION HOW TO IMPORT A FUNCTION THAT HAS THE SAME NAME AS AN EXISTING EQUILLA FUNCTION   

You can easily import a function and give it an alternate name as a third parameter to the Import command.You can easily import a function and give it an alternate name as a third parameter to the Import command.

Import( "MyMovingAverage", "MyEquillaExtension.dll", "RenamedMovingAverage" ); 

 

DrawLine( RenamedMovingAverage( Close, 10 ), "Avg" ); 
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HOW TO WRITE AN EQUILLA EXTENSION IN MICROSOFT VISUAL C++ 2005 HOW TO WRITE AN EQUILLA EXTENSION IN MICROSOFT VISUAL C++ 2005   

The Equilla Extension API is described in the The Equilla Extension API is described in the EquillaApi.hEquillaApi.h file, which is located in the  file, which is located in the IncludeInclude sub sub--directory of your Tradesignal directory of your Tradesignal 
installation. In order to create Equilla Extension libraries you have to add the directory to the installation. In order to create Equilla Extension libraries you have to add the directory to the Include filesInclude files directory of Visual Studio  directory of Visual Studio 
under under Tools > Options > Projects and Solutions > VC++ DirectoriesTools > Options > Projects and Solutions > VC++ Directories..  
  
Follow these steps to create a sample project:Follow these steps to create a sample project:

l Create a new Visual C++ DLL projectCreate a new Visual C++ DLL project  

1.1. File > New > Project... > Visual C++ > Win32 Console ApplicationFile > New > Project... > Visual C++ > Win32 Console Application  
2.2. Type a name for the new project for example "MyEquillaExtension"Type a name for the new project for example "MyEquillaExtension"  
3.3. Press Press OKOK  
4.4. Select the Select the Application SettingsApplication Settings and set the  and set the Application typeApplication type to  to DLLDLL  
5.5. Press Press FinishFinish  

l Include the Equilla interface description and dependencies by adding the following lines to the top of the Include the Equilla interface description and dependencies by adding the following lines to the top of the 
MyEquillaExtension.cppMyEquillaExtension.cpp file, below the  file, below the #include "stdafx.h"#include "stdafx.h" line: line:  

#include <wtypes.h> 

#include <oleauto.h> 

#include <EquillaApi.h> 

l Add the following function to the bottom of the Add the following function to the bottom of the MyEquillaExtension.cppMyEquillaExtension.cpp file: file:  
Note:Note:Note:Note: All Equilla Extension functions must be declared with the following function prototype. All Equilla Extension functions must be declared with the following function prototype.  

EQUILLA_API int MyMovingAverage( DWORD scriptID, int argc, EqVariable* variables[],  

                                 VARIANT* result ) 

{ 

    // check that the number of parameters passed to this function is two (Price and Period) 

    if (argc != 2) 

        return EQUILLA_ARGUMENT_ERROR; 

    // extract the period value from the second parameter 

    VARIANT vPeriod; 

    VariantInit(&vPeriod); 

    variables[1]­>GetValue(&vPeriod); // read the latest value from the variable 

    // ensure the period parameter is valid 

    if (V_I4(&vPeriod) < 1) 

        return EQUILLA_ARGUMENT_ERROR; 

    // calculate the sum of all prices for the given period 

    double sum = 0.0; 

    VARIANT vPrice; 

    VariantInit(&vPrice); 

    for (int index = 0; index < V_I4(&vPeriod); ++index) 
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    { 

        variables[0]­>GetValue(index, &vPrice); // read a historic value from the variable 

        sum += V_R8(&vPrice); 

        VariantClear(&vPrice); // release any allocated memory 

    } 

    // write the equilla result and set the type to a 8­byte floating point value 

    V_VT(result) = VT_R8; 

    V_R8(result) = sum / V_I4(&vPeriod); 

    // clean up and return successfully 

    VariantClear(&vPeriod); 

    return EQUILLA_SUCCESS; 

} 

l Compile the project and copy the DLL to the Compile the project and copy the DLL to the Equilla Extension DLLsEquilla Extension DLLs directory directory  
Note:Note:Note:Note: Ensure you are compiling a 32 Ensure you are compiling a 32--bit DLL otherwise it can not be used from Equilla!bit DLL otherwise it can not be used from Equilla!  

l You are finished. You can now access this function from Equilla as described You are finished. You can now access this function from Equilla as described aboveabove..  

EXTENSION FUNCTION ARGUMENTS AND RETURN VALUE EXTENSION FUNCTION ARGUMENTS AND RETURN VALUE   

All Equilla Extension functions have the same prototype as shown above. The parameters are: All Equilla Extension functions have the same prototype as shown above. The parameters are:   
  

  
  
The return value is an integer that must be one of the following constants:The return value is an integer that must be one of the following constants:  
  

WORKING WITH EQUILLA VARIABLES WORKING WITH EQUILLA VARIABLES   

The EqVariable object represents a variable that has been passed to this function from an Equilla script. You can use the object to The EqVariable object represents a variable that has been passed to this function from an Equilla script. You can use the object to 
access the latest value of the variable or a historic value (from a previous bar). All values accessed via the EqVariable object will access the latest value of the variable or a historic value (from a previous bar). All values accessed via the EqVariable object will 
be returned as VARIANTs. be returned as VARIANTs.   
  
Note:Note:Note:Note: A VARIANT is generic variable that can hold data of various different types; for an overview of working with VARIANTs see  A VARIANT is generic variable that can hold data of various different types; for an overview of working with VARIANTs see 
belowbelow..

ParameterParameterParameterParameter DescriptionDescriptionDescriptionDescription
DWORD DWORD scriptIDscriptID A value that uniquely identifies the instance of an Equilla script calling this functionA value that uniquely identifies the instance of an Equilla script calling this function
int int argcargc The number of parameters being passed into this function from the Equilla scriptThe number of parameters being passed into this function from the Equilla script
EqVariable* EqVariable* variablesvariables[][] An array of the parameters passed into this function from the Equilla scriptAn array of the parameters passed into this function from the Equilla script
VARIANT* VARIANT* resultresult A pointer to a variable receiving the result of the function that will be passed to the Equilla scriptA pointer to a variable receiving the result of the function that will be passed to the Equilla script

Return valueReturn valueReturn valueReturn value DescriptionDescriptionDescriptionDescription
EQUILLA_SUCCESSEQUILLA_SUCCESS The function has completed successfullyThe function has completed successfully
EQUILLA_ARGUMENT_ERROREQUILLA_ARGUMENT_ERROR The is a problem with one or more of the parameters passed into the functionThe is a problem with one or more of the parameters passed into the function
EQUILLA_GENERAL_ERROREQUILLA_GENERAL_ERROR Any other error has occurredAny other error has occurred
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l To access the latest value of the variable:To access the latest value of the variable:  

VARIANT vValue; 

VariantInit(&vValue); 

variables[0]­>GetValue(&vValue); 

// convert the value into a string 

VariantChangeType(&vValue, &vValue, VT_BSTR); 

// include windows.h to use the MessageBoxW function 

MessageBoxW(NULL, V_BSTR(&vValue), L"The value is", MB_OK); 

VariantClear(&vValue); 

l To access the value of the variable from the previous bar (assuming this is a series variable):To access the value of the variable from the previous bar (assuming this is a series variable):  

VARIANT vPreviousValue; 

VariantInit(&vPreviousValue); 

variables[0]­>GetValue(1, &vPreviousValue); 

// do something with the variable here 

VariantClear(&vPreviousValue); 

HOW TO DEBUG AN EQUILLA EXTENSION IN MICROSOFT VISUAL STUDIO 2005 HOW TO DEBUG AN EQUILLA EXTENSION IN MICROSOFT VISUAL STUDIO 2005   

Important:Important:Important:Important: Before you start the debugger, ensure that Visual Studio is in native debugger mode. This can be enabled as followed: Before you start the debugger, ensure that Visual Studio is in native debugger mode. This can be enabled as followed:

1.1. RightRight--Click on the project in the Solution Explorer and select Click on the project in the Solution Explorer and select PropertiesProperties  
2.2. Click on the Click on the Configuration Properties > DebuggingConfiguration Properties > Debugging in the tree view on the left in the tree view on the left  
3.3. Locate the Locate the Debugger TypeDebugger Type property and change it's value to  property and change it's value to Native OnlyNative Only  
4.4. Click Click OKOK to close the dialog to close the dialog  

To start debugging your DLL:To start debugging your DLL:

1.1. Start Tradesignal and change the property Start Tradesignal and change the property File > Tradesignal Options > Equilla > File Locations > Equilla Extension DLLsFile > Tradesignal Options > Equilla > File Locations > Equilla Extension DLLs to  to 
the build directory of your project (this will normally be in the sub folder called the build directory of your project (this will normally be in the sub folder called DebugDebug). Click ). Click OKOK. Then shut down . Then shut down 
Tradesignal.Tradesignal.  

2.2. In Visual Studio ensure that this is the Debug build configuration and select In Visual Studio ensure that this is the Debug build configuration and select Debug > Start DebuggingDebug > Start Debugging from the menu. from the menu.  
3.3. A dialog will open asking you for the executable to run. Enter the location of the tse.exe file from the Tradesignal A dialog will open asking you for the executable to run. Enter the location of the tse.exe file from the Tradesignal 

installation directory on your system and click installation directory on your system and click OKOK..  
4.4. The application will now start, you should use your extension function in a new script as described The application will now start, you should use your extension function in a new script as described aboveabove..  
5.5. Set breakpoints in visual studio and then apply your Equilla script to a Chart, Watchlist or Scanner. Execution will be Set breakpoints in visual studio and then apply your Equilla script to a Chart, Watchlist or Scanner. Execution will be 

automatically interrupted when one of your breakpoints is hit.automatically interrupted when one of your breakpoints is hit.  

ADVANCED TOPICS ADVANCED TOPICS   

HOW DO I INITIALIZE AND CLEANUP GLOBAL DATA IN MY EQUILLA EXTENSION HOW DO I INITIALIZE AND CLEANUP GLOBAL DATA IN MY EQUILLA EXTENSION   
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If you want to write a library of functions that maintain some global state from call to call you will need to use global variables in If you want to write a library of functions that maintain some global state from call to call you will need to use global variables in 
your DLL. This can cause problems in determining when to initialize and free these global variables. To solve this problem, there your DLL. This can cause problems in determining when to initialize and free these global variables. To solve this problem, there 
are two optional functions that you can add to your extension DLL that will be called once when a script containing functions from are two optional functions that you can add to your extension DLL that will be called once when a script containing functions from 
your DLL is added to a chart, and once when it is removed from a chart. The following example illustrates how these functions are your DLL is added to a chart, and once when it is removed from a chart. The following example illustrates how these functions are 
used:used:  
  
Note:Note:Note:Note: The prototypes and names of the  The prototypes and names of the DllAttachScript()DllAttachScript() and  and DllDetachScript()DllDetachScript() functions must be exactly the same as in the  functions must be exactly the same as in the 
example.example.  
  

#include "stdafx.h" 

#include <wtypes.h> 

#include <oleauto.h> 

#include "EquillaApi.h" 

#include <map> 

BOOL APIENTRY DllMain(HMODULE hModule, DWORD dwReason, LPVOID lpReserved) 

{ 

    return TRUE; 

} 

class CGlobalCounter 

{ 

public: 

    static CGlobalCounter& Instance() 

    { 

        // This is not thread­safe, included only for the brevity of the example 

        static CGlobalCounter singleton; 

        return singleton; 

    } 

    void Add(DWORD nScriptId) 

    { 

        EnterCriticalSection(&m_hCS); 

        m_barCounts[nScriptId] = 0; 

        LeaveCriticalSection(&m_hCS); 

    } 

     

    void Remove(DWORD nScriptId) 

    { 

        EnterCriticalSection(&m_hCS); 

        m_barCounts.erase(nScriptID); 

        LeaveCriticalSection(&m_hCS); 

    } 

    int Increment(DWORD nScriptId) 

    { 

        EnterCriticalSection(&m_hCS); 

        int nResult = ++m_barCounts[nScriptId]; 
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        LeaveCriticalSection(&m_hCS); 

        return nResult; 

    } 

private: 

    CGlobalCounter()  

    { 

        InitializeCriticalSection(&m_hCS);  

    } 

    CGlobalCounter(const CGlobalCounter&); 

    CGlobalCounter& operator=(const CGlobalCounter&); 

    std::map<DWORD, int> m_barCounts; 

    CRITICAL_SECTION m_hCS; 

}; 

EQUILLA_API void DllAttachScript(DWORD nScriptId) 

{ 

    CGlobalCounter::Instance().Add(nScriptId); 

} 

EQUILLA_API void DllDetachScript(DWORD nScriptId) 

{ 

    CGlobalCounter::Instance().Remove(nScriptID); 

} 

//call this function once on each bar to get the current bar count 

EQUILLA_API int BarCount(DWORD nScriptID, int argc, EqVariable* variables[], VARIANT* result) 

{ 

    V_VT(result) = VT_I4; 

    V_I4(result) = CGlobalCounter::Instance().Increment(nScriptId); 

    return EQUILLA_SUCCESS; 

} 

  
  
Note:Note:Note:Note: Because this DLL can be used by multiple scripts instances at the same time it is important to separate the global data of  Because this DLL can be used by multiple scripts instances at the same time it is important to separate the global data of 
each script in some way. In the example above we use a map that stores the bar count against a given scriptID. We recommend each script in some way. In the example above we use a map that stores the bar count against a given scriptID. We recommend 
you use a similar approach in your own DLLs changing the int data type to whichever data you need to store.you use a similar approach in your own DLLs changing the int data type to whichever data you need to store.

WORKING WITH THE VARIANT DATA TYPE WORKING WITH THE VARIANT DATA TYPE   

A VARIANT is a variable that can hold any type of data, it maps quite closely to the types of variables that are used in Equilla. The A VARIANT is a variable that can hold any type of data, it maps quite closely to the types of variables that are used in Equilla. The 
trick to using variants in your Extension DLL is in correct initialization/detrick to using variants in your Extension DLL is in correct initialization/de--initialization and in accessing the correctly typed data.initialization and in accessing the correctly typed data.

DECLARING AND RELEASING VARIANTS DECLARING AND RELEASING VARIANTS   

Whenever you declare a variant in your code you should always initialize it in the following way:Whenever you declare a variant in your code you should always initialize it in the following way:  
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VARIANT vPrice; 

VariantInit(&vPrice); 

  
  
Whenever you have finished with the variant (even in an error case) you should clear the variant in the following way:Whenever you have finished with the variant (even in an error case) you should clear the variant in the following way:  
  

VariantClear(&vPrice); 

READING AND WRITING DATA READING AND WRITING DATA   

The following example demonstrates the important variant functions to use to read and write various data types from and to a The following example demonstrates the important variant functions to use to read and write various data types from and to a 
variant:variant:  
  

// initialize the variant 

VARIANT vValue; 

VariantInit(&vValue); 

// Write and read a double value (like a price) to a variant 

double nPrice = 12.1; 

V_VT(&vValue) = VT_R8; // set the underlying type of the variant 

V_R8(&vValue) = nPrice; 

double nNewPrice = V_R8(&vValue); 

VariantClear(&vValue); 

// Write and read an integer value (like a period) to a variant 

int nPeriod = 14; 

V_VT(&vValue) = VT_I4; // set the underlying type of the variant 

V_I4(&vValue) = nPeriod; 

int nNewPeriod = V_I4(&vValue); 

VariantClear(&vValue); 

// Write and read a Boolean value (a true/false value) to a variant 

bool bValue = true; 

V_VT(&vValue) = VT_BOOL; // set the underlying type of the variant 

V_BOOL(&vValue) = bValue ? VARIANT_TRUE : VARIANT_FALSE; 

bool bNewValue = V_BOOL(&vValue) != VARIANT_FALSE; 

VariantClear(&vValue); 

// Write and read a string value to a variant 

LPCWSTR sValue = L"Text"; 

V_VT(&vValue) = VT_BSTR; // set the underlying type of the variant 

V_BSTR(&vValue) = SysAllocString(sValue); // you have to create a BSTR from the input string 

BSTR sNewValue = SysAllocString(V_BSTR(&vValue)); //SysFreeString needs to be called once sNewValue is not required anymore

VariantClear(&vValue); 

// Write and read a date/time (OLE Datetime) to a variant 

SYSTEMTIME stLocal = {0}; 
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DATE dtOle = 0; 

GetLocalTime(&stLocal); 

SystemTimeToVariantTime(stLocal, &dtOle); 

V_VT(&vValue) = VT_DATE; 

V_DATE(&vValue) = dtOle; 

DATE dtNewOle = V_DATE(&vValue); 

VariantClear(&vValue); 

CHECKING FUNCTION PARAMETERS ARE THE CORRECT TYPE CHECKING FUNCTION PARAMETERS ARE THE CORRECT TYPE   

Due to the data types used by the Equilla engine, you should always check if the type of a given parameter is what you expect. If Due to the data types used by the Equilla engine, you should always check if the type of a given parameter is what you expect. If 
the type differs from what you expect you can use the the type differs from what you expect you can use the VariantChangeTypeVariantChangeType function to perform the conversion as the following  function to perform the conversion as the following 
sample demonstrates (this is the same moving average example as shown above but with this checking added):sample demonstrates (this is the same moving average example as shown above but with this checking added):  
  

EQUILLA_API int MyMovingAverage( DWORD scriptID, int argc, EqVariable* variables[],  

                                 VARIANT* result ) 

{ 

    // check that the number of parameters passed to this function is two (Price and Period) 

    if (argc != 2) 

        return EQUILLA_ARGUMENT_ERROR; 

    // extract the period value from the second parameter 

    VARIANT vPeriod; 

    VariantInit(&vPeriod); 

    variables[1]­>GetValue(&vPeriod); // read the latest value from the variable 

    // ensure the period parameter is an integer 

    if (V_VT(&vPeriod) != VT_I4 && FAILED(VariantChangeType(&vPeriod, &vPeriod, VT_I4))) 

    { 

        VariantClear(&vPeriod); 

        return EQUILLA_ARGUMENT_ERROR; 

    } 

    // ensure the period parameter is valid 

    if (V_I4(&vPeriod) < 1) 

        return EQUILLA_ARGUMENT_ERROR; 

    // calculate the sum of all prices for the given period 

    double sum = 0.0; 

    VARIANT vPrice; 

    VariantInit(&vPrice); 

    for (int index = 0; index < V_I4(&vPeriod); ++index) 

    { 

        variables[0]­>GetValue(index, &vPrice); // read a historic value from the variable 

        // ensure the price is a double 

        if (V_VT(&vPrice) != VT_R8 && FAILED(VariantChangeType(&vPrice, &vPrice, VT_R8))) 

        { 

            VariantClear(&vPeriod); 
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            VariantClear(&vPrice); 

            return EQUILLA_ARGUMENT_ERROR; 

        } 

        sum += V_R8(&vPrice); 

        VariantClear(&vPrice); // release any allocated memory 

    } 

    // write the equilla result and set the type to a 8­byte floating point value 

    V_VT(result) = VT_R8; 

    V_R8(result) = sum / V_I4(&vPeriod); 

    // clean up and return successfully 

    VariantClear(&vPeriod); 

    return EQUILLA_SUCCESS; 

} 

CONVERTING VARIANTS TO STRINGS CONVERTING VARIANTS TO STRINGS   

One of the most common conversion tasks is taking a variant (such as a price) and converting it into a string for output, this can be One of the most common conversion tasks is taking a variant (such as a price) and converting it into a string for output, this can be 
accomplished in the following way:accomplished in the following way:  
  

double nPrice = 12.1; 

VARIANT vPrice; 

VariantInit(&vPrice); 

V_VT(&vPrice) = VT_R8; 

V_R8(&vPrice) = nPrice; 

// convert the value into a string 

VariantChangeType(&vPrice, &vPrice, VT_BSTR); 

// include windows.h to use the MessageBoxW function 

MessageBoxW(NULL, V_BSTR(&vPrice), L"The value is", MB_OK); 

VariantClear(&vPrice); 
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COM-API EXTENSIONS 
The following article offers an introduction to COMThe following article offers an introduction to COM--API Extensions for Equilla (API Extensions for Equilla (notenotenotenote: available in Tradesignal 6.3 and above): available in Tradesignal 6.3 and above)

WHAT ARE COMWHAT ARE COM--EXTENSION OBJECTSEXTENSION OBJECTS  

Equilla COMEquilla COM--Extensions are COMExtensions are COM--Objects that implement a special set of interfaces. Each COMObjects that implement a special set of interfaces. Each COM--Object can provide one or more Object can provide one or more 
Extension objects by implementing one or more interfaces derived from the Extension objects by implementing one or more interfaces derived from the IEquillaExtension InterfaceIEquillaExtension Interface. These objects are . These objects are 
referenced from equilla by using the Progreferenced from equilla by using the Prog--ID or the CLSID and an optional interface name. Extension COMID or the CLSID and an optional interface name. Extension COM--Objects need to be Objects need to be 
registered with the system so they can be instantiated via the Windows CoCreateInstance mechanism. For a detailed stepregistered with the system so they can be instantiated via the Windows CoCreateInstance mechanism. For a detailed step--byby--step step 
guide to create COMguide to create COM--Extensions read the section Extensions read the section How to write a COM ExtensionHow to write a COM Extension and check out the samples projects installed with  and check out the samples projects installed with 
Tradesignal.Tradesignal.

HOW TO USE COMHOW TO USE COM--EXTENSION OBJECTSEXTENSION OBJECTS  

Equilla objects are created similar to Variables, by adding an Equilla objects are created similar to Variables, by adding an Objects:Objects:--Block to the script and declaring the objects you want to use. Block to the script and declaring the objects you want to use. 
For every object within a script one extension object will be instantiated. If you use the same indicator multiple times separate For every object within a script one extension object will be instantiated. If you use the same indicator multiple times separate 
extension objects will be created for every script instance.extension objects will be created for every script instance.  
  

Objects:  

myObject("ProgID"); 

 

myObject.MyMethod(); 

For a detailed description of the Object syntax see the Equilla help.For a detailed description of the Object syntax see the Equilla help.  
  
Important Note:Important Note:Important Note:Important Note: COM API Extension modules must be enabled in the options by selecting the setting at  COM API Extension modules must be enabled in the options by selecting the setting at File > Options > File > Options > 
Advanced > Equilla ExtensionAdvanced > Equilla Extension..

LIFETIME OF AN EXTENSION OBJECTLIFETIME OF AN EXTENSION OBJECT  

All extension objects go through a common life cycle.All extension objects go through a common life cycle.

l CreationCreation  

l There are multiple reasons why an extension object can be created.There are multiple reasons why an extension object can be created.

1.1. By the equilla editor to provide auto completion support.By the equilla editor to provide auto completion support.  
2.2. By the compiler to validate that the script is correct.By the compiler to validate that the script is correct.  
3.3. Because the compiled script is loaded (e.g. indicator added to a chart)Because the compiled script is loaded (e.g. indicator added to a chart)  

l If the extension object was loaded by the compile or editor no further actions will be performed and the object will be released If the extension object was loaded by the compile or editor no further actions will be performed and the object will be released 
shortly after. In case it was created by loading script the following actions will occur.shortly after. In case it was created by loading script the following actions will occur.

l Attach Session (optional)Attach Session (optional)  

l After loading a compiled script the virtual machine will first attach a session object. This is an optional step that is only After loading a compiled script the virtual machine will first attach a session object. This is an optional step that is only 
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performed if your extension implements the performed if your extension implements the ISupportSessions InterfaceISupportSessions Interface..

l Attach Host Object (IEquillaExtension)Attach Host Object (IEquillaExtension)  

l This call on the This call on the IEquillaExtension InterfaceIEquillaExtension Interface is done before the actual script evaluation starts. It supplies the extension object  is done before the actual script evaluation starts. It supplies the extension object 
with a thread safe Hostwith a thread safe Host--Object that can be used to trigger reevaluation of the script an provides information about the executing Object that can be used to trigger reevaluation of the script an provides information about the executing 
context.context.

l Script Evaluation PhaseScript Evaluation Phase  

l While a script is evaluated barWhile a script is evaluated bar--byby--bar, methods will be called and signals will be passed to the extension object.bar, methods will be called and signals will be passed to the extension object.

1.1. Methods called by script evaluationMethods called by script evaluation  
Once the script evaluation has started the virtual machine will call methods of your object as instructed by the script. These Once the script evaluation has started the virtual machine will call methods of your object as instructed by the script. These 
methods can contain multiple arguments of different type and a return value, as explained in methods can contain multiple arguments of different type and a return value, as explained in Extension Supported Parameter Extension Supported Parameter 
TypesTypes..  

2.2. Signals received (optional)Signals received (optional)  
If your COMIf your COM--Object implements any one of the SignalObject implements any one of the Signal--Sink interfaces (Sink interfaces (Extension Signals and SinksExtension Signals and Sinks) signals will be passed ) signals will be passed 
to your extension after a bar is evaluated. SymbolStateChanged and interactive script alerts can be received at any time.to your extension after a bar is evaluated. SymbolStateChanged and interactive script alerts can be received at any time.  

l Detach (IEquillaExtension)Detach (IEquillaExtension)  

l After script evaluation has stopped (e.g. indicator was removed from a chart) the Detach() method will be called on the After script evaluation has stopped (e.g. indicator was removed from a chart) the Detach() method will be called on the 
IEquillaExtension InterfaceIEquillaExtension Interface. Shortly after this the COM object will be released. All necessary clean up work should be performed at . Shortly after this the COM object will be released. All necessary clean up work should be performed at 
this point.this point.

YOUR EXTENSION INTERFACEYOUR EXTENSION INTERFACE  

The extension interface has to be derived from The extension interface has to be derived from IEquillaExtension InterfaceIEquillaExtension Interface and it should be the default interface of your COM and it should be the default interface of your COM--
Object. If it is not the default interface the user will have to explicitly name it every time he wants to instantiate an equilla object.Object. If it is not the default interface the user will have to explicitly name it every time he wants to instantiate an equilla object.  
  
Equilla extension interfaces requirements and limitations:Equilla extension interfaces requirements and limitations:

l Limited set of return and argument types (see Limited set of return and argument types (see Extension Supported Parameter TypesExtension Supported Parameter Types))  
l Properties are not supportedProperties are not supported  
l default values are not supporteddefault values are not supported  
l only 'dual' interfaces are supportedonly 'dual' interfaces are supported  

EXAMPLE PROJECTSEXAMPLE PROJECTS  

A few sample projects are shipped with Tradesignal. They are located in the install folder of Tradesignal.A few sample projects are shipped with Tradesignal. They are located in the install folder of Tradesignal.

l ExcelOrderTracker (C#)ExcelOrderTracker (C#)  

l Demonstrates direct data transfer to MicrosoftDemonstrates direct data transfer to Microsoft--Excel.Excel.

l RSSExtension (C#)RSSExtension (C#)  

l Query of RSS 2.0 and Atom 1.0 data feeds, reacting on user interaction and display of custom user interface elements. This Query of RSS 2.0 and Atom 1.0 data feeds, reacting on user interaction and display of custom user interface elements. This 
Extension is accompanied by the RSSExtension is accompanied by the RSS--Indicator that can be found int the standard Tradesignal package.Indicator that can be found int the standard Tradesignal package.
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l TextFileReaderTextFileReader (C++) (C++)  

l Reading and processing of text file from an equilla script.Reading and processing of text file from an equilla script.    
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HOW TO WRITE A COM EXTENSION 
In this tutorial we will focus on using C# with Visual Studio 2008 (other versions of Visual Studio will work in much the same In this tutorial we will focus on using C# with Visual Studio 2008 (other versions of Visual Studio will work in much the same 
way). It is also relatively straightway). It is also relatively straight--forward to create extension objects in unmanaged C++ using ATL, and is preferable where raw forward to create extension objects in unmanaged C++ using ATL, and is preferable where raw 
performance is required. The TextFileReader sample project found in the installation directory of Tradesignal demonstrates how this performance is required. The TextFileReader sample project found in the installation directory of Tradesignal demonstrates how this 
is done.is done.

OBJECTIVE OBJECTIVE   

Create an Equilla extension object that can compute a Simple Moving Average and play a sound from the local hard disk.Create an Equilla extension object that can compute a Simple Moving Average and play a sound from the local hard disk.

CREATING A PROJECT FILE CREATING A PROJECT FILE   

The first task is to create an appropriate project:The first task is to create an appropriate project:

l Start Visual Studio 2008 (as administrator when running Windows Vista or above)Start Visual Studio 2008 (as administrator when running Windows Vista or above)  
l Select Select File > New > Project... > Visual C# > Class LibraryFile > New > Project... > Visual C# > Class Library  
l Enter a name for the Project (e.g. "SoundAverage") and click Enter a name for the Project (e.g. "SoundAverage") and click OKOKOKOK  
l A project containing a single class called A project containing a single class called Class1Class1 should have been created should have been created  

Once the project is created we must add a reference to the Once the project is created we must add a reference to the EquillaExtension.dllEquillaExtension.dll::

l Select Select Project > Add Reference... > COM > Tradesignal EquillaExtension 1.0 Type LibraryProject > Add Reference... > COM > Tradesignal EquillaExtension 1.0 Type Library and click  and click OKOKOKOK  

DEFINING THE INTERFACE DEFINING THE INTERFACE   

The next task is to define what the interface for our new object will be and then to make it visible via COM:The next task is to define what the interface for our new object will be and then to make it visible via COM:  
  
Open the Class1.cs file if it is not already open and inside the Open the Class1.cs file if it is not already open and inside the namespace SoundAveragenamespace SoundAverage block add the following: block add the following:

namespace SoundAverage 

{ 

public interface ISoundAverage 

{ 

double SimpleAverage(EquillaExtension.IDoubleSeries prices, int length); 

void PlaySound(string path); 

} 

public class Class1 

{ 

} 

} 

Next we must make the interface visible to COM, this requires us to indicate it is COM visible and to specify a unique class ID (a Next we must make the interface visible to COM, this requires us to indicate it is COM visible and to specify a unique class ID (a 
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GUID). Both of these can be set by specifying attributes as follows:GUID). Both of these can be set by specifying attributes as follows:

using System.Runtime.InteropServices; 

namespace SoundAverage 

{ 

[ComVisible(true)] 

[Guid("E4AF0866­A1DB­462f­A304­4ED46EB7C2E6")] 

public interface ISoundAverage 

{ 

double SimpleAverage(EquillaExtension.IDoubleSeries prices, int length); 

void PlaySound(string path); 

} 

public class Class1 

{ 

} 

} 

Important:Important:Important:Important: All classes and interfaces that we create must have a unique GUID, the tool under  All classes and interfaces that we create must have a unique GUID, the tool under Tools > Create GUIDTools > Create GUID is a simple  is a simple 
way to create a new GUID.way to create a new GUID.  
  
Important:Important:Important:Important: Once an interface is created and deployed it must  Once an interface is created and deployed it must nevernevernevernever change, it is one of the ground rules of COM development. If  change, it is one of the ground rules of COM development. If 
you want to add more methods to a deployed interface you must create new interfaces.you want to add more methods to a deployed interface you must create new interfaces.

ADDING HELP STRINGS TO THE INTERFACE ADDING HELP STRINGS TO THE INTERFACE   

Extension objects are supported by the auto suggest and insight help features of the Equilla Editor. In order to display help Extension objects are supported by the auto suggest and insight help features of the Equilla Editor. In order to display help 
messages we must adorn our interface and members with messages we must adorn our interface and members with DescriptionDescription attributes: attributes:

using System.Runtime.InteropServices; 

using System.ComponentModel; 

namespace SoundAverage 

{ 

[ComVisible(true)] 

[Guid("E4AF0866­A1DB­462f­A304­4ED46EB7C2E6")] 

[Description("Calculates a moving average and plays sounds")] 

public interface ISoundAverage 

{ 

[Description("Returns the result of a simple moving average")]   

double SimpleAverage(EquillaExtension.IDoubleSeries prices, int length); 

[Description("Asynchronously plays the .WAV file specified by the file name")] 

void PlaySound(string path); 

} 

public class Class1 

{ 
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} 

} 

IMPLEMENTING THE EXTENSION OBJECT IMPLEMENTING THE EXTENSION OBJECT   

Now that we have our interface, we can create a class that uses it.Now that we have our interface, we can create a class that uses it.  
  
First of all we must implement our interface (we will ignore error handling for the sake of brevity, and because the Equilla compiler First of all we must implement our interface (we will ignore error handling for the sake of brevity, and because the Equilla compiler 
and runtime engine will display exceptions in a useful way if they occur):and runtime engine will display exceptions in a useful way if they occur):

public class Class1 : ISoundAverage 

{ 

double ISoundAverage.SimpleAverage(EquillaExtension.IDoubleSeries prices, int length) 

{ 

double sum = 0; 

for (int i = 0; i < length; ++i) 

sum += prices.GetValue(i); 

return sum / length; 

} 

void ISoundAverage.PlaySound(string path) 

{ 

System.Media.SoundPlayer player = new System.Media.SoundPlayer(path); 

player.Play(); 

} 

} 

Next we must implement the Next we must implement the IEquillaExtensionIEquillaExtension interface, without this interface Tradesignal will not recognize the object: interface, without this interface Tradesignal will not recognize the object:

public class Class1 : ISoundAverage, EquillaExtension.IEquillaExtension 

{ 

double ISoundAverage.SimpleAverage(EquillaExtension.IDoubleSeries prices, int length) 

{ 

double sum = 0; 

for (int i = 0; i < length; ++i) 

sum += prices.GetValue(i); 

return sum / length; 

} 

void ISoundAverage.PlaySound(string path) 

{ 

System.Media.SoundPlayer player = new System.Media.SoundPlayer(path); 

player.Play(); 

} 

void EquillaExtension.IEquillaExtension.Attach(EquillaExtension.IEquillaHost Host) 

{ 
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} 

void EquillaExtension.IEquillaExtension.Detach() 

{ 

} 

} 

We do not need to use the We do not need to use the IEquillaExtensionIEquillaExtension methods in this case. methods in this case.  
  
We must next make the class visible to COM, indicate the default COM interface, and provide a suitable name (Prog ID) with We must next make the class visible to COM, indicate the default COM interface, and provide a suitable name (Prog ID) with 
which we will create the object from Equilla:which we will create the object from Equilla:

[ComVisible(true)] 

[Guid("516024B3­0D76­4d5b­97AE­65F3A30E0C8A")] 

[ComDefaultInterface(typeof(ISoundAverage))] 

[ProgId("SoundAverage.Class1")] 

public class Class1 : ISoundAverage, EquillaExtension.IEquillaExtension 

{ 

double ISoundAverage.SimpleAverage(EquillaExtension.IDoubleSeries prices, int length) 

{ 

double sum = 0; 

for (int i = 0; i < length; ++i) 

sum += prices.GetValue(i); 

return sum / length; 

} 

void ISoundAverage.PlaySound(string path) 

{ 

System.Media.SoundPlayer player = new System.Media.SoundPlayer(path); 

player.Play(); 

} 

void EquillaExtension.IEquillaExtension.Attach(EquillaExtension.IEquillaHost Host) 

{ 

} 

void EquillaExtension.IEquillaExtension.Detach() 

{ 

} 

} 

Our COMOur COM--based extension object is almost ready, we just need to build it and register it. based extension object is almost ready, we just need to build it and register it. 

l First indicate it should be registered automatically after it is built by checking the option: First indicate it should be registered automatically after it is built by checking the option: Project > SoundAverage Project > SoundAverage 
Properties... > Build > Output > Register for COM interopProperties... > Build > Output > Register for COM interop  

l Now, select Now, select Build > Build SolutionBuild > Build Solution to build the DLL. to build the DLL.  

Now we have a built and registered COMNow we have a built and registered COM--based Equilla Extension Object which could now be based Equilla Extension Object which could now be deployed to other users deployed to other users 
workstationsworkstations..
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USING THE EXTENSION FROM EQUILLA USING THE EXTENSION FROM EQUILLA   

To use the object from Equilla we must first create a new indicator called To use the object from Equilla we must first create a new indicator called LoudSMALoudSMA after starting Tradesignal. after starting Tradesignal.  
  
Next we must create an instance of our object as follows:Next we must create an instance of our object as follows:

Object:  

soundAverage( "SoundAverage.Class1" ); 

Notice how we use the same ID string as we declared in the Notice how we use the same ID string as we declared in the ProgIDProgID attribute when we created the object. attribute when we created the object.  
  
Finally we can call the functions on the Finally we can call the functions on the soundAveragesoundAverage object to plot a SMA and make an audio alert based on a sound file when a  object to plot a SMA and make an audio alert based on a sound file when a 
cross over occurs (we assume the file exists at the specified location).cross over occurs (we assume the file exists at the specified location).

Inputs:  

Price( Close ), 

Length( 14, 1 ), 

AlertFile( "C:\alert.wav" ); 

 

Object:  

soundAverage( "SoundAverage.Class1" ); 

 

Variable:  

lsma; 

 

lsma = soundAverage.SimpleAverage( Price, Length ); 

 

DrawLine( lsma, "LSMA" ); 

 

If Price Crosses Over lsma Then 

soundAverage.PlaySound( AlertFile ); 
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HOW TO DEPLOY A COM EXTENSION 
Once a COM Equilla extension Once a COM Equilla extension has been createdhas been created, it must be deployed to a target workstation. Deployment is fairly straight, it must be deployed to a target workstation. Deployment is fairly straight--forward, forward, 
consisting of the following steps:consisting of the following steps:

l Ensure prerequisites are installed (e.g. Tradesignal and correct version of C or .NET runtimes if Visual Studio 2008 is not Ensure prerequisites are installed (e.g. Tradesignal and correct version of C or .NET runtimes if Visual Studio 2008 is not 
used)used)  

l Copy the Extension DLLCopy the Extension DLL  
l Register the Extension DLL (either with Register the Extension DLL (either with regsvr32.exeregsvr32.exe for C++ DLLs or  for C++ DLLs or regasm.exeregasm.exe for .NET DLLs) for .NET DLLs)  
l Copy any indicator package created with TradesignalCopy any indicator package created with Tradesignal  
l Register the indicator package for auto discovery on Tradesignal startRegister the indicator package for auto discovery on Tradesignal start  

These steps are best combined into a setup for ease of distribution. Packages such as InstallShield can handle all of the These steps are best combined into a setup for ease of distribution. Packages such as InstallShield can handle all of the 
registration issues automatically.registration issues automatically.

DEPLOYING AN EXTENSION WITH A SETUP DEPLOYING AN EXTENSION WITH A SETUP   

The best way to distribute a library of indicators and/or strategies that include one or more Equilla extension DLLs is to use a setup.The best way to distribute a library of indicators and/or strategies that include one or more Equilla extension DLLs is to use a setup.  
  
First create the First create the packagepackage in Tradesignal and copy the extension DLLs into the folder that contains the package contents using  in Tradesignal and copy the extension DLLs into the folder that contains the package contents using 
Windows Explorer.Windows Explorer.  
  
Next, add this package folder including indicators, functions, strategies, manifest file and extension DLLs to a setup project (for Next, add this package folder including indicators, functions, strategies, manifest file and extension DLLs to a setup project (for 
example InstallShield). Already compiled indicators and strategies make it easier to use the deployed extension.example InstallShield). Already compiled indicators and strategies make it easier to use the deployed extension.  
  
Mark any Extension DLLs as requiring registration:Mark any Extension DLLs as requiring registration:

l In InstallShield C++ DLLs should be marked as In InstallShield C++ DLLs should be marked as Extract COM Information at BuildExtract COM Information at Build  
l In InstallShield .NET DLLs should be marked as In InstallShield .NET DLLs should be marked as Register for .NET COM interopRegister for .NET COM interop  

Now instruct the setup to add a string value to the following registry key, with a unique name (GUID) and a value that contains the Now instruct the setup to add a string value to the following registry key, with a unique name (GUID) and a value that contains the 
folder path on the target machine of the installed package:folder path on the target machine of the installed package:  
  
HKEY_LOCAL_MACHINE\Software\SystemSoft\TradeSignalEnterprise\PackagesHKEY_LOCAL_MACHINE\Software\SystemSoft\TradeSignalEnterprise\Packages  
  
This will make Tradesignal automatically add the package when it is next started.This will make Tradesignal automatically add the package when it is next started.  
  
Finally, build and test the setup.Finally, build and test the setup.    
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IEQUILLAEXTENSION INTERFACE 
An An extension objectextension object must implement the  must implement the IEquillaExtensionIEquillaExtension interface so that Tradesignal will recognize the object as a valid  interface so that Tradesignal will recognize the object as a valid 
extension. extension. 

interface IEquillaExtension 

{ 

void Attach(IEquillaHost Host); 

void Detach(); 

} 

When an object is first created the When an object is first created the Attach()Attach() method will be called by Tradesignal with a  method will be called by Tradesignal with a HostHost object as the only parameter. The  object as the only parameter. The 
majority of initialization should be performed in the majority of initialization should be performed in the Attach()Attach() method rather than the objects constructor. The Host object is a thread method rather than the objects constructor. The Host object is a thread--
safe object that allows an extension module to communicate with the hosting chart or list.safe object that allows an extension module to communicate with the hosting chart or list.  
  
When the Equilla script that declares the extension object is removed from a chart or list, the When the Equilla script that declares the extension object is removed from a chart or list, the Detach()Detach() method will be called,  method will be called, 
allowing the extension object to preform cleanallowing the extension object to preform clean--up. The majority of the cleanup. The majority of the clean--up of the object should be done in the up of the object should be done in the Detach()Detach()  
method rather than the objects destructor.method rather than the objects destructor.    
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IEQUILLAHOST INTERFACE 
The interface provides access to methods on the chart or list that is hosting the The interface provides access to methods on the chart or list that is hosting the extension objectextension object..

interface IEquillaHost 

{ 

void ScheduleEvaluation( bool Incremental ); 

string TimeZone { get; } 

int OwnerHandle { get; } 

} 

The The IEquillaHostIEquillaHost interface is implemented by the  interface is implemented by the HostHost object that is passed to each extension module shortly after creation. The  object that is passed to each extension module shortly after creation. The 
HostHost object is thread object is thread--safe (neutral threaded) and may be passed between and used from various threads without restriction.safe (neutral threaded) and may be passed between and used from various threads without restriction.

VOID SCHEDULEEVALUATION( BOOL INCREMENTAL ) VOID SCHEDULEEVALUATION( BOOL INCREMENTAL )   

Call this method to instruct the hosting chart or list to perform a new evaluation of the Equilla script that created the extension Call this method to instruct the hosting chart or list to perform a new evaluation of the Equilla script that created the extension 
object. This method is nonobject. This method is non--blocking and the evaluation will occur in the near future in much the same way as if a tick had been blocking and the evaluation will occur in the near future in much the same way as if a tick had been 
received. received.   
  
If If IncrementalIncremental is set to  is set to truetrue only the current bar will be reevaluated, if  only the current bar will be reevaluated, if IncrementalIncremental is set to  is set to falsefalse, the entire price history and any , the entire price history and any 
dependencies will be reevaluated. dependencies will be reevaluated.   
  
Please note:Please note:Please note:Please note: Performing frequent non Performing frequent non--incremetal evaluations will result in a incremetal evaluations will result in a severesevere reduction in system performance. reduction in system performance.

STRING TIMEZONE STRING TIMEZONE   

Returns the current application timezone in Windows Timezone ID Format. This string can be be used directly by the .NET Returns the current application timezone in Windows Timezone ID Format. This string can be be used directly by the .NET 
System.TimeZoneInfo.FindSystemTimeZoneById()System.TimeZoneInfo.FindSystemTimeZoneById() method. method.

System.TimeZoneInfo equillaTimeZone = System.TimeZoneInfo.FindSystemTimeZoneById( Host.TimeZone );

INT OWNERHANDLE INT OWNERHANDLE   

Returns the windows handle of an object that may be used as the parent of any windows that the extension object wants to show.Returns the windows handle of an object that may be used as the parent of any windows that the extension object wants to show.

// Helper object to convert a windows ID to a IWin32Window object. 

class WindowWrapper : IWin32Window 

{ 

public WindowWrapper( int handle ) 

{ 

Handle = new IntPtr( handle ); 

} 

public IntPtr Handle { get; private set; } 
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} 

// Show a message box that is owned by the Tradesignal application 

System.Windows.Forms.MessageBox.Show( new WindowWrapper( Host.OwnerHandle ), "A message from an extension"
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ISUPPORTSESSIONS INTERFACE 
An An extension objectextension object may implement the  may implement the ISupportSessionsISupportSessions interface in order to share a common  interface in order to share a common SessionSession object between all  object between all 
instances of the extension object used inside a single chart (or portfolio). Sessions provide a mechanism for multiple indicators instances of the extension object used inside a single chart (or portfolio). Sessions provide a mechanism for multiple indicators 
within a chart to share a common resource, for example a connection to an external server.within a chart to share a common resource, for example a connection to an external server.

interface ISupportSessions : IDispatch 

{ 

IEquillaExtensionSession CreateSessionObject(); 

void AttachSession(IEquillaExtensionSession Session); 

} 

The first time an extension object is created that implements this interface, a chart will call the The first time an extension object is created that implements this interface, a chart will call the CreateSessionObject()CreateSessionObject() factory  factory 
method, which must return an object that implements the method, which must return an object that implements the IEquillaExtensionSessionIEquillaExtensionSession interface. The newly created session will  interface. The newly created session will 
immediately be passed back to the extension object via a call to immediately be passed back to the extension object via a call to AttachSession()AttachSession(). .   
  
Following the creation of other extension objects of the same type within the same chart, the Following the creation of other extension objects of the same type within the same chart, the AttachSession()AttachSession() method will also be  method will also be 
called with the original session passed as the only parameter.called with the original session passed as the only parameter.  
  
The example project The example project RSSExtensionRSSExtension uses a session object to manage a pool of RSS feeds so that the same data does not need to be  uses a session object to manage a pool of RSS feeds so that the same data does not need to be 
rere--requested by each use of the RSS indicator within a chart.requested by each use of the RSS indicator within a chart.  
  
The example project The example project ExcelOrderTrackerExcelOrderTracker uses a session object to manage a single Excel workbook that all instruments within a chart  uses a session object to manage a single Excel workbook that all instruments within a chart 
will forward strategy data to.will forward strategy data to.    
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IEQUILLAEXTENSIONSESSION INTERFACE 
A session object may be created and shared between all instances of an A session object may be created and shared between all instances of an extension objectextension object used within a single chart (or portfolio).  used within a single chart (or portfolio). 
Such a session object must implement the Such a session object must implement the IEquillaExtensionSessionIEquillaExtensionSession interface. interface.

interface IEquillaExtensionSession 

{ 

void Attach(); 

void Detach(); 

} 

An extension session object will only ever be created by an extension object that implements the An extension session object will only ever be created by an extension object that implements the ISupportSessionsISupportSessions interface.  interface.   
  
Shortly after the session object is returned from the Shortly after the session object is returned from the ISupportSessions.CreateSessionObject()ISupportSessions.CreateSessionObject() method, the  method, the Attach()Attach() method will be  method will be 
called. It is expected that the majority of the construction logic for the session object will be performed in this method instead of called. It is expected that the majority of the construction logic for the session object will be performed in this method instead of 
the object's constructor.the object's constructor.  
  
When the last extension object that uses a session is removed from the chart (or portfolio), the When the last extension object that uses a session is removed from the chart (or portfolio), the Detach()Detach() method will be called, so  method will be called, so 
that the extension session can perform cleanthat the extension session can perform clean--up. It is expected that the majority of the destruction logic for the session object will up. It is expected that the majority of the destruction logic for the session object will 
be performed in this method instead of the object's destructor.be performed in this method instead of the object's destructor.    
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EQUILLACONSTANTS CLASS 
The EquillaConstants object provides access to standard values used within Equilla scripts that may be needed within an The EquillaConstants object provides access to standard values used within Equilla scripts that may be needed within an extension extension 
objectobject..

interface IEquillaConstants 

{ 

double InvalidValue { get; } 

DateTime InvalidDate { get; } 

} 

The The InvalidValueInvalidValue constant can be used to test if a price parameter is set to the Equilla Invalid value. constant can be used to test if a price parameter is set to the Equilla Invalid value.  
The The InvalidDateInvalidDate constant can be used to test if a date/time parameter is set to the Equilla Invalid value. constant can be used to test if a date/time parameter is set to the Equilla Invalid value.

// Test if a price is valid 

bool IsValidPrice( double price ) 

{ 

EquillaConstants eqConsts = new EquillaConstantsClass(); 

return price != eqConsts.InvalidValue; 

} 
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EXTENSION SIGNALS AND SINKS 
Extension objectsExtension objects can register interest in certain  can register interest in certain alertsalerts and other events that may be generated by a chart (or portfolio) that are not  and other events that may be generated by a chart (or portfolio) that are not 
directly related to an Equilla script evaluation. These directly related to an Equilla script evaluation. These signalssignals are broken down into four main categories that can be independently  are broken down into four main categories that can be independently 
hooked by the extension object: Equilla script alerts, tool alerts, strategy events and instrument events.hooked by the extension object: Equilla script alerts, tool alerts, strategy events and instrument events.  
  
To register interest in a specific class of signals, the extension object must implements a To register interest in a specific class of signals, the extension object must implements a SinkSink interface of the corresponding type: interface of the corresponding type:

interface IScriptSignal 

{ 

void ScriptSignalRaised( IScriptSignal Signal, bool MoreToFollow ); 

} 

interface IStrategySignalSink 

{ 

void StrategySignalRaised( IStrategySignal Signal, bool MoreToFollow ); 

} 

interface IToolSignalSink 

{ 

void ToolSignalRaised( IToolSignal Signal, bool MoreToFollow ); 

} 

In each of the above cases, the implemented method will be called when a signal is raised, containing an interface to an object In each of the above cases, the implemented method will be called when a signal is raised, containing an interface to an object 
the contains details of that signal (see below), the the contains details of that signal (see below), the MoreToFollowMoreToFollow flag will indicate if more signals are pending, so that the signals  flag will indicate if more signals are pending, so that the signals 
may be queued and processed in a batch when may be queued and processed in a batch when MoreToFollowMoreToFollow is set to  is set to falsefalse (this is of special importance with strategy orders). (this is of special importance with strategy orders).

interface ISymbolStateChangedSink 

{ 

SymbolStateChanged( string Symbol, string DisplayName, bool Active ); 

} 

Implementation of the Implementation of the ISymbolStateChangedSinkISymbolStateChangedSink allows an extension object to respond when instruments transition from an active  allows an extension object to respond when instruments transition from an active 
to an inactive state (inactive can mean the instrument is stale, or that the data connection has been lost).to an inactive state (inactive can mean the instrument is stale, or that the data connection has been lost).

ISCRIPTSIGNAL ISCRIPTSIGNAL   

Contains details about an Equilla alert that has occurred as the result of calling the Equilla Contains details about an Equilla alert that has occurred as the result of calling the Equilla Alert()Alert() function, or clicking on a chart  function, or clicking on a chart 
hyperlink generated by hyperlink generated by DrawText()DrawText() using the  using the signalsignal protocol. protocol.  
  
Please refer to the sample project Please refer to the sample project RSSExtensionRSSExtension and the corresponding indicator  and the corresponding indicator RSSRSS for how to hook and generate script alerts. for how to hook and generate script alerts.

interface IScriptSignal 

{ 

string SourcePath { get; }        // Unique workspace location of the event source 
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string DisplaySource { get; }     // User visible location of the event source 

string ScriptName { get; }        // Name of the script that generated the event 

string SignalName { get; }        // Name of the event 

string AlertText { get; }         // Test specified in the Alert() function 

string ParentSymbolName { get; }  // Symbol of the script parent instrument 

DateTime BarTimestamp { get; }    // Chart timestamp of the bar on which the alert was generated

double BarPrice { get; }          // Parent instrument price when the alert was generated 

DateTime TimestampUTC { get; }    // UTC Timestamp of the signal 

string ParentDisplayName { get; } // Display name of the script parent instrument 

} 

A simple way to generate an alert would be to use the following Equilla code:A simple way to generate an alert would be to use the following Equilla code:

If IsLastBar Then 

Alert( "It is the last bar: " + CStr( CurrentBar ) ); 

To generate script alerts from a user clicking on a hyperlink in the chart, do the following:To generate script alerts from a user clicking on a hyperlink in the chart, do the following:

If IsLastBar Then 

DrawText( High, "LinkTest", "Click 4 Alert", Default, Default, AlignTop,  

"signal:It is the last bar: " + CStr( CurrentBar ) ); 

ISTRATEGYSIGNAL ISTRATEGYSIGNAL   

Contains details about a strategy event that has occurred. Strategy events are generated when a chart is running Equilla strategies Contains details about a strategy event that has occurred. Strategy events are generated when a chart is running Equilla strategies 
that use the Buy, Sell, Short, Cover and ExitPosition functions to build and backtest a trading system.that use the Buy, Sell, Short, Cover and ExitPosition functions to build and backtest a trading system.  
  
Please refer to the sample project Please refer to the sample project ExcelOrderTrackerExcelOrderTracker and the corresponding indicator  and the corresponding indicator OrderTrackerOrderTracker for how to hook generated  for how to hook generated 
strategy alerts.strategy alerts.

interface IStrategySignal 

{ 

EStrategySignalType SignalType { get; }     // See below 

string SourcePath { get; }                  // Unique workspace location of the event source

string DisplaySource { get; }               // User visible location of the event source 

string ScriptName { get; }                  // Name of the script that generated the event

string SignalName { get; }                  // Name of the event 

string OrderId { get; }                     // Unique ID of the order to which the event belongs (placed, filled, etc.)

EStrategySignalOrderType OrderType { get; } // See below 

double OrderPrice { get; }                  // Price of the order (valid for limit and stop orders)

double OrderQuantity { get; }               // Size of the order 

string ParentSymbolName { get; }            // Symbol of the traded security 

DateTime BarTimestamp { get; }              // Chart timestamp on which the order occurred

double BarPrice { get; }                    // Chart price at which the order occurred 

DateTime TimestampUTC { get; }              // UTC timestamp of the order 
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string RelatedOrders { get; }               // XML list of orders that will be generated if this order is filled

string ParentDisplayName { get; }           // Display name of the traded security 

} 

enum EStrategySignalType  

{ 

eqSignalTypeLongEntryPlaced, 

eqSignalTypeLongExitPlaced, 

eqSignalTypeShortEntryPlaced, 

eqSignalTypeShortExitPlaced, 

eqSignalTypeOrderCancelled, 

eqSignalTypeOrderFilled, 

eqSignalTypeOrderModified, 

eqSignalTypeOrderModifiedTrailing, 

} 

enum EStrategySignalOrderType 

{ 

eqSignalTypeMarketLongEntry, 

eqSignalTypeMarketLongExit, 

eqSignalTypeMarketShortEntry, 

eqSignalTypeMarketShortExit, 

eqSignalTypeStopLongEntry, 

eqSignalTypeStopLongExit, 

eqSignalTypeStopShortEntry, 

eqSignalTypeStopShortExit, 

eqSignalTypeLimitLongEntry, 

eqSignalTypeLimitLongExit, 

eqSignalTypeLimitShortEntry, 

eqSignalTypeLimitShortExit 

} 

ITOOLSIGNAL ITOOLSIGNAL   

Contains details about a tool alert that has occurred.Contains details about a tool alert that has occurred.

interface IToolSignal 

{ 

EToolSignalType SignalType { get; }               // See below 

string SourcePath { get; }                        // Unique workspace location of the event source

string DisplaySource { get; }                     // User visible location of the event source

string ScriptName { get; }                        // Name of the script that generated the event

string SignalName { get; }                        // Signal text associated with the tool 

string ParentSymbolName { get; }                  // Symbol of the script parent instrument

DateTime BarTimestamp { get; }                    // Chart timestamp of the bar on which the alert was generated

double BarPrice { get; }                          // Parent instrument price when the alert was generated

EToolSignalToolType ToolType { get; }             // See below 



:: www.tradesignal.comwww.tradesignal.com

Tradesignal GmbHTradesignal GmbH Page 421Page 421 Version 7.0Version 7.0

EToolSignalLine Line { get; }                     // See below 

EToolSignalPriceDirection PriceDirection { get; } // See below 

string ToolText { get; }                          // Text associated with the tool 

DateTime TimestampUTC { get; }                    // UTC Timestamp of the signal 

string ParentDisplayName { get; }                 // Display name of the script parent instrument

} 

enum EToolSignalType 

{ 

eqSignalTypeCrossed, 

eqSignalTypeBreakIn, 

eqSignalTypeBreakOut, 

} 

enum EToolSignalLine 

{ 

eqToolLine, 

eqToolUpperLine, 

eqToolMiddleLine, 

eqToolLowerLine, 

eqToolLineChannel, 

eqToolLineFibo1, 

eqToolLineFibo2, 

eqToolLineFibo3, 

eqToolLineFibo4, 

eqToolLineFibo5, 

eqToolLineFibo6, 

eqToolLineFibo7, 

eqToolLineFibo8, 

eqToolLineFibo9, 

eqToolLineFibo10, 

eqToolLineFibo11, 

eqToolLineFibo12, 

eqToolLineFibo13, 

eqToolLineFibo14, 

eqToolLineFibo15, 

eqToolLineFibo16, 

}; 

enum EToolSignalToolType 

{ 

eqToolTypeTrendLine, 

eqToolTypeFiboRetracement, 

eqToolTypeStopLine, 

eqToolTypeTrendChannel, 

eqToolTypePitchfork, 

eqToolTypeRegressionChannel, 

}; 
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enum EToolSignalPriceDirection 

{ 

eqDirectionUpwards, 

eqDirectionDownwards, 

eqDirectionSideways, 

}; 
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EXTENSION SUPPORTED PARAMETER TYPES 
Extension objectsExtension objects must declare an interface that may only contain methods (no properties or events). These methods may only  must declare an interface that may only contain methods (no properties or events). These methods may only 
accept as parameters the types listed below, and only as input. The methods may only return a value that is one of the accept as parameters the types listed below, and only as input. The methods may only return a value that is one of the simple simple 
typestypes with the exception of  with the exception of objectobject. A method may also have a return type of . A method may also have a return type of voidvoid  -- to return nothing at all. to return nothing at all.

SIMPLE TYPES SIMPLE TYPES   

bool (IDL: VARIANT_BOOL) 

int (IDL: long) 

double (IDL: double) 

string (IDL: BSTR) 

DateTime (IDL: DATE) 

object (IDL: VARIANT) 

The The objectobject type should only be used when a function accepts different types for a specific parameter. The actual type of these  type should only be used when a function accepts different types for a specific parameter. The actual type of these 
parameters may change from call to call and can be of any of the supported types including extension objects (parameters may change from call to call and can be of any of the supported types including extension objects (IEquillaExtensionIEquillaExtension). ). 
Determining the actual type present is therefore a task for the extension object author. The Determining the actual type present is therefore a task for the extension object author. The objectobject type is not the same as a  type is not the same as a 
parameter that accepts an extension object which should use the parameter that accepts an extension object which should use the IEquillaExtensionIEquillaExtension type (see below). type (see below).

EXTENSION OBJECT TYPES EXTENSION OBJECT TYPES   

Any object that implements the Any object that implements the IEquillaExtensionIEquillaExtension interface can be passed to a method that has an  interface can be passed to a method that has an IEquillaExtensionIEquillaExtension parameter. parameter.

SERIES TYPES SERIES TYPES   

Accepting a series type as input allows the extension object to access historic values of the parameter. There is no length value Accepting a series type as input allows the extension object to access historic values of the parameter. There is no length value 
associated with the series types because the associated with the series types because the BackBufferBackBuffer of the Equilla Script will be determined by how much historic data is  of the Equilla Script will be determined by how much historic data is 
accessed by the script and any extension objects. So for example if a script only needs 14 bars of data to process, this value should accessed by the script and any extension objects. So for example if a script only needs 14 bars of data to process, this value should 
be provided to the extension object to ensure it does not blindly access historic data on a series variable and artificially elongate be provided to the extension object to ensure it does not blindly access historic data on a series variable and artificially elongate 
the the BackBufferBackBuffer (which could lead to severe performance problems). (which could lead to severe performance problems).  
  
In each of the below interfaces a single method exists, that when called will return the value at the supplied offset in the series In each of the below interfaces a single method exists, that when called will return the value at the supplied offset in the series 
variable. An offset of zero (0) implies the current value, one (1) the prior value and so on.variable. An offset of zero (0) implies the current value, one (1) the prior value and so on.

interface IDateTimeSeries 

{ 

DateTime GetDate( int Offset ); 

} 

interface IDoubleSeries 
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{ 

double GetValue( int Offset ); 

} 

interface IIntegerSeries 

{ 

int GetValue( int Offset ); 

} 

interface IStringSeries 

{ 

string GetValue( int Offset ); 

} 

interface IBooleanSeries 

{ 

bool GetValue( int Offset ); 

} 

interface IVariantSeries 

{ 

object GetValue( int Offset ); 

} 

The The IVariantSeriesIVariantSeries should only be used when a variable can contain a mixture of the other basic types (which is never a good thing  should only be used when a variable can contain a mixture of the other basic types (which is never a good thing 
to do). Determining the actual type present is therefore a task for the extension object author.to do). Determining the actual type present is therefore a task for the extension object author.

ARRAY TYPES ARRAY TYPES   

Array types accept as input Array types accept as input Equilla ArraysEquilla Arrays (declared using the  (declared using the Array:Array: block in an Equilla script). The extension API provides  block in an Equilla script). The extension API provides 
dedicated support for onededicated support for one-- and two and two--dimensional arrays, and a generic version for ndimensional arrays, and a generic version for n--dimensional arrays.dimensional arrays.  
  
For each basic type supported by an array there is a corresponding series type with the same behavior as described for series types For each basic type supported by an array there is a corresponding series type with the same behavior as described for series types 
above. Array interfaces have a method to access a value at a given index (and offset in the case of series) and a property for above. Array interfaces have a method to access a value at a given index (and offset in the case of series) and a property for 
determining the maximum index possible. Arrays are zerodetermining the maximum index possible. Arrays are zero--based.based.  
  
Arrays that hold Arrays that hold VariantVariant types should only be used when a variable can contain a mixture of the other basic types (which is never a  types should only be used when a variable can contain a mixture of the other basic types (which is never a 
good thing to do). Determining the actual type present is therefore a task for the extension object author.good thing to do). Determining the actual type present is therefore a task for the extension object author.

ONEONE--DIMENSIONAL ARRAYS DIMENSIONAL ARRAYS   

interface IDateTimeArray 

{ 

DateTime GetDate(int Index); 

int MaxIndex { get; } 

} 

interface IDateTimeArraySeries  



:: www.tradesignal.comwww.tradesignal.com

Tradesignal GmbHTradesignal GmbH Page 425Page 425 Version 7.0Version 7.0

{ 

DateTime GetDate(int Offset, int Index); 

int MaxIndex { get; } 

} 

interface IDoubleArray 

{ 

double GetValue(int Index); 

int MaxIndex { get; } 

} 

interface IDoubleArraySeries  

{ 

double GetValue(int Offset, int Index); 

int MaxIndex { get; } 

} 

interface IIntegerArray 

{ 

int GetValue(int Index); 

int MaxIndex { get; } 

} 

interface IIntegerArraySeries 

{ 

int GetValue(int Offset, int Index); 

int MaxIndex { get; } 

} 

interface IStringArray 

{ 

string GetValue(int Index); 

int MaxIndex { get; } 

} 

interface IStringArraySeries 

{ 

string GetValue(int Offset, int Index); 

int MaxIndex { get; } 

} 

interface IBooleanArray 

{ 

bool GetValue(int Index); 

int MaxIndex { get; } 

} 

interface IBooleanArraySeries 

{ 

bool GetValue(int Offset, int Index); 

int MaxIndex { get; } 

} 

interface IVariantArray 
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{ 

object GetValue(int Index); 

int MaxIndex { get; } 

} 

interface IVariantArraySeries 

{ 

object GetValue(int Offset, int Index); 

int MaxIndex { get; } 

} 

TWOTWO--DIMENSIONAL ARRAYS DIMENSIONAL ARRAYS   

interface IDateTimeArray2D 

{ 

DateTime GetDate(int Row, int Column); 

int GetMaxIndexOfDimension(int Dimension); 

} 

interface IDateTimeArray2DSeries  

{ 

DateTime GetDate(int Offset, int Row, int Column); 

int GetMaxIndexOfDimension(int Dimension); 

} 

interface IDoubleArray2D 

{ 

double GetValue(int Row, int Column); 

int GetMaxIndexOfDimension(int Dimension); 

} 

interface IDoubleArray2DSeries  

{ 

double GetValue(int Offset, int Row, int Column); 

int GetMaxIndexOfDimension(int Dimension); 

} 

interface IIntegerArray2D 

{ 

int GetValue(int Row, int Column); 

int GetMaxIndexOfDimension(int Dimension); 

} 

interface IIntegerArray2DSeries 

{ 

int GetValue(int Offset, int Row, int Column); 

int GetMaxIndexOfDimension(int Dimension); 

} 

interface IStringArray2D 

{ 
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string GetValue(int Row, int Column); 

int GetMaxIndexOfDimension(int Dimension); 

} 

interface IStringArray2DSeries 

{ 

string GetValue(int Offset, int Row, int Column); 

int GetMaxIndexOfDimension(int Dimension); 

} 

interface IBooleanArray2D 

{ 

bool GetValue(int Row, int Column); 

int GetMaxIndexOfDimension(int Dimension); 

} 

interface IBooleanArray2DSeries 

{ 

bool GetValue(int Offset, int Row, int Column); 

int GetMaxIndexOfDimension(int Dimension); 

} 

interface IVariantArray2D 

{ 

object GetValue(int Row, int Column); 

int GetMaxIndexOfDimension(int Dimension); 

} 

interface IVariantArray2DSeries 

{ 

object GetValue(int Offset, int Row, int Column); 

int GetMaxIndexOfDimension(int Dimension); 

} 

NN--DIMENSIONAL ARRAYS DIMENSIONAL ARRAYS   

interface IDateTimeArrayND 

{ 

DateTime GetDate(int[] Indices); 

int GetMaxIndexOfDimension(int Dimension); 

int Dimensions { get; } 

} 

interface IDateTimeArrayNDSeries  

{ 

DateTime GetDate(int Offset, int[] Indices); 

int GetMaxIndexOfDimension(int Dimension); 

int Dimensions { get; } 

} 

interface IDoubleArrayND 
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{ 

double GetValue(int[] Indices); 

int GetMaxIndexOfDimension(int Dimension); 

int Dimensions { get; } 

} 

interface IDoubleArrayNDSeries  

{ 

double GetValue(int Offset, int[] Indices); 

int GetMaxIndexOfDimension(int Dimension); 

int Dimensions { get; } 

} 

interface IIntegerArrayND 

{ 

int GetValue(int[] Indices); 

int GetMaxIndexOfDimension(int Dimension); 

int Dimensions { get; } 

} 

interface IIntegerArrayNDSeries 

{ 

int GetValue(int Offset, int[] Indices); 

int GetMaxIndexOfDimension(int Dimension); 

int Dimensions { get; } 

} 

interface IStringArrayND 

{ 

string GetValue(int[] Indices); 

int GetMaxIndexOfDimension(int Dimension); 

int Dimensions { get; } 

} 

interface IStringArrayNDSeries 

{ 

string GetValue(int Offset, int[] Indices); 

int GetMaxIndexOfDimension(int Dimension); 

int Dimensions { get; } 

} 

interface IBooleanArrayND 

{ 

bool GetValue(int[] Indices); 

int GetMaxIndexOfDimension(int Dimension); 

int Dimensions { get; } 

} 

interface IBooleanArrayNDSeries 

{ 

bool GetValue(int Offset, int[] Indices); 

int GetMaxIndexOfDimension(int Dimension); 
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int Dimensions { get; } 

} 

interface IVariantArrayND 

{ 

object GetValue(int[] Indices); 

int GetMaxIndexOfDimension(int Dimension); 

int Dimensions { get; } 

} 

interface IVariantArrayNDSeries 

{ 

object GetValue(int Offset, int[] Indices); 

int GetMaxIndexOfDimension(int Dimension); 

int Dimensions { get; } 

} 

EXAMPLE: PASSING AN ARRAY TO AN EXTENSION DLL EXAMPLE: PASSING AN ARRAY TO AN EXTENSION DLL   

C# interface and code for the extension DLL (all other series and array types are used in much the same way):C# interface and code for the extension DLL (all other series and array types are used in much the same way):

public interface ISoundAverage 

{ 

[Description("Asynchronously plays the .WAV files specified by the array of file names")] 

void PlaySounds(IStringArray paths); 

} 

[ProgId("SoundAverage.Class1")] 

public class Class1 : ISoundAverage, EquillaExtension.IEquillaExtension 

{ 

void ISoundAverage.PlaySounds(IStringArray paths) 

{ 

for(int i = 1; i < paths.MaxIndex; ++i) 

{ 

System.Media.SoundPlayer player = new System.Media.SoundPlayer(paths.GetValue(i));

player.Play(); 

} 

} 

void EquillaExtension.IEquillaExtension.Attach(EquillaExtension.IEquillaHost Host) 

{ 

} 

void EquillaExtension.IEquillaExtension.Detach() 

{ 

} 

} 

Usage from Equilla:Usage from Equilla:
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Inputs:  

Price( Close ), 

Length( 14, 1 ); 

 

Array:  

pathArray[](); 

 

Object:  

soundAverage( "SoundAverage.Class1" ); 

 

If CurrentBar = 1 Then 

FillArray( pathArray, "c:\file1.wav", "c:\file2.wav" ); 

 

If Price Crosses Over Average( Price, Length ) Then 

soundAverage.PlaySound( paths ); 
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DATA FEEDS 
Here you can find a list of data providers supported by the Tradesignal family.Here you can find a list of data providers supported by the Tradesignal family.  

THOMSON REUTERS THOMSON REUTERS   

Available for Available for TradesignalTradesignalTradesignalTradesignal. Further information for existing customers using a Thomson Reuters data feed can be found in the . Further information for existing customers using a Thomson Reuters data feed can be found in the 
Thomson Reuters DataThomson Reuters DataThomson Reuters DataThomson Reuters Data section. A list of all mayor symbol codes you can find here:  section. A list of all mayor symbol codes you can find here: Reuters SymbollistsReuters SymbollistsReuters SymbollistsReuters Symbollists. Reuters users . Reuters users 
interested in testing Tradesignal can find more information online at interested in testing Tradesignal can find more information online at www.tradesignal.comwww.tradesignal.com..

BLOOMBERG BLOOMBERG   

Available for Available for TradesignalTradesignalTradesignalTradesignal. Further information for existing customers using a Bloomberg data feed can be found in the . Further information for existing customers using a Bloomberg data feed can be found in the Bloomberg Bloomberg Bloomberg Bloomberg 
DataDataDataData section. A list of all mayor symbol codes you can find here:  section. A list of all mayor symbol codes you can find here: Bloomberg SymbollistsBloomberg SymbollistsBloomberg SymbollistsBloomberg Symbollists. Bloomberg users interested in testing . Bloomberg users interested in testing 
Tradesignal can find more information online at Tradesignal can find more information online at www.tradesignal.comwww.tradesignal.com..

TRAYPORT GLOBALVISION TRAYPORT GLOBALVISION   

Available for Available for TradesignalTradesignalTradesignalTradesignal. Trayport users interested in testing Tradesignal can find more information online at . Trayport users interested in testing Tradesignal can find more information online at 
www.tradesignal.comwww.tradesignal.com..

TELETRADER TELETRADER   

Available for nonAvailable for non--professional users as part of professional users as part of Tradesignal Online TerminalTradesignal Online TerminalTradesignal Online TerminalTradesignal Online Terminal, more information and a free trial for this product can , more information and a free trial for this product can 
be found online at be found online at terminal.tradesignal.comterminal.tradesignal.com..  
  
Available for professional users with Available for professional users with TradesignalTradesignalTradesignalTradesignal. Further information for existing customers using a TeleTrader data feed can be . Further information for existing customers using a TeleTrader data feed can be 
found in the found in the TeleTrader DataTeleTrader DataTeleTrader DataTeleTrader Data section. TeleTrader users interested in testing tradesignal enterprise edition can find more  section. TeleTrader users interested in testing tradesignal enterprise edition can find more 
information online at information online at www.tradesignal.comwww.tradesignal.com..

MISSING A DATA PROVIDER?MISSING A DATA PROVIDER?  

You would like to see the list of data providers expanded? No problem You would like to see the list of data providers expanded? No problem -- contact us at  contact us at sales@tradesignal.comsales@tradesignal.com to discuss the  to discuss the 
possibility of connecting another data provider to Tradesignal.possibility of connecting another data provider to Tradesignal.    
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SESSIONS, HOLIDAYS AND PROPERTIES 
Information on basic data properties, sessions, time zones and holidays are usually offered by the data provider together with the Information on basic data properties, sessions, time zones and holidays are usually offered by the data provider together with the 
quotations. However, the data may contain errors quotations. However, the data may contain errors --  for whatever reason for whatever reason --  or the data may cause unwanted side effects in your or the data may cause unwanted side effects in your 
trading system or the chart display. For cases like these, Tradesignal offers you the possibility to add missing information or even trading system or the chart display. For cases like these, Tradesignal offers you the possibility to add missing information or even 
overwrite the delivered data. Use the editing for: overwrite the delivered data. Use the editing for: 

l Adjusting currency data to your working hoursAdjusting currency data to your working hours  
l Adding the right trading times (sessions) to quotationsAdding the right trading times (sessions) to quotations  
l Adding time zone information for quotationsAdding time zone information for quotations  
l Adding missing holidays or other days without tradingAdding missing holidays or other days without trading  

MODIFY SESSIONS AND PROPERTIES WINDOWMODIFY SESSIONS AND PROPERTIES WINDOW  

The window for editing the sessions, holidays and properties can be called up for an instrument (a symbol). This can be done in a The window for editing the sessions, holidays and properties can be called up for an instrument (a symbol). This can be done in a 
ChartChart, or from a selected row in the , or from a selected row in the ScannerScanner, , WatchlistWatchlist or  or PortfolioPortfolio. You can open the window in two ways:. You can open the window in two ways:

l Click on the Click on the SessionsSessionsSessionsSessions button in the  button in the Home > DataHome > Data group on the  group on the ToolbarToolbar..  
l Alternatively, rightAlternatively, right--click on the chart legend or the selected row and choose the option click on the chart legend or the selected row and choose the option Show Session ManagerShow Session ManagerShow Session ManagerShow Session Manager in the  in the 

context menu.context menu.  

The window opens. The name of the currently edited instrument is displayed in the window header.The window opens. The name of the currently edited instrument is displayed in the window header.

DEFINING SESSIONSDEFINING SESSIONS  

On the tab On the tab SessionsSessions you can set up which times should be used for trading.  you can set up which times should be used for trading. 
You have two options:You have two options:

l Use session information from the data providerUse session information from the data providerUse session information from the data providerUse session information from the data provider  --  Select this Select this 
option if you want to use the information delivered by the provider. option if you want to use the information delivered by the provider. 
E.g., the trading hours of the NYSE are 9:30E.g., the trading hours of the NYSE are 9:30� 16:00 local time.16:00 local time.  

l Use session information defined below for all charts Use session information defined below for all charts Use session information defined below for all charts Use session information defined below for all charts 
displaying this instrumentdisplaying this instrumentdisplaying this instrumentdisplaying this instrument  --  Select this option to set up your own Select this option to set up your own 
trading times for a symbol.trading times for a symbol.  

The trading hours are displayed as blue areas in the session display. Move The trading hours are displayed as blue areas in the session display. Move 
the mouse over the cells to see which time range they represent.the mouse over the cells to see which time range they represent.    
  
You can select the trading hours as follows (repeating the actions removes the selection again):You can select the trading hours as follows (repeating the actions removes the selection again):

l Click on the name of each weekday to add (or remove) complete days from the selection.Click on the name of each weekday to add (or remove) complete days from the selection.  
l Keep the mouse button pressed and move the mouse over the upper edge of the session display to select a time block, e.g. Keep the mouse button pressed and move the mouse over the upper edge of the session display to select a time block, e.g. 

08:00 to 15:00.08:00 to 15:00.  
l Click on a column header to select a cell column.Click on a column header to select a cell column.  
l To define session times to the minute, rightTo define session times to the minute, right--click a cell and select another start time from the list.click a cell and select another start time from the list.  

Session Manager, Tab SessionsSession Manager, Tab Sessions
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l To select a continuous region, keep the mouse button pressed while moving over the cells in the session display.To select a continuous region, keep the mouse button pressed while moving over the cells in the session display.  

You can select a You can select a Time ZoneTime ZoneTime ZoneTime Zone for which the quotations are displayed. This setting is important when you are using external  for which the quotations are displayed. This setting is important when you are using external 
quotations from distant exchanges and the original data does not include the time information. You can also set the time zone quotations from distant exchanges and the original data does not include the time information. You can also set the time zone 
when defining external data sources (see the chapter when defining external data sources (see the chapter Data SourcesData Sources); however, in this case the settings affect all data in the defined ); however, in this case the settings affect all data in the defined 
folder, even when they do not belong to the same time zone. folder, even when they do not belong to the same time zone.   
  
When you want to display trading information after the official end of the session without new bars/candles being generated, When you want to display trading information after the official end of the session without new bars/candles being generated, 
select the option select the option Session ExtensionSession ExtensionSession ExtensionSession Extension. Enter a number of bars or click on the small arrows to enter the numbers. The information for . Enter a number of bars or click on the small arrows to enter the numbers. The information for 
high, close, low and volume are added to the last bar. When you select the additional option high, close, low and volume are added to the last bar. When you select the additional option Disable volume cumulation in Disable volume cumulation in Disable volume cumulation in Disable volume cumulation in 
session extension periodsession extension periodsession extension periodsession extension period, only the prices, not the volume are added to the last bar., only the prices, not the volume are added to the last bar.

DEFINE HOLIDAYSDEFINE HOLIDAYS  

On the tab On the tab HolidaysHolidays you can define which holiday options should be used.  you can define which holiday options should be used. 
There are two options:There are two options:

l Use holiday information from the data providerUse holiday information from the data providerUse holiday information from the data providerUse holiday information from the data provider  -- Select this  Select this 
option to use information delivered by the provider. (Note: not every option to use information delivered by the provider. (Note: not every 
Dataprovider delivers holiday information)Dataprovider delivers holiday information)  

l Use holiday information defined below for all such Use holiday information defined below for all such Use holiday information defined below for all such Use holiday information defined below for all such 
instrumentsinstrumentsinstrumentsinstruments  -- Select this option to enter holidays. You can define  Select this option to enter holidays. You can define 
any day as "holiday", i.e. day without trading activity, for example any day as "holiday", i.e. day without trading activity, for example 
bridging days.bridging days.  

To add a new holiday, click on To add a new holiday, click on NewNewNewNew. A dialog opens. To enter the date, . A dialog opens. To enter the date, 
click on the arrow button to open a calendar in which you can select a date. Then enter a name for the holiday.click on the arrow button to open a calendar in which you can select a date. Then enter a name for the holiday.  
  
To edit a holiday, select it in the list and click on To edit a holiday, select it in the list and click on EditEditEditEdit. A dialog opens in which you can edit the date and/or the name. . A dialog opens in which you can edit the date and/or the name.   
  
To delete a holiday, select it in the list and click on To delete a holiday, select it in the list and click on DeleteDeleteDeleteDelete..

EDIT SECURITY PROPERTIESEDIT SECURITY PROPERTIES  

On the tab On the tab PropertiesProperties you can change four settings for the instrument data.  you can change four settings for the instrument data. 
This is especially useful when the external data does not include this This is especially useful when the external data does not include this 
information. As default, the information. As default, the StandardStandard settings are selected.  settings are selected.   
  
Instrument NameInstrument NameInstrument NameInstrument Name  -- Here you can change the name of the symbol as  Here you can change the name of the symbol as 
displayed in the chart. displayed in the chart.   
  
Lot SizeLot SizeLot SizeLot Size  -- The Lot Size is the smallest number of pieces traded, for  The Lot Size is the smallest number of pieces traded, for 
example 100 pieces for a security. For futures, it is usually 1 piece. To example 100 pieces for a security. For futures, it is usually 1 piece. To 
simulate a leverage effect that is caused by multipliers, you can edit the lot simulate a leverage effect that is caused by multipliers, you can edit the lot 
size. For the Dax Future that would be 25 Euro, for the Bund Future 1000 Euro.size. For the Dax Future that would be 25 Euro, for the Bund Future 1000 Euro.  

Session Manager, Tab HolidaysSession Manager, Tab Holidays

Session Manager, Tab PropertiesSession Manager, Tab Properties
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Tick SizeTick SizeTick SizeTick Size  -- There you can change the smallest possible price movement of a security. For stocks and some indices, it is 0.01 Cent.  There you can change the smallest possible price movement of a security. For stocks and some indices, it is 0.01 Cent. 
For some futures it is 0.5 points, for other futures 0.01 ticks or for currencies 0.0001 pips. For some futures it is 0.5 points, for other futures 0.01 ticks or for currencies 0.0001 pips.   
  
Display UnitDisplay UnitDisplay UnitDisplay Unit  -- Here you can change the smallest unit of the value scale. Here you can change the smallest unit of the value scale.    
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IMPORTING EXTERNAL DATA 
Today, all charting software is connected to the internet and thus also to a data provider. This data is called "primary data feed" in Today, all charting software is connected to the internet and thus also to a data provider. This data is called "primary data feed" in 
Tradesignal. For intraday trading, it is important to have upTradesignal. For intraday trading, it is important to have up--toto--date and selfdate and self--refreshing data. refreshing data.   
  
For some trading methods or for developing trading systems and tests, however, it is important to have long histories and a high For some trading methods or for developing trading systems and tests, however, it is important to have long histories and a high 
time resolution. These histories are often expensive and can only be purchased as monthly subscriptions. A less expensive and time resolution. These histories are often expensive and can only be purchased as monthly subscriptions. A less expensive and 
more individual solution is the inclusion of historic data of files saved on hard drives, removable storage or web servers. For such more individual solution is the inclusion of historic data of files saved on hard drives, removable storage or web servers. For such 
quotation data, many free and pay sources are available. This allows the users to retrieve and pay only for the histories they need quotation data, many free and pay sources are available. This allows the users to retrieve and pay only for the histories they need 
for their analysis.for their analysis.  
  
Offline quotations from external sources can be used for: Offline quotations from external sources can be used for: 

l Extending the price histories of the online data providerExtending the price histories of the online data provider  
l Inserting instruments not offered by the online data providerInserting instruments not offered by the online data provider  
l Inserting data other than quotations (business or sentiment indicators, statistics)Inserting data other than quotations (business or sentiment indicators, statistics)  

External data is treated the same as data from the online provider. You can apply all functions like External data is treated the same as data from the online provider. You can apply all functions like Chart AnalysisChart Analysis, , IndicatorsIndicators, , 
StrategiesStrategies, the , the PortfolioPortfolio and the  and the ScannerScanner..  
  
In the following, you can find information about the import of external data and the necessary structure of the file name and the In the following, you can find information about the import of external data and the necessary structure of the file name and the 
data of such quotation files.data of such quotation files.    
  

IMPORTING EXTERNAL DATA IN TRADESIGNALIMPORTING EXTERNAL DATA IN TRADESIGNAL  

EDITING THE DATA FEEDSEDITING THE DATA FEEDS  

You can open the settings for the data feed in two ways:You can open the settings for the data feed in two ways:

l DoubleDouble--click the connection icon in the topclick the connection icon in the top--right corner of the right corner of the 
Tradesignal window.Tradesignal window.  

l Alternatively, open the file menu, select the Alternatively, open the file menu, select the OptionsOptionsOptionsOptions entry and click  entry and click 
on on DatafeedsDatafeedsDatafeedsDatafeeds..  

The area for data connection appears in the right side of the window. At The area for data connection appears in the right side of the window. At 
the top you can find settings for the data connection to online providers, for the top you can find settings for the data connection to online providers, for 
example "Tradesignal Online Terminal". Below you can find the settings for example "Tradesignal Online Terminal". Below you can find the settings for 
the "additional data sources" that are available offline. the "additional data sources" that are available offline. 

DATAFEED (ONLINE DATA)DATAFEED (ONLINE DATA)  

Here you can set up the primary data feed.Here you can set up the primary data feed.

l ProviderProviderProviderProvider  -- Select your online provider here. Select your online provider here.  
l SettingsSettingsSettingsSettings  -- Here you can see the settings of your connection. Different data feeds have different settings. To edit an entry,  Here you can see the settings of your connection. Different data feeds have different settings. To edit an entry, 

Entry Datafeed in the Tradesignal OptionsEntry Datafeed in the Tradesignal Options
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click on the value to the right, for example "300" for the parameter "Keep Alive Interval".click on the value to the right, for example "300" for the parameter "Keep Alive Interval".  

Click on the Click on the Show more optionsShow more optionsShow more optionsShow more options link to show less critical configuration options. link to show less critical configuration options.  
  
When you make changes to the data feed, a link will appear offering the chance to reconnect now. Alternatively, clicking on the When you make changes to the data feed, a link will appear offering the chance to reconnect now. Alternatively, clicking on the 
connection button at the top right above the toolbar will show a menu with a reconnect option.connection button at the top right above the toolbar will show a menu with a reconnect option.

CSV DATA SOURCES (OFFLINE DATA)CSV DATA SOURCES (OFFLINE DATA)  

Here you can edit additional data sources. Depending on the settings, this data is used in addition to or as a substitution for online Here you can edit additional data sources. Depending on the settings, this data is used in addition to or as a substitution for online 
data.data.  
  
Any available path can be used as data source. You can define folders on local hard drives, external hard drives or network drives Any available path can be used as data source. You can define folders on local hard drives, external hard drives or network drives 
as additional data sources. It is also possible to use web or XML servers. as additional data sources. It is also possible to use web or XML servers.   
  
The list of data sources determines the order in which Tradesignal searches these folders. When you use a symbol in a chart, this The list of data sources determines the order in which Tradesignal searches these folders. When you use a symbol in a chart, this 
is important if you have more than one folder for the same symbol. In this case, the order determines which data is displayed. is important if you have more than one folder for the same symbol. In this case, the order determines which data is displayed. 

l NewNewNewNew  -- Create a new data source. A dialog opens, see next section. Create a new data source. A dialog opens, see next section.  
l EditEditEditEdit  -- Edit the selected data source. Edit the selected data source.  
l DeleteDeleteDeleteDelete  -- Delete the selected data source. Only the source reference is deleted, not the data on the drives. Delete the selected data source. Only the source reference is deleted, not the data on the drives.  
l UpUpUpUp//DownDownDownDown  -- Use these buttons to change the sequence of folders in the list. Use these buttons to change the sequence of folders in the list.  

ADDING AND EDITING ADDITIONAL DATA SOURCESADDING AND EDITING ADDITIONAL DATA SOURCES  

Set up the type of the additional data source:Set up the type of the additional data source:

l Add a folder containing CSV dataAdd a folder containing CSV dataAdd a folder containing CSV dataAdd a folder containing CSV data  -- To configure the folder, click  To configure the folder, click 
on on BrowseBrowseBrowseBrowse. Select the folder in which the imported files are . Select the folder in which the imported files are 
located. This may be any folder available on your computer or via located. This may be any folder available on your computer or via 
intranet.intranet.  You can also create a new folder for future import. The You can also create a new folder for future import. The 
folder is also called "topfolder is also called "top--Up service", as it works like a data Up service", as it works like a data 
provider.provider.  

Please note that external quotation files can only be used when they are Please note that external quotation files can only be used when they are 
located in the configured folder and adhere to both the located in the configured folder and adhere to both the Naming Naming 
Conventions for FilesConventions for Files and the  and the Data FormatsData Formats. . 

l Add a TXML serverAdd a TXML serverAdd a TXML serverAdd a TXML server  -- Select this option if the external data is to be  Select this option if the external data is to be 
found on a web or XML server. Enter a URL.found on a web or XML server. Enter a URL.  

Select the Select the TimezoneTimezoneTimezoneTimezone from the list (see above). from the list (see above).  
  
You can enter a You can enter a Text that is added to the legend name of an Text that is added to the legend name of an Text that is added to the legend name of an Text that is added to the legend name of an 
instrumentinstrumentinstrumentinstrument. The default string is "top. The default string is "top--up". You can enter any other string or delete the entry and leave the field empty. The up". You can enter any other string or delete the entry and leave the field empty. The 
additional label on the offline data is intended to help you distinguish them from online data. This is especially useful if both data additional label on the offline data is intended to help you distinguish them from online data. This is especially useful if both data 
sets have the same shortcut. Additional label won't be visible when extending the price histories of the online data.sets have the same shortcut. Additional label won't be visible when extending the price histories of the online data.

Window view "Location of Data Source"Window view "Location of Data Source"



:: www.tradesignal.comwww.tradesignal.com

Tradesignal GmbHTradesignal GmbH Page 438Page 438 Version 7.0Version 7.0

COMBINING ONLINE AND OFFLINE DATACOMBINING ONLINE AND OFFLINE DATA  

If symbol data is available online and offline (topIf symbol data is available online and offline (top--up), you can configure how Tradesignal should proceed:up), you can configure how Tradesignal should proceed:  
  
Only use data to backOnly use data to backOnly use data to backOnly use data to back----fill missing historic datafill missing historic datafill missing historic datafill missing historic data (default setting)  (default setting) -- Usually, the online data provider offers all instruments  Usually, the online data provider offers all instruments 
needed. However, the available history is often too short or no intraday data is available. If you want to fill the missing history byneeded. However, the available history is often too short or no intraday data is available. If you want to fill the missing history by  
data of offline sources, the files have to be saved in the folder configured above and the data shortcut has to be the same as for the data of offline sources, the files have to be saved in the folder configured above and the data shortcut has to be the same as for the 
instrument of the online provider. Only if both conditions are met, Tradesignal can concatenate the data. The program attempts to instrument of the online provider. Only if both conditions are met, Tradesignal can concatenate the data. The program attempts to 
fill the history into the past. The additional data is inserted at the point where the history of the online data provider ends. fill the history into the past. The additional data is inserted at the point where the history of the online data provider ends.   
  
Always overwrite historic dataAlways overwrite historic dataAlways overwrite historic dataAlways overwrite historic data  -- This setting is only sensible if you have enough offline data for this instrument, so that most or  This setting is only sensible if you have enough offline data for this instrument, so that most or 
all of the online data is unnecessary. Alternatively, you could also enter a new instrument name so that no collision or all of the online data is unnecessary. Alternatively, you could also enter a new instrument name so that no collision or 
concatenation could take place. However, if you want to use a general shortcut for the data without using the online data, this is concatenation could take place. However, if you want to use a general shortcut for the data without using the online data, this is 
the right option.the right option.  

CONDITIONS FOR THE CORRECT DISPLAY OF TRADING PERIODSCONDITIONS FOR THE CORRECT DISPLAY OF TRADING PERIODS  

For Tradesignal to recognize the time resolution (period) of your data, certain conditions have to be met for the For Tradesignal to recognize the time resolution (period) of your data, certain conditions have to be met for the File NamesFile Names and the  and the 
Data FormatData Format. In cases of display problems or certain trading periods missing in the chart although the data is available, the error . In cases of display problems or certain trading periods missing in the chart although the data is available, the error 
can usually be tracked down to one of these conditions.can usually be tracked down to one of these conditions.

EXAMPLE: CONFIGURE AN ADDITIONAL DATA SOURCE IN TRADESIGNALEXAMPLE: CONFIGURE AN ADDITIONAL DATA SOURCE IN TRADESIGNAL  

STEP 1: OPENING THE CONNECTION SETTINGS IN TRADESIGNALSTEP 1: OPENING THE CONNECTION SETTINGS IN TRADESIGNAL  

1.1. Open the file menu to the left of the command line.Open the file menu to the left of the command line.  
2.2. Click on the menu point Click on the menu point OptionsOptionsOptionsOptions..  
3.3. Click on the tab Click on the tab DatafeedsDatafeedsDatafeedsDatafeeds..  

STEP 2: DEFINE A FILE FOLDER AS DATA SOURCESTEP 2: DEFINE A FILE FOLDER AS DATA SOURCE  

1.1. Click on Click on Add a folder containing CSV dataAdd a folder containing CSV dataAdd a folder containing CSV dataAdd a folder containing CSV data to configure a new connection. to configure a new connection.  
2.2. Click on Click on BrowseBrowseBrowseBrowse to open the folder list. to open the folder list.  
3.3. Browse to the folder "Tradesignal Files", select it and click on Browse to the folder "Tradesignal Files", select it and click on New FolderNew FolderNew FolderNew Folder to create a new folder. to create a new folder.  
4.4. Enter the name "Ascii Data" and click on Enter the name "Ascii Data" and click on CreateCreateCreateCreate..  
5.5. Confirm with Confirm with OKOKOKOK..  
6.6. As As Time ZoneTime ZoneTime ZoneTime Zone, select "Europe/Berlin"., select "Europe/Berlin".  
7.7. Confirm with Confirm with OKOKOKOK..  

STEP 3: IMPORT AND SAVE FILESTEP 3: IMPORT AND SAVE FILE  

Save the file Save the file Sample02Sample02--1d.txt1d.txt in the folder described above (right in the folder described above (right--click the link and "save as target"). click the link and "save as target").   
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If you have read the article about If you have read the article about File NamesFile Names, you can see that the shortcut for the instrument is , you can see that the shortcut for the instrument is Sample02Sample02 and that the data has a  and that the data has a 
resolution of one day. Keep this instrument name for now. You can always change it later, if desired.resolution of one day. Keep this instrument name for now. You can always change it later, if desired.

STEP 4: OPEN CHARTSTEP 4: OPEN CHART  

1.1. Enter the shortcut "Sample02" in the command line.Enter the shortcut "Sample02" in the command line.  
2.2. Select the option Select the option New ChartNew ChartNew ChartNew Chart from the drop from the drop--down menu.down menu.  

The chart with the "Sample02" data is opened.The chart with the "Sample02" data is opened.

FILE NAMES FOR QUOTATION DATAFILE NAMES FOR QUOTATION DATA  

File names have an important function File names have an important function -- ideally, they tell the user what kind of data is included and how it is to be displayed. The  ideally, they tell the user what kind of data is included and how it is to be displayed. The 
operating system automatically opens the program assigned to the file extension. operating system automatically opens the program assigned to the file extension.   
  
In the case of quotation data like in our case, the file name has another important function. It shows us and the software to which In the case of quotation data like in our case, the file name has another important function. It shows us and the software to which 
instrument the data belongs, which trading period is used and more. If you have a problem displaying data, this is probably caused instrument the data belongs, which trading period is used and more. If you have a problem displaying data, this is probably caused 
by an error either in the file name or in the by an error either in the file name or in the Data FormatData Format..  
  
Please note where the information in a filename is used and if it is mandatory or optional. Please note where the information in a filename is used and if it is mandatory or optional. 

FILE NAMESFILE NAMES  

The file name can/must include the following information:The file name can/must include the following information:The file name can/must include the following information:The file name can/must include the following information:  

l Shortcut (mandatory)Shortcut (mandatory)  
l Period (mandatory)Period (mandatory)  
l Field Identifier (optional)Field Identifier (optional)  

File names can be constructed in the following ways:File names can be constructed in the following ways:File names can be constructed in the following ways:File names can be constructed in the following ways:  

l Shortcut.FileExtensionShortcut.FileExtension  
l ShortcutShortcut--Period.FileExtensionPeriod.FileExtension  
l ShortcutShortcut--FIDFID--Period.FileExtensionPeriod.FileExtension  

As a separator between the parameters, the minus sign is used. If you want to use a shortcut that already includes a minus sign, As a separator between the parameters, the minus sign is used. If you want to use a shortcut that already includes a minus sign, 
substitute it with a comma or semicolon. Valid file extensions recognized by Tradesignal are .csv, .asc and .txt.substitute it with a comma or semicolon. Valid file extensions recognized by Tradesignal are .csv, .asc and .txt.

SHORTCUTSHORTCUT  

If you want to be able to use the file name in the If you want to be able to use the file name in the Command LineCommand Line of Tradesignal, e.g. to open a chart with the data, the shortcut has  of Tradesignal, e.g. to open a chart with the data, the shortcut has 
to follow a certain convention. The shortcut is also important if you want to combine data from your online provider with offline to follow a certain convention. The shortcut is also important if you want to combine data from your online provider with offline 
data.data.  
  
NotationNotationNotationNotation: If you want to use a shortcut independent of your online provider, you may freely choose the filename. However, if you : If you want to use a shortcut independent of your online provider, you may freely choose the filename. However, if you 
want to combine data from your online provider with offline data (for example to extend the history or to add intraday data for an want to combine data from your online provider with offline data (for example to extend the history or to add intraday data for an 
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instrument), the shortcut of the offline data has to be identical to the one used by the online provider. Otherwise, the external instrument), the shortcut of the offline data has to be identical to the one used by the online provider. Otherwise, the external 
offline data will not be assigned correctly.offline data will not be assigned correctly.  
  
For shortcuts with a leading point (e.g. many indices), a trick has to be used since Windows does not allow filenames with a For shortcuts with a leading point (e.g. many indices), a trick has to be used since Windows does not allow filenames with a 
leading point. Just add a plus sign before the point. leading point. Just add a plus sign before the point.   
  
Example for an instrument with leading pointExample for an instrument with leading pointExample for an instrument with leading pointExample for an instrument with leading point: +.gdaxi: +.gdaxi--5m.csv5m.csv

PERIODPERIOD  

The period is optional in a file name. If no period is given, Tradesignal automatically displays the data in daily intervals, even if The period is optional in a file name. If no period is given, Tradesignal automatically displays the data in daily intervals, even if 
intraday data is available in the file. The software can display the data correctly only if the period parameter is used. If you receive intraday data is available in the file. The software can display the data correctly only if the period parameter is used. If you receive 
an error when changing the period settings of your external data in the an error when changing the period settings of your external data in the ChartChart or  or ScannerScanner, it is very likely that this error results from , it is very likely that this error results from 
a missing or invalid period value.a missing or invalid period value.    
  
Notation:Notation:Notation:Notation:  

FIELD IDENTIFIERFIELD IDENTIFIER  

The Field Identifier is only mandatory if instead of the normal quotations (open, high, low and close) the bid, ask, or last prices are The Field Identifier is only mandatory if instead of the normal quotations (open, high, low and close) the bid, ask, or last prices are 
given in the file. These prices can only be displayed with the correct identifier. The following identifiers are valid: given in the file. These prices can only be displayed with the correct identifier. The following identifiers are valid: 

l lastlast  
l bidbid  
l askask  

Example for a file with bid pricesExample for a file with bid pricesExample for a file with bid pricesExample for a file with bid prices: +.gdaxi: +.gdaxi--bidbid--5min.csv5min.csv  
Example for a file with ask pricesExample for a file with ask pricesExample for a file with ask pricesExample for a file with ask prices: +.gdaxi: +.gdaxi--askask--5min.csv5min.csv

DATA FORMAT OF EXTERNAL QUOTATIONSDATA FORMAT OF EXTERNAL QUOTATIONS  

PeriodPeriodPeriodPeriod Short codeShort codeShort codeShort code ExampleExampleExampleExample
Tick DataTick Data tick, 0, t, tick, ticks, 1ttick, 0, t, tick, ticks, 1t aaaaaa--tick.csvtick.csv
1 Minute1 Minute 60, 1m, m, min, minute, minutes, minuten60, 1m, m, min, minute, minutes, minuten pumg.depumg.de--60.csv60.csv
5 Minutes5 Minutes 300, 5m, 5min, 5mins, 5minute, 5minuten, 5minutes300, 5m, 5min, 5mins, 5minute, 5minuten, 5minutes adsg.deadsg.de--5m.csv5m.csv
30 Minutes30 Minutes 1800, 30m, 30min, 30mins, 30minute, 30minuten, 30minutes1800, 30m, 30min, 30mins, 30minute, 30minuten, 30minutes depfadepfa--30min.csv30min.csv
1 Hour1 Hour 3600, 1h, h, hour, hourly, 1hour, stunde, stunden3600, 1h, h, hour, hourly, 1hour, stunde, stunden eurusdeurusd--hour.csvhour.csv
1 Day1 Day 86400, 1d, d, day, daily, tag86400, 1d, d, day, daily, tag +.rut+.rut--1d.txt1d.txt
1 Week1 Week 604800, 1w, w, week, weekly, woche604800, 1w, w, week, weekly, woche +.gdaxi+.gdaxi--w.csvw.csv
1 Month1 Month 2592000, month, mothly, monat2592000, month, mothly, monat dowjonesdowjones--monthly.csvmonthly.csv
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In files of quotation data, the data format (i.e. the sequence of elements In files of quotation data, the data format (i.e. the sequence of elements 
such as date, time, prices and volume) defines the data display and such as date, time, prices and volume) defines the data display and 
whether the program can handle it at all. Since there are many possible whether the program can handle it at all. Since there are many possible 
combinations, import problems may be caused by data in the wrong format. combinations, import problems may be caused by data in the wrong format. 
Often, a simple wrong separator or a nonOften, a simple wrong separator or a non--supported date format can cause supported date format can cause 
havoc with the data. havoc with the data.   
  
When you need to edit the data format, you can do this with a text editor. When you need to edit the data format, you can do this with a text editor. 
For exchanging complete columns, however, usually programs like Excel or For exchanging complete columns, however, usually programs like Excel or 
Access are necessary.Access are necessary.  
  
A file with quotation data has the following components:A file with quotation data has the following components:

l Header Header -- recommended but optional recommended but optional  
l Data columns separated by separators (by default semicolon or comma)Data columns separated by separators (by default semicolon or comma)  

Tradesignal recognizes the following column types:Tradesignal recognizes the following column types:

l DateDate  
l Time Time -- optional optional  
l Open Open -- optional optional  
l High High -- optional optional  
l Low Low -- optional optional  
l CloseClose  
l Volume Volume -- optional optional  
l Open Interest Open Interest -- optional optional  

For the display of intraday data, time and date stamps are necessary. Otherwise, the data is filled in beginning with the current For the display of intraday data, time and date stamps are necessary. Otherwise, the data is filled in beginning with the current 
trading day, which may not always give correct results. If you want to add information to the history of your online data provider, trading day, which may not always give correct results. If you want to add information to the history of your online data provider, 
make sure that your file has the same data elements as the file from your provider.make sure that your file has the same data elements as the file from your provider.

HEADERHEADER  

The first segment of the file should be the header. It contains information about the data columns, their order and the used The first segment of the file should be the header. It contains information about the data columns, their order and the used 
separators. The header is optional; when no header is given, Tradesignal attempts to interpret and display the segments. However, separators. The header is optional; when no header is given, Tradesignal attempts to interpret and display the segments. However, 
this may cause errors. this may cause errors.   
  
In the header, information about the columns is given in the way of identifiers. The identifiers have to be separated by the same In the header, information about the columns is given in the way of identifiers. The identifiers have to be separated by the same 
separator as the data columns. For each column type, several identifiers are possible, as you can see in the following list:separator as the data columns. For each column type, several identifiers are possible, as you can see in the following list:    
  
NotationNotationNotationNotation

l Date Date -- d, date, datetime (when date and time are combined) d, date, datetime (when date and time are combined)  
l time time -- t, time t, time  
l Open Open -- o, op, open o, op, open  
l High High -- h, hi, high h, hi, high  
l Low Low -- l, lo, low l, lo, low  
l Close Close -- c, cl, close c, cl, close  

View of an ASCII file in a text editorView of an ASCII file in a text editor
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l Volume Volume -- v, vo, vol, volume v, vo, vol, volume  
l OpenInterest OpenInterest -- oi, openint, ointerest, openinterest oi, openint, ointerest, openinterest  

Example HeaderExample HeaderExample HeaderExample Header: Date;Time;Open;High;Low;Close;Volume : Date;Time;Open;High;Low;Close;Volume   
  
If no header is given, Tradesignal uses the following masks to analyze the column grouping: If no header is given, Tradesignal uses the following masks to analyze the column grouping: 

l d,o,h,l,cd,o,h,l,c  
l d,o,h,l,c,vd,o,h,l,c,v  
l d,o,h,l,c,v,oid,o,h,l,c,v,oi  
l d,cd,c  
l d,c,vd,c,v  
l d,c,v,oid,c,v,oi  

Some data sources, for example Internet offers, contain data in additional columns. Since Tradesignal cannot display those, the Some data sources, for example Internet offers, contain data in additional columns. Since Tradesignal cannot display those, the 
data has to be skipped. For this, the word "Skip" can be used in the header. In the following header example, the last column is data has to be skipped. For this, the word "Skip" can be used in the header. In the following header example, the last column is 
skipped.skipped.    
  
Example for a file with an additional column that is skipped:Example for a file with an additional column that is skipped:Example for a file with an additional column that is skipped:Example for a file with an additional column that is skipped:    
  

Date,Open,High,Low,Close,Volume,Adj. Close*09.11.05,10539.24,10637.78,10466.24,10546.21,22144600,10546.21 

  
  
results in: results in:   
  

Date,Open,High,Low,Close,Volume,Skip09.11.05,10539.24,10637.78,10466.24,10546.21,22144600,10546.21 

DATA AND TIME FORMATSDATA AND TIME FORMATS  

For date and time, many different formats exist.For date and time, many different formats exist.

DATE FORMATDATE FORMAT  

l European Format European Format -- Example: 01.04.2006 Example: 01.04.2006  
l English (US) Format English (US) Format -- Example: 04/01/06 Example: 04/01/06  
l Standard ISO Format Standard ISO Format -- Example: 1998 Example: 1998--1212--22T01:02:03:98722T01:02:03:987  

When the European format is recognized, a comma has to be used as decimal separator. In the case of an English format, a When the European format is recognized, a comma has to be used as decimal separator. In the case of an English format, a 
decimal point has to be used as decimal separator. decimal point has to be used as decimal separator.   
  
Additional differences may exist in the day, month, year sequence, especially in the case of UK/US formats. See the example Additional differences may exist in the day, month, year sequence, especially in the case of UK/US formats. See the example 
below for combinations recognized by Tradesignal.below for combinations recognized by Tradesignal.

TIME STAMPTIME STAMP  
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No flexibility is given regarding the time stamp format. The separator has always to be a colon. If necessary, the separators of an No flexibility is given regarding the time stamp format. The separator has always to be a colon. If necessary, the separators of an 
external data file have to be exchanged to a colon in a text editor. external data file have to be exchanged to a colon in a text editor.   
  
Components of the Time StampComponents of the Time StampComponents of the Time StampComponents of the Time Stamp

l hourhour  
l minuteminute  
l secondsecond  
l oneone--tenth of a second (for tick data)tenth of a second (for tick data)  

For English time zones, "AM" or "PM" can be used if the hours are given in a 12 hour interval.For English time zones, "AM" or "PM" can be used if the hours are given in a 12 hour interval.  

EXAMPLES FOR VALID DATE AND TIME STAMPS IN TRADESIGNALEXAMPLES FOR VALID DATE AND TIME STAMPS IN TRADESIGNAL  

ENGLISH FORMATSENGLISH FORMATS  

l 1998/1/11 11:05:001998/1/11 11:05:00  
l 5/17/1998 11:05:00 AM5/17/1998 11:05:00 AM  
l 5/17/1998 8:05:00 PM5/17/1998 8:05:00 PM  
l 2005/10/25 12:25:11 PM2005/10/25 12:25:11 PM  
l 2005/10/25 11:05:00:124 AM2005/10/25 11:05:00:124 AM  
l 55--1717--19981998  
l 19981998--1212--2222  
l 19981998--1212--22 01:02 PM22 01:02 PM  
l 9898--1212--2222  

EUROPEAN FORMATS EUROPEAN FORMATS   

l 04.12.9804.12.98  
l 04.12.199804.12.1998  
l 04.12.1998 12:2304.12.1998 12:23  
l 04.12.1998 12:23:1204.12.1998 12:23:12  
l 04.12.1998 12:23:14:12204.12.1998 12:23:14:122  
l 04.12.1998 12:23:14.12204.12.1998 12:23:14.122  

ISO FORMATSISO FORMATS  

l 19981998--1212--22T01:02:0322T01:02:03  
l 19981998--1212--22T01:02:03:98722T01:02:03:987  
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TRADESIGNAL DATA IN EXCEL 
Extending Equilla via Extending Equilla via COMCOM--API ExtensionsAPI Extensions allows you to get periodically updated data from Tradesignal into your Excel  allows you to get periodically updated data from Tradesignal into your Excel 
spreadsheets.spreadsheets.  
  
In Tradesignal 7, we've added a COMIn Tradesignal 7, we've added a COM--API extension API extension LiveExportLiveExport and indicator of the same name to help you accomplish this. The  and indicator of the same name to help you accomplish this. The 
extension enables the indicator to write price data into an Access database file which can be imported into an Excel worksheet. To extension enables the indicator to write price data into an Access database file which can be imported into an Excel worksheet. To 
get periodic updates to the data displayed, you can specify how often Excel updates from the database.get periodic updates to the data displayed, you can specify how often Excel updates from the database.

WRITING DATA FROM A CHART TO AN ACCESS DATABASEWRITING DATA FROM A CHART TO AN ACCESS DATABASE  

1.1. Make sure that COMMake sure that COM--API extensions are enabled, API extensions are enabled, File > Options > File > Options > 
Advanced > Equilla ExtensionAdvanced > Equilla Extension..  

2.2. Apply indicator Apply indicator LiveExportLiveExport from the  from the TradesignalTradesignal package to an  package to an 
instrument or indicator on a chart.instrument or indicator on a chart.  

3.3. Set path and table name prefix in the properties of the indicator. You Set path and table name prefix in the properties of the indicator. You 
can use macros for some commonly used folders on your machine, can use macros for some commonly used folders on your machine, 
see source code of the indicator for details.see source code of the indicator for details.  

ACCESSING DATABASE FROM EXCEL 2010ACCESSING DATABASE FROM EXCEL 2010  

1.1. Data > From AccessData > From Access on the ribbon allows you to pick the database  on the ribbon allows you to pick the database 
file and table.file and table.  

2.2. Make sure to pick Make sure to pick DB_MODE_READDB_MODE_READ to open the database as read to open the database as read--
only, otherwise Tradesignal will not be able to write to this only, otherwise Tradesignal will not be able to write to this 
database.database.  

3.3. In the properties of the connection, you can enable periodic refresh In the properties of the connection, you can enable periodic refresh 
and change the refresh interval.and change the refresh interval.  

Equilla Extension options in TradesignalEquilla Extension options in Tradesignal

Open Mode in Excel 2010Open Mode in Excel 2010
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Connection Properties in Excel 2010Connection Properties in Excel 2010
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EXPORTING PRICE DATA 
If your data provider allows exporting of price data, you can export data displayed in Tradesignal byIf your data provider allows exporting of price data, you can export data displayed in Tradesignal by

l dragging the symbol from the chart legend to another application which can handle CSV data input, e.g. most spreadsheet dragging the symbol from the chart legend to another application which can handle CSV data input, e.g. most spreadsheet 
applicationsapplications  

l or by selecting the or by selecting the Home > Data > Export DataHome > Data > Export DataHome > Data > Export DataHome > Data > Export Data found in the  found in the ToolbarToolbar..  

l The file format for export is CSV which can be parsed by a wide range of applications and is also human readable.The file format for export is CSV which can be parsed by a wide range of applications and is also human readable.    
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XML DATA SERVERS 
You can integrate external data sources into Tradesignal. The following You can integrate external data sources into Tradesignal. The following 
reasons work in their favor:reasons work in their favor:

l Extension of histories: If you want to extend the history of your data Extension of histories: If you want to extend the history of your data 
provider with an external data source.provider with an external data source.  

l Exchange historic data: If you want to substitute the histories of your Exchange historic data: If you want to substitute the histories of your 
data provider data provider -- partially or completely  partially or completely -- by using better data from  by using better data from 
your external source.your external source.  

l Extend the "data universe": If you want to use external data that your Extend the "data universe": If you want to use external data that your 
normal data provider doesn't offer. normal data provider doesn't offer.   
  

Note:Note:Note:Note: To connect the XML data server, a valid, special product license is  To connect the XML data server, a valid, special product license is 
necessary.necessary.

PROCESSING PERSONAL DATAPROCESSING PERSONAL DATA  

For the professional use of external data sources, data banks are used that assemble and providing time histories. These data For the professional use of external data sources, data banks are used that assemble and providing time histories. These data 
servers offer the data in a standardized XML format which can be interpreted and displayed by Tradesignal.servers offer the data in a standardized XML format which can be interpreted and displayed by Tradesignal.  
  
Usually, such a server is situated in the intranet, but since it is a normal web service, a use via internet is possible as well. Usually, such a server is situated in the intranet, but since it is a normal web service, a use via internet is possible as well. 
Several data sources or data servers can be used.Several data sources or data servers can be used.  
  
In the In the OptionsOptionsOptionsOptions, menu entry , menu entry DatafeedsDatafeedsDatafeedsDatafeeds, you can configure up to ten external data sources. Instructions can be found at , you can configure up to ten external data sources. Instructions can be found at Additional Additional 
Data SourcesData Sources..

USING PROPRIETARY TIMESERIES IN TRADESIGNALUSING PROPRIETARY TIMESERIES IN TRADESIGNAL  

In Tradesignal, trading houses or other companies that assemble data histories of their own are given the ability to display and In Tradesignal, trading houses or other companies that assemble data histories of their own are given the ability to display and 
chart these histories via the XML data server. chart these histories via the XML data server. 

DATA INTERFACEDATA INTERFACE  

The data server interface offers an (internal) Search API, a Master Data API and a History API.The data server interface offers an (internal) Search API, a Master Data API and a History API.

l Search API: Via this API, Tradesignal connects to the data source of the data server. The search is integrated so that the Search API: Via this API, Tradesignal connects to the data source of the data server. The search is integrated so that the 
normal search functionality of the chart application are available.normal search functionality of the chart application are available.  

l Master Data API: Via this API, master data like currencies, pieces, names, units etc. are available.Master Data API: Via this API, master data like currencies, pieces, names, units etc. are available.  
l History API: This API offers the complete data history of the requested instrument. The interface offers the same time periods History API: This API offers the complete data history of the requested instrument. The interface offers the same time periods 

as the data source. In case the requested history is not available on the server, the time history can also be accumulated in as the data source. In case the requested history is not available on the server, the time history can also be accumulated in 

XML Data ServerXML Data Server
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Tradesignal. Due to a possible decrease in performance, however, the most important periods should always be preTradesignal. Due to a possible decrease in performance, however, the most important periods should always be pre--
cumulated in the data source.cumulated in the data source.  

DATA UPDATESDATA UPDATES  

Since the XML data server does not "push" the data, Tradesignal has to access the data server at regular time intervals to pull Since the XML data server does not "push" the data, Tradesignal has to access the data server at regular time intervals to pull 
current data. You can set these time intervals to the second in Tradesignal, even for each stock if desired. If the data have changed current data. You can set these time intervals to the second in Tradesignal, even for each stock if desired. If the data have changed 
since the latest update, Tradesignal only pulls the data difference to optimize server and client performance and to minimize the since the latest update, Tradesignal only pulls the data difference to optimize server and client performance and to minimize the 
necessary data volume.necessary data volume.    
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PRICE EDITOR 
Price data can be obtained from various sources. On the one hand, data is Price data can be obtained from various sources. On the one hand, data is 
supplied to the software from the default data provider via the Internet, on supplied to the software from the default data provider via the Internet, on 
the other hand data can be imported via a data interface, as the other hand data can be imported via a data interface, as text filestext files or in  or in 
other data formats. other data formats.   
  
When receiving data, errors may happen and make it necessary to edit the When receiving data, errors may happen and make it necessary to edit the 
price data manually. Use the Price Editor to: price data manually. Use the Price Editor to: 

l enter stock splits retroactivelyenter stock splits retroactively  
l rectify faulty ticks and corrupt data recordsrectify faulty ticks and corrupt data records  

The Price Editor is available in the Chart, Scanner and Portfolio.The Price Editor is available in the Chart, Scanner and Portfolio.

OPEN THE PRICE EDITOROPEN THE PRICE EDITOR  

l Click on the button Click on the button Edit PricesEdit PricesEdit PricesEdit Prices under  under Home > DataHome > Data on the  on the ToolbarToolbar..  
l Alternatively, open the context menu of the documents and select Alternatively, open the context menu of the documents and select Edit PriceEdit PriceEdit PriceEdit Price..  

The Price Editor opens. The The Price Editor opens. The PricesPrices group appears in the toolbar. group appears in the toolbar.

EDIT DATAEDIT DATA  

CHANGE DATACHANGE DATA  

You can edit the values of a line (single trading period).You can edit the values of a line (single trading period).  

l DoubleDouble--click the line.click the line.  
l Alternatively, rightAlternatively, right--click the line and select click the line and select EditEditEditEdit from the context menu. from the context menu.  

DELETE DATADELETE DATA  

You can delete lines (single trading periods) from the price table. You can delete lines (single trading periods) from the price table. 

l Select one or more lines and press the Select one or more lines and press the DelDelDelDel key. key.  
l Alternatively, rightAlternatively, right--click the selected lines and select click the selected lines and select Delete Row(s)Delete Row(s)Delete Row(s)Delete Row(s) from the context menu. from the context menu.  

Depending on file size, the process may take several minutes, as backups are created.Depending on file size, the process may take several minutes, as backups are created.  

ENTER STOCK SPLITSENTER STOCK SPLITS  

You can enter stock splits manually, if the data provider offers no corrected data or if you downloaded data without split correction You can enter stock splits manually, if the data provider offers no corrected data or if you downloaded data without split correction 
from the Internet.from the Internet.

Price EditorPrice Editor
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1.1. Select the lines you want to edit.Select the lines you want to edit.  
2.2. Open the split function by clicking the Open the split function by clicking the SplitSplitSplitSplit button in the symbol bar or selecting the entry  button in the symbol bar or selecting the entry SplitSplitSplitSplit in the context menu. in the context menu.  

Select a Data Adjustment Mode:Select a Data Adjustment Mode:

l AbsoluteAbsoluteAbsoluteAbsolute  -- The value is subtracted from the selected prices. The value is subtracted from the selected prices.  
l RelativeRelativeRelativeRelative  -- Here you can enter a multiplier or the split ratio. Many stocks are split in a 1:2 or 1:3 ratio. The preview window  Here you can enter a multiplier or the split ratio. Many stocks are split in a 1:2 or 1:3 ratio. The preview window 

displays the effects of the entered split settings on example data.displays the effects of the entered split settings on example data.  

Click Click OKOKOKOK to save the settings and start the process. The data is changed. This may take a few minutes. to save the settings and start the process. The data is changed. This may take a few minutes.

RESET CHANGESRESET CHANGES  

Changed or deleted prices can be reset to their original values at any time (with the exception of DataConnect data). Tradesignal Changed or deleted prices can be reset to their original values at any time (with the exception of DataConnect data). Tradesignal 
keeps backups of the data. keeps backups of the data. 

1.1. Select one or more lines with changed data. Changed data are underlined in orange in the table.Select one or more lines with changed data. Changed data are underlined in orange in the table.  
2.2. Open the context menu and select Open the context menu and select Reset Edited DataReset Edited DataReset Edited DataReset Edited Data. The program restores the backup and overwrites the changes.. The program restores the backup and overwrites the changes.  

DIFFERENCE BETWEEN LOCAL DATA AND TRADESIGNAL DATACONNECTDIFFERENCE BETWEEN LOCAL DATA AND TRADESIGNAL DATACONNECT  

Tradesignal DataConnect is a product from Tradesignal that collects and organizes data from many commercial data feeds. It is only Tradesignal DataConnect is a product from Tradesignal that collects and organizes data from many commercial data feeds. It is only 
relevant to Tradesignal institutional users.relevant to Tradesignal institutional users.  
  
The functions described above are available for local data or data offered from the provider, and also for the price data of The functions described above are available for local data or data offered from the provider, and also for the price data of 
DataConnect. DataConnect.   
  
The sole difference is that in the case of DataConnect data, no backup and data restoration is available. If you want to change The sole difference is that in the case of DataConnect data, no backup and data restoration is available. If you want to change 
DataConnect data, save the data as personal backup before editing it.DataConnect data, save the data as personal backup before editing it.    
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REUTERS DATA 

SYMBOL SYNTAXSYMBOL SYNTAX  

Reuters Symbol syntax differs from the Bloomberg syntax. In general, you only have to enter the symbol short code in the command Reuters Symbol syntax differs from the Bloomberg syntax. In general, you only have to enter the symbol short code in the command 
line, for exampleline, for example

l short code + exchange (e.g. Siegn.DE)short code + exchange (e.g. Siegn.DE)  

The short code behind the colon refers to the exchange, e.g. the following:The short code behind the colon refers to the exchange, e.g. the following:

l .DE .DE --  XetraXetra  
l .FRA .FRA ––  FrankfurtFrankfurt  
l .MU .MU --  MunichMunich  
l .STU .STU ––  StuttgartStuttgart  

In addition to those short codes, you can add more commands, e.g. period information.In addition to those short codes, you can add more commands, e.g. period information.  
  
For example:Siegn.de 5mFor example:Siegn.de 5m (opens Siemens at xetra in 5minute period) (opens Siemens at xetra in 5minute period)  
  
Continuous Future contracts are indicated with "c1", e.g. FDXc1 for dax future or FGBLc1 for Bund future.Continuous Future contracts are indicated with "c1", e.g. FDXc1 for dax future or FGBLc1 for Bund future.  
  
Single contracts are entered as follows: Single contracts are entered as follows: 

l short code + expiry month + expiry yearshort code + expiry month + expiry year  

e.g. for dax future dec. 2007, it would be FDXZ7e.g. for dax future dec. 2007, it would be FDXZ7  
  
Indices always have a dot before the short code, for example:Indices always have a dot before the short code, for example:

l .GDAXI for dax index.GDAXI for dax index  
l .DJI for dow jones index.DJI for dow jones index  
l .GSPC for s&p index.GSPC for s&p index  

A list of all mayor symbol codes you can find here: A list of all mayor symbol codes you can find here: Reuters SymbollistsReuters SymbollistsReuters SymbollistsReuters Symbollists

SYMBOL LISTSSYMBOL LISTS  

When starting TradeSignal for the very first time, you are asked if you want to receive lists from your data provider. If you confirm When starting TradeSignal for the very first time, you are asked if you want to receive lists from your data provider. If you confirm 
this, you will use the Symbol List wizard for the first time. However, you can start the wizard any time to create a new list. this, you will use the Symbol List wizard for the first time. However, you can start the wizard any time to create a new list. 

l In the toolbox, click the Symbol Lists button.In the toolbox, click the Symbol Lists button.  
l In the Related Task area, click on New Symbol List.In the Related Task area, click on New Symbol List.  

The Symbol List wizard opens. Choose The Symbol List wizard opens. Choose Predefined Symbol List from Your Data ProviderPredefined Symbol List from Your Data ProviderPredefined Symbol List from Your Data ProviderPredefined Symbol List from Your Data Provider. On the upper left side you will find a . On the upper left side you will find a 
search box. Enter the RIC of the wanted index and hit search box. Enter the RIC of the wanted index and hit SearchSearch. Now the result will be displayed. Make a check into the checkbox . Now the result will be displayed. Make a check into the checkbox 
next to the result and hit next to the result and hit OKOK. Now the new Symbol List will be added to your list.. Now the new Symbol List will be added to your list.  
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Use the RIC, you will use to open the Index as chart.Use the RIC, you will use to open the Index as chart.  
  
Please use:Please use:  
  
.GDAXI.GDAXI.GDAXI.GDAXI for the Dax 30  for the Dax 30   
.MDAXI.MDAXI.MDAXI.MDAXI for the MDax for the MDax  
.TECDAX.TECDAX.TECDAX.TECDAX for the TecDax for the TecDax  
.FTSE.FTSE.FTSE.FTSE for the FTSE 100 Index for the FTSE 100 Index  
.FCHI.FCHI.FCHI.FCHI for the CAC 40 Index for the CAC 40 Index  
.BFX.BFX.BFX.BFX for the Bell 20 Index for the Bell 20 Index  
.AEX.AEX.AEX.AEX for the AEX Amsterdam Index for the AEX Amsterdam Index  
.IBEX.IBEX.IBEX.IBEX for the Ibex 35 Index for the Ibex 35 Index  
.DJI.DJI.DJI.DJI for the Dow Jones Industrial Index for the Dow Jones Industrial Index  
.IXIC.IXIC.IXIC.IXIC for the Nasdaq Composite Index for the Nasdaq Composite Index  
.SPX.SPX.SPX.SPX for the S&P 500 Index for the S&P 500 Index  
.BVSP.BVSP.BVSP.BVSP for the Ibovespa  for the Ibovespa --  Bovespa IndexBovespa Index  
.HSI.HSI.HSI.HSI for the Hang Seng Index for the Hang Seng Index  
.N225.N225.N225.N225 for the Nikkei Stock Average 225 for the Nikkei Stock Average 225  
.SSMI.SSMI.SSMI.SSMI for the SMI Index for the SMI Index  
.MIBTEL.MIBTEL.MIBTEL.MIBTEL for the Italian Mibtel for the Italian Mibtel  
.SMSI.SMSI.SMSI.SMSI for the Madrid General Index for the Madrid General Index  
.OMXSPI.OMXSPI.OMXSPI.OMXSPI for the Stockholm All Share Index for the Stockholm All Share Index  
.OMXHPI.OMXHPI.OMXHPI.OMXHPI for the Helsinki All Share Index for the Helsinki All Share Index  
.OMXC20.OMXC20.OMXC20.OMXC20 for the Copenhagen 20 Index for the Copenhagen 20 Index  
.OSEAX.OSEAX.OSEAX.OSEAX for the Oslo Exchange All for the Oslo Exchange All--share Indexshare Index  
.BUX.BUX.BUX.BUX for the Budapest Stock Exchange Index for the Budapest Stock Exchange Index  
.STOXX50.STOXX50.STOXX50.STOXX50 for the DJ Stoxx 50 ETF for the DJ Stoxx 50 ETF  
.STOXX50E.STOXX50E.STOXX50E.STOXX50E for the DJ Euro Stoxx 50 ETF for the DJ Euro Stoxx 50 ETF  
.AORD.AORD.AORD.AORD for the All Ordinaries Index for the All Ordinaries Index  
.KS11.KS11.KS11.KS11 for the KOSPI Index for the KOSPI Index  
.KLSE.KLSE.KLSE.KLSE for the KLSE Composite Index for the KLSE Composite Index  
.SETI.SETI.SETI.SETI for the SET Composite Index for the SET Composite Index  
.JKSE.JKSE.JKSE.JKSE for the Jakarta Composite for the Jakarta Composite  
.PSI.PSI.PSI.PSI for the PSE Composite Index for the PSE Composite Index  
.KSE.KSE.KSE.KSE for the Karachi SE 100 Index for the Karachi SE 100 Index  
.SSEC.SSEC.SSEC.SSEC for the Shanghai Composite Index for the Shanghai Composite Index  



:: www.tradesignal.comwww.tradesignal.com

Tradesignal GmbHTradesignal GmbH Page 454Page 454 Version 7.0Version 7.0

BLOOMBERG DATA 

SYMBOL SYNTAXSYMBOL SYNTAX  

Bloomberg Symbol syntax differs from the Reuters syntax. In general, you only have to enter the symbol short code in the command Bloomberg Symbol syntax differs from the Reuters syntax. In general, you only have to enter the symbol short code in the command 
line, for exampleline, for example

l short code + security type (e.g. SIE EQUITY)short code + security type (e.g. SIE EQUITY)  

Other short codes are:Other short codes are:

l GOVTGOVT for government bonds for government bonds  
l CORPCORP for corporate bonds for corporate bonds  
l CRNCYCRNCY for currency for currency  
l INDEXINDEX for indices for indices  
l CMDTYCMDTY for futures for futures  

Due to the fact that instruments are traded on different exchanges, you have to enter additional commands, otherwise the most Due to the fact that instruments are traded on different exchanges, you have to enter additional commands, otherwise the most 
profitable exchange will be offered automatically.profitable exchange will be offered automatically.

l short code + exchange + security type (e.g. SIE GY EQUITY for xetra)short code + exchange + security type (e.g. SIE GY EQUITY for xetra)  

In addition to those short codes, you can add more commands, e.g. period information.In addition to those short codes, you can add more commands, e.g. period information.  
  
For example:For example:

l short code + exchange + security type + period (e.g. SIE GY EQUITY 5m opens Siemens on xetra in 5min. period)short code + exchange + security type + period (e.g. SIE GY EQUITY 5m opens Siemens on xetra in 5min. period)  

Continuous Future contracts are indicated with "1", e.g. GX1 COMDTY for dax future or RX1 COMDTY for Bund future.Continuous Future contracts are indicated with "1", e.g. GX1 COMDTY for dax future or RX1 COMDTY for Bund future.  
  
Single contracts are entered as follows:Single contracts are entered as follows:

l short code + expiry month + expiry year + security typeshort code + expiry month + expiry year + security type  

e.g. for dax future Dec. 2007, it would be GXZ7 COMDTYe.g. for dax future Dec. 2007, it would be GXZ7 COMDTY  
  
You can recall more short codes and infos within the Bloomberg terminal. Enter the commands as follows:You can recall more short codes and infos within the Bloomberg terminal. Enter the commands as follows:

l DOCS + GoDOCS + Go formal documents formal documents  

l BLP + GoBLP + Go Bloomberg Launch Pad Bloomberg Launch Pad  

l PDF + Go personal default settingsPDF + Go personal default settings  

l BBXL + Go all about Bloomberg und Excel G + GoBBXL + Go all about Bloomberg und Excel G + Go  
  

A list of all mayor symbol codes you can find here: A list of all mayor symbol codes you can find here: Bloomberg SymbollistsBloomberg SymbollistsBloomberg SymbollistsBloomberg Symbollists

DATAHISTORYDATAHISTORY  
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All data comes directly from Bloomberg. There will be no local caching or saving. All data comes directly from Bloomberg. There will be no local caching or saving.   
  
Generally there will be the following data history be available:Generally there will be the following data history be available:  
  

SYMBOL LISTSSYMBOL LISTS  

When starting TradeSignal for the very first time, you are asked if you want to receive lists from your data provider. If you confirm When starting TradeSignal for the very first time, you are asked if you want to receive lists from your data provider. If you confirm 
this, you will use the Symbol List wizard for the first time. However, you can start the wizard any time to create a new list. this, you will use the Symbol List wizard for the first time. However, you can start the wizard any time to create a new list. 

l In the toolbox, click the Symbol Lists button.In the toolbox, click the Symbol Lists button.  
l In the Related Task area, click on New Symbol List.In the Related Task area, click on New Symbol List.  

The Symbol List wizard opens. Choose The Symbol List wizard opens. Choose Predefined Symbol List from Your Data ProviderPredefined Symbol List from Your Data ProviderPredefined Symbol List from Your Data ProviderPredefined Symbol List from Your Data Provider. On the upper left side you will find a . On the upper left side you will find a 
search box. Enter the shortcode of the wanted index and hit search box. Enter the shortcode of the wanted index and hit SearchSearch. Now the result will be displayed. Make a check into the . Now the result will be displayed. Make a check into the 
checkbox next to the result and hit checkbox next to the result and hit OKOK. Now the new Symbol List will be added to your list.. Now the new Symbol List will be added to your list.  
  
Use the shortcode, you will use to open the Index as chart.Use the shortcode, you will use to open the Index as chart.  
  
Please use:Please use:  
  
DAXDAXDAXDAX for the Dax 30  for the Dax 30   
MDAXMDAXMDAXMDAX for the M Dax for the M Dax  
TDXPTDXPTDXPTDXP for the TecDax for the TecDax  
UKXUKXUKXUKX for the FTSE 100 Index for the FTSE 100 Index  
CACCACCACCAC for the CAC 40 Index for the CAC 40 Index  
BEL20BEL20BEL20BEL20 for the Bell 20 Index for the Bell 20 Index  
AEXAEXAEXAEX for the AEX Amsterdam Index for the AEX Amsterdam Index  
IBEXIBEXIBEXIBEX for the Ibex 35 Index for the Ibex 35 Index  
INDUINDUINDUINDU for the Dow Jones Industrial Index for the Dow Jones Industrial Index  
CCMPCCMPCCMPCCMP for the Nasdaq Composite Index for the Nasdaq Composite Index  
SPXSPXSPXSPX for the S&P 500 Index for the S&P 500 Index  
SPTSXSPTSXSPTSXSPTSX for the TSX COMPOSITE INDEX for the TSX COMPOSITE INDEX  
IBOVIBOVIBOVIBOV for the Ibovespa  for the Ibovespa --  Bovespa IndexBovespa Index  
HSIHSIHSIHSI for the Hang Seng Index for the Hang Seng Index  
NKYNKYNKYNKY for the Nikkei Stock Average 225 for the Nikkei Stock Average 225  
SMISMISMISMI for the SMI Index for the SMI Index  
ATXATXATXATX for the Österreichischen ATX Index for the Österreichischen ATX Index  

---- DailyDailyDailyDaily IntradayIntradayIntradayIntraday TicksTicksTicksTicks
StocksStocks 20 20 -- 25 Years 25 Years 50 Days50 Days 5 Days5 Days
Futures (adj.)Futures (adj.) ca. 15 Yearsca. 15 Years 50 Days50 Days 50 Days50 Days
Indizes DtIndizes Dt up to 1960 (Dax)up to 1960 (Dax) 50 Days50 Days 50 Days50 Days
Indizes USIndizes US up to 1900 (DJI)up to 1900 (DJI) 50 Days50 Days 50 Days50 Days
Indizes USIndizes US up to 1980 (NDX)up to 1980 (NDX) 50 Days50 Days 50 Days50 Days
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MIB30MIB30MIB30MIB30 for the Italian Mibtel for the Italian Mibtel  
MADXMADXMADXMADX for the Madrid General Index for the Madrid General Index  
OMXOMXOMXOMX for the Stockholm All Share Index for the Stockholm All Share Index  
HEXHEXHEXHEX for the Helsinki All Share Index for the Helsinki All Share Index  
KFXKFXKFXKFX for the Copenhagen 20 Index for the Copenhagen 20 Index  
OBXOBXOBXOBX for the Oslo Exchange All for the Oslo Exchange All--share Indexshare Index  
BUXBUXBUXBUX for the Budapest Stock Exchange Index for the Budapest Stock Exchange Index  
SX5PSX5PSX5PSX5P for the DJ Stoxx 50 ETF for the DJ Stoxx 50 ETF  
SX5ESX5ESX5ESX5E for the DJ Euro Stoxx 50 ETF for the DJ Euro Stoxx 50 ETF  
AS30AS30AS30AS30 for the Australian All Ordinaries Index for the Australian All Ordinaries Index  
KOSPIKOSPIKOSPIKOSPI for the South Korean KOSPI Index for the South Korean KOSPI Index  
KLCIKLCIKLCIKLCI for the KLSE Composite Index for the KLSE Composite Index  
SETSETSETSET for the Thai SET Composite Index for the Thai SET Composite Index  
JCIJCIJCIJCI for the Jakarta Composite for the Jakarta Composite  
PCOMPPCOMPPCOMPPCOMP for the Philippine PSE Composite Index for the Philippine PSE Composite Index  
KSE100KSE100KSE100KSE100 for the Karachi SE 100 Index for the Karachi SE 100 Index  
SHCOMPSHCOMPSHCOMPSHCOMP for the Shanghai Composite Index for the Shanghai Composite Index  





All material included in this document is for informational purposes only. The All material included in this document is for informational purposes only. The 

information published should not be considered as advice (financial or otherwise) information published should not be considered as advice (financial or otherwise) 

and is not intended to replace consultation with a qualified professional.and is not intended to replace consultation with a qualified professional.


